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T _ {QUE ES VISUAL BASIC?

INTRODUCCION | -

L i . * . -

. ) Visual Basic es un sistema de desarrollo disefimdo especialmente para crear apli-
1: ‘ caciones grificas de una forma ripida y sencitfa. Incluye una udilidad para disedios
. ' grificos v un leaguaje de ulto nivel. 13
: [N
N ' ' o . s . - t
] Al escribir este libro el autor ha' supuesto gue el lector conoce los conceplos

fundamentates para uuhz.lr Windows y que pusee conocimientos de, programa-

; . et cion. Si no es asi. empiece por adguiric conocimicatos sobre las sentenéias v es-

1 T r L, . .

: : L . '_ tructuras bdsicas de un lengugje de programacion: para elly le recomiendo mi
‘ ’ libro Curso de programacion QBASIC v MS-DOS 3 publicado por l.i editorial
RA-MA. En cambio. si ya tiene conocimientos de QBASIC o de Quu.LBA".IC le
resultard mucho mis ficil aprender a desarrollar programas con Visual Basic, - ‘

Visual Basic e¢stad.centrado en dos tipos de objelos, ventavas y controles. que
' I U S . . " permiten diseiidr sin programar. un mecanismo de comunicicion (interfuz) para
una aplicacion. Para realizar una aplicacion se crean vemranas, llamadas formas. ¥y
. o R . sobre ellas se dibujun otros objetos Hamados controles. A continuacion| se escribe

el cédigo fuente relacionado con cadid objeto. o ’ |
. < LT o Quiere esto decir. que cada objere (formas v controlésy esti linddo b tin cédi-
. ot c o T b
. f- W S - ) oo NI 80 que permanece inactivo hasta-que se dé el suveso que lo activa. Por ejemplo,
|
podemos. programar un botén (objeto que se pucde pulsar) que ru.punda a un clic

. . del raion. .
L " .- . 3 : ; i
. Visual Basic también incluse. .
. ‘ !
: . e soporie para intercambio de dutos con otras aplicaciones (DDE - !dynamic , '
data exchange) )

e

%
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Para hacer gue uni apheadion respondi i sucesos lenemos gue unir cddizo
las formad v o los controles.

r
= - i -~
Siguiente libio ‘ ‘ .
, . - o
_IVnuaI Basic é_ -:-ﬂ- "'_l-?n[(?fiﬂl' o siguiente entradu -
| Couneclo | Cancelar “Cerrar la forma . - A

B I mdlun guie’se une o un objeto se denoming i o edimienio wmhu ido por
1 steese o sinplemente procedinicnto. - ‘ : 5
“Paga unir un procedimiento a un ohjeto hay que escribir el cadigo correspon-
diente  dicho procedimiento en la ventana de cédigo asoviada con el objeta. Para
vistalizar L ventana de cadigo de una determinada forma. hay gue hacer un doble
clie dentra del diea correspondiente a esa forma v haciendo un doble clic subie ¢l
drea uurupnndtum. aun mmrul e visualiza la ventana de codigo para ese con-

o

wol. ! - . '

‘Uh-i'ecl: ICAricelar T L_‘._I Pmc:‘ICIick - -’ [;J R

Sub Cancelan _Click () ' '  +|

b . . o —

End Sub LN T T ‘I' Salleb iy ' . \
+|

.l !l b ) - ! s r ]‘ !

L S = — =

1 . . l'r o -

Un brwcdi-m kL i Inrmddn por un numhrL dl. oabjeto. un nombre de suceso
LR BIHICINPHAEIRS; L nuum -.““L[ll\r muestra el esqueni pari el provedi-

miento asoviado co el contral ‘Cameelar. Obsenve yue el nombre del objeto es
L v el nombre del pr(mdumunu es Cunice-

Cancelur. ¢! nombre del suceso ¢ Clic
Jar Cliekezs 0 o o e

oty T e o T . e AV P b 7

. . N : 3 . ’
Todu ob cnligo Saociade con uia form v st s mmrulp. weoalmace i cun

L]
eva Tonmz Cuando una aplicacion const de varius fOrs ¥ 8¢ quicre Coip: artir

condige Aas. hay yue poner el cidigo en un modalo,

. .!, J'h-
i t Tre 1 s / - oo ..
‘ gt W = . .
(3} _ 1 § R HER | I : ...“‘ i
T e g Lol CAMIUTO T OUEES VISUAL RASIC! B
¥ AT v TR T

: l.Fn ntédider es un fichero gue contiene los procedinmientos que son compartidos
por lus formas de una aplicacion,

1

S boong e . ‘
3 et e | N 1 * o,

UN LENGUAJE DE ALTO NIVEL
v Y . . -y . 1 I
Visual Basic incluye un lenguaje I.iul de undizar que proporiiona muchas de Tas

caracteristivis de Micrisolt QB: icTo de Microsort QuichBisic v de Microsult

Busic Compiler. :
Algunas de ellas son: - : e .
o Blogues IF .. THEN ... ELSE ot ' '
4 If- rarviLe > 0 o
. vard s '
Elsa ' R B D PLIN .
vard = 0 ' r ’ .o
End It
N TR VI 0T L A M A .-
s -Bucles L . .
. P P - o . ,
Do-wnile. 1 <= 1032 e )
Print i
N T ,
LooD
Ll oo v [ - -
Coan ELt . \ . .
e Ochotipos de duos o
. o, . - A -4 P s
Inceger, Long,:Si - , .
Currency, Suring, =B N
Funciones matemdticas y de cadena ) -
. L LM LI B R B -. ‘:1 . .. N
-var?) ) : e

ses | l‘j Grod

Cumo ay ud.x [h!ld. revisar el codwu r.ipul.nmenu v |~.u.4[ Basic prupnrunlla.
13 A 1 FR - .

. Vcriﬁcuci(m autoniitica de Ly sintaxis.

o Utilidades pars depurar codigo SR

N



= Ordenes para cjecucion
"' Ejecucién paso a puso

Punios de parada

Condiciones de arrangue

e Ventana inmediata gue permile probar una linea de cddigo o verificar una
variable.

MENUS

Cuando en una aplicacién se utilizan muchas 6rdenes, Visual Basic permite agru-
parlas en un meni.

Edicién .
CoiiM

Copiar

Un mend se diseiia utilizando Ja ventana de disefos de menus.

Para visualizar esta ventana hay que ejecutar la orden Menu Design Window
del mend Window. )

Como se ve en la figura siguiente, el nombre del menid que apareceni en la
burra de mends. se escribe en fa caja de teato Caption.

CAPITULO 12 ;QUE ES VISUAL BasiC? L

-

Caplion; |Em I r'lom l

CHiName: lFichem ] | Cancell

Index: I:I Accelerator: [[none] ,il}l“'

[ Checked 5 Enabled [ visible N‘ o

[e]o]¢]o] [ memt 1| tnsen J[ vetetc’]

----&AbIg

---kGuaidar '
-~ &lmprimiy
- §Saln

LEdicidn
-Chorlar
---kCopias
---kPegar

Para resaliar la letra que da acceso al mend se inserta un ampersand (&) antes
de la misma. El usuario podrd seleccionar este mend pulsando la tecla Alt y la
tecla correspondiente a fa letra resahada, la Cual aparece submyudaJ También’
puede realizar 1a seleccién utilizando el ratén. '

COLORES

Visual Basic permite también afadir colores a los objetos. La puleta de colores
ofrece 48 calores estindar. También se pueden definir colores JdlLIOIIdlCS pulsan-
du ¢l botdn Custom Colors >> que dpdl’t.u_ en lu ventana gue se pn.s:.ma a conli-

nuacion.

I, Muestra ¢l cobor actual del primer plano (cuadrado interno) y el|color de
fondo (cuadrado externu).

2. Muesira el color del wexto.
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3. Pone ol objeto seleccionado, los colores utilizados por defecto por Visual Ba-
SIC.

UTILIZANDO LA AYUDA

Visual Basic siene instalada una avuda e’n ILnea que da informacion acerca de
propiedades. sucesos, mensajes de error); s¢ftencias, teclado. depurador. inter-
cambio dindmico de datos v entomo de Visual Basic.

Para obtener ayuda, puede utilizar el indice proporcionado por ¢l meni Help
de la barra de mends de Visual Basic, o puede seleccionar el elemento deseado en
¢l entorne de Visual Basic v pulsar F1.

E“c |“ .Ed"“ Bﬂnimalt.iﬂe l.‘-' P Sy .
Contenls Lieach I Back ] Hu;olLI £<
&~

Til Visual Basic Help

i ating An Apohicsinan

Sieps o build an application.
Auc,.u.ai Bazig nedsce Guide to windows and 1ools.

. sommands Refsrence 1o menu commands

. and dialog boxes.

Step-by-slep instructions.
Reference 1o ohjects. proparias.
events, and methods. Includes
cods exainples.

Qe arnaning b D Reterence to Visual Basic
functions, slatements, methods,
and other components of the
language. Incudes code

examples.
Tahle of useful key combinations
oo Lilwspye . ' .Guida 1a the lcon Library.

Cuando esté dentro de Ja avuda, - ...

« utidice 1a orden Search para buscar un rmine o una palabra clave del len-
gu

CAPITULO 1, QVE ES VISUAL BaSIC? |3

+ haga clic sobre una frase o palabra subrayada para ver la ayuda refereme a la
misma. o
» haga clic sobre una palubra subrayada con trazos discontinuos para ver su de-

linicidn,

: It .
Cuando se visualice un mensaje y desee ayvuda sobre el migmo. pulse FIL

it
ol

Cuando esté dentro de 1a ventana de eédigo. seleccione una ﬁalabm del len-
auaje vopulse F1 para obiencr ayuda sobre 1a nisma. B :

Para obtener ayuda sobre un mend o una herramieata’ de” Visual Basic,
seleccidneta y pulse F1. v

INSTALACION DE VISUAL BASIC ‘

Antes de instalar Visual Basic compruche que su erdenador cumple los reguisitos

minimos. Visual Basic para Windows 3.0 o postenor. corre ¢n modo esidodar

(286} 0 en modo extendido (386). Los requerimientos bidsicos son:

*  Unordenador con microprocesador 80286 v superior,

«  Undisco duro.

+ Unrtén

e Una placa de video CGA. EGA, VGA, 8514, Hércules. o compatibles (se re-
comienda EGA o superior),

¢  MS-DOS versidn 3.1 o superior.

¢ Wipdows version 3.0 v superior.

« | Mb de memoria o mis.
Tumbién se recomienda leer ¢l fichero README.TXT.

Siosu sistema cumple 1os requerimientos minimos, puede comenzar a instalar
Visual Basic. La instalacion puede realizarse desde Windows o desde MS-DOS.

Instalacion desde Windows

k. Insere ¢l disco | en fu unidad A.
2. Active el administrador de archivos y ejecute la orden Ejecut un} del
mend Archivo (File),
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3. Escribaen la caja de texto asetup

1. A continuacién siga las instrucciones dadas en b p.ml.l“a

Instalacion desde MS-DOS

1. lnsene el disco | en Ja unidad A. '
[1 P
b R
2. Escriba a: Lo
Escriba win selup

3 -
4. A continuacién siga las mstruccnones dadas en la pantalla.

ARRANCANDO Visual Basic

Visual Basic se puede arrancar desde Windows o desde \IS DOS.

Arranque desde Windows

1. Active el administrador de archivos y ejecute la orden Ejecutar (Run) del
mend Archivo (File).

2. Escriba en la caja de texto vhb

Arranque desde MS-DOS_

« FEscriba a continuacion del simbolo de sistema win vh

Opciones de la orden vb

vb [[/run] fichero Ji/cmd argumentos

frun permite que se ejecute ka aplicacion Visual Basic.especificada por
Sicheru.
femd permile pasar argumentos en la linca de drdenes gue serin puestos
a disposicion de la aplicacisn Visual Basic. por la funcion
Command$.
[ Commards = T° Tnecn . .
Msg$ = "llo =€ a1 © TITENT0S

il CAPITULO 2

MI PRIMERA APLICACION

INTRODUCCION

Bienvenido a Visual Basic. un potenie paguete perteneciente o 1 nikeva genera-

cion de compiladores para el desarrotlo de aplicaciones. La progrumacion bajo
Windows con Visual Basic permite desarrollar aplicaciones para Windows o para
0572 Presentation Manager.

. . . . . | L.
Segun se ha expuesto en el capitulo anterior, Visual Basic ¢s una caja in-

mensa de utilidades y recursos puestos @ nuestra disposicion para hacer que la
programacion de cualquier aplicacion pur compleji que sea, resulie ahora mds
sencilla gque nunca y con pantallas infinitumente mejor presentadas e infuitivas.

Sin tugar a dudas el desarrolto de aplicaciones bajo Windows es una realidad,
lo cual hace suponer que el futuro dc la microprogramacion va encaminado hacia
los emornes grificos. ‘ -

Una de las caracteristicas fundamentales que diferencian a Windows de DOS
es un entorng grifico que a base de ventanas presenta al usuario en Iurm.: de obje-
toy, la mavariu de las operaciones gue se pueden realizar bajo ¢l sistema operi-
tvo. evitando asi tener que recordar drdenes y opciones que en muchos casos et
escribirlas va eran una posible fuenic de ervores. En un enomo grificofun usuanio
simplemente selecciona la wilidad mrrupundlu\lc a la trea que desea ejecutar;
el resto del irabajo lo hace ¢l sistema. '

Una de fas grandes ventgas de wabajar con Windows es que lmlaz, las venta-
nas se comportan de la misma forma y wdas las aplicaciones utilizan 10s mismos
-métodos bisicos (mends descendentes, botlounes) para introducie drdenes,
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w

Una ventana tipica de Windows tiene las sivuienies partes:

Barra de memis. Visualiza el conjunio de 1os mends disponibles para exa
aplicacion. Cuando alvuno de los mends se activa haciendo clic con el ratén
sobre su Litulo. se visualizan el conjunto de drdenes que lo forman,

LI | %, 403

=

| ite  Editry Search:

£

3 7

Mewi e conrrol. L menid de conirol proporeiona drdenes para: restaurnir a su
twano, mover, dimensionar. minimizar. maximizar v cerrar. [a ventana. In-
cluye también li orden Cambiar a... que invoca I lista de tarcas activadas,

Barra de tituto. Contiene ¢l nombre de la ventana.

Boton para minimizar ket ventana. Cuando se pulsa este botdn la ventana se
reduce a un iconu. Esta es la mejor torma de mantener las aplicaciones, cuun-
do tenemos varias de ellas activadas y no e estdn vtlizando en ese mstante.
Boion para maximizar fa ventung. Cuasndo se pulsys este boidn Ly ventana se
amphia al maximo y ¢l boton se transforma en otro con dos flechas. Si éste se
pulsa. la ventana se reduce al tanafio anterior,
Barra de desplazomiento verdeal. Cuando la informacién ne enira vertical-
mente en una ventana. Windows afade una barra de desplazantienio ventical a
la derecha de ta ventana,
Burra de desplazamienio horizontal, Cuando la intormacion no entri hori-
zonmalmente en wna ventana, Windows anade upa barra de despluzamicnin
horizontal en el fundo de 1a ventny, ° . ’

vbarma de desplazamiento tiene un cuadrado que ~e desplazaca o largo de

Ta pard indicar €n qué pusicion nos encontiainus con respecto al prinei-

o s al final de Ya informacion tratada.

7l
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Para desplazarse:

*  Lna linea vericalmente o un caricter horizontalmente, utilice las
Ifechas de fos extremos de las barras,

LTSI Cry e CArEy e 1 y \
o Vurias lincas vericalmenie o varios curucf res horizontalmente,
rulse con ¢l ratén una Necha y manienga ¢l lu1 in pulsado.

*  Aproximadamente uny pantalla completa, |I:lg&|"t‘li'¢ sobre la barra de
desplazamicnto. Para subir haga clic encima dét cuadrady de la barra
_\'cnical ¥ para bajar haga clic debajo del cuadrado. Para moverse ta
teguierda, haga clic o la izquicrda del cuadrado de 1a bara horizonta]
Y para moverse a la derecha haga clic a la derecha del cuadrado,

cli d

* Aun ugar especitico. haga clic sobre ¢l cuadrado’y manteniendo ¢l
butdn pulsado arristre e coadrado.

8. Area det uswario. Es la pane de fa ventana en la que el usuario coloca el lexto
y tos grihcos.

Un objer en general. puéde ser movido 3 otro lusar haciendo clic sobre &l y
arrastrindolo manteniendo pulsado el boton izquierdo del raton.

PROGRAMANDO BAJO WINDOWS '

La pmgmm;u:idn que realizamos bajo DOS. por cjemplo cun'QBusic difere
bastante de como se programa una aphicacion en Windows, par gjemplo ’cun Vi-
syul Basic. Un programa escrito bujo DOS es un coujunto de sentencias que se
cjecutan de arriba a abajo. mas o menos. en ¢l urden yue ¢l programador h:?d" -
nadu. Por cjemplo, i *

PRINT "2ulse ura -zcia Bara
CLS )
WH11 =
PRIET

continzer L. »

En este ejemplo lu seatencia WHILE siiplemente espera hasty que ¢l usuario
pulse uma tecla, momento en ¢k cual se pasa a la linea siguicnie Yy aparece cl‘ wn-
saje Bienvenido a QBusic. Si hubicra mids sentencias a &mlinuucid l la ejec I "id
continuaria secuencialmente. s

)

‘ qna aplicacion bajo Windows presenta iadas lus opeiones pusibles en una o
‘s formas para que el usuario Siju una de elias. Esto da lugar o an;‘ =va forma
de pensar y de progrumar. Por cjemplo. en la figura siguicﬁlu, ¢l E THIET T
haga clic sobre ¢l hoton Huga clic agui. en la caja de 1exio apir -1 mensaje
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Bienvenido a Visual Basic. Se dice entonces que 1a programacicn ¢s conducida
por sucesos y orientada a objeios.

Cuando desarrollamos una aplicacion bajo este tipo de programacion, la se-
cuencia en |3 que van a cjecwtarse las sentencias no pucde ser prevista por el pro-
gramador. Pur ejemplo, si en lugar de un boidn hubiera dos 0 mids bolones. cla-
rumente se ve que el programador no puede escribir el programa pensando que ¢l
usuario va a pulsarlos en una determinada secuencia.

Por lo tanto, para programar una aplicacién Windows hay que escribir cédigo
separado para cada objeto en general. guedando la aplicacidn dividida en peque-
fios procedimientos conducidos cada uno de ellos por un suceso. Por ¢jemplo,

Suh Oréan_Click {) .
Mensaje.Text = “Zienvenido & Visual 2wesic”
rd Sub ’

El procedimiento Orden_Click es puesto en ejecucidn por el suceso Chek y esti
ligado al objeto que hemos denominado Orden (botdn titulado "Haga clic agui”).
Por ¢éslo. esta forma de programar se¢ denomina programacion comducida por su-
cesos y orientada a objetos. Las venianas, los botones, las cajas de texto. ete., son
pira nosotros objetos que, coOmo veremos a continuacion. lienen asociado un
conjunto de datos y un cédigo.

Esta nueva forma de desarrotlar una aplicacion se apana bastante de la pro-

gramacidn bujo DOS dunde el prograna era ua solo blogue que se leis de arriby a
abajo.

DESARROLLO DE UNA APLICACION

Juntos ¥ haciéndolo ficil vamos a construir nuestra primera aplicacion. Esta wen-
drd una ventana (forma), una caja de texto v ires butoney!

CAPITULO 2 MIPRIMERA APLICACION 19

= '

Haga clc aqui o

? lSa.l'l

o

T esta aplicacion, cuando ¢l usuacio pulse el botén Huga clic aqui®, en la
Caja de texto tiene que aparecer el mensaje “Bienvenido a Visual B.I\IL cuando
pulse el botén "2 en Ta caja de texto ticne que aparecer ¢l nensaje annanlo r

y cuando pulse ¢l botdn "Salir”. la aplicacion finalizars,

Para comenzar ammancamos Vistal Basic como se indicd cn el capitubo ante-
rior. l

En generul, para construir una aplicacién siga los pasos indicados'a conti-
nuacion;
1. Cree una nueva aplicacién.
2. Mueva y ajuste el tamadio por defecto de la forma.
3. Dibuje los controles.
4. Defina ks propiedades de la forma y de los controles.
3. Escriba el cddigo para cada uno de los objetos.
6. Guarde la aplicacidn. +
1. Verifique la aplicacion,
8. Cree un fichero ejecutable.

Crear una nueva aplicacion '

Este paso se cjecuta sutomiticnente cuando se amanca Visual Bd\iL En otro

_caso, esta es, se ha finalizady con una aplicacion v se deseq cmpezar olra nueva,

cjecutaremos la orden New Project del menii File.
1
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Una aplicacion Visual Basic puede estar formada por tres clases dz ficheros:
formas, madulos. y un modulo global. Una forma es un lichero que coatiene ob-
jeros grificos, llamados controles. mis cddigo, mientras gue un mddulo contiene
sulamente cddigo.

En este momemo ¢n ¢l centro de 1a pantalla hay una ventana tilada Furml.
Visual Basic denomina a las ventanas oru'as. Observe cdmo la forma tiene algu-
nos'de los elemmentos comunes a las"veplanas de Windows descritas anierior-
mente. L . ’

Mover y ajustar el tamaiio-de la forma

L.a forma es el plano de fondo para los controles. Se puedce cambiar el tamuio v la
sttuacidn de Ya misma utilizando el rutdn. Para cambiar el wmafio apunie con ¢l
ratén a uno de los lados o a una de las esquinas de la forma, y cuando ¢l puntero
cambie a una lecha doble, con el botdn izquierdo del-ratén pulsado. armasire en el
sentido adecuado hasta conseguir el tamaio deseado.

En la figura se observa que el drea del usuario estd lena de puntos regular-
mente disinbutdos. Esios puntos formin una rejilla que nos ayudard a alincar los
controles que coloquemos demro de la lorma. Para hacer que la rejilla desaparezca
ejecutaremos la orden Grid Settings... del mend Edit y desactivaremos la opeidn
Show Grid (mostrar rejilla) haciendo chic sobre el cuadrado adjunto. Pars ninahizar
s hawe vl subre ¢l boton Ok,

Si ahona be decnnos o Viswal Basic que ejecate este progranie pars fo cusl
wndienn gue ¢ecutar Lorden Staet del meni Run, 1o wentana sin La replla apa-
te i lu pantalla v podremos actuar sabre cualyuiera de sus controles
(m. o, maninnzar, moser. ajustar ¢ tamaio, o). Esta es fa pane que Vi-

T
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sual Basic realiza por nosotros s para nosotros: pruchelo. Para finalizar dispone
de vanas posibilidades:

I, Hagaun doble clic sobre ¢l buton del mend de controlde Fornl,

[ 2*]

Active el nweni de comrol de Ja ventana Formd v ejectle Glose.
&
}*&
L
R

e

Pulse las tectas Al + F4.

=

Ejecute kvorden End del mend Run,

Dibujar los controles e

.I .
Hay dos tipos de objetos en Visual Basic: formas v controles. Los controles son
objetos grilicos gne nosotros dibujumos sobre una Torma, wles como cajas de
lexto, ‘botones, etquetas. marcos. listas y temponizadores, U'na forma es una
ventama sobre fa que nosorros diseiamos os elementos gue el usuario tiene que
utilizar para comunicarse con la aplicacion. Los elementos son los controles. esto
¢s, objetos yue permiten entrar o sabir datos. La forma mds los controles forman
L interfaz o medio de comunicacion. : )

Si usted esti familiurizado con la programacion orientads a objetos. recordard
Que un objeto no solamenie tiene asociado datws, sino tuinbién procedimientos.
Ea C+, estos procedimicntos reciben ¢l nombre de funciones miembro. En otros
lenguajes, como en Visual Basic. reciben el nombre de métondos.

Para aiadir un.control a una forma utilizaremos ¢l panel de wilidades. Cada
utilidad del panei crea un dnico control. La figura siguicnie muesira este pine].

-

Puniero Lagen

Etiguets Capade texio

r .
Marco — —  Botin
Senal — ——  Opeion
Combinado — —  Lista

Barra de desplazamicnis b, Barra de desplazamiento v,

Femporizador Listi e unidades de disco

SRR
Wi E=@®C|E

Lista de directorios Lista de licher
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El puntero se utihiza para manipular los controles existentes sobre fa forma.
Con ¢l puntero se puede seleccionar, mover y ajustas ¢l tumafio de los objetos.

Una caja de imagen se uliliza cuando queremos visualizar una imagen gue
nosotros dibujamos utilizando cédigo p que importamos de algun fichero.

LUiilizaremos una etiguete cuand qt,eramos un fexto, de una o mids lineas,
que no pueda ser modificado por el usuano Una etiqueta se unliza para dar ins-
trucciones al usuario.

Una caja de texio es un drea dentro de la forma en 1 que el usuario puede es-
cribir o visualizar (exeo.

Un marco se utiliza para realzar el aspecto de b forma. A veces utilizamos
Jos marcos para agrupar los objetos relacionados entre si. Los marcos tienen pro-

piedades propias como, por ejemplo, color.

En boton tiene asociada una orden con ¢1. Esta orden se ejecutard cuundo el
usuario haga clic sobre ¢ botdn,

Una seiial se utiliza para seleccionar una opeidn, De esta forma se pueden
seleccionar vanas opeiones de un grug...

El comrol opeion se utiliza para seleccionar una opcidn de entre varias. De
esta forma solo se puede seleccionar una opeion de un grupo de ellas.

El control combinade combing una caja de 1exI0 y una hsia.

El contrul fista contiene una lista enrollable de la gue el usuario puede selec-
cionar un elemento.

La barru de desplazamiente horizondel permite desplazar Ly informacion de
una caja hacia la izquierda o hacia la derecha.

La barra de desplazaniento vertical permite desplazar Ta informacion de una
caja hacia arriba o hacia abajo.

El temporizador penmite activar procesos a intervalos regulares de tiempo.

Lo tista de wnddades de disco se utiliza para visualgzar fa lista Je unidades
disponibles. con ¢l fin de seleccionar una,
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La listu de directovios se utiliza para visuahzar los directonios|a los que el
usuario puede moverse.
i

La lista de ficheros se utiliza para visualizar los fichgros de un|determinado
direciono a los que ¢l usvano puede acceder, N
. |I* *
Siguiendo con nuestra aphicacidn, seleccionados del angl de utilidades que
acabamos de describir. Yos controles que vamos a utilizar.:kn ‘prumr lugar vamos
a crear una caja de fexto. Para ello. hacemos un duble Lln. sobre la ullllddd caja de
texo. y vemos como en el centso de la forma aparece una-caja de texto de un ta-
mano predefinido, segdn se muestra en la figura sigviente.”
.

Observe que en la barra de propiedades. comenada en el capitulo anterior, se
visualiza la propiedud CtName (nombre del conuol) que tiene usinr{adu el valor
Text! que es ¢l nombre dado al control por defecto. EI nombre duil contzol se
utiliza para referimos al control en nuesiro programa. )

-

Tamhu.n se abserva sobre la _caju de texto ocho cuadrados pequeiios de color
negro que reciben ¢l nombre de modificadores de tnmeaio. los cuales permilen
muoditicar el tamano de Yos controles que estamos disenando. Para jmndlﬁc:ar el
tamaiio de un control, primero seleccidnelo hiwiendo clic sobre €I, dcs!pués apunte
con el rutén a alguno de los modihicadores de wmano, observe que 'aparece una
doble flecha, entonces, con ¢l botén izquicrdo del rién pulsado arrastre en el
sentido que desee ajustar el tamafo.

También puede mover el control a un lugar deseado deniro de falforma. Para
mover un control, primero seleccidnelo haciendo clic sobre él v dc‘ipués apunte
con el ratén a alguna zona perencciente al mismo v con ¢l bowin |zqu1crdu del

riaton pubsado arraswre hasia situarlo en el lugar deseado. ,
i .

4

H - =
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Ahora ajuste el tanvado de 1a caja de teato y mudévala para yue se corresponda
con la figura que se presenta a continuacion.

= on

( Text)

o

-,
-
T

Borrar un control

Para borrar un conirol. primero ¢ selecciona haciendo clic sobre ¢l v a continua-
cion se pubsa la tecka Del (Supri. Para borrar dos o mids controles primero
seleccidnelos haciendo clic sobre cada uno de ellos al mismo tempo que mantiene
pulsada hi ecla Cirl, y después pulse Del.

Propiedades de los objetos

Cada tipo de objeto tiene ciertas propiedades como titulo, nombre, color, ete. Las
propiedades de un objeto representan ludo: los daws que por definicion esiin
asociados con ese vbjeto,

Para cambiar las propiedades Je un objeto lenemos gue utilizar fa baera de
propicdades que se muestra en ba Bgura sizuiente v que se correspunde con la ba-
rrit que estid debajo de la barra de mends. En esta figura se observa en la fista de la

“izquierda las propiedades de la fonma ttulsda Form .

— |-

ike™ Edity Code’ Rua' Windew  Help -

Caption L) i ! IFa-l
*
Contioth ox
Diswbode
De~=Siyrla )
Hh N
1 1
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Cuando se selecciona un objeto puede verse 13 lista eniera de propiedades,
haciendo clic sobre Ya Mecha de la Bara de propicdades situada a Ta derecha de
Caption {ver figura antcrior). .

‘

Algunas propiedades son comuncs a varios objelos y (krag son tinicas para un
objeto determinado. Por ejemplo. la propicdad Caption giitelo) la tienen vanios
objetos. pero 13 propiedad Interval sélo la ticne ¢l lunpmﬂudﬂr.

Cada propiedad de uin objeto tiene un vator por deLLlU que puede ser modifi-
cado si se desea. Por ejemplo. b propicdad Caption de 1.1 hmna del ejemplo que

nus ocupa tiene el valor Forml.

o

Para verificar ¢l valor de una determinada propicdad correspondiente a varnios
ohjetos, se seleceioni ésta en la harra de propiedades para uno de ellos, y a conti-
nuacin se pasa de un objeto al siguiente haciendo clic con ¢l raton sobre cada
ubjeto. o simplemente pulsando Latecla Tab,

Para cambiur ¢l valor de una propiedad de un objeto siga los pasos indicados
a contingacion:

. Seleccione e objeto. Para ello. haga clic subre ¢l ubjeto o pulse sucesiva-
mente la tecls Tab hasta que esté seleccionado. Un conteod seleccionado apa-
rece radeado por los modilicadores de tamano y una fornu seleccionada
cambia ¢l color de fondo del tilo.

2. Seleccione de Ta dista de propiedades la propiedad que desea cambiar.

3. Modifigque el valor gue actualimenie ticne la propiedad seleccionada. E} valor
actual de ta propiedad seleccionada pucede verse en la taja de la bama de pro-
piedades, silada a continuacion de la caju de propiedades. Para cambiar el
valor escriba directamente sobre la caja que presenta el valor actual o. si es
pusible, seleccione uno de B lista que se despliega haciendo chic sobre la Ne-

_cha gue aparece a la derecha de esta caja. Para algunas propiedades. esta fle-
cha es sustituida por tres puntos (...). En este ciaso se visualizard un cuadro de
didlogo. ' :

Otra forma de modificar una propiedad es durante 1a ejecucién de ta aplica-
cidp. Esw implica anadir ¢l cédigo necesario al procedimiento que deba realizar
la modificacion,

Sizuiendo cun nuestro ejemple vamos a cambiar el titulo F- f de la forma,
por el titulo Mi primere aplicaciin. Pata ello, seleccione T [ *a continua-
cién la propiedud Caption ¢n la lista de propiedady . Despuc dese en la se-
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gunda caja de la barra de propicdades haciendo clic sobre ella. v sobrescriba el
"texto "Form|1” con el texto "Mi pnmera aplicacion”: finafice Ja operacion hacien-
do clic sobre 4 o putsando Enter.

Veamos ahora las propiedades de la caja de texto. Seleccione la caja de weato

“y'despliegue la lista de propiedades como se ha descriio anterionnente. Algunas
de estas propiedades son BackCulorL colpr del fondo de la caja de texto): Ct-
Name (nombre dado a la caja de texorpara referimos a ctla en el codigay y Text
(comtenido inicial de la caja de texto).

Siguiendo los pasos descritos ari'leﬁprmente, cambie ¢l valor actual de ta
propicdad CtlName al valor Mensaje y-el valor Texi! de la propiedad Text a
nada (esto es borre Textl). A continuacion vamos a cambiar el color de tondo de
la caja de texto, Para ello, seleccione la propiedad BackColor de la lista de pro-
piedades, pulse el botdn {...} situado a la derecha de l1a segunda caja de la barra de
propiedades, elija como color de fondo (ver colores en el capitulo anterior) el
quinto color de la tercera linea y cierre la veniana de colores (Alt+F4).

El resuliado se muesira en la figura siguiente.

= -]-]
L |

Nuesiro paso siguiente es afadir los controles que nos faltan. Recordando ¢l
enunciado de la aplicacién. tenemos gue agregar tres botones de drdenes.

Para anadir el botén primero. hacemos un doble clic sobre la utilidad botén
del panel de utilidades. Observamos gue en ¢l centro de fa forma aparece un bo-
ton tilulade Commandl. Vuelva unas hojas ateds en exte mismo capitulo y iire
come tienen que uedar Ninalmente 1a forma + Jos controles. Mueva el boton y
JJUSTE U BHRAAG PaEd conse s los anismos resudtados a s que seabamaos de ha-
cer relerencia. Ahora moditigue las propiedades y asigne a Caplion (tlslo) el
vator Haga clic aqui; y a CtiName (nombrey el valor Ordend. Siguiendo los

mismos pasos, afada los botones que quedan y asigneles lus propiedades indica-
das en el cuadro que se presenta a continuacion.

Caption
Boton sezundo 1
Botén tercero Salir

[ Haga chc aqui
- ? S ali :
Unir codigo a los objetos -

Sabemos yue el nombre de un objeto (C1IName) nos permite referimos a él den-
tro del codigo de un programa. Por ejemplo, a la cuja de exto se le|ha dado el

nombre Mensaje. Pues bien, para poder asignar dentro de un procedimiento el
|

-vilur Bienvenido a Visual Basic a la propiedad Text del objeto Mensaje ¢.cnbi-
|

remaos,
Mensaje.TexT = "Bienvenido a Visval Basic*

En otras palabras, la forma genera! en Visual Basic de referirse a una
propiedad de un determinado vbjeto es. )

Objeto. Propiedad
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donde Objeto es el nombre (CUName) del objzio. forma 0 controd, que tiene esa
propiedad y Propiedud e5 ¢l nombre de la propiedad del mising.

Una vez que hemos creado ia interfaz o medio de comunicacion eatre la
aplicacion y el usvario. tenemos que wnir el codigo correspondiente a cada uno de
los objetos para hacer que la aplicacion fesponda a las acciones del usvarnio.

Como usted sabe. una aplicacién brﬁjo'."l_h'indows es conducida por sucesos v
orientada a objetos. Es10 significa que nosatros ligamos el codigo escrito pard un
determinado objeto a un suceso que puede ocurrir sobre dicho objeto. de tal forma
gue cuando ocurra ¢l suceso, dicho cﬁgiigp se gjecute. Por ello, la umdad qgue
agrupa ese cddigo recibe el nombre de procédimienio conducido por un suceso.

Mientras disedanios un programa. para ver los posibles sucesos que se
pueden asociar con un objeto se hace un doble clic sobre ¢l objelo. Aparece
entonces una nueva ventana, Hamada venrana de cddigo, como se mmestra en la
Aigura siguiente.

Object: [Qidenl T#] Proc: [Click B

Sub Ovdeni_Click ()

End Sub

l.a ventana de codigo tiene un esquema para cada procedimiento conducido
por un suceso. La figura anterior presenta el esquema para el procedimiento Or-
denl_Click conducido por el suceso Click. En ouras palabras, el nombre del pro-
. cedimiento Orden!_Click indica que ese procedimiento condin -+ - . ¢l suceso
Click estd conectado con ¢l bowdn Orden!, y que serd ejecutind.. . . USLUND
haga clic en dicho boién. Esto es excepeionalmente mancjable poi dus razones:
una ¢s gue el cddigo queda unido al objeto y la otra es que Ta ventana de codigo
indica qué clase Je suceso liene que ocurrir para que se ejecute ¢l codigo.

Ademads del suceso Click. hay otros sucesos asociados con un botén de orde-
nes. Observe en Ju figura siguiente, en la caja de procedimientos {Proc:). 1os su-
cesos gue se pueden dar para el objeto panicular Ordend. <

“stinguir visualmente qué sucesos estdn asociados y cuales no, Visuul
Basic pr...c en negrita los sucesos de la lista que vayamos asociando,
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.

—_— - - I
Object: [Oident 1#] Proc: [Click ¢

L b
Sub Orden1_Click () Cuagluon +

Dragidve ' |
End Sub GotFoacns i .

¥ eyl rwary 13

¥ epPrecs ML |

Fepblp b G

LiaF oous ‘

hd

e
En la vemana de eddigo tambhidn pndL:mus ver. en la caja de objetos (Object:).
fa lista de odos fos objetos pertenccientes a la forma sobre i que estamos traba-
jJando. Para ver el procediniento asociado a cualquiera de cllos. haga clic sobre su
nombye.

I ||

Object: {Oidenl I_g ‘Pioc: {Click Lq
(geneial}

Sub OrdiFoim +
Mensaje

End Sub
iden2
Oiden3

o-ll o [+

Observe a lista, en ella estan los nombres de la caja de exto (Mensaje). de los
botones de érdenes (Crdent, Orvden2, Ordend), v ¢l nombre de la forma (Forn).
Quiere esto decir que también hay varios sucesos que pucden ocurtir con la forma.
Pur ejemiplo Load; cuando una fonna es unlizada por un programa por primera
vez, déste considera antomdticunente gue ha ocurndo el suceso Load v ejecuta el
procedimiento Form_Load. Adeids de los objetos mencionados hay -viro objeto
(general) que es anadido por Visual Basic. En la caja de cddigo asociada con este
objeto detiniremos las variables y constantes comunes a todos los procediniientos.

+

Sigamos con nuestro cjemplo y pensemos la Tuncion que tiene que reabizar
cada uno de los controles. La caja de exto tiene gue visuahizar el jexto que se
envia cuando se pulsa el botén primero o el segundo. Quiere esto Fue como
tal ubjeto, no fleva codigo asociadu.
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Cuando el usuario haga clic sobre el botén Haga clic ayui. tene que

visualizarse en la caju de texto el mensaje “Bienvenido a Visual Basic”. Por lo

tanto el procedimiento asociado con este gbjeto e

Sub Oréenl_Clicx ()
Mentaje.Text = "Iiernarnildo z
=nd Sub :l .

iHaga dable clic en el botén Haga clic agui v escriba el cuerpo de este proce-
dimiento en la ventana de cédigo presenada. Proceda de la misma forma para
cada uno de los otros dos bolones.

Cuando el usuario haga clic sobre ¢l botén . tiene que visnalizarse en la caja
de texto el mensaje ";Contento™. Por lo tanto ¢] procedimiento asociado con csle
ohjeto es: .

Sub Orcen2_Click ()
Mensaje - Text = *:Conzzrzoz"
End Sub

Cuando el usuario haga clic sobre el botdn Salir, tiene que finalizar la aplica-
cién. Por lo tanto el procedimicnto asociado con esie objero es:

Sub Orden3_Click (}
End
End Sub

Observe que al escribir el codigo se ha reatizado una dentacion o sangrado en
las lineas (puede hacerlo con espacios ¢n blanco o con tabulaciones). Esta denta-
cion efectuada no es obligatoria pero ¢s una buena prictica en programacion, ya
que de esta forma se consiguen programas mis ficiles de entender. La dentacidn
o sangrado se efeciia sobre un grupo de sentencias para indicar su pertenencia a
olra sentencia,

Guardar la aplicacion

Una vez Linalizado el desarrollo de la aplicacion se debe evardar en el disco para
que pueda ener continuidad: por ejemiplo st mds adelame se quiere modilicar.
Para ¢llo, ejecute la orden Save Project del mend File v asigne un nombre de fi-
chero a la forma y al prosecto cuando le sean solicitados.

Si observamos el mend File no< encontrames ademds de con la urden Save
Project. con tres ordenes mis: Save Project As.... Save File, y Save File As..;
unmbién hay otra orden Save Text en ¢! mend Code,

CAPIHTUTO 2 A1 PRIMER A APLICACION 31

cutar {a orden Start det mend Run o pulsar F3.

La orden Save Project guarda en el disco 1odos los ficheros asociados con la
aplicacion actual, en formato binario. La orden Save Project As... nos permite
guardar la aplicacion en el disco con oo nombre. Esn es dil, por cjemplo,
cuando a partir de una aplicacion existente realizamos otra.

|

¥
. la forma 0 médulo
% 14 misma operacion
y ademis nos permite cambiar el nombre. lo cual es il (_uandu la forma o ¢l mo-
dulo ya existen.

La orden Save File guarda en el disco. en formato bing
actusimente seleceionada/o v la orden Save File As... real

La orden Save Text penmite guardar en ¢l disco. en le\m mnnml todos los
ficheros yue componen ki aplicacion. Esto s il coando queramos \lmllmr otro
procesador de textos distinw al de Visual Basic, especialmente cuando el cédigo
gue eslamos escribiendo ey demasiado largo y no estd directamente ligado a la
E/S. Esta cs también la mejor forma de importar o de exporlar iexiy escrito bajo

QuickBusic, QBusic, o GW-Basic.

No ¢s conveniente gue utilice los nombres que Visual Busic [asigna por
defecto, porque pueden ser Ficilmente sobrescritos al suardar d.p]l(_.u.]()ngs poste-
riores.

Verificar la aplicacién

Para ver como se gjecuta la aplicacion vy los resultados que produce, hay que‘eje-

5i durante la ejecucion encuentra problemas o la solucién no es satisfactoria ¥
no es capaz de solucionarlos por sus propios medios. puede utilizar I"u‘nd.uncntal-
meate las Ordenes Single Step (F8). Procedure Siep {blnlt+!~8) Toggle
Breakpoint (F9), 1odas ellas del meni Run, y la orden Immediate Window del
ment Window.

l.a orden Single Step permite ejecutar cada procedimiento de ta aplicacion
paso a paso. Esta modalidad se sctiva y se continga pulsando F8. Si no quiere que
los procedimientos y funciones se cjecuten linea a lizea, sino de una sola ve,
utifice las teclas Shift+F8 1Procedure Step). Cadi vec que el pmbr‘u'm estd de-
tenidg puede ver en la ventana inmediata los vilores €. tienen las variubles,

La orden Togpgle Breakpoint permite colocar un sunto de parada (stop) en
cualguier linca. Esto permite ejecutar Ya aplicacion fea el punto de pamda sin
pausa (F3), y ver ea la ventang inmediata los \..llUI'L\ % las vaniables en ese ins-
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tante. Para poner o quitar una pausa, s coloca el cursor en et Jugur donde vaa te-
ner o tiene Jugar la pausa v se pulsa F9.

La orden Immediate \Windoaw abre una vertana donde podemos éjecutar de
una furma inmediati cualquier sentencia. Por ejemplo.

LN

El resultado seri el contenido de esta Variable.

Cuando se pulsa la tecla F3. la ejeciicion continua desde la dltima sepencia
ejecutada en un procedimiento hasta finalizar ese procedimiento o hasta un punto
de parada.

Crear un fichero ejecutable

Una vez que la aplicacién tiene el aspecto deseuble y que su ejecucion transcurre
satisfactoriamente, se puede crear un fichero ejecutable que permita ejecutar dicha
aplicacién fuera del entorno de Visual Basic.

Para guardar 1a aplicacién como un fichero ejecutable, ejecute la orden Make
EXE File... del meni File. Un tichero de este tipo requiere Windows v el fichero
VBRUNI10(.DL.L para poder ejecuiarse.

Si el fichero .EXE se guarda en otro directorio distinto de VB (Visual Basic).
fiene que guardar también en ¢l mismo directorio una copia del tichero
VRUNI100.DLL. Este fichero se encuentra en ¢l directorio VB.

Cambio de propiedades en ejecucion

Supongamos ahora que necesitamos realizar alguntas modificaciones sobre nuestra
anterior aplicacién. Por ejemplo. nos hemos dudo cuenta de que cuando se visuil-
liza un mensaje, el usuario puede destruirlo escribiendo sin mas. sobre la caja de
eato, y deseamos gue esto no suceda.

Una de los sucesos que se pueden dar sobre una ¢ija de texto es gue su con-
tenido sea modificado al intentar escribir el usvario ¢n Ja propia caja de tento.
Cuundo ¢sto ocurre se sctiva el procedimiento correspondiente ul suceso Chunge
{cambiary >i es que se ha escrito para este control, .z

nuesira caja de teato se Hlama Mensaje. el procedimiento que se ejecuta
es Me...ge_Change. Entonees, 1o que hay que hacer es interceptar el inlento de

CAPITULO 2: M1PRIMERN APLICACION 33

cambio del contenido dé 1a caja de testo. anadiendo ¢l codigo correspondiente a
este procedimiento, Ui posible solucion se muestra en o Ngora siguicote.

Object: IMemaie I_!_l Proc: lchange ! I BJ
Sub Hensaje_Change () ﬁtu T +
Ordeni.Caption = “Restaurar Hsg" N
End Sub S
s
.i‘l% . .-' - l"

Haciendo doble clic sobre la caja de texio se visualizat fa ventana de cidico
para este control. En elli se observa que uno de los sucesos que se pueden dar es
Change coma va se ha dicho anteniormente. Nosotros hemos completado ¢l pro-
cedimiento Mensaje_Change con la sentencia.

Ordenl .Caption = "Fesiairar Msg®

Esta seniencia lo que hace es cambiar el ttulo Haga clic aqui del batdn pri-
mero por el tiwalo Restaurar Msg. Esto sucederd siempre gue ¢l usuario intente
cambiar ¢l contenido de la caja de texto. y con ¢llo se advierte al usuario gue res-
taure el mensaje. Para gue ¢l bodn primero, uaa ves restaurado ef mensaje, vuel-
vi a adyquiric su titulo inicial. wadremos que moditicar ¢l procedimiento ligado al
mistno de la torma siguienie:

Sub Ordeni_Click
Mensaje.Texe = "31
Ordenl .Caprion = "Ha

End Sub

arido a Visual Basie®
a cilc acui” -

Ejecute el programy v observe como cada vez que intema ¢scrihir sobre la
caja de texto se ejecuta el procedimiento Mensaje_Change. Ahora pulse el bolén
? y swrpréndase de que tambidn se ejecuta ¢ procediniento Mensaje_Change.
Esto le eisefia que cada vez que ¢l contenido de una caja de texto se muodifique,
se ejecutard el suceso Clanye asociado o lu misma.
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LooAbrr b ventana de divedio de memis 3 Menu Design Window s Pura ello) se-
leccione La formea paea I gue desea erear el mend v o continuacidn ejecute la

orden Menu Design Window delena Window.

Yo rodueie datoy en B vensana. En 12 cajade o Caplion se ewcribwe ¢l nom-
bre deb menn yue se desea crear, edeuad aparecend en b harma de mends, Inverte
un ampersand (&3 zntes de la lerd L;"L.ll' daacceso b meni. Bl usuario podrd
seleccionar este mend pulsando la tecla™ AN mds Ltechn gue da scceso al mend,

L cual aparece subrasada,

Lo b caga de evto CiXame'se eserbe el nombre unlizado en el codizo

pard relerirse al mena.

A contimucion, pacaereas ¢ mend expeaiticado e la caga Caption, haga
clic en el botdn Neat o pulse Enter. Poc ejemplo. en la Dgwa siguiente Fi-

chevo s Bdivion son memis.

] [ pone ]
1 [ cancet |

Caplion: [&G uaidar

CtiName: ,rFicheloG uarda

Index. [ | Accelesator: | [none) [+}
[ Checked Enabled C] Visible
[ef2] el o] [ net J{ tnsen ][ oetee |
tFicheto

- bAbiis

- LMismo nombie
........ 80t nombie

Cul+S

<o &S abu
Lt chicion
- Cosat
c-Cokpas
- &Pegarl : -
§ |Fhuente

L nedueir by drdones g componen cbinonis b Becaga de tesi Capion we

LAl 1o CaName <o esenbe ol

ewcnibe el nomiine de borden yoen o
nombie wilizado encel codigo parireten~ wdicha orden, Por cjempla. en b

Breuninterion Abrir es i orden.
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3, 5 .- o R . . . N

Para diferenciar una orden de un mend Jel propio men. hay que sanerar
o dentar By orden. Pari sangrae una orden ~cleceioneli v haea clic en ol boton
Hecha hacia Y derechia (-,

Despues de v orden. ~¢ pocede afadin oirs arden o hilw.;n_ GO e i,
) t
L Crear un submeni Puede crear un submeat ~angtando qlb_‘.n arden debajo de
ot orden. Par epemplan en L Ngui antenion Guordar es an siabinend.

5. Adiadir una Bnea de separacion. Ulizanda e de e paracion pucde azrg-
par las Srdenes cn funcion de su actisidad. Paca crear wina linda de SCpalacion
escribaun dico 2uion - en fa caju Caption de L venana de diseiih de Hie-
mis. Ticne que especiticar tanbicn un pontie Cllil'(lllili‘l'll (CtNamey. Por
ciemplos e b izt antenior se ha creado ni Linea de separcion '.mllc.\ de fu

orden Safir

6. Cerrar la ventuna de diserio de memis, Una s que Doy Dnalizado el diseiio
pulse Ltecla Done y obwerve como en i bara de ments de 1 turnna apare-
cen los ments diseiiados.

Guarde la aplicacién v cjecutindola (F51 o no. b che sobre cualguier
mend v ose sorprenderd al ver cono e desplicen, Logicamente. 1oy drdenes
que componen cadie e no estiein operaivas hast o iz el L’t';diuu Co-
nespondiente., : )

5 _ B

| - i o 1
Para definir como debe responder cada onden de un mend sl suceso Click

hay que escribir un procedimicnto para Cada inande elas, Lis Grdenes de un mend
s6lo respunden al suceso Click. Pon ciemplo. a comtigaacion se muestia el pro-
AN
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cedimiento para Ly orden Salir del mend Fichero que se visualiza en la fizurs an-
teriorn, cuvo nombre de contral (CtiName) es FicheroSalir.

Para crear un procedimiento para una‘_.“prden de un ment, haga clic sobre ¢l
ment y a continuacion haga clic sobre k-orden. Observe que se visualiza el es-
quema del procedimiento, lo que le permite escribir el mismo.

Otra furma de realizar este proceso os la siguiente:

1. Para abrir la ventana de eddigo ejecute ha orden View Code del memi Code o

pulse F7.
3 Seleccione el nombre del conrol en 1a caja Object.

3. Escriba el cédigo enire Sub y End Sub.

Propiédades de un menu

Las propiedades que pueden seleccionarse en la ventana de disefio de mends son
Accelerator. Checked, Enabled, Visible ¢ Index.

La propiedud Aceelerator permite definic una tecla o combinacion de 1eclas
para ejecutar una orden. Las combinaciones vilidas son Ctrl+A a Ctel+Z, F1 a
Fi2, Ciri+Fl a Ciel+F12, Shift+F1 a4 Shift+F12 y  Corl4Shilt+F1 o
Ctrl+Shift+F12. Por ejemplo. abra la ventuna de diseno de mends. seleccione fa
orden Sufir y elija para la propiedad Accelerator fa combinacisn Ctrl+y, Cierre
la ventuna de diseio de mends y ejecute la aplicacion. Compruebe como al pulsur
Ctrl+8 se cjecuta fa viden Salir,

La propiedad Checked es dnl para indicar sy uia orden eski activa v no o
estd. Cuando se especilica esta propicdad aparece una miarca ¥ a La izguicida del
clemiento del mend. Por ejemplo, puede wilizar esta propiedad en el meai Freente
de la figura anterior para especilivar el tipo de letra gue estd aclive,

La propredad Enabled es anil para desactivar ana orden en un momento en el
cual e tiene sentidu gue esté active, Por ejemplo, st estamos inhajando con un
editor v no wnemos seleccionado un blogue de teato, no tiene sentido que Laoore
den v del meni Edicion esté activa, Cuando se liace clic en una orden de un
men. seni vjecutada st su propiedad Enabled estd sequdada. 8ila propiedad
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Enabled no esti seialada, la orden se muestra en tono gris ¥ no pucde ser ejecu-
tada.

La propiedad Visthle ¢s duil cuando en tiemgnr de ejecucion se desea ocultar
una orden. Cuando esta propicdad no estd sefialada, B orden fo aparece y por Lo
tanto no pucde ejecutarse. ; K

|
) : . .

La propicdad Index permite que un conjunio de drdenes'sein agrupadas cn
un armay de controles. Cuzndo un usuario selecciona una ofden de un array de
controles. Visual Basic utifiza ¢l valor Index para identificar qué orden del array
fue seleccionada,  ~ KR

CAJA DE TEXTO CON MULTIPLES LINEAS

Un editor de textos parece a simple vista wna aplicacion muy complicada. pero
ahora veremos que noes asi. Visual Basic tiene mecanismos de entrada gue hicen
suthamente sencillas aplicaciones como xti. .

Liilizando via definicidn sencila, un editor de textos es una caja de 1exio con
mdltiples lincas, y Visual Basic soporia este tipo de cajis.

El aspecto y el comportamicnto de una caja de texto estd altimente influenciado
por dus propicdades, Multiline y ScroliBars.

[=-1

linea 05 . b4
linea (6 '-|
linea 07 .
linea 08 : '

linea 09 “J
linea 10
finea 11
linea 12
linea 13
linea 13

RN | -

Para crear el editor ¢ue veinos en L fieura los pasos son my sencilios:

I. Abra una nueva fornes,
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2. Dibuje sobre ella una vaja de texto y ajdstela al tamadio que desee. Seleceione
la propiedad Text y asignelu un valor aulo.

3. Scleccione la propiedad MultiLine y asignela ¢l valor True. Esto permite es-
cribir en fa caja varias lincas de texto. Por delecto esta propiedad tiene ¢l va-
lor False 1o que indici que Ta caja de texto sélo puede comener una linca.

1. Seleccione la propiedad StrulIB.!rs y asigncla ¢l valor 3 - Both. De esta
forma, ka caja de wxio queda dotada con barras de desplazamiento honzontal
y venical. Por defecto esta propiedad tiene valor 0 lo cual indica yue no hay
barras de desplazamicnto. Un valor 1 anade a la caja de texto solamente ta ba-
rrade desplazzmiento horizontal y ui valor 2 afade a la caja de tevio sola-
mente la barra de desplazamienio horizondal. ’

Guarde T aplicacion y ejecdtela. Pruebe a escribir texto, actde sobre lus ba-
rras de desplazamiento, modilique el 1exto, inserte teo, y seleccione. bone y
mueva blogues de texto. Como podrd comprobar tudas estas operaciones ¢stin
implicitas sin esenbir nada de cédigo.

Cuando una linea de teato es mis larga de 1o que puede ser. automiticamente
se produce un salto a fa linea siguiente. Esta longitad no coincide con ¢l ancho de
Lo cagin de e,

También se puede anadir 1exto en ticmpo de LJLLUL]OH Por ejemple, umba
¢l procedimiento Form_Loud que se mdu.l a continuacion:

Sunp fors-__ozd ()
: v3(13}) - Cnhr3(10) ‘Caracter pui
- = *irm=a3 01t o MLS o« "Linee

Este provedimicnio hace que se visuabice en la caja dos lineas de testo.
“Linea 047 v "Linea 027, '

© Para hacer mids operative nuestro editor. vamos a adadirle las drdenes de
Cortur. Copigr. v Pegar. Estus rdenes nos permitisin scleccioniar un ealo y
desplazario dentro del mismo documento o llevarlo @ otro documente.

TRABAJAR CON TEXTO SELECCIONADO

Eacualyuier editor Je testo el usoanio puede seleccionar texto utilizande ¢l raton
ool tectudo, Con et rutdn, apunte v amastie con el botdn izquicrdo palsiado s con
¢l weeludo, sitie el cursor v manteniendo pulsada fa wely Shift gmas dsculis g des-
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UTILIZANDO EL PORTAPAPELES :

place el curser wilizando Lis weclus de desplazamienta del mismo. Visual Basic da

automaticamente estr capacidad o s cagas de tevta, Ademas de esto. lus cajas de

wxto nenen una serie de propicdades que permiten tribagar con o exib seleccio-
R R . e . . . . g N - - | 1 “

nido woravds del portapapeles (Cliphoardy. Esis pmp]cd;urs son SelStart, Sel-

» g . " 1 gy g LS 3 ) . . !
Lenght v SelText y se veficren ab blogue de tevto seleccions
- ’

i

o

Lu propiedad SelSeart e un entero gue especiticn la q’uu\mn de comicnso
del blogue de texto sebeccionado. Sioao hay texvto seieccionado, ullnmu el
prapredad hace referencia a la posicion de inserciin, Un \.n!nr cero L\I'K.thll.-l lu
posiciva justuneme antes el primer carierer de B caja de ll.‘.\ll)-_\ un valor igual a
Lt longinud ded tests especifica Ly posicion justinente dc\pl‘]éh del dlumo cargicter
de L caja de eao,

La propiedad Sellenght es on entero que especitica el imimero Je|curacteres
seleccionados.

Ea propiedad SelText oy una cadena de caracteres gue contiene ¢l lexto se-
leccionado. Sino hay texto seleccionado, su valor s nulo,

- . N . . . '
El ponapapeles es un objeto que na tiene propicdides ni sucesos, Rrosi tiene

it seric de métados (procedimicntos) que permiten transterir dato’ a y desde su
entorno, Los métodos mds vnles son SeclTent y Get'lest.

El méwoda SetText copia el texto seleccionado en el portapapeles destruyen-
do cualuier oo texto que hubiera en el nison y el métado GerText recupera ¢l
texto glmaceniado en el portapapeles. La sintayis - 0cocada oho de estos métodus
sl siguiente: '

Clipbourd.Set'Text origen
destine = Cliphuard.GetText(
Ejemplos:

Clipneoa-d.Saetiam, [exn ]l ol 7wy

Eses sentencia puarda en ol portapapeles ol esio seleccionadoen la caji do
wxlo feaalf.

Permiuioseliesy & Ol nmmgrd, o om0
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N .

. ) ) ) A continuacion cree los memds Fichero, Edicion, Faemies v Avedu. Para esie
Esta otra sentencia coge ¢l contenido del portapapeles v lo mserta en L caja

d - del s d plateamiento iniciak. suponga que o mend Fickero st lommade solo por 1 or-
e texto Teard a parvr de 1a posicion del cunsor.

den Safirs el mend Edicion por fas drdenes Cortarl Copiar v Pegar. el memi
. .. . . Fuentes por las drdenes Couwrier, Helv s Times v el mena Axvida por la wrden
Otro método il gque permite borrar toda ¢l contenide del porapapeles es

. . . o Averca de. Las propiedades para cida uno de Tos mends se respmen en la tabla si-
Clear. La sintaxis ey la sigmenie:

Lhienie. t
STH - t
Cliphoard.Clear |! A : I I
: RAEY Caption CtiName Accelerator ﬁr‘lahlud
DESARROLLO DE UN ED|TOR ‘ Fichero Mendbichero ninguie (o) Si '
Nuestra prévima aphicacion va a consistir.en el desarrollo de un editor de eatos. Salir FicheroSalir Cirl el . :,'
Este editor. aungue sus prestaciones son muy himitadas, va o servir para poner en —
practica lus menis, las cajas de teato con miltiples lineas y la unlizacion del Edicién Menalidicion fineunn Si
portapapeles. denominado Clipboard ea Visual Basic, '
’ Conar EdicidnCortar Fl No
Para camenzar vamos a disefiar 1a forma v los controles que se muestran ¢n la - B
Ngura siguicnte. Copiar ldicionCopiar 12 No
Pegar EdicidnPegar I3 Nu
Fuentes Memibuenies ninzuno Si
) Cuounier Fuente (hudex: ) 1 ninguno Si
Hely Fuente (Index: 1) | ninguno Si
Symbol Fuente (Index: 2) | npinguno Si
Ayudy MenidAyoda nnguiny - Si
= Acercad \yudaAcercabe | i Y
1 . Acerca de AyudaAcercale | minguno Si
|

En primer lugar cree una nueva forma v asigneda ¢l nombre Editor. Para el resto de Las propiedades se asume ¢l vator pur defecto.

Anudu a b forma una caja de teato, ajuste su Lamaho para formar ¢} drea de A comtnuacion escribimos ¢l cddigo comrespondiente para cada una de las or-

escritura del editor y asignela las siguientes propiedades: denes. Para visualizur la ventana de codigo para una determinada orden. haga clic
: - en el mend y despuds en la orden. A cominuacion escriba el codive entre Sub y

CtIName Teul ; End Sub. )

M ng True .

Ne. s 3 tAmbhuyy

Teat fninguRo}
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El mend Fichero solo tiene [y orden Sadie. Cuitndo esta orden se ejedute la
aplicacion Nnalizari. Por lo tanto el procedinnento es ¢l Mguicnte:

Mis adelamte, cuando leguemaos A} ngnipular ficheros. afadiremos a este
ment drdenes como Abrir Fichero vy Glardar Fichero.

El meni Edicion tiene tres drdenes Cortar, Copiar v Pegar que ntcialmente
no pueden ser ejecutadas (su propiedad, Enabled no estd seialada). Las srdenes
Cortar v Copias estarin activas cuando haya seleccionado un blogue de tenio y k
orden Pegar estani acliva cuando haya wexio en el portapapeles. Con el 1in de i
explicanda puevos conceptos. supongamos que la seleccion de eato para Corrar
y Coptar fa realizamos utidizando el teclado. esto es. pulsindo Shift+tecla (donde
techn es. «= T =, b cuyos codigos 25H. 26H. 27H y 281 se pueden ver en el fi-
chero CONSTANT.TXT de Visuad Basic). )

Seyin lo expuesto, |y condicion para activar ks drdenes Cortar v Copiar e
yue el usuariv haya seleccionado un blogue de tevto, lo que puede siaberse inter-
ceptandu las teclas gue pulsa (recuerde que cuando se pulsa una tecla se dan tres
sucesos KeyPress, KeyDown y KevUp: ver Capitslo 4). Para activar upa orden
lay que paner Ya propicdad Enabled de la misia o un valor -1y para desactivarly
aun valor 0. Todo esto puede especificanse de Ta Fora siguiente:

: 0Or ZeyCode = 17924

EHZ3) Then

icidnCortar. ¥
icidnCopiar.=n:
if

La condicion para desactisar las ocdenes Cortar y Pegar ¢s que no hiva leato
seleccionado. 1o yue puede saberse por la propiedad Seflength (longitud del
teato seleccionado) de L caja de exto.

Laorden Pegar esturd aciiva cuando v gvto en el portapapeles e To
estaid coando el paitapapeles esté vacin. Recuende que el didtodo GetTeatty del

ubjeio Clipboard desuelve como resuliado una codenat Jde camcreres ivual o su
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contenido Si Ta Tongitud de esta cadena ex 0, ¢l porapapeles estid vacio. Lsio

puede csarse de la formia siguiente:
1§ LentClipoizas = 40 inen
radicidnles
2 s !
HeldnPerar . Tnanl !
' i

R
La funcion Len da como resultado la Jongitod o ndmero de cariacteres de una

cadena, '

A continmacion agrupamuos los segmentos de cadigo :mlcriun} ¢noun prowe-
dimiento que se cjecute cada ves e el usuario jrualse wni lL‘L“;'L \_.’l,\l;l'i las lcclu'a
que utitizimos para seleccionm o blague de exto. ¢l pnu‘mh'lnu'qu) que e
bumuos ticne gue ser conducido por el sueess KeyvDown o RKeyll |).' k1 ‘.\uccm
KevDown ocuie cada ves que ¢ ustiano pubsia una teckyy ol saceso Kevlip ocu-

rre cada vez que el usuario suelia b tecta pulsada.

s onn Intecer, Shiin A
sCodo = EHZYH U Feploar =

FoyCode =

Sub Pextl
If shife =
ar F

tdicié =451
. P . . i
FEdiciond 4

#nd I1f
1{ Textl.

Fdic

vl 1f N

If Len S0 Than
Edicid ]

Flgsa -
Fdiciognzazar.fEnainlaed = 51

End 1T

Fad Sub

iLus constantes STy NO las detiniremuos a nivel de Ta foema con los valores -1
y O respectivamente.

Const St Z
Consn MO = ©

Una vez seleccionade un blogue de texta podemas copiurky o ulnlurlu. Ll

bloque resultante de esta operacion se paede ;l|lll:|CCll.ll.r e ung cadena de carie-
fes cualguicra. 0 ¢n el portapapeles. L venbig de utilizar ¢l porapapeles, es que
Gsle prennite intercambiar infonmacion entre aplicaciones que o utilicen. Bsto es.
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podemos Tevar blogues de informacion de una aphcacion a otra vtilizando las or-
denes de Conar, Coplar'y Pegar.

Cuando el usnario haga clic sobre 1a orden Cormr se cjecmard ¢l procedi-
niente asociado con clla, el cual, segdn se muestra a1 continuacion. ticne geie al-
macenar el texto seleccionado en el portapapeles v despuds borrarlo de s ventana,

ar_Click (f -
Text TexvibSelTlex:

Laorden Copiar se diferencia de I otden Cortar en gue no borra el texto se-
leccionado.

lopiar_Click ()
sa05cuTere Texil.Sel Tome

Cuando ¢l usuanio haga clic sobre lu orden Pegar ¢ ¢jecutard ¢l procedi-
micnto EdicionPegar_Click, el coal, segin se muestra a continuacion. colovard el
tentu del pomapapeles sobre €l texto seleccionado o en su detedio. a partir de ls
pasicion del cursor.

Zr2agar_Click ()
zxb = Clipboard. ez lzxzt)

Para asegurar que ¢l portapapeles esté vacio cuando amanquemos ki aplica-
cién, escribiremos el procedimicnto siguicnte:

Cuando los menis sean birgos, un detalle de gusto u tener en cuenta es no
presentar cast das s opeiones desactivanlas ten tono grist, Una sotucion mejor
o> chiminar las drdenes que menos se wilicen del mend v reemplazarlss cuando
sean necesanas. Esto se consigue poniendo Ta propiedad Visible de la orden, a
valor =1 (verdudero} o a valor O (falso).

A contimmgcion vamaos a desareollar el eodigo para ¢l mend Freertes. g
fuen®uncipes de letrae EL ndmero de Guentes disponibles en Visoat Basic varia
eh vde Yo confizuracion de su sistemi En nuestro editor solo samos ain-
cluir..  pos: Cows telvética y Symbol Para vambizr ¢l cditor de teatos i
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..

una de estas fuentes simplemente tenemos gue moshiicar la propicdad FoatName

de L caja de weato.

In una caja de tevto soliamente puede utifizarse una fuente. 1o cual sigaifica

gue cuando se modiligue el g de leica para L caja de luxl‘;. cambiari todo ¢l
|

tentoaese tipo de et
t

'
Siousted quiere unlizar diterentes tipos de kewis en ct'.'h':is!,nn documento,
tene gue utilizar el método PPrint gie se aphica o lormas y ;.{Lcuj':_i.\' de imigenes.
Esta seria La solocion pura crear un editor que adunla dil'crclits:s fipos de letras y
que pueda mamipular up texto mavor de 64K valor limie [)ill'i‘l: unu i de texto.

. . " N X -
Las ordenes del mend Puemies Torman un amay de controles denominado
Fuente (Fuentefty = Courier. Fuentegdy = Helvética v Fuente(2) = Symbaol).

Esto evita tener que escribir un procedimiento pag cinda npo de e,

Cuanda el usuario haga e en uma orden del wena Fueates. ¢l procedimiento
Fruente_Click serid invociado para sa cjecucion « recibini como salor pars Index el
indice ustgnado cuando ered este niend (0 = Courier. | = Helvética y 2 = Symbal).
Por 1o tanio. cl cuerpo del procedimiento lo dnico gue debe hacer o5 verificar qué
valor se pasa v asigiar en funcion de este valor 1 cadena de caracteres Correspon-
diente al nombre de L Tuente.

" Gymbhol

DIFTS:

A continuacion vames i sefabar (propiedid Checked) Ta foenie que esti acti-
vir. Visual Basic utiliza por defecto el tipo de fetra "Helv™. Quiere esto decir que
cuando ¢} usuario arrangue Jaaplicacion. esta es s fuente gue debe aparecer seia-
lada. Esto se puede hacer inclusendo en el procedimienio Form_fowd 1 senten-
cia Fuentet ). Checked = -1 vabriendo Ly venana de disefio de menas, eligiendo
la ordep "Helv™ v senulando Ta propicdid Cheched.

Durante la ¢jecuciim, cuandu ¢l usuario seleceione vtro tipo de letra, hay g
guitar Ju seial de donde esté s ponerli en el tipo de e seleccions “wa reali-
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.. . ) . . Lo 1. Cree una nueva Torma v ajuste su Ganaio, Ssivnela o utelo (Caption) Acer-
2ar esta operacion, deting a pivel de T forma T variable fnd para guardar ef indice s yale . - i
- . ca del Editor v el nommbre (FormName) deercabe.
del nipo de letra actual. o

12

i Dibuje los conroles sigaicntes:

Sim Ind is integs

Inicialice esta variuble en el procedimiento Form_Loud al valor del tipo de i CtiName L"-lpliunt ‘ /
letra por defecty. | | — N N |
[ .. i . . .
- . o : St . e ! Etigueta | ‘ [abell Microsdie Visual Basic
Ind = L ‘Tine ce lewra por cdaiecto Halw __ 1 Lk | g
] h
Eliguets 2 f.uabel2 Bditor & (
Por dliimo, moditiyue el proudunh.nlu Fuente_Click como se indica a conti- (. : —— - _| — _—
nuacian, s .. . ; T
oo Etigueta 3 ‘ Labeid Versidn- 100 l
' [
i Botdn Conforine Confurme (
= "Couriz-" . . . R | R
: 30 Afada unaimagen (en este caso unicono) a ly forma gue simbolice su Tun-

cidi, Para ello, sfada ung ciga de imagen a T fonma (primera hl.l seaunda

= "Helwv"
Le cobummna, del paned de utilidades). Seleccione en fa barra de pmpml‘ldu la
— W ~1
Enc Zelect = "Symbol propicdad Picture de la caja de imagen, y haga clic cn el bown I..‘!l situado a
nc e . . . - ; .. oL
Fuerte(Index) .Chaecked = ST ‘none safal ) ~laderecha. Visual Basie visualiza una cajia de didlogo coma la .~.1;u|1wh..
Iné = index ;uaui\; indice cda tigo d2 letrz actual
Ind S.lb
A continuacién pasumos al disefiv del mend Avada. Fste mend estd com- File Name: | TRV TRNINY) ] l 0K ]
puesto por upi sola urden, Acerce de, y 1o que queremos ¢s gue cuando sty or- Fil \wb | C i '
. - . . . Hes: CI\Y ancel
den se ¢jecute, aparezea ba ventana siguicnie: . — ’ -
.. i Dueclaries:
= -] : ' [ K -
. licons)
‘ [samples] m
Microsolt Visual Basic [¥b.cbi]
3 ol
Editas f-c] +
. Version 1.00 i
Si no estid sitnade en el dircctorio s by sitdese haciendo (lnhl‘c clic sohre
'Cunlo:me , [} las veces gue sean necesarias. Elija el directoria icons y dcn:r‘n ;dc Este of
directorio writing. Cargue eb icono notel7.ico (haga doble chic sobre ese
i} nombie o seleccionela v pulse el bordn OK).

Para crear esta ventiana siga los pusos que se describen a continuacion:
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Ahora enemos creadin la Torma. Bl sigaiente paso e esenbir ¢l procedimiento
correspondiente a la orden Acerca de. Este ¢s ¢l siguicnte:

El méiodo Show permite cargar y |\|s|]mh£.1r cualquier torma en la aplicacion.
Si L forma ya estd cargada pere no \'l&ua Itddd (estd vculia - Hide). Show la vi-
sualiza. Su sintinis es la siguiente:  ©

orma. |Shew [modo
U IShow [modo |

El arcumento sl es un entero de valor 0 o 1, por defecto es 00 Ua valor |
obliga a cervar la Torna visualizada para poder continuar tdescargarla u oculiarla),

Cuando Visuad Busic carga una forma. adenids de poneria sus propiedades
¢jecutd el procedimiento Form_Load asociado con 1o misnia.

Para cerrar esta forma henwos dispuesto el botén Conforme. Por lo tant, el
codigo asvwiado con este botdn es el siguienie:

El métoda Hide oculia (no descarga) b forma especilicada de la aplicacidn,
La ventaja de ocultar una fosma en fugar de descargarta. es que los duws y pro-
predades higados a b misma no se pierden. Su sintaxis es la siguiente:

[forma. |Hide

El botén Conforme responde a un clic, a Liecla Enter o a la tecks espacio.
Para hacer que responda s cualguier otra teclu, escrba el stcuiente procedimiento:

Down (reylode As Troeger,

Ll provedimiento Conforme _KesDown estil isociado con el objeto Conforme
v cpecuba para el suceso KeyDown gue se dacadis ves que el usiana’ pulsi una
L

APLICACIONES CON MULTIPLES FORMAS

Cualquier aplicacidn Visual Basic puede ser extendida a mais de una forma, cada
uia de las cuifes tiene su propio aspecto ¥ propisitos. Un ejemplo claro es a
aphicacian anterior. en Ly gque se hizo pricticamente todo el dixscfm sobee una for-
ma pero al final resultd necesanin aiadic una forma mds pa Fa dar informacion
acercy de b aplicacion. Esid claro que la otilizacian de variag, formas incrementa

Lo funcionalidad de Fa aplicacion. ‘ u
Disponer de mids de una forma es p.mu.ul.mnum vl un.mdo $€ necesita
crear L..lj.l\ de (Il.llu-'n COMD verenun 1is tarde en esle Ldplluln y.un el pmxunu

capitula. -

Métodos y sentencias para manipular formas

Para manipular formas Visual Basic dispone de los métodos Show y Hide, y de
las sentencias Load y Unload.

Los méodos Show y Hide ya fueron expuesios anleriormente ¢n este misme
capitulo y las sentencias Load y Unload las comentamos a continuacion.

La sentencia Load permite cargar una forn en L memoria pero no fa visuy-
hza, Para wenes accesu a lus controles y propiedades de una Forni, ésta debe estar

cargada en memeriin Su sintaxis es.

Loud forma

La sentencia Unload descarga (cierra) una forma de [a memoria independien-.

temente de gue se esté o ne visualizando.

¢adose ubaji con muliiples formas. puede ser necesario relerinse desde el
cadige ligadu aunm de ellas, o los controles v propicdades de ot forma, O tan-
hidn, puede ser necesario escribir un procedimicnto en un modulo para que lo
pucdan atilizar nis de wna forma. En ambos casos. es necesario calificar las refe-
rencias a las fonmas,

Para refenirse a vna propiedad de ot forma, se attliza La sintagis,
Sorma propiedad

Py referine 4 uma propicdud de un control de otra forma, se ut’ © sinta-
AlS, .
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forma.control propiedad

Cuando 1a aplicacién tiene una sola forma. Visual Basic asume el nombre de
ta forma actual, excepto en los médulos, donde hay que especificarlo explicita-
menie.

ASOCIAR UN ICONO A LA APLICACION

Después de finalizar una aplicacidn, plncdi:'.crcar un fichero ejecutable bajo Win-
dows {vea crear un Hichero .EXE en el Capitulo 2). Una vez creado cl fichero ¢je-
cutable, puede afadit esta aplicacién én la venana de "Aplicaciones Windows®
del "Administrador de Programas” de Windows. Para hacerlo siga l0s siguicntes
Pasos:

I, Seleccione la ventana “Apticaciones Windows”.

[E*]

Ejecute la orden Nueve... del mend Archivo.

3. Enel cuadro de didlogo ehijs "Elemento de programa” y pulse Aceptar.
4. Edie las propiedades del elemento de programa,

Descripeion: Editor

Linea de comando: Editor

Directorio de trabaju: c\wh

3. Pulse Aceptar.

Observard que se ha afadido a la ventana "Aplicaciones Windows™ el icano
correspondiente a nuestra aplicacion. Esie icono puede ser el icono por defecto de
Visual Basie, o un icono asociado durante el diseno de la aplicacidn,

Para asoctar un icono a la aplicacidn, haga clie sobre la forma, seleccione la
propicdad lcon y proceda igual que se explicd en ¢l apartado antenor para anadir
utia binigen a ta forma.

EL FICHERO CONSTANT.TXT :

Visual Basic incluye un Nchero denominado CONSTANT.TXT que deline por
detecto una serie de constantes relativas a colores, codigos del weelado. propieda-
Sdes yosueesos. Porejemplo,

Glaeel JoisL CTRLEE ==

Ston o JTosh b
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Si quicre utilizar las detimciones de este ehero puede cargarko o fus‘lun:ulu
en el madudo global de L aplicacion. Para cargar CONSTANTTXT en dste mo-
duln. '

I, Seleccione cb madulo global bas en la ventu A laaphicacjon.

Y Ejecute lorden Eoad Text det mend Code. ." :
3. Seleccione el fichero CONSTANT.INT, ‘I}l
4. Pulse el botsn Replace o Merge. ok

Si usted solo necesita atgunus deliniciones dek fichero CONSTANTTXT ¢je-
cute s0lo Tos puntos 2 y 3y pubse ¢l butdén New. A continuacion seleccione ded
wodulo creado lus detiniciones que necesite v riselas. a ey del portapapeles
des Visual Basic, 2l madulo glebal.bas (copiar y peyar). Esto reduee Ia cantidud
de memoria necesana para T aplicaciin, Despuds climine el moduto q:lc cre
ejecatundo Ta vrden Remove File del mena File.

MODIFICAR UN MENU EN TIEMPO DE EJECUCION

Unu propicdad de un control es especiticada por delecto o explicitumente durante
el diseiio y puede ser moditicada durante L ejecuckon de la aplicacion, sin mas
gue asignarle un vidor de su tipo. Por cjemplo.

gdicidncortar.fnabled = -1
Text . FonlName = "Courior”

Leuadmente una orden de un mend, puede ser cambiady, borrada o afadida du-
rante la ejecucidn. Veamos estas afinnaciones con un ejemplo.

s

DESARROLLO DE UN RELOJ DESPERTADOR

Vamos a disciae un reloj desperador digital como el que se muestra en L figera
sizuiente. Bl relog tiene wna pantatly para sisualizar I hora y una caja denomina-
Ju Despertador donde el usuano puede eseribir o hont a la gue quicre ser avisa-
do. Para activar o desactivar el despertador. ¢l usuario dispone de un ment de-
nominado también Despertador.

La pantalla para visuabizar B hora seed una ctiqueta con el fin de que ¢! usua-
rio a0 pueda moditicarla, Para que T hora varie segundo a seaundo. el tilo de Ta
etigueta a la gue hemos hecho referencii, que representa La hova, debe cambiarse a
intervados iguales o inferiores & un segundo, Para realizar esto Visual Buhic dis-

pune de un control denominado wemponzador,
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]

.

Hav un seeundo mend denominado Pais que perminiza al usoanio afadir pai-
ses al propio mend, pari después haciendo dlic sobre cualyuiera de cllos. obtener
en una tercera caga, formada por una etigueta. la horg actoal e ese pais,

rtadog;

)

Palgighey i~

Haora: |! o

L
[13:10:45

Despe

; Hota en
Despetador: © ~ New Yok

00:00:00| [07:10:43 |

Temporizador

Un tempurizador es un contral de Visual Basic que respande a intenvalos regula-
res de tiempa. Esto quiere decir que en el procedimiento asociado con el mismo.
especificaremos las acciones que descemos se ejeculen cada vez que truseurra u
intervalo de ticnipo. .

Cada temporizador ticne una propicdad Interval que especifica ¢t intervalo
de tiempo en milisegundos gue Liene que ranseurric pasa que su provedimiento
asociado se ¢jecute independientemente del usuario. El valor. de la propiedad 1o-
terval puede vscilar entie Oy 63767 () a 64.8 segandos).

E) sisteua genera 18 tics de relo) por seguado. por ello aungue of valor de Ja
. propiedad Inteeval se exprese en milisegundos, kaprecision no puede ser mayoer
de TUOAS nulésimas de segundo.

Una utilidid tipica de este control es veriticar, de alvuna forma. Juahora del

sislema para ver si es el momento de ejecutar atguna Larea,
. . .

Diseno de la forma y de {os controles

Inicie una nueva aplicacion v asigne o b forma por delicio el twlo (Caption)
Rele,

spectador, ahaneestamos Tisios parn atadie bos controbes, Lo poaero que

Taeer es colocar La puntalla del relogs baga un doble clic en Ly utilidad
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ctiqueta deb panel de atilidades v colosue Ta etiqueta en ol fugar yoe se indica en
L figuras sjuste su tamanio y asizneka kas sizuientes propicdades:

BorderStale: - E~tilo del borde
Caplion: (naday Titulo
CuUName: Hora ’ Nombre del cdotrol

- BackCulor: KHODODFEEEX Color de Fomdp
ForeColor: K HORENRHADSE: Color del prmite plano

FontSize: LB Famaio deb exio

Anada una etigquety encima del borde de faamerior, wsignela el vtudo Hore:,

ajuste el amano y siniela como indica la Hear. o

—— Snpe
v|a

__Qespeﬂadot,.“ oo

Hora:

&

Despertador:

. Colocamos ahora un temporizador, comi se ve en fa Nettra. por cjemplo a la
izguicrda de L etiquets Hora: haga un doble clic en Ty utilidid [cnuu)rizadnr del
panel de uttidades y sine el wemponizador en el lugar indicado, Ponsa el vidor de
la propicdind nterval a vador HOOO tntersalos de 1 sevundi). )

A continuacion adadimos unma cajit de texto yue via dar Jugar o desperntador;

- g . - V !

Wagiun doble chic en la utilidid caji de tento del panel de unlidades v colugue la

cagten el uzar gue se indicaen b figura: ajuste su @imiao v asivnela las sieuien-
s propuedides: )

CtiName: l)u:\pcn;uilvr Nombre del control
BackColor: SHOMOFTFTIF& Color de fondu
ForeColor: I EFT AN Color del primer plano
FoulSize: 15 Tamano ded texto
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Afadi una etiqueta encima del borde de la cajie de tevton asignela el titulo
Despertador:. apuste el tamaiio v siideka coma indica b figara,

Pura activar o desactivar el despertindor vumos o adadic un mend. Abra la
ventana de disefio de mends v disefie ¢l mend Desperiador con las drdenes Des-
pertador No v Cerrar (deje las propiedades especilicadiy por defectoy.

DespenadarSiNo
Cerrar

Despertadur No i ‘(_,‘il.\'ume:
Cerrar b CilNume:

Caption:
Caplion:

i . una buena wea, guardar shora el trabajo realizado: ejecute ta orden Save
Project v asigne a la forma el nombie relojfrmi y a Ta aplicacion (provecio) el
nombre relof meak.

Unir el cédigo a los controles y a la forma

Tenemos va los cantroles necesartos para naestro reloj. Ahora unigemos a clos ¢l
cidizo correspondiente pari un comecto luncivaamiento del reloj.

Empecenos por eb despertador: nuestra intencién es gue ¢l usuario escribi en
esta cajir 1o hora a la que quiere ser avisado. Por Lo tanto los ciracteres que €l
puedi eseribir tos restringiremos a los digitos "0% 0 79" v los ™7 Para realizar el
procedimicnto correspondiente. haga un doble clic sobre L caja de tento desper-
tador. seleccione el suceso KeyPress v esenba.

HIRES

Este procedimiento recibe como argamento el eddigo de fatecly pulsada y lo
almaceny en el pacimetro KeyAscii. La funcidn Chr$ conviene este eddigo d su
comrespondiente caridcter ASCILY To almacena en L variable Cor. A continuacion
se veriiea siel canicier Do ¢s uio de Jus permitidos. ¢ eny o citse se cimite un pi-
tido v we borra el cardcter. esto ex, se cambia el carivter teeleado por el carlicter

nulo teddiea Uy,

EL paso sizuicate o presentar L hora a rasés debconnol Hora, Pera visuali-
zar L hora Visuad Basic tene L funcion Time$ Lo cual devuelve ung cadena de 8

L
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3

. i
caructeres de’lis fogma hlvimmiss. Entonces. para presentar L hora bastaria con es-

cribir wna entencir como.

AR R e

it Clestion ey que si osla ~sehiicndi ¢ ejeduli una \nl.uLu lu hnl.l send i
presentada v no sariad, BEs preciso por lo oo, ejecutarli g fmervalos t.lL, LR se-
sundo o menos, Para conseyuir e~to. haga Jue ot sentenci nii

aparte dLI Cuerpr
del procedimicnto del wmporizador, ¢l cual ha ~sido progcaniado’ para qm. dicho
procedimicnto se cjecute cady seyundo, Para cllos haga wn doble clic] solue el

tesnporizador v escribi,

Pev o algo s, suponganios gue el ussarie eseribe una hora en el desper-
Gador, e que se prodazean pitidos de aviso cuando se alcinee esi o, tienen
que dise dos condiciones: nna gue cb despertador esté actividdo y ot gue la hora
delual sea tgual o nayor gue Ly hora especilicada en eb despertador. L condicidn
mayor es para gue el pitido coninde lusti gue el usuano desactive ol despertador,

Deling unin vaviable DesperaadorSioa nivel de la forma, v asfeneks un valor
scial ceros U vador 0 4iadso - False) signitica desperador desictivado v un va-
lor =1 (verdad - Truey signitica despertador activudo.

Dim Dosp

.

Para inicializar las variables ¢l procedimicnto adecuado es Form_Lowd ya que
es ¢l primero que se ejecata cuando se arranca by aplicacidn,

Suh Foro Loas
Dasper Lo
DESLerLs ey

rad sub

L valor False estd dedinido en b Bchero CONSTANTIUXT. Abra este 13-
chero, seleccione lus detiniciones que fe interesen v cologuelas en el fichero glo-
bal.bas, gue a continuacian gurdaremos con el nombre reloj.bus.

De scuerdo con o L\l"llL\[ll nunllllqm ol provedimiemao Fimer! _Timer como

se¢bdica a continuacinon,

S Tinerrd
ID (Resper. oo om0 Llrel i Tosve

ST e
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Desarrollemos ahora el cédigo para fas drdenes del mend Desperiador. empe-
zando pur L orden miis sencitla, Cerrgr. Haga clic en este seni v después en la
orden Cerrar. A continuacion escnba]

o

v

Sub Cazras Click
Fnd
end Suib

El titulo de Ta orden Desperndor Noovaindics que el despertador no esti ac-
tivado, lo que implica que Ja varguble DespertudorSi wenga un valor False, Cuani-
do et usuarnio haga clic sobre esta orden ¢l titula de Ta misnv deberd cambiar para
indicar Deaperiudor Siov la variable DesperiudorSi wmard el valor True. v ul
Cuntrariu,

Cambiar en ejecucion una orden de un meriu

La orden para activar v desactivar el despertadur que acabamos de comemtar tiene
que ser canbiadi durante Ja ejeeucion del progran., Para hacer esto. no tiene mas
que asignur el ttulo deseadw & la propicdad Caption ded control correspondiente,
en nuestio Caso al contrel denominado DesperivdorSiNo.

Haga clic en el mend Despertador v despuds en L orden Despertador Noo A
conlinuaciin escnba.

Sub Désterceds

Fna
=nd 8.

Obsers e gue cuando el usano haga chic sobre B oden para activar v desacti
sar eb desperiador. el titalo de Ty misina cambiari para indicar Despertador Neosi
Ly varable Despertadior$i o« Trueo v lasaniable DesperadorSi womarni el valor
Fab Al continin,

CAriT Tae IeNIeas De biskso LY

Esto también pudria huberse hecho diseiando el ment con las drdenes posi-
hles. Despertador STy Desperiador Noo estando und de elfis, la no activie no vi-
“sible, o que puede hacerse poniendo su propiedad Visitile a valor False. Suponga
que ha constriido este mentd con s siguienies propicdades T)s valores para lus

propicdades que o se especitican son los didos por detecto):!
!

: ' oo .

Caption Dexpernador N | Hmpm‘,tnhy' 5 i
CtiName PespertadorSiNo f DespettadorSiNo ;
| I |

ludex ] ' | o :
o e e e e o e
Visible True tsenadicking | False e senalan ) ;
B N

1 cadizo pars estos controdes puede ser el mpaienie:

PDesp

'
i

Despe:r tadorsi
Znd Sulb

Las dos ordenes forman un iy de conteoles denominado DesperadorSiNo.
Inicialmente esti visible Ta vrden Despertador No. Cuando ¢k usuario haga clic
sobfe ell, se invoca el procedimicnto DespertadorSiNo_Click que recibe un va-
lor 0 en Index. La ¢jecucion deeste procedinieno es como siguer se hacen visi-
bles las dos Srdenes: seguidamente se hace no visible ke ordef que indica el indi-
ce. en este ciso Despertador No. quedando visible G onden Despertador Si: lu
variable DespertadorSi toma et valor lndex — 1 en este ciso -1 (Fruey ¥ al

contlsirio,

"
marca ¥ cuindu esté activa, v sin marca cado o esté etiva lo gue poede ha-
cerse poniendo su propicdind Checked a valor True o False. Incialmente Ts pon-
dremos @ valor True. lo que implica que Basariable DespertadorSi valga False.

nhici st to prefiere. podriumos poner ke otden Despertador Noocon ung

De acuerdo con lo dicha, ¢l provedimicuto podeia ser el siguicnie:
Sub Despertadoriilio_ T ick ()
L (Desporiedo: Sy T
pespertade: i -
Despurtadorsiiio.
Else




1200 VISUSEL BSSIC 3PLICACTONES AR Y WINDAOMW S
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T
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Anadir ordenes a un menu
En Visual Basic es posible afadir uma orden 4 un mend utihizando la sentencia
Load v tambiéh se puede eliminar uia orden de un mentd wilizando L sentencia
Unload. Extis sentencras vaose expusieron ab hablar de aplicaciones con maluples
formis en este mismo capitulo, lo que apinta a que Load v Eaload s¢ van a po-
der wilizar con muchos controles, " '

]

Para poder realizar estas operaciones sobre un meni, ks drdenes del mistio
ticnen gue perenecer 2 un aray de controdes, La razon es goe una vez anadida
una orden no podifanes siadic un Buevo procedimiento parie by misma. micntras
que conun array el provedimienta es comin i odas las ordenes.

Quicre esto decir gue durante el diseno bay crear unray de controles y esto
exige que dicho arras tenea al menos un clemente. al que unirenws ¢l procedi-
micnto caumin. Come inicialimente nosotros no siahemos qué drdenes van o ana-
dirse al memi. Ya solucidn es gue cuando diseiemos ¢l memd iagamos que T pri-
mera orden. la de indice O, sed mvisible. De esta forma, las drdenes gue se afudan
despuds irdn a continuacion de esta mvisible,

Para ver esto en T priciica. vamos afadic a nuestra aplicacion. como ya se
indicd en ¢l enunciado. un sezunde menmt denominado Pady que perminird al
usuario adadic panses al propio memi, para despuds haciendo chic sobre cualyuicra
de eflos. obtener en uny tercera caju. Tormada por una etiqueta, B bora actual en
ese pais.

Lo printero gue vamos o hacer ex colodir exa tercera cajae bz un doble clic
en la uididad etiqueta det panel de utilidades s cologue L etiqueta encel fugar gue
se indica en lu figour siguienie: ajuste su tano voasiziela Ly siguientes propie-
dades:

Esnto del bopde
Triulo
Noubre del conunl

BorderStyle: I
Capliog
CilName
BackCulor
ForetUalor

tnadao
Ciraldona
Al
CAHER KA

13,5

Colot de Toade
Colon det proner plane

FamSize Tunane Jdel weao

Anada una etiguet encinn del borde de Tacaji znierior. ne b asgne titudo,
pongala el nombre Erigireralais v ajusie ¢l tamaio. Feia ciqueta T u[illi/,::rcnms
para visualizar ¢l nomibee del pais del coal eb usario guicre saber sy hora actual.

Incima de esti eiiqueta cologue orrvon e titalo Hora on,

Despentador - Pais

Hota:

Hua en
Despertados:

I

L posa sivaiente es erear el memid Pady de losia gue permita uﬁ;u‘lir BUeVIs
drdencs. Abra ki ventamin de diseno de ments v esershidicho mend coma se ve en

la figura siguicnte.

Caplion: ‘ I
CuName: [Pais |

Index: [0 |

[ Checked (3 Enabled 71 Visible

Mrﬂeul ” Insent JI Delele I

tDespertadm
---hDegpertador No
o bCenrar

tlPais

-o-RARadi Pais

Accelerator: {[none]

CTEONETAS DE DISERO 121
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Inicialmente este meni se ba formado con las siguientes Bidenes v propicda-

des:
Caption Adadir Paiy - [2ubdne tespacioen blanco)
CdName Al Pais pu";ulnr Pais

- s .
fndex (aingunw) { Eniogunod ]

B L
Visible si dseialada) S tsenulada) mo (no sefaliadiy

Observe en la figura anterior que Puisety es la primera orden de un armay de
controles. indice {, y tiene un titulo, espacio en blanco. invisible (propiedad Vi-
sible sin sefalur). En oiras pulabras,
ceder desde el mend alos elementos Paist Fr. Paisi 250 v asi sucesivamente. ya que
¢l elemento Pads(0) permanece invisible.

en puestro amay de controles podremos ac-

Si ahora LJ(.(.IJI..I. el programis. pucede ver que el meni aparece como en fa figu-
r \I"UILIIIL

‘Desperntador Wit

Hota: Aﬁad s .
13:30:10
Hoia en
Despertador:

00:00:00

Cuando el uswario huga clic sobre Ly orden Adadie Pais 1o que se pretende es
que puedaintroducir dos nuevos datos: une ¢l nombre deb pais gue serd el tiwlo de
L nueva orden y otro b diferencia hociri con respecto a nestro pais. para posie-
vonmente poder caleulir la horaactuat en eb pais especilicado.
ener aecesu @ estos ditos, los puarderemos en i atiay de esteucturas

den o Pui ora. donde cada elenento serd dol sicuiente tipe:
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aYyIn

SEATE B
Clopa. SilzdEar

N
Otro dato al goe tenemos que seguir 1a pisties al nimero de elementos del
mend. goe nos vaca propercionar el valor det fndice de T (MLn a afadir y gue
coincide con vl indice del elemento del array domie .;Im.tu.n.mim los datos. Para
chlo, declararenios la sariable NumPaises con un vabor muml. 6. valor que ya
liciie Lt ddu.ln

Globa. T.rfxis SIS by

Escriba todas estas declaraciones o of niddule global reloj bas,

10 conclusidn. el conjunto de operaciones gue ticne que suceder coando ol
usuario haga clic sobre fu arden Aiadiv Pais es:

1. Incrementar la vanable NnPaises.

2. Introducin los datos pais v diferencia hosiria,

ot

Detcszo-.2n

Difeiencia horania: ‘:::\

3. Curgar una nuevi onden en el memi Pais.

[ e

bt

s

")

Lo

jo

4. Asjuznar o la propreaad Caption de esta orden, ¢l nombre del pais y hacerla

visible.
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En definitiva. el procedimicnto MedirPai _Click quedi coma sigue:

A

O

L’J. L IAS I S U R

18]

Cuanda ejecute esta orden v afada drdenes al menth Padv. ¢l aspecio del meni
- . Il'a
serd como el que se muestra a continuacion.

Despertador
Afadir Pais
14_ 'L,nm_l'rqs
- -Alenas
., Roma.. . .
Nchulk
Despeitados: Hong Kong
-0n-0cl- £ Australia’
[po.oo.n -Aus B

Anadir una nueva forma:

Disponer de mis de una forma es particularmente dtil cuando se necesita erear
cajas de didlogo. En nuestro caso, sepin hemos visto en el apanado antenor, para
attadic una nuevi orden al mend Pods presentamos uni segunda forna gue repre-
senla unit caji de didglogo Ta cual pennite introducir los datos, pais + diferencia
horaria.

Continuando con nuestra aplicacion. afada una pucva forma: para etlo, eje-
cute la orden New Form del mena File, A continuacidn asigne o b fonmael vido
(Caption) Datos v el nombre tFormName) DugosEng.

BN paso siguiente ey afadir los controles o ba torma Frjese en Ta fonna Duroy
mostiznda en el apartado anterior, afada bos contrales cone das propicdades indic-
das en knabbic siguicnte. y ajusie ef coaio de los controhes s de T fona,
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Control | Cuption | CtiName Ceat
Lrigueta i [%ais: | Fabell f
Caja detesto ¢ PuisE |51 1aday
3 !
- !
Eligueta Diferencis horaria: | Laboet? k o
| H
. N :'
Cajir de texin I DitHora | Vi)
* i '
Batdn Aceplar I Aceplar 1

Una vez creada Lo torma, uniremos ¢l addieo o cadiduno de los controles,
Cuando se ejecuta b orden DarosEne Show T se muesera By forma unidada Daros
con el carsor situado en L caja denominada Padddnr A contimiacion| se espera

que el usuano escribi el nombre del pais oo desea afadir v L diferencia horgria,

Una ves Gue el ustario ha wecleido Tos date st sk correctos 1oy acepard
pulsunda ¢l botdn Acepiar ¥ s1o son carrectos dingird de nuevo el dursor ol
primera caji para escribitlos wira ves: en ot palabras. enfocar de nuevo |d WTH]
PaisEne. Paa entocar un contral puede utitizar el vatan o L tecl Fab.

Cuando se pulse el botdn Acepren gueremos e sucedin s cosis:

i Almacenar el contenido de Tas cajus de fexto, en el clememo correspondiente
delarray. Recucrde gue el elemento detarmay se relerencia por i .!-.um indi-
ce gue ke arden correspondiente del meni. Esto es. el clemento § ded array
contiene los datos para la orden Panst 1) del memi. el clementa 2| del array
conticne tos datas para T orden Pane2) del mentis v asi sucesivamente, Esie

indice viene dado por la variable global NumParses. oo

[E%)

Que cl cursor guede colocado en fa caja PaisEng paca una proxine emrada.

30 ¥ yue la forma guede oculia.
El procedimiento asoviado ¢ muesine a contiuacion.

Sub Acentar
Palsiiora(:
Palsiarall
Paismnni
Datow

End Suaiy

Dora.
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El méedn SetFocus permite enfocar el objeto espediticadu, Eae ohjeto
puede ser una Forii o un control, Su sintaxis ex.

objeta.Setb ocus
Después de enfocar un objeto. cuatquier entradu del usuario ind dingidica ese
objeto. Si en algdn momento necesitgl satfer qué abjeto esti entovadu. aulice Jas

propiedades ActivateControl y ActivateForm del objeo Sereen.

Screen. ActivateControl
ScreenActivateForm

La propicdud ActivateControl devuelve el control que esti enfovado v [
propicdind ActivateForm devuelve L forma gue estd enlucadi. Por epeanplo.

1

Corrae
Slee

o 2L

Vad Lo

Eate cjemiplo dice que sio el boton Compand b esti enfocado entoness pasar a
enfocar el botdn Command?. v si no esi enfucado, entocarlo.

Cuandu up objer se enfoca por cualquier accidn, por ejemplo. haciendo clic
sobre ¢l uilizzando la tecls Tab. porque se ha cargado v visualizado una fora, o
incluso porque se ha enfocado utilizando ¢l mélodo SetFocus. se di un suceso
denominado GotFocus v cuando un objeto picrde el foco. se desentoia se da un
suceso denominado LostFocus.

Comw eemplo. la senencia Peisdin SetFoecus del procedimicnto Acep-
tar_Click presentado anteriormente. enfoci el ubjeto PuisEnr: esto implica que se
dé el suceso GetFocns, yue peritite se o cjecote ¢l procediniento Fads-
Ent_GotFocus, que se presenta a continuacion, Como para cada entradu de datos
el objetivo que se persigue es que el objeto epfocadu seu la caja de wevio Paisbnt
y que ambas cajis de texto se presenten limpias de informaciin. ¢sto es. sin laine
formacion de L entrady anteriur, escriba,
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Cada vez que se visualiza L forma como el obyces cnlovado es PaiEnr, se
cjecuti este provedimiento que Tampra Jas dos cajas de e,

El botin Aceprer responde aoun chics b eela Enter 't] a4 la el espacio.

Paca hacer que respondaca cualguier otra tecla. eseniba ef sigggente procedimiento:

Procedimiento comun para las érdenes anadidas

Cada una de Bss ordenes anadidas al mend Pan, penmie saber fa hora acnal de)
pais curo nombre coincide con el titdo de la orden, Caando e aseario haga clic
et alguna de esas drdenes. tene que:

oo Mosinse <debijo de Ja cuqueta Horg ens oltg eiiqueta que especiligue el
nombre del pids del cual queremos saber L hora

S.Cxmuion = Tolatindis L s Ton

30 Visualizarse en Ly caja de texo que hay debajo de T ctigueta amerior, depo-
minada radtora. T hora actual correspondicnte o ese pais,. b cual seid la

hora actual de nuesivo pais s L diterencia horare.

El procedimicno conwin para estas drdenes que ceabiza o anteriornente ex-

puesto ¢s el siziinic:

El formato de Hora Caprion es Bemmess, Por To tanto fa funcion Val devaoel-

ve el valor i al que se suma B diferenci horario cpositivag o negar-, Si el re-
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sultado de esta operacion es mavor que 24 1 hora vendri dada por la eapresion

Horas —  24.y sies negauvo. por [a eapresion 24 + floras, .

La expresion SirdiHoras) + RighiSttfora. Capiion, 63 une la cadena "hh” con

la cadena ":mm:ss”,

La funcion [.trim$ climina los es dClPs a Ly izquierdu Je una cadena de ca-
racteres. a funcién SIr$ conviene un num:.m a una cadena de caracteres v Ja
funcion RightS toma los n caracteres mds a la derecha de la cadena especificada.

Si la cadena resultanie. debido a que Ya variable Horas tiene un digito, es de

la forma fizmmcss, se anade un cero a ld izquierda. La funcién Len da como resul-

1ado el nimero de caracteres de la cadena especiticada.

Borrar érdenes de un menu

La sentenvia Unload solamente puede utilizarse para borrar un objeto gue hava
sido creado con la sentencia Load: esto es. Unload no puede uilizarse para bo-
rar un objeto creado en ticmpo de diseiio.

Por cjemplo, vamos a afadic a contingacion de Ly orden Adadir Pais ded
mend Pais de nuestea apheacidn. una orden twlada Berrar Pars y denominada
BorrarPaiy. EL siguicnle paso es escribir el procedimiemo Borrarals_Click
asociado con esta orden.

Cuando ¢l usuario ejecute b orden Berrar Puis, Visual Basic invocarnit al pro-
cediniento asociudo BorrarPufs_Click que tiene gue realizar lu sigusenie:

I. Tomar ¢l mimero (indice) de L orden del mend que se desee borrar.

2. Verificar que dicho mimero exti dentro del rango,

3. Slendo NumQOrden ¢l ndmero el orden a borrar, reemiplazar el vinlo de 1a
arden NumOpden con el Utulo de 1o orden NumOnden+ £oel titulo de g orden

NumOrden+ 1 con el ttulo de Ya orden NumOrden+2,
hasta el Naal Jdel mena.

Y s sucesivamente

400 Bawrar b dltiona orden Jdel mend.

o

Decrementar enuna umdad Ta sariable gue coenta el aumera total de drdenes,

El codigo correspondicnte i lu expuesto es el siguiente:

4T
P L0 S TCNOAS DE DISESG |29

CA]

SANnE o
ol (o

RITH LR BY
iora{Humlial ses) .,
isas < Hambals.

La funcidn InputBox$ devietve como resuliido una cadena de caracteres que
ek usuario eseribe como respuesta a una ciya de didlogo que se visualiza cuindy
se ejecuia la funcion,

La funcion MsgBox visualiza en unia cipa de didlogo el niensaje especilicado.

Tanto InputBox$ como MsgBox serin vistis con mas detalle en el capiulo

siguienle.
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»

CAJAS DE DIALOGO

INTRODUCCION

Visaal Basic liene ung serie de coniroles para ser utihizados como mecanismos de
entcadwsalida t1/S). L buen ejemplo de To dicho son Las cajas de texta gue hasta
shara hemos venido wiilizando. Owra serie de abtermativas poc ks gue podemos
opLir son: seales feajas para senalar uma opadnt. opciones telegir una opeidn
entre vanas). fisues, combimados y barray de desplazamicnto.

E/S DE DATOS CON InputBox$ y MsgBox

Una ventana pars emradifsalida 3 datos es aal cuando se necesita prezuntar al
usuitrio cualquier tipe de infomuacion, o caando se pecesita viswalizar cualyuier
resultado o mensaje. Para crear una vendani de este tipo sigaclos sivuientes piasos:

1. Seleccione wi suceso. 1o Lrimera es determinar qué suceso livie gue ocurrir
para pregantar al usuatio una detwermimada informaciing o pary visualizar un
resultado o un determinada mensuaje.

.

Par cjemplo. si desea que el usuario introdusca wna palabra de paso (uny
claver cuando intente ejecutar una dererminada aplicacion, piense en ol suce-
so Loud. Entonces. tene que esertbir el codigo necesario en el procedimiento
Form_Load de To forma que se cirgee en el momenio gue s¢ cjecuta dicha
aplicacion. En el supuesto de gue el usuanao antroduzea una palabre de paso
incorrecta. se le potticari con un mensaje.

20 Everiba el eddiyo, EF codizo para ana entradis tene yue cargar vovisualizar b
ventand. voespediticar con un nwehsaje <L tipe de infonmacion o reguiere
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del usuario y para una salida. tiene que corgar v visushzar o sentana, y pre- S La cadens de caracteres mensaje comiene el mensaje yue se desei visualizar.
sendar en ba misina el resuhiado o el mensgje ' ‘

; - El resto de Jos parimieiros son opeionades. Bl entero tipo g3 uni sumg de valo-
Visual Basic prosee algunas ventanas predefinidas que nosetros podemos

- res que describe el ndmero vel tipo de batones w visualizan N oestilo de) wone. v
utilizar puri este propasito: lnpulBoxS v MsgBox,

L adentificacion Jdel boton por defectos Para ver estos \.1|nr$'s asi comu)los retor-
nados por L funcion, vea kuasida que Visual Busic da pdrﬁ\lsgliu\ La cadena

La funcion InputBox$ \uuallza luna caja de diddogo con un mensaje. de caracteres tindo$ seri visualizada en 1 barra de tlo de 1.1 L‘.I_] 1 de didilogo.

semejante a la de Ll |I“L|I’.l 3]'-‘Ult.m=3 qu;: indica al usuario ef npo de infurmiacion

e debe il S i 5. s

InputBox$(mensajeS|. titdoS(. omisiinS|. posyec. posy<i |y v
oo : @ La palabra de paso no es corsecla
La cadena de caracteres mensafe$ contiens el mensaje que indica ) usuario ¢l
tipo de informacion que debe Introducir, Si el mensaje consisie de varias lineas.
hay que introducir explicitamente al Nnal de cada una de ellas, los caracteres re- . Aceplar
torno de carro (Chr$i13r v avance de linca «(ChrS(Lop. ' -

El resto de los pardmetros sonp opeionales. La cadena de caracteres ritlo$ serd
visualizada en la barra de tiudo de la caja de didlogo: emision$ es la entrada por
defects; y posyy posy son las coordenada v e v medidas desde la izquierda y des-

de la parte soperior de Ja pantally respectivamente y expresadias en twips
(1/14407).

EL codigo para el ejemplo expuesto y que da lugar alas cagas de didlogo an-

teriores ¢y el sivuicnie:

~ N | ' gt B
Palabra d L ges (O]ave)
alabra de paso: -“

Oy Cuencda = 2

(S}

o5 ocorraccat, 1

X"l paLé
Cancel

L vaniable Clave es una cadena 1 de ocho caracieres gue contendri la pa-
labra de pasor gque teclee el wariv (i no teclea ocho caracteres. Visual Basic la
completa con blancos). Hasta que esa palabia de paso no comeida con L cadena
de ochu caracteres “JAVIER 7 ihay dos espacies en blanco al final), y[hasta un
[J“im’ j mdaimo de tres veces, el usuario seni reiteradamente preguntado. Cada ves que
. no hava comcidencia se vistabizard b cups de diilogo presentuda anteriormente.
El valor 16 de la sentencia AsgBox da lugar al iconoe STOP. Si hubi¢ramos ¢seri-
1o un valar 20 {16+4) se visualizatian adomas del ivono, dos botones Si y Nooen

La sentencia o du funciin MsgBox visuatizan un mensaje en una caja de Jid-
logo. semejunte a fu de la figura siguiente. Su sintanis es lasiguiente: Jugar del botén Aceprar. 1n este Qllmo caso. si necesitamos saber qué boron se

pulsd, utilizaremos La funcion en lugar de dasentencias ya gue la luncion devuel-

MspBox mensajed], tipoi |, ritulo$ y i )
k gedl. tipot | el ve como resultado el valor (6 0 7y correspondicate al boton pulsado,

Vidon Retornado®e = NsgBoxtmensaje S|, ripo® [ tndoS|))
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Suh ConverMayus T ioe
N If Con
SENALES -1 oot
' End 1f
Una sefal es un controb que indica si una deienminada opuion estd activikda o 1f Cort
desactivada. Cada opcian es independiente de las demds ya que cada una de cllas ) Texs i
tiene su propio nombre (propiedad CtiName). El numero de opciones representa- ;‘“gnﬁu :1): ‘ :!
das de esta forma puede ser cualquieﬁa. b de elas el usuariv puede seleccionar s et e
. Y P . =
todas las que desee cad vez. S Cuando ¢l usuario haga clic sobre la opeidn "Convertir a naydsculas” y la

propicdad Value valya 1. el teat de la caja Teard se conviene amayiiscolas utihi-

Si en tiempo de cjecucion se hace clic sobre una opeidn simbolizada por un . o . - - !
pu ] - zande la funcion UeaseS. Comu la opeion queda enfocada cada vez que se hace

control de este 1ipo. ésta queda seleccionada (X). Una opcion va seleccionada.
pucde pasar 4 no estarlo haciendo clic de nuevo sobre ta opcidn (). Todo esto.
suponiendo gue el convenio adopiado ¢s; una x opuidn seleccionady v nada op-
cién no seleccionada.

chie subre elfa. cjecutamos i continuacion ¢l método SetFocus, para que sea ol
control Texrd ¢l gque quede enfocado. Este método no puede ejecutarse si la op-
cion estl deshiabilitda,

= El segundo punto se resuclve recordando que cada vez que el usuario pulsa

—3 o Fescr]- N e . . - - m
_:I_ “ una tecla, uno de los sucesos que se da es KeyPress y que e parimeto Key Ascii
de dute, contiene ek valor ASCIL el cardcter pulsado. Entonces, Jo que hay que

[ _ J hacer es convenir el vidor ASCIH al cagicler correspondiente, conventir este curdie-
ter a maydscula y convenic de nuevo éste dltimo a valor ASCIL

Sefiul —— 1 [ Convertir a mayasculas .
’ Sub Textl_r ii As Integer)
’ - Dim car = - )
Para saber si una determinada opcion estd seleccionada hay que renhear el If Convecr N Then
valor de su propiedad Value. Este valor puede ser 0, la caja aparece vacia: 1. 1a car = UCas Havzacii))
caja aparece con una x; y 2 la caja aparece en gnis. F”Seal/zl’:_.sc il

. P - L . Fnd Sub
Cuando una de estas opciones estd deshabilitada. aparece en gris. Esto se -

consigue poniendo su propiedad Enabled a valor 0 y es entonces cuando lu pro-

: La funcidn Asc di como resultado el valor ASCII de cardeter especificado,
piedad Value vale 2.

Por ejemplo, diseiie una caja de didlogo como la de {a figura anterior. de tal OPCIONES - O
forma que cuando se seleccione la opciin "Convertir a mayusculus”,
_ | . el © Una opeidn es un’ control que indica si una determinada opaidn estd activady o
: ce havi ese a caja de texto aparezca en mavisculas. sactivadi, Cadi oneion o & ; 4
1. Todo el texto que se haya escnto en la cay ¢ pare : desactivada, Cadic opeion es independicote de Jas demds ya que cada una de eblas
tiene su propio nombre (propiedicl CuUName), Bl ndiméro de opeiones representa-
das de esta forma puede ser cuat, .y de ellas ¢l usuario sélo puede seleccio-
lus. nar una cada vez.

2. Y 10do el 1exto que se escriba a continuacion. también aparezea ¢n mavdscu-

* Suponicndo que Ya caja de teato se denomina Tearl, que la opaion "Convertr
4 maviscubas” se denomina ConverMavus, v sabiendo qug [z oprion s¢ selecciona ) ! o \
L Ay Y . A , < . controd de este Lipo. la opeidn queda seleccionadit ( * ). La seleccion de wna op-
ha o clic o eligiéndola con ta tecla Tab v pulsando espacio. el pruner punto 511 de este i ] A_ . P

jeui mienio: cidn de este tipo, provovs que la opeion actualnente seleccionada pase Cs-
se € con ¢l siguienie procedimienio: wrlo . 3

Si en tiempo de ejecucion se hace clic sobre una opcidn simbolizada por un
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I (|
L |

O Decimal
Opcion —3#- @ Octal

O chJdectmal

Lt

Para saber si una deterinada opeidn estd seleccionadu hay que veriticar ¢l
valor de su propiedid Value, Este vator puede ser fulso 10y, el circulo aparece
viio, o verdadero (-1), el circato apﬂfccé‘con un +, Cuando una opaion se pane a
valor verdadero. se da el suceso Click.

Cuando una de estas opeiones estid deshabilitada. aparece en gris. Esto se
consigue pontendo su propiedad Enabled a valor 0.

Por ¢jemplo. disefie una caja de didlogo como la de la figura anterior, de 1l
forma gue coando seleccione una de lus opiones "Decimal”, "Octal” o
"Hexadecimul™. el ndimero tecleado en la caji de wexto. aparezea en la base indi-
cada, La wbla de propiedades puede ser la sizuiente:

]
S _ Py
Conieol Caption CtlName i Value
B |
Caju de texto < Teanl I
Opcion primera Decimal Decimat True (-1)
- -
Opcion segunda Octal Octul i False ith
| |
. -
Opeion ereera Hexadecinal Hexadecimal b False (1))

Esta aplicacion responde a los siguientes sucesos:

s Cadu vez que ¢l usuario modilique ¢l contenido de Ta cuja de teata se dari el
suceso Change. En este instante almace areimos ¢l valor decimal. octal o he-
sadecimal (dependiendo de la opadn sclecaionadas vn una vaniable cmera
denomnada NumeroAciual. ) -

_Chanee O
LlriosS{Text .

CARiD Lo T OAsS BEDuoGo 137

.

P ‘4 3

La funcion Val conviente una cidena de caracteres o uninumcn‘). St la ca-
n valor en
octal: si comivnza con los caracteres "&H™ seri ierpretada como 1‘m valur en

heaadecimals v si comienza por los Caracteres &P por -+ por ] 0 simple-
) o

dena conmpensi con cdracteres T&O7 seri interpretivky como u

mente por un digito serd interpretsda comao un valor en decimil, Eneste ilu-
mo caso. st L cadeny tene adn i sdbo canices. + o = cludimos| i conver-
sion o decina), de o conrrio obtendecinos wn error, El sulijo ™00 espeailica

ue Cse vilur s un enteio.

o Cuando ¢l usuario seleccione una de bis opeiones Decimal. Octal o Hevade-
cimal, se dard el suceso Click asociado con ese control que hard que ef valor
NrimeroAetual se visualice en decimal. octab o hesadecimal respectivamente.
Como Lo opavin ana vez seleccionida queda enfocidi, ¢ecuiunos a cont-
nuacion ¢l método SetFocus para gque sea b control Feard ol que q‘ucdc enlo-
cado. ste método no puede cjecatarse si la opeiin esti deshubilitada,

La funcidn OaS devoelve una cadena de caracteres correspondiente a Ja re-
presentacion octal del valor especiticado v L funcion Hlea$ devuelve una cadena
de caracteres correspondiente a L represeniacion bexadecind del valdr esprecitl-
cado.
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Con el fin de limitar la entrada a los caracteres gue forman pane de cada base. ralmente. una lista es apropiada cuando se quiere linutar la entrada 3 una sene de

escriba el provedimiento siguicaie: , elementos determinados.
_Heyrrass (neyiscil AS InUECET) Un combinado es un control que combina lus caracteristicas de una caja de
'ZESE.S-H_,'”- SE}":"":‘SC:” texto v de una bista. Esto permite al uswario clevic un elemento de vanos,
::]S. vT'):« : ‘ :E‘;-—) escribicndulo directamente en la vaga de lexto o seleccionindolo d.c la hsta. .Gcnc-
Satzilialue Tran rafmente. un conrol combinado es apropado cuundo hay una lista sugerida de
T-Sr-(Bciz, Car) ‘! . clementos v ademils. ¢l usuario puede sugenr olms gue 1o csq!'_l cu la lista.
xadzcimal . Velue Then
InSur (Hexa, Cer)t U Para colocar un clemento en una lista o ¢n un u)mhm.ldu uuh e el método
) Additem v pars chiminar un elemento de alguno de estos um:mlu. utilice el
» Tren métado Removeltem, o
»
=0

Para acceder a Tos elementos de una Lista o de on combinado. puede utilizar
alguna de Tas propicdides siguientes: Test. List, Eistlndex. o ListCount. De 1o-

das ellus, Ta mis sencitla de wtilizar es Text. Esta propiedad proporciona la cade-
La funcidn InStr( XS, ¥S) devuelve la posicién del primer canicter de Y5 en
XS. Si Y8 nose encuentra en XS, lu funcidn devuelve como resultado 0. .

na de caracteres correspondiente al elemento elegido.

Los sucesos mids importantes para una lista son Click (clic) y DbIClick
l.us varables que aparecen en este procedimiento ¥ en los anterores estin {doble clic) v para un combinado. Click v Change.
definidus en la seccidn {general) de la forma, vy son inictalizadas por el |)I'U(.‘C(.|l-

miento Form_Load como se indica a continuacién. - .. .
Utilizacion de listas

Oiz im=os s Integer
Sim o Dell Ls Suring v 12 Supongamos una pequeia base de datos para levir |3 cuenia de los libros de
;?"‘ OCZ2 3 g: ring : ig nuestra biblioteca particular, de los cuales. hemos prestado aleunos a vtras perso-
Dim FZex»z 1s. String : - . T

oo . = . ) _ . - nas. Pura seguir Ty pista i estos Libros vamos a almacenar los sivaicntes datos:
Dim Car Iz String * 1, vr is Intsger, Texto :§ Z1ving 2 P £Hicilie 5
Suh for- _“osad () _ Tiwlo de libro p A

Zecloz *--0123£2378G% - ChrSi(8) + Crnrs(il) Autor

Cc-a = *312%4567* + Cnr3(8) + Chrsi{id) Eduorial .

Hexa = "J123456759ABCIIFY v Chrs(8) - Datos sobre ¢l préstumo
Inc Sun

Cada uno de estos datos elementales se denomina campo v el conjunto de w-

Las expresiones Chr$(8) y ChrS(13) se comresponden con los carcieres de dos los campuos referentes a un misimo libro recibe el nutibre de regisiro.

rawcacese (BackSpace) y retorno de carro respectivamente.

: Nuestra aplicacion va a consistir de una ventana principal que permita intro-
ducir o visualizar os datos de un regisiro v de un mend gque permita. enlre otras
cosas, buscar un detenminado regisuo, Cuando ¢l usuario seleccione en este mend

LISTAS Y COMBINADOS

Unia fister 23 un control gue pone a disposicion del usuario un conjunto e elemen-
ton. de Tos cuales elegird uno. Sicel ndmero de elementos ®hasa ¢l nimero de los
que noser visualizados simultineamente en ¢l espacio disponible en da fisp,

elu uede despluzar fa lista de elementos hacia arnby o hacia abajo, Gene-

la orden-"Buscar Registro.." apareceni una cuju de diidlogo con una bista clasifi-
cuda de los titwlos de los fibros prestados. Cuando el usuario haga un doble clic
sobre uno de lus Gtulos. Jos datwos correspondientes a ese libro se vViv,

,_f_‘;gr;in ]
la ventana principal.
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Generalmente una base de daros estid clsifivada por alzuno de sus campos, en
nuestra caso lo v a estar por ¢l campo “Titulo™ Para realizar esta operacion nos
va a ser de gran ayuda L propiedad Serted: cuando esta propiedad 1enga valar
True (-1}, Visual Basic visualizard la ista clsificada.

Pary disedar esta aplicacién, comignce un auevo provecto v asigne a ki forma
¢l nombre Libros Prestados. A conlinL‘acién afada cuatro cajas de texto. cada uny
de las cuales se corresponderd con u;ivlcap{po del registro, y cuairo etiyuelas gue

tas identiliguen.. !
Comrol Caption CtiName
-C;sja de texio | Tiwlo
Cujar de 1exto 2 Aulor
Caja de 1exto 3 ' Ediorial
Caja dL: lexto 4 Prestado .
Etigueta | Tiwlo:
Eliqueta 2 Autor: )
Engueta 3 Editorial:
Etiquera 4 Prestado:
1

Hagu que Ta caja de tenio Prestude sea una caja muftilines v con una barra de
desplazamiento vertical. Eswo le permiuri introducir varias lineas de informacion,

valor 2.

Ahora anadi un mend denominado Fichero con la ardenes, Aadir Registro,
Buscar Registro.. y Salir. Asiyne a estay Ordenes los nuombres AidadirRey;.
Biscar Reg v Saliv respectivamente.

Bjecute Liorden Save Project para gusdir el trabajo realizado hasta ahora y
astgne a LaTorma el pambre fibros frm v a L aplicacion el nombre fibros.mak.
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Para ello, ponga ba propiedad Multiline a valor True y la propicdad ScroliBags o

Titulo:

Aular: l:

E dilonal: [

Piestado: '

lin primer lugar vios a esenbir el cddizo correspondicate o la orden Adadir
Regisiro del memi Fichere. Cuando el usuario haga elic en esta ovden desearid gue
el comtenido actual de las caas de wexo sea almacenado en a bise de dutos,
Nuestra base de datos va a estar formada por un arriy de registros denominado
Libros, que lo dehoiremos. como se indica a continuacion, en el madulo elobal
Lbros.bas. 1n ¢l proximo capitulo veremos como almacenar estos datos en un fi-
chero. '

Type Registire :
Tituelo &s Zt-ipg = 30
Autor s ETrirg * i '
Edivcrial z2: Scrize =~ 12
Prescaco L: Zirirg = L4
End ‘lyns
Global Libresz!l 7o <3) 23 Registrio .
CGlobal Totellzcs ~sg Intager

Visualice et midulo global.bas. escniba las declaraciones v definiciones an-
rjores y guarde de nuevo el madule, ihoca con el nombre fibros.bas! para 1o
cual tiene que cjecutar la orden Sasve File As, del menai File

Un"amray definido de esty forma puede ser accedido desde cualquicr prove-
dimiento de la aplicacion. Observe que el array pucde tener un midximo de 40 re-
gistros. Pary levar la cuenta de Tos registios que hay almacenados. se ha definido
la variable ToralReys. 1 valor inicial de esta vatiable es O,
' ‘ ”

Para acceder al primer registro deb array, Librost ), primero incremente Ty
variable TetalRegs: después almacene L informacion de cada ung Jde lus cijas de
texto en los campos correspondicntes del registro. A continuacion. hay gue anadir
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el Trulo a Ia hista gue apareceri en la caja de Jdudlogo gue se visualiza cuando se
ejecuta ba orden Buscar Registro, Para los siguizntes registros del aray se proce-
de de L misma forma. El procedimiento complaio se muestry a continuacion,

g scivReqg Clice ()
*ZT3E - #1CTERI-2Z8E - -
stToralezz), Tizul
s{Totaltrzess) . iutar
siTortalizecs).zcizo
S tallcecs).Fress:
TormZz._istalLibros.xdédIz

Zra Sub . ‘

El método Additem permite anadir un elemento a una lista (lista o combi-
nado). Su sintaxis ¢s la siguiente:

nombre-lista. AddIlem elementol, indice)

donde nombre-tista es el nombre del control tlista o combimido) y elemenio es
una ¢udena de caracteres correspondiente al elemento a afadir. El argumento in-
dice, si se especifica, indica la posicion donde se insenari el nuevo elemento. Un
valor ) indica lu primera posicion. Si indice no se especifica. ¢l elemento se afia-
de al final de la lista. '

La lista se visualizard clasificada 51 la propiedad Sorted del control se pune a
vator True (-1).

Siguiendo con nuestrs aplicacion. ¢l paso siguiente ¢s afadir una nueva forma
que conlenga la caja de didlogo que se tiene que visvalizar cuando se cjecute la
orden Buscar Registro.

Cree una nueva forma. Form2, v asignela el nombre Buscar Reyisiro. Des-
pués, elinine los botones gue permilen maximizar v mintmizas la ventana, po-
niendo a valor False (0) Tas propiedades MaxButton v MinButten respectiva-
menle y fiyje ¢l borde, asignando un valor 3 .2 la propiedad BorderStyle. para que
no se pueds moditicar el lamano de la forma.

A continuacion aiada los controles que se especifican en Lt tabla siguiente. El
resubtade se ve en la Higura gue Se imuestra a conlinuacion.

[‘('nnunl

‘ L.isti

Caption ~ Sorted

|
! CtlName

ListLibros I True
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| Boton | Aceptur Aceplar
i
! Buton 2 Cancelar Cancelar
I - ——
i Bolon 3 ~ Bormar Romar !
! A
4
I
: -1~} |
= . I
Listalibios
Aceptai
Cancela

Escribamos ahora el cddige para la orden Buscar Registro, Cuando el usuario

haga clic en esta orden se tene gue visualizar fa caju de didlogo presentiuda en la
figura anterior, Jo gue se consigue ¢jecutando b método Show para esu forma.

Cuando se visualice la Fforma Buscar Regisero, apareceri sobre etla la lista de
libros clasifivada v el boton Caneelur enfocado. Ahora, el vsuanio seleccionard el
libro que busca. del que quiere conocer el resto de los dutos.. Una vez selecaw-
aado. hard clic en el botan Aceprar para que los dittos relativos @ diche libro se
visualicen en la ventana pringipal. También, en lugar de hacer clic sobre el boton
Aceptar. el uswarivy podriac optar por hacer un doble clic sobre el clemento selee-
civnado, ubteniendo el inisimu resultado,

Quicre esto decir. que tanto el procedimicnto igado al botdn Aceptar como el
procedimiemo ligado a La lista para un doble clic. tienen gue invocar a un mismo
procedimiento. VisualizarRegistro. que se encargue de buscar el registro en la
base de datos y de visualizarto en L ventana principal.
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sibros_Dnt
izualizerss

Para que un procedimiento (Sub o Funetion) pucda ser invocado desde cual

quier parte de la aplicacion. hay que colocario en un madulo. proceso gue reah-
zamos mids adelante. 1 '
) ‘-"

Una vez presentada Ly forma VisialiZar Registro ¢l usuario s¢ puede encon.
trar con gue el libro que busca no estd en'la hsta v debido a cllo. simplemente,
quicre abandonar esta caja de didlogo. para lo que pubsari cl butdn Cancelar.
Quiere esto decir, gue ¢l pmcedlmu:nlo hoado al botdn Cancelur ticne gue ocul-
tar 1a forma Form?.

S:h Czrneczslar_Click ()
For Hide
Ird Sun

La funcién de la orden Salir es finalizar 1a aplicacidn, cosa que se consigue
¢jecutando la sentencia End.
Sub Salir

£nd
“nd Suo

_Click {}

Crear un mddulo

Para crear un madulo, seleccione la orden New Module del mend File v a conti-
nuacién siga uno de los dos caminos a) o b) gue se indican a continuacion:

a)  En la ventana de cédigo que aparece escriba el procedimiento, incluvendo Tas
lineas Sub y End Sub del mismo.

b) Fjecute a orden New Procedure del mend Code. En la ventana de diilogo
que se presenta, clija la opeidn Sub y esciiba en |y caju de testo el nombre
del procedimieno VisualizarRegiviro. Finalmente. pulse ¢l bowdon OK » &5-
criba el cucrpo del procedimiento entre Sub v End Sub.

Para modificar un maédulo exastente, seleccidnelo en la ventana Je lu e2lioe-

cidn, pulbse ¢l botdn View Code. v seleccione el provedimicmo en la caja oo ooo-
cedunientos Proe: de L ventana de codigo presentada. -
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Siguicndo con la aplicacion v teniendo cn cuenta lo expuesto anfenomente.

el procedimiento VisualizarRegistro es el siguiente:

Observe gue el procedimicary anterior realiza uni hisqueda secuencial & par-
nir del registro L para hallar la posicidn [ en la que se encuentri el registro co-
rrespondiente al hibro buscado, ’

Tenga en cuenta que al ser Tas cadenas de caracteres de los registros|del array
de longitud Dija, Visual Basic las completa con blancos. Dos cadenas de caracte-
res con la unica diferencia de gue una de ellas tenga al final wids csp'lciu:. en
blanco que I otra. son desizuales. Por ello. para evitar resultados lllt.sp\.l'ddt)b.
utilice la funcidn Ririm$ que climing los espacios ¢n blianco a la derecha de una
cadena Je carcieres.

Eliminar un elemento de una lista

Para finalizar nuestra aplicacion queda por esernibir ¢l procedimiento asociado con
lu orden Borrar de Ly caji de didlogo Buscar Regisivo.

Para eliminar un elemento de una Bista o de un combinado se utiliza el méto-
do Removelteni. La sintaxis es Lo siguiente:

nombre-liste. Removeltem indice

donde pombre-lista ¢ ¢l nombre del control (lista o combinada) v el argumento
indice indica la posicion delelemento que se desed chiminar. Un vador O indica la
primiera posicion,
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l.a propiedad ListIndex du la posicion. respecto de 0. del elemento actual-
mente seleccivnado. También permite Njar dicha posicion. Su sintaxis es,

[forma Jeontrol Listindex| = posiciont|

Cuando el usuario pulse ¢l botén Borrar. el elemento seleccionade tiene que
borrarse de Ly bista ListaLibros v del array Libros. Tenga en cuenta que u lista
estd clasificada vl anay que forma da bhse de dutos no o estd: quiere esto decir
que un detenmnado elemento gencr-;i'lnf.:hlc ocupuard posiciones diferentes en la
lista v en el armay. Para borrar el registro del array correspondiente al clemenito
seleccivnado de la lista. primero realizamos una bisyueda secuencial para locali-
tarlo v después to bortamos escribig:ndt,'l ¢l siguiente registro sobre Sl o que
implica retroceder uni posicion 10dos 10s registros que estén a continuacion del
gue queremos borrar. Y para borrar el elemento seleccivnado de la lista, caleula-
mos su posicion pur medio de la propicdad ListIndex v lo climinumos utilizando
el método Removeltem.

El siguiente procedimiento realiza estas dos funciones.

th

SimS(Linrests
SimS{Torm: Ll

h ~— i

1
[

lest
if - lRz2s Ther zZxit &:b 'Mlo encentraas
VS e
rer = Tcre_.rfec: - L
L i) = Liprosiz - L)
I
L: Tozalksgs) . rizilo =
Li Totalfezs) . AuTor o=t
I, Tonalkase)  Zéineovizl o= ot
L Totalkegs) . Freszaio = 7
T £ = Teuallegs - L
' Ss = ==z
' sta
: roaLLlar s
el SR O TaLERr =l
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Utilizacidn de combinados

La diferencia entre una fista ¥ un combinado ¢s gue ¢l combinado es una lista con
una cajit de texto en la que el usuanio pacde oweribir su rOpiY XL, COTTes-
pondicate 4 un postble clemento, sin necesidad de ~:Iccciu:!!Lr un clemento de la
lista. Hay tres estilos diferentes de comhinadin bos cuales se muestran en la figura
siguiente como Combol, Combo2 v Combod, 0

[Combul I[E_' [CnmboZ ] |Cnmbo3 |_!I

~ El conrol Combol represents un combinido estindar v sé obticne poniendo
la propiedad Style, usociada con dicho conral. o valor ( Cuaido ¢l usnario hagy
clic en fa tlechi, se visualizard Ja lista de clementos v podrd optar por elegir un
elemento de 1a lista o por esenbir directumente el clemente descudo en la caja de
exto. .

El control Combo? representa un combinado en el cual la lista de elementos
siempre esti visualizuda y se obticne paniendo b propicdad Style. asociada con
dicho control. a valor T ElLusuario_podei optar por elegir un elemento de fa bista |
o por escribir directamente ¢l elementy deseado en la cuja de exto.

] contral Comubod representa un combinado que se diferencia del estdndar en
que el usuwio s6to tiene la posibilidad de elegir un elememo de la lista, esto es,
no se e permite escribir en la caja de tento. Se obtiene poniendo ta propiedad
Style. asocizda con dicho conrol. o valor 20 Enoowras palabras. Combold es uira
fista encollable, '

Para vee como trabajga este control viamas i madiniear nuestri aplicacion Li-
bros, introduciendo en la caja de didlogo Biescar Libre un combinado en lugar de
una lista.

L.a modificacion mas sencitla e sustituir la lista por un combinado estito 2.
Para realizas esta operacian sefeceione fa lista v borreta, esto e, haga clic en el
controb ListeLtbros y pulse kotecla Supr iDeh. A continuacion elifa del panel de
utilidadzs el conirol combinedo v atidalo a la Torm como se indica en la figura
siguiente. Ponga la propicdad Style o valor 2. la propiedud COName a valor Lis-
tulibros v la propiedad Sorted a valor True.
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Ejecute ahora L aplicacion v vea los resultados gue se obticnen. Observe que

el procedimiena Listaf ibros _DOICHCK ahora po le sirve.
ll.istaLibm: ' |£l | Aceplar I
|

Maodifigue ahora la propiedad Stale del combinado Listalibros a valor § y
ajuste el famano del control como se indica en la figura siguiente. Ahora tiene un
combinado estilo 1. Ejecute ahora la aplicacion v vea los resultados que se obtice-
nen. Observe gue el procedimiento Listalibros_DbICHick ahora si le sirve, Ahora
también puede escribir directamente en la caja de texto el elemento con ¢l que de-

sed operar, aungue no esté en la lista.

= -]-]

: Aceptar

Cancelar

Bonar

Jald)

Por ullime, modifique la prapiedad Style del combinado ListaLifros a valor
0. Ahora tene un combinado estilo 0. Ejecute la aplicacion y vea los resultados
que se obtienen. Observe que el provedimicnto Listalibros_DBICHck no le sirve.
En este caso tmbién puede eseribir directumente en ta coja de exto e clemento

con cl que desean operar. aungue no esté en Ju hista.

Pary acceder a los elementos de una hista o de un combinado, puede utilizar
alguna de lus propiedides siguientes: Text. List, Listdadex. o ListCount. Las

propicdades Test y ListIndex va las bemos vistwo con las listas,

1
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La propicdid List se corresponde con un aray de cadenas de caracteres que

i : v acecder e de o Coole s haralo
contiene los clementos de To st Pary aceeder o uno de estos elementos hig

comi si de olro armay se traki. st es,
(forma.eontrol ListUidice )| = elementos)

L primer elementa ticae conto indiee Oy el il I.|s|(_!qUnl -1

e ..

1 ' I l\“ - - - Hi
La propiedad ListCount da como resultado el ndamero de’elementos, que hay

en ¢l controld ilista o comhinado).

Modifiquemas ahora nuestra aplicacion para gue cuando-e usuario eseriba en

la caju de eato del combinado un elemente que no oste e Ta s, se visualice
una forma con o mensaje gue o indigue. Cono i al principio de este capi-

wilo. esto se puede facer Fcilmente uiilizando Ly senencia AMsgBox,

Para consexuir la especificado,
comu ¢ especilicat a conlinuicion.

gisvro ()
Leger,

To Totalbleygs

- rado} Then

cetado.Text =

o Eide

~

"1

ST
1

inta

S0

11
]

orcontrado As ntace
= 0 'elemonto O enuonilian

W iLibrosiTy. . Titulo) =

SiForm?.Listalbibros.T
rago = -1 'elamehily enconinaco
Tor

Stulo.Tent = Libros(r}).iiiuio
tor.Text = Libros(i) . utor
irorial.vext = Bibros(I).

G *T1 libro esmecificeto o se 3

madifigue ¢l moduly ViswalizarRegisiro

Libros(i).=?

Observe que L1 ipformacion de si un determinado titulo se s:m:ucnlfu 0 no en
la basg de datos. nos fa da lu vaniable Encontrado. Coando el tiwlo especificado

. H - - et . a0 lsle
en la cuja de texto del combinado de estilo 0 o estilo 1 no se eocuentre en la lista,
la variuble Encontrado vildia Oy se visualizard L forma gque se presenta en la fi--

surd siguiente.
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=

@ El libro especiticado no se encuentra

BARRAS DE DESPLAZAMIENTO

Las barras de despluzamiento son a menudo utilizadas en cajas de wexio y venta-
nas para desplazar 1a informacion hacia abajo o hacia arriba de fa ventana, o hacia

la izquierda o bacia la derecha de la vemana. Pero tumbién pueden utilizarse

como controles de enteada como muestra la figura siguiente,

FVaIacidad del teclado

| LAcepta |
Betardo antes de la piimera 1epeticion

Laigo -Coito | |I' cancetar
IcE L

Rilmo de repelicidon

Despacio Rapido
el . L
Piueba:

L |
—-——————#-—_——J

_Una barra de desplazamiento representa un valor entero. Cada barra de des-
plizamicoto tiene un bowdn que se desplaza a lo largo de la misma. La posicién
inicial se corresponde con el valor minimo. L posicién final se corresponde con
b valor maximo y cualquier otra posicidn es un valor entre estos dos.

El valor minima se especilica medianie Ja propiedad Min y el valor maximo
mediante la propiedad Max. Cualguier vulor comprendido entre el minimo y el
mdvimo especitivadus. depende de L posicion del boton que se desplaza a lo
karge de Ta barra y viene dado por la propiedad Value

o el usuario hace clic encima o debajo del botén, este se desplaza una
vat, g, negativi o pasitisa con respedto ol posiciin actual, que es espeti-
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ficada por la propiedad LargeChange. Cuando ¢l usuario hiace clic en la flecha
que estd al principiv o al final de Ty barrit ¢! botdn se desplaza una cantdad hja.
negativa o positiva con respecta a la posicion actual. que es especificada por la

propiedad SmaliChange.

La unidad de medida wilizada por defecio por Visual Bglsil’.‘ es el twip que
equivale a 171330 pulgadas, El amaio de una fuente se especifica en puntos. un
punto se define como /72 puleadas v un twip es 1720 pur{"s.-'._Un twip cs una
unidad de medidi independiente de a pantadla lo que garantiza que la situacion v
la proporcion de los objetes de una aplicacion en L p;mlull:n;,':scn'la misma en 1o-
dos los sistemas, :

-
Cudy vez que el usaariv desplaza ¢ botdn o o largo de la burra se da el suce-
su Change.

Coma ¢jercicio vamos i construiy una aplicacion gque permica visualizar el ca-
ricter correspondicnte a un cadigo ANSI en el cango de 0 a 235, Como se mues-
tra en I fzura spouiente, una barra de desplaziuniento proporcions un valor de 0 a
255 que se visualiza en una etiguets, v oen otra etiqueta se visualiza el cardeter
correspondiente.

Inicie una nueva aplicacion v asigne 2 la forma por defecto el ritulo ANSE A
comtinuacién ponga sobre la forma los comtrales con las propicdides que especifi-
can en la tbla siguiente, ajuste Tos lamados y guarde la aplicacién con ¢l nombre
barras.mak.

Tilic|uct;| l Erigueta 2| Eiiqueta 3 F.liq‘ucm 4 :3):?;:;

L(.‘u[)tiun _ Cadigo ANSE {0 Caricter: § Gunla)

CiName Labell Cddigo Label2? Cardcler | DespH
FonlSize 8.5 13.5 8.5 135

BorderSt e U 1 0 |

Min ¥

Max - 235
SmallChange | |
LargeChanyge
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Cadigo ANSI: 'Eméclel: @

(e L [+]

L,

Wl
M

Cuandu el usuario actie sobre ia.bura de desplazamiento DespH, se dard ol
sucesn Change para este control, 1o que hard que se ejecute el procedimicnto
asociado DespH_Chunge el cual tiene que visualizar el cédigo ANSI en fa cligue-
w Codigo v el cardcier comrespondicnte enla etiquety Cardcter.

Iub 2&gX_Change () .
¢ go.Caption = ForzarsS{bess. 'zl
C ter.caption = CnrsS(Des

DesED

MARCOS

Un marco tiene propiedades propias {por ejemplae. tlo. color) caracieristica que
gprovechumos cuando queremos reslzar el aspecto de una forma. Normalente.
un marco se utiliza para agrupar objetos relacionados eatre si.

Fara crear up marco. proceda coimo se indica a continuacidn:

I Dirgase al panel de unilidades y haga un doble clic sobre Ja utilidad marco, o
bien selecciune esta wiilidad viilizando la ecla Tab v pulse Enter.

20 Ajuste ¢l tamaiio del marco y muévalo a la posicion deseada. Puede hucerlo
con ¢l ratdn o moditicando lias propiedades correspondientes,

3. Silo desea, ponga un tido al marco. Scleccione la propicdad Caption y es-
criba el tiulo yue desee,

Una vez creado el marco, anada los controles que van a estar agrupados bajo
el mismo. Para adadic un control, dirfjase ad panel de utihdades. haga un clic
subre €1, desplace ¢l ratdn (+) al interior del marco, v con el botdn izguicrdu del
raton pulsado arvastie hasia dibujaclo.

UN SHELL DE WINDOWS

La funcidn Shel de Visual Basic permite ejecutar cualyier lichero ejecutable. Su
sintaxis e Ta siguicnte:

idd = Shelllordend], estilo% )
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COLORES

L.a cadena de caracieres orden$ es el nombge del programa a n.'jcculiur inclu-
yendu los areimentos en linea de drdenes. Este nombre corresponderi o un fiche-
ro existente ¢n ¢l diseo con extensidn .COM. EXE. BAT. o _PIF. E] pardmetro
estilo determing ¢l estilo de s ventana sobre la coal se va a ejecutar ¢l programa,
Los posibles valopes para este pardmeatro son,

| Ventana nocmal. enfocada | ¢

2 Ventana minimizada. enfocada l?ill- .
3 Ventan maximizada, sin enfocar R
- Venlana normal. sin enfocar :

7 Ventana mininuzada. sin enfocar

Si el programa se ejecuta satistactoriamente. 1a funcion Shelt rcmrn.ii un valor
tnice id que identifica al programa areancado. En oico caso, Visuad Basic penera

un mensaje de error.

Durante ¢l diseio de una aplicacion e puede afadir Cicilmente color a Lis formas,
a los controles y a los grdlicos wilizando Ja palets de colores de Visual Basic. La
paleta de calores ofrece 48 colores fijos ¥ 16 colores mds que ¢l usuario puede
detinir y afaudir 2 la paleta. .

Para poner color a un objeto durante ¢l diseiio, los pasos a seguir son os si-
suicntes:

1. Abrir la pale de colores. Para ¢llo ejecute la orden Color Palette del mend
Window. |

Seleccionur el objeto. Puede selecoionar cuatquier forma, CO!I!I'Ull o grifico

(3]

haciendo clic subre ¢l

3. Flegir of color de fondo v del primer plano (vea la paleta de colores en ¢}
Capitalo 1)

También durante Ja ejecucion de una aplicacidn se puede modificar el color
de cualguier objeto.

Por ejemplo. suponga una caju de tento denominada Resuftado que se utiliza
para visualizar resultados puméricos positivos o tegativos, El siguicnte procedi-
miento, figado a esta caja vy gue se ejecuta cada ves gque su contenido cambia,
utiliza dos colores para diferenciar un valor positive de otro negativo,
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T, 233} tcvolor zzul

2, 0) *color rojo

. . 11 l .
En este ejemplo. la sentencia If apaliza el valor de la caja de 1exto Resubrado:
si es positivo asigna al primer plano (al texto) ¢l color azul y si es negativo asigna
al primer plano el color rojo.

Funcién RGB

La funcion RGB permite especiticar un color cualquiera. Su sintaxis es la si-
guienie:

RGBUojot, verdet, uzul')

La funcion RGB tiene tres parimetros enteros en el rango de 0 a 255 que es-
pecifican el nivel de color rojo, verde y azul respectivamente. Esta funcion retor-
na un ¢ntero de cuatro bytes (entero largo) que representa el color RGB especifi-
cado. Este valor expresado de una forma genérica en hexadecimal es de 1a forma

“&HOUAAVVRR. L1 byte mds significativo es cero. v 10s tres bytes siguientes es-
pecifican el nivel de color Az, Verde y Rojo respectivamente.

La siguiente abla muestra fos valores para algunos colores estindar.

Color valor RGE nivel de azul  nivel de verde nivel de rojo

Negro &HON 0 0 0

Azul &HFFO000 155 0 {

Verde &HFFOO 0 255 0

Cyan &HEFFFO0 153 255 0

Rojo &HFF 0 0 235

Magenta & HFFOOFF 255 - 253
CAnuanlle &HFFFF 0 233 2535

Blanco &HFFFFFF 253 235 235

Visual Basic dispone wmbién de la funcion QBCulor y det mérodo Point.
que ~rin ditectamente relacionados con la funcion RGH.
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4.

Lz funcion QBColor tiene un tnico arrumento entero en ¢f rango de @ a 15
que se comresponie ‘con un color estindas, v devuelve como resultado un entero
larzo correspondicnie af color RGE.

Tor~l Zackfoins = QBColovi{l) rooior zxnul t
N !

El método Point tiene dos argumenios de (ipo real de précision simple gue
especifican las coordenadas de un punto de uma forma o de l!l'ha imagen {contrul
imagen) v que devaelve como resultado un entero Jargo mmspondleme al color
RGB que tiene el pumo especificada. 1as coordenadas estin r;fundaz. ala forma.

Color = ~orml.3cinci{(, 0)

APLICACIONES A MEDIDA

La sizuicnte aplicacion presenta sobre la pantudla una simple ventana con un
mend Fichero. Dicho ment estd formado por tres drdenes: Punel de Control, Eje-
cuiir y Salir,

Un panel de control sirve para definir cienas caracteristicas de una aplicacion.
En nuestro caso, nos va a permitir defiair el wnado. ¢l color de fondo y el tiwlo
de la veniana principal que por defecto es Formi, La figura siguiente muesira la
ventana principal y el panel de control gue queremos disenar.

Yitulo de la aplicacion ,Folml | :

" Tamafio  Colot
Alto Ancho Rojo _
Veide

L EL

Azul

CLTLTH| [Conortar]
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Pary empezar cree una aueva aplicacion. panelmak. v afiada a la fonna ' Canti CtlName Min | My Simall Large
. . - o aption “UName A M . .
Form i el mend Fichere con lus drdenes que se indican en la siguiente tabla: I Change | Change
.. Tilo de la
Lueta | L
Caplion CtiName _ | uplicacion i
- 3 Cajade texto NuevoTiulo i
Panel de Control.. | FicheroPanel i . !}i
THE i . B ~ . ..
. O ) ’ Marco | Tumanio Tamano S
Ejecutar... Y 1 FicheroEjecutar
_ | ‘ ) Fliquets 2 Alto
Salir " FicheroSalir — _ _
S A Engueta 3 Ancho "\
Cuando FI usuario haga clic en la orden Sr_:hr la aplicacién iene que linalizar. Barra V. | Ao HHNE | 5000 | 57 370
El procedimiento siguiente realiza esta operacion. . :
. L ) . Barru V. 2 Ancho SO0 | SO0 | 37 370
Sub FicreroSalir_Clizh () - _ I |
End . . '
ad sub ' ) Marco 2 Color Color
i} siguicnte paso es diseiar el Panel de Conyol. Cree una nueva forma v Etiqueta 4 Raojo
asignela el titulo Panel de Control. y ¢l nombre (FormName) Pane{DeControl. — i -
Etiqueta 5 Vende
Hsta forma va o contener 103 siguientes controles; una caja de 1ex10 que - . I
permitird al uswario inoducic on nuevo nombre para [y ventana principal. Dos Etiqueta 6 Al
harras de desplazamiento vertical que permitivda al usvario imodificar ¢k tamafio i - i
.. N B LET \ 185 b}
de la ventana principal. Recuerde que las medidas para una ventana hay que ex- Barra H. | Rojo LU R 20
presarlas en twips, Tres barras de desplazamiento horizontal gque perwitivin al s |
. . o ; ferde 153 )
usuario vanar el color de fondo de la ventana principal. Un marce, Muestra. para Barra 11. 2 Verde - 0 235 |—0
ver una muestra del color seleccionado. Paca resaltar las caracteristicas del panel B W3 s = !
de vontrol agruparemos las burras de desplazamiento de acuerdo con su funcion, arra il - Azul U -2 | TO
para ko que utilizaremos dos marcos: Tamaio v Cofor. Un boidn, Aceptar. que N 3 N : \
penmitind af usuario sceplar las caracteristicas nonmbre. tamaio y color especitica- reo uestr luestra
dus y otro botdn, Cancelar. para poder retomar a ki ventuna princepal sin realizar ) .
ninguna modificacidn. Boton | Aceptar Aceptar
. . , in ? . FI . s
Recuverde que para agrupar dzotro de un marco un Jeterminado nimeso de Boton 2 Cancetar Cancelar ‘
contrales, primero hay que aiadic ¢l marco a fa forma ¥ despuds se incluyen los
controles en el nugeo. . = )
Ponea la propiedad Text de la caja de texto i valor nulo, .
Fijese en la figura anierior s anada a Ta forma Panel de Conprel, los controles . . ) o .
gue en ella se muestran ¥ yue acabamos de comentar, espectlicando s propieda- A continuicion, llnl‘n:nm.s cl c‘)d'gu. 4 .I.m. controles v a ta forma. I-_umcce.mos
des que se indican en la tabls sisuiente por la orden Panel de Control deb mena Fichero, Cuando el usuario haga ¢he en
L
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esta orden tiene que visualizarse el panel de control. el cual tiene yuedar automi-
ticamente inicializado con las propicdades actuales Je la ventana principal.

Sub FicheroPane: _C_ick (1}
PaneldeControl  3-aw
=nd Sub

Cuando se carga una forma se da|cl Juceso Load asociada con la misma, cir-
cunstuncia que aprovecharemos par:r rcnllzar las iniciahizaciones correspondicn-
1es. El procedimiento asociado con ésie ‘suceso. s¢ cjecuta solamente la primera
vez gue se visuatiza el panel de control ya que como veremos mas adelante, los
bolones Aceptar 'y Cancelar oculian la forman. no la descargan. Las siguientes
veces que se visualice el panel de control. conservari los valores que ¢l usuario
“1j6 Ja Glima vez.

Sub Form_Load ()
Dim Color 2s iorg
Dim Fojo As Il.._a;e:

ala

n

ser, ~zul As _sleger

5”*..

‘Inicializar ca ce -

PaneideContro! tiiaveTl = Forml.Captizn
*Inicializar barras iz |
PanelDaControl.xizo.'2 nl.Height

"PanelDeControl.nch :o:ml.u1dLh
‘Inicializar la =y jofe Pl
PanelDeControl.Mue lor = Forml.BackxColor

‘Inicializar parr
Color = Forml,Poin
Rojo = Color rnd &H
Color = Color \ 25
verde = Color
Color = Color \ 236

Azul = Color zrg £HFT
PaneliDeControl.Zojo..
PaneineControl \Verde.
PanelbeControl 2zl

End Sub

Jn-

Este procedimiento pone el nombee actual de ka ventana principal en la caja
de texto, inicializa Ya propiedad Value de cada una de las burvas Afto v Ancho con
el alto y ancho actwales de la ventana. inicializa el cotor de foado del marco
Muestra al color de fondo de la ventana principal. e inicializa 1a propiedad Value
de cadu una de las barras Rojo. Verde v Azul con los niveles de rojo. verde y azul
actuales. La operacion And de.Color con FF nos da el byte menos significativo y
la division entera de Color emtre 256 realiza un desplazamiento a fa derecha de un
by
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Si el uswario guicre ntrodducic un nuevo titnlo pari Ly ventana principal lo es-
cribird en L caja de texto. Siquiere nendificar ¢l timado de la ventana principal.
actuard sobire Las burmas At v Ancho. S quicre modifear ¢l color de fondo de la
ventana principal actuard sobre las barrus Roge. Verde y Azul y al mismo tiempo
tiene gue estar vidndo en el marco Muesira las \.:u.iutmn_s; s color gue estd pro-

duciendo. o
[

.

Cada ves que se despluza el cursor a 1o largo de una barri: se da el sueso
Change. Por to tanto, af fijar ¢l nivel de color en las h.m.ls Kojo. Verde y il
los procedimientos Invocados tienen que cjecotar i funcion. RGB para esos valo-
res. con el fin de actualizar ¢l color de fundo del marco Muestia.’

BUZVROI0 e, asizi
Lol alis

_Chenge {}
.BacxColor = ECG3(Rojo.  zlue, Verde.valuo, Moot Vallzs)

Una vey tijadas {os caracteristicas deseadas. el usuario pulsard ¢l botin Acep-
tar, momento en el gue se trasladan dichas carcteristicas o a ventana principal v
se oculta la forma. El procedimiento asociado con este botdn - senta a conti-
auacion.

wevoTitulo . l'ext
Valus
value
zrnelleControl.

.."‘C-\(_OIOL" =
cCortrol b

Mieastra. 2aciColor

Si en lugar de pulsar el boton Aceprar el usuario pulsacel boton Cancelar. no
se tienen en cuenta las caracternisticas hjadas y se oculta fa forma.

Finalmente. cuando ¢l usuario haga clic en ta orden Ejecirtar.
sulizarse una cid de didlogo que solicite ¢l nombre de una aplic

s que vi-
- que desee



-

- | ‘ ) CAPITULO3

INTRODUCCION

El lenguaje Visual Basic es1d muy cerea en muchos aspectos a sus predecesores
QuickBasic, QBasic, y al Basic prolesional. todos ellos de Ja firma Microsoft. Por
ello, si no tiene conocimientos de alguno de estos lenguajes, le 5u‘t__-i::{rn adquiera
mi libro sobre QuickBasic o mi otro libro sobre QBasic v ,‘US-DOS‘publicados
por la editorial RA-MA. No obstunte, este capitulo explica algunos mecanismos
del lenguaje para que usted recuerde y pueda continuar leyendo esta obra con co-
’ modidad.

PR - . |
Visual Basic adopta los tipos de datos. estructuras, y muchas de-las reglas
sintdcticas de sus predecesores. Sin embargo. hay algunas diferencias, como las
que se indican a continuacion, gue endrd que aprender.
« _Eldmbito de trabajo de tas variables ahora es diferente. |
e las variables de tipo Currency contienen canmidudes fruccionarias!
¢ Las llamadas a funciones (Function) deben incluir paréntesis, aungue no ten-

an daraunieatos.

Por supuesto. hay otras diferencias entre Visual Basic y QuickBasic las cua-
les se verdan mas adelante,

COMENTARIOS

: - Cuando una frase va precedida de una comilla simple (* ), Visual Basic interpreta

que esa frase es un comentario y no ejecuta accion alguna sobre ella. Por ¢jemplo,
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' Céilctiln e L
suma = % g

CONSTANTES NUMERICAS Y DE CARACTERES

Una constante es un valor que no c:imb'a duranie 1a ¢jecucion de un programa.
Viswal Basic admite nomeros decimalgs (base 10). hexadecimales (base 16) y
octales thase 8). Un nimero hexadecimal va precedido por &H y un niitero octal
va precedido por &0. El siguienie ejemplo muestra los mismos adimeros en de-
cimal, hexadecimal y octal. w

son nimeros decimales

9 15 :
&H% Liir & son numeros hexadecimales
&017 L0177 4 son niameros octales

Una constante de caracteres o constante alfanumérica es una cadena de carac-
teres encerrada entre comillas dobles. Por ejemplo,

"Grecdos centizrzics:®

. VARIABLES

Una vartable contiene un valor que puede modificarse a o largo de la ejecucidn
de la aplicacion. Cada variable tiene atributos propios comu:

»  Nombre. Es el nombre que wilizamos paca referirmos a la variable en la aph-
cacion.
o Tipo. El tipo determina qué clase de valores puede almacenar la variable,

o Ambito. F imbito de una variable especifica en qué pante de la aplicacion la
variable es conocida v por lo tanto puede utilizarse.
Nombres de variables

El nombre de una variable tiene gue comenzar por uaa Jetra y puede tener hasta
J0 caracteres de longitud.

Los caracteres pueden ser detras, digitos, el cardcter e subrayado ¥ los carac-

teres de declaracidn del upo de Ja vanable (e, &, 0L # @, v S). ELnombre de una

v no puede ser una pilabra reservada.
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Una palabra resenvada tiene un significado especial para Visual Basic. Son
palibras reservadas las sentencias predelinidas (For) v los nombres de funciones
{Vah. métodos (Hide), propicdades (Captiony y operadures (And),

|
| 1

Tipos de datos 't
' L

Una variable puede ser de alguno de los seis tipos siguienes:

Caracter de decla--

Tipo Desceripeidn racion del tipo "Rango
Integer Entero ‘,} " 32768 a
(2 byles) 32767
Long Entero largo & -2HT7483648 4
(4 bytes) - 2147483647
Single Real simple ! -3376438 0
{por defecto)  precision (4 bytes) 3.37E+38
Double Real doble # -1.67D+308 a
7 precision (8 bytes) L.67D+308
Currency Numero con punto @ 9.22FE+1da
. decinal fijo 922E+ 4
String Cadena de S 7 .
cunicteres ‘

Antes de utilizar una vanable, hay que decluar su tipo. Uni forma de hacer
ésto es ulilizando la sentencia Dim (o una de las palabras Global o Static). Cual-
quicr declaracion de &stas inicializa las variables numéricas con ¢l vator cero-v las
vaniables alfanumdricas con el cardctes nulo. Por ¢jemplo, )

A3 Innzger

~8 Decuble

lonbre s Strinz

iguete 15 Scring * 10
=8 Currency

~s Loryg, X A5 Currerncy

1R

Las sentencias anteriores declanan § como ung variable entera. R como una

-variable real de precision doble. Nembre como una v ariable para contener uni ca-

dena de caracteres de longitud variable, Etigreta como ung cade caracleres
de longitd fija (10 coracteres)y. F como una variable fraccions como una
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variable entera larga, ¥ X como una variable fraccionana. Observe que en una
seniencia Dim puede realizar mas de una dectaracion.

Oira forma de declarar una vanable es utlizando los caracteres de declaracién
de upo. Por ejemplo,

1% Vanable entera ' l

RE Vanable real de precisiof doble
Vomhres Cadena de caracteres )
F@ Vanable fraccionana

Si una variable se utiliza y no se declara se asume que es de tipo Single,

Si de una variable se sabe que nunca va a contener un valor fraccionane. es
mejor declararla como entera. ya que las operaciones con enteros son mis ripidas.
En caso contrario, si el valor no va a tener nds de 4 digitos deciimales v no mds
de 14 digios enteros, es conveniente declararta como fraccionaria (Curreney).
En tas variables de tipo Currency no tiene lugar el error producido en la conver-
sidn entre 1as bases 2 y 10, que si tiene lugar cuando la vanable es de upo Single
0 Double.

Cuando una variable numénica de un tipo se asigna a otra vaniable numérica
de un tpo diferente, Visual Basic realiza la conversidn correspondiente.

Ambito de las variables

variables globales
(declaradas en el médulo glabaly

variables a nivel de la forma’ variables a nivel del médulo

(seccidn de declaraciones) {seccion de declaraciones)

variahles variables variables variables
lociles lovales locales locales
Procedimicnios Procedinmentos
Forma CMaduto
Aphcucion

. CAPITULO X ELEMENTOS DEL LENGUAJE 39

I8

Se entiende por dmbity de una variable. el espacio de lu aplicacion dende la
variable ¢s visible v por lo anto se puede unlizar, La Ngora anterior indica los
cuatro lugares donde se puede declarar una variable.

m" i

Variables locales

Ui variable local se reconoce solamente en el procedimientd®en el que estd de-

finida. Fuera de ese procedimicnto Ly variable no es conodida, Su utilizacion mis
comiin es itervenir en cileulos interimedios,

Para declarar una variable odal o un procediniento, coloque fa sentencia Dim
correspondiente dentro del mismo. Por ejemiplo,

{(meyaseil As Inlager)

'.)l

I7 (
Grac J2ligra do::( Xt * 49 /5 + 32
Craad = ‘O'.’le,::((,‘ldd sranr)

Erc If

End Suh

Una variable local es reiniciahizada cada vez que se entra en ¢l procedimiento.
En otcas palubras, una vanable locil no conserva su valor entre una Hamada al
procedimiento v la siguiente. Para hacer que esto siveda hay que deClarar la va-
nigble estitica. Visual Basic reinicializa una variuble estitica solamente la primera
vez que se Hama al procedimiento P declarar una variable estitica utilice Ja
palabra clave Static en lugar de Diw. Por ejemplo.

Static var_ent ~s Iateger

Variables a nivel de la forma y a nivel del médulo

Una veriable declurada a nivel de la forma puede ser compantida por wdos los
procedimicntos de esa tonua v una variable declurada a nivel del tndiculo puede
ser compartida por todus lus procedimientos de ese médulo. Una vaniable a nivel
de la forma o det mddulo hay que declararls en la seccidn de dc-.lur..slcmncs de 1a
furma o del médulo. Para editar esta seccion, hay que abrir la vemana de cidigo
parir un objeto ¥ seleccionar “teeneral)y” de L caja de objetos y "ldcclalr;llions}" de
Ia caju de sucesos pary ese objeto. La forma de crear un nueso modulo es ejecu-
tando la orden New Module del mend File.

Este tipo de vanables sun por defecto estiticus.
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Variables globales , . Tipo Operacion Operador
. : Logico ~ Negacion Not

Una variable global puede ser accedida desde cualyuier pane de la aphicacion. ! (mancjo de bits)  And And

Para hacer que una variable sea global. hay que declararla en el modudo global de ‘ Or inclusiva C

la aplicacién. Este modulo no admite ¢gdigo. solo admite declaraciones. Eb nom- Or exclusiva !¥u|.'

bre dado a este modula por defecto cs£l:fal.bz:s. P;ira editarlo. seleccionelo en Equivalencia (opuesto a Xor) ! ".‘l"

la ventana Project y haga clic en ¢l boign Kiew Code. , Inplicacion g

 (verdad sio primer operando falso v

Para declarar en ¢l mddulo Global bas una variable global. utilice la palubra sepundo operando verdadero)

clave Global en lugar de Dim. Por ejemplo,

Glohal —z2rl_alobal As :o';'::'-"_e', rar2_clobal s String SENTENCIAS

Variables con el mismo nombre en diferentes niveles Una sentencia es una lines de teato que indica una o miis operaciones i realizar.
Una linca puede 1ener vanias sentencias separadis unas de otras por dos punios.
Una variable local, otra a nivel de ki fonna o del médulo y otra global pueden te- '
ner ¢l mismo nombre, pero no son la misma vanable. La regla para estos casos es
que ¢l procedimiento siempre utiliza la variable de nivel mas cercano ¢local. fur-
ma o mddulo vy global).

rotal = cantidad * srecio: 3

La sentencia miis comdn en Visual Buasic es ko sentencia de asignacidn, Su
forma gencral es,
Si una variable aparece en un procedimienta y no estd explicitamente decla-

rada es por defecto local. Para asegurarse de que la vaniable es local. es mejor
declararla explicuamente.

variable = expresion

la cual indica que el valor que resulte de evaluar la expresicn tiene yue ser alma-
C : cenado en la variuble especilicada. Si Ja expresion es nmnérica la vagiable tiene
OPERADORES . que ser también nuineoea y i fa expresion es altanumérica la \erh!;_ tiene que
ser también .Aif.mumc.m.n Por ejemplo.

La wbla que se muestra a continuacion presenta el conjunto de operadores yue - c c 1 -
. - . . = t ‘
soporta Visual Basic l:U|0Cd('.iOs d.e Iayor a meior privridad. Los (-)le'..ldUl’Ls yue Tntereses = Capitai * TantodorCien<o / 10C
aparecen sobre una misma linea tenen |l_.ru.1_l priondad. Las operaciones enire pa- Mensaje = "lLa operacién €3 correctit
-réntesis se evaldan primero. cjecutdndose primero los paréatesis mds internos,
Tips Operacién Operador PROPIEDADES
1 it N BRI A
Antetico Exponenciacion Recordar que un ohjeto (forma o control) tiene asoviadas varias propiedades. Para
Cambio de signo - . referirse a una prup:ul.nl de un objeto se utiliza Ja forma,
Multiplicacion ¥ divisicn ® ]
Division enterit \ ' objetopropicdad
Resto de una divisian entery Maod
Sumia v oresta +- Por ejemplo, supongamos el ubjets Tevio y su propredad Tew < siguienles
o operaciones serian vilidas
Relu lzual. distinte. mayor gue. ... =, <>, > >3 €, €=
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el {Texto.
Xto.72xrt = “El Zctal =23 * - IiriiTeoal)

La funcion Val convierte una cadena de caracieres en un ndmero v la funcisn
Sir$ convierte un mimero en una cadena de caracieres. El operador + con cadenas
de caracteres, enlaza las dus cadenas para formar una sola.

SENTENCIAS DE CONTROL ¢ "'

Las sentencias de control. denominadas también estrucinras de convol. permiten
tomar decisiones y realizar un proceso repetidas veces. Visual Basic dispone de
las siguientes estructuras. idénticas a las de sus predecesores como QuickBasic:

e« If..Then.. Else
s  Select Case
¢ For.. Next
+ De.. Loop

if ... Then ... Else ...

Esta estructura permite ejecutar condicionalmente una o mds sentencias y puede
escribirse de las dos formas siguientes: .

If condicion Then sentenciais) |Else sentencia(s)]

If condicién Then
semtencials)

|Else
sentenciafs))

End If

Si 1a condicion es verdadera se ejecutan las sentencias que estin a continug-
cion de Then y s 1a condicidn es falsa se ejeculan las semencias que extin a con-
tlinuacién de Eise, si esta cliusula ha sido especilicada (una expresion eoatre cor-
chetes - [ ] - es opcional). Por ejemplo. '

1t #eyascil
Gradoskahr
Greddos_FoTesT = Torrzt il

[DETTS B
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La condicion es una expresién de Boule. Una expresion de Boole dla un resul-
tado verdadero o falso. Los operadores que intervienen en una expresion de Boole
pueden ser de relacion {=, <>. <, <=, >, y >=) y légicos (And, Or, Xor, Egy,
Imp, v Not). Por ejemplo,

I{ 2> BOr (A >= > znd &~ <= 5) Then {

! 1

Para indicar que se guiere ejecutar un blogue de scntenﬁfis'ye varios bloques
dependientes cada uno de ellos de una condicion, la estructura adecuada es la si-
guiente: '

If condicion- 1 Then
sentencius-1

[Etself condicion-2 Then
sentencius-2j ...

|Else
senlencias-n)

End If

51 se cumple la condicion-1 se ejecutan las sentencias- 1, y si no se cumple, se
examinan secuencialmente las condiciones siguientes hasts Else, cjecutindose las
sentencias correspondientes al primer Elself cuya condicién se cumpla. Si todas
las condiciones son falsas, se ejecutan las sentencias-n correspondientes a Flse.,

En cualquier caso, se continida en la sentencia gue sigue a End If. Por ejemplo,

If ¢ » 100 Then
Resu = C * p * 0.¢
Elseli C »>= 25 Then
Resu = C * P *» (.3
ElseIf C »>= 10 Then -
Resu = C *+ p * 0.¢
Else
Resu = C * P
nd 1:

Select Case

.Esta sentencia permite ejecutar una de varias acciones en tuncién del valor de una

expresion.
Select Case expr-test
Case lista 1
[sentencius 1)
[Case tista 2
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[sentencius 2] . ..
[Case Else

|senrencias nl)
End Select

donde expr-test es una expresion numéfica o alfanumérica. y fista i es una lista
que puede tener cualquiera de las formag siguientes:
¥
expresion|, expresion) : . .
: expresiin To expresion
Is operador-de-relucidn expresion
combinucion de las anteriores separadas por comnas

Aqui expresion cs cualquier expresion numérica o de caracteres del mismo tipo
yue exprrest. Por cjemplo;

Case Is < » cesT <« X

Casa 3 “est o= 3 -
Cane X 1o 20 “esT = X, X-1, ...,20
Case 3, x test = 3, ¥

Case -1, x To 5 cest o= -1, x, =x+1, ....5
Casg "sit, *S51¢ zest o= “"sait, "S5t

Case Is zest o»= 10

»>= 10

Cuando se utifiza la fonma expresion To expresion. el valor mis pequefio
debe aparecer en primer lugar.

Cuando se ejecuta una senmtencia Select Case. Visual Basic evalia la expr-rest
y busca el primer Case que incluva el valor evaluado. ejecurando 4 continuacion
¢l correspondiente blogue de sentencias. Sino existe un valor igual a la expr-rest,
entonces se ejecutan las sentencias a continuacion de ‘Case Else. En cualyuier

- cuso, el control pasa a ta siguicnte sentencia 3 End Select. Por ¢jemplo.

Select Case X

Case 1 .
Textl.Text = *."
Case 2, 3 .
Texel.Text = "2 o @ *
Case 4+ -7To 9
Texne ) Text = 2 2 ="
Cuse Zise - .
Taxt ] Texe o= "Mal T Moz -

A lect
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-

For ... Next

La sentencia For da lugar a un Lizo o bucle ¥ permite ejecutar un conjunto de
sentencias. clerto ndmero de veces. ,
. | '
For variuble = expresion | To expresion 2 [Step e:.(prcsfo'u 3
{sentencias| fh‘
[Exit For o
|sentencias)
Neat [variable [variable). . .

Cuando se cjecuti una sentencia For. primero se asigna ¢l valor de la expre-
sion 1 ala variable y se comprucha. cuando el valor de La expresion 3 es positivo,
st i vartable es mayorgue la expresidn 2, en cuyo cano se salta ¢} cuerpo del
bucle v se continda en fa Hnea a continuacion de Next. En otro caso, se ¢jecutan
las lineas de programa que haya a contingacion de la sentencia For hasta gue apa-
rezca la sentencia Next. Entonces la variable se incrementa en el valor de la ex-
preston 3o en s Step no se especifica, volviéndose i efectuar 1a comparacidn
entre v variable v s expresion 2, y asi sucesivamentice.

La sentencia EXit For penmite salit de un bucle For ... Next antes de que éste
finalice. :

Un bucle For ... Next se ejecuta mis ripidamente cuando la variable es ente-
ra, y las expresiones 1, 2, 3. constainies.

Ejemplo:
Sub Fora_C_ck ()
Dim I 25 Inteyer, Suma 23 Inceger
For - T To 99 Step 200 Para I=1,3,5,... has-z 5%

Este ejemplo indica que cuando hugamos clic sobre 1a fonna. se visualizard
sobre la misma la suma de los ndmeros impares entre |y 99,
;
Siel vilor de la expresion 3 es negativa, se comprucha si la variable es me-
nor que la expresicn 2. en cuso caso se pasa a gjecutiar 5 siyuier - <entencia a



36 VISUAL BASIC. APLICACIONES PARA WINDOWS

Next. En otro caso, se ejecuta el bucle y se decrementa 1a variuble. Este proceso
se repite hasta que la variable sea menor que la expresidn 2.

" Ejemplo:
Suh Form_Click () |
Dim I ~s Integer, Suma %S|Fn:eger
For T = 99 To 1 Step -2'%t.parz 1299,¢7, resca 1
Suma = Suma + I o
tlext I
Brinc Suma
End Sub

Este ejemplo conduce al mismo resultado que el anterior.

Do ... Loop

Un Loop (bucle) repite la ejecucion de un conjunio de sentencias mientras una
condicion dada sea ciena, o hasia que una condicion dada sea cierta. La condicion
puede ser verificada antes o después de ejecularse el conjunto de semencias.

Formato 1;

Do [| While/Until] condicidn)
|sentencius)
|Exit Do)
[sentencias]

Loop

Formato 2;

Do
[sentencias)
[Exit Do]
[sentencias)

Laoop [| While/Until} condicicn|
donde condicidin es cualquier exprcsién numérica. relacional o logica.

Esta sentencia nos permite realizar vanas estructuras diferentes. Permite,
vamo se aprecia en los formatos. crear bucles con la condicion de terminacion al
final o al principio del blogue de semencias. Por ¢jemplo.

———
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+

Suma As Iateger

* Hacer mientras 1 <= 99

Este ejemplo indica que cuando hagamos clic sobre 1o forma, se|visualizard
sobre la misma la suma de los ndmeros impaces entre 1y 99, El mismo resultado
se abticne con el ejemplo que se presenta a continuacion.

Sub Form_Clicx () k
Dim [ As integer, Suma As Inieger
[ = 99
bo ' Hacer hasta que [ < 1
S5zZma = Suma + 1
I =1-2.
l.oonp Until I < 1

Princ Suma
End S:uo
La sentencia Exit Do permite salir de un bucle Do ... Loop antes de que fina-

lice éste.
. . . i

PROCEDIM!ENTOS Y FUNCIONES

La base de una aplicacién en Visual Basic la forman sus pracedimientos conduct-

dus por sucesos. Un procedimiento conducide por i sncesa s el c()tlligo que es
invocado cuando un objeto reconoce que ha ocurido un detenninado suceso.

También podemos crear procedimientos u;nemlm Un procedimiento general
es invocado cuando se hace una Hamada explicig al misimo, desde cunlquner pane

|
de la aplicacién. .Una buena razdn para utilizar este tipo de procedimientos, es

eliminar la necesidad de duplicar ¢odige cuando varios pmccdimienl(_lns conduci-
dos por sucesos necesiten ejecutir un nusimo proceso. Por ejemplo, visualizar un
diugrama de barras. En este caso, ¢l eddigo comitin se coloca en ua pruc::dunlcmo
general que serid invocado desde cada procedimiento conducido por un suceso,

que nécesite ejecutar dicho proceso.

Un procedimiento general puede escribirse como procedimienio Sub o como
fuicion Function. Un procedimienio conducido por un suceso siempre es un pro-
cedimiento Sub.
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Ambito de un procedimiento

Cuando un procedimicnto es llamado para su ¢jecucion. Visual Basic buscy ese
procedimiento en la forma o médulo actual. Si no o encuentra. entonces continia
b biisgueda en ¢l resto de los médulos de 1a aplicacion.

Consecuentemente. un procedmne#uo etinido en un médulo puede invocarse
desde cualguier parte de la aphcnuon, 0 un procedimicnto ligado a vna forna
solu puede ser Hamado desde otros prou:dmnemos lizados ambidn a esa forma.
Por 1o 1anto. el nombre para un procedimiento definido ¢n un médulo debe ser
dnico para wedos tos modulos. mientras que ¢l pombre para un procedimicnto de-
finido en una forma puede utilizarse también en otra forma.

Crear un procedimiento general

Para crear un procedimienio general. primero se abre 1a venana de codigo corres-
pondiente a la forma o al médulo ¥ a continuacidn se ejecuta ks viden New Pro-
cedure del meni Code. ’

Paru editar un procedimiento general existente. seleccione "(general)” de la
caja de objetos en la ventana de cédizo y a continuacion sekeccione ¢l provedi-
miento de la caja de procedimientos.

Funciones (Function)
La sintaxis correspondiente a una funcidn es la siguiente:

|Static] Function nombre ([purdmeiros]) [As tipo)
{sentencias]
[nombre = expresion]
{Exil Function]
{sentencius)
l1omibre = expresicn)
- End Function

nomine es el nombre de 1a tuncidn v tipo de datos quc LlL‘\'UL.‘l\'L' s~
A pecificado por un sulijo Je tpa de datos (%, L@ o
Sy Bl tpe de datos devuctio por ls funcion l.l['llhlt.ll prede
mdicarse utilizando L cliusula As gipo (nteger, Long,
Single. Double. Currency o String)
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purimetros son una lista de identificadores separados por comas gue re-
presentan variables. Cuando se Hama la funcién, Visual Ba-
sic astgna el valor de cada argumento en la llamada sl para-
metro correspoadicente de la funcidn,

expresion define el vator devueho por La tuncion.iEste valor es almace-

aado en el propio nombre de la funcion; gue actda como va-
riable deniro del cuerpo de la misma, 'Si np se electia esta
asignacion. ¢l resuliado devuclio seed U s e:,l.l €5 numdrica, o
nulo (") si la funcion es de caracteres. -
Exit Function permite sahir de unu funcion. Exit Fmilc,liun no es necesany
4 1o ser gue se necesile retomar 4 la sentencia inmediata-
mente @ continuacion Je L gue efectud la Namada antes de
yue fa funcion finalice.
End Function esta sentencia, al izual gue Exit Function, devaelve el con-
trob a Ja seatencia inmediatamente a continuacion de | que
efectud la lamada. continuaady de esta forma la ejecucion
del programa,

La lamada a una funcion es de la forma:
variable = nombre ([argumenios])

Argumentos son una lista de constantes, variables v expresiones separa-

- das por comas. El mimero de argumentos debe ser igual al
ndmero de pardmetros de 1a funcidn. Los tipos de los argu-
mentos deben coincidir con los tipos de sus correspondientes
parametros. |

En cada Namada a una funcion hay que escribir tos parcéatesis, aunque ésta no
wnga argumientos. Una lankada a una funcion es parte de una expresion,

El sizuiente ¢jeimplo corresponde @ una funcion gue devuelve como resultado
el factorial de un nimero N.

Function Factorial (X s integer) as Long
Dim © A5 Long
If 11 = 0 Then

ractorial = 1
Flse
F =1
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~

po While N > G

F=N@*TF
H=H-1
Loop
Factorigl = F
End If

- . . [
=nd Funcrion |

] '

La llamada a esta funcién se hard de’fa forma siguiente:

ract = Factorial (lium)

Procedimientos (Sub)
L.a sintaxis que define un procedimiento es 1a siguiente:

[Static] Sub nombrelfpardmeiros))
[semtencius)
[Exit Sub]
[jémenm’asl

End Sub

La exphicacién es andloga a la dada para funciones (Function).

La ltamada a un prOCCdlmICI'IlO puede ser de alguna de las dos formas si-
guientes:

Call nombre [(argumentos))
nombre [argumentos] ~

A diferencia de una funcién. un procedimicnto no puede ser utilizado en una
expresion.

Para declarar procedimientos externos. esto es. procedimieatos conenidos i
una DLL, uilice la sentencia Declare. Una sentencia Declare puede aparecer en
el médulo global o en la seccién de declaraciones de la forma o del médulo.

El siguienme ejemplo corresponde a un procedimiento {Sub) que devuelve
como resuliado el factorial de un ndmero N.

Sub Factorial (M -s Irnzeger, 7 23 Long)
1t = 0 Then
Pos ol )
Else
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7

[P

En
End Su:

8
W
'

La HNamada a este procedimiento puede ser de Lu.slqun.r.l dc las dos formas
siguicntes:

[

Factorial 1., =

Call Factoria-i(ll, 7.

Declarar todas las variables locales como estaticas

Para hacer que todas las vanables locales de un procedimiento sean por defecto
estdticas, hay que colocar al principio de la cabecera del procedimiento la palabra
clave Static. Por cjemplo.
Static Sub Double, N &As

zrce_: (X i3 intege:)

Ené'éub

Argumentos por referencia y por valor

En las fupciones (Function) v en los procedimientos (Sub), los argt:nncmos se
pasan por referencia: de este modo cualquier cambio de valor que sufra un pard-
metro en ¢l cuerpo de la funcion o del procedimienio. timbién se produu: en ¢l
argumento correspondiente de Ta Hamada a Ly Tuncion o al pmudumcnm

Cuando se 1lama a una funcidn o 4 un procedimicnio, se podra especificar que
¢l valor de un argumento no s2a cambiado por la funcién o por ¢l procedimiento,
ponicndo dicho argumento entre parémtesis, en la Hanada. Un argumento entre
paréntesis en la Hamada es un argumento pasado por valor. Por ejemiplo,

Factorial

jh

[ B

En la Damada o la tunciva Factorial de este ejempio, el arcumento Num ¢s
pasado por valor.

-
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Oura forma de especificar que un argumento serid Sicmpre pasado por sglor e
antepomiendo la palubra By Val a la declaracion del pardmeiro en la cabecera del
procedimiento (Sub o Function}. Por ejemplo.

al N As Integsr, © A3 Ling

Procedimientos recursivo's

Se dice que una luncmn {Function) es n,cursu.n 0 que un procedimiente (Sub) es
recursivo si se llaman a si mismos.

La funcidn facterial. cuyo programa se presenta a continuacion. es recursiva,

(N As Ihcege:} ~5 Long

urcticr. Factorial
If N = 0 Then
Facctorial = 1
Else
Factorial = t * Factorial({:l - 1)
End :i:Z
End Furnccion

TIPOS DE DATOS Form y Control

Los tipos de datos Form y Contrel solo pueden uiilizarse en las declaraciones de
los pardmetros de un procedimiento (Sub o Fuaction).

Un pardmelro declarado de 1ipo Form puede operar sobre cualguier mimero
de formas. Por ejemplo, supongamos que queremos inicializar alyunas de las
tormas de nuestira aplicacion, con el mismo color de fonde v del primer plano.
Esto puede hacerse escribiendo un procedimienio geners al gue se le pueda pusar
Ccomo argumento un objeto, en este caso una jurma. Esto ao seria posible sin el
tipo Form.

Sub ColorFerma (ZormaN As Form:
Formali,RackColor = &HFFFFPFI
Forrzll ForeCoior = &NUK

£nd s.n

H- ardmetro declatado de tipo Control puede operaf sabre cualquier nime-
I roles. Por ejemplo, supongames que queremos inicializar algunos de
los « 28 de las formas de nuestea aplicacidn, con el mismo color de fondo y

CAPTIULO 3 LT EAENTOS DEL LENGUAJE 33

del primer plano. Esto puede hacerse escribiendo un provedimicato general al que
se le pueda pasar como argumento un ohjeto, en este caso un control. Esto no se-
ria posible sin ¢l tipo Control.

Sub ColorCor-
Controll, Zac! !
Controll,¥or=Color p

nd Suis ‘ "

Pura tener acceso a estos prmullnmnlm desde Lu.ther parte de Ly aplica-
cidn, los incluiremos en un moduks. :

Cuando estos procedimientos sean invocados, recibirdn' como argumento el
nombre de cualquier forma o contral que gueramos inicializar a los colores en
cllos defnidos. Por ejemplo, supongainos gue el siguiente procedimicnlo perte-
nece ala losa Fornl,

Sub Form_Load (})
ColorfForma rormi ‘Fone coler a
ColocrControl Texti *Zone coior atl
ColorControl Text? *Fane color &l
Form2 . Show *Carga y +wisua:
End Sub

...
W

0N

Form2

El suceso Loud ocurre cuando se ‘carga una forma. Quicre esto decir que
cuando se ejecuie la aplicacion. se ejecuani el procedimicnto Form_Load que
pone color a la forma Formi v a lus contioles especifivados. Tambidn, como dl-
tma accion, carga y visualiza la forma Form?2. Por o tnto. si supoiemos gue el
signiente procedimiento pertenece a la forma Form?. ésta v o3 contrules especi-
ficados serdn inicializados al color detinido por los prmuhnmmus Hamados,

Sub Form_Loead ()
ColorForma “orm?2
ColorContral Texti

End Sup :

Tipo de un control pasado como argumento
Cuando se lama a un procedimiento al que se le pasa como argumento un con-
trol, se puede determinar el 1ipo exacto de control que se ha pasado utilizando la

sentencia,

ARV EIself} TypeOF conrof Is tipo-de-contred Then
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!
. . i _ , )
donde comirof es ¢l vator pasado y tipo-de-controf ¢s una palabra clave de las si- : clase de arrays. arravs de controles. necesanos pary escribir menas, |para crear
guientes: l nuevos controles en tiempo de ejecucidn. o para haver yue una serie de controles
t

tengan asociado un mismo procedimiento para cada upo suceso. !

CheckBox Frame PictureBox

ComboBox HScrollBar TextBox : _ ,

CommandButton Label; - Timer . Arrays de variables ;.'.

DirListBox ListB;Jx A VScrollBar : Y

Privel.isiBox Menu' ! { Un array de este tipo tiene que declwrarse atilizando cédigo’y puede tener una o

FileListBox . OptionBulton ' mds dimensiones, Para declarar un armay estitico (con un niinero fijo de elemen-
_— tos), Visual Basic hace ues consideraciones importanies:

Par ejemplo, el siguiente fragmento coloca una cadena de caracieres en un . ’ N L
control. si ¢l control es una caja de 1exto.” o Pura declarar un array en el mddulo global. utilice la semtencia Global.

| s Para declarar un array a nivel de mddulo o de la forma, utlice la sentencia

2uh Iri:zloControl (ControlN is Cornirol) | } Dim
) . +  Dentro de un procediniento. utilice b sentencis Stutic.
S Tons0f Controlil 1s TextBox Then C
croroll.Text = “Correcto® .
_ CLeniool c , Ejemplos:
Ind T:
i Dim Array_2a(19) As Siring
Zrd SuXz I . . .. .
| Este ejemplo declara un array de una dimension. Array_A, con veinte elemen-
La clivsula Elself se utiliza igual que se indico al hablar de la estructura If en ! 108, Array_A(0). Array_A(1), ..., Arvay_A(19). cada una de Hos cuales permite al-
este mismo capitulo. Por ejemplo, . macenar una cadena de caracieres.

gup InicioControl {(ControlN As Control) Dim Array_B(3, 1 To &) As Intecer

: : Este ejemplo declara un array de dos dumensiones. Arrav_8, con 4x6 elemen-
é ghen . ! 108, Array_B(0,1}, ..., Arrav_B{3,6), de tipu eniero.

u - :
Tlsel: TvpeOf ControlN Ts TexcZox rhén

CcmzrolM.Text = “Correcto” Stacic Array_C(l To §, 1 Tz 5) 23 Inceger

Znd i { o : ,
) i Este ejemplo declara un array de dos dimensiones. Arrav_C. con 5x5 elemen-
} tos, Array_Cd, 1), ..., Array_((3,3), de tipo entero.
Ind Suk !
; Globegl Array. D(l To 12) &s Zoring
ARRAYS ‘ Este cjemplo declara un array de wna dimension. Array_{, con doce elemen-

tos, Array_D(1), ..., Arrav_D{12), cada uno de los cuales permite ulm;ljccnar una

Un array permite referirse a4 una serie de variables por un mismo ‘nombre y cadena de caracteres. .

referenciar una dnica variable de Ja serie utilizando un indwe.
A diferencia de otras versiones de Basic. Visual Basic no permite declarar

isual Basic, iew: us scesores. permite definic arravs de variabley . .~ . . P i
Visual Basic. igual que sus predecesores. pe v - implicitamente un array. Un array tiene que ser declrado explicitamente.

de una 0 mas dimensiones y de cualguier tipo de datos, e introduce una nueva k
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Arrays dinamicos ;

Cuando las dimensiones de un array no son siempre las misimas. la mejor forma
de especificartas es mediante variables. Un amay declaraduo de esta Tormis es un
array dindmico. El espacio necesario para un amay estitico se asigng al intciurse
¢l programa v pennanecerd (ijo. El espacio para un amay dindmico serd asignado
durante 1a ejecucion del programa. U.I:," ay dindmico puede ser redimensionado
en cualquier momento durante la ejecicion.

Pury crear un array dindmico;
1. Declare el array con.una sentencia Dim o Global. y una lista de dimensiones
vacia.

Asigne el mimero actual de elementos con la sentencia ReDim.

i.a sentencia ReDim puede aparecer solamente en un procedimientu y per-
mite cambiur el ndmero de elementos del array. no el nimero de dimensiones.

Cuando se crea un armay que e¢s local 4 un procedimiento, ¢l primer paso se
recomicnda pero no es necesario. Al declarar un array dindmico primero con
Dim. ¢l pdmero de dimensiones queda lintitado a 8. 5i son necesarias mas di-
mensiones. hay que eliminar el primer paso v wilizar diceclamente la seniencia
ReDim. -

Por ejemplo, si declaramos ¢l armay Arvay_A a nivel de la fornu,

v_n() A

Tnto

Jim irr S

41}

eger

mds tarde. un procedimiemto Calculo puede asignar espacio para ¢l array, como
se indica a continuacion.

Suo Céiculo ()
sedi ‘—"zay 7, )
__,;-'c..-ﬁ

PR 6 S

Arrays de controles
Un sy de controles se crea ol asignar el mismo nombre a dos o méds controles
{p id CtiName) duranie ¢l diseiio de una apheacion. o bien, asigmindo un

vale, propiedad Index de up control. La Gluma fonma penera un amay de un

N .
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1.

solo clemento, lo cual es dnl cuando se guicre crear controles en tiempo de eje-
cugion. N

A dilerencia de un array ordinagio. un armay de controles no se declara en el
coOdigo. estd limitado a una sola dimension, no tienen defy do el limite superior
{el limite inferior de un armay de controles es cero). no pue ser pasado como un
dnico argumento (cada elemento debe ser pasado como u ar"umenln separado),
y los indices no necesariamente ticnen que ser ummun\'ds l’nr cjemplo, MiAd-
rrav(ty v Midrravi7) pueden ambos corresponder a cumrulu aungue no haya
coniroles con los indices 2 a 6.

Cuando Visual Busic crea un amay de controles. asigna por defecto los indi-

ces 0, 1. 2,0 los cuades pueden moditicarse a soluniad ded usuario, cambiando el
valor de La propicdad Index. Esta operacion solo puede realizarse durante el dise-
fo.

Cuando cualyuier control del armay reconoce un suceso, Visual Basic pasa ¢l
indice coino un argumento extra. Este argumento siempre v antes que coalquier
otro argumento. Por ejemplo.

Sub MiArray_Click (irndex A5 Inceg2:, Dato As [nteger)
El valor de ndex puede utilizarse dentro del procedimiento para determinar
* qué control ha recibido el suceso, Un elemento del amray de controles puede refe-
renciarse escribiendo NombreArray(Index). nomenclinura que puede utilizarse en

cuatquier lugar donde pueda especificarse ¢l nombre del control.

EL MODULO GLOBAL

El madulo global contiene las declaraciones de variables, las definiciones de
constaptes, y el tipo de informacidn gue es reconocida por toda la aplicacion,

Cada aplicacion tiene undnico médulo global. aunygue no'se utilice. EI médu-
lo global puede incluir:

Declaraciones de variables globales. Ea las declaraciones de variables, Dim

L]

es sustituida por Globad.

Clobal Precio s Currasnl.
L]

Sentencias Defiipo (DelMnt. DefM.ng. DefSng. DefDbl, Defr™ VefStr).

CefIint H-K, N
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'« Definiciones de constantes globales. En la definicion de una constante.
Global tiene que preceder a Const.

, FALSE = 0

. Sentencias Declare

ESTRUCTURAS

Una estructura o registro es un nuevo 1ipo de datos que puede ser manipulado de
la misma forna que los tipos predefinidos. Una estructura puede definirse como
una coleccidn de dutos de diferentes tipos relacionados légicamente.

Para crear una estructura hay que utilizar la sentencia Type ... End Type.
Esta sentencia solamente puede aparecer en el méduio global. Por ejemplo.

Type Ficnea
Nombre 5s String
Direccidn &s Scring = 40

ong

Teléiono s L
Dni ~s Long
End Type

Este ejemplo declara un tipo de estructura de datos denominado Ficha que
consta de cuatro miembros o campos denominados Nombre, Direccion. Teléfono
y Dni. :

Una vez definido un 1ipo de estructura, podemos dectarar varisbles de ese
tipo. Por ejemplo: .

Dim Aium s

Este ejemplo declura 1 vaniable Adum de tipo Ficha. Esta vanable esti for-
mada por lus miembros Nombre. Direccion, Teldfono y D,
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-

. . . aee |
Para refenrse a un determinado miembro de una estructuri se utiliza Ja nota-
cidn variuble.miembro. Por cjemplo,

Alum.Dni = 111333444

Un micmbro de uni estructura puede ser de un tipo defnido por el usuario.
Par gjemplu, vbserve a continuacion el miembro Afra. ¥

Type Fecha
Dia ~s Inceger
Mes s Integer
Afo 2s Intecer ,
End Tyne Ve

Type Ficha
Alta ~s Fecna
Noinbre s String
Direccidn s Serirg * 40
Teléfono xs Long
Dni ~s Long

End Type

También, una estructurd puede asignarse a otra estructuri. Por ejemplo,

Pim Aluml As Ficha, Alum2 23 Ficha

Aluml.alta.Dia = 15
Alum2 = Aluml
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i CAPITULO 4

CONTROLES MAS COMUNES

INTRODUCCION

CONVERSION DE TEMPERATURAS

Los controles s comunes en v aplicacion Windows son Las cajus de tesio, lag
etifuetas v 1oy botones. Las cajas de texn son particularmente nportates por-
que permiten realizar fa entrada de datos para una aplicacion v visualizar los re-
sultadas producidos por Ty misima, Quicre esto decir que cllas sustituyen a las
sentenchny bidsicas de entcadisalida (E/S) de) lensugge Basic (INPUT, PRINT.
INKEYS. cte.). Las etiquetas son cajas de teato no madilicables por el vsuario.
Su finahidad es informar al usuario de qué tiene gue hacer y para qué es cada
coitrol. Por dliimo, un botén permite al usuario ¢jecutar ung oden cuando sea
preciso. '

Los ejemplos que se presentan o continuackan permiticin aprender a utilizar
estus controles y ugos, ademas de sus propicdadves.,

Lavaplicacion de conversion de grados centigrados a fahrenhieit y viceversa requicre
un medio de comunicacion Gnterfag) de forma que cuando el usuario in‘l[udugcu en
un drea uia lemiperatug en grados centigiados. en otrcdres se visaalice la tempe-
ratura equivalente en grados faheenhieit v cumdo eheste oo dires se introdugca
una temperasara en geados Gadienheit, en la primera se siswadice Bemperatura co-
n‘u»wndichlc en grados centivradus.
) :

Recuerde que una interfaz se detine como el imedio de comunicacion entre el

uswariv v keaplicacion,
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DESARROLLO DE LA APLICACION

Antes de crear una aplivacion debemos respoader algunas preguntas como las si-

suienles:

s Qué objetos forman el medio de comunicacion”?

e Oud sucesos acen gue el medio comunicacion responda?
. ) 1" A‘.l, ,

e, Cuiles son los pusos a seguir pard un’ desamollo ordenado?

Objetos .

La conversion de wemperatuzas implica los siguientes objetos:

o Ul fonma que permits implemenizr nuestro medio de conmunicacion.
o Ui caga de wento para visualizar los grados centizeados.

s Uhnacagi de e para visualizar los geados Tahrenhen.

o Do ctiquetas gque informen al usuario de la informacion que conticne cada cuja
de leat.

Sucesos

L esta aphicacion se quiere gie cuando un usiario escribi una temperaturie en
unis caja y pulse Knter. ¢l contenido de fa vira caja se actialice avtomidicinenie,
y viceversa, Por lo tunto. el sueeso para cada una de las cajas de eato es pubsar la
tecla Eanter. que en Visual Basic <e denomina KeyPress.

Pasos a seguir durante el desarrollo

Lo Crear una nueva aplicacidn.

3 Movar, gustar el timadio por detecto de la forma.

3. Dibujar los conuoles.

A4 Definir Las propiedades de - jormia v de Lo controles.
5. Escribir el codigo para cada uno de los objeos,

6. Ciuardar la aphicacion.

~

ear L aplicacion.

8. L ait hichero ejecutable.
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Exios pasos fucron expuestos con detalle antenormente en et Capitulo 20 Por
cllos se supone gue o conceplos generales, cime crear upa nuesa aplicacion.
mover A ajustar o o por defecto de B forme s dibugar los comtroles. napre-
sentan i ninguna dificaleud.

. .!
La forma, los controles y sus propiedades

Conncidos Tas objetos v os sucesos procedemios a dibujar ¢l nfedio de comuoai-
cacion, Para clbo. creamos una nueva aplicacion y cambtamos b vtalo Formd de
fa torma que se visualiza, por el twlo Conversiin de temperaturas. Eato se hace
madificiomdo o contenido de Tu propiedad Caption de 1o forne. A continaacion
ciecutamus Tivadeir Save Project pars giandir vodin lu pand de L aphicacion gue
hemos reabizade hasta ahora, Poagimos o da forma el nombre Converfrim s o la
aplicacion o prosect el nombie Converanak (s extensiones son anadidas suto-
mticaniente por Visual Bisicr. Es wna buena ides sadvar feecuenicmente ¢l traba-
Jorgue estamos realizando.

A continuacion dibujamos [os controles, Para dibujar uia etigueta haga doble
clic sobre L utilidinl “A" en by bama de utilidades v opasa crear una caga de exto
gy doble chic sobre L utilidad "ab",

Dibujiomos una ctignet Ta movemes al Tugar deseado, caunbiamas ¢! dulo
Labell por Grados centiyradoy. v ajustimos su taniinio. Despuds, dibupamos una
cagi de texto, L movemos a contmcion de b etiguesa v cunbiinnos su nombre
CUName) Texr! por Grados_C.oSiguiendo Tos niismaos pasos, dibujamos ung se-
gundy etiquets denominady Grados fufirerhieit y olig capn de testo gque deaomi-
narcinos Grados_F. Una vez gjustado el lugar v el lamado de fos controles. ajus-
fumos ¢l o de ba forma, Bl medio de comuncacion obgenido seri somilar ol

de L figura siguicnte.

.
L etigresa tene la caractenistica de que no pucede ser moditicada por ¢l
uswarie de L aplicacion.
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Pura mejorar L apariencia inicial de noestro medio de comunicacion podenmuns
realizar alguna cosa mis. En primer lugar vamos 3 bormar Tos contenidos Teul ¥
Teai2 de tas cajus de teato. Para hacer ésto. selaccionamos la caja de evto pri-
mera y en la bar de propiedades ponemas Ta propicdad Text gque selecciomire-
mos de Ia cija de propredides. A continuacion moditicamos el contenideor de 1a
misia borranda Tear!. Para borrar Tear2 procederzmos de fonma similar, £n we-
vunde lugar eliminaremos L geyilla, |ura’lo cual hav que ejecutar fa orden Grid
Seltings del mend Edit y en la venuha'de didlogo que se nos presemta, dess -
vamos la opeidn Show Grid Guostrar rejilla). Por dltinao cambiaremos ¢ color de
funda de las cajas de teato. Para cllo, seleccionamos una o una cadu caja de 1evo
y su propiedad BackColor: después pubsamos el boton “..." que estd a ka derecha
de la caja de edicion, en 1a barea de propiedades. para visualizar ¢l pancl de colo-
rest elegimon el color guinto de 1a wercera linea v cermamos esta ventana (Al+E 4,
El resubtado gue se obtiene se muestra en la figura siguiente.

irados centigrados 1—:}

]

Ya enemos la forma y los contreles. Para hacerlos trabajar necesitamos unir
a los mismos el cadigo correspondicnte.

Grados lahjenheit

Escribir el cddigo

Para hacer que una aplicacion respondi i sucesos uniremos el cddizo correspon-
dicnie pary cada suceso. a cada uno de s controles. Este cédizo asoviado con
cady comrol para un detenminado suceso, recibe ol sambye de procedindento del
MICEMO.

Para esta aplicacidn tenemas quie excribir dos procedimicntos. uno para cada
comrol. ambaos accionados por ¢l suceso KeyPress. '

LI proceso que descamos reahzar es que coando un usuario escribua wni wei-
peratiea en uti caja v pulse Enter. seactualice autonuiticamente ¢! contenido de
v ot cuga con el valor resultiie de B conversion correspondiente. Para realizar
Livonseraon de ung wempe rataes ot stilizareimios s ionmalas siguicntes:

i 2y iradosleh

- 32) x5 -
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GrecgssTalhr = (Oroadestent ® 3 0 9 - Ls
En primer lugar desarmotlaremos el procediniento asociado con la caja de

texto Grados_C. para el suceso Kevitress. La veatani de cddigo correspondienie
a este procedimiento, se visualiza haciendo un doble clic sobfe esta caja de teato.

. ' R S o
Obsersemos Ta dista de sucesos t'roct) que se pueden dar paga glie se ejecute este
fien presemta el es-
. | -
sapieci en la figury

. .. . d
procedimiento, y ehjamos Kes¥ress. Ahora laovemany de d !
guemi paria el procedimiento Grados_(_KeaPreas, comw sg

siguicnne, .

Obiect: [ﬁlddos_l: EJ Proc: |Feybiecs ' )
ST JCharg= : N
Sub Grados_C_KeyPress (Kuynsciwp,_.,gg,mp -
[ragdver [~ |
End Sub RotFraus :
ieyOown '
P '

Feyldp
Lk Lioze

:

;QQ:
Cuando en la ciga Grados_C eseribamos una cantidad {grados centigrados) y

. . . .. + . .
pulsemos Enter se cjecutard el procedimiento asociado Grados _C_KevPress. Por
lo tanto, este procedimiento nene gque convedic i cantidad escrita, en grados fah-
reaheit y almacenar el resultado en Grados _F. Texr. Esta candad estid almacenada

como cadena de caracteres en Lu propicdad Tear del objeto Grados C. y como ya
sahemuos, se accede a ella wilizando Ly nomenclcury Grados_C Text! Segin o
expuesto el eodigo resultante es b siguiente:

Sub Grados_C
tf

Yeybre

53
3

Din Gradoscaie - Jovbhla
T (Reypscii = [
(iradostehr = Val P T ]

Crados_ 71
: It
End Sl

En segundo luear desamoliaiemos el procedimienio asociado con I caja de
LI - . - .
texto Grados_F, para ol sueeso Reyl'ress. L vemana de cadigo correspondiente
- A . . T
a este procedimiento, se s isuadiza haciendo un doble clic sobre esta’caja de texto.

Observemos lahista de sucesos tIProcsy que se pueden dar pana que se Cjecute este
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procedimicato. v elijamos KeyPress. A continuacion esernbiremos en b ventani
¢ codivo el procedinnento Gredos_F_KevPress, que se presentin a conunuacion.
de codigo el procedinnento Grados_F_Kev# (UC S Presenitil i Connnuacion

,.
i
~
e
-
P
v
W

sLer

Interceptando la tecia pu!Sada

Cada ves que el usuario pulsa una tecla. ocwrren tres sucesos sobre ¢l ubjeto ac-
walmente selecaionadu tobjeto sobre el que estd el cursory KeyDown. KeyPress.
y KeyUp, B suceso KeybP'ress es el mis factl de utilizar de Yos ires sucesos refu-
clomados con el eelado. A diferencia de los sucesos KevDown y KeaUp, et suce-
sik KeaPress se genera solamente cuwindo se introduce un cardeter ASCHL Bsa
detimicion excluye tecks especiales como teclas de funcion (F1a FI2). weclus de
movimicnto del cursor . 1. =y by o latecla Del.

121 conjuma de caracteres ASCIH es un subconjunte del conjunto de caracteres
ANSE con el que wabiapa Visual Basic. Los cafacteres ASCIL incluyen wdos bas
cavacterés imprimibles. Jas combinaciones Ctrl+(A-Z) v ovos caracieres estindar
como Enter (ASCI [3) v BackSpace (ASCIL 8 - rewroceso). Para ioterceptar
cuilyuicr ot teclu o combinacion de teckis que no produzean un cadien ASCL,
se utilizardn los sucesos KeyDown y KeyUp.

Bl suceso KeyPress utidiza ¢l areumento KevAsedic ¢ cual conticne el valor
ASCH del caricter imprimible. Este valor puede ser converiido a un cagieter uti-
bizandu Ly Juncidn ChrS v puede ser comparado utilizando los operadores de re-
laciin (=, <. >, <= >= v <31,

Otrs funciones relacionadas con cancreres son, AscteS) Jue devuehe ¢l va-
lor ASCHE del cazicrer o8 v UCaseS(eS) que canviente el caricier ¢ a maytiscu-

las. Por ejemplo,
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Bl siguiente ejemplo demuesten conio cancelar un canicter ~E no estd dentro
ded rango permitido. Este ejemplo previene a la caja de enio de recibir cuatyuicer

Caricler W o sea un nmimera.

znd

Los sucesos KeyDown y KevlIp wiilizan los ar ~-ununlm Ke vOonde y Shifi. El
primer argumento contivie ¢b codizo ANSE (o ASCI e Ya el pubsada v el
segundo argumento contiene un vador 1,2, 0 4 depeadicuda e gque <o hava put-
sado b tecta SWift. Corl o Al respectivainente. (i no se ha pulsado i de estas
techis ebyador de Shifi ex 0o un valor sunicde fos anieriores siose i pulsada dos
o s tecks simuliancamente (por ejempto sl pulsar Shift+ Al el arguiento Shige
s el salor 5).

L.os sucesos KeyDown y Key Up no diferencian entre mindsculas v maviseu-
las. Para hacer esta distineion enemos que ver sio el argumenio Shifi s 0
(mindscul) o 1 (mayddseula). Por cjemplo si pulsamos Latecls "a” el v alor del ar-
gumento KevCode es 63 v el valor del argumento Shii es 0 si pulsamos las te-
clas "Shil” +"u™ el valor del argumento KeyCode es 03y el valor el argumento
Shift es 1. La razon de POr qué estos sucess son dtiles estid en ¢l reconocimiento
de teclas que no producen un cidigo ASCH. comio lis teekas de Tuncivn.

Ui vez presentuda Lo fama de proceder de estos sucesos. obsen emos cual-
quiersde los provedimientos anteriores. por ejempho, -

(S oy S3t
Souble
Then
frados_C )7

Tormal S{urad

e 7
wnd St

Cudu vez gue se pulse uny eela sobee 1a capr de wato Gradoy O se actisva el
procedimictto Grados, C_KevPress y Kevbedi woma o vaior correspondicnte i la
tech pulsidia. Por cllo, par gue la operacian de comversion svurra solo en ol
momento de pubsan Enter. enemos que verificar si Ja ek pulsada ha sido Enter
(ASCH 13) Esto e,
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Ahora, cuarde la aplicacion (Save Project) v pruche como Tunciona (F3).

COMO TRABAJA UN PROCEDIMIENTO

Como cjemplo, examinemos ¢l codigo del procedimiento Grados _C_KexvPress.
Muchos de los procedimientos que escribiremos a 1o largo de esta ubra son sini:
lages 4 este y trabajan de acuerdo conlos siguientes puntos:

I, Screcuperi el weato que ¢b usuanio escribe on las eajas de texto.

2. Seconvierte b leato o un ndmero para gue pueda imervenir en los cileulos,
3 Serealizan los cileulos.

4. Se da furmate a los resultados para visualizarlos en las cajas de texio.

Recuperando el texto de las cajas de texto

E1 contenido de cuda caja de 1esto es representado por Ly propiedad Text y la
forma de referenciar una propiedad de un objeto es objeto.propieduad. Ea nuestio
ejemplo. Grados_C. Text representa el teato de la caja nombrada Gradoy _C.

Convirtiendo el texto a un numero

El contenido de umi caja de texto ex una cadena de caracteres ¥ por o into, o
tiene valor numdérico. Quiere esto dectr que st tenemios que realizar operaciones
Arilmétivas con ese contenida, previamente Bay que convernelo aoun mimero.

Para convertiv wnt cademt de caracteres @ oun ndmero. se utidiza la funcion
Val

Realizando calculos

el Capitalo 3 Tueron expuesios bos opetudores s ol orden en el gue ~e evalian
Cuanda el expresion interviencn varios, Recueide que uni operacion eitie
pardnlesis ene mayor prioridad v que Lis Tunciones ~e evahian antes yue cual-
quivr otra gperacion. Por ejemplo,

|
|
|

L

CAPEILLO (U\H\IIIIN\I\\UJ\I\E\ (.l)

operaciones indicadas, admzecina el resuliado en i variab

Graons

Tl este cpemplo. Grados _C Fear representa el tenan de L ciga nomibradi G
dos CoLa funeion Val contvierte este fexto o un pimero v odespuids nlc‘ reulizar Ly
 Gradosfahr de upo

I
Double. 1

Dando formato a la salida

Sioqueremos presentar en v capn de westo el valor mlmului oblenido coma
resultadu de una serie de operaciones antidneas. b Torm, m is il lll. hacerio ey
uttlizar b funcion ' Strs para o e o s cideni de CHEICICTeS VIR L
cadenit a L propiedad Feat de L caga de tevo, Por ejempla, ’

Graa

La funcion FormatS resliza Lo misma operacion que SueS v adenuis da for-
nnto L salida de acuerdo al patrdn especilicado. Por cjemplo.

Gracaz_ .~

21 simbaolo # cepresenz un digito cualyuicra excepio los ceros ng signilicit-
vos. Ll simbolo O representa un divie coadquiera incluyendo bos ceroy o slgnili-
cativos y ademds redomdea o resuludo, BN panto indica fa posicion del punio de-
cimal v Ficoma es cl separador de dos miles. Oteos siibolos que timbidn se pue-

den incluir son: - + S () vy espacio. Estos diltimos se viswalizan Gl m.lll I simba-

lo %e presenta el vator por cken v akinde al resultado ese simbolo.

.l_'utn'm " Entrada: 3 _I{nlru:m: 3

510 Sarrdn : ) ,

0 i

U, o ET .. IR

H,3°3 C = H i

#,2=2.00 =, " S

B,5=5=,== , T - , ,

0% P .
0L . . % J P
-1 , - v, 9] , .

0.0°=-%0 .
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Siusted ha elegido en Windows como idioni el Expatol. ohawerve como un

punto dechinal en b entsda o en ed patrdn, es convertido en una coma decunal.

lemabmiente la comncde Tos mates es convertidien el punto de los nules,

VISUALIZAR LA FECHA Y LA HORA

La funcion Now da como resultado ju fgcha ¥ Tu hora actuales. Para visualizar
esta fechi v hora bajo diversos patroifes.‘uilice fa tuncidn Fornua$ con los sim-
bulos especiates d {din). m (mes). ¥ (uho) v b thors) m minuos) v o8
(seundos). Por ejemplo.

Patrén ©FormatS(Now, “Patran')

Ceiney 21-3-932

calnnous . 21/65/92

Cl-nnnr -y, 2 l—!-ia‘;-lS‘]L’:

oon T Y

Sadc I o~ ommnoooo- yuy T L1553
NIt g, SoMnE-Y -zl
mhrntiE3y RM/RM, adermooey

Como prictica. modilique la aplicacion Conver.mak para que presente los re-
sultados con dos decimales v también. visualice [y fecha. El aspecto final seei ¢l
indicado ea da figura sizuiente.

- - - |
Fecha: Et.u.-.u;.p 21-Map 1992 ]
Gtado: cenligiados '
Grados fahiepheit

~

F1procesoinsewair es el sivuiente:

oAb baphicaaasn Comver md cOren Projecty

e \|R|:||\\|\~.um| ~es 71

¢ \lllll

20 Visdice Ta Torma Comver frm. Scheccioneta en Ta ventana de Ly aplicacion v
haga clic enced boton View Forn,
3 Visuadice L ventana de codigo de Gradon_C s atada Termato al resulizlo

::_‘-:l:]")

Crados v Tow, s Farrans i
4 Visuadice Laoventana de cadigo de (;'m.!u_\rj'_\ anada Im 1t al resuhado.

e o==0.00"

W

CGrados O lexml = Somnatioiniosoe

3. Ajnte el tmano de ke ora adada los controles goe s¢f ul'k.ulu.m cn lasi-
guicite tabla y nnnlnltqm stis propiedides como e 1mh_.1
Etigueta - Cajude testo
e e e — = ————— e s — ] v I
\ Caption Fecha: (e biene)
\ CuUName Tabweld Fecha
Text {no tiene} SHL TN

6. Modifique ¢l color de Ta caju de teato. Para ello, seleceione b caja de exto
Fecha y su propicdad BackColor: después pulse el boton 7.7 que estd a la
derocha de Ta cija de edicion. en b bacea de propicdades. parac visaalizar el
pantel de colores; elija el color guinto Jde la ereera Wea como color de fundo
y negro pari el texto. Cierre estir ventana (AlteF4).

A continuacion tenemos gue sanadic cadizo para que se visualice L fecha,
“Queremos que cuando se cjecute la aplicacion. fa techa apareszea en so cuja de
texto. Uno de los sucesos guie ocorre cuando una aplicacion se ejecubin o8 ef suce-
so Load asociado con B forma. Es aqui donde wenemios gque escribir el codiyo co-

rrespondiente paai visushizar b fecha,

Haua un doble clic sobre cualyuier parte exclusiva de Lo torma v e aparecera
la ventana de cadigo correspondieate, Sceleccione ¢l suceso Load pura este pro-
cedimicnto y escriba el cuerpa del misme come se indica a continuacion.

sSub —orm l.oa
-

B S T S Y B PR B L =
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La funcion Now proporcivna G fechioy Format§ especifica el formans con ¢l
guie e B de visoalizar, FYoresaltade hay goe abmacenado en la propicdad Test
i Yy

Jdebabjero Eecha, estoesoen Feche Tear

PASAR DE UN CONTROL A OTRO

Como es usual en Windows el usuariy pul.‘dc pasar desde un contral a otro pul-
I L. H L
sando latecl Tub o %0y o wilizando ef ratdh.

Fao guicre decir que el uswario.. sobre [a aplicacion que hemos disefado,
puede sitarse sobre Ta fecha voalterarla. Como esto no o considesamos conve-
NICIIE. (enemos que ey itar que el usuario pulsando la el Tab pueda moverse a
L cafi de tento gue visoaliza Ly fechas La forma de hacer esta es ponendo
propicdad TabStop i sabia False. ‘

Nosotras poademos hacer esto seleccionands a propiedad TabStop de fa caja

detento Focha en b basra de piopiedades v poniéndola s valor False.

BOTONES DE ORDENES

Ui fonma Jde conine una orden es-pulsande un badn, Como es asual en Win-
dow s el usuario puede pulsar tn boton haciendo clic en ¢l o seleccionindolo con
Lo teela Tab v pulsando Ty barra espacisdora tespacio en blancos. Estas acciones
imvocin al procedimiento conducido por el suceso Click del boton pulsado.

Cusandus unt Forma tiene uno o mis hotones. 1no y salo uno de ellos puede ser
“hotdn por dedeco”. Ext caracteristica hace gque cada ves que el usuano pulse
Enter. < imogue el sieso Click de este botdn sin importar el comtrol que esté
cnfocindo, Cuande seleccionumos un contral, si este ex un botdn, su ttalo aparece

rodeddo por un horde: se dice entances que el botdn estit enlociada”,

Para hacer que an botén sea el botdn por defect, hay que poner e propiedad
Defaudt del mismo wovulor Teae, B boton por defecto se distingue de los denuds,

porgue aparece rodeado con un borde nids neero,

Come cjemplo, vamos @ afadic o nuestie aplicacion dos botones, uno para
walizar un inciemento de una unidiad en Ly caja de s Grados C s oite pasa
realizar un incremento deuna unidad en Becagi de wesio Grados _FL L usuario
Poudei activare ¢stos botones con el riwn o cidocindotos v pulsando L barra espa-
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cludora. La figura sieuiente mnestra cual serd el resultado despuds de hacer ewa
aperacion.

techa: l

Giados centigrados [:]
L]

Grados lahtenhest

Yara aizdic uno de tos botones haga doble clic en B usitidad bordn det panel
de unilidades. wjuste su tamimo, mudvido al fuzar deseados cambie el nnlo por de-
tector por el malo "+ modificande su propicdad Caption v canbie du nowbre
de control "Command 17 por “Ordent™ modificindao su propicdad CaName. [2ara

anadir el seeundo boton siga los mismos pasas.

A comtinuacon aiadimos el cadigo conrespondiente para hacerles operativos.
Fo que guerenos gue suceda es que al pulsar el botdn ¢l contemido llC‘ fat cuja de
texto correspondiente se incremeite en wna widicl, Por ejemplos el comtenido de
L caja de westo Grados_Ces (,-'rm!u.\'_(‘._l"r.u. Eoste valor ln incrum..'n.uul‘ms ¢l uni

unidad wtthizando Ta sentencia,

Grados_C Formeros{val (Nrados |

Al cambiar ¢l valor de Ta caja de texto Grados_C debe cambiar cunbién el
. . - - I- .
valor de L caja de texto Grados_F, al valor equivatente en grados Galirenlicit.
- . . N . !
Parit hucer exto, simplemente Hamamos al procedimicnto gue realiza fa conver-
st de grados centigrados o wrados Bihreidiin. Esto ex.
[

Ho P e

Grades_o_

Recuerde que este procedimiento se activa cada vez Yl |ml.-;|nms| unir el
sobre fa ciga de lexto y es Lirects pubsinda ol wrgunicimo que recibe conin parine-
tro. La conversion se cleciuaba cuando pulsibsunos Enter (valor ASCI 13, Por
¢llo, pasimos como argumento el valor 3.

.

Para escribir un procediniento gue ejecule csBs operaciones., hawafdoble clic
sobre el boton situado ol lado de L capa de oo Gradoy_C parac viswailizar su
ventagid de cadivo y escriba,
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Sicuiendo ¢l mismo razonamiento, el procedimicnto pary el oiro botdn ey,

- - ¥

{23 5 )

vl
I—‘or??.a:S(‘.’all((}a:i:s_?.'l‘-zx;;) - L, "E,==3.00")

Fjecute Ya aplicacién v observe como funciona. Debido o que Windows esid
conligurado para el idioma Espanol. en’las cajas de texto aparcce come separador
de los decimales la coma. Esta caracteristica queda reflejada por T constante’
sDecimal del fichero WIENINT de Windows,

Eato hace gue L funcian Vad no actie comectmnente. Por ejemplo. si la caja
de texto Grados_C contiene 10,3 L expresion Valt 1.5 da un resultado de 10, La
selacion a este problema es pasar ¢l argumento o ks funcian Val en a notacion

inglesa (punio devimal ),

'REEMPLAZANDO EL SEPARADOR DECIMAL

El separador decimal. dependiendo del pais. puede ser la coma o el punto, Por
cjemplo en Espana se utiliza o coma v en EE. LUL se unliza ¢l punto. Esta dile-
rencia catsa un problema con La funcion Val. que aswme el puntu como separador
decimal. La soluckdn o este problema purit los paises gue wtilizan lu coma como
separador decimal es adic B siguienie funcion como un procedimicnio general.

: ¢13]
aricn.
Dois
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La funcion Valor devaelve como resultado el vator correspandiente a una ca-
dena de caracteres que incluye ke cont como separador decimal.
-
La funcion MidSOXS, i, omda como resuliado de -t cadena XS una subcadena
de mcaracteres de Jongitad, empezande por el a-dime caricigr.
| '
La sentencia MIdS(VS, np = 18 sustituy e Tos canacteres ql:l s estan a partir de la

posicion o en XS por los caracteres que hay en S Y

i
4

Observe gue T Tuncion Valor ieeibe coma argumcatn m'.i;l cidena de caricie-
res que representa un valor numdrics con coma de sepatador decimal 'y punie de
separador de Tos nules, ciunbia ke comia por ek panta sy sustitus e fos punios de los
mifes por expacios que no s emdos en coaenta por La funcitin Valk, B resudtado
estuni cadena de caracteres gue representi an vilor con puito decimal valida para
fa Tuncion Val que realiza finadmente fa comversidn. EDvator devuehio por L fun-
cion Vedor es el valor devuelo por L funcion Vall el cuad e~ de tipo Double,

Paca que esta Tuncion pueda ser aceedidin desde cualguaier parte de Ta aplica-
cion. L colocaremos en on nwidulo que denominareimos Converbas, U proce-
duniento detfinido en an mddulo puede Baamarse desde cuabguer parte de L apli-

Cueion.

Para crear la funcian Valor abra la ventang de cadigo carrespondienie i un
nuevo mddulo. orden New Moduale del memi Fileo s o continmacion ejecue L or-
den New Procedure del mend Codes; elija en L ventang de diilogo presentada la
apeion Funetion y escriba en fa caju de wato de lanniswta el nombre Conver; fi-
mitlmente pulse el butdn OK y eseniba el cddizo cortespondicnte,

Para modilicar un procedimicnio veneral existente (Sub o Function),
seleccidnelo en la ventana de la aplicacion. pulse View Code. se visuuliza {a
sentuna de cadigo, seleccione “feeneral)” de i cig Jo objetos y o continuacion

seleccione ¢ procedimienta de Ty cuja de procedimicntos,

EJECUTAR ORDENES DEL SISTEMA

Lo botdn puede utilizirse tunbidén para ejecutar vaa opden ded sistema operativa o
para ejecutar wlro progrania. Esta puede hacerse ficilinente wilizindo la funcion
ShelllordenS{, nh. Ebargumento ordenS epresenta el aombire de Ty orden o del
programa que se desei cjecutar s clhargamentose es unovalor eatero (1,2, 3.4,
que hace que el proceso ejecutado s¢ presenite en g seatana noemgl, minimizada
o maximizadi, enfocadic o sin entocar. Por cemplo,
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Sibh Libros Clice
id = Sheil("c: win @i cardiite.exe libros.crdr, 2)
Ind Sun

Cuando se pulse ¢l bosin correspondiente a este procedimiento, s¢ ejecuta la
apheacion candfile de Microsoflt Windows. Observe que la luncion retorna un

. T T HCAPITULO 5
valor id que identifica el programa cado ¢ indica 51 se ejecutd satislactony- i
mente. Este valor normalmente no es ;

licddo. ' o
oAy Lo

INTRODUCCION

parten ¢l
| mismo nombie y los mismos procedinnientas. Los clementos de an amay de contro-
: les son controles fisicamente separados. cada wno con su propio conjunto de pro-
piedades. Por ejemplo, supongamos una aphicacion “Tanio por Cieno™! formamda

Un wrray de contreles es un comunto de controles simibares que com

por los conttoles expeciticados en fa siguiente tabla:

Caption CtiName I)t-ruullﬁ Ii:u'k(.'n:lnr ]

Botdn | L6 TantoPorCicnio | Fubse 7 AI;TIILI_LAEL_“-]-—_‘

Butdn 2 +13¢ TiantoPorCiemo | True Puog .Icl'c:cln |
; Hnl(?n 3 +334; TantoPuCiento | False . : Por ¢Icfc|‘cln
i Eoqueta 1 Cantidad lubell Por llufcilcln

! 7(71}_1 Texta | Teatl I ' : :cl_i.!)ﬂﬂ(:ll:l‘l:i:;_
: ‘ I{l.iqllul;! 2 7 SN I.;lhl'll ‘ Puar «lufc;;ll)

Caja Texto 2 “’rc.uz - .&HU(M)(J)FFI"F&_
Etiguens 3 :)_l_ll I_ul.m!_'ﬁ Pur dufc!cln

' Caja Tento 3 Teaid F &nwnfn-‘l-‘rl—‘ﬂ
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Esta tabta dari lugar, conuy se verd a continuacion. al medi de comunicacion
gue se presenta en b tigurd siyuiente.

En este caso. se pretende caleular la cantidad Toral, resultado de sumar a una
Cantidieed 0B deterninado tanto por cienw 66, 13 0 331 No seria ana buena sola-
cion. sino mas bien mala. escribir un procedimients para cada botdn (por ejemplo.
Bowinty _Click. Borind3_Click s Boton33_Clichy. porque los botones ejecutan
esencishneme L misima accion. Fotad = Cantickad + T8 Cantidad, con uni pequeia
variacion. el vador del tnto por caemto, Ea forma mids Ficil de watar un caso como
éste es asignar el nnsmo nomibre akos botones, To gue da lugae a vn array de con-
troles, y esenbir st win sule procedimic o,

Un array de controles se crea al asignar ¢l mismo nobre o dos o mas contro-
les durainte el diseiio de una aplicacion. o bica. asigaando un valor @ la propicdad
Index de un control. La dliima forma genera un array de un solo clemento, o
cual ¢s dtil coando se quiere crear controtes en licmipo de cjecucion. Para cicar un
nuevo control en liempo de ejecucion. €l debwe ser an elemento de un arcay de
contiol.

~ 0 Cuando Visual Basic crew v array de controles, astzna por defecto los indi-
ces U, 120 os cuales pueden modificarse a v oluntad del wsuario, cambiaado ¢l
valar de L propicdid Index. Esta operacion salo puede realizare durante el dise-

.

Por cjemplo. dibuje elinedio de comunicacidn anterior v asiene i los butones
el nombie TamtoPorCiento, Para cllog seleccione el botdn +64% v asizne s
propiedad CName el valor FoantePorCienio. A continuacian repita L misma
operacion para el boron twbado = /390 Coando osted haga esto, Visual Basie
presents i caji coro B de b Nzura diciendo: "Usted v tiene wn contraol nom-
brado "TatoPorCienia’. [ Quiere crear unarray de contioles!”.

CAMITULG S ARRAYS DE CONTROLES 19

I |

You alres! have a control nained
0 ‘TantoPorvacnte’. Do you want 1o create a
control array?

I
i

.1

i

-

; ' '
ﬁo . ‘bl¢ Y

Respunda si y contintie con el resto de los botones. Si ahora hace doble clic
subre cada uno de los botones observari que el esquema del procedimiento uso-
ciadu es ¢l misma, esto ¢s, ahora. en lugar de ties procedimiemas separados hay
un solo procedimiento como ¢l siguiente:

Sub TernvolforCicento_Click (Index As lrneaer)

oid San

1o gue ha hecho Visual Basic ha sido asignar a los botones ¢l mismo nombre
mids un indice para diterenciartos. 12stos nombres para noesiro ejemplo son: Tan-
i PorCieniog (), TamioPorCieniof 1) y TantoPorCienio(2).

Cuando cualguier control del array reconoce un suceso, Visual Basic pasa el
indice (Index) comu un arguinento extra. Este argumenty siempre va ainles que
cualquier otro argumento,

Con un array de controles, cady nuevo elemente hereda los provedimicntos
comunes al array.

A difereacia de un array ordinario, un amay de cancoles

I. Nosedeclaraen el cadigo.
20 Estd limitado 4 upa sola Jdunension.

3. Notiene definido el liwite supenior (el limite inferivr de un amay de controles
es Cero).

4. No puede ser pasado como un dnico argunaento (cinka elemento debe ser pa-
sudu como un argumento separado).

.

5. Los indices no necesasmnente tenen gue ser consecutivos. Por ejemplo,
Midrrayt £y y MiAreaxe7) pueden ambos corresponder a controles, sungue no
haya contrales con bos indices 2 4 6.
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£l valor de Index puede utitizarse dentro del procediniento para determinac
qué control ha recibido el sucesa. Un clements del array de contioles puede refe-
renciarse escribiendo NombreArravi Index), nomenclatura que puede utilizarse en

cualquicr lugar donde pucda especificarse ¢ nombre del controf.

Continuando con el ¢jemplo. nuestro propasito es escribir una cunidad y al
pulsar Enter deseamas que automidticamente se hagan los cilleulos para ek 139,
La cantidad tecleada aparecerd en la caja db texto primeri, el edleulo del wano por
ciento aparecerd en b segunda caja. b, Lllqil(.l.l de esti caja variard de acucrdo con
el o por ciento (64 13% o 33} y 1.1 sunta de las dos canndades anteriores

aparcceni en fa tercera caja,

Cantidad [y onuou0

EE I

@ Total:  [{130000

Para conseguir que al pulsar Enter anomdticamente se hagan los caleulos
para ¢l 134 hay que hacer que el butdn + 184 sea el botdn por defecto, Jo que
implica poner ks propiedad Default del mismo s valor True. E] boton por defecto
se distingue de tos demds. porque apagece rodeado con un borde mids negro.

Segiin lo expuesto, el cuerpo para ¢l procedimicato TamoPorCiento conduct-
do por ¢l suceso Click. es el siguiente:

Sub las uu?m‘l.‘ic-::'_'

Dim Wwini 4z
Tp = {Tance?
Canuin:
T o= 0y

fabwed —,

Observe come el o por ciento Fpaaplicar, se obliene convitbieado el tulo

del boran o vator mndrice. -

CAPEIL L S ARRAYS DE CONTROLES S

—-y- —_

Cuande uno de los controles de un armiy reconoce un suceso. \’nual Binic
lama al procedinienio comin v le pasa un argamento adicional tpmpud.ul In-
dex) que ddentilica et conirol gue actaalmente ha reconocido ¢l ‘\ULL\U Por
cjémplo.si hacemos clic en el butdn +33% Visual Hasic pasu el valor D para In-
dex. Por ot Vol FanioPorCiento Index).Cupiiony da ¢hmo resultado 6 pars
Index igual al), 13 paga Index agual a 1y 33 pura lodex igl:g la2.

Mﬂ ol

Lasentencia Label2. Caption = SuS(Tpy ¢ 00 modilicacla @igueta de T caja

Tear2 al valor 6% 135 0 334 dependiendo de 1y P

Creando controles en tiempo de ejecucin

U array e controles tiene al nrenos un elemento v puede Heear awenee hast
235, Cudy clemento tiene so propro conjunte de propicdades. aungue Icumpuncn
el misma cadigo, Puesto que el cddigo o compantie licae que existir, noles posible
crear durante T ejecucion de la aplicacion uin nuevo contrul, si no existe un array
de controles,

Para anadic wn nuevo contrel a un awrray de controles dwrante Ta ejecucidn de
una aplicacion, utihizaresos fo sentencia Load y para elimimarlo udlizacemos fa
sendencia Unload. No se puede utihizar Unload para chiminar un control gue no
aya sido creado e tiempo de ejecocian. Por cjemplo.

indice 3

indica 3

Ancde un occrnl cos
‘Ehisiing un oncrol

lLoad TerioPorCientol(s)
Unlozd TantoorCiencotld)

Cuando se adade un nuevo elemento aoun array de conoles. odas las pro-
piedades excepto Visible, Index, y Tablndex son copiadas del clenpento nvis
bajo en el array. Esto hace gue cuando afadamos varios controles. [ndn's seuan del
MHSINO LHane v ose apilen en el omsio fugar, va que las pruplul..du 1.eft
(distancia desde Lo izquierda). Top (distancia desde wrbad, Width Ginchura) ¥
Height (aduna) son idénticas. Por ot parte, ninguno de fos contrales creados se-
ran visibles ya que se crean con L propicdad Visible o valor False.

‘

Como cjenmipio. vagnos o considerar el siguiente caso sobre b aplicacion an-
terior: cusndo escribamos una cantidad 1gual o superion a KUOO000 | aparecera
un nuero bolin ttaldo 4345 como se indica en la figwea sigoicate. |y cuando
escrbanmus una Cantidad menor de TOULB0 este botdn, sioesti enlla forma,
desapareceri. Comtemplar bos casos de no wiadie el botin cuindo vi eslé anadido
y no eliminarlo cuando ya esté elimindo.
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’ ~ .
. t
. ! .
i _
I (- | . DISENO DE UNA CALCULADORA
Cantidad 100000000 f A continuacion vameos q realizar el dise o de una calealadura como la de la tigura
: . siguicnte. . :
@ 54X [5400000m : . o
] () ¢ Jmal i | | o) It
.. ] ] .
El procedimiento comin serd ahora el siguiznie: . 7 8 9 ClICE] | ..
2.n TentoPorCiento_Clicx (I . 4 5 6 / -
2im (_.,nLInL As Doublsz, T . Dounia ‘
Zratic Botdnbd fs Ur - J—
Tn o= Yal({TFantoPorCier . Cavtion) 1 2 3 ® +
Capcind o= Val{iextl )
yo= o /100 * Canc
H N - . L] _— -
LanelZ Caplion = S0 0= x H 0 i} = % )
_'r.-L. Text = Format s L= -
.-_-.w..,i_ fext = FormatsSi, - T}
CPoCan: i = 102 =:75n3s = O fthen C
7 L ui;\. ill L . > [301?‘(‘)0?0 - ' Antes de crear una aplicacion debemos responder ulgunus preguntas como las
oxd TantoPorlenie L g o
: : . siguientes:
fanioPorCiento(3) . &
lentobPorCiento(3). o ) ) L
TentobPorCienco(d) . "-5ik* s 0Qué objetos forman ¢l medio de comunicacion?
TantoPorCiento{3) .’ -1 - . L
;13"6:35‘1 -1 t3) - o Qud sucesos hacen gue ol medio de comupicacion responda’?
200 4 = .
— . =2 . : st Te i Sa-fe5s - TR . g ) ) ) i .
z lbti f (aanl_ Ini < éOC R -? 20T ZGLIND= L Then o Cudles son los pasos a sequir para un desirrollo ordenado”?
Unload FantoPorClernzZoi: .
Zoudns4 = 0 ‘
oEmd ID ' Objetos -
End Sub .
. i . o , o Lacaleutadora incluye los siguientes objetos:
La variable estitica Boron34 estd a cero cuzndo el botdn +34% no extd en la ye s sy es ubjetos:
forma v se pone a | cuando este botdn extd sobre la forma. Esto perinitini no ¢ Upa forma que permita implementar puestio medio de comunicacion.
anadir ¢ n cul a esté adadido v no eliminarlo cuando ya esté eliminado. . : :
anadir ¢l boton cuando yu esté adadido y no e ¥ o L'na cuqueta (pantalta de la calouladora).
Oh‘:&.l'\l._ que las propiedades como Width tancho) v Height talio} no se han *  Diecinueve botones de drdenes distribuidos de ta forma siguiente:
Mo, e han especihicado las ' ..
especificado puesto que son heredadas. En L.mdlllt 1 ~! ) e :L1 . | | ~ digitos del 04l 9
» . ST It trey de i forma, 1 .
[“"“P!“ldd"5 Left y Top que “_“_,'C‘m k I'PU wida de ) conir "n_ o : = punto decimat
propiedid Caption gue especifica of ttalo det botgn. v s propiedad 3 isible que ! o operaciones b~ X, 4. =y
aw rele readu seu visible. . : . . L
hace que el control creado seu visible R : = operaciones de borra tode v borrar altima ewtrsda (oC y CEy
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Sucesos

Haciendo clic sobre tas teclas de los digitos visualizaremos un nimero en 1a pan-
talla. Un ndmero puede contener un punto decimal. La entrada de un nimero fi-
nalizard al hacer clic sobre una de las teclas de operacion. Por 1o anto. ¢l suceso
al que tiene que responder cada uno de Nos botones es un clic del raon (o su equi-
valente, seleccionar ¢l botn con Tahly phisar la bama espaciadora). que en Vi-
sual Basic se denomina suceso Click. =/

Pasos a seguir durante el desarrollo

1. Crear una nueva aplicacion.
3. Mover y ajustar el amaino por defecto de la forma. ‘ :
3. Dibuja los controles.

Definir Jas propiedades de la forma y de los controles.

:.IlJ-

Escribir el cédigo para cada uno de lus objetos.
Guardar la aplicacion.

Verificar la aplicacion.

o ~ o

Crear un lichero ¢jecutuble.

Disefo de la forma y de los controles

Conocidos Yos vbjetos y lus sucesos. procedemos a dibujar et medio de comuni-
cacion entre el usuario v lu aplicacion. Para elto. abrimos una nueva aplicacion
(New PProject), si atn no 3o | aos hecho. ajustamos la forma y dibujamos los
controles.

La propiedad Caption nos permute cambiar ¢l situlo a la formia v a lus coniro-
les. De esta manera podremos poner a fa forma ¢l titulo "Cateuladora™ v cada
“una de lus teclas (controles) el cardcter correspondiente 2 su funcion.

La pantafla es una eriqueta titakada "007 ajustada a Liderecha y conun burde.
Las propicdades gque hay gue especificar para conseguir [o expucsto son:

Alignment I (ustificado a la derecha) .
BackColor KHOKOFFTF R :
BorderSiyle I {una lined fiju)

Caption .

——-
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-

CuName Pantalla
FontSize 13.3

Para referirnos en el cddigo i cada uno de los controles hay que asignarles un
nombre. La propiedad CiIName de cadi conol permite reafizar esta operacion.
Pero antes, consideremes si hay controles que tenen un cond ortamiento similar
y por 1o tanto pueden compartir los mismos procedimientos. b

: L

En el caso de la caleuladora, hay 10 weeks cava fnabidiad es visualizar un
digito en L pamtalla. Io gue deja o que su Tuncion ey la avisma. 1o qlllc uiere
decir yue pueden compantir Jos mismos procedimientos. leualiente sucede con el
grupo de recks +. - x4 = Bl resto de Tas weelas actian indc|')l::_|ulicnluncnlc.

Para gqoe varios controles compagtan los nisimaos procediniientos, deben for-
mar parte de wiarray de controles. lo que imphici que iengio el imismo nombre.

Segan lo expuesto. las propicdades pari lus 1eclas son lus siguidnies:

Caption CuName Fm{lSize
|
Teclas Ua Y 0.1, .49 Nivito ‘)E75
tarray de’controles)
Tectas +. - %, /. = +, - /= Operacicn [
Garray de contiofes)
Punto decimad . Punol) . I|I 3
1 AR
Tanto por cienio iy FamoPorCicato ™~ 9| 75
_ 1
Puesta a cero total C Linciadvzar l)'?i
j
Puesta a cero dbtima CL Borcarkmrada ‘J’?S '
cilrada {

Ty 4 s v by . . .
Una vez que se ha puesto nombre a tdos Tos controles y se han especificado
el resto de Las propiedades deinterds, el paso siguiente s umir el cadigh corres-
pondiente o cada uno de los controles pari que cada uno de ellos cumpl;ll st fun-

cion,
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Escribir el cddigo

JPor donde se empieza. En ung programacion conducida por sucesos se pucde .

empezar por cualyuier control,

Por ¢jemplo, empicee con las teckas cormespondientes a los digitos 0 a 9, y
preginlese: ;jqué ticne que suceder cuind se haga clic sobre un digiw?. Cuando
esto suceda se espera gue el digito apeicp en la pantalla de Ts caleuladora. Esto
se consigue escribicndo un procedimiento que responda al suceso Click y asigne
el tiulo de la tecla (U,1,...) al tilo de la pantalla. Para crear un provedinmiento
coine éste hay que realizar los pasos sigui't_f'mcs:

. Abrir la ventana de cédigo. Para ello, haga un doble clic sobre cualquier con-

ol del array Digito, o seleccione ¢l comrol (entéqueln) y pulse F7. Visual

Bas visualiza el siguiente esquema:

(Ircex A5 oz

Mm
Wl
1
"~

Sub Digiro_Click
End Sub

Observe que ¢l nombre del objeto es Digirof lndex) v que cl suceso es Click.

i

Escribir el cadigo. Anteriormente se ha indicado que hay que asignar el tiwlo
de la tecla pulsada (0,4,...) al ritulo de la pamalla. Para ello, escriba como
cuerpo del procedimiento la sentenciy,

tolinizx)

Pantalla.Caption = Digi .Cenzion

Este procedimiento serd compartido por todas las teclas agrupadas en el array
de controles Digito. Cuandoe un control del array reconoce el suceso Click, Visual
Busic pasa el indice (Indnj COMO UN Argumento extra para identiticar B ecka que
ha sido pulsada.

El procedinmiento tal cual se ha escrito. asigna un solo digito a la pamalia de
la caleuladora. Para asignar un digito tras otro hay que modificar el cadigo de
furma que cadia nuevo digito lecleado sea afiadido a los va existentes en la panta-
Ila. Esto se consigue modificando la sentencia antenor asi:

Jub Dicrio Chack Clmdex S5 lntazer)

Diin ' tGro AS Sirira :

Hota:t o Pantal by, C .

P e s Capt lon - Tlale lmzent o Loun
A Y

o CAPTH 0 3, ARRAYS DECONTRELES BT

..

Guarde la aphicacion v ejecitelin. Observar que ahora todos 1os ninieros te-
cleados empiczan por “007. Esto indica gue cada ves que el usuano vaya a intro-
ducir un muevo mimero. L pantalla debe ser imcializada. Este caso se da al prin
cipio, ¥ después de teclear un operador. Para detectulo intcodpciremaos una nueva
vitgiable denominada Llimabnirada que tended of valor "DIGITO™ si lo dlimo
tecleado ha sido un digio, v otro valor en otro caso. P

Y

[f Ulsimabnorads < 2RG0T0° Then' S
Parncella.Cannien = == ) P
F¥nd if i

Otro detalle o tener en cuena ex que los ceros iniciales na son significativos,
por lo yue no se tendrin en cuenta. Esto s,

If Paralla.Cayiol = =7."
- Exii Sub

End 1:

vt igiio(ndsg Gt ion = "0 Then

Las vaniables, comeo Ultimabnirada, que tengan gue sec compartidas por o-
dos los procedimientos de Ja Torma ticoen gue ser declaradas a nivel de la forna.
Para declarar una vanable a este nivel, abra la ventana de eddigo para un objetn y
seleccione “(generad)’ de I.| cipa de Uhlel)b y “(declurations)” de la caja de suce-
sus para ese objeto.

Dim UlvimaEncrede 23

Czring
Con las mudificaciones introducidas, el codigo queda como siuue:

Sub Digito_Ciick
Dim timero -3 :
1f zantalla.Caotion = *0."

Exic Sut
Fné it
[f Jitimak:
Pantalla.Ca

As Integer)

And Digitodindex) .Caption = 0" Then

“NGETo"

Then

P I

Mitncro = Fancalia

Pqngalld.Cen:ia: 3 + Digito{index) .Caption
Uli isuBEntracse = = -

End sub

Para aiadir decimales i un oimero se pulsa fa wela del punto decimal. Antes
de escribir ¢l eddigo para esta tecla analicemos 1us casus que se pucden das:

1. Elusuario imroduce un nimero que no tiene parte entery y puls-

s primes
tecla el pumo.
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[

El ndmero ticne pane enieri.

3. Noaceptar un segundo punto decimal. Para detectr este caso antroducisenios
vaa nueva variable denominada PusterDecimal que tendri el valor S1siel
admero v liene un puaio decimal o un valor RO si no lo dene. Defing esta
variable y estas constantes a aivel de la forma.

Dim :
Consc ST =
Const™ 0 =

De acuerdo con lo expuesio ¢l pnk._dnmcnlo para el punty du.mul es el si-
wuiente:

icey

e nen

Can

0l

Cao Caption + .

foIREs

i

It
PR

L

Znd Sub

La inroduccidn del puino decioal obliga g realizoar algunos ajustes en el pro-
cedimtento Digito_Click para poder introducir mimeros de ¥ foema O4b .y para
permitir el punto deciial pura un nueve ndimero.

@ Digito{index) . Cantiorn
NO Then

" nen
PuntoDec:.
Ena i
[RIVEE:
Dlgitotindex)  Canion
. . . !
tNotic st L poomers linea fy 0 Phen aparece partida e dose es debido o que o

coze en uni soli B B Visiad Basic se eseribing en una sola lnea, Tenga en
CUCHtL Esto i Cisos stnilares o o Largo de esta ol

Una vez gue el usuario ha tecteado un ndmera. lo leico ¢s que pulse a conn-
nuacion la tecta coespondicnte a la operacion o realizar. Esw es. ¢l usuario hard
clie sobre una de las teelas +, - %, £ 0 =, agrupacdas en b array Operacidn. En
este instanie fa caleuladora tiene yue recordar el operador introducido.

Goeradcr = Gporacion{index) Cemiion I
l' ‘

A continuacion el usuario introducind otro ntmero, P.ifﬁ%‘lrc% nar en pantalla
¢l nuevo mimero. dsta vene yue ser imcializada. Para enterirnds de este denalle,
después de introducir un operadoc haremos gue T \.uuhlu Uhmmhnrm!u wome
el valor "OPERADOR". .

Por ot parte, sifa caleuliadora ademis del u|x.r.|dnr o ruu._nll ¢l primer
operando. este e perderi cuando se inicialice 1 pantilla pura introducir cl
seeundo operando.

Operandol = Yal(Pantalla.Ception)

Recopilando lo hasta ahora expuesto y pensando un poco mas alld! el proceso
totul se puede resumir en los siguicntes puntos:

1. Primero, un usuanio introduce un nimero (operandog.

(=]

A comtinuacion, introduce un operador. La cileuladora recuerda el namero y
el operador,

3. Despuds introduce un segundo mimero.
1. Y cuandy introduce otro operador, Ta culeutadora:
s Recuerda el segundo namero.

-

¢ Visudliza en Ia pantadla el resuliado producido por el operador sobre
lus dos operandus.

e Recuenda el resuttudo, como siose hubiern introducido un operando,
y el dlimo operador.

3. Sise introduce un operador a continuacidn de obo se recueida el dliimo.

6. Con respecto a una operacion cualguiery la caleuladora debe suber cuando se
introduce el operando primero y cuanduo se introduce el scgumlu.l para alma-
cenarlos en Jugares dilerentes y para saber siova tiene gue realishr Ta opera-
dion. Para esto wtilizaremes una variable NemOperandos que valdrd | cuando
se huva introducido b operanda priniera y 2 cuando se hasa introducido el

sezundu,
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7. Elresulrado de una operacian queda disponible como operando ..
und Siguiente siguienic operacion.

FLUNSHIH]

Para crear este procedimicnto. haga un doble ¢lic en una Je s tecls o, -, %,

/0 =, 0 bien_enfiqueks v pulse F7. Esto hace que se visualice fa ventana de codi-
¢0 cormrespondiente. can ¢l esquema que se indica a continuaciin.

Suly Operzsidn_Tliza (I:—:’exfr?{é!‘ Integer)

Observe gue el objeto subre el que ha hecho doble clic, penienece al amay de
controles Operador v ue el suceso es Click.

Seleccione “(gencraly” de Ja caja de objetos y “(declarationsy” de la caja de
sucesos para ese objeto. v declare las variables,

Dim 1o 2y cger
im0 . Uperanco? As Double
Dim Gps -1

Sub Operzcidan ad - s Irteger)

LnLE
e

'Tr

Gperad
l,J_..:::lc.!.G'J.
Gneranas?
Operagnio?

1 Operardol -
Lo Qperanaol -
1 = QOperercol -
1 .
1

)

= Uperanaol
= Operarndo?

[SINVIRTIRV NS

rErdot)

ILrsiope
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a L primera.

L siguienie teck que vamos a programar ¢s kudel tanto por cicato. Para ello,
picise pramero come rabaja esta lecks. Supangamus que ha Herado a la conclu-
sion de que a forma general de actuar es:

Operando_1 Operador Operando 2 <
! '
visualiza 1030, : —

i

a L.llkul.lllﬂrd si‘)l() responderi

Por ejemplo. si se teclea 1K) + 3 ¢

En el caso de pulsar repetidas veces la tecli ©

£n funcion de o expuesto, el procedimiento asociado con'esta tecla es el si-

guienie;
Zun f tanro _Clicx )
Dl TP R Dou ale:
H corada = "0isioo
= = Operandol * "g'( y /100
TapLion = Stryiitests
ick (0) ‘pare *=". Index @8

"OPERADROR"

La sentencia Resultudo = Operandol * Vali Panralla. Caption) /100 calcula
el tanto por ciento especilicado por Paatatle. Caption de 1 cantidisd especificads
por Operandol. Por ejemplo, si se teclea 1000 + 3 % Resudiado = 31,

El resultado se Hleva a la panialla como si el seeundo operando de 1a opera-
cion especilicada (en ¢l ejemplo +) se hubiera iroducido. Para que se realice
aulomdlicumente ¢sta operacion, de acuerdo con el ejemplo 1600 + 50, se llama
al procedimiento Operacion_Click come si latecla "=" se hubiera pulsado.

Cuando se pulse Ja tecli C es por que se yuiere inicializac fa caleuladora, esto
es. como st la hubicramos acibado de eacender. Fitonees. to gue ticse gue suce-
der es que en T pantalla aparezea "0y que las variables detinidas a nivel de la
forma sean inicializudas, para lo que se invocard ab procedimicnio Forn_ Lonud.

()
u‘J.u -

“oded as0-
LIS Varia-

Cuando se inicia la aplicacion se cjecuta el procedimiento F
ciado @ la formi. Por o anto, este procedimienio sicve pata inicic
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bles ueeesarias cuando se pone en marcha la calculudora ¥ cuando se pulsa L te-
clad,

Cuando se pulse lx ecly CE lo que S(':;-quierc e¢s borrar el altimo dito weleado
(dato aciuat de fa pantalla). porque nos hemos equivocado y lenemos que repe-
nrlo. En este caso, lo dnico que hay gque hacer es inicializar la pantalls a cero y
poner Las vanables afectadas al valor correspondiente en ese instante.

sub Horrarinirada

F Y .Capt 10 T
uine (-HJLL imal =
UlvigeEntrada = =~Co"
rrd :

Para teaminar, vamos a fijamos en un dltimo detalle. Cuando inicializamos la
caleuladora no es posible realizar una operacion comy, por ejemple, =3 x 3 (o
piense en operaciones como 3 X — 30 vi que. como es el dliimo operador el que se
liene en cuenta, lo que se realiza es 3 — 3). Este caso se da cuando sin haber te-
cleado operando alpuno, tecleamos un signo ~ con la finalidad de que ¢l primer
operando sea negative, Para dar solucian a este caso particular afada el siguicute
codigo al procedimiento Operacion_Click.

Sub Operacidn_Clic Thisd A ""err,_)
P Dhsidperandos = 0 2nz Zax).Campeion = "-* ‘Then
UltimeeEntrada = *!
Et*.cl Lf
Tf Ultimakntrada = *22ZiTO* Than

tnd sob

Obxerve que pars visualizar ¢l resultado se convierte el valor numidrico resul-
tanie a cadena de caracteres uiilizando la funcidn SeS. Si guieie representar ¢l re-
sultado baju un determinado formato. wilice la funcion Format$ en logar de s
Lanc16n Streg. a
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Es importante recordar que si en lugar de uiilizar Strs se utiliza |la tuncidn
FormatS. la cadena resultante utiliza fa notacion correspondiente a nuestio wdio-

Nt esto es. coma decimal.
|

Seain se vio en el capitulo anterion. cuando se convier{§ una cadena a un va-
lor numdrico utilizando ta funcion Vad. la conversian finalika cuande se lovaliza
i coma. lo-que origina Ya pérdida de la pane decimal. Esties U;Imlnl a4 gue estit
funcidn T SU arguimenio coma si esluvierd en nok 1unn m--l..m (pumu deci-
mal). Esie problema se soluciond entonces. implement mdn una Iunu:dnn Vidor
gue convierie una cindena de caracteres aoun valor Iillllh_ilu! ¥y que interpreda el

punto. coma separador de los iiles y Ls coma. como sep: n.uinr de lns decimales.

Seain ko expuesto anterionnente, si desea (ue su caleuladora utilice la cona
como separador de los decimales. sustituya Y funcion SteS por la funcion For-
mat$ para converir un valor numérica a una cadena de canwieres ¥k funcion
Val por la funcion Vedor para conventic una cadena de caracienes a un valor nu-
mérica (véa el capiula amenor).

Und vez gque haya cjecutado y comprendido esta aplicacion. conlo ejercicio
intente aiadir aleunas fonciones neis o fu caleuladora. Por cjemplo.

'

1. Anadir Las teclas de smemoria,
o sumar ol comenido de i memoria (M+)
o restar del contenido de la memoria (M=)

o leer el comenido de la memoria (MR).

EQ

Afudin lis funciones mateniiticas mads usuales. .

3. Permiitir utilizar, ademis del raton, ¢l weclado numérico parainirodocir datos.
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TECNICAS DE DISENO

—

DISENO DE UN MENU

Lrual que umy caja de wato o un boton, un mend ey un control. Para diseiar un
mend ilizareios la ventana de disefio de mends gque se puede ver en la figara si-

suienle.

- ]

Caption: | - - |_pone |

CtiName: | | [Cancet |
Index: [ | Accelesator: [(none) [+]

(] Checked " [ Enabled [ visible

(e[ [o] 0] Tl [t ) [Loskae ]

fara crear unomend los pasos a ejecutar son los siguienies:
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ejecutir. Este nombre correspondeni a un fichero existente en cf disco con exten-

sion [COM. EXE, BAT. o PIF; por ejemplo. WINMINE que arranca el joego

"huscs minas” que va con Windows, Por lo lanio, ¢l procedimicnto asociado con
la orden Efecutur es ¢l siguiente:

n FigrazroRjecutar_Click ()

i
] P

Cree una nueva forma y asignela el wtulo ¥ ¢l nombre Ejecutrr. Afada a la
forma uny etiquela "Aplicacion a cjc'cutﬁi;". una caja de texto en la gue ¢l usuario
pucda ¢seribir el nombre de la aplicacin a ejecutar, y dos botones con tos nom-
bres Cancelar y Aceptar.

Lina vez que el usuarid escriba el nombre de 1a aplicacién a gjecular. pulsard
el botdn Aceprar; en este instante la aplicacion arranca y se ejecuta normalmente,

. 3etFocus
.Jext = "¢
voar.Hide

Lste procedimiento, primers ejecuta la orden Shell que arrunca 1a aplicacion
referenciuda por, Text] Text v después devuelve el focw. que esti en el bowsn Can-
celur, u da caja de texto, elimina el texto existente en ka mismia. y veulta fa forma,

Si el usuario pulsa el boton Cuncelar, nu se ejecuta nada y se oculia la forma.

—elar_Click {)
L. Zetlocus
Tl.Text o= ot
fecLtar Hide : .

—_—— e

! CAPITULO 8
ih-

t

FICHEROS DE DATOS

INTRODUCCION

Muchas aphcaciones requicren almacenar y recuperar datos de una sesion a ora,
Los ficherus de datos pesmiten almacenar informacién gue el usuario ii:llrnducc a
través de una caja de didlogo v por lo tanto, son 1ambién L fuente de informacion
para visualizar ditos sobre una forma v para eseribir datos en una inlprc.ls'uru.

Par ejemplo, recuerde que en Capitalo 6 desarrollumos un editor cuyo menid
Fichero no soportaba fas ordenes Abrir y Guardar. Como comeeuencid, al finali-
zar un trabajo de edicion, no era posible guardar la informacion editady y por 1o
fanto, tampaeco pedriwnos recuperar dicha informacian en una nueva sesidn. El
mismo problema se nos presentd cuando disefiamos la base de datos pur[u Hevar la
contabilidad de los libros de nuestra biblioteca en ¢l Capitulo 7. Estos problemas
serdn solucionados en este capitulo.

Un fichero de datos se alinacena como yn fichero separada en el disco, esto
es, un fichero independiente de los Reheras que alimacenan la aplicacion!

Los tipos de ficheros de Vicual Basic asi como las sentencias para Iy manipu-
lacion de los mismos comnciden con lus tipos v sentencias suporadus [])ur QBA-
S1C 0 Quick BASIC. No obstante. existen muchas diferencias, en la Jorina de co-
municarse con el usuario. '

TIPOS DE FICHEROS EN VISUAL BASIC

Visual Basic permite crear tres clases dilerentes de ficheros de datos: secuencii-
les, aleatorios y binarios,
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£ tipo mas simple de fichero de datos es el fichero secuencial. Este ¢s un fi-
chero de texto que puede almacenar registros de cualquier longitud. Cuando lain-
formacion se escribe 1egisiio a registra, ostos son colocados uno a cuntinuacion
de otro v cuando se lee. se empieza por ¢l primer Fegistro y se continui al si-
suicnte hasta alcanzar el final. Generalmente. se utilizan como ficheros de wexto
en 108 que s¢ escribe toda la informacién desde ol principio hasta el final y s¢ bee
de la misma forma. Veremos esto practicamente cuando modiliquemos nuestro
edilor para que permila guardar la |d[0rulmcmn editada. Las sentencias y funcio-
nes mds comunes para tratar este tipo'de ficheros son: :

Open, Print #, Write #, Close, lnpui #, Line Input &, Input$, Eof

Un fichero aleatorio consiste eén un conjunto de registros de la misma longi-
td, los cuales pueden ser accedidus en cualguier secuencia. Cada registro indivi-
dual se identifica con un (nico nimero y puede ser leido. escrito o aciualizado.
Un fichero aleatorio es conocido lambién como un fichero de acceso ab azar, de
acveso directo o fichero relativo, La utilizacién de Nicheros aleatorios la veremos
précticamente cuando modifiquemos 1a aplicacion referente a la buse de datus de
libros. Las seatencias y funciones mds comunes para tratar este tipo de ficheros
son:

Open, Type...End Type, Put, Get, Close, [.OF, Loc

Los ficheros binarios ofrecen 1a posibilidad de teatar cualquier fichero como
una sécucncia numerada de caracleres. indepcndiememcme de la estruciura del
mismo. Los caracteres ocupan las posiciones 1. 2, 3. eic. Por ejemplo. si quisié-
ramos copiar un fichero ¢jecutable (EXE) ¢n otro, tendremos que tratarlo como
un fichero binario para leerlo caricier a curicter (byte a byte). Las sentencias y
funciones mds comuaies pira traty este 1po de ficheros son:

Qpen, Put, Get, Close, Seek, Input$

UTILIZACION DE FICHEROS SECUENCIALES

Vamos a afadir soporte a nuestra aplicacion Editor. para lo que 'm.idlrcnms al
mend Fichero las 6rdenes Abrir v Guardar.

Cargue la aplicacion Editor que realizé en el Capitulo 6 y unada al mend Fi-
chero las Gidenes con las propicdudes yue s¢ indican en la tbla siguiente. Re-
e res puntos a continuacion de una orden. ex wna torma de andicar al
u: que cuando ejecute la orden. s¢ vaa visuahzir una caja de didlogo,

Lt

-
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.

i Caption \ CtlName Accclerator
I Abrir... FicheroAbrir CultA
! Guanlz:r.:. FicheroGuardar ('lrl+d

i

Cuando ¢l usuario seleccione LI orden Guarduar. querenios quc se visualice
una cagi Jde didlogo como B que se presenta a contingicion. |

Guardar el fichero como:

| Aceptar ]

) (e ]

Cree una nueva forma, asienela el titulo Guardar Fichero v el nombre Guar-
dart’. A continvacidn anada los siguientes controles:

Caption CtiName | Text
Etiqueta Guardar el fichero como: | Labell
Caja de 1exto NombreFg | (nada)
Botdn | Aceprar Aceplar
Botdn 2 Cancelar -Cancelar i

Como se trata de una cuja de didlogo pademos eliminar Jos butones de mi-
nimizar ¥ maximizar la forma, Para cllo, ponga las propiedades MinButton y
MaxButton de la torama a valor False. También. y. con ¢l fin de que el usuario no
pueda vanar el lamaio de la forma, ponga la propiedad BorderStyle a valor 3.

Para que se visualice la forma gue acabamos de crear cuando el usuario haga
clic en ks orden Guardar, hay ue unir a esta orden el siguiente procedimiento:

oG ardar_C1i
"L Show

ox

()
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A continuacion, unimos ¢t procedimiento commespondicnte al botén Cancelar,
Cuando ¢l usuario pulse este boton. nosotras queremos limpiar la caja de texto,
enlucarla. para yue la siguicnte vez que se visualice la forma esté enfocada Ly caja
de texto v no el botén Cancelar, oculiar la forma v enfocar la ventana del editor.
Paca eflo. abra la ventana de codigo para el botén Cancelar ¥ escriba:

S:p Cencelar_Click () I
Nerkrerg.Texe = " ?'3;
Lognrefg. SetFecus o
GuerdarfF.Hide
Sorr_.Text] . SecFccus

ond £

.

Una vez que el usoario hava finalizado 1a edicidn, decidird guardar L intir-
macion escrita en un fichero en disco. Para cllo. ejecutard by vrden Grardur Jel
mend Fichero y escribird en a cajis de teso el nombre de hchero con el que guic-
re suardar Y informacién: después pulsard la orden Acepiar. En nuestro caso,
infurmacion de ka caja de 1exto viene dada por Formd Teal Text y el nombre del
fivhero viene dado por Guardurt NombreFg. Tear.

Escribir en un .fichero

Para realizar ¢l proceso de guardar b informacion en e fichero. hay que realizar

(es pPises! .
1. Abrired fichero para escribir (Ouiput) utilizando la sentencia Open. En este
caso crearemos un tichero secuencial. 1a sintanis de esta seniencia es:

Open nombre-fich [For modo] As [#]0° fichero

nembre-fich es ¢! nombie del Gichero {puede incluir el caminoy.

modor pede ser Output. Inpun. Append. Binary. o Random:

w* fichero es un nimero entre | v 233 para relerenciar el fichero.
Y. Escribir los datos en el fichero wilizando la sentencia Wrile # o Print #. En

nuestro Caso utilizaremos Print cuvi sinlanis ¢s: R :

Print #0° fichero. expresiones

1® fichero es ek nimero con ed yue s¢ abrid ¢l fichero para escribir

eapresiones exuna lista de expresiones numénivas y/o de caracleres sepatindis

PO CSPRICIOS, CONKLS O PUALOS v COIds,

Y Cenvar of fichere mediante Ta sentencia Close, La sintinas de et sentencia

(SN

]
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Close [|#[n® fichero | [/ ficheral. | .
a” fichero es el ndmero con el que se abnio el Nichero.
Continuemos con la aplicacion. Abra by ventana de codigzo correspondiente al

butén Aceprar y escriba ¢l procedimiento siguienie: ‘

ity

lzrero
Tor Outouel A5 o=k,
%l il Texs

Este procedimiemo tiene dos partes: esciibar en el fichero y ocubiae L forma,

La sentencia Open abre el fichero reterenciade por NonthreF g Tear para esceribir
(Output) y le asigna ¢l ndmero 1. Si el lichero no existe se crea y Si existe se
destruye y se crea de nuevo. La sentencia Print #1 escribe en el t':chcru‘ nomero 1,
La informacion referenciada por Formd Fex! Feur la cuad se canresponde con la
sdormacion edinada: el tichero estd creado. Fimdlmente La sentencia Close #1 cie-
ma el fchero ndmers 1, Un Achero cerrindo no pucde ser accedido: |u|r;‘1 acceder al
mismo. hay que volverlo wabrir con igual o diferente niinero. ‘ .
~ Sial abrir un fichero eaistente pari eseribir no queremos gue sa contenido se
destruva. tenemos que abrirlo en modo Append en lugar de niodo ()l!llpul. Esta
modatidad permite anadir la nueva informacion al tinal del lichera.

-

Control de errores’

Cuapdu se abre un Aichero de esta Forma. cabe La posibilidad de que se produzea
un error putgue el usuario ha espeailicado un camino incorrecto o porgue ¢l nom-
bie no ¢s correcto sintdcticumenie. Para manipular 1ales errores y cualquier otro
tipo de ermor, vamos a inteoducir b sentencii

On Error GoTo etigueiu

. donde etigaetes idemtitica a Ja primera Wnea de Ta ruting gue manipula el error,
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Una vez que se ejecute la sentencia On Error GoTo. cualgquier error que su-
ceda en ¢l procedimiento en ejecucidn, invocani a Ja runina-de error. donde noso-
tros manipularemios el mismo a nuestra convemicnuii.

L.a sentencia Resume permite continuar 1a ejecucion del programa despuds de
realizar un procedimicnio de recuperacidn de un emor. Puede utilizarse de cual-
quicra de lus formas siyuientes: Lo

H
B K
i oy : .
Resume (0] La ejecucién se reanuda en la sentencia que provoed el ecror.

Resume Next La ejecucion se réanuda en la semencia inmediatamente

postenior a la que’ provocd el error.

Resume etigueta La ejecucion se reanuda a partir de la etiqueta o nimero de
linea especificado.

Haciendo uso de estas seatencias modifique el procedimiento Aceprar_Click
de la forma siguicnte:

ar_Click ()

! ‘or GoTo futinaDeFrror
£scribir en el fichero
Open lombreFg.Text For Outp:: ~5 =1

rinz =1, Forml.Texrl.Text

la forma
Vlext = ="
.SerLFocus
.Hide
xtl.SetFocus

=xiz 3ub
RatirelaZrror:

¥sg3ox “*Error al abrir el {izrero", 13, *Zdéizor"
orgFg. 5etFocus

ResuT2 Salir
znd Sub

Obsene que hemos colocada la sentencia On Error al principio del proce-
dimieno para que cuando se abra el fichero. si el camino no existe o ¢} nombre
no ¢s comecto, se invogue a la ruting de mampulacién del emor referenciada por
Ya cuqueta KutnaDeError.

I a ruting de error visuabiza en una forma kada “Editoc”. el mensape “Ermor
al ! Nnehero® y enfoca de nuevo ba caja de wexte NombreFy para permitir al
(T wregir cl error,
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CONTROLES RELATIVOS A FICHEROS

El primer paso para leer ek contenido de un fichero s ablener el nombre del mis-
mo. leual gué hicunas para escribir un hehero, podrizmos construir una ¢aja de
didlogo y preguntarte il usuario por ¢l nombre del Hichero a'sccr. Pero esto no es
prictics, subre wdo cuande ¢l sistema de ticheros es grandg. Nosotros enemos
gue ser capaces de buscar un fichero por twodo el disco. de laymisma forma que lo
huce Windows, esto es, elegimos en una ventana 1 umdad ¢ disco, después en
otrd elegimos ¢l dicecteno, y por Gl en la ventana desticheros elegimos ¢l
nombre del fichero que deseamos leer. Para reabizar estas operaciones Visual Ba-
sic tiene disponibles en el panel de wiilidades wes controles: fista de unidades de
disca, lista de directorios y lista de ficheras (vea ¢l panel de wilidades en el
Capitulo 2). Por ejemplo, cree una forma y asignels el ttulo Sistema de Ficheros,
¢l nobre Sistemal, e incluya en la misma los siguientes controles:

Caption CilName
Etigqueta | Ficheros: Labell
Lista de ficheros ‘ Filel
Etiqueta 2 Directorios: Label2
Lista de direcrornios Dirl
Etigueta 3 Unidades: Labeld
Lista de unidudes Dnvel

El resultado, es lu forma que se presenta a continuacion.

-

Ficheros; Direclorios:.

fig0101 fim M=a *
1igl102 tim S vb

torm1_fim " P

foim3.frm =

global bas 0 cale hd
F oy Mok Unidades:

p0103.mak

project] mak hd [[QC: [STACVOL_DSK] EI
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{.a propiedad Drive del control lista de unidades de disco permite saber cuil
es la unidad actual. Coando queremas modificar fa unidad actual, sélo el primer
cardcter de la cadena de caracieres correspondiente, es significativo. Un cambio

de unidad de disco, genera eb suceso Change. Esta propiedad sélo estd disponible

en tiempo de ejecucion. Por ejemplo.

[

iztenaer.Drivel . Drivs = "g:*
] ‘.."!J. ‘ )
El directorio actual en el control fisia-de direciorios aparece sombreado. Lo
propiedad Path devuclve el camino completo del directorio actual, incluyendo ¢l
nombre de la unidad. Modificando el valor de esta propiedad podemos cambiar ¢l
directorio actual. Si sélo modificamos.la unidad (por ejemplo d:). por defecto se
seleceiona el directorio actual en dicha unidad. Un cambio de directoriv actual.
genera ¢l suceso Change. Esta propiedad sélo estd disponible en tempo de eje-
cucidn v perienece tumbién al control lista de ficheros. con la diferencia de que
aqui un cambio del caminu actual. genera el suceso PathChange. Por ejemply,

Siéter.a? .'D.irl .Pat= = *2: cemp”

La propiedad Pattern del control lista de ficheros permile que se visualicen
solamente los ficheros que cumplan ese patrdn. Por ejemplo. *mak hace que se
visuahicen sélo los ficheras con extension anek. La propiedad FileName permite
especificar el fichero que se guiere leer, o devuelve el nombre del fichero selec-
cionado cn la lista; esta propiedad sdlo esid disponible en tiemipo de ejecucion.
Por ¢jemplo, - :

combrer$ = Sistemat.rlizl.TileNare

Utilizacién conjunta de estos controles

Para sincronizar los controles Drivel. Dirl y Filel de la forma que acabamos de
diseiiar. Ya secuencia de pasos a seguir es la siguienie:

1. Elusuario selecciona una unidad de disco de la lista.

20 En el control Drivel. se visualiza la nueva unidad y se genera ¢l suceso
Change para este control,
3. Para gue se visualice simuliineamente la fista de directorios corespoadicnte

a la nueva unidad seleccionada. ¢l procedimiento Drive!_Change tene que
asteoar la nueva unidud a la propiedad Path del controd it
Sl orivel _Chan

. Paih =
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ABRIR UN FICHERO PARA LEER

ki
4. Enel control fYird. se, visualiza 1a aueva lista de direcionios v se genera el su-
ceso Change para éste control. L . f

’ : 11

5. Para que se visualice simulineamene la lista de ficheros correspondiente al
direetorio actual, el procedimiento Dirf_Change tiene 1uc asignar|el nuevo

. . z |

camino o la propiedad Path del control Fite t. :

’
'

Sub Dirl_Change (! .
Filel.Paln = Dlrl.¥act -
End Sub

o

6. Enel conirol Fife!, se visualiza Ly nueva fista de ficheros y se genera el suce-

so PathChange para éste control. v

Escriba estos procedimienios v continuetmos con nuestra aplicucion. Pense-
mos qué debe sticeder cuando el usuario haga chic en la orden Abrir deljmeani Fi-
chero de nuestra aplicacion Editer. La respuesta oy seoalla, s¢ tiene gue mostrar
la ventana Sistema de Ficheros. Para realizar esto, ubra L ventana de cédigo co-
rrespondiente @ la orden Abrir ¥ escriba el procediniento que se muestia a conti-
nuacion,

Sub Ficherororir_C:icz ()
Sistequ‘.Si’.o;—:
£nd Sub ’ ‘ : :

Guarde L aplicacién y a continuacion ¢jectitela. Observe como al c;lunbiur de
unidad se visualiza la lista de directonios comespondiente. Seleccione uml) de estos
directrios y observe gue-haciendo un doble clic sobre ¢l di.rc_cmrio seleccionado,

aparece la lista de fcheros correspondiente al mismo.

Una vez presentado el sistema de ficheros. et usuario seteccionard det mismo ¢
fichero que desea abrir, haciendo clic sobre su nombre. A continuacion,| para car-
garlo, pulsari el botén Aceplar o hard un doble clic sobre el nombre del mismo.
En otro caso, si desea cancelar L operacion. pulsard el boton Cancelar,

De acuerdo con lo expuesto, primeramente afiada o by formu Sistenia de Fi-

.

_cheros los botones Aceprar v Cuncelar s asigneles un nombre igual al twlo. La

. ; . . P . |
propiedad Default del boton Sceprar pongaly a valor True, esto hard ue ceando

pulse la tecly Enter ¢l resultado seu el mismo que si hubiera pulsado|el botdn
Aceptar. A continuacion, esenba el codico pura que extos butenes acuien como
deseamos. El cédigo para el boton Cancelur es el mis sencillo. pues simplemente
se trata de oculiar la torma. Esto es. . i ‘
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Fichetos: Directosios:

edilor.fim =eN |

editoi.mak o= ﬂ\, L Lﬁ:_e_pEJ
foirm1.him )

guardaif fim 2 Samples

1oject]. mak

Unidades: -

sistdefi. fim

[E=e: (sTACVOL_DSK) | ¢]

Escribamos ahora el codigo para el procedimiento Aceprar_Click. Este boton
va a tener indhiples funciones, esto es, aceprar una unidad, aceptar un directono o
acear un fichero seleccionado.

_ Cuando 2l usuario hace clic sobre Ty wnidud yue desea seleccionar en el con-
ol Drivel. s¢ genera el suceso Change para este control: 1ambién se genera esie
suceso cuando después de haber hecho La seleceién con las teclas de direccian, el
control se desenfocs manualmente o en ejecucion (SetFocus).

Para acepiar un directorio o uceprar un fichero seleccionado. necesitaremos
primero siber de qué elemento se trata, Para ello defina a nivel de la torma Sis-
tema de Ficheros {seleccione (general)), lus siguientes constantes v vanables que
a continuacion vinnos a utilizar.

Cuando e usuario pulse el'botdn Aceprar. o la tecla Enter. el procedimiento
asociado tendrd que verificar ka vanuble UltimoCambio para saber si 1o que hay
que uceptar es un directono v un fichero. El esquema de este procedimicnto es ¢l
siguiente: '
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8
Liy s
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w
M
ct

3

[FF I

£rd 35
La sentencia Acepiar.SerFocus enfoca ¢l boton .~\rcpfu;‘. Esta operacion es
necesaria después de pulsar Enter para aceptar I unidad de disco. si ésta fue se-

leccionada con las eelas de direceion. i

Cuando se genera ¢l suceso Click para el control Dird significa que el usuario
ha seleccionido, pero no ha aceplado, un directorio. Esta seleceion puede reahi-
zarla haciendo clic sobre el directerio o can lus tectas de direccion. La seleccion
realizada, la conprmard puksando el botdn Aceprar o haciendo undoble clic sobre
el directorio seleccionado. Entonces. en el procedimiento Dt _Click no tomare-
Mos ningun aceidn, sing simplemente gnotareinos gue se ha dido este hecho,
Su'r_) Lol _Clics (1}

UlzimeCamhio = CLIC_IL_DLX
nd Zub

Si- después de haber seleccionado un direciorio ¢f usuario polsa el botdn
Aceprar. este serid ahora el directono acwial, se genera ¢l suceso Change pura este
control v por Jo tamo, se acwaliza la ventana de licheros. El procedimiento
Aceptar_Click seri ahora asi:
Sub fcsptar Click ()

fcentar. Seilfocus

Select Cage UltimoCamhio

Czse CLIC_EN_DIR
Dirl.%ath = Disl. LisciDiri.liszindar)

Cazze CLIC_MN_FILE -
Enc Selecc
IroCambic = 0

La expresion Dird Listt Dirl Listlndex) devuelve el camino del directorio ac-
walmente seleccionado (vea fistas y combinados en ¢l Capitute 7). Esia opera-
cién estd implicita cuasdo fa aceptacion se hace con un doble clic.

Cuando se genera ¢l suceso Click para el controd File ! signitica que el usva-
rio ha seleccionado, pero o ha aceptado. un tichero, Esta seleceion puede reali-
zarla haciendo ¢lic sobre el fichern o con las teclas de direceion. La seleccién
reatizada la confirmard pulsando ¢l bodn Aceprar o haciendo un 77 clic sobre -
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el fichero seleccionado. Entonces en el procedimicnto File!_Click no tomareinos
ninguna accion. sino simplemente anotarenios que s¢ ha dado est hecho,

Cuanda el usuario hace un dobleitliclsobre ¢l fichero seleccionado para car-
garlo, el resultado ¢s equivalenie a sefeccionar ¢l fichero ¥ pulsar el bolon Acep-
tur. Por lo 1anto, el procedimiento Ft!el DblCluL tiene que contener las siguien-
les sentencias: L

}
IC_TL_TILE

Si despuds de haber seleccionado un fichero ¢l usuario pulsa’ed butdn Acep-
tar, el procedimiento Aceprar_( ek reconocerd que se ha aceptado un fichero,
tothard su nombre y Lo abrird para leer,

Leer de un fichero secuencial

Pura realizar el proceso de leer la informacidn de un fichero secuencial. hay yue
realizar (res pasos:

1. Abrir el fichero para feer (Input) utilizando la sentencia Open. La sintaxis
de esta sentencia es: -
Open nombre-fich [For modoe] As |#]n” fichero

nombre-fich es ¢l nombre del lichero {(puede incluir el camino);
maodo puede ser Ouiput. lnput. Append. Binury. o Random;
i” fichero s un numero entre 1y 233 para referenciar el fichero.

2. Leer los daios del fichero utitizando la sentencia Input # o InputS. En nues-
tre Caso utilizaremos Inputs cuya sintuxis s

S = Input$ (. Bn” ficheroy

#nes el mimero de caracteres a leer:
n” fichero es el nimero con el gue se abrid el fichero para leer.

3. Cerrar ef fichero mediante la sentencia Close. La sivaxis de esta sentencia
es:

(luse[[ In* fichere [ {# " .rulu'ml 1
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i
n® fichere es el ndmero con el gue se abrid el fichero. ;
Continuemas con la aplicacion. Abra la ventana de cddiyo correspondiente ul
botén Aveprar de la forma Sistema de Ficheros v complee ¢l procedimiento
Aceprar_Click como s¢ indica a continuacion: ‘
1

“ing ' ih.

LoimoCarnbio A
_DIR :

Dirl Lisc(DIirl. Lissind
vorile
SUSH{Oirlo2ath, by o= "Wt
"o = Dirt.vath - Tiiel i
PJiz-l.faen - ow - Uilal o Fi ik
. o For Input s #1
B JTexe o= lnpu S{O~i Ly, =10
C:
Fnd se
Jicizne .
eng sun

Este procedimicnio tiene dos partes: huscar ¢l nombre del fichero v abiir este
-
hichero para leer.

El nombre del fichera a abrir se almacena en Ly vanable Fichero, La expre-
sion Dirl Paik vepresenta el camino completo incluy coda Ly unidad de disco (por
ejemplo. c:wbsamples) y nosotros adadimos el caricter A" v el nombre dlcl tiche-
ro dado por ka expresion Filel FileNume. Esto nos peruitird recuperar cualquier
fichero de texto de cualyuier directorio. Sin embargo. cuandu el | canino
Dirl Path se corresponde con el directorio raiz, l como diL obtendifamos un ca-
rdcter "V de mids (por ejemplo, d'Wichero.r), Para evitar esto. chcquculrcnms el
altime cardcter de Dirl. Path. EL resultado es:

,

rath, 1) = :
i Patn + Filel. Filenzoe

]

Dol Path o+ A+

1.a seniencia Open
y le asigna el ndmero

abre el fichero referenciade por Fichéro para leer (Input)
I. Si el fichero no es de teato o es demasiado grande

e ey
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{mayor de 64 Kb), se produciri un error. Para detectar los posibles errores y
permitir la continuacidn del programa, modificaremos el procedimiento Acep-
tar_Click de I forma siguiente:

End
Zalir:

JttizcCampio = 2
Exic Sub

RuLinazrror:
Msg2ox "wrror:
Close
Resurz Salir

End Sub

A3, "Iaicor"

También puede ocurric ua error al seleccionar fa unidad de disco (por ¢jem-
plo, la unidad @) debido s que ésta no esté preparada. Para detectar este posible
error, moditicaremos el procedimiento Driver]_Change de lu forma siguienle:

MsoScx *"Error: 2nidai no pregaveds-, <3, "Zali-or”®
Exiz Sub
End Suz

La funcion TnputS lee del fichero niniero | un nidmero de caracteres igual a
la longitud del mismo (LOF(1)) v almacena la informacion en Forml Textl Texr
que.; esponde con el drea de edicién. Finalmente la sentencia Close #1 cierra
el “ndmero 1. Un fichero abierto no puede ser vuelto a abrir ¢n ninguno de

CAPITULO 3 BICHEROS DE DATOS 175
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los modos: para volverlo a abrir en ¢l mismo u otra modo. con igual o diferente
numero. hay que cermarlo previamente.

La funcion [nput$ esta limitada a leer 32767 caracteres de un fichero abierto
en modo secuencial o binario. Para leer ficheros miis largos. sipplemente hay que
chequear la longitnd del Ildn.m y leerlo en varias veces como se especifica a
conunu.juun ‘

Diz longizug As bong, NOAS lnoegas k

Lorgizia = LOF(1)

_E¥oG = """ ‘.'

] :
I Longltud » 32767 ‘Then
TZuhi ! :

ionaizud

Texto + inpui$iN, =21)
Longitud - 32767

Longitud <= 0

.Text = Téxto

En el ejemplo anterior, fa variable Tevio es de tipo String y esid definida a
nivel de la forma. Si define esta variable comu local, tendrid problemas de espacio
de memoria.

Similanmente. la sentencia Line Input # lee de un fichero cadenas de caracte-
res delimitadas por retornos de carro (el detimitador no se lee). Esto significa que
otra torma de leer un fichero, es utilizando esta sentencia como se especilica a
continuacion. En cualguier caso, y pard nuesira aplicacion. leQ furma resulta muy
leata. por 1o que no es aconsejable.

Diz Linea s 3tring
41, Linea

Text = Forml, Textl. Texc + Lirss - Crrs(ld) + Cusilo)
ZEOF (1}

Observe que por cada Linea de 1exto que anadimos a 1a caja de texio hay que
aitadir lambién el retuyno de carmo que no se fee (CheSt 13} + ChrS(10)) .

La funcidn EOF retorna un valor de —1 (True} si se ha alcanzado el final del
fichero especificado, en nuestro caso el fichero 1y un valor 0 (B~
contranio.
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~ Recuerde que la propiedad Text es de tipa String ¥ por o tanto estd hmitady
a aproximadamente 65535 caracteres. '

UTILIZACION DE FICHEROS ALEATORIOS

Vamoes a afiadir soporte a-nuestra aplicacién Libros. .para lo que afiadiremos al
e Fichero las drdenes de Abrir y dlui_}‘f!ar.
V o
Curgue 1 aplicacion Libros que realizé en el Capitulo 7 v afada al menn Fi-
chero las drdenes.con las propiedades que se indican en fa wbla siguiente.

|
|
|

Caption " | CiiName Accelerator
Abrir... FicheroAbrir C_lrI+B ‘
Guardar.” FicheroGuardar Cul+G

Recuerde que nuestra base de datos estaba formada por un armdy de registros
denoniinado Libros, definido en el médulo global libros.bus como se indica a
CONLINUACION. ‘ i

I

ype SZZlElro Co. .
Tit..Zs s sString * 30
sutcr A3 String * 30
Edizorial As String * 12
Prez-aco As String * 240
—nid Tuos
Gicbha: “itzros{l To 40) 5s Regizz:io

Escribir en un fichero aleatorio

Cuando el usuario haga clic en la orden Guardar del mend Fichero. ¢s porgue

-gquiere guardar fa base de datos Libroy en-un tichero. Para realizar esta operacion,

podemos utitizar b misma caja de didlogo que en la aplic;icién anterior, Pura cur-
var lu forma Guardar Fichero de la aplicacion Editor en la aplicacion Libros, se-
lecciwone Lo orden Add File (Anadir Fichero) del mend File de Visual Basic y se-
leconwmie ¢ lichera fon correspondiente de L lista de ficheros,

A vontmuvadion visaahice faovenima de codivn LU[[(.‘PU"LIIL“IL a Lo ovden
G dar del iena Frchere y casenba: ’

.

P

-~
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\

el
1
[0 B [

- 4
;
."dudii!“ncnms shora tos procedimicnios asociados con esta forma para ackap-
tarfus a la aplicacion Libros. Asi. eb procedimiento Cancelgf_Click asociado al
botin Cancetar. cuando finalice, tiene ahora que enfovar a fa caja Titdlo de 1a
forma Form!. Realizado este cambio, ¢l procedimicnto qlud.“nmu sigue:

ek o)

CCUs T

LTI DL senrocus

Ll procedimicno Aceprar_Click asociado con ¢l botdn Aceptar, permite
cuardar la informacion requenida en un fichero de nombre, el escrito en lu caja de
texto NombreFe. Para guardar los registros de ba base de datos uuhmrum)s
ahora, un fichero aleatorio en lugar de un fichero secuencial. Para eseribir en un
fichero aleatorio. hay gue readizar (res pasos: ‘

. Abrir el fichero para acceso al azar wiilizando 13 sentencia Open. La sintaxis

ei esle caso e lu siguiente: 7
Ogpen nombre-fich [For Random| As [#]n” fichero Len = longind reg

nombre-fich es el nombre del Nichera (puede incluir el caminon);

n® fichero es un ndmero entre 1y 2535 pura referenciar el fichero;
fonging reg ¢s una expresion entera que indica la longitud de cada uno de fos
re2istros de un fichero aleatono,

3 Escribir los dutos en el fichero utilizando la sentencia Put. La sintaxis de esta
Seniencia es: . :

Put [#|n° fichero. [|n® regisirol[, variuble)

) ju heru es el ndmero con Ll qm, se abid el fichero:

- W% regisiro es el admero 4 o del registro. Si se onnte se toma el ndime-
m-mgunemc al unlizado en ta ulnm.n sentencia Put:

varigble contiene Yos ditos u escribir en el fichero.
3. . Cervar el fichers una ves finalizadas las operaciones de 159/ mediante la sen-

tencia Close.

Cuundo se abre un fichero en modo Random si no existe se crea y siexiste
simplemente se abre. En cualquier caso. el fichero queda abiento para leer y es-
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cribir a menos que se especifique otra cosa mediante la clivsula Access, Escribir
encima de cualquier registro del fichero significa modificar ese regisiro.

Para escribir la base de datos, ahora almacenada en el array Libros. en el fi-
chero referenciado por NumbreFg. Teat. las operaciones son Las sivuicnies:

()pen;bk:brng.Text Tor Pavcmm ts 1l len = Lemiiinres(l))
fror I = 1 To TotalRegs v .1 :
Put #1, , Libros(i) D
Next I )
Close &1

En el supuesto de que el fichero'va exista. el proceso anterior sobrescribirid
los registros exislentes a partic del 1. Cuando se modilique b base de datos y se
guarde una y otra vez en ¢l fichero. sucederd que si el ndmero de registros del
aray Libros es menor que el nimero aciual de regisiros del fichero, los regisiros
en demasia quedarin, cuando lu realidad es que tienen que desapurecer. Uni for-
ma lacil de dar solucion a este problema es venificar antes de escribir en ol fichero
si éste existe, en cuyo caso lo borramos y lo creamos de nuevo. Las sentencias si-
guientes realizan este proceso.

Open MNombreFg.Text For Random Is k] ian = Len{iibrosil))
If {(LOF{1) <> 0} Then
Cadena = *“El fichero va exisze® + CrrS{il) + Ckr3(10)

Cadena = Cadena +
I1f MsgBox{Cadere, 36,
Close #1
Kill NombreFg.Text
Open NamweFg.Text For Fzdam 25 =L Len = Len(Librez (1))
Else
Close #1
NombreFg.Setrocus
Exit Sub
End If
End If

g3cripirio?»
j =

6 Then

En el caso de que el fichero exista (su lungitud no es 0). 1a funcién MsgBox
visualizard el mensuje dado por Cadena en una forma con un icono " v con dos
botones Si'y No (icono (32) + botones SifNe t4) = 36). Si se pulsa el boton $i Ta
funcidn devuelve el valor 6 y si se pulsa el butdn No devuelve el valor 7. Observe
que ¢l memaje escrito poc la funcion MsgBos comsta de dos tineas.

31 el wsuario pulsa el butdn 57, la sentencia Kill burrrel fichero especiticado.
clv wie gue estur cemado. vl sentencia Open crea de nuevo el ficheros si
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pubsa ¢l botén No, se enfoca de nuevo fa vaja de tento, para permtor al usuario
modificar el nombre del lichero. v w2 abandona este provedimiento.

Abra la ventana de codiva comrespondiente al botn Aceprar de la forma
Guardur Fichere y mudifique ¢l procedisniento .-h-cpmr_CHTk para que realice

- . . ]
las operaciones indicadas. H
r
Sub fceptar_Click () _ . ..
Dim © 28 Integer, Cz2zana String v

on Error GoTo Rut!
‘Bscribivr en el ficnh

Open lrabrefy.Text ror andom A5 =t Len = Laﬂll,.ibrostl))
If (LO¥{1} <> 0} Trnzn - S
Cedena = =l fick - Chrs{13) + Chr$(i0)
Cadena = Cadena 's:-s::-.'i;bf'rlo? "
I HsgBox(Cadenra ") = & ‘then
Close =

111 Kombrerg.?”
Open Noireby.TexT Tor
Else
Close #1
tiombrefrq ., SetFoc.s
Exit Sub
Eng [f
End 1¢
For I = 1 To Totalrsgs
Pug &1, , Libros{I)
Naxt 1
Clcse #1
*Ocultrar la forma

e o= Laentbibros(l))

NombreFg.Text = *° .
NombreFg.SetFocus
GuarcarfF.Hide ~
Forml.Titulo,.Setfogc:s

Salir:
Exiz Sub

RurineDekrror:
tisg3ox "Error al gzrir el
Moznrefg.SetFocus
Resume Salir

End Sub

“Libros*

Guarde Y forma que acuba de modifnicar con oire nombre, para no cambiar el
fichero .frm de la aplicacion Editor. Para ello ejecute 1a orden Save File As del
mend Fite de Visual Basic,



180 VISUAL BASIC. APLICACIONES PAR Y WINDOWS

Leer de un fichero aleatorio

Cuando ¢l usuario haga clic en la orden Abrir del ment Fichero s porque quicre
leer la base de datos almacenada en un fichero conocido v almacenarla en el array
Libros. Para realizar ¢sta operacién, podemos uiilizar la misma.caju Je didlogo
Sistema de Ficheros que en la aplicacion anterior. Para cargar en nuestra aplica-
cidon Libros fa forma que da lugar a egla'.,'&,_aja de didlogo. seleceione fa urden Add
File (Afadir Fichero) del ment File'de Visual Basic y seleccione el tichero fim
correspondiente de Ja lista de ficheros.

A continuacion visualice la vendana de cédigo correspondiente a la orden
Abrir del mend Fichero v escriba:

gub Ficreroitbrivr_Click (}
Sistenatr.Show
Znd Sub

Modifiquemos ahora Jos procedimicnios asociados con esta forma para adap-
wrlos a la aplicacion Libros. E) tnico procedimiento que cambia es Acep-
tar_Click, que se tiene que encargar de leer Ja base de datos del fichero y almuce-
narla en et array Libros. Para leer los registros de la base de datos. teniendu en
cucnta que el fichero es aleatorio, hay que realizar res pasos:

L. Abrir el fichero para acceso af azar wilizando la sentencia Open.

3. Leer el regisiro deseado del fichero utilizando la semencia Get. La sintaxis
de esta sentencia es 12 siguiente:
Get [#]n* fichero, [.|n° registro}l, variable]
n* fichero es el nimero con el gue se abrié el fichero:
@ yegistro es ¢l nimero 1, 2, 3, ., del registro. 8i s¢ omite se ton el mdme-
ro sigetiente al utilizado en la dhima sentencia Get:
variable almacena los datos del registro leido del fichero
3. Cerrar el fichero una vez finalizadas Jas operaciones de E/S mediante La sen-
tencia Close.
Para leer Ia base de datos del fichero eferenciado por Nombreb 2. Text y al-
macenarla en el array Libros. las operaciones son lus siguientes:

3 = LC-(1)
Tor 1 = 1 To Nerz=gsFi
Ger =1, , Librcs{i}

' |
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Hext I L
Close #1 - .

e e

La operacion de leer ol fichero v cargar ol areay no activa la base[de datos,
Por ¢so. a continuacion, wenemos que anadir a Ta hisa casitidada Listaliibros, los
titlulos de cada uno de tos registros del amayv, concel tin de due el usuarnio pueda
\LILLLIUI].IF de L misia cuslguiera de ellos. Pava realizar esy npt:rluunl €8 nece-
satio previmmente borrar todas las entradas actuales de la In».lu clasitica da. De no
hacerlo asi, L carga de i base de datos ¢ anadinia i la .mh,ru)rmum. cargada,

Finalmente, se visuadiza en Ly cuga de didlogo tulada Libriss Prestados y deno-

mimada Formd, el primier registr, Estas operaciones, se redbizan de la [forma si-

auicnte; ' K
‘Borrar los registres cxlztesooes en la base e dutos
tror I = 1 To Togal?
Form?2.ListaLinros. Ferzvelnan 0
Next 1
"TotalRegs = MNumlegstios

*Afadir los elenmentns 322 3rray a4 ia lista
Fer 1 = 1 To To:alﬁ“;

4ol

Form? . Listalibros
Next I

"Visualizar el primes
orml.Titule, Text = _
Forml.sucor.Texe = !
Forml.rditorial . Texc
Forml . 2restaedo.Toxt =

Abra ta ventana de codigo correspondienie sl boton Aceptar de la !mma Sis-
tema de Ficlieros y modifigue el procediniie o ,\(qmu_(h(l\ para gue realice
las operaciones indicadus.

Sub Aceptar_Click {)
PDim Fichero 25 Surin
Dim HunBegsFicn A5 2 LanIReg s Inbeger, T
LongReqg = Lentlibrazii) .
Aceptar.SetFocus
Select Case Ultizelz

Case CLIC_Z:_Din
Dirl.Parz = Sirzl.list:

tn

Integer

PriLListIndex)

Case CLIC
Oon Errc :
If (Rigros

Ficher

) = ity Then
1e1.i~110[1amc

'
g
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_ TYpDe Registro
=-5= _ s Tl i leren Titulo &s Sering <= -3
7ic Tiri.Zath o+ "\t o+ Filel.rilelame Lutor 4s Scring * 30
3 - v emdor ta 51 Len = Longies kEditorial xs String = 12
==t For Rangom =3 il LEN = SONY~Ly Prestado As Sktring * 240
] LGT(1} \ LongRey znd Type
[-=s -stros del fichero Global Libros As Reaiziro ‘
rer Jumzenglcn Global TotalRegs is ineger K
TR R “DKOS(“l_. Global f—‘ichc—:o ks Suring .
lexo T oy
C.ose =1 i . )
‘torrar los rezistros ex15te1tes en 1a kase de dzvcs Esto implica que ¢l pnxcdunmnu)l:uud;u:R.gn:n)Lﬂrnucelrcgwuu se-
rcr I =1 7o djo z21R3egs, leccionado de la fista, directamente del fichero. .
?O!mZ.LiSC&;lDVO: Removeltem 0 BE
lizwe I Sub Visuvatizarregiscro () FE
TcoalR h Dim [ 2s Integur, fncontraco =23 Inceger
*iAadi éel array a la lisca Encontrado = 0 'elersnto no encontrido
ror I 'Buscar el registro seleccionado
Tors ddicten Libros(I).Tiz:io Open Fichero For Rerdom As =1 Len = Len({Lizros)
x For I = 1 To LOF{l} % Len(Libros)
i s registro Get #t, I, Libros
Forml,Titulo.Zexs = Libros(l}.Titulo L (Riries(Lilros. Titw o) = RIvasSifom? Listalabraz: Taxg)) Tren 7
Forml.rutor.zexc = Libros(l}.Aucor Encontrado = -1 ‘elemento enconirado
Taorml.Editoriel.Texy = Libros{l}.Editoria: Exit ror
Forml.Prescedo.Taext = LIibros{l).Prestado End If
Sistemar.Hics ‘ ' Next 1
End Szlect Close 31
Salir: If (Encontrado} Then .
UitizcCembio = 7 ‘Yisualizar regis:zro
Exit Scp . Forml.Titulo.Text = Libros.Titulo:®
Rut inagrror: - . Forml . tutor.Text = Libros.Zutor
MsgBox "Irror: ro 22 pixie abrir el fichero®, 48, "libros® Forml.Editorial.7axt = Libros.Edizorial
Close Forml .Prestado.Text = Libros.Prescado
Resuwe Salir Form2.Hide
End Sub Else ~
Msgrox "zl libro esazcificaas no se ewxuentra®, <E, “Libros®
. End If :
Trabajando directamente sobre el fichero £nd Sub
Eb array Libros ocupa una cantidad de memonia considerable y dependiendo del El procedimiento Aceptar_Click asociado con el batdn Aceprar de la forma
tfamaio de 1a base de datos puede incluso que no podanos crearlo. Esio nos con- Sistema de Ficheros, se mudifica en el seatido de que ahora no carga un armay con
duce a pensar como prescindir del amay y trabajar directamente sobre ¢l fichero los registros del fichero, y en que la lista clasilicada, Listalibros, se crea leyendo
en disco. aunque ¢sta fonna de trabajo resulte un poco mis lenta. cada registro directamente del fichero. La variable Fichero se ha definido como
: global.
En primer lugar defing Libros como un registro y no como un aray v aiady ) .
la variable Fichero como glubal. Fichero especilica la base de datos sobie la que Sub Acekptar_g ! l‘"k {) o .
ests trabajando. Dim [ximRegsfich As [rtzger, Longleg 25 Integer, I s Integsr

LongrPeg = Len(Libros)
Aceptar.Setrocus
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Ca

) o
1ol

O

Random ~s #1 Len = longleg
“{1)-\ LongReg .

vgs existentes en la bise £z dacos
z1Regs

ros.Removeltem 0

Zzgsrich i
ntos del array & la 1

frs

Lin
o1
0

item leLGS Titulo
‘mer registro

Lipros.Titulo
Linrcs.sutor

¥U = Lipros.Ecitorieal
Libros.Presizado

tnd Select
Salir:

UltiroCambio =

Exit Sub
RutinaZrror:

Msqi2ox "Error: @D 22 riade eprir el ficheron, 18, *Linros”

Close
Kesume Salir
End Sub

Muodifique el procedimiento FicheroGuardar_Click asociado con la orden
Guardar Jel mend Fichero, como se indica a continuaciin. Este procedimicnio

visualiza la forma GuardarF v el nombre del fichero actual en su caja de exo.

Sub Vi”"

IMTIVEN S-St
Guerasss,

nd Seh
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]

llpnwaMnumnAnpm:CMLJuKHM)umclhmm hqmudgﬁlmmm
Guardar Fichero. puesto que va no existe ¢l array Libros. se modifica de 1a fonna
siguiente; como es pasible que hayamos borrado elementos de la listal debemos
crear un nuevo fichero, con el nombre especificado por ¢f usuano, que contenga
solo tos registros del fichero viejo (Fichero} que pertenczcag a la lisia. Para ello,
pnnmn)nnmnhmnmsPuhwwLunLlnnmhn Temypr, aeoﬁumamonabnmu>d
fichero especificado por el usuario para guardar fa base de datos. y cnpmmos en
éste todus los registros de Temp que estén en Ta lista de llbrn'.s'(l_lsmL:bm_\) ’

Esto proceso resulta satisfactorio si no hay tilos rc'p'ctidos. Dejo para el
lector el tratamiento de este problema, 1 1o cree neeesano.

.
I sentencia Name permite cambiar ¢l nombre de un fichero. Si al escribir el
pombre nuevo se indica un camino diterente al camino original. el fichero. ade-

s de ser renombrado, ¢s movide al auevo directorio especificado.

sub ~eeptar_Click )
Dim 1 A~s Integer, Cedena & String
0N EZrror GoTo ?LL- zDebrror
Merme Fichero 'si Fichero no existe, error I3
‘Zscribir en
Onen Liombrerg. Te
If (LOF(l) «» OJ Than
Cadena = “il .1c:ero va existe" - C;
Cacana = Cade - *:desea sobrescr
TL Hschx(Caée ,b, “Libros") =
Close 21
Kill Nombrefy.-=xt
Oen Lorbrerg.Tsx: For Random 25 =1 len = za(Libros)
Slee
Close =1
llombrerg. Setfocis
a Ex it Sub

wandom As #1 Len = Len(Lilres)’

Eng TE T
Onen "Temp® For Razdom As #2 Len = ien(Lizros)
fov = 1 To LOF{z) / lLen{Libros)

s 2, , Libros

or I =G To loh' Fegs - 1
If a)z BivunS{Form?. Listebijzos . l=7(0))) e
Put 51 , Linrcs
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Fickero = Herkbr ‘cnere creado
'

*Oculzar la for

Tg.Texg = **
.Setrrocus

= . Hide

itulo.Secrocus

Hombr
Nomb~
Guarg
Form?
Salir:
Exit 32D
RutingleZrror: -
Selec: Case Err R
gze 53 'el fichero no existe
sume Next

End &
Nompre g.SetFocus
R;sune Salir

End Sub

< . Lz i
vsgBox *Error al abrir. el fichero®, 48, *Libros”
2l '

En el procedimiento Borrar_Click asociado con el boton Borrar de la forma
Buscar Regisiro, desaparece la pane que bumaba un registro del array Libros,
quedando dicho procedimiento como sigue: :

Sub Borrar_Click (1}
Dim * As Inteager
'Borrar el registro ce la lis:
*Posicidn en la lisca .
R = Torm2.ListelLibros.ListIrcex
'Se morra
Form2.Listal.ibros.Zezovelten =
Totailegs = Form2.LiscalLibros._istCour:
Form2 .Yide

End Sun

AT]

El procedimiento AiadirReg_Click asociado con 1a orden Ailadir Registro del
meni Fichero, ahora debe anadir el registro al final del fichera, y el titulo a la
lista de libros.

Sub AfzdirReqg_Click ()

Dim - ) 48 Intecger
Librso. .  alo =1
Libres. autor =
Likres.Editorie
Litr2s.Prescado ; ;
Tichero Fer =i oR3 Len o= SAlinrozs
! 35 = LOF(LY o Langlinrss
' =L, Humiscs - 2, Llzros
L =1
Fo. ..,Listalibres.iZ2Giten c.Text
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Cuando ¢l usuario desce crear un fichero nuevo, simplemente aftadira
registros v después los guardard en el fichero deseado, ejecutando la orden
Guardar del meni Fichero. Fsto exige inicializar la vaniable ghheN)1un\uhw
operacion que realiza ¢l procedimicnio Form_Load. Sewin estd, el procedimicnto
AdadirRey_Clik anadird los regisiros al fichero denominaflo Temporal y el
procedimicnto Aceprar_Click asociado con el bowin Aceptar “Ia tunna Guardar
Fichero. lo copiard sobre el nuevo fichero especificado.

SENTENCIA Seek

La sentencia Seek permite situar Ja posicion de lectura o de escritury en una po-
sicion determinada denwo del fichero. Su sintaxis es:

Seek [#]n” fichero, posiciin
Por ejemplo, 1a sentencia:

Cet #i, 1, Limres(l)

es equivulenlc a Tas sentencias:’

Seek =1, I

Get =., , Lizrecs{I) -

[kl

La sentencia Get lee tantos bytes como quepan en la variable y 1a sentencia
Put escribe tantos byles como hava en L variable,

Fi areumento posicidn ¢s un entero largo y especifica la nueva posicion den-
ro del fichero. Para up fichero secuencial o binario, posicién es interpretado
como el nimero de byte (caricter) a pastir del cual queremos leer 0 escribir dentro
del fichero: para ficheros aleatonos. posicion s interpretado como el namero de
registro a partir del cual queremos Ieer o escribir deniro del fichero.

Esta sentencia nos permite trabujar byte a byle ¢n ticheros binanos. Por
ejemplo:

Dim & s S=ri:
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"

1
f
Cpe St oTor Rinzry As sl i i
Ice
Cet =., .
Seek =1, 1 ;
Pat f:, ., a .
. | g - . lcAPITULO 9
Partiendo de que la primera posicién dentro del Hichero es a1 este cjemplo X _

almacena en o los caracteres de fas ppsigiones 11, 12,13, 14y 15, quadande en
16 la posicion actual dentro del fichdro! A continuaciin. se escribe el contenido
de a en las posiciones |, 2. 3, 4 y 3. quedando en 6 la posicion aciaal.

o EFECTOS GRAFICOS

e .

i

FUNCIONES Loc y LOF

Recordamos por el interds que tienen. que las funciones Loc(n) v LOF(n) dun |NTRQDUCC|()N
como resullado la posicién actual en ¢l fichero y Ju longiwd o ndnero Jde caracte-
res del fichero ar especificado. l ’ Visual Busiv provee varias formas de producir efectos griificos y de ana form
aiis sencillia que con la programacian tradicional. Se pueden mover objetos por la

Para un fichero secuencial. Loc devuelve el mimero de bloques de 128 bytes puntally, hacerlos aparecer y desaparecer. mixdificar su imaio y ademds realizar

feidos o eseritos; para un fichero aleatorio, devuelve el niinero del Glimo registro cualguicr grifico que se nos pueda ocurrir. combinundo tas figuras bdsicas como
leido o escrito; y para un fhichero binario, devuelve 1a posicion del dltimo byie lineas, cajas, circulos, etc., soportadas directamente por Visual Busic.
leido o escrito.

Paca un fichero aleatorio. el vator devueho por la funcion 1L.OF dividido por IMAGENES
fa longitud del registro (argumento Len o £28 por defecto) da el ndmero de regis- : .
tros def fichero. Para un fichero secuencial en el yue los registros son de longitud En Visual Basic es posible afadic uni imagen (uni Hgura en L—’U"L""-‘“.ﬂl una for-
variable. esie vdleulo no tiene lugar. © ma. La imagen puede ser pucsta directamente sobre Ta toruia o dentio de una caja

. . . .
de imagen (conteol imagen). Esta inagen puede estar almacenida cn tres tipos de

ficheras: .BMP (bitmap), 1CO ticom) y WMFEF (Windows metafie).

UTILIZACION DE LA IMPRESORA

Estos hicheros pueden ser creados por muchos paguetes griaficos, Porfejemplo,

Para obtener resultados impresos Visual Basic provee ¢l objeto Printer. ¢l cual ¢s Windows puede crear ficheros BMI por inedio de la aididad arifica Paintbrush.
utilizado para controlar ¢l teato y los griticos que se imprimen en una paging v Pur otra parte, Visual Basic provee una amplia libreria de ticheros 1CO {vea ¢l
para enviarlos directamenie a la impresora por defecto. Por ejemiplo. ditecturio Whiicons).

Printes.2vint Librecs.T7z2la, Tab(40); ibros.Zilzorizl

. Cargar una imagen
Para mds detalles ver en el Capitulo 12 "INMPRESION DE RESUL IADOS”™.

Una imagen puede ser afadida durante el diserio de la aplicacion y durante la ¢je-

" FICHEROS INDEXADOS :  cucidn.

Visual Basic no tiene ficheros indexados. No obstante, ¢n ¢l Capitulo 12 se es-
diard sy estructurit, Creacion v mantenimienta,

Para afiadir una imagen durante ¢l diseio los pasos i seguir son:
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l.  Seleccione la forma o la caja de imagen.

w

Dirijase a la barra de propiedades. seleccione Picture de Ya lista de propieda-

des y haga clic en el botdn [...] siado a la derecha de ta barra de propicda-
des, Se visualiza una caja de didlogo.

3. Elija el fichero .BMP. 1CO. o .WMF que desce.

La imagen seleccionada es colocalla ¢n la forma o en la caja detrds de cual-
quier control que hubiera colocado all. .

También puede afadir una imagen de otra aplicacion, utilizando el portapape-
les. Por ejemplo, dibuje una imagen con PaintBrush, copiela en el portapapeles y
péguela en la forma o caja de imagen de su aplicacién.

Para eliminar 1a_imagen. ponga de nuevo la propiedad Picture a valor
“(None)”. Para ello, haga un dable clic en la baa de propiedades sobre el valor
actual asignado a Picture y pulse la tecla Del (Supr).

Para afadir una imagen durante 1a ¢jecucién, utilice 1a funcién LoadPicture.
Esta funcion permite asignar un fichero .BMP. .ICO o .\WMF a la propicdad Pic-

ture de una forma o de una caja de im

los siguientes controles:

.

agen. Por ejemplo, diseie una forma con

Caplion CuName AutoSize BorderStyle
fmagen | Imagenl True !
Etiquetal | FICS SL. Etiquetal
Tmagen 2 Imagcnl False 1
Imaﬁen 3 Imagen3 True 0
Etiqueta 2| (942) 232526 | Eugueta?
Etiquela 3 PUBLICIDAD | Engueta2
Boton Cancelar Cancelar

) g - .. ~
Everiba ¢l procedimiento Form_Loud para que uutizando {a tuncion Load-

Pic
“bra,.

wrgue en Ta lorma Formf L imagen "Oesta bmp™. en fmagend 1a imagen
ip”, en Jmagen? la imagen “farmowmt™ y oen bragend la imagen

CAPITULO Y EFECTOS GRAFICOS 19]
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“phone01 ico”. Ponga tambidn en tiempo de ¢jecucion fos titlos de las etiquetas
1y 2. El resultado se presentia a continuacion,

La propiedad AutoSize con un valor -1 (True). permite que la caja aumenie
0 disminuyva autlomdlicamente para ajustarse a la imagen. Si exta propiedad tiene
valor 0 ¢False) y la imagen es mis wrande gue ¢l ubjeto gque lagea a contener. éxta
es recortada por la derecha y por abajo. La propicdad AuteSize sélo es aplicable a

etiguetas v cajas de imagen. LT

Toruara{ o
=73Cs s.i." =
Loeiricture{"c: vo\NeD. chp\brerlx. o)
Cicrure{"cI\vD AD.eht\ia Wi ")
fotira (e ioms® oot
=ra?.Caption = *(3412) 23 25 Za”

~dows\fiesta. .o

Tambidn es posible asignar una imagen i un control, desde otro contred, Sien
el destino ya hay una imagen, ésta es sustituida por la aueva hnagen. Por ejem-
plo, :

Imacszrz.Piczure = lmaganl.Picoure

fas imdgenes cargadas durante el disefio son goardadas y cargadas con la
aplicacion. Quicre esto decir que cuando cree un fichero [EXE de sa aplicacién.
no pecesitard acompanarlo e los Hicheros de imdgenes uiihzados. En cambio.
cuando las imdgenes se curgan en tiempo de ejecuciin. wilizando la funcién
LoadPicture, y cree un Nichero EXE de su aplicacion. debe acompaiar éste con
los ficheros de imigenes utilizados,

En Ja libreria de iconos de Visuad Basic hay series de dos o mid- " =anos que

utilizindolos conjuntamente producen sniniwion. Por cjemplo. tij los ico-
i
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nos FILEO3AICO ifichero cemmadoy v FIEEGIBACO ifichery abierto). Para crear
un ¢lecto de animacion stilizando estos iconus. siga los siguientes pasus:

1. Durante ef diseno afiadys a la forma tres cajas de imagen,
2. Denomine a ba primera Fichero v ponga su propicdad BorderStyle 1 (0.

3. Denomine a las oiras dos, FicheroCerrado v FicheroAbierto y ponga fa pro-
picdad Visible de cada uno de ,I0_$'ea valor 0. Significa esto gue queremos
utilizar las imdgenes de esios coftrolés, pero no queremos ue se vean. '

1 Asigne a la propicdad Picture del control FicheroCerrado la imagen del fi-
chero cermado (FILEOJAICO) v.a la propiedad Picture del control Fiche-
roAbierto, la imagen del fichero abieno (FILEO3B.ICO).

Recuerde ahora nwestra aplicacion Edior. En el mend Fichero de esta apli-
“caci6n habia dos érdenes. Abrir v Grardar. que shota queremos implementar de
una forma simbélica, esto es. ba orden Abrir queremos sustituirla por la imagen
abrir el fichero (pasi a fichero abierio) ¥l orden Guardar por la imagen cermar ¢l
fichero (pasa a fichero cerrado). El cadigo en ¢l que tiene que apoyarse para reali-
Zor este proceso se indica i continuagion,

Primero, cuando la forma se carguee se inicializa la imagen Fichero para que
muestre un fichero cerrado. Esta imagen aparecerd encina de las dos inkigenes de
La figura amerior, permaneciendo éstas oculas.

Sub Form_Load

)
Fichero.Picture
gnd Sub

o.Piczure

A continvacion, cuando el usuario quiers abrir un fighero hard clic sobre la
imagen Fichero para que ba aplicacion le permita seleccidnar un fichero al misimo
tempo gue se muestra la imagen fichero abierto. Cuando ¢l usuano faatice la

-
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OPERACIONES DINAMICAS CON CONTROLES

PR

o

sesidn v quiera guagdar el fichero, hard cic sobre L imagen Fichero para que se
realice ese proceso al mismo iempo que se muestra by nagen 1ichero cerrado.

G .".".(fO.PiiiLil:'r.“: Then
Siorto.picihire
Ficheros'

Duicante Ta ejecucidn de una aplicacidn se puede mover cuilguicer control a otra
postcidn, modificar su tamano, oeularle v afadie nuevos controles.

Para mover v/o para moditicar ¢l umaio de un control duranie s cjecucion
de una aplicacién. lo dnico que hay que hacer ¢s modificar sus propicdades Left,
Top, Width y Height utitizando ¢l méodo Move, La sintaxis para este méodo
es la siguiente:

lebjeto }Move izgl. supl, anchol. alto]]]

Objeto se refiere a la forma o al control gue se desei mover v/o redimensio-
nar y los siguientes cuatro pardmetros son datos reales de precision simple cuyo
significado es el siguiente: el parimietro izg especifica Ls distincia entre La esquina
superior izquierda del control ¥ el lado izquierdo de Ta Tforma; ¢l pardnietro sup
especifica fa distancia enire la esquing superior izguierda del comra) y ¢l ilado su-
perior de la forma: ¢l pardmetro ancho especifica ¢l ancho del conuol; yiel pard-
metro alto especifica la afra del conrol. Por e¢jemplo,

Texcl . Move

Texe!l  Move

- 10Cg, Textl.Top - 307

La primera sentencia mueve ¢l contal Pear! a las coordenadas (2500, 1)
esla p'osici()n se mide respecto de fa esquina superior izquicrda de a forma. La
segunda sentencia mueve el control Texr! a la posicion {EU0. =300) relativa a b
esquina supenor izguicrda del mismo.

Todas las medidas empleadas para desplazar y dimensionar un objeto. asi
como las empleadas en las sentencius grificas, son consideradas por Visudl Basic
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en twips. Recuerde que una pulgada son 40 twips v por lo tanto. un centimetro
567 twips.

Como ejemplo disedie una foruia Form! con lus siguientes cantroles:

Caption CilName Left Top J
Marco Marcol .\Iarlgo l'-_-l I_« 1320 3ol
Caja de e . . Tex;-l .
Botdn Oent | Orden

Recuerde, para agrupar controles bajo un marco. primero hay que disefar ¢l
marco y después se incluyen los controles en el mismo. Para incluir un conirol,
“disijuse al panel de wiitidades. haga un clic en el contral deseado (no emplee T
e de hacer un doble clic), apunte con ¢l radn al lugar deniro del marco
donde desea dibujar ¢l control, y con el boldn izquierdo det raidn pulsado arvastre
hasta dibujarlo. Por dltimo, ajuste ¢l tamado del mareo v de los controles,

Iﬁl
-

Maicol

Cuando ¢l usuario pulse el boton Ordenl. se tienen que realizar las siguientes

operaciones:

¢ El marco se moverd a la coordenadu (1000 —300) relativa a su posicién y ¢l
alio se ampliard en 300 twips.

+  El bowdn Orden! serd sustituido por un botdn Restunrar. que perminiri retor-
nar el marco a su posicion inicial con-los pardmewros v conroles iniciales, y
se anadird ¢l botén Salir que perinitind Nnalizar la aphicacion (vea la figura de

CAPIIVLO Y FFECTOS GRAFICOS 143

-

Para realizar el punto seeundo. hay que afadir durante la epecuc ion dos nue-
vos controles: Restaurar y Salir, ponet su propicdad Visible a valor -1y situarlos
en la pusicion adecuada. Como el contral Restaurar queda encima de Ordend.
hay que cculiar este dltino para que o intervenga.

Recuerde que para aiadic un control dutante cjccucién.'tl* una aplicacion,
este liene gue [ornar parte de un arcay de controkes (vea ¢l .lp.l.l'lddt) "Creando
controles en tiempo de ejecucion” del Capitulo 3} Por'lo mm» en tiempo de di-
seio, ponga la propiedad Index’ del control denominado Orden :i valor 0. Esto
crea el array Orden con un elemento Orden{t)) que uh.renu.l el.botdn titulado
Ordenl. A continuacion escriba el procedimicnto comin Uuieg:_( lick.

Ciicw {index s Inicger) b

ce Indeux
col.vcve Yarcol.leic - 10607, Marcel.bop -
100, rarcol.widcn, Marcol.iteignt o« 5C0
“oad Orden(l)
_.Or-(l Orcentz)
] = "Restaeurar”
L/isinle = -1
.Top = Orden(2).Top - 430
cion = “Satire
OLccn(2) ”lb‘blC = -1
Gréen{G).Visible = 0
Czss 1
vzrcol  Move Marcol.lLefu - 10“9 Harroi.Top +
3100, Farcol.Wideh, ¥arcol.Height - 500
o Orden(l)
Jrtoad Ordenl(?2)
Ordaen() .Visible = -1
Cese 2 .
-
End Cglect
Enc Sun

Cuando ¢l usvario pulse el botén Ordend se ejecutard el procedimiento co-

min asociado con el amay Orden para ¢l suceso Click (Urden_Click) para un

valor de Index igual a 0. En este viso, Muve wueve y redimensiona Marcol.
Load carga los botones Orden{ ) y Orden(2}. se asignan valores a las propieda-
des de estos nuevos contrules y se ocubta el botdn denominado- Orden(0). En re-
sumen, los botones titulados Ordent, Restawrar ¥ Saliv se corresponden con los
nombres Ordent0), Ordent 1)y Orden{ 2} respectivanente.

Despuds de esto se visualiza la forma de Ya figura siguiente.
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s on

FMarcol ™~

Restautas

.l
e

Cuando ¢} usuario haga clic en.el boién Restaurar se ejecutard el procedi-

“miento Orden_Click para un valor de Index igual a 1. En este caso, Move retoma

<l marco a su posicion v medidas iniciales, Unload descarga (elimina) los contro-
bes Restanrar y Safir v se hace visible ¢l control Ordent.

Si el usuario hace clic en el bordn Sidir. Ta aplicacion finahiza.

L2l méodo Move mueve v redimensiona ¢l objeto en diagonal, esto es. simul-
tdneamiente en ambas direcciones lo que evita movinientos bruscos. Por ¢jemplo.
la sentencia

1000, HMarcoi.TZop -

Yarcol . Vove Mar -
.wicth, Marcol.Heighr + 372

Yarccl + 1000
l-.arcc_ 360
Marcol.x zight + 500

Prucbe esta serunda solucidn y observe como se producen sullus briscos.

DIBUJANDO CON VISUAL BASIC

En Visuul Basic se puede realizar un dibujo en una forma y en una cajs de nna-
wen. Kl urigcﬁ de coordenadas para cualguiera de estos objetos coincide con la
esuia superion iguicrda de los mismos; Ja coordenada v se incresmenta hacia la
derecha s Lo coodenada v seincremenia hacia abajo.

Hay cuateo propredades gque especitican polectaménte lys dimensiones e
cada uno de extos objeios: Width. Height. ScaleWidth v ScateHeight gue se co-
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g

rresponden con el ancha y alto de Ta Torma. v con ¢l ancho y alto del dre
la Torma respectiviunente.

RV —

Height scaletlein S
s Sealeleisht_ ¢ teWidin ;

Width

Un sistema de coordenadas se puede ajusiar a Ly esealy gque se desee, Hay
siete escalas predetinidas, las cuales se indican o continuacion.

Escala  Descripcion

i Twips. Hay O twips por pulzada.

2 Puntos. ay 72 puntos por pulgada.

3 Pixels. Un pixel es la unidad mids pequena de resolucion de un meni-
1or.

+ . Caracteres. Un canicier se deline como un drea 16 pulgadas de aho y

E12 pulgadas de anchao.

3 Pulgadas (1 pulgada es igual a 23,4 milimetros).
6 Milimetros, -
7 Centimetros.

Para ajustar el sistema de coordenidas a una de estas escatus estindar hay gue
poner la propiedad ScaleMode al valor deseado. Por ejeniplo,

Scaledoce = 6§ :
Imagenl!l.Scalelode = 2

Cuando se utiliza una escals estindar. excepto la 3. las unidades empleadas se
comresponden con s longitud que se vaa emplear para imprimir. Por Lj(.'“‘plu
ulitizando la escala 6, un elensento Jde 3 unidades de longitad ocupard [3 milime-
Irus cuiando se escribu.
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Para ajustar el sistema de coordenadas a la escala que nosotros deseemos,
disponemos de las propiedades: ScaleLeft. ScaleTop. ScaleWidth y Sca.
Seleight. Por ejemplo, si queremos visualizar una curva y=sen(x) para valores de
v de 0 a 6.3 sabiendo que los valores de v estdn comprendidos entre -1 y b, un
sistema de coordenadas adecuado es:

Scaleleiz = 0 i
Scaletop = -1 vy a
ScalewWicza = €.2 ‘'arc
Scalebeighc = 2 'z_-

Las propiedades Scaleleft v ScaleTop definen el valor numérico yue se
asigna a la esquina superior izquierda del objeto. Por lo tunto, el ejemplo anterior
define un area de dibujo que comprende valores de x desde 0 hasia 6,3, ya que el
ancho del idrea de dibujo es 6.3 unidades, y valores de v desde -1 a L. va que ¢l
alto del drea de dibujo es X unidades. Por to tanto, el origen de coordenadas queda
situado a la jzquicrda v a 1a mitad del objelo como se muestra en la hgura si-
guicnie,

Cuando se utitiza ScaleWidth v ScaleHeight para definir un sistema de co-
ordenadas. ScaleMuode vale 0.

Esta definicion de un sistema de coordenadas que acabumos de realizar, se
puede hacer 1ambién wilizando ¢l méodo Scale. Por ejemplo,

Scale (0, -1)-16.3, 1) ‘escala para la forma

Imagenl.Scale (2, -2)-.5.3, 1} ‘'escala para la caja
O.-n
| (0.0) ©.-1)
1 (0.0)
631

En general la sintas es.

L apcale (ol v D020
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donde 1/ ¢ v/ se comesponden con Scaleleft y ScaleTop v x2 ¢ v2 con las sumas
ScaleWidih + Scalel.eft y ScaleHeight + ScaleTop respecnvamente.

Observe que para invere ¢l cje de voordenidas (valores posilives por encima
del eje 1) basta con cambiar de signo a ScaleHeight y asignar #Scale'l’op el valor
superior del cje v. Por ejemplo. para que los valores pusitivos Gueden por encima
del eje v en Ta definicion del sistema de coordenadus Jel ‘-'j““l]'kf a.n.tcriur. escriba:

’ : Tk

o oesquing
Ta asguing
o del dres d
o del area de

o lo que es lo mismo,

,.
2|

skl

Scains (0, 1y-(€6.3, -1) *escald para La Zor

Escribir texto

Desde el punio de vista grifico, Visual Basic puede escnbir teato en una forma.
en una caja de imagen y en la impresora. Al decir desde el punio de visia erifco,
nos referimos a exlo yue no aparece en controles orientados a exio, o que sig-
nifica que cuundo escribimos un cardcler en una forma o ¢n una caja de imagen,
no se almacena el caricter, sino gue aparece una imagen de dicho cargerer.

Para escribir texio en una forma, en una caja de bnagen o en Ly impresora,
utilizaremos el método Print cuya sintaxis es.

{objeto.)Print {lista de expresiones|[{ 1], }]

Si no se especifica el ohjeto sobre ¢l cual queremos esenibir. se supone la
formu actual. Por ejemplo,

143g5

El texto escrito aparecerd a partir del origen de coordenadas. La razén ¢s que
la posicion de salida para ¢l teato viene fijuda por las propiedades CurrentX y
CurrentY gue por defecto tienen valor 0. Quicre esto decir. que nosotros pode-
mos fijar Ja posicion de salida del texto, asignundu lus coordenadas de dicha po-
sicion 4 las propiedades CurrentX y CurcentY. Por ejemplo,
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FontSize = 18

C4 = Scerewidth / 2 + S-zlele’: :
CY = Sca:aileightc izzleTco

Cls ¢ iimpiar 1

lMsgs = “Curvas'

* Coorcenzdas par

Currencs = CX -~ 7 F 2
currents = CY ¢ z
' Color arde

ForeColor = QBCelori2)

Frint Msgs

Este ejemplo fija para el texto un tamaio de 18 puntos, calcula el centro del
drea actual Jde dibujo (CX, CY), Limpia la forma, caleuta la posicidn de salida del
texto para que quede centrado (CurrentX. CurrentY). fija el color verde para el
primer planu y escribe ¢ exto "Cunvas”.

Los métodos TextWidth y TextHeight devuelven como resuliado ¢l ancho v

el alto, respectivamente, del texto tal cual va a ser eserito en la forms. caja de

imagen o impresora.

Si utiliza el procedimiema Form_Load para dibujar grificos (lineds o texto)
en una forma o en una caj de imagen. tiene gue poner la propicdad AutoRedraw
de ese objeto a valor Frue (=1), de lo contrario ¢} grifico no se visualizani.

Como ¢jemplo vamos & escribir texto en una caja de imagen. [nicie una nueva
aplicacion, ponga a ka forma el tiwlo Tevio, anada vna caja de imagen. pngata el
nombre CajuTextu y escriba el procedimiento yue se indica a continuacion. Guar-
de la aplicacion y a continuacion ejeciitela.

Sub Form_Load ()

Bim Texio As SL_lzig
Texto = "En un iugar -
Texto = Texto :+ "ro
CajaTeuto.Princ Tax

End Sub

Observard ue si no ha puesto Ta propiedad AutoRedraw a vator True no se
visualiza nada. Si no lo ha hecho, higalo ahoera v ejecute de nuevo la aplicacion.
Ahora. como puede ver en la figura siguiente. ¢l tento si e visualiza pero fa linea
apaece cortada justamente en el ancho de Lacaja. La solucion a este problema es
Formar a partir del teato. cadenas de caructeres que no supdren ¢l ancho de L caja
deinirgen y al nisino nempa in escribicndo una cadena a continuacion Je ot

L
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texto. Por Lo tanto, el procedimiento Form_Load queda come sigue

‘Sub Form_Lozt

§
- .

-
£ n un lugar de la

Para rcahmr ¢l proceso deserito vanios i escribir un nuc\n prmulu}mnlu.) de-

nominado FormatoTexto. Fsie procesa serd invovido desde ¢l procedimiento
Fornt Load y recibird como pacimetros ¢l objew en el yue vimos a escribir v el

Dim Texuc & ‘ ) I
Manehna o Civyo nombre

- Texto : :
Texto Acorganrna
Ccall Texio)

End, Sud

Abra la ventana de todizo para realizar un nuevo mddulo (vew en el Capitulo
7 el apanado “Crear ua modulo™) cuyo esguei cs el siguene:

-

famp s Control, Vexbo Zs Strirg)

Sulby Forratl

End Sub .
En este esquema. el pardmerro Objeto se relicre al drea en la que vamos aes-
cribir y el pardmetro Fexio ab textn que adn nos lalta por escribir,

Vamos a denuminar Linea o ka cadena de canwteres mayar {en nuestro cjem-
plo. Ja cadena es de palabrus completas) que no superis el ancha de la Ciji v que
por lo tanto dard tugar a la siguicote lnea endacaja. La funcion Unaljulabra de-
vuelve la siguiente palabra de Tevio que anadiremos o Lotea siempre y cuando la
Jongitud actual de Linea mis Ta de la pulabra, no supere el ancho de' I caju: si
esto sucede. entonces escribimas Linea v 1a patabra devaciia por la lu|lu_mn Una-
Palubra. pasard a ser fa primers Je la siguicnte Linea. Para saber si Linea mis la
siguiente palabra supera ¢l uncho de fi cya, utidizamos la variable temporal de-
nominada Temp, Esta vaniable slmacena Linea mis la siguicate palabra que pre-
tendemos afadir. i resuliado que se obticne se ve en ki figura siguicnie.
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En un lugar de la
M ancha de cuyo

nombie no quielo
acoidarms ... ’

Con 10do 1o dicho el procedimiento’ FormatoTexto queda como se indica a
continuacion:

jeco As Conzrol,
, Slgulentelala:

crawictn) Tren

m
po

i
_ it

wm
el

= UnaPalatre(ierza)
entefalabra = "*)

atil (Slg i
Ob‘*‘o Print Linea
tnd Scbh

Ry
o}
[Re
'U

La funcidn UnaPulabra devuelve la primera palabra de lu cadena Tevio al
mismo tempo que elimina dicha palabra de esta cadena. De esta forma. cada vez
que ba tuncién UnaPalubra es invocada, devuelve la siguiente palabra. Para to-
mar la siguiente palabra de Texto lo dnico que tenemos que hacer es buscar donde
s¢ encuentra el siguiente espacio en blancu. De esta tarea se encarga la funcion
InStr(XS. ¥Y5) que devuelve la posicion gue ocupa el primer caricter de ¥S en XS,
En nuestro caso la cadena ¥S es un espacio en blanco v XS es e] 1evto que ain
gueda por escribir. 5i YS no se encuentra en XS 1a funcion InStr devuzlve un 0.

Visualice ¢l modulo anterior y ejecute la orden New Procedure del meni
Code. yue le permitird esenibir en el nismo un nuevo procedimiento. ¢n nuestro
i nuesa funcion. que readice Lo anteriormente evplesto tul v comw se es-

1§ CONBNUACION,
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i

Padri completar ¢l Tormato del eato utilizando las pl’()ph.d.ldt.s que se indi-
can en li bl siguiente:

Significado DS

Propiedad

FontName Nombre de la fuente (por ¢cjemplo. Courier)

FontSize - Tamaio en puntos de la Tuente.

FontBold Sisu valor es True (-1) La Tuente se visvaliza en negra.
Fontltalic Si su valor es True (-1) L fuente se visualizi en cursiva.
FontStrikethru Si su valor ¢s Troe (-1) fa tuente se visualiza tachada.
FontUnderline  Si su valor es True (-1) la fuente se visualiza subrayada.

Graficos persistentes

Cuando la propiedad AutoRedraw de una forma o de una caja de imagen tiene
un valor True, Visual Basic crea una imagen del vbjewo en memoria con el fin de
poder reproducis automdticamenie Jos griticos (lineas o 1exto) cuando dicho obje-
tw es maximizado, vueho a visualizar en su forma habitsal despuds de haberlo
ocultado 0 minimizado, o cuande se agranda sy twmano, Si ki propiedad Auto-
Redraw ticne un valor False (0). los grificos no serin reproducidos.

Esta operacidn ticne un coste de memaria. En ¢l caso de upa forma con su
propicdud AutoRedraw a valor True la imagen de memoria es de 1oda la panta-
Ha y en caso de una caju de imagen sélo es de la caja. Por ello. si quiere conservar
memonia tiene dos opciones: crear una caja de imagen para wdos los dibujos y
poner la propiedad AutoRedraw de ku forma a valor False. o poner a valor False
la propiedud AutoRedraw de 1a forma y de todas las cajas de imagen, y repro-
ducir los grificos directamente.

Para reproducir los grificos directumente hay que incluir el cédigo necesaro
en un procedimiento ligado ul objeto (Fforma o caja de imagen) v co :
suceso Paint ya que éste se da cadu vez que ¢l objelo necesite ser 1.
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ejemplo. cuando ¢l objeto recupera su forma habitual despuds de haber sidu mi-
nimizadoy, Este suceso no se da si la propiedad AutoRedraw esti a valor True.
La propiedad AutoRedraw puede ser moditicada en tiempo de ejecuciin..

Limpiar el area de dibujo
R
-l . o
El inéiodo Cls borra un gr:i!‘lco'(line:a's‘o;tcxlo) generado en tiempo de ejecucion
en uni forma o en una caja de imagen. Su sintaxis es,

|ebjern)].Cls

Lo- cedhcos dibujados en un objeto mientras la propiedad AutoRedraw es-
taba a valor True. no se ven afectados pur el método Cls mientras dicha propie-
dad esié a valor False. Las propicdades CurrentX y CurrentY son puestas a 0.

Dibujar puntos

Para dibujar un punto en la pantalla Visual Basic dispone del método Pset. Este
método pone color al pixel de b posicion especificada. La sintaxis para este mé-
todo ¢ la siguiente:

|

[ubjeto. |Psett X, YI|. color]

Los argumenios X ¢ ¥ son valores reales de precision simple que indican fas
coordenadas del punto v color ¢s un argumento opcional que especifica el color
que se quiere poner a dicho punto. Si color no se especifica se supone el calor del
primer plano 1ForeColor). Las propiedades CurremtX y CurrentY' son puestas.
respectivamente. a los valores X e Y.

Como ¢jempto. segin se muestea en fa figura siguiente. dibuje en una furma
las curvas commespondientes a lus funciones senfx) y cosfx) para vilores e v emre
. . ”, . . I
0 v 6.3. Parafelamente realice el mismo grifico en una caja de imagen.

Para empezar. cree una nueva aplicacion v asigne a la fora ¢l itelo Grdfi-
cos. A continuacion anada. como se indica en b fgura siguieare, una caja de ima-
sen v pingala ¢l nombre fmagend. Ajuste el maio de la forma v de la caja ¥
suzrde Ly aplicacion.

Para pintar fas cunvas. abra Ls ventana de cédigo correspondiente a b forma y
cree un provedimiento generad denominado Carvas que haga Jo siguicente:
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b9

- " : .
o Crear wn sistena de coordenadus para valores de ventre 0y 6.3 v para valores
de vemre =1 y 1. de forma que los valores positivos gqueden por encima del
efe v o que implica dar un salor negativo s la propiedisd ScaleHeight.

o Fijur el grosor de ka linea a 2. propicdad DrawWidth, y ¢l lamaio de los ca-
racteres grificos o 18, propiedad FontSize,

+ Escrbirel titulo "Curvas” centrado en L forma v en la caja,
*  Dibujar las curvas.
El procedimiento completo se especilica a contimuacion.

Sub Cuzvas ()

éinetros. para & forma

Cocordenadas del
CZ = Scalewidth / 2
CY = ZcaleHaight 7 2

lisa:z = *"Curvas*
cordenadas para
reritX = CXL -
Currzat¥ = CY +
Co:or verde

For=Color = QiColoriZ)
Pri-:- HMsg$

' Co_or neqro
ForeCalor = QRCaicrt )

FEYEAMELIOS pare |4
Irecenl.Scale (0,
Imeszn1.Cls

- —
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(=, wC) ' coseno
{x, ¥s) ' se€no

El pracedimiento Cunvas serd invocado desde ¢l procedimicnto Form_Click

comao se indica a conlinuacion:

Sub Form_Clicy 11
curves
Zna Sun

Ejecwe 1a aplicacidn. haga clic sobre la fonma v vea los resuliados. Observe
que como el procedimiento Curvas no es Hamado desde el procedimiento For-
m_Loud, los grificos se visualizardn independientemente de que la propiedad Au-
toRedraw. de la forma v/o de la caja. esté a valor False o True. Pero hay una di-
ferencia: $i la propicdad AutoRedraw es False (), los grancos (lineas o texiv) se
escriben solamene en la pantalla. no en memona. cosa que si ocuire si la propie-
dad AutoRedraw ¢s True (-1

Suponiendo que en nuestro ejemplo la propiedad AutoRedraw es False (0),
ejecute la aplicacion v minimice ka forma. Cuando lu restaure. observard gque los
“grificos no persisten. Recuerde que Visual Busic restaura los grificos solumente
si la propiedad AutoRedraw es True (~1). No obswnte, sabiendo gue al agrandar
" una forma se da el suceso Paint puede hacer usted directamenie 14 restauracion de
tos grificos desde ¢l procedmiemto Form_Paini. El proceso es sencillo: e
Fonn_Painn al procedimiento Curvas ¥ modiftque el procedimiento Form_Click
como se indica a continuacidn:

LIRS
oo el wananio haga chic sobre Lo tenna, se epdcuta ¢l provedimiente
Fon £y e pan las cunas, Y tmbidn se ejecurini oste provedinnento
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cada vez yue la forma necesite ser redibujada (por ejemplo. si se mimimiza y
después se restaura a su lamaio, o si se agranda su tamano).

Dibujar lineas i

- - s r - .
Pura dibujar una linea entre dos puntos Visuat Busic dlspon‘t’:’ del mérodo Line,

Cuyi sinlaxis es, T
[objero |Line[(X1, ¥ D-(X2, Y2, color]

Si objeto no se especifica se asume que |a linca se dihuj':lj_sobre ka forma ac-
wal. Las coordenadas pueden especificarse como valures enteros o reales. Siel
punto (X1, ¥1) que es opcional no se especifica, se supone 1a posicidn actual. Por
ejemplo,

Sub Forz_Click () o '
Line. {3, 0y~ (Scaltewideh / 2, Sce.lz_f:-.ew.l‘_‘ ;2)
Lira -(Scelewidth, ScaledelghL / D)

End Sub

Cuando ¢l usuario haga clic sobre la forma se dibujarin las dos Tineas que se
muestran en ta figura siguiente, Observe como Ya segunda linea empieza donde
tinalizo 1a primera.

Las propiedades CurrentX y CurrentY son automdticaménte actualizadas al
altimo punto de la linea.

Las coordenadas pueden expresarse también en forima relativa wtilizando la
palabra reservada Step. Por ejemplo,

Lire -S:ep[%f;‘l], 500) )
Line Sz=p(200, 0)-Stepn(500, -100}
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Estas sentencias son equivalentes a lus dos siguientes:

Lirne (Qurrenc, (.‘ur'c.--)—({_‘,rre—:._x + 211, Cur—eanny = 500)
Lire (CurrzncX + 200, Qurreszvy-(Qurraiy - 200, Corenty - 100)

Si necesita vanar ¢l grosor de una linea utilice la propiedad PrawWidth y i

necesita cambiar el estilo utilice la propiedad DrawStyle.
| o

Como ejemplo, diseiie una forma’y dibuje en ella los siete estilos de linea
existentes (DrawStyle = 0 a DrawStyle = 6). El resultado que se quicre obtener
se presenta en la siguiente figura. Observe que el estilo 5 es una linea invisible. El
estilo O se denomina linea sélida y es el-estilo por defecio; el estilo 6 se denomina
linea sélida ierior y es igual que el estilo 0, excepto cuando se wiiliza pura dibu-
jur cajas como veremos a continuacion.

Y | -
Eslilo D - -

Eatilo 1 — — o — - —
Estito 2 - ---cermmmemer ool
Estilo
Eslilo
Eslilo
Estilo

;NN e w

El procedimiento conducido por ¢l suceso Click que da lugar a los resultados
pedidos es el siguiente:

Sub Form_Click ()
Dim I »s Integer, © =5 nieZfer, = 13 Inoeger, Msqg As SLring
Msg = " Estilo * -
H = TextHeight {:zg) / 2
For I = 0 To 6
DrawScyle = I

Current¥ = 0 -
CurrentY = Currenty - _75
Print Msg; I: . .
. Lire {1000, C:irrenty - H)-(11.0, CurrentY = H)
Nexo Z

End Sub

Un ancho de linea mayor que 1 du lugar o que los estibos 1 a4 produzcan |-
neas salidus.
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Hasia shora, nosotros hemos aprendido a cambiar el espesur de las Imcl.Ls ¥y su
estilo. Para entender mejor esto. pignse que cada uhjun urifico tene una pluma
que puede dibujar en diferentes estilos, dependiendo éstos de Tas pmpn.d.idcs (ue
s¢ definan ancho. estilo, colory. Dando div paso s, piense ahora camo puede
afectar lo que dibuja, si lo hace encima de un grifico cxim-nmt Este conceplo es
¢l que define la propicdad DrawMode. 'r

La pmpudul DrawMode pucde wmar vatores de 1 a IA’ Las valores mis
utilizados son los siguientes: '

DrawMode Nomibee Signilicado
4 Not pluma Se dibuja ¢l inverso de la pluma,
6 Inverso Se dibuja el inverso de la pantatla,
7 Xor Se dibuja el resultado de bacer la operacion Xor
entre L pluma y Ta pantalla.
10 Not Xor Inversa de Xor.
1) Nuo operacion No dibuja: Ta salida penmanece igual,
13 Copiar pluma Se dibuja directamente lo de o pluma. Es el

valor gue se i por defecty, |

’ I
- | L
Como veremos mds adelame, ¢l modo.de dibujo 7 (DrawMode = 7) s il
para producir aniimacion. Esto es posible porque dibujundo en este modo un obje-
to dos veces. ¢l plano de fundo queda restaurudo a su valor inicial.

Dibujar cajas

Para dibujar una caja se whiliza ¢! método Line que aciabamos de exponer, pero
anadiendo la upeion B segin se especifica a continuacion.

[objeto JLine [(X1, Y] — (X2, Y2)) [{cotor& | BIF])}
Cuando se especifica la opeion B, fas coordenadas (N4, Y1)y y (X2, ¥2) hacen
referencia a las esquinas superior izquicrda ¢ inferior derecha de la cija, Si se es-

pecifica la opeion BF se obticne uni caju coloreada. Por cjemplo,

Lime (170, 100)-(1000, 1000), 255, =7

Anterionmente dipmos que o la hora de dibujar cajas. hubia una diferencia

enire lus estlos Oy 6. Esta difereacia, queda definida con las dos figuras w’uicn-
e

tes. Las medidas de lu caja en esas dos figaras, se corresponden con lo indicado
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por las lineas finas. Esa misma caja se ha dibujado con un ancho de linca de 10 v
estilo 1: se observa como la linea gruesa que dibuja la caja se reparte por igual a
ambos lados de la linea fina. En cambio si definimos el estilo 6, la linea gruesa

que dibuja la caja es imerior a las lineas finas.

El procedimiento que da lugar a la ligura anterior es,

Sub Form_Click ()

Line (1400, 600)-(3C%G, 230

Line (1400, 1600)-(3332, 1273

Line {1700, 300)-(1724, LS00

Line (2700, 3G2}-(27C3, 1302

DrawWidth = 10

DrawStyle = 1

Line (1700, 60Q0)-127¢ i85y, , B
End Sub

Ahora, cambie el estilo a 6 poniendo TrzwStyle
figura siguiente:

6. El resultado es la

( ejemplo, disefie una caja como 1a de la figura siguiente. Para ello. co-

miency

2 nueva aplicacion. ponga a 1a forma el tiwlo Cajus y a continuacion

L

+.
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abra la venana de cddigo y cree el procedimiento Form_Load para que escriba
las lineas de texto especificadas v dibuje la caja que las contiene.

—

N
Articulo Precio “ W
Gasbanzos 500 ‘
l.entejas 300 RE
Manzanas 400 "
Plalanos 200 |

El codigo para el procedimiento que da lugar al grifico anterior, se presenta a

conlinuacidn.

Sub Form_Load ()

tuccledraw = -1

Prin:

Princ

Printc

Pr?nc Tan{12); "irciculo*; Tab(32); "Precia-

Princ .
Print Tean(12); r"Carnanzos"; Tab(32); 500

Princ Ten(12); *Lentejas*; Tab(32); 300

Print Teb(12); "“zrzanas"; Tab(32): 400

Princ Tab(l2); *3lé&tanos®; Tab(32);: 200

Drawwideh = 2

Line (700, 330)-(3630, 1950), ,
Line {7060, B80)-(¢31630, 880}
End Subd

B

Ia funcion Tab indica ta posicion (columna para un caricter) donde se desea
que comience fa impresién de una determinada expresion,

Dibujar circulos, elipses y arcos

Para dibujar un circulo, una elipse o parte de esta

s figuras con centro (X, ¥) en la

pantalla utilizaremos el método Circle. La sintanis para este método es,

lobjeto. |Circle (X!, ¥2), rudio!|. [color&|l. [comicnzo!i[. final?)|. s

R
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El argumento radio ¢s eb radio del circulo o el eje mayor de la elipse. Amibos
se miden en sentido horizontal si aspecto < Iy en sentido ventical si aspeeto > |,
Ll argumento aspecto e§ una expresion numdnea que afecta a la relacidn X/Y.

Los argumentos comienzo y final son angulos en radianes. de valores com-
prendidos en el rango <21 a 2/, gue especifican donde comienza v finaliza ¢l areo,
Si se omiten. se traza una curva compkia, Si se les antepane un signo menos, se
dibujardn los radios correspondientes desde Jas teminaciones del arco al centro.

Como ¢jemplo, disefie una nueva aplicacion. ponga a la forma el utulo Civey-
fos y a continuacion abra la veniana de cédigo y cree ¢l procedimiens For-
m_Load para que dibuje un circulo. una elipse v dos sectores circulares mmplc-
mentarios como se muesira en la figura siguiente.

El ¢édigo para el procedimiento que da lugar al grifico antenor, se presenta a
continuacion.

Sub Form_ lLoad ()
Dim i 4 Double
Dim Cl As Long, C2 As Long, C: 25 Leng
Pi = 3.1415926 :
Ci = G340, 0, 2%5):
Auto~aedraw = -1
Scalevode = 3
Circle (60, 70y, 30, C. 'cirz:lo

Circle (150, 70y, 30, C2, ., , 3/ 1. *elin=e

Circle (240, 70y, 30, C3, -©- 2, -z = i rzzzuor

Circle Step(5, -3}, 32, C1, -Z = pi, -2i / Z “zaccor
End Suo .

Observe que se ha empleado la escala estdndar 3 . quetsignitica que las coor-
denadas son tomadas en pixels.

A
CAPIVLO % LHCTOS GRAICOS 213

. . B . . 1 .
Lus propiedades CurrentX y CurrentY son puestas, respectivamente. a los
valores X e ¥ especitivadus en Circle, !

Colorear figuras ‘

Una Nigura puede ser rellenada con un color solido o con un determinado patron.
Para selecowonar con gud se va s rellenar 1a tigura, ulllu.in_mlh la pmpn.ld.ul Fill-
Style de la misma. Los valores posibles para esta propu_d.ld e llldlt.ln en una

Labla a contimuacion.

Valor para FillSile  Significado

0 Color sohido

] Color trunsparente. Es byvopeidn por defecto.
2 Liness horizontales

) Lineas venicales

4 [hagonales ascendentes

3 Diagomiles descendentes

6 Lineas cruzidas

7 Diagonales cruzadas

Si para rellenar una figury se utiliza un color solido (FilStyle = (l) por de-
fecto se unliza el color negro. Para especilicar otro color, wtilice la pmpuddd
FillColor. £ valor para esta propiedad puede ser especificado por una de las fun-
ciones RGB o QBColer, o tambidn pueden especificarse algunos de los colores
predefinidos en el tichero CONSTANT.TXT. Por ¢jemnplo.

FillCo 23'—3, 0}
Fomrtl. ZColori2)
Imaqguni CEEREN ' cefinido en COMETANT.TYT

Coma ejemplo coloree ¢l citeulo y la elipse de la figury anterior conlun color
silido v los sectores cicculares con algunos de los patrones, Una posible|solucién
puede ser la que se muesira a continuagion.

C3 s Long

35, 0):

e g
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riiiztyie = 0

rilifolor = CL

Circ_z (€0, 75y, 30, C1 'circulo

FillColor = C2

Circls (150, %0}, 30, €2, , , 5/ ii *=2linzs

FillCelor = C3: FillStyle = ¢

Circ-e (240, 70), 30, C3, -Pi / 2, -2 = i ‘'zzzcor

FiiiColor = CL: FillStyle = 3

Circlis Scep(>, -5), 30N Cht, -2 * 2i, -2i s 2 'sector
Ind Sun . o

El resultado que se obticne se muesira a continuacidn,

Animacién de graficos

La animacién de una imagen se realiza de acuerdo con la siguiente secuencia de
pasos:

1. Se dibuja una imagen en la pantalla,

3]

Se introduce un retarde que serd funcidn de 1a velocidad con la qie se quiere
que s¢ mueva el ubjeto. ' o :

3. Se borma la imagen. se calcula una nueva posicién y se repite la secuencia de
pasos desde el 1.

Como ejemplo, vamos a disefiar una aplicacion que muestre una pelota ro-
- dando @ lo largo de una Linea, segdn se muestra en la figura siguicnte.

Para ello. disefie una nuevi aplicacidn, ponga a Ja forma el thwlo Animacion y
a conbinuawicin abri 13 sentana de codigo v cree el procedimiento Forin_Load
COIMU ¢ MUesin i conunuacion,

]
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!

|
cE

Dim T As Lo A

D = 100 elota

BackColor 233, 255, 235) ‘'blance
ForeColor = 2GB({C, &, 255) 'azul

CY = Scaledeight 7 2

'Linea sobre la cgue rueda la pelcta
Line (0, CY + D)-(ScaleWidth, CY + D}, Q3Color(2)

FillStyle = 0 ‘color sélido
FillColor = ForeColor 'color pelota
DrawMode = 10 'Neot Zor

*Animacidén - pelo:ze rodando
For T = 0 To ScalsWidch Step 30
Circle (i, CY), D ‘'dibujar pelota
For Reter = 0 To 1000: Next ‘'control velocidad
Circle (I, C¥), D 'bhorrar pelota
Next I
End Sub

a

En este procedimiento, lo primero que se hace es fijar ¢l color de fondo y del
primer plano. A continuacion se dibuja la linea sobre la que va a cnrrer|la pelota,
Las sentencias FillStyle = 0 y FillColor = ForeColor permiten rcllena‘r la peloa
del color especificado ¢ada vez que se dibuja. Por iiltimo, se activa el modo de
MhﬂoIU(XunnqmdmcmnﬂapMnmylupumumLponmchRmderbhnuﬂy
se efectia la animacién de la figura. Observe yue primero se dibuja I pelota en
una posicion determinada, despuds se produce un retardo (For Retar) yl se dibuja
la pelota por segunda vez en Ja misma posicidn. Esto hace que la pelota se borre,
ya que cada vez gue se dibuja. se estd haciendo 12 operacién Xor, negada, entre la
pluma y la pantalla. E} siguiente paso es dibujar la pelota en la siguicmlc posicién
¥y usi sucesivamente.
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4.

© Elefecioexacto de DrawMode depende del color de la figura que s dibuja y D whlle (I » 3 Or Direccidn = !
de los colores de la panialla. Por ejemplo, el modo de dibujo 7 realiza la opera- rj";:f"le ( . €Y}, D 'dibuja c-= v
cidn Xor de cada pixel que se dibuja con c;?fla p.n'el dela pam.:alla. S: el punto de -7 -r:n e (I . 6, C\) <> Backh Co_ v ire
la pantalla es negro (todo ceros) la operacion Xor es el propio punto dibujado; Tavr Patar = 0 To 300: Mext ‘concral velocidad
ahora si ¢l punto de la pantalla es blanco (1odo unos) la operacién Xor es el punto Circ le (I, CY)., D 'borra peictz *t
dibujado. pero negado: en cambio. si en este Wlimo caso la operacion es Not - = I + Direccidn ,
Xor, es resultado es el propio punto. Leop ’
propio punto.; cnd b I

e : (I
El siguiente CJmelﬂ presenta uria pelola que rebota al chocar contra una ba- '

— Observe que mientras la variable Direccion valga 1. 1a pelota se mueve hacia

la derecha v que cuando vale -1 la pelota s¢ mueve hacia la izquierda, Esto es asi,
| l rll porque la coordenada X (variable /) cuando se dibuja la pelola se ve incrementada
b

o decrementada en ¢l valor de Direccion.

El métoda Point da como resultado el color RGB de un punto (X, Y), comes-
pondiente a una forma o a una caja de imagen. Su sintaxis es,

[objero.|Point(X, 1)
Observe gue para saber si la pelota ha llegado a tocar la barrera. cada vez que

se dibuja se analiza el color del punto justamente a continuacidn de la misma. Si
el color coincide con el color de fondo, quiere decir que atin no se ha legado a la

Disefie una nueva aplicacién. ponga a la forma el twdo Animacion v a coni- barrera.
nuacion abra la ventana de cddigo y cree el procedimiento Form_Load como se
fmuesira a continuacion. ‘

Sub Fcra_Click ()

Dim I Zs Integer, Retar As Inceger

Diz 2 is Integer, Dirzccidn s Inregar

ScaisMode = 3 'escals en pixels -
D =% 'racgio ¢e la pelota

BzcxZolor = Q2ZColor(:3} 'blanco
ForzZolor = Q=Color(:) raiul
Cr = =calenchﬁ /4 * 3

Y = 3caledeight / 2

zobre la
Scalelel

zdlido
‘color f=ton:




€APITULO 10
in

SUCESOS DEL RATON

INTRODUCCION

ARGUMENTOS DE LOS SUCESOS.DEL RATON

Las formas y varios tipos de controles reconocen tres sucesos producidos por el
raton: |

« MouseDewn. Reconocido cuando el usuario pulsa cualquier botén.

+ MouseUp. Reconocido cuando el usuario suelta cualquier botén.

« MouseMove. Reconacido cada vez que el usuario mueve el puntero del raién

4 upa nueva posicién,

Una forma reconoce un suceso del ratdén coando el puntero del mismo esta en
una zona en la que no hay ningin control: ¥ un control reconoce un suceso del
ratén cuando el puntero del ratén ¢std sobre ¢l propio control.

Cuando el usuario pulsa un botén del ratdn sobre un objeto y lo mantiene pul-
sado, después que el objeto hayva reconocido el suceso MouxeDm\nI aunque
mueva el puntero fuera del objeto. éste contintia reconociendo el suceso Mouse-
Move, mientras se mueva el raién. y el suceso Mouselp cuando suelte' el botén
del ratén. .

Los tres sucesos tienen los mismos argumentos: Bunon: bolén que da lugar al
suceso; Shifiz teels pulsada (Shift. Cirl o Al o reclas pulsadas: X, ¥: coordcna-
das correspondientes a la posicién del puntero del ratbn.
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.

noeger, X &S gle, ¥ &5 Single}

Sub Form_ Mossedown (ﬂ,:‘cm s Integsar, Shifc As
Argumento Button . uo -Mo-selow
‘ : “a pulsado 2l v

Es un entero cuyos tres bits menos significativos indican ¢ botén que da lugar al = 1 ‘Then =Zving "botdn izguierco"
suceso. Por lo tanio, es un valor entre 0 ¥ 7 dependiente del suceso y de los boto- = 2 Then Srint "boudn carecho

"

nes que se hayan pulsado simultineamenie. En Ia siguiente ligura, T es el bit co- = 4 Then
rrespondiente al botén izquierdo. D-es el bit correspondiente al boton derecho y - : :
M es el bit correspondiente al boton ge] edio. El resto de los bits no se utilizan, '

EEE

~int "hotdn d21 m :?io'
1

on.Aas Integer, ‘iulbc #s Integer,
Single, Y 2s Single)’

al *;

|

S
6CiojojojofolojolOoi0|0fjO0 |0 |M|D]|I

sint "botdn izguierdo”
rint "bhotdn derecho”
s rint "botdn czl medio”
Sucesos MouseDown y MouseUp: .
Se ha pulsado el botdn izquicrdo (Button = 1) oot Para determinar si se ha pulsado un solo botdn o mas de uno hay que recurmir
‘ al suceso MouseMove. El sicuiente procedimicnto presenta las combinaciones
Se ha pulsado el botén derecho ( Button = 21 Ot 10 posibles.
5 N . _ Sub Toom_MouseMove (3utzon As Integer, SniLT ~S
Se ha pulsado el botén del medio (Button = 4) t]j]0|0 Tniecer. X as Single, Y ie Sirg
If z:zcon = Q Then Zxit Sub
it = 1 Or Bucton = 2 Or Button = 4 Then
Para los sucesos MouseDown v Mousel'p solamente un bit del argumento © "S2 pulsd sdéio el botdn ";
. . - . _ o H n o3 n
Button se pone a |, el correspondiente al boidn que se ha pulsado. Esto quiere {Button = 1) Then Print 1z‘do _
{Button = 2) Tren Print "dcho" .

decir que es posible saber qué botén fue utilizado. pero no LU.’.II]IOS se pulsaron
simultdneamente.

n
{Butzon 4) Tren Print *"mecio”

1
Joes

int *Se pulsaron los botones
{Sutron And 1) Then Print “izdo y ?*

{3utcon And 2} Then Print "décho y 2"

{(3utzon And 4) Then Print "medio w ?°

{Butzon And 3) = 3 Then Print "izdo y dcho"
(Butcon and 7} = 7 Then Print "izdo, dcho y medic”

Para saber que botén foe utilizado y cudntos botones se pulsaron. hay que
verificar el valor del argumento Button para ¢] suceso MouseMove. Este valor
puede ser, ademds de los anteriores. 1os de la tabla siguiente.

TN TN BT N NPT
|

t

r
3

[£3] L“J. IR A o S O O I TR 1 O Y Y B IR ¥

Sucesos Mousehfove:

t

b
[ &R

End

No hay botones pulsados {Button = 0) 0y07]0

Para saber si s6lo se pulsd un botén (por ejemplo el izquierdo) la sentencia
Se pulsaron los botones izquierdo v derecho ( Button = 3) o111 tiene que ser similar a la siguiente: :
Se pulsaron los tres botones (Button = 71 L] If (Z2zcton = 1) Then

Para saber si se pulsd un determinado botén (por ejemplo el izquierdo) inde-
Para determinar gué botdn causa el suceso MouseDown o MouseUp, escriba pendientemente de que se hayan o no pulsado otros, la sentencia tiene que ser

los- "nles procedimientos: simiilar a la siguiente:

If£ {(zuzzon and 1) Trhex
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Para saber si se pulsaron los botones izquierdo v derecho. la sentencia tiene
que ser la siguiente:

if {(Z-cvon And 3) = 3 Then

Obsenve que sentencias como las siguientes dan lugar a resultados errénéos.

If£ {Buzcon And 3) Then ... .
If (Zutton And 1) And (Bytton ind 3) Then ... !
Argumento Shift " ,

La utilizacién del ratén puede ser mds diversa cuando se utiliza conjuntamente
con las welas Shift, Cirl o Alt.

El arcumento Shift es un entero cuyos tres bits menos significativos indican
las teclas pulsadas. Por lo tanto, es un valor entre 0 y 7 dependiente de las teclas
gue se hayan pulsado simultincamente. En la sigutente figura. 8 es el bit corres-
pondiente a la tecla Shift, C es el bit correspondiente a ta tecla Ctrl y A es el bit
correspondiente a la tecla Alt. El resto de los bits no se uulizan.

0jlolojofojojojoyo0|jo0f0o]oj0|A|C]S
No hay teclas pulsadas {argumento Slu’ﬁ =0 0(0]0
Se ha pulsado Ya tecla Shift (Shifi = 1) 0o 1
Se ha pulsado la tecla Ctel (Shifi = 2) ‘ 01110
Se ha pulsado la tecla Alt (Shifr = 4) Il 0{ 0O
Se han pulsado las teclas Ctrl+Shift (Shifi = 3) gl 1]
Se han pulsado las teclas Alt+Shift (Shifr = 3) 11011
Se hun pulsado las teclas A+ Cerl (Shift = 6) 1{L}O
Se han pulsado las teclas AI.HCerShifl tShifr=7y . | 1Ly

R .

. 4
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l
Por ejemplo. para saber si conjuntamente con e} botén 1zquierdo del|ratén se
ha pulsado la teela Alt, la semiencia adecuada es:

Bucnan = - ing €hifc = 4 Than

1=
ity

El estudio para saber si se ha pulsado una o mids tecas. cstsimilar al realizado
1

para los bolones.
t

L

Argumentos X, Y

Los argumentos X ¢ Y se corresponden con las coordenadas del puntero del ratén
releridas al objeto para el que se da el suceso. :

L
Como cjemplo cree una nueva aplicacidn lamada raton.mak. Cret? una nueva
forma llamada raton frm y aiadd a la misma os controles de 1 1abla siguiente:

r()hjeto Propiedad | Valor
Caja de imagen AutoSize True ]
Picture CIR_OF.ICO

- . . 1
El icono CIR_OF.ICO no se encuentra en lus librerfas de Visual Basic. Para
crearlo utilice la aplicacion ejemplo iconwrks.mek suministrada con Visual Basic.

-

La forma seria similar a la de la figura siguiente.

. -
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Nuestro objetivo es que cuando ef usuario haga clic en una posicidn determi-
nada de la forma, el objeto se mueva a esa posicién. La caja de imagen tiene ¢f
nombee Piciurel por defecto. 'Un procedimiento sencillo que realiza esta opera-
cién es ¢l siguiente:

Z.h Frro_Mouselown (Burton As Inzeger, SnlE
Incecar, % =5 Sirgle, ¥

e X, Y 4o
;

-
-

Observe que al desplazarse el objeto, se coloca su esquina superior izquierda
en la posicion indicada por el ratén. E] método Move fue expuesio en ¢l capitulo
anterior. - S

A continuacién haga que el objeto persiza al puntero del ratén de forma que
su centro se coloque en la posicidn indicada por el ratdn. El procedinmiento que
realice este proceso tiene que ejecutarse cuando se mueva el ratén.

Sup Foro_Youselove (Button As Integer, Shiirc
Integar, X As Single, Y 2s Single)
CZ = - Picturel.Wicdth / 2
CY = 7 - Picrurel.Heigrz / 2
Pictural.MMove CX, CY
=nd §:i% '

Observe que un movimiento ripido del ratdn genera saltos imds grandes que $i
lo mueve inds lentamente. Esto quiere decir que Visual Basic no genera necesa-
namente un suceso MouseMove por cada unidad de medida, sino que genera un
ndmero limitado de sucesos por segundo.

APLICACIONES GRAFICAS

Vamos a realizar una aplicacién simple que permita al usuario realizar dibujos
sobre una forma, segin se muestra en la siguiente figura. La aplicacion debe
cumplir 1as siguientes caracteristicas:

¢ Mostrard en.todo momento tas coordenadas (X, Y) del puntero del ratdn.

“.Capticn = STrSi{x})
_.7.Caption SLrsity)

Cc
cC

) )

s Cuando el usuario apunie a una determinada posicidn y pulse et botén iz-
auierdo del raton: las coordenadas (X, Y) comespondientes a la posicion cle-
s¢ guardan en (CX, CY). También (X, Y) pasardn a ser las vourdenadas
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-

actuales (CurrentX, CurrentY). Recuerde que ¢f método Line modifica las
propiedades CurrentX y CurremtY,

Cx = Z: Currentc¥ = X
Cy = 7: Currenty B

e Cuando ¢l vsuario arrastre ¢l ratén manteniendo pulsadlir ¢l botén izquierdo,
realizard un dibujo continuo.

1Z z:tton = 1 Then ‘
Line - (4, Y) P

Erd It

« Cuandoe ¢l usuario pulse et botdn derecho del ratn se dibujard una recta
desde las coordenadas {CX, C¥) a la posicion sefialada. -

2 Then
CY)-(#, )

X: 2520 Y. 1245

Para realizar lo anteriormente expuesto, cree una nueva aplicacidn llamada
graficos.mek. Cree una nueva forma Hamada graficos.frme. pongala el tiuly Grd-
fieos y afadu a la misma los controles de ta tabla siguiente:

Ohjeto Propiedad ; Valor
Etigueta 1 Caption 'X
' CiName - ' Label|
Etiqueta 2 Caption i (nada)
CtlName - X
Etigueta 3 _ Caption FY
CuUNuame * Label3
Edgueta 4 Caption " (nada)
CutName Y
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Cuando ¢l usuario pulse un batdn del rawén serd para hjar una coordenada de
partida (boton izquierdo) o para dibujar una linea (boton derecha). Por lo wnto ¢}
suceso a fener en cuenta es MonseDown.

Cy = .
£lgsIf Butreon =
linz (CE, CY)-(X
ciia -
Ind SIb ;

Cuando ¢] usuario quiera dibujar de un modo continuo, moverd el raidn ¢ I Puara dibujer ¢ mano alzada. primero haga clic sobre este botdn.|A continua-
direccion deseada con el botén izquierdo pulsado. Por lo tanto el’succso a tener cion sitde el cursor del ratén en la posicién del panel donde desea CU nenzar a di-
en cuenta es MouseMove. También. siempre que se mueva el raton hay que ac- bujar y pulse ¢l botén izquierdo del mismo: con este botsn pulsado | rastee en la
walizar las coordenadas (X. ¥) visualizadas en fa forma. diveccion deseada. Para finalizar suelte el botéin.

Lz Iinteger, Shifc

* is Single, Y * = :QT Aol Para dibyjar lineas, primero haga clic subre este botan. A continuacién sitie
R N =2 =21ngdi

el cursor del ratdn en la posicion del panel donde se desea que comience la linca,
pulse el botén izquierdo del mismo y con él pulsado mueva ¢l ralén!en la direc-
cidn deseada hasta dejar la Hnea con la longitud e inclinacidn requendas. Para fi-
nalizar suelte el boton.

l'l)

Para dibujar cajas, primero haga clic sobre este botdn. A continuacién siuie

, . . el cursor del ratdn en la posicion del panel donde desea situur la esquina superior
EJEMPLO DE UN PANEL DE DIBUJO izguierda de la caja, pulse el botén izquierdo del mismo y con él pul‘s:tdu mueva
el ratén en la direccidn deseada hasta dibujar la caja. Para dibujar un cuadrado

1.a figura siguiente, presenta el aspecto final de la aplicacion que tratamos de de- perfecto, pulse al mismo tiempo la tecla Ctrl. P ara finalizar stelte ef boton.,

sarrollar. Como puede ver consta de un mend. un panel con cinco utlidades ¥ un
resistro X, ¥ que presema las coordenadas correspondientes a la posicién actual
del cursor del raton, ’ :

Para dibtjur circulos o elipses. primero haga clic sobre ¢ste boton. A conti-
nuacian sitde el cursor del ratdn en la posicion del panel donde desea situar el
centro de L elipse o del circulo. pulse el botdn izguierdo del mismo yl con €] pui-
sado mueva el ratdn en.la direccion deseada hasta dibujar la elipse. Si quicre ase-
gurarse de que lo que dibuja es un circulo. pulse al mismo tiempo la tecla Ctrl.
Para finalizar suelie el bowdn.

El mend Fichere consta de dos drdenes: Nwevo y Safir. Lu orden Nuweve lim-
piat la pantalia para iniciar un nuevo dibujo v fa orden Safir finaliza una sesion de
trabajo.

Para escribir texto, primero haga clic sobre este botén. A continuacidn sitde
el cursor del ratén en la posicion del panel donde se desea que comience ¢l texto,
pulse el botén izquierdo del mismo y escriba el exto. f

El panel de utilidades consta de las herramientas: dibujar a mano alzada. di-
bujar lincas. dibujar cajas. dibujur elipses o circulos y esenibir texto. Eb cursor dzl
raton seri una ¢niz subre el drea de dibujo v uma flecha sobre los butones cuundo
se vit a hacer ¢lic sobre uno de ¢llus.

[nicialmente, la utilidad por defecto es lu de dibwjar a mano alzada. Poste-
. L. . . |
riermenie, la cleccion de cualquier otry herramienta cancela la anteriormente se-
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leccionada. Si hace clic sobre el botdn que es1d pulsado, no se ejecutard ninguna

accion.

Nuestro primer paso para ¢l desarrolto de Ta aplicacidn es crear los iconos ne-
cesarios para 1a mismi. que s muesuan a contnuacion.

e Dibujar 3 mano alzada.

s Dibujar fineas.

MANO_ONICO

LIN_OF.ICO

s Dibujar cajas.

LIN_ON.ICO

CAJ_OF.ICO

+  Dibujar circulos o elipses.

CIR_OF.ICO

CAJ_ONICO

CIR_ON.ICO
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o Escrbir texio. .

.
TEXT_OF.ICO TEXT ONICO
Para crear los teonos, cargue v cjecuie la aplicacion fcomvrks. que es un editor
de iconus que se suministra como ejemplo con Visual Basic. Abra el fichero
PENCH.05.1CO que se encuentra en el directorio ”...\Wwbhicons\writing”, haga las
maditicaciones necesarias para que tome el aspecto de fa figura amerior y gudrdelo
en su directorio de trabajo como MANOQ_OF.ICO. De la misma forma y a partir
del icono creado, diseie el icono MANG_ONICO. El resto de los iconos serdn
construidus, ulilizando las herramientas del editor y wmando como plantilla tos ya
creados. El resuhiado serd similar al presemado en las figuras anteriores.

Inicie una nueva aplicactdn, asigne a la forma por defecto ¢l iitulo Panet de
Dibujo v demds propiedades que se especifican en la tabla siguiente, ajuste su
maiio v guarde la apheacidn con el nombre panel mak v Ta forma con el nombre
punel fron.

Objeto Propiedad Valor

Forma FormNume Forml|
Caption Panel de Dibujo
BorderSiyle 7
leon "~ | DIBUJO.ICO

I.a propiedad Icon de la formu permite que se visualice el iconu asociado a la
misma cuando Ia forma se minimiza. Para nuestra aplicacion, hemos elegido ¢l
itono PENCILO3.ICO que se encuentra en el directorio ”... \b\icons\writing”. Car-
gue el editor de iconos y realice las modificactones oportunas, si lo considera nece-
sario. v a continuacion gudrdelo ¢n su directono de trabajo con el nombre DIBU-

101CO.

Continuando con Ta aplicacion, disefic un mend denominado Fichiero con las
drdenes que se indican en la tabla siguiente.
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Caption CtiName Acelerator ‘
&Nucvo FicheroNuevo Curl+N ’
| &Salic FicheroSalir Cul+S |

‘El siguiente procedimiento da Iuglnr_ a que. cuando el usuario ejecure la orden
. - 4 . - L
Nuevo, se limpic el drea de dibujo. 7

Sub Ficreroduevo_Click () -
Cls
End Sub

El siguiente procedimiento da lugar a que. cuando el usuario ejecute 1a orden
Salir, finalice 1a aplicacion.

Sub FicreroSalir_Click ()
End
End Sub

A continuacion vamos a construir el panel de control. Para ello aiadz los con-
troles yue se indican en la tabla siguiente.

La hgura siguiente le indica cémo debe anadir cada pareja de iconos. Primero
coloca una pareja de iconos une al fado de otro. a continuacidn asigna las propie-

dades especilicadas y por ditimo coloca el icono ...OF.ICO sobre el icono
..ON.ICO. Observe que los iconos ...ON.1CO son no visibles inicialmente.

ﬂsﬁ + propiedades = ﬁ
LR

Siguiendo el mismo proceso, coloque el resto de las pargjas una debajo de
ofra hasta completar el panel de uiilidades.

Objeto ' Propiedad Valor
Caja dc imagen CtiName Botdn
AutaSize True
BorderSiyle 1
Index 0
Picture MANO_ONICO

N Visible False

i
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Caja de imagen CuName Boton ‘
AutoSize True |
BorderStyle | !
Index ] ) i
Picture .\IAN?_OF.ICO ‘
Visible True I: l
Cuja de imagen CudName Botdn
AutoSize True ‘h o
BorderSivle 1 '
Index o
Picture LIN_OQN.ICO
Visible False:
Caja de imagen CiName Boon
AutoSize True
BorderStyle 1
Index k)
Piciure LIN_OF.ICO
Visible True
Caju de imagen CiName Botdén
AutoSize True
BorderSiyle |
Index +
Picture CAJ_ON.ICO
] Visible False
Caju de imagen CtlName Botdn
’ AutoSize True
BorderSiyle |
Index 5
Picture CAI_OF.ICO
Visible True
Caja de imagen CtiNane Botén
AutoSize True
BorderStyle |
Index 6
Picwre CIR_ON.ICO
Visible False
- Cuja de imagen CtlName Botén
AutoSize True
BorderStyle |
Index 7 .
Picture CIR_OF.ICO
Visible True
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Caja de imagen CuName Botdn ]
AutoSize True |
BorderStyle. I ]
Index 8 : !
Picture TEXT_ON.ICO i
. Visible Fulse \
Caju de imagen ! CuName Botdn :
AutoSize V) .}, True :
BorderStyle -~ 1
[ndex _ 9
Picture - " TEXT_OF.ICO
Visible . True

Las cajas de imagen que forman ¢l panel de utilidades constituven un array de
controles que hemos denominado Boten, '

Para completar nuestro panel de dibujo anada las etiquetas indicudas en la
tabla siguiente.

Ohjelo Propiedad Valor
Etigueta CtlNume Labell
Cuption 4 X:
ForeColor &HOO0000O0&
" BackColor &HOOFFFFFF&
Etiqueta CilName X
Caption {nada)
ForeCalor & HOON00M0&
BackColor &HOOFFFFFFL
Eugueta CuName [.abel2
Caption Y
ForeColor S:HOOOKXNN&
BackColor &HOOFFFEFFS
Enqueta CuName b
Caption (nada)
ForeColor ~ &H00000000&
BackColor L HOOFFFFFE&

El siguiente pase es anadir el codigo necesario para yue nuestra aplicacion
i s funciones especincadas anteriormente, Primeramente vanios o hacer
) punel de vnlidades. Recuerde que sélo puede haber un botdn pulsado

A
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cada vez. Cuando pulse cualquier otro botdn thacer clic). ¢l botén que estd pul-
sado volverd autométicamente a su posicion normal (sin pulsar). Si hace clic so-
bre ¢l botdn ue estd pulsado. no se ejecutard ninguna accidn. Por lo tanto. ¢l pro-
cedimicnto yue realice este proveso responderd al suceso Click.

Segtin 1o tubla empleada para construir ¢] panel de mﬂgdades. un botdn sin
pulsar tiene indice impar (Index = 1. 3. 3. 70 Yy y un bmc‘)p pulsado nene indice
par (0, 2, 4, 6 u 8). De acuerdo con esto, el procedimiento l;brd_d:ﬂ(‘h'rk. primero
realiza la accion de pulsar el botdn v despuds restaura el botdn que estaba pulsado
a su posicion normal: el indice de éste botdn se guarda de una vez para la siguien-
te ent la variable fadAar definida a nivel de la forma. El efecto-putsadu/no pulsado
de un botdn, se consigue a travds de dos imdgenes _ON/OF. Pulsar un boton
equivale a hacer visible la imagen .ON ¥ hacer no visible fu imagen ..OF. Lo
contrario vuelve el bouin a su posicidn normal (sin pulsur),

ornoensr)

Sub Bounn_C-icx (102
"Pulsar el Zotdn
Select C on

Case 1
Boton () . visizlse = -2: Zozdén{i).Visible = 0
Case 3
Botdniz) . Visinls = -1:
Case 5
Botdnis) . Wisizlzs = -1;
Case 7 .
. Botdn(5).vizinls = ~_: Boudni{7).Visible = 0
Case 9
Botdn(2) . visinls = -1: Z016n(9) . Visibleg = 0
Case Fl :
Exiy £
End Selec:
*Al pulsar un bozdn
*Indant e )
Boton{ Ind:
BotdntIng:
TndAant =
End Suhb

cocdn(3).Visible = 0

¥
1

Zo-on(5) .Visinle = 0

T erior

O

]
[
WO T

Ahora ya tenemos en marcha el panel de wilidades y sabemos que un botdn
pulsade tiene indice par y gue su propiedad visible vale —1.

Para continuar defim a nivel de fa torma (igeneral)) las variables que se indi-
cin a continuacion ¥ que exphicaremos sewidn aparezean,

Dim Indant Az
Dim Radic &~

i
[
1]




234 VISUAL BASIC. APLICACIONES PARA WINDOWS

Cuando se arrangue la aplicacion. deseamos como color de fondo el blanco v
como color del primer plano tdibujo) el negro. También aparecerd como opeitn
por defecto. dibujar a maeno alzada. £l procedimiento Form_Load escrito a contj-
nuacion realiza estas operaciones. Para conseguir que inicialmente aparezea pul-
sado el botdn de dibujo a mano alzada, invocamos al procedimiento Bidn_Click
con un valor de | para Index y como este procedimiento to dltimo que hace ey
retornar ¢l botén que estaby pulsado a su posicion nonnal. hacemos el supuesio
que el que o estaba era el botén paré. escnbir texto {(/ndAnt = 9). A pesar de que
inicialmente esto no es asi. el resuliado déseado no se ve alierado.

Sub For« () .
Backfalcry <Eiclo:(L5L"fondo blanco
ForeCelor = GZIzicrz (7)) 'dibujo en regro
indint = 32 :
Rotér_Tiicx °

Eng &un

Comuo va explicamos. al mover el ratdn sobre un contrel se da el suceso
MuouseMove para ese contrul. Pues bien, cuando arrastremos el cursor del ratdén
por encima de los bulones que forman el panel de utilidades. queremos que éste
tenga forma de flecha. Como el procedimiento invocado en esie caso es Bo-
tin_MaowseMove, lo inico que enemos que hacer es incluir en el cuerpo del
mismo la sentencia Screen. MousePointer = 0.

Sub Bozdr_ Iriex ~s Integer, ButIion A

er, X As Single, ¥ As

Screcr.MousefolinIer =
End Subd

Una vez que el usuario hava elegido la wilidad deseada del panel. o primera
que hard serd situar el cursor del ratdn en el lugar donde desee comenzar ¢l dibujo

y pulsar el boton izquierdo del mismo (Bunion = 1). Eslo hace que se d2 el suceso-

MouseDown y como respuesta. almacenareinos las coordenadas actuales del cur-

©sor del rudn en las variables CX y CY y en las propiedades CurrentX y
CurrentY. También es necesario. como veremos mas adelante al explicar la
ruting de dibujar elipses v circulos. poner {a variable Redier a valor 0.

!
I+
try

T 13iiion As Integer, S5l
Irmzger, ¥ oAs Sincle,

Sub Forr_VWouse

I
LT
HY)
]

wy
b
in

. o oas
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Para reahizar un dibujo. el usuario armasirard ¢l midn con el botdn uqmerdo
pulsado. lo que hace que se dé el suceso MouseMove. La respuesta a éste suCeso
depende del butén del panel que haya pulsado. Pur otra punie, cuando Arrastremos
¢l cursor del ratén por encima del drea de dibujo. esto es sobre la I’orlmfl. quere-
mos que tenga torma de cruz. o cual se consigue ejecftando  la sentencia
Sereen MousePointer = 2 en ¢l procedimiento Form _MauselMove. También,
COMO respuesti a este suceso-actualizaremos fas eliquetas )j*c; )’ qQue muesiran la
posicién actual del curser del ratén.

E procediiniento que se presenta a continuacisn, re.lhm IJG operaciones an-

*leriormente expuestas y las rutinas correspondicntes a cada uno de los bulom:s del

|
panel. Es impontante que recuerde ta funcidn de las propiedades CorrentX y Cu-

rrentY para cada tipo de grifico, vistas en ¢l Capitulo 9.

El proceso de dibujar comienza si el botdn izquierdo del ratén se mantiene
pulsado (Burron = 1). Si ademds ¢l botdn det panel pulsado es el de dibujar a
mano alzada, amastrando el raton puede realizar esta funcidn (hine (X, Y)). Si es
el botan de dibujar lineas, cajas o elipses (If Nor Borint0).Visible) es|necesario
que cada una de sus rutinas asociadas permita variar la figura que estamos dibu-
jando hasta obtener la que deseamos, momento en que sohuremos el botén iz-
quierdo del radn. Este efecto se consigue dibujundo con la pluma Xor
(DrawMode = 7).

Pantalla Pluma Pantalla Xor Pluma
O 0 0
0 i 1
| 0 i .

] ! 0

La forma sobre la que se dibuja es de color blanco ttdo unosi. Por Lo tanto,
si dibujumos con color blanco (ForeColor = BackColury ubtendremos un dibujo
en pegro {todo ceros). Para borrar este dibujo. lo dibujamos de nuevo justamente
encima; el resultado es el dibujo en blan o rcotor de fondu). esto es. no ls:, visua-
hza. Esta es la téenica utilizada para conseguir el efecto al gue nos referiamos en

¢l parrafo amerior.

En resumen. el clecto de variar una figura dindgmicamente se consicue bo-
rrando fa figura existente v dibujando una nueva, La posicién de la lmia O caja
exisiente es conocidis por las courdenadus (CX. CHy v (CurrentX. C urrem\'
Una clipse o cireulo existente queda definiday/o por lus coordenadas (CX. CHyy
por las variables Radio y Aspecte. Como estas variables son estiticas, conservan
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su valor de una vez para la siguiente. En las figuras nuevas ademas del punto
inictat (CX. CY) interviene ¢l punto actual (X, ¥). Por ejemplo,

a

Inicialmente, la primera sentencia de la pareja que hay en cada rutina de dibu-
JO RO gfecuti ninguna accién. por COII‘ICI?II’ las coordenadas iniciales v finales. o
en ¢l caso de las elipses y circulos por ser-el radio’0. Cuando se dibuja una linca o
una caja. autemditicamente las coordénadas finales (X, ¥) pasan a almacenarse en
las propiedades (CurrentX, CurrentY)..

¥ ‘actuales
= SCrS{X - 2zIén
= ScrsiyY)

izdo.

II Lot Eotdéni). VlSlble Tran
Colorini = roreColor
ToreColor = SackColor

ricigl = Drawliode
srode = 7 'Xor

inle Then
- (CurrenzX,
-(X, Y)

CurrentV)

{

'
1
'y

Zel recén

T

———y
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N

]
=1 {1
=1
Lot 1Y

Fhy

0
L im

Qo

.5 D
- Oy O 08 L.

- T

[ =t

It Shift = 2 Tren 2go
Circle (CX, Cv), :
=nd If

DifTni c1al
Colorini

Drawiiode =
TereColor =
Irné If
Eng If
End Sub

Observe que en la rutina de dibujar cajas, si mantenemos pulsada la tecla Ctrl
(Shift = 2), se dibujan cuadrados perfectos y en caso de las elipses. circulos per-
fectos (Aspecto = 1),

Una vez finatizado el dibujo de una linea, cuja o elipse, se restauran los valo-
res iniciales de lus propiedades DrawMode y ForeColor.

Cuando ¢l usuario hace clic en el botén del panel que permite escribir texto,
dicho botén queda enfocado. Por lo tanto, cuando pulse una tecla para escribir un
caricter se producird el suceso KeyPress para ese conrol (Botén), Quiere esto
decir que en el procedimiento Botin_KeyPress es donde ten2mos que colocar el
cidigo que permite escribir cada cardcter pulsado, Para realizar esto utilizaremos
el método Print. La escritura comienza en la posicion indicada por las propieda-
des CurrentX y CurrentY.

Cuando Print escribe una expresion. ésta es finalizada con un retorno de ca-
rro. Enionces la propiedad CurrentX es puesta a cero v la propiedad CurrentY
es incrementada en ¢l alto de la expresion (TextHight). Si a continuacién de la
expresion colocamos un punio y coma, una vez eserita la misma no se produce un
retorno de carro. En este caso la propiedad CurrentX es incrementada en ¢l an-
cho de la expresion (TextWidth) v Tu propiedad CurrentY nb cambia.

Sub Boidn_KeyPress (indsw ag integer, ©4 i3 =cer}
Forml.Print ChuS{Hey: $C1l);
Znd Sub
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SELECCIONAR Y ARRASTRAR

Cuando estamos disefiando una aplicacion Visual Basic. a inenudo seleccionamos
un control y lo arrastramos a la posicidn deseada. Esta caracteristica puede ser
puesta a disposicién del uswario de una aplicacion. en tiempo de ejecocion. La
forma de ejecutar una accién como ésta es hacer clic en cl objeto v con ¢l boldén
izguierdo del ratén pulsado, anaslmf’lo hlacia la posicién deseada.
o

Cuando un control se arrastra hacia'una nueva posicidn durante la ejecucidn
de una aplicacidn, nosotros mismos deberemos programar cual serd esa nueva
posicién, No obstante, ¢sta caracteristica se utiliza a menudo para permitir que al-
guna otra accion se cjecute: en este-caso, al soltar el botén, el objeto vuelve au-
tonxiticamente a su posicion inicial. :

Para permitir al vsuario seleccionar un control y arrasirarlo. asigne a la pro-
piedad DragMode del control e} valor 1. Esia operacidn puede hacerla durante el
disefio o durante la ejecucion. Por ejemplo.

Picturel.Dragkoce = 1

Cuando se arrastra un control. Visual Basic muestra un cuadro gris en lugar
del propio conirol. Si quiere. puede sustitwir esie cuadro por otra imagen, durante
el disefio, asignundo et fichero correspondiente a la propiedad Dragleon, o du-
runte la ejecucion como se indica en los ejemplos siguientes.

B

Picturel.Dragicon
Picturel .Dragicon
Picturel.Dragiccnh =

n
1= 0y

e 2re4re)

Cuando ¢l usuanio suclia ¢l botén para dejar de arrasirar un objeto. se genera
¢l suceso DragDrop para ¢b objeto sobre el cual se amrastra. El esquema del pro-
cediniento correspondiente a este suceso cuando el control se arrastra sobre una
forina es,

Conzroel,

SDLNC-=2, =

Ve
1]
u
h
i

"y
|
1]

tnd Sub

EF wrgunwento Sowrce referencia el conte gue se st ¢l cual puede ser de
cittlguier upo excepto un mend o un winporizador. Ea palubra Form que aparece
i el nombre del procediniento Fonm_Dragirop especilica el objeto sabre ¢l
cual se arrasira; en general puede ser una forma @ un control.

-

CAPI1i L0 HE SUCESOS DEL RATON 239

t

Los argumentos X, }. son las coordenadas comespondientes al puntero del
e 4 2 3 g A M ' '
raton. referidas al objeto (forma o control) subre el que se arrastra.

Mientras la propiedad de arrastrar avtomiticamente yn control esté activa,
este o reconoce otros.sucesos del ratdn. Dicho de otra forma. como la operacidn
de arrasirar empieza con ua clic sobre ¢l control, los sucesds del ratén, por ¢jem.

plo MouseDown, no son reconocidos por el contrul. .

- W

Como ejemplo, cree un procedimiento para que la aplicacion que disefamos
Anterionuente en ¢ste mismo capitulo y que denominamos rator.mak, permita
arrastrar ¢l icono CIR_QF.ICO a una nueva posicién. Para' realizar este proceso,
cargue la-aplicacion. seleccione el control denominado Pitiurel que contiene el

Icuno ¥ ponga su propiedad DragMode al valor | (arrastrar uumm;iliculmcmcj.

Cuando el usvano seleccione y amastre ¢l objeto sobre la forma (Formy), en el
momento que suelte el boldn para dejarlo en la posicién alcanzada, se genera el

- suceso DragDrop. Si no hay una respuesta a este suceso, ol objeto retorna anto-

midticamente a su posicion iniciak. Para colocar ¢l objeto en’la nueva posicidn,
respoimli a este suceso con el método Move y Jas coordenadus correspondientes al
punicro del rutén,

orm_DrezZrop {Scurce As Control,
¥ &s Single, Y s Single) .
cgirel vidch /2
toral . Height / 2
X - CXP, Y - CYP

[

Con el fin de que el centro del uhjeto sea el que se sitie.en la posicidn indi-
cada por fas coordenadas (X, ¥} dei puntero del ruén y no ta esquina stiperior iz-
quicrda del misino. se resta a X una cantidad igual 3 la mitad del ancho el objero
y u ¥ una cantidad 1gual a la mitad del alo.

Cuando una operacion de seleccionar y arrastrar estd en proceso v ¢l puntero
del rtdn entra en. sale de. o estd encima de, un control cualquiera de la|forma, se
da el suceso DragOver asociado con dicho control. Por ejemplo. si el contrul so-
bre el que se arrastra es una etiqueta Labell, ¢l esquema del proccdimilcnlo para
esle suceso es ¢l siguicnie:

Sub l3k=ll TragQuer (Scurce o
TOAs Sih

14 s

[N9]




240 VISUAL BASIC. APLICACIONES PARA WINDOWS

Cuando se da el suceso DragOver aparece un nuevo parimetro Siare. Si esie
pardmetro toma el valor O es porque el puntero del ratén entra en el objeto. en
nuestro caso en Labell: si toma el valor 1 es porque el puntero del raén deja o
sale del objeto; y si tama el valor 2 es porque el control Sonrce 2std encima del
objelo. .

Nonnalmenle los estados O (emrar) y | (salir) se utilizan para distinguir
cuando estamos Jdentro del drea de uh Objclo mientras que ¢l estado 2 es dul para
saber si el puntero del ratén estd encima de una determinada zona de un objeto,
En este dlimo caso, serd necesario evaluar los argumentos X e Y.

Como ejemplo, aitada una etiqueta Label! a 1a forma y ponga la propiedad
Caption de [a misma a un valor aulo.

A continuacidn, cree un procedimicnto para dicha etiqueta, de forma gue si al
arrastrar el control Picurel (imagen CIR_OF.ICO) entra en el drea correspon-
diente a Labell, se inviertan los colores del fondo y dei primer plano de la misma
y lo mismo cuande salga de la ctiqueta,

~ Abra la ventana de codigo correspondiente a Labell y escriba el sigweate pro-
cedimiento.

Sub Lapell_DreagCver (Source s Control,
Y As Single, State
Cornsc ENTRA = 0 R
Const SALE = 1
Dim ColorTern 2s Long
1t State = R QOr SLaL,P = SAL7 Then
ColorTemp = Labell.3ackColor
I;5L11 BackColor =-tabeli.arcColor
anell.ForeColor = Colo:
If
Er. 2
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Guarde y ejecute la aphicacion.

Ohserve que al arrasirar el conirol Picrurel, si entra en la etiquelta, ésia in-
vierte su color y cuando sale de ella ocurre lo mismo.

A continuacidn, modifique ¢l procedimiento Form_Dragrop para que
permita tanshién amasirar Ly etigueta. La solucidn se presenta a continuacion,
As Single, Y

Sub Form_ Drac?*oo (Scurce As Control, X

" AS Slnole)

If TypeOf Scurce’ Is 2ictureBox Then

CX = Pictural.Widrn / 2
CY = Picrurel.Heighc / 2
Picturel .Xove X - CX, Y - CY
Elseff TypeCi Source Is Label Then
CX = Labell.Width / 2
CY = Labeili.Heighz / 2
Lahell . VMove X - CX, ¥ - CY
End It .
End Sub

Observe que para saber de qué objeto se trata utitizamos la expresién,
IE TypeOF ubjeto 1s 1ipo_objeto

El argumento objeto es una variable de tipo Control y ripo_vbjeto indica el
tipo del objeto en cuestion, el cual puede ser uno de los siguientes: CheckBox,
ComboBox, CommandBution. DirListBox. DnveliasiBox. FileListBox, Frame,
HScroliBar, Label, ListBox, Menu. OptionButton, PicwreBox, TeatBox, Timer,
o VScrollBar.

© determi-
Jdcamente
Jea, Visual

Hasta ahora hemos visto que cuando la propiedad DragMode
nado control tiene un valor 1, dicho control puede ser armstrado a
¥ o reconoce otros sucesos del ratdn, Ademis de la forma aut.

———
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Basic tiene la forma manual. propiedad Dragdode = 0, que permite controlar
cuando un objeto puede ser arrastrado y cuando no. Por ¢jemplo. usted puede
querer arrastrar un objeto en respuesta a un suceso MouseDown. a una ecla. 0 a
una orden de un ment.

Cuando la propicdad DragMaode vale 0 (manual), la forma de permitir o no
arrastrar un objeto es utilizando el método Drag cuya sintaxis es ka siguiente:
¢y '

f

[control.}Drag accion

El valor del argumento accicn puede ser 0,1 0 2. Un valor 0. cancela la ope-
racién de armasirar; un valor |, inicia la operacion de arrastrar: un valor 2. finaliza
la operacidn de arrastrar v ademas hace que se dé el suceso DragDrop.

Como ejemplo cree una nueva aplicacidén llamada meamal mak. Cree upa
nueva forma lamada manual fron y anada a la misma los controles de la tabla sj-
guiente;

Objeto Propiedad ' Valor

Caja de imagen CtName Picture |
AutoSize True
DragMode - 0 - Mapual .
Picture CIR_OF.ICO

1

La forma serd similar a la de la figura siguiente.

Nuestro objetivo es que cuando el usuario seleccidne v amastre o imagen
Prcturel. el control se mueva precisamente dentro de la posicion final del rectan-
gulo gris. Para conseguir esto, hay que registrar las coordenadas iniciales corres.

22
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.,

pondientes a la posicion del raton dentro del contral. Entonces cuando sc;muéva
el objeto uiilizaremos esta posicion como un desplazamiento.

Los pasos a seguir para realizar lo especificado son los siguientes:

s Declarar dos variables a nivel de la forma DespX ¥ Desp}'!

Dim ZaspX 2s Single, Desp¥ 2s Sinzlse 004

+  Permitir arrasirar el control cuando ocurra el suceso MoiiseDown, 'll'umbién,

almacenar los valores de X y de Yen DespX 'y Desp) respectivamente.

Sub Piczurel_MouseDourn Len A - ‘ nifg| As
X : ingle)
Pict:rel.Drag 1 .
Dessid = X
Degoy = Y
End Suo

«  Cuando fnaliza el arrastre y se suelta ¢l botdn del ratén, se produce ¢l suceso
DragDrop. El procedimiento asociada con la forma para este suceso, situard
el contrul en ta posicion (X— DespX. Y= DespY). ‘

Sub Fora_DragDrop (Source 2s Control, ¥ 2s Single,
Y 3 Single)
Picturel.Move X - DesnXk, Y - Sesp?
End Sub

EJEMPLO DE SELECCIONAR Y ARRASTRAR

El siguiente ¢jemplo emula el funcionamiento de la papelera en un sismm:lx Macin-
tosh. En un sistema como éste. para borrar un fichero que aparece en una lista
Fuente, simplemente se selecciona y se arrastra hasta la papelera. donde se deja
caer. Lo papelera para indicar que tiene algo. aumentari de volumen. Para borrar
cualguier otro fichero de la lista, se procede de igual forma.,

Esios ficheros que se han eliminado de 1a lista Fuenre y que $e encuentran en la
papelera, adn no estdn fisicamente borrados de la unidad de almacenamiento co-
mespondiente. Para ver lo que hay en la papelera haga un doble clic sobre la misma
y aparecerd una segunda ventana. Observe las dos figurs siguientes.

La lista Destine indica los ficheros que hay en la papelera. Cualquiera|de estos
ficheros puede ser devuelio u'la lista Fuente selecciondindolo y arrastrdndolo hasta
dejarlo caer sobre la misma; este proceso equivale a recuperar el fichero. Pura bo-
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rrar definitivamente los ficheros que se encueniran en la papelera se pulsa ef botdn
Vaciar papelera.

Fuenle

Destino

Nuestro primer paso e¢s crear los iconos necesarios para nuestra aplicacion:
papelera vacia (PAPELERA.ICO). papelera oscura vacia (PAPEOSVAICQ), pa-
pelera llena o con algin fichero (PAPELLE {CQ), papelera oscura llena o con al-
gin fichero (PAPEOSLL.ICO) y un icono indicando que hemos seleccionado un Ni-
chero y lo trasladamos de lugar (FICHERQ.ICO).

Para crear los iconos. cargue vy ejecute la aplicacion iconwrks, que es un editor
de iconos que se suministra como ejemplo con Visual Basic. Abra ¢l fichero
TRASHOLICO que se encuentra en ¢l directorio "...\vblicons\computer”, haga las
“modificaciones que considere necesarias y gudrdelo en su directorio de trabajo
coma PAPELERA.ICO. Proceda de forma similar para las otras wes papeleras. E1°
resultado serd similar al presentado en la figurs siguiente.

R
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&

PAPELERAICO

8
PAPEOSVAICO"

PAPELLE.ICO PAPEQSLL.ICO

Para crear el quinto icono abra ¢l fichero FILESHO.ICO que se encuenira en el
directorio .. \whhiconstoffice”, haga lus modificaciones para que quede como se
muestra en la fieuis siguicnte y gudrdelo en su directorio de trabajo como Fl-

CHERO.ICO.
I?-5131
1
]

——l
. FICHERQ.ICO
Inicie una nueva aplicacion y cree una forma tirulada Tirar en la papelera con

Jos controles que se indican en la tabla siguiente (ver en las piginas anteniores la
comespondiente figura). Guarde la aplicacion con el nombre papelera.mak 'y la

furma con ¢l nombre papele0! frin. -
Objeto ' Propiedad Vulor
Forma FormName Forml
Caption Tirar en la papelera
BorderStyle ]
ControlBox False
lcon PAPELERA.ICO
l‘.isla CuUName Fuente
Draglcon FICHERO.ICO
Sorted . . True
Tag tuente
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Boton CiName Salir “
Caption Satir ’ .

Caja de imagen CilName | Vacia
AutoSize True
BorderStyle 1
Draglcon,; 1 PAPEOSVALICO
Picre <, PAPELERAICO
Visible ' False

Caja de imagen CilName . Llena :

' AutoSize’ True

BorderSiyle 1
Draglcon PAPEOSLL.ICO
Picture PAPELLE.ICO
Visible False

Caja de imagen CtIName Papelera
AutoSize True
BorderStyle 0
Picture PAPELERA.ICO
Visible False

La propiedad ControlBox de la forma permite habilitar (True) o deshabilitar
(False) el menud de contro de dicha forma. La propiedad Icon de la forma per-
mite que se visualice el icono asociado a la misina cuando la forma se minimiza.

La propiedad Tag de un objeto permite almacenar un dnico dato. que serd
utilizado para identificar el objeto. Otras veces, esta propiedud se utiliza con fines
de almacenamiento. '

Las cajus de imagen nombradas Vaucia v Liena. que durante la ejecucion per-
manecen ocultas, sirven pura proveer a la caja de imagen Papelera Je la imagen
adecuada en cada momente. Observe que cada una de eilas almacena dos image-
nes, ta real en la propiedad Picture y la oscurecida en la propiedad Draglcon. En
‘esle caso, la propiedad Dragleon se ha wilizado con fines de almacenamiento y
no con intencion de arrastrar. También, observe que la caja de imagen Papeleru,
inicialmente muesira la papelera vacia. .

Cree una nueva forma titulada Recuperar ¢ vaciar con los contrules que se
indican en la tabla siguiente (ver en fas piginas anteriores la comespondiente figu-
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ra). A continuacién. guarde la aplicacién con el nombye que ya tiene y 1a forma con
¢l nombre papele0?. frm. l
1
Objeto Propiedad Valor
I
L)
Forma FormName Form2 ’
. Caption Recup%q c_>.\faciar
3 BorderSiyle I
ControlBox False |
lcon PAPELERA.ICO
Lista CriName Desting .~ |
' Sorted True -
Tag - Destino
Bowon ClName | Orden
Index 0
Caption Cerrar
Botdn ' CiName ~ Orden
Index !
Caption Vaciar papelera

En primer lugar escriba ¢l cddigo asociado con el boton Selir para el suceso
Click. El objetivo de este procedimiento es finalizar la aplicacion,

Sub Salir_Clicx (}
end K .
End Sub

Pura hacer mis sencilla la aplicacion, en hugar de que un sistema de ficheros
muestre la lista de Nicheros de un directorio elegido. vamos a generar nosotros una
lista que emule a la citada.

El siguiente procedimiento. que se ejecutard cuando se inicie la aplicacion.
genera la lista de elementos para demostracion ¥ ademds asigna a la lista Destino,
el icono que se visualiza cuando se selecciona v arrastra la lista Fuemq, con el
mismo fin. Por dltimo se asigna a la propiedad Listindex de la lista Fuenre ¢l
valor 0 1o que hard que quede seleccionado. automdticamente ¢l primer elemento
de la misina.
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Sub Form_Load ()
Dim I As Integer

Form2.lestino.Draglcen = Fuents.2Jrazlzon

For T = 1 To 15
Fuernte.xdéélitem “Fuente_* « Form=-z-2, "GO
Haxz
Fuentz.Listindex = 0 'Seleccicriair nvimss gleranto
znd Subn

wo ol
Una lista responde a un clic, realizado con ¢l botén izquierdo (Button = |}
sobre un elemento de la misma, cambiando de color el elemento seleccionado y
poniendo su propiedad ListIndex al i';_xlor correspondiente a la posicion del
clemnento en la lista (el primer clemento ocupa la posicidn 0). El nimero de
elementos de la lista lo da la propiedad ListCount.

Nuestro siguiente objetivo es arrasirar la lista. manteniendo pulsado el botén
derecho deb ratén (Button = 2). y dejar caer en la papelera el clementa
seleccionado. Cuando se pulsa un botdn ded raién se da el suceso MouseDown.
Si en la lista hay elementos y el botén pulsado es el derecho. iniciamos el proceso
de arrastre de la hista Fuente.

Observe gque no se ha utitizado el arrastre automdrico va que una vez iniciada
la operacion de arrastrar, el control Freente no reconoceria otros sucesos del raton.
Fsto es. al hacer clic sobre el objeto para iniciar el ammastre. los sucesos del ratén.
como por ejemplo MouseDown. no serfan reconocidos. Esto. por ejemplo, impli-
caria no poder seleccionar un elemento.

Sub rusnte_MouseDown (3urten 23

_rntegsr, 3nhift is
Integer, ¥ 23 Si-g.z, Y 28 Zingle)
I1f ruente.ListCount > 0 Ther I iizzz ro vacia
1f Zuctton = 2 Thern 'si botd rezho oulseaio
Fuante.Drag 1 'inicio ars &
rg If
End T&
End Sub

£l elemento seleccionade lo dejaremos caer en la papelera cuando estemos
sobre efla y sollemos, en nuestio caso, ¢l botdn derecho del rudn. En el momenio
de soltar ¢! botén derecho det ratén el armastre finaliza v se da el suceso Drag-
Drop para ¢l control sobre ¢l gue se estaba wrasirando v cuando en una operacidn
de arasire se entra ¢n un control, se da el suceso DragOver. Esie dlumo suceso
lo utitizaremos para indicar al usuario cuando entra en. v cuando sale de. la pape-
bera. Cuando entre, cambiaremos la imagen de la papelera a oseurt y cuando
sal: Weremos a poner la imagen real.

T T
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- .

iSource is Comirol, X As Single,

2
Zise 4
P --rve = leraz,lreclicon
Znd ii 'T‘
Cacs2 1 ‘'sale ce parelera S
‘ If Form2
Pagczie
Zise
Par-. .
Znd TZ
talect
5}

)

G.om
=]

vl L

3

Seulin hemos dicho. en ¢l momento de soliar el botén derecho del ratdn se da
el sucese DragDrop que to uiilizaremos para mover el elememo seleccionado de
la lista Frente, a la lista Destino. El etementy seleccionado lo dejaremos caer so
bre ta papelera, s6lo si el control armastrado (pardmetro Sonrce) es la lista Fuente. .
Cuando se trate de otro control. por ejemplo lista Destino, se realizard un aviso
acistico. La operacidn mover implica afadir el clemento seleccivnado de la lista
Frente a la lista Destino y borrarko de la lista Fuente. También, si no hay un ele-
mento seleccionado en la lista Desiino (Listlndex = —1), se selecciona el elemen-
e O de la misma. Por ditmo, se cambia la apanencia de la papelera para que
mucsire la imagen real de Hena, que estaba vacia o llena pero oscurecida.

sub Papelers_DragDres (Source is Concrol, X As Single,
. ¥ 25 Single)

I1f Source.rég <> "ZzsCino" Then. -~
Form2.D=3tino. 383 -em Source.Lizt{Source.ListIndex)
1f Form2.Destiro.listIndex = -1 Then

“ormZ . Destino.liscIndex = 0

n @

mm
My

e ey D
& T mo

tn (Lo

3

&
o

1z

5

E
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Para ver el contenido de la lista Destino hay que hacer un doble clic en la pa-
pelera.

Suly Pecelera PDhiclick {}
Forr2.Show
Znd SuD

Cuando ta lista deslino esid presente en la pantalla. se permitird al usoario
mover un elemento direciamente degtle 1a lista Fuente a la lista Destino. Esto es,
en lugar de dejar caer el elemento en la papelcm lo dejard caer directamente en lg
lista Destino, obieniendo los mismos resubtados. Por lo tanto, el procedimienio
Destino_DragDrop es muy similar al procedimiento Papelera_DragDrop ante-
riormente explicado.

- Zub Destino_Draclrop (3ource Cortrol, ¥ is Sirngiz,
Y As S e}
Tf Source.Tag <> "bescino™ Tren
If Forml.Papelera.Ficiure <> rorml.Llena.Picture Tren
Torml.Papelera.Picture = Torml.Llena.Piccure
grd If
Descino.Addizem Source.Lisz(Source.Liscindex)
It Descino.Listincgex = -1 Then .
Destino.ListIndex = 0
End If-
BorrarElemenco Source
End Tf .
=nd Sub

Otra operacion a tener en cuenia €s que el usuario pueda recuperar un elemen-
to borrado de la lista Fuente. que se encuentre en la lista Desrino. Esle proceso
consiste en arrastrar ta lista Destino, manteniendo pulsado el botén derecho del
ratén (Button = 2), y dejar caer en }a lista Fuente ¢l elemento seleccionado. Si en
la lista Destino hay elementos y el botén pulsado es el derecho, iniciamos ¢l pro-
ceso de arrastre. :

Sub Destino_MouseDown {Butcon s I
Integer, X X
If Destino.ListCount > 0 Than

I7 3utton = 2 Then
Destino.Drag 1 -
Tnd If
Fng If
ZInd Sub

Como ya sabe, al solar ¢l botdn derecho del rdn para finalizar el armastre v
dejar caer el objelo, se da ¢l suceso DragDrop que lo utilizaremos para mover el
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¥
-

elemento seleccionado de §a lisia Desting. 2 la lista. Fuemte. Bl elemento seleccio-
nado lo dejaremos caer sobre la lista Fuente. sélo si el control arrastrado
(pardmetio Sonrce) s la lista Destine. Cuando se trate de otro control, por ejem-
plo de la propia lista Fuente. no se tendrd en cuenta. La operacidn mov erimplica
afiadir el elemento seleccionado de 1a lista Destino a la lista j‘ueule y borrarlo de
La lista Desting, También, sino hay un elemento selecciona 1o en la lista Fuente

(ListIndex = —1). s¢ selecciona ¢l elemento 0 de la misma. "

£l l.. ."'
Sub Fuente_bDraglrop (Scurca As Control, X is Single, Y
23 Single) o

If Source.Teg <> "7
Fuente,rddlcen Scu
'Si ono hay un eilers
If Fuence.lLiscing

Fuente.iLiscIndas

End 7f

Para borrar definitivamente todos los ficheros de Ia lista Destine, el usuario
hari clic en cl bowon Vaciar papelera (Index = 1). El ¢édigo asouadc; con este
botdn realiza las siguicntes operuciones: verifica si hay elementos en la fista,
cambia el cursor del ratén utilizando la sentencia Screen MousePointer, para que
indigue "esperar”, borra los elementos de la lista uno a uno (para borrar|los fiche-
ros correspondientes a cada elemento de la lista, incluya usted el codigo que le
interese), modifica la apariencia de la papelera para que indique vacia y restaura
el cursor del ratén. Para cerrar esta ventana, haga clic en el boién Cerrar.

Sub Orden_Click {Index 2s integer}

Dim T As Integer
If Index = 1 Tren ‘*-aci
If Destino.ListCcun

& 1a nap 1era
<= 0 Then 'si hay elementos

Beap

ExXLIt Sub
End If
Screen.¥ousePoinzer = .1 ‘gazmbiar cursor del racdn
For I = 1 To DBes igzlount

Destino.Listin

'tqui escribza-= rio para borrar

'los e‘- : ~cl la lisca

Descti
Next T
Forml, P& Torml.vVacia. D‘CuUIE
Screen. voilver al cursor 1n1c1a1

Else 'cerra:
Orden(0).Se
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E:
ad

m

Para borar un elemento de 1a lista Fuente o de la lista Destino. escriba of si-
guiente modulo v gudrdelo con el nombre papemod i bus. En ¢l procedimiento «j-
guiente distinguimos dos casos; borrar un elemento que no es el primero v borrar
el elemento primero. Para borrar un elcmcnlo que no es el primero seleccionamos
el elemento anterior a él v después ]o boaramo: ¥ $i se trata del primer elemento,
prmero lo borramos y a continuacién. si quedan elementos en la lisia. seleccio-
namos ¢l primero. Cuando se trate de.1a Jista Destino y se borre el Gltimo elemen-
10 que quede, hay también que modmcar la apariencia de la papelera para que
md:qm vacia. g

Sub Borrarzlerern 2 Lz Control)
If Source.LiscTrcdex D Then
‘Gorrar un elemznco gue ro es el primero
fource.Liggindex curce.listIndex - 1
Source.Removs:l rce.llstlindex + 1
Else
‘Borrar primer
fcource.Rezovel .LiscTndex
T{ Source. L1='Cc : 0 Thzn *si lista no vaciz
‘seleccionar e: o amento
Source.lLiszzindex

orml.Vacia.Pic:u:e

End .5ub

CAPITULO 11

-
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DEPURAR UNA APLICACION

INTRODUCCION

Visual Basic provee wilidades que permiten analizar como se desarrolla la ejecu-
cion desde un lugar de Iz aplicacién a otro. Esto es una forma de determinar qué
ocurre en una aplicacion que apareptemente parece correcta, pero que los resulia-
dos mostrados no son satisfactorios. Las téenicas de depuracidn empleadas por
Visual Basic incluyen, puntos de parada. ejecucion puso a paso. y la posibilidad
de visualizar valores de variables y de propiedades.

Cuando se reahiza una aphicacion se pucden presentar res clases de errores:
errores de sintaxis, errores en liempo de ejecucion v errores 16gicos.

Los errores de sintaxis son el resultado de escribir incomrectamente una sen-
tencia. Si tiene activada la opeidn Syntax Checkingdel mend Code, Visual Bu-
sic detecta e510s ertores tan pronto coma se producen. esto es, en ¢l momento de
escribir una sentencia incorrecta en la ventany de codigo, ~

LLos errores en tiempo de ejecucion ocurren cuando durante ta ejecucion de
una aplicacidn, una sentencia intenta una operacion que ¢s imposible realizar. Un
ejemplo tipico es una divisién por cero. Una buena programacién exive que la
aplicacion se anticipe a muchos de estos errores, manipulindolos adecuadamente.

Los erroves logicos se producen cuando siendo la aplicacién sintdcticamente
correcta, se cjecula sin producirse errores en tiempo de ¢jecucion. pero los resul-
tados gue se obtienen no son correctos. Para detectar este tipo de emores, es nece-
saria una minuciosa depuracién. analizando cada pante de ¢édigo v verificando re-
sultados intermedios.

[
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MANIPULACION DE ERRORES

Desde el punto de vista teérico las aplicaciones no necesitan rutinas para manipu-
kacién de errores. Desde el punto de vista prictico €sto no es cierto. ya que hay
que prever cualquier manipulacién errénea del usuario, Por ejemplo. un usuario
¢jecuta una aplicacidn para buscar determinados ficheros en la unidad A y no ha
introducido el disquete. La aplicacién fallard.
II 'I

El siguiente ejemplo permite buécar ficheros en un directorio previamente es-

pecificado.

Esta aplicacion presenta una ventand como la de la figura siguiente. En ella.
la caja de tex1o sirve para que el usvario escriba el camino comptelo de los fiche-
ros que desea buscar. Por defecto. la caja de 1exio muesira el directorio aclual.
Una vez escrito el camino de bisqueda. el usuario pulsard el botén Buscar y Ia
lista de ficheros serd visualizada. Si no hubiera ningdn fichero de los especifica-
dos, aparecerd un mensaje indicindolo y si los hubiera, 1ambién aparecerd un
mensaje indicando cuantos ficheros se¢ han encontrado. Cuando el usuario haya
realizado todas las buisquedas previstas. pulsard el botén Salir para finalizar la
aplicacidn.

DileF""iO-' [C:\VB\:amplet\cap]0\'.mak

BOTON MAK d O -
BOTONES MAK B M
RATON.MAK -
GRAFICOS.MAK
DRAG.MAK -
MANUAL MAK
PAPELERA MAK P

Inicie una nueva aplicacion v cree una forma tiwlada Buscar Fichero con los
controles que se indican en 1a tabla siguiente. Guarde la aplicacidn con ¢l nombre
diramak y la forma con el nombre dir frm,
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2nd Soh

!
!
Etiqueta CuName - | Labell l
: Caption Directorio: |
Caja de texto CilName Directorio |
Tablndex 0 |
Text (nada)
~ - . . A
Buidn CiName Busm'r
Caption Buschb:
Default True
Boton CriName Sulirlw
Caption Salir."~
=
La propicdad Tablndex devuelve o asigna la posicion Tab para un control
deniro del conjunto de controles de una forma, Cuando usted pulsa la tecla Tab

para dirigirse de un controb a otro. el orden que se sigue ¢s el asignado;por el va-
lor de esta propiedad. Visual Basic asigna un valor por defecto a esta propiedad.
El valor de esta propndad para ¢l primer control dibujado es cero ¥ ca‘dd control
que se anade toma el siguiente valor. Si usted modilica uno de estos valores, Vi-
sual Basic realiza una renumeracion automtica para el resto de los controles.

Para aseguramos de que al arrancar la aplicacién el cursor se sitda en la caja
de texto, hemos asignado ¢l valar cero a su propiedad TabIndex. 5i h.j pensado
utilizar el método SetFoeus en el procedimiemto Form_Load para n.l.lludr esta
operacion, no 1o haga ya que obtendrd un error, Una vez que Ta forma esté presen-

te podrd utilizar este método,

A continuacién escribimos el ¢6digo para que la aplicacion cjecut{c o enun-
cindo. En primer lugar escriba ¢l cadigo asociado at botdn Sefir para ¢l suceso
Click. El objetivo de este procedimiento es finalizar L aplicucion,

Sub Sziir_Click (}
Enc

Para que inicialmente, cuando se arranque la aplicacion, aparezca

Ohjeto

Propiedad

Valor

Fornnma

FormName
Caption

Forml
Buscar Ficheros

en la caja
de texto e} direclorio actual. escriba el sivuiente procedimiento. :

Sub Torm_Lozs () ‘
.Directorio."sxt = CurDirs
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La funcién CurDir$ devuelve et camino actual para fa unidad de disco espe.
cificada. Su sintaxis es,

CurDir$ [(unidad3)]

Si la unidad no se especifica o es una cadena vacia. CurDir$ devuelve g
camino para la unidad de disco acalmente seleccionada,
uo ol .
LI
Cuando el usvario haya escrito ¢ camino de bisqueda en la caja de texto,
pulsard el botén Buscar. Esto hard que se ejecute el procedimiento Buscar_Click

que invocard al procedimiento que realizael proceso de bisqueda.

Sub Bugcar_Click. )
Buscarrichero
End Sub

El procedimiento BuscarFichero utiliza la funcién Dir$ para buscar uno o
mis ficheros. Su sintaxis es.

Dir$ [(ficherv$)]

El argumento fichero$ especifica ¢l pardn del fichero o ficheros que quere-
mos buscar. La primera vez que se llame a esta funcidn, hay que especificar dicho
argumento.

La primera vez que se ejecula la funcidn DirS, devuelve el nombre del primer
fichero que coincida con las especiticaciones realizadas. Para seguir buscando
mds ficheros con las misma especificaciones, ¢jecute Dir$ sin argumentos, Cuan-
do la cadena devuelia sea nuta. quicre decir que la’bdsqueda ha finalizado.

En nuesira aplicacién. los ficheros encontrados por la funcidn DirS son ana-
didos a una lista y cvando la blsqueda finaliza se enfoca de nuevo la caja de tex-
to. En el caso de realizar mds de una bisqueda. cada lisia quedaria aiadida a la
anterior; para que esto no suceda. antes de tormar una nueva lista borramos la
anterior si existe.

Abra la ventana de cddigo para eseribir un nuevo procedimiento {(general)) y
eseribi ¢l codigo que se presenta a continuacion.

TarFicher o (o
Jdacidn g I
! lvinera o as
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’.

norrarla

ioen
t1l.ListCounc - 1

. .
CReéro R

Cecn—a = Zonta -
ir

§ 'sin argumentos busca""el'

pe- 3
L.oop c
If Forml.lizrl.LiscCount inen o L
¥sg = "Iz encontraron’ o« Sursi{Contal) + ficharcs
Zise . . )
g = ge enconiraron ficheros
End & o - )
tsg o gz, [IIFORMACICH, Forml. Caption
Forml . Diveccorio. Secfocus
£nd Sub

El procedimicnto que acabumos de escribir, ledricamente unciona correcta-
mente: incluso, 1o hemos probado con puestro disco duro y no hemos dcwct_ado
ninudn fallo. Sin embargo, si se especilica una unidad de disquete v és:lu no n‘cne'
deatro el disquete o no ticae la puerta cerrada, ¢l procedimiento falla

interrumpiéndose la ejecucion.

Para evitar esta situacion utilice rutinas para manipulacion de errores. Visual
Basic tiene la sentencia On Error que perimite interceptar cualquicr error gue
ocurra durante la ¢jecucion para asi poder manipulario. Esta sentencta y Ja sen-
tencia Resume fucron explicadas en el Capitulo 8, en ¢l apartado "Cnmro! de
errores”. Por ejemplo. los problemas expucstos anteriormiente pueden ser manipu-
lados con el siguiente codigo.

Suh Buscarfichero () B
‘Urilizecidn Ga. Dirs para buscar ficheros
revo is String, MMsg As String

Dim Fict 59 A
Dim Conte &5 Integer, [ 2s Integer

= 71

N
'
(R4}

N
—
U
(o]
It
W
w
e
x
1
-
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Tivar la incercep
On Zrror GoTo RuLing

Mo

—ac
Der

‘81 2 existe una lista horrzric
If “sral.Liscl.LiscCount Ther
Fcr I = 0 To roral.Liscl.rlizzlcuns - 2
Torml.Liscl.Removeltem G
exz I
EnG

alizar le lisca d;‘fache:cs
Ficmero = Dirs{Forml.Directoric.”
Do walle Len(Fickero)
Forml.Listl.xddIcem Fichero
Ccnta = Conga + 1 o
Fichero = DirS ‘'sin argumencos npus<z el sicuiente
Looco

[0k

If orml.Listl.LiscCoun:z Thex ‘
Ksg = “Se encontraron® + S1r5(Cornzz) - " fimheros*

Else o
sz = *No se encontrarocon ficheros*

End It

MsgZox Msg, INFOREACION, Forzl.Cap:tlon
Formi.Directorio.Secfocus

Exiz Sub

Rutinanefrror:
‘If (Zrr = 71} Or (Err = 58)

’sg = "Introcducir disqguete ¥ Cgrrar la pusr-a”
Ms=g3ox Msg, AVISO A

Else
lisg = "Ha ocurrido el error* - ZIr3(Zrr) - " no zZrevisto'
Keg = Msg + ChrS(10) + Chr3(l3) - Zzzors i

Mzg2ox Msg, CRITICO
Szon 'suspende la ejecucién

End It
Res:Te
End Sk

La funcidén Err devuelve el cédigo del dltimo error ocurrido durante la eje-
cucion. La lista de emores puede verla en la avuda de Visual Basic (solicite ayu-
da, pulse el botén Search y busque Trappable errors).

La funcion Error$ devuelve el mensaje correspondiznte al dliino error ocu-
rrido. 51 a continuacion se especifica un mimerw enterw. ErrorS (n). entonces ¢l
mensaje de ermor devuelo corresponde a ese cidigo. ' '

o 1
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DEPURACION

Si en algin caso desea desactivar la interceplacion de errores, ejecute l:lI sen-
rencia 'On Error GoTo 0. Si desea simular que ha ovummido un error ejecute la

sentencia Error cadigo.

Cuando ocurre un error en un procedimiento que no tiene una rutina de mani-
pulacion. o cuando ocurre un ervor dentro de una rutina de m!dnipulaci('m: \'fisual
Basic busca hacia atrds en la rula de invocacion otra rutina de manipulacién. Por
Qcmpm‘unuMcmqucunpnmcmnﬂumxAcwcumwlmanm'QdcnmnmuMdém
llama & un procedimicpio By que éste o su vez llama a uﬁ.‘-"pr(_)bcdimilenlo C.
Mientras el procedimiento C se estd ejecutando. 1a ruta de invocacién es A, B, C.
Si ocurre un error en ¢l procedimienta € que no tiene rutina de 111anipulac‘i6n. Vi-
sual Basic busca por ¢lla primero en B y después en A. Cuando Visual Basic en-
cuentea una ruting de manipulacién la cjecura; st nw la encueritra, entonces visua-
liza el mensaje de error apropiado y detiene la ejecucion.

Durante ¢l disefio v puesta en marcha de una aplicacion hay tres oo en fos que
podemos estar: diseio (design), ejecucion (run). o pausa threak), Mire a la barra
de tfwlo de Visual Basic y observe que siempre le muestra ¢l modo en el que se
encuentra.

El modo diseiio se caracteriza porque es donde se realiza la mayor parte del
trabajo de creacién de la aplicacidn. En este modo se disenan formas, s«% dibujan
controles. se escribe ¢odigo, ¥ se utiliza la barra de propiedades para ver o modi-
ficar algunas de ellas. pero no se puede ejecutar ¢l codigo.

El modo ejecucion se caracteriza porque aqui la aplicuacion toma- ¢l control.
En este modo podemos ver el c6digo pero no pedemos moditiearlo. Parag| pasar de
este modo al Jde disenio, ejecute la orden End del memi Run; para pasar; al modo
pausa, ejecute la orden Break del mend Run o también. pulse las leclas
Ctrl+Break.

£l modo pansa se caracleriza porque permite ejecutar la aplicacion paso a
paso. En este modo se puede editar c6digo. examinar variables y propiedades, dar
un paso mds en 1a ejecucion. ejecutar la aplicacion hasta el linal. imciar; l:} ejecu-
cién. o tinalizar la misma.

Para entrar a depurar una aplicacién. es necesario entrar en el modoj pausa.
Esto lu puede hacer de varias formas, dependiendo del lugar donde qui[cra enlrar
en la aplicacién.  S1quicre entrar a realizar una ejecucion paso a paso justamen-
te desde le principio pulse la tecla F8. Si lu ejecucion paso a paso la quiere reali-
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zar 4 partir de un determinado lugar dentro de fa aplicaciin. coloque en ese punio
un Stop o un punto de parada. Ambos detienzn R gjecucion de la aplicacion pa-
sando del modo de efecucion al modo pausa.

Un punto de parada puede ponerse en tiempo de disefio o en tiempo de ¢je-
cucidn. Para poner o quitar un punto de parada. sitte el cursor sobre la linea don-
de desea se produzeala interrupeidn temporal de la ejecucion y pulse la tecla F9,
Cuando ¢n una linea hay un punto d-;':paiz;da dsla aparece en negrita.

Por ejemplo, cargue la aplicacién dir.mak anterior v observe el titulo de [a
ventiana de Visual Basic, pone (designl.'_Ponga en la aplicacion anterior un punio
de parada en el lugar que indica la figura siguiente. A continuacién pulse F3 para
¢jecutar la aplicacidn y observe de nuevo el titulo de la ventana de Visua! Hasic,
pone [tun]. Pulse ¢l botén Buscar v observari que la ejecucion se deliene donde
ha puesto ¢l punto de parada: ahora ta ventana de Visuat Basic pone {break].

- - | -

Object: |lgene|all I!I Pioc: IBuscalFichelo L!_J

Fichere = Dir§(Formi1.Directorio.Text) 'busca el pri
Do ihile Len(Fichero)
Formt.List1.AddItem Fichero
Conta = Conta + 1
Fichero = Dir$ ‘sin argumentos busca el siguiente
Loop
* . +>

End IFf *
‘Yisualizar lista de ficheros buscados
n

L

Entre colocar un punto de parads o una sentencia Stop hay una diferencia
importante. Cuando se abandona la aplicacion v se carga otra vez. se observa que
iodos los puntos de parada fueron borrados. En cambiv. las sentencias Stop son
perntitentes.

Ahora prucbe a pulsar F8 una v otra vez. Observard que a ejecucion continua

paso 4 paso.

S en lugar de pulsar F8 pulsa Shift+F8 ¢l proceso es idéntico. excepto cuan-
do la sentencia es una lamada a un procedimiento. como ocurre en el procedi.
miento Brscar_Click. B este caso lu Hamada se ejecuta en un solo paso. esto es,
ebp limieno Buscar_Click no se ejecuta paso a paso.
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4,

Como ¢jemplo. detenga la ejecucion. si adn no to ha hecho, y pruebe desde el
intcio fas dos modalidades de cjecuctdn anteriores, F8 v Shift+F8§.

Orras veces, iniciada la ¢jecucion paso a paso. puede querer iniciar la ejecu-
ci6n desde una linea anterior. esto es, desde una linea por 4 que ya ha pasado.
Quizd desee hacer esto porque desde la ventana inmediata (Immediate Window)
ha cambiado ¢l valor de ulguna variable o propicdad v quieﬁg,,\'er los resultados
que se producen. Visual Basic le permite realizar esta operacion desde diferentes
puntos dentro del mismo procedimiento. Para ello. cologue el cursor en la linea
donde desee iniciar la ejecucion y ejecute la orden Set Next Statement del menti
Run. : .

-

Si quiere reanudar Ia ejecucién hasta el final. pulse la tecla F5.

Ventana inmediata

La mayoria de las veces, para encontrar la causa de un problema mientras ejecu-
lamos paso a paso una pante del codigo de nuestra aplicacidn, necesitamos asignar
valores, evaluar expresiones y verificar procedimientos. Este tipo de operaciones
son las gque nos permite realizar [a ventana inmediata (Immediate Window).

Para visualizar valores en esta ventana hay dos formas: wiilizar la sentencia
Print o ? directumente sobre ésta ventana para escribir los valores actuales de Jas
variables y propicdades deseadas, o colocar sentencias Debug, Urint en el ¢odigo
de la aplicaciion,

Una vez que ha entrado en la ventana inmediata, haciendo clic sobre ella o
¢jecutando lu orden Immediate Window del mend Window, -para moverse den-
o ella utilice lus teclas convencionales de cualquier procesador de textos (teclas
de movimiento del cursor, igina arriba, pagina abajo. suprinyr, etc.).

Por ejemplo, coloque un punto de parada en el procedimieno BuscarFichero
en el lugar que se indicd en la figura anterior. A continuacidn pulse F5 para
ejecutar la aplicacion. escriba un camino en |a ventana de texto y pulse el botgn
Buscar. Observard que la ¢jecucion se detiene donde ha puesto el punto de para-
da. Active la ventana inmediata haciendo clic sobre elly v pregunte por los valo-
res de las variables y propiedades que desee. como se indica en Ia figura si-
guiente.

También es posible asignar vajores. evaluar expresiones y verific: ‘uitados
de procedimientos.
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?Fichero
PACKING.LST

?Conta

2

fForm1.BackColor=Q8Color[2)

?Len(Fichera)

LI

For1=0 Fo List1_ListCount-1: Print List}.List[{): Next
CONSTANT. TXT

OECOMP.DLL

o

La otra forma de imprimir datos en la ventana inmediata era escribiendo en
los Iuoare< apropiados del procedimiento sentencias de la forma.

Jeouo s xint Ficnhero -
Jebuc Zrint Forml.BackCoior

También, si su aplicacidn estd preparada para admitir argumentos en la tinea
de 6rdenes para cuando produzca un fichero ejecutable, para probar desde Visual
Basic como se comporta con estos argumentos, tiene en el mend Run la orden
Modify Command$... que le permite en tiempo de disefio, entrar dichos
a:gulrnentos.

La funcidn Command$ de Visual Basic. precisamente devuelve como resul-

tado|los argumentos enviados. Si esta cadena es nula. no hay argumentos.

CONSIDERACiONES ESPECIALES

)
Cuando se dcpura un programa es importante pensar en las dificultades que nos
puedcn presentgr procedimientos a\LKIIIdOS a algunos sucesos, como lus referen-
tes al ratén o al keclado.

- Por ejemplo, si hace una pausa durante la ¢jecucion de un procedimiento
asqcilado con el suceso MouseDown. suelta el botén del ratdn. realiza las opera-
CIONES que estima convenientes. elc.. cuando continte fa ejecucion. se le presenta-
rd el problema de que la aplicacién asume que el botan del ratén estd todavia pul-
sado! Quiere esto decir. que no se reconocerd un suceso MouseUp hasta que no
pulsé otra vez ¢l botdn del ratén v 1o suche. .

r

smo efecto ocurre con los sucesos KevDown y KeyUp,

[

Técnicas avanzadas

Ficheros indexados

Intercambio dindmico de datos

Comunicaciones

Llamadas a las funciones de la API de Windows



CAPITULO 12

FICHEROS INDEXADOS

INTRODUCCION

Existen tres organizaciones de ficheros bisicas. de cuva vonnbinacion se derivan
multitud de organizaciones posibles. Estas son:

e Secuencial
¢ Aleatoria
e Secuencial indexada

En cada caso, se elegird una u otra en funcion de las caracteristicas de los so-
pories v del modo de acceso requerido.

En cuanto a los tipos de acceso, disiinguimos dos:

o Acceso secuencial
¢ Acceso aleatorio o directo EE— -
fat
Se habla de acceso secuencial cuando se van accediendo posiciones sucesi-
vas. esto es, Lras acceder a la posicidn N s accede a lu posicidn N+11y se habla
de acceso directo cuando se accede directamente a la posicion deseada, sin neee-
sidad de acceder a las posiciones anteriores.

En ¢l Capitulo 8 ya se expusieron los ficheros secucnciales y los ficheros
aleatorios. A continuacion veremos como trabajar con ficheros indexados. Atgu-
nos leneuajes, como por ejemplo COBOL. incorporan este tipo de ficheros. Vi-
sual Basic. lo mismo que Basic. QBasic v QuickBasic, no incluven este tipo de
ficheros por 1o que tiene que ser el usuario el que se los construya. Otra solucion
serfa adyuirir un paquete estindar como. por cjemplo. VB 1SAM o BTRIEVE.
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l
ESTRUCTURA DE UN FICHERO SECUENCIAL INDEXADO

La organizacidn secuencial indexada es un modelo de almacenamicento de datos
que e apoya en una tabla de claves v en un fichero de datos. La wabla de claves
actia como indice del fichero de datos. Un ejemplo tipico de este lipo de almace-
namiento es un libro, va que éste consta de un indice ordenado por nimero de
pagina y ¢l contenido del libro en si. De esta forma. para acceder a una determi-
nada informacion, buscaremos en el indice el nimero de pigina donde se encuen-
tra, )‘ a continuacion iremos direciamente a esa pigina.

|Lus claves de acceso que contiene la 1zhla. generalmente estd clasificada cn
orden ascendente y cada una de eHas se corresponde con un registro del fichero de
datos. Una clave puede ser un eddige de arrfcwlo. un dni. ete.

Ahora bien, para hacer corresponder una clave de la wbla con un registro del
fichero de datos, se precisa convertir ésta en un ntimero gue nos de su posicion
dentro de la tabla y nos permita asi acceder al nimero que tiene el registro dentro
del fichero de datos. Existen diferentes algoritmos para realizar este proceso. En-
tre ellos, los mds wilizados v eficientes son los afgorinnos Hash. También es
verdad, que la organizacion secuencial indexada es un modelo de almacenamiento
que r:m precisa de esta conversion de claves. va que cada una de ellas puede direc-
tamente emparejarse con ¢l primer registro libre del fichero de datos. De hacerlo
asi, en la tabla de claves se almacenarin kas parejas clave. ndniero de registio.
Estajforma de proceder es menos eficiente que la anteriormente citada.

Segdn lo expuesto. para crear un ficheru secuencial indexado se tendrin que
crearydos ficheros, uno con lis claves denominado fichero indice, y otro con hos
datos denominado fichero de dates, Para acceder a un determinado registro del i
cth‘rcl) secuencial indexado. primero se busca la clave en el fichero indice, lo cual
nus propurcionard el ndmero del regisiro que a continuacion Jeeremos en el fiche-
ro de datos. '

Tabla de claves - Fichero de datos
310A77 | 3 REGISTRO 1
| AXM7B | 2 REGISTRO 2
BB{{1A 4 REGISTRO 3
i
T
: CD255X 1 _ REGISTRO 4
|
1
I
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-,

La clave de acceso no Liche por qué ser Unicd. esty ¢s. pard acceder a un
fichero podemos utilizar $i es preciso varias cla\-cs.dc acceso, lo C-lfﬂl requenrd
otras lantas tablas indice. Dicho de otra forma. el nivel de indexacion puesic ser
rambién miltiple. lo que quicre decir que la bisqueda ¢n el indice se efectie por
medio de otro indice (indices jerarquizados o cn drbol).

ALGORITMOS HASH

LLos aleoritmos Hash son métodos de biisqueda. que proporcionan u‘na longitud
de busqueda” pequeiia y una flexibilidad supenor 4 la de otros métodos, como
puede ser. el método de "busqueda binaria” que requicre que los elementos de

la tabla estén ordenados.

Por "longitud de bisqueda” se enticnde el numero de accesos que cs nece-
sario efectuar sobre una tabla para encontrar el elemento deseado.

Esté método de bisqueda penmite. como operaciones badsicas. ademas de la
busqueda de un elemento, insertar un pUEVO elemento (si la tabla estd vacia,
crearla) v eliminar un elemento existeme.

Tablas Hash

Una 1abla producto de 1a aplicacion de un atgoritmo Hash se denomina “tabla
Hash” y son las 1ablas que sc utilizan con mayor frecuencia en los sistemas de
acceso, Graficamente estas tablas tienen la siguiente forma:

CLAVE  CONTENIDO

5040
3721

& -

6375

La tabla se organiza con elementos formados por dos miembros: clave y

“contenido.
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La clave constituve ef medio de acceso a la tabla. Aplicando a la clave una
funcidn de acceso "fu”, previamente definida. obtencmes un nimero entero posi-
tivo "i", que nos da ta posicion del elemento correspondiente. dentro de la tabla.

i = fafclave)

Conociendo la posicion. wenemos acceso af conrenido, El miembro contenide
puede albervar directamente la informacidn, o bien un puntero a dicha informa-
cion, cuando €sta sea muy extensa. '

El acceso, tak cual lo hemos definido. recibe ¢l nombre de "acceso directo”

Como ¢jemplo, suponga que la clave de acceso se comresponde con el nimero
del docwinento nacional de identidad (dn) y que el contenido son los datos co-
rrespondientes a la persona que tiene ese dni. Una funcidn de acceso, i=fafdniy.
que haga corresponder la posicidn del elemento en la tabla con el dni. es inne-
diata:

i=dni

la cual da lugar a un acceso directo. Esta funcion asi definida presenta un incon-
veniente y es que el ndmero de valores posibles de i es demasiado grande para
utilizar una tabfa de este tipo.

Para solucionar este problema. es posible siempre. dada una tabla de longitud
£, erear una "funcion de acceso”. fo. de forma que genere un valor comprendido
entre 0y £, mds cominmente enre /v L,

En este caso'puede suceder que dos 0 mids claves den un misme valor de "i":

o
T

]

i = fufclavey) = falclaves)

El méiodo ‘{ash estd basado en esta téenica; el acceso a la tabla es directo por
“i" y coando se produce wna colision (dos claves diferentes dan un
mismo atmero ") este elemicnto se busea en una zona denominada “drea de
overflow”,

el mimero

Metodo Hash abierto

Este ex uno de los métodes nrds wilizados. Bl aleoritmo para acceder a un ele-
mento de L abla de longitud L, es el siguienie;
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1. Secalculai = falclave). .

2. Sila posicion “i" de la tabla estd libre. se inserta la clave y ¢l contenido, Sino

estd libre y la clave es la misma. error: chave duplicada. Si no estd libre ¥ la
pclave es diferente. incrementamos "i” en una umidad y repetimos ¢l proceso
descrito en este punio

CLAVE CONTENIDO

5040 o

KFPa| 1

2

6383 ———» 4007 : 3
{: 3900 4

= . 5

6

6375 . 7

En la ficura observamos gque quercmos insertar la clave 6383. Supongamos
que aplicando la funcidn de acceso obtenemos un valor de 3, esto es,

i=fuf6383) =3

Como la posicién 3 estd ocupada y 1a clave ¢s diferente, wenemos que incrementar
" y volver de nuevo al punto 2 del algoritno.

I.a "lengitud media de hﬁsque'di“ en una "tabla Hash abierta” viene dada

. AN AR ' [
por la expresion: SR
5,

accesos = (2-kM(2-2k)
stendo k igual al ndmero de elementos existentes en la tabla dividido por L.
Ejemplo:

Si exislen 60 elementos en una tabla de longitud L=100, el nimero medio de
accesos para localizar un elemento seri:

" accesos = (2-60/100042-27600100) = 1.75

En ¢l método de “biisqueda binaria™. ¢l ndmero de accesos viene dado por
logy N, siendo N el nimero de elementos de la tabla.
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)

Para reducir al mdximo ¢l ndmero de colisiones v. como consecuencia, Otra forma alternativa mis normal es orgamizar-una lista encadenada por cada
oblener una “longitud media de hisqueda” baja, es tmponanle elegir bien la postcion de la tabla donde se produzea una colisién.
funcion de acceso. ' NTE

CLAVE  CONTENIDO P

lUna “funcidn de acceso” o "funcién Hash™ bastante utilizada v que propor- 5040 -

uona una distribucién de las claves uniforme y aleatoriaes la” funcmn mitad del
2039 —» ar2y 2039

cuadrado” que dice: "dada una clave €, se eleva al cuadrado ic?) v s2 cogen
bits del medio, siendo 27 <= [,

6383 —» | 4007 | —-———», 5283 ] l_}_

Ejemplo:

Supongamos: I. =256 lo que implican = §

C =623

C2=390625 (0<=C2<=2321)

390623 ) = D00000000000101 1 LLIO101 11100001 5
n bits del medio: 01011111y =93

Cada elemento de esta estructura incorpora un nuevo miembro P, el cual refe-
rencia la lista encadenada de overtiow. '

Eliminacion de elementos

En e! método Hash la eliminacién de un elemento no es tan simple como dejar
vacio dicho elemento, ya que esto da lugar a que los elementos insentados por co-
lisidn no puedan ser accedidos. Por ello se suele utilizar un miembro (campo)
complementario yue sirva para poner una marca de que dicho elemento estd eli-
minado. Esto penmite acceder a otros elementos que dependen de & por colisio-
nes, ya que la clave se conserva v también perimite insertar un nuevo clemento en
esa posicion cuando se dé una aueva colisién.

Owra "funcion de acceso” muy utilizada es 1a “funcién médulo” (resto de
una divisién entera):

[ = clave madule L

Cuando se utilice esta funeidn es importante elegir un nimero primo para L.
con ]a finalidad de que el nimero de colisiones sea pequeio.

Método Hash con overflow PROCESO DE UN FICHERO SECUENCIAL INDEXADO

. N R . i : LfE A " s - H H ‘.' ! OIS N S rl] 3 1 1ot A
Una|alternsiy; ‘nul métado anterior es Ja de disponer de otra tabla separada, para Para crear un fichero .sc.cuuncm]mdﬁxaﬁo, los pasos a seguir son los siguientes:
insertar las claves que producen colision. denominada “tabla de overflow”, en la - -

L o o . . b, Crear el tichero indice.
cual se almacenan todas estas claves de forma consecutiva. -
i 2. Crear el fichero de datos.

I
I CLAVE  CONTENIDO : ) ARRAY DE OVERFLOW . R .
! ' El acceso a los datos de un fichero secuencial indexado debe hacerse siempre

,‘ 5040 0 / 2039 0 en dos pasos; ‘
2039 —» | 3721 § 6383 i

l. Acceso al fichero indice para buscar la clave.

- : 2 2, Acceso directo al fichero de datos.
63831 —» | 4007 3 . i
3500 Tl . ‘ Por ejemplo. crear un ficherv indexado que contenga los datos de cada uno de
‘ ' los libros de nuestra biblioteca particular. Por cada.uno de los Libros vamos a al-
macenar: una clave gue lo identitique. tituto del libro, autor, editwriz’ “~tos sobre
¢l préstamo y un canpo, borrado. gue nos permita identificar un amo eli-




272 VISUAL BASIC. APLICACIONES PARA WINDOWS

minado, pero sin borrarlo fisicamente. Esto permite una velocidad mayor de eje-
cucidn y posibilita en un momento determinado obtener un fichero con los librog
dudos de baja. actualizar el fichcro maestro y reconstruir el indice.

Inicie una nueva aplicacién y cree una forma titulada Bibliotecu con los con-
troles que se indican en la 1abla siguiente. Guarde la aplicacion con el nombre fi-
bros.nak v |a forma con el nombre libros.fim.

Ohjeto ' Propicdad Valor
Mend Fichero Caption &Fichero
CitName MenuFichero
Fichero: orden 0 Caption Ab&rir...
' CtiName FicheroAbrir
Accelerator Cul+R
Fichero: orden | Caption & Guardar como...
CilName FicheroGuardar
Accelerator Cul+G
Fichero: orden 2 Caption &Aiadir Registro
CilName AdadirRey
Accelerator Cirl+A
Fichero: orden 3 Caption &Buscar Registro
’ CdXName BuscarReg
Accelerator Cul+B
Fichero: orden 4 Caption B&orrar Regisiro
- CilName BorrarReg
; Accelerator Cul+O
Fichero: orden 5 Caption &Salir
s CilName Sabir
- w Accelerator Curl+S
Etigueta 1 ! Caption Clave:
b CtIName Labell
Caja de teato ! ' CuNume Clave
Teat {nada)
Etiqueta 2 | Caption Tiwlo:
CuNume Label2
Caja de texto 2 CilName Titulo
Teat {nada)
Enguela 3 Caption Autor:
CilName Label3
Cuja de texto 3 CuName Autor
Text (nada)
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4.

Etiqueta 4 Caption * | Editorial: !
CiName {_abel4

Caja de texto 4 CiName Editonial
Text (nada)

Etiqueta 3 Caption Prestado:
CilName [Label3

Caja de texto 5 CtiName Prestado
Text {nada)
MululLine True
ScrollBars - Vertical

i tidvy .
Clave r

Titulo:

r
Aulor: [
r

E ditarial;

Piestado:

Cada regisiro del fichero de datos conlendra los campos. Clave. Titulo, Autor,
Editorial. Prestado y Borrado. El Lampo Borrado inicialmente tendrd un valor 0
y cuando se marque el registro como borrado, tendrid un valor ~1,

Cada reaistro del fichero indice contendrd dos campos: Clave. la misma que
figura en el fichero de datos y NumReg. mimero de registro del fichero de datos,
donde se guardan los datos correspondientes al libro identificado con esa clave.

Afiada las sivuicntes declaraciones al moduto global v denominelo fibros.bas.

Global Cons:z TRUE = -
Global Cornz: riLSE

e

Type Registro
Clave ks Long
Tivtulo As Suring =

(o)
(A1
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R
£ 11 g

[FTRNEY LRI LR S '] T

ARSURT |

Iag T
Gioz
Gion
Tn{_ nd
ong
|: Integer
znd T,
Gloral Z As TionoPRegInd
Glozzl tatecer ‘longitud
Glonal ol %5 String 'fich

El hecho de almavenar fa clave en el fichero de datos cuando seria suficiente
almacenarla solamente ¢n el Nichero indice. tiene ventajas como la de reconstruir
el fichero indice con muy poco esfuerzo, una vez se hayan eliminado fisicamente
lus|registros marcados como barrados.

Cuando el usuario desee crear un fichero nuevo. primero introducird los dutos
correspondientes a un registro, después ejecutard la orden Adadir Registro del
mend Fichero y asi sucesivamente. Por Ghimo ejecutari Ta orden Grardar como
purlu asignar un nombre al fichero. Esto extge inicializar ks vaniables Ficheref> v
Ficherol a un valor por defecto, operacién que realiza el procedimiento
Fuj'm_l_nud. ‘

n

C;

J

.
TS

'
]
TVt i

m 0

W .
o) .
STty
[1E R 4
iy iy 2% i (b
ol

M
D

La sentencia Al ascgura que inicialmente partamos de una situacion tal-
n;mlnc nuevi. borrandu. si existen. Tos ficheros de datos ¢ indice wtilizados por de-
fecto v denominados Temp.dar ¥ Temp.ind respectivamente. Si el fichero expeci-
ﬁcu!du purit borrar no oxiske, se ejecuta la sentencia Kesienie Next,
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El procedimiento Crearindice inicializa a 0. los campos cline y mimero de
reeistro de cada uno de los registros del fichero indice. También calcula el ndme-
ro de recistros del fichero indice. Por ejemplo. si deseamos tener 1000 regisiros
dtites y una longitud media de bisqueda de 3. aplicando la teorfa retativa al mé-
todo Hash abierto. el fichero indice debe tener L=1000/0.5 registros.

Inicie un nuevo mddulo Namado indice.bas (orden New Module del mend
File) y aiada al mismo ¢l siguiente procedimiento,

Sub Crzazvincdice ()}

Dim I A3 inteqger

‘Crear un fichero indice tars.

'L rzgistros lniciaimente vac

‘oue = pravé sean ocupades 2

I, = 1230 / .8 'longitud mediz = ]

= Siguiente_Primo(L)
Ticherol For Random s =1 L& = Len{=ezind)

mnor
3
]

= 1 170 L

tegind.Clave = 0
2z¢ind.lumReqg = 0
puz =1, I, Reglind
Mexs I
. Close =1
—nd Sub

Por otra parte. vilnos que era imporiante elegir un ndmero prima para L. con

la finalidad de que ¢l nimero de colisiones sea pequeiio. De esto se encarga [a
funcion Siguiente_Primo. Adada este procedimiento al mddulo indice. bas.
Siguiente_Primo (N =5
jmo s Integer,. [,2s I
o = F:RLSE e

: Mod 2 = 0) Therd n'= & = 1
ile Mot Primo
= THUE
= 3 To Sqr(¥) Stes ¢
WoMod I = 0) then =r

sS85 InTeger

i
11}

ay
ot

‘o =

™~

t Primo} Then N = I -
cisnte _Frimo = U
Una vez creado el fichero indice. pasamos a crear el fichero de datos, El acce-

so @ los datos de un fichero secuencial indenado debe hacerse siempre en dos pa-
508:
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1. Se accede al fichero indice para buscar la clave. lo cual. lambién proporciona
ta posicion del registro coirespondiente en del fichero de datos.

2. Seaccede directamente a ¢se registro del fichero de datos.

Acceso al fichero indice
Cuando se accede al fichero indice puede ser por una de las dos causas siguienies:

¢ porque hay que afadir un nueva clave,
¢ 0 porque hay que buscar una determinada clave,

Para afiadir una nueva clave invocaremos a 1a funcidn Hashin que se describe
a continuacion. Esta funcién devuelve un | si se afadié la clave. un 2 st fa clave
ya existe, y un 3 si el fichero indice estd lleno. El desarrollo de la misma, se ha
hecho aplicando los conceptos tedricos explicados anterfiormente para ¢l método
Hash abierto. Aiada este procedimiento at médulo indice. bas.

Function Hashin (Zz¢
Dim T 23 Long, Conca - , :
Dim Reg As Tipcregingé 'ragisiro acizal
Conta

1 ‘'‘conteécor

= FaL3E

(ot Ingercac

I, Reg
{(Reg.Clave = 0) Thenr 'el_szznto librz
42, I, rzgt
sertado = T3
EdshIn = 1 ‘'se @ [
Els2if JRegIng.Clzre

0 M

MsgB&x "Err
insertado =

n

o

5

1]

b
oo

End Function
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-

Puesto que Reglnd se ha definido en ¢l madulo global, o seria necesany gue
esta funcién recibiera este valor como parimetro. Simplemente se ha espedifivado
para dar una vision mds clara de To que s¢ estd huctcm‘]u.

Para buscar una clave invocaremos a la funcion HashOur que se describe a
continuacién. Esta funcién devuelve el nimero de registro del fichero de datos
correspondiente a esa clave, o un 0 si la clave no existe. El desarrol_lo de la
misma. ¢ ha hecho aplicando los conceptos tedricos explicados anl.cnurmemc
para el método Hash abierto. Anada este procedimicnto al modulo fdice. bas.

1zz-Cut (Clave As Long) ~s Inzeger

icnz, Conta As Integer, Frcontrada AS irteger
TipoRegInd 'registro actual

7 Thnen Exit Function

‘contador

= TALSE

cinter = 11

= D

. f

b

_én(?eqfnd)

RN

Q- ®
1]

ca oo 1)
1, Reg

Clave = Clave) Then ‘'clavs
- = Reg.NumReg

rada = TRUZ

-0 estd o sestd mas adelarze
- 1 *'siguiente registro

= Conta + 1

= i) Then I =1

(i
'
i
o
3
[
v
W
o8
B

HH
o

[

Y ol
-0 M AL

e o= O 03 O

RPN th
o
o~ T

.ty vt 1y

[}

L} Then . ) )

tor: o existe un dibro con esa clave”, 48, "Libres”
Ty rl

0 Lo

WMo-eePolnter = 0 'restaurar punierc

i

Observe que para aplicar la funcion de acceso Mod necesitamos utilizar un
valor numérico. Esto no guiere decir que la clave tenga que ser numérica. como
sucede en nuestro ejemplo, sino gque puede ser altanumérica. Cuando se trabaje
con claves alfanuméricas o alfabélicas, por ejemplo Titulo. antes de aplicar la
funcion de dcceso es pecesario convertir dicha clave en un valor numérico, utili-
zando un algoriuno adecuado.
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i

[Para utilizar estas funciones en otras aplicaciones. tiene que cargar el médulo
indice.bas wilizando la orden Add File del meni File v definir en ef médulo elo-
bal el registro Regind. i

‘ rEgr W
Supongamos ahora que ¢l usuario va a érear un fichero nuevo. Una vez arran-
cada la aplicacion. imroducird los datos commespondientes-a un registro, a conti-
nuacion ejecutard la orden Aiiadir Registro del meni Fichero y asi sucesivamente
hasta finalizar la entrada. Para realizar el proceso de anadir un registro, abra la
\'emaqa de cédigo correspondiente a esia orden y escriba el siguiente procedi-
miento. '

Sub AfacdirbPeg Ci:
Di@ NumRecs s
RegInd.Clavs
Libros.Clave 2
Libros.Tituio =
Lipros.Autor = LIew
Lipros.EdiCOria E i ial.Text
Libros. Prestaco :
Lipros.Borrado
Opqn Ficherob =
NumRegs = LOF{:
RegInd.NumpPee

]

[ | [ I
N o~

SO m

VI |= Hashin (it
lf|vr = 3 Then Ind icn indi lleno
If ¥ = 1 Then ]
Put #1, lNumfegs - 1, Liprcs
End If
Close #1 '
Znd Sub

Cudla nuevo registro introducido es afadido al final del fichero de dutos. Para
ello, este procedimiento acepia tos datos del nuevo registro, caleula el nimero
wtal de ‘registrbs‘ ¢ tiene dicho fichero. NmRegs. v llama a 1a funcion Hashin
para afiadir at fichero indice. si es posible. la clave y la posicion, NumRegs+1.
que el registro om:\p'arzi en el fichero de datos. |

Para obligar a que Ja clave sea un valor numérico. abra la ventana de cadigo
correspondiente a la caja de texto Clave y eseriba el procedimiento
Clave_KevPress, asociado con la caja de texto Clave y conducido por el suceso

KeyPress, como se indica a continuacidn.

Sub Cf:]iave__}\’eyl‘]:c-ss trerAscil f: Inzzcer)
Dim Car As sir
Car |:
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“"G* Or Car » "¢*: 13 Csr <> Chrs(3) Tre:n
'pitido .
= { 'Dorrvar czricter

Finahizado el proceso de entrada de datos. tenemos que guardar f"l fichero,
Para realizar esta operacion cree una nueva forma titulada Guam'a.r F fr’hero con
los controles que se indican en la tabla siguiente. Guarde la aplicacion con el
nombre fibros.mak y |a forma con el nombre grardarl_frmn.

Objeto : Propiedad . Valor

Forma -| Caption Guardar Fichero
FormNae L GuardarF

Etiqueta Caption Guardar el fichero como:
CuName [Lahell

Caja de texto Cilivame NombreFg
Text (nada)

Boton 1 Caption Aceplar
CuName Aceprar

Botén 2 Caption Cancelar
CdName Cancelar

I

Gt_mrdat el fichero coma: | Aceptas I

’Iibm:.dat . } oot
P

N

Cuando el usuario pulse la orden Guardar como det meni Fichere se visuali-
zard esta forma. Abra la ventana de codigo correspondiente a la orden Guardar
como del mena Fichero y escriba el siguiente codigo.

Sub FicheroGuardar_Click ()
siardarf. Show o
rdarf.Nembrefg.Text = Ficherod

Este procedimiento visualiza la forma vy pone en la caja de texto el nombre
actual del tichero con el que estamos rabajando. $i es nuevo aparecerd Temypr.dur.
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a

. A continuacién, el usvario escnbird et nombre del fichero en la caja de texio
(si es necesario, puede especificas ¢l camino completo) y pulsarid ¢l botén Acepiar
par.a’guardar el fichero con ¢l nombre especificado o Cancelar pura anular la ope-
racién. : ‘fichere no encentraco

Abra la ventana de cédigo correspondiente a la orden Aceprar v escribs enerer 85 TR
g s Aceptar v escriba ¢l
codigo que se muestra a cominuacién. .

Sub ‘ceptar Clicx ()
Dim I As Integer, C = Irg, Nororel 13 Zorin
On Error GoTo Rugis y .
llame FicheroD s
Name Ficherol s

Este procedimicnto primero compone el nombre del fichero indice con el
mismo nombre base que el fichero de datos y extension .ind. Después comprueba
si el fichero especificado existe. en cuyo caso se lo notifica al usuario. A conti-
nuacion. se utiliza la sentencia Name para asignar los nuevos nombres a los fi-

*Componer el nombhre indice
I = InStr{Len{lombre Vorhrerg. Texz, *.") cheros. Recuerde que cuando se trata de un fichero nuevo, los nombres asignados
If}\,ém;ze? ThEths Ciosrratc. - sx- o . iniciulmc_me son Tmrfp.t{a! v Temp.ind. Por dltimo. se enfoca la caja de tento
Elvse. = Yomorafe.TsxT, I} o+ “ind NombreFy para una siguiente entrada y se oculta fa forma.
Hombrel = Hombrefg.,_ sz = =.I-d"
End If T o Ahora abra la ventana de codigo comespondiente a la orden Cancelar v es-
'Verificar si el fice Az iz-53 ewisre criba el cadigo que se muesira a continuacion.
Open HombreFy . Text ~or 3 = Len(Libres)
If (LOF(1) <> O} Sub Cerncelar_Click {}
Cadena. = "El fic: - Chr3{i3) + Chr3(id) Hombrery . Te:
Cadena = Cadena =+ rrescrinirio?n Nombreryg. &
IT MsgBox{Cadena, i ="} = 5 Then Guarcarf.H
Kill Nombrel ‘borrer fichzro Indice correspeoniience Formi.Cl
Else End-Sub
.Closé #1 Lo
E.‘grlnlsrg‘ig SeLrogus Cuando ¢l usuario quicra \'isuali'zar'!_os datos correspondientes a un dclenn_i-.
end 1F . nado libro, liene que escribir ta clave en la caja de texto Clave y a conlinuacion
End If - ejecutar la orden Buscar Registro del meni Fichero. Para rekalizar ¢sle proceso,
A ";i “abra la ventana de cadigo correspontilicn;‘é a esta orden y.escriba el ¢odigo que se
Close #1 ° ‘ muestra a continuacion. ' :
Kill Nom?Fng.Tex: ‘horrar f}ciaro ca datos
sub ZuscarPez_Clicx ()
'Huevo nombre parz Sighar Dim wr AS 1o
ch.me "Temp._d_" . inmnrato. : yr = Jisua
FicheroD = NoxbreTFg.Tex:z 'muzw: de daccs creado End Sub
Hueve nombre par Toener Para visualizar en la forma Form/ los datos correspondientes a un determing-

Name “"Temp._1i_"

Ficherol = No-bre g fieraeg Irdice do registro del fichero de datos. este procedimiento Ilgmm‘a la func?dn Visualizar-

Registro que se muestra a continuacion, IPara crear esta Tuncidn ejecute 1a orden
‘Ocultar la forso . r T New Procedure del menti Code v escriba el cédigo mostrado a continuacion.
lombreFg.Text = ** -

HombhreFyg. SelFfocus
_GuardarfF.Hide

-zzcistro {)} A Integer
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o
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Ilisw funcion invoca a la funcion HashOus para obtener 1a posicion del regis-
tro en el fichero de dwos que tiene la clave especificada. A continuacidn, ltee ¢l
registro v lo visualiza. Fambién, si el registro estd marcado como borrado envia
un mensaje notificdndolo. La funcion ViswalizarRegistro devuelve el ninero del

N S . -
registro visualizado, o un 0 51 la clave especificada no se encuentra,
-1

Cuando ¢l usuario quiera borrar un determinado fegistro. tiene que escribir la
clave en la _caj:j‘d:: texto Clave v a continuacion ejecutar [a orden Borrur Registro
del mend Fr'(h_é'm. Entonces. si la clave existe. se presenta e registro sobre Ta
forma Fnrm!‘_\'.’ﬂsc visualiza la siguiente caja de didlogo.

Q iEsta seguro que quiere borrarle?

§i ‘ No

T‘}i <l wsuario pulsa el bowdn Si. la tuncidn MsgBox que da lugar a esta caja

deve 7 s el valor 6 (v el valor 7 s se pulsa Mo en cuvo caso. o) regisiro especifi-
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ra

cado se marca como bomrado. Para ello. se lee el registro. se asigna el valor -t a
su campa Borrado. v se vuelve a escribir en fa misma posicion.

Abra la ventana de codigo correspondiente a la orden Borrar Registro del
menti Fichero y escriba ¢l cédicomosirado en el sivniente procedimicnto.

Sub Borr Digkou
Dim Ca gorirz, 1T &5 Integer
1= 71 -zasizizol)
If i« _ ]
Cecena 41T0 gue gulers soryarlo?"
If ¥scB , 34, "bLivbros"} = & Tren .
Gseg T-»- Zarndcom 23 fr Len = Len(Libros)
net x5
11.".) 2:—1
UL o=t
Clo
Eng I
Eng T§
End Sun

Cuando se ejecuts la orden Abrir aparecerd la cijat de didlogo (que se muestra
en la sieuiente ficura. Para ello. abra la ventana de cadigo correspondiente a la
ovden Abrir v escriba el cddigo que s¢ muestra a conitnuacion.

Sub Fichercinrir CLigk ()
SistemaF.5ncw
End Sub

e o et o A

Ficheios: Dir_eclo::io:; .
BV l Aceptar I
= vb s
1= samples ‘ Cancelar l

Unidades:

[=Je: IsTACVOL_DSK] | ¢

Como ¢l disciio de esta misma caja va fue explicado en el Cupitulo 8
“Ficheros de datos™. no vamos a volverlo a hacer agui. Simplemente. por como-
didad para usted mostrareios los procedimientos impli.cados en el discﬁu. de d|
cha caja. También. si usted va dispone de este fichero frm (en nue aplicacion
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se denomina sistdefl frm) puede anadirlo a esta aplicacidn v realizar las modifi-
caciones que necesite en funcion del codigo que a continuacion se deialla.

Si desea visualizar sélo los ficheros de la lisia de ficheros Filed con una de-
terminada extension, por cjemplo *.det, ponga la propiedad Pattern a ese valor.

Afada las siguientes dectaraciones a la seccién de declaraciones de la forma
Sistemna de Ficheros, '

Cecnsg T.JC_EW_DIR = 1, CLIC_EN_F-.=2 = &
Sim UltimoCambio ns Integer
Sim Tewts 4s String

Afada el siguiente codigo al procedimiento Drivel_Change de la forma Sis-
tema de Ficheros.

I_Change (}
GoTo Driver
= Drivel.Drive

(¥

., "Zil-or"

R

¥ "Zrror: unidad no prepzarzca”, -«

tiy
b
I$3

Afiada ¢l siguiente codigo al procedimiento Dir] Click de 1a forma Sistema
de Ficheros.

= CLIC_EN_DIR

Aiada el sighiente cddigo al procedimiento Filel_Click de la forma Sistema
de Ficheros. '

Suh Fli=d Ci].ick ()
mibio = CLIC_EN_FILE

Anada el siguiente cédigo al procedimiemo Aceprar_Click de la jorma Sisre-

" m de Ficheros.

S ~C
Tim l:

—ar_Clicx ()
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Select Case UltizeCambio .
Cage CLIC_EZN_DIZ . )
Dirl.2ath = Dirl.Lisc{Diri.c:
Case CLIC_®EN_Tilz
If (RighiS{Dir_.2ath, 1)
Ficherold = Diri.Path +
Else
Ficherob
End 1% o
Ficherol = iefts(Ficherob, Len(Ficherod) - 3) + "ina”
Sistemar.Hice
End Selec:
End Sub

¥
1"

.earth -+ "\" - Filel.rfileName

n
)
|-
i
o

Este procedimiento compone el nombre del fichero indice a partir del nombre
del fichero de datos sin extensién. El fichero indice tiene el mismo nombre base
que ¢l fichero de datos y extension .ind.

Afiada el siguiente cédigo al procedimiento Cancelar_Click de Ta forma Sis-
tema de Ficheros.

Sub Cancelar_Click {) .
SistemaF.Hide
Engd Sub

_ Cuando ¢} usuario quiera finalizar la aplicacién ejecutard la orden Salir del
ment Fichero. Abra Ja ventana de cédigo correspondiente a esta orden y escriba
el codigo que se muestra a continuacion.

Sub Salir_Click (}
End
End Sub o -

. Rl
L

L PN . L .
Guarde l1a aplicacién y ejectitela. La razon de esta aplicacién es simplemente
que usted tenga una base de conocimientos para trabajar con ficheros indexados.

IMPRESION DE RESULTADOS

En muchas ocasiones necesitard obtener resultados impresos. La forma mis
comoda de realizar esta operacion es utilizando el objeto Printer. Su sintaxis es,

Printer.propiedad [= expresion]
Printeranéteni i
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|

| El objeto Printer es utilizado para controlar ¢l texto y los grificos que se

lmpnmen en una pdgina y para enviarlos directamente a la impresora por defecto.

Conlesle objetivo, Printer tiene asociados varias propiedades y vanios métodos -

.que usted podra ver con detalle en la ayuda suministrada por Visual Basic. Las
tablas siguientes mucstran algunas de las propiedades v métodos mas psuales.

Propiedad Descripcidn

Curl'ent.\' Pone o retorna la coordenada X.

Cur%’em\' Pone o retorna la coordenada Y. .

FontSize Pone o retorna el 1amano de la fuente wilizada para imprimir
el texto.

Fontestilo Determina el estilo de la fueme (Bold. Italic. Strikethru,

. Transparent, Underline) -

ScaleMode Pone o retorna las unidades para un sistema de coordenadas.
Por ejemplo: t — Twips (valor por defecto). 2 — Puntos, 3 -
Pixels. 4 — Caracteres. -

ScaleWidth Pone o retorna el ancho del ¢je horizomal del sistema de
coordenadas de un determinado objeto.

Método Descripcion

Prinl‘l Escribe un expresion numérica o alfanumérica.

NewPage Finaliza la pdgina actual y avanza a una nueva pdging.

EndDoc Finaliza un documento enviado 2 la impresora. descargdn-

dolo en dicho dispositivo o en fa coli de impresidn. Si se
invoca EndDoc  inmediatamente  después  del  método
Newl’age. entonces no se afade una pdgina en blanco.

Ciomo qjemplo afiada al mend Fichero. la orden titulada fmprimir Fichero y
de nombre Imp*fum Cuando el usuario ¢jecute esta orden se realizara un listado
por la impresora de todos los registros que no estén borrados. impnmiendo por

:lda uno de ell

los campos Clave, Titndo v Editorial. Para ello. abra [a ventana

de COdl°0 correspondiente a esta orden y escriba el procedimiento que se muestra

a commuat ion.

icherod For

Imir_Click () )

imir los registros del fichero de datos
is] estén marcados como morrados

AS Suring

Jegs A3 Incs I 25 Enteger,
"Listaco de iikros"

T icn As =1 Len = Len(lLinrcs)
.Scalelonde = ¢ ‘raracieres
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- HewPage 'nu
r.Fonusize =
r.Currentx =
r.Current¥ =

ontBold =
.fentUnderts
.Print Cabl
.FonrUnderli
.Fonc3old
.FontSize =

Toen punios
ian(Capl) \ 2

ryoEg e

b4

—zoy ira v subrayada

oty

H

R TGS IRV RIS I RV AV I

nJ
SE AT T

Q@mwomoo
~

reglstros

=
oy

et}
C

[t R I 4 Tl E R S O O 4 O

i1, , Libhros
not Libfos Bor:ado T:e:

hADrOS iL
Tanh(50); s.=zédlzortal
Eagd If
Hex:
Close &1
Printer. FncDoc ‘finaliza cocumenzo )
End aub
V"" j"



CAPITULO 13

INTERCAMBIO DINAMICO DE
DATOS

INTRODUCCION

£! intercambio dindmica de dat. (Dynamic data exchange, abreviadamente
DDE) es un mecanismo soportado por Visual Basic que permite que una aplica-
cién hable continuamente con otra para intercambiarse datos automilicamente.
DDE automatiza el intercambio manual entre aplicaciones que se realiza a traveés
del porapapeles. No todas las aplicaciones soportan- DDE.

Por ejemplo. utilizando, DDE ¢l procesador de textos Word pura Windows
puede hablar con Iz hoja de cilculo Excel para Windows. Esto permitied por
ejemplo, que una hoja de cileulo importada desde Fxeel a nuestro documento €n
Word. se modifigue automdticamente cuando en la hoja de cidlculo realicemos
cualquier vanacion. R

COMO TRABAJA EL DDE ;' )

Lon
Un DDE ¢s similar a una conversacién entre dos personas. La aplicacidn que ini-
cia la conversacidn se denomina cliente; 1a aplicacion que responde a su cliente s¢
denomina servidor. Una aplicacion puede estar ocupadil en varias conversaciones
simultdneaniente. actuando en unas como cliente v en vtras como servidor.,
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t En Visual Basic pueden actuar como cliente. |as cajas de texto, las cajas de
nnaﬂcn y las etiquetas. mientras que como servidor salo pueden acwar las for-
mas.

- Cuando un cliente inicia una conversacion DDE. debe especificar dos cosas:

» Elnombre del servidor con el que quiere hablar (aplicacion que responde).
s« Eltema de 'a conversacion (daios a intercambiar).

Cuando un servidor recibe una peticidn de conversacion referente a un tema.
la reconoce y en caso afirmativo inicia 1a conversacidn. En general, es el servidor
el que envia datos al clente.

C;Ind;l aplicacion que puede actuar como servidor tiene un tinico nombre que
n()rm’almcnlc coincide con el nombre del fichero ejecutable sin extension. Por
ejemplo, Excel, WinWord. Si el servidor es una aplicacion Visual Basic. su
nombre es el dado al fichero ejecutable correspondiente a la misma, Para otras
aplic'aciunes Windows vea la documentacion comespondiente a fa misma.

FTI tema de conversacion se¢ corresponde con la unidad de datos reconocida
por ¢l servidor. Por ejemplo. Excel reconoce ficheros con extension .XLS o

)\LC mientras que WinWord reconove ficheros con extension .DOC. Cuando el -

serv ulm de una conversacion es una forma correspondiente a una aplicacién Vi-
sual Basnc, ¢l lema queda especificado por la propiedud Link Topic.

Durante unid conversacion se intercambian elementos de datos pentenecientes

a un|tema. Por'éjemp]u Excel reconoce celdas referenciadas por su linea (L) y

columna (C) tal come L1C L. Cuando el cliente de una conversacion es un control

de una |p!|cacmn Visua! Basic. ¢l elemenio de datos que se pasa durante la con-

\ers.‘ir.:(m ghedy L\ptczﬁcado por la propiedad LinkItem. Cuando el sernvidor de

una Lon\'crsac;on es una forna correspondiente a una aplicacion Visual Basic, cl

. elemento de da[ps que se pasa durante la conversacion cs el nombre de una caja
de texto, de undetiqueta. 0 de una caja de imagen. perteneciente a la forma.

Una conversacion DDE constituve un enlace entre Tas dos aplicaciones que
II1HI]I;CHCn la conversacién. Hay dus fonmas dz establecer un enlace entre aplica-
ciones: '

_ Elemento Jde »
Servidor Cheate
datos .

Envia datos Revibe dutos
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o Enlace frio. E servidor suministra nuevos datos solamente cuando el cliente

lo requicre. Para realizar esta peticidn y asi actualizar los datos. serd necesario -

wtilizar ¢! método LinkRequest. Exste tipo de enlace no puede establecerse en
tiempo de disedio.

o Enlace calionte. El servidor suministra nuevos datos al cliente cada vez que
el elemento de datos definido por la propiedad LinkItem cambia.

En una aplicacién Visual Basic. el tipo de enlace para un objeto queda espe-
cificado por la propiedad LinkMode. Para un control utilizado como cliente. el
valor de esta propiedad puede ser: 0. no hay enlace {es el valor por defecto): 1.
enlace caliene; 2. enlace frio. Para una forma utilizada como senvidor el valor de
esta propiedad puede ser: 0. no hay enface: 1. servides fus el valor por defecto).

CREAR UN ENLACE EN TIEMPO DE DISENO

Durante ¢! disefio de una aplicacion es posible establecer enlaces entre ésta apli-
cacién v otras apticaciones que soporten DDE. Estos enfuces son guardados en las
propiedades Link de las formas y de los controles de la aplicucion. Dichos enla-
ces serin establecidos automdticamente siempre que la aplicacion se ejecute.

Aplicacion Visual Basic como cliente

Cuando quiera que su aplicacion Visual Basic reciba datos de oira aplicacidn.
liene que establecer un enlace definiendo su aplicacion como cliente y la otra
como senador. :

.

Como ¢jemplo. vamos a e~lab!t.tqr un enlace caliente entre ta aplicacién
WinWord (servidor) y uma aphcamun Visual Basic que depominaremos
DdeWinW (cliente).

Inicie una nueva aplicacion v cree una forma tiwlada Cliente con los contro-
les que se indican en la tbla siguiente. Guarde la aplicacidn con el nombre
DdeWinW.mak y la forina con el nombre DdeWinW.frm.

Los valores de las propiedades Link de la caju de texio de 1a abla siguiente,

son los valores por defecto. Los valores necesarios para realizar ¢l enface caliente
con el servidor, serdn puestos autonkiticamente por Visual Basic cuando se cree
dicho enlace.
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Objeto | Propiedad : Vator
Forma | FormName Forml
' ! Caption Cliente
Caja de texto fCuName Cliemte
' Linkltem (nuda)
; LinkMode -1 O (ninguno}
! LinkTimeout Y]
{ Link Topic “{ tnada)
i Text (nada)

La propicdad LinkTimeoul determina la cantidad de tiempo que un control
{cliente) espera para establecer a conversacion con el servidor. Se midg en déei-
mas de segundo y el valor por defecto es 30. Si el tiempo de respuesta del servi-
dor supera este valor, se genera un mensaje de error. Un valor de -1 significy
esperar indetinidamente. En este caso. podemos finalizar la espera pul\dndﬂ fa te-

cla At
g &E

FHay establecido un enlace con la aplicac ‘

A cnnlmudﬂon ejecute la aplicacion Word para Windows (WinWord). cree
un dowmunoi asignele el nombre midocu.doc.

! Edlt -V'cw

.

Table W'nduw Help:

3 t & Cin la zphcaciin WinWerd,
Ei rul:l’r E5 0 z].rfh‘*

{Pg 1~ Sec i 71 TAt3cm  Ln2 Cd 23 | 10

————— ey
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Para crear un enlace caliente entre una aplicacion Visual Basic como cliente v
otra aplicacion como servidor, en este caso entre DdeWinW y WinWord, ejecute
los siguientes pasos:

I Scleccione en Ta otra aplidacion, los datos con los que quiere establecer el
enlace. En el ejemplo. seleccione tado ¢} documento midocu.doc o una pang
del misimo.

=)

Ejecute 1a orden Copy (Copiar) del mend Edit (Edicin) de la otra aplica-
¢idn. para copiar en el portapapeles fos datos seleccionados.

3. Ahbora dirfjase a la aplicacion Visual Basic (cliente) y scleccione el control
que va a recibic fos datos. En el ejemplo. la caja de texto Cliente.

1. Ejecute T orden Paste Link del meni Edit de Visual Basic.

Observard que en la caja de texto. aparece el texto scleccivnado. Esto quiere
decir que ¢l enluce estd establecido, Vaya al procesador de textos v moditique ¢l
texto. Vuelva i la aplicacion de Visual Basic y observe como los cambios se han
efectuado. Recuerde que esto es un enlace caliente.

El enlace estab! o es guardado con ki forma y es permanente. Por lo tanto,
siempre que abra la apheacion. tanto en tiempo de disefio como en tiempo de ¢je-
cucion. ésta intentard restablecer fa conversacion con el servidor. Si no hay una
aplivacién que reconozca el tema de conversacion. Visual Basic viswalizard un
mensaje indiciandolo.

Ahora verifique las propiedades de la caja de texto descritas anteriormente.
Observard que sus valores han sido.cambiados por ¢l hecho d(, crear ¢l enlace.
Estos valeres se presentan en la [dbld siguiente.

s

N

Caja de texto CilName + " Cliente

Linkltem DDE_LINK1

LinkMode | - Hot

LinkTimeout 50

LinkTopic WinWordl . \MIDOCU.DOC
Text {nada)

Analizando tos valores de las propicdades deducimos que Ta caja de teato es
un cliente que tiene f.“-!dh'u.ldl) un enlace caliente (LinkMode) piara conversar
sobre ¢l tema MIDOCU.DOC con el servidor WinWord (LinkTopic). El ele.
mento de datos wtilizado por el servidor para enviar los dates es DDE_LINKI.
Este nombre referencia el teato seleccionado.
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Aplicacion Visual Basic como servidor

Cuando quicra que su aplicacion Visual Basic envie datos a oira aplicacion, tiene
que esmb!cccr un enlace definiendo su aplicacién como servidor v la otra como
clunte

‘ Como ¢jemplo, vamos a establecer un enlace caliente entre la hoja de cileulo
Excel (cliente) y una aplicacién Visual Basic que denominaremos DideExcel
(servidor).

Inicie una nueva aplicacion y cree una forma titulada Servidor con los contro-
les que se indican en la tabla siguiente, Guarde la aplicacin con el nombre Dde-
U
Excel.niak v 1a forma con el nombre DdeExcel frm.

Los valores de las propiedades Link de la forma de la tabla siguiente. son los
valores por defecto,

O'bj(:?lo Propiedad Valar
Forma ’ FonnName ’ Forml
- Capuion | Servidor
LinkMode I - Server
LinkTopic Form1
Caja de texto CtIName | Textl
. Text 1 Midawo

lHi dato

l

' A continuacion ejecute la aplicacion Excel para Windows.

.
"
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{—] - -
Nommal b4
- Al
A B C D
1 b1 dato
2
Listo * NUM

Para crear un enlace entre su aplicacion Visual Basic como servidor y otra
aplicacion como cliente. en este casv entre Defebyeel y Excel, ejecute los siguien-
1e5 pasos;

1. Dirfjase a su aplicacion Visual Basic (servidor) y seleccione el control que
contieng lus datos que quiere enviar. En el ejemplo, seleccione el control
Textl.

(]

Ejecute la orden Copy del memi Edit de Visual Basic, para copiar ¢n ¢l por-
tapapeles los datos seleccionados.

3. Cambie a fa otra aplicacidn {cliente) y seleccione el destino de lus dutos. En
el ejemplo. seleccione la celda A/ de la hoja de cileulo Excel.

4. Ejecute la orden Paste Link (Pegar vinculos) del menit Edit (Edicidn) de la
otra apl_icuci(’)n. En el ejemplo, dc la hoju de cilculo Excel.

Observard que en la celda AJ C]E“ldﬂ aparece ¢l contenidy de Ta caja de texto.
Esto quiere decir gue ¢l enlace esla.esl.iblecndo Vayaa la aphcmlon Visual Ba-
sic, elija 1a propiedad Text de la c.lj.l dé texto y modifique su contenido. Observe
como los cambios se hacen también en la hoja de cdleulo.

El enlace establecido es guardado con la forma y es permanente. Sin em-
bargo, cuando ejecute la aplicacidn, Visual Basic tiene que romper ¢l enlace para
pasar de tiempo de disenio a iempo de ejecucion. Algunas aplicaciones son capa-

ces de restablecer awtomiticamente sus conversaciones DDE, pero hay otras que

no. Estas aplicaciones que soportan DDE pero que no son capaces de restablecer
sus conversaciones automdticamente, proveen alguna forma manual de restablecer
dichas conversaciones, Para tener avceso a esta informacion. consuhte la docu-
mentacion de esa aplicaciin,
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Por ejemplo, ejecute la aplicacion DdeExcel gque acabamos de desarmollar y
madifique el contenido de la caja de texto. Observe que dichas modificaciones no
se reflejan en la hoja de cdleulo. Quiere esto decir que el enlace no se ha resta-
blecido. Dirijase a 1a hoja de cilculo v proceda a restablecerlo manualmente eje-
cutando la orden Paste Link (Pegar vinculos) del mend Edit (Edicion).

Si en lugar de realizar el ejemplo con Excel lo realiza con Word le ocurrird
fo mismo. En este caso para restablecer el enlace con el servidor tendra que ejecu-
tar la orden Links (Vinculos) det mend Edit (Edicidn).

Ahora veriique las propiedades de 1a caja de texto descritas anterionmente.
Observard que sus valores no se han modificado. Estos valores se presentan en la
tabla siguiente.

Forma FormName Formi
Caption Servidor
LinkMode I - Server
LinkTopic Forml

Analizando los valores de las propiedades v la expresion asignada a ta celda
Al =DDEEXCEL Formi!Text]}, deducimos que 1a hoja de cdiculo es un cliente
gue tiene establecido un enlace caliente para conversar sobre ¢l tema
Formd ' Texti con el servidor DDEEXCEL. que es la aplicacion Visual Basic que
contiene la forma Form . El elemento de datos s Tv.wi.

CREAR UN ENLACE EN TIEMPO DE EJECUCION

Hemos v 1slo,qub muchas aplicaciones que soporian DDE proveen una forma es-
tindar para qué ¥ usuario pucda establecer una conversacion DDE sin escribir
_eadigo. Por ejemnplo, Visual Basic permite haver esto con las ordenes Copy y
Paste Link del fienid Edit. También. como vanos a ver a continuacion. es posi-
ble establecer un enface entre dus aplicaciones. escribiendo cddigo. En este caso
el enlace puede ser caliente v frio.

Aplicacién Visual Basic como cliente

Cuando guiera que su aplicacién Visual Basic reciba datos de otra aplicacion. tie-
e que establecer un enlace definiendo su aplicacian conwi clierte v 1a otra como
servidor.

« \Plﬂllll I\”Rl \\'Hl')[!l\ \\H((ll)l |I\HI\ A}

Como ejemplo. vamos a establecer un enlace valiente entre fa aplicacion Ex-
cel (servidor) y una aplicacion Visual Basic que deaominaremos Dde0t {cliente),

Inicie una nueva aplicacitn v cree una fonna tintada Clienze con los contro-

les que se mdican en la tablif siguiente. Guarde la aplicacion con el nombre

Dt nak v 1a forma con ¢l nombre Dded frm.

Objeto Propiedad Valor

Mend Caption &Edicion
CilName Fdi

Meni: orden | Caption &Vinculo
CiName EduVinculo

Mend: orden 2 Caption &Saliv

‘ CtName EditSulir

Forma FormXName Form!
Caption Cliente

Caja de texto CuName Cliene
Teat (nada)

=

Edu:mn

En primer lugar cargue el fichero CONSTANT.TXT en el médulo global. va
que cn €t estdn detinidis constantes como NONE. HOT. cte., que vamos a utifizar
en nuestea aplicacion. Abra la ventana de codigo para el modulo Glohal bas v
gjecute o orden Load Text del mend Code: escriba el nombre | dwbconstantaat
vy pulse el butén Replace.

Cuando ¢l usuario haga clic en Taorden Vinerdo del mena Edicion de nuestra
aplicacion. se generard un suceso Click. La respuesti a este suceso vit g ser esta-
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blccelr un enlace caliente entre el servidor Excel v el cliente Tearf, Los datos se-
rin enviados desde 1a celda L1C1 (A1) de Excel a la caja de texto Texi].

T — 5 ¥

Bara crear ¢l enlace hay que poner las propiedades Link del cliente Text/! a
los valores que se indican a continuacién:

. Imcuﬂmcme 1a propiedad LinkMode de Teur! se pone a cero {I\O\Fl con el
fin de romper cualquier enlace exisiente.

* A continuacidn, se¢ asigna un valor de la forma “aplicacion _servidorltema” a
la propiedad LinkTopic de Text/ (el cardcter | es el ASCIl [24): el nombre
del fichero ejecutable de la apficacidn que wabaja como servidor es Excel y
el 1ema es un fichero correspondiente a la hoja de cdlculo desde la cual se van
a enviar los datos; supongamos que s¢ denomina Hojal,

*  Después, niédiantc ta propiedad LinkItem se especitica el clememo de datos.
LIC (Al)* utilizado para la wransferencia.

* Y por tiltimo, LOHOCIdOS el servidor. el tema de conversacion y el elemento de
Jatos, se eglablece un enlace caliente,

. Estas operaciones son las que tiene que realizar el procedimiemo EdirVincu-
lo _Click que se presenta a continuacion.

i

Su‘b| EditVinculo_Click
Tle;ctl Linkicde = 1104Z
LexLl LinkTonic =
Text‘.l LinkIcerm

:ex\_ 1.LinkMode

13
3
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La-orden Safir finaliza la aplicacién. El procedimiento correspondiente s
presenta a cominuacion:
Sub ECi

End
End Sub

vSelir_Clicx

Guarde 1a aplicacion Ddeftl.mak y asegirese que tiene cargado el fichero
Hojal en la aplicacion Excel. Ponga en marcha su aplicacién y ejecute la orden
Vinculo del meni Edicion de la misma. Cuando se establezca el entace entre am-
has aplicaciones. observard que el dato de la celda AT aparece en la caja de texto
Text!. Ahora. cualguier variacion que real:cc en la celda Al se reflejard en ta caja
de texto Texr/.

Una vez estahlecido ¢l enlace. puede cambiar si quiere el elemento de datos
especificado por la propicdad LinklItem. sin que esta opv racion afecte a dicho
enlace.

Como ejemplo. supongamos que descamos tener acceso i los datos de las
celdas Af. A2. Bl v B2.

Modifique la forma anterior. afadiendo los controles que s indican en la ta-
bla siguiente.

Objeto Propiedad Valor
Opcidn | Caption . At
- CuName - LnCn
Index 0
Visible- 4 True ~
‘Opeidén 2 Captiog " Bl
Cll.\.mle LnCn
Index l
Visible False
Opcidn 3 Caption A2
" CilName : LnCn
Index 2
Visible False
Opcion 4 Caption B2
CuName [.nCn
Index 3
Visible 0 Lalse
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Observe que ¢] conjunto de opciones forma el array de controles LnCn.

Celdas:
®a OB
Oaz  Os2

Cuandu ¢] usuario haga clic en una de estas opciones, se genera el suceso
Click para el control LaCnf hiedexy. Por 1o @anio. ha respuesta a este suceso la da-
remos en ¢l procedimiento LunCn_Click que tiene que visualizar el valor corres-
pondiente a la celda referenciada. Para ello, lo tnico que lenemos que hacer es
modificar el valor de la propicdad LinkItem en funcion de la celda elegida (opeidn
elegida).

Sun LoCn_CYi ~s Integer)
Ceiggn Czs
Caze 0 -
Taxrl. "L1CL" ‘celde A1
Cazs 1 |
TEK;;'LlHR:LeW = "L1C2" ‘rcelde 3%
Cesez 2
Tent = "L2Ct" ‘celds 17
Ceze 3
TERT = "L2C2" ‘celdz 32
Eng Izie
“nd Sun

Guarde la agilcacuon cjeciitela y compruebe los resubtados.

Aunque hasta ahora hemos elegido una celda como clemento de dutos, esto
no quiere decir que siempre sea asi, Por ejemplo. el elemento de datos puede ser
¢l rango de celdus LICT:L3CA. Si el elemento de datos se cambia durante 1a eje-
cucion, diremos exactamente lo mismo.
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Establecer un enlace frio .

Mientras que en tiempo de disefio el tinico tipo de enlace que se puede realizar es
un enlace caliente, en tiempo de gjecucion se puede realizar ademds del anterior,
otro tipo de enlace denominady enface frio. Entre ambos existe una diferencia
importante; con up enlace caliente. una variacion en los datos del servidor es re-
flejada automdticamente en el clicnte. Si embargo, con un enlace frio cuando los
datos varian en el servidor, ia actualizacion de los datos en el cliente no sucede a
menos que se solicite explicitamente con el método LinkRequest.

En muchos casos, un enlace frio puede ser mejor que un enlace caliente. Por
ejemplo, volviendo a la hoja de cilculo. suponga que debido a los cilculos las
celdus enlazadas estan sometidas a numerosas variaciones hasta completar dichos
cilenlos. Con un enlace caliente. estas variaciones se estdn refiejando también en
el cliente con la consiguiente pérdida de velocidad en la aplicacién, cosa que no
ocurre si realiza un enlace frio. '

En una conversacién DDE. el mélodo LinkRequest permite actualizar el
contenido de un control que actia como cliente con los datos enviados desde el
servidor. Su sintaxis es,

control LinkRequest

donde contrnl es una caja de texto, una caja de imagen o una etiqueta que aclia
como cliente en la conversacién DDE.

Comaq ejemplo, vamos a establecer un enlace frio entre la aplicacién Excel
(servidor) y la aplicacion Visual Basic anterior denominada Dde01 (cliente).

A la hora de crear el enlace 1a d]ﬁcq';i'ariacién que hay que realizar es cambiar
el valor de 1a propiedad LinkMode para que especifigue un enlace frio.

Sub BEditvVinculo_Clicx ()
Textl.LinkMode = KOMNE 'rotper oniace
Textl LinkTopic = "Zxcell=o
‘Pextl . LinkItem "LiclL-e
Textl.LinkMode CQLD 'eniacz frie

End Sub

A continuacién afiada a la forma un botdn Actualizar de manera que cuando
el usuario haga clic sobre él. los datos de 1z caja de texto queden actualizados.
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Celdas:
®a Om
Oaz Ope2

~ Ellprocedimiento asociado con el botén Actualizar sélo tiene que cjecutar el
método LinkRequest para el control Text/, si hay un enlace frio establecido,

lizar_Click (}

Sub fec
If[ Tex-l.LinkMode = COLD Then
?ele.LinkRequest
Erd I:
.Enéd Sub -

Guarde la aplicacidn, ejecitela y compruebe los resultados.

Aplicacion Visual Basic como servidor

Si quilerc que su ‘aplicacién Visual Basic envie datos a otra, tiene que establecer

- un enlace defini¢ndo su aplicacion como servidor y 1a otra como cliente.

Atlmquc el ﬂ'_u'jo de dalos en una conversacion DDE es generalmente desde la
aplicacisén secvidor a la aplicacion cliente, el chiente puede lambién enviar datos a
la aplicacién se'rwdor, utilizando el méodo LinkPoke.

,

En una con\i’é_rsacién DDE, el métode LinkPoke permite transferir el conte-

nido de un controt a la aplicacién servidor. Su sinlaxis es,

control LinkPoke
donde|comrol es una caja de texto. una caja de imagen o una etiqueta que actda

como cliente en lu conversacion DDE.

Como ejemplo, vamos a establecer un entace frio o caliente entre una aplica-
ion Visual Basic que denominaremos Servidor y otra aplicacion Visual Basic
que &7 ~iunaremos Clienre.,

Para resolver este problema tiene que:

»  Crear una aplicacion Visual Basic que funcione como servidor,
»  Crear una aplicacion Visual Basic que funcione como cliente.

+  Establecer un enlace frio pata DDE entre la aplicacién cliente y la aplicacién
servidor.

o Utilizar ¢l método LinkRequest para acwalizar la informacion de la aplica-
cién cliente enviada desde la aplicacién servidor.

« FEstablecer un enlace caliente para DDE entre la aplicacién cliente y la apli-
cacion servidor.

¢ Utilizar el méodo LinkPoke para enviar informacion desde la aplicacién
cliente-a 1a aplicacidn servidor.

Inicialmente la aplicacion cliente envia drdenes a la aplicacién servidor para
establecer el enlace. Después a través de una conversacion DDE, el servidor envia
datos al cliente o acepta datos del cliente a peticidn de éste.

A continuacién desarrollamos paso a paso la aplicacion enunciada. En primer
lugar creamos una aplicacién Visual Basic que funcione como servidor.

Inicie una nueva aplicacién y cree una forma tiutada Servidor. Observe que
los valores por defecto de las propiedades LinkMode y LinkTopic son /
(Server) y Forml respectivamente, Esto quiere decir que las aplicaciones que uti-
licen ésta como servidor, tienen que buscar para realizar el enface una aplicacidn
con un tema de conversacién "Servidor|Form[”. Afada a la forma una caja de
texto de nombre Datos. Guarde la’aplicacién con ¢l nombre Senvidormak y la
forma con el nombre Servidor frm. -

e
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Ahora cree un fichero ejecutable SERVIDOR EXE para esta aplicacién. Para
ello, ejecute la orden Make EXE File del meni File.

En segundo lugar cree una aplicacién Visual Basic que funcione como cliente.
Inicie una nueva aplicacidn y cree una fonna titulada Clienze con los controles
que se indican ¢n la tabla siguiente. Guarde la aplicacidn con el nombre Clien-
te.mak v la forma con el nombre Cliente.frm.

Objeto Propiedad Valor

Caja de texto CuName Textl
Text (nada)

Opcion 1 Caption Enlace frio
CtlName Enlacefrio
Visible True

Opcion 2 Caption Enlace caliente
CiName EnlaceCaliente
Visible False

Botén | Caption Envio
CilName Envio

Botén 2 Caption Peticion
CtName Peticidn

= A [~1-]

m @ Enlace fiio

' O Enlace cakiente

Careue el fichero CONSTANT.TXT en el médulo global. ya que en él estdn
definidas constantes como NONE, HOT, etc.. que vamos a utilizar en nuesira
aplicacion. Abra la ventana de cédigo para el médulo Global bas y ejecute la or-
den Load Text del mend Code: escriba el nombre .. Wwhiconstantixt y pulse el
boton Replace. Cimbielo de nombre y denominelo Cliente.bus.
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Cuando se inicie la aplicacion Cliente debe wniciarse también la aplicacién
Servidor que hemos creado anteriormente. puesto que ¢l siguiente paso es crear
un enlace entre ambas aplicaciones. Para etlo. escriba el siguiente procedimiento
conducido por el suceso Load que se encargari de armancar la aplicacion Servidor
v de crear el enlace entre ambas’

Sub Torm_Load ()

*Este oroced1m1€1 ar
‘gue funciona Ccomo ==
Dim id As Integer

Id = Shell{c:\vb\ nles cap
‘La s:guiente sent a as=2¢u
'finglizard antes <= intencar

Td = DoEvents()

.Linkiode =
.LinkTopic
.LinkItem
.LinkMode

7]

7]

=3

13934
oo m

X N NN

OO oot

O t= et e
1

L.a funcion DoEvents intemempe Visual Basic y cede el control al entorno
operativo (por ejemplo, Windows), hasta que todos los mensajes que estin espe-
rando en la cola de procesos sean ejecutados.

En el procedimiento anterior. la funcién DoEvents garantiza que la cjecucion
de la apticacion Servidor finalice antes'de continuar con ¢l proceso actual. Si no
se llama a la funcién DoEvents. Ius sentencias que crean el enlace frio entre el
cliente y el servidor se ejecutarin antes de que el proceso de carga de éste haya
finalizado. lo que provocard un error, ya que la peticidn de conversacion del
cliente al servidor no pucde ser (.(’J!\teﬂ:lda por no estar éste activo en el tiempo
establecido por defecto, En este case concreto, otra solugidn seria incrementar el
tiempo por defecto especibicado por 1a propiedad LinkTimeout.

Como el servidor de la conversacitn 2s una forma correspondicnte a una apli-
cacion Visual Basic, el elemento de datos wilizado por ef servidor para enviar los
datos es su caja de texto Datos. Recuerde que éste debe ser una caja de texto, una
etiquety. o una caja de imagen. perteneciente a la forma.

Una vez enlazadas lus dos aplicaciones. si quiere puede modificar el tipo de
enlace. Esta es la finalidad de las dos opeiones que aparecen en la forma Cliente,
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l.a npcit')n Fn!nrefn'n establece un enlace 1o entre el clienie y el servidor. T2

visinle este Zoiadn
en enlace
frio

La apeion Enlace caliente establece un enlace calicnie entre cl cliente v el
servidor. EI procedimiento conducido por el suceso Click para cste control cs el
siguiente:

[

sinar esta boudn
- en enlace

taliente

1l

Observe que cuando el tipo de enlace es caliente, el botdn Peticicn. que ac-
taliza la caja de teato cuando ¢l enlace es friv. se oculla ya que la actualizacion
s altomgtica.

1 botdin Peticion cuando ¢l ipo de enlace s [tiv, permite actualizar Text!
con im datos procedentes del servidor. De acuerdo con esto, el procedimiento
conducido por el suceso Click para ¢l control Peticidit es el siguicnie:

éz_ cliente

T - o
l‘ 21 hoton Mhvio con cualquier tipo de enlace, permite enviar los datos del
t|lL‘Il}IL al sr.‘r\ldnr Pur 1o tnte, ¢l procedimiento conducido pur el suceso Click
para el control ‘rm for ¢s el sicuicnte:

Guarde I aplicacion v cjecntela. Recuénde que T aplicacion que ticne gue
cjccullur es Clicnze va que e éta quien se encarga Je arrmear el servidor. Cuando
:||1;m|quc la aplicacion Chieate. esperard ver ¢n Ly pantalla las dos formas, la co-

o "
-

— Mg ..
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..

rrespondicnte al cliente y la correspondiente al servidor. Si no es asi. anastre la
fornna correspondiente al Cliente v verd que Ta delb servidor se encontraba debajo.

Si lo desea puede crear un fichero CLIENTE.EXE para poder ejecutar esta
aplicacién bajo Windows. Pafa crear este fichero. ejecute |a orden Make EXE
Fite del mentd File,

Este ejemplo. puede hacerlo extensivo a otros casos. Por cjemplo. el cliente
es una aplicacion Visual Basic v ¢l servidor ¢s Excel. En este caso. cuando se
inicie Ja aplicacion correspondiente al cliente. debe iniciarse tambicn la aplicacion
Excel. pucsto que ¢l siguiente paso cs crear un enlace entre ambas. El procedi-
miento siguiente conducido por el suceso Load se encarga de armancar la aplica-
cion Excel y de crear el enlace entre ambas.

Sub Form_Lczad ()
‘Esre procsdimiento arranca -z eplloacidn fmesl
'gue funciona como servidor
Dim Id Zs Inleger

Id = Shell{"c:\exceliexcel c:uexcaish : . -b)
‘La sigui=nie senteérncia asegura que 2@ proreso de
‘cargar Zxcel finalizard antes ¢s intentar
‘establecer el enlace

1d = DoEvents()

Text!].LinxMode = WONE " romper er_a c& sioern fe
TexLl..l,ﬁ.cch = “Ixcelinojal.xis

Textl.LirkIcem = "LiCl"

Textl.Link¥ode = *enlace Iric

COLD
Fnd Sub

Para un cliente idéntico al anggrige. el resto de los procedimientos pueden ser
lus mismos. o

SUCESOS ASOCIADOS CON LOS ENLACES

l.os contrules que pueden actiar como clicnies en una conversacion DDI, reco:
nocen los sieuientes sucesos: LinkOpen. LinkClose v LinkError.

Fl suceso LinkOpen ocurre camdo un control inicia una conversacion DDE
con vna aplicacidn servidor, Si el control es Fexr/. ¢l esquema del procedimiento
conducido por este suceso s

————
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Sub Textl_l.inkOoan (Ca 2. 25 nuager)
znd Sub

El parimewro Cancel yue se evalda al final del procedimiento conducido por
el suceso LinkOpen, indica al cliente si la conversacion DDE se ha edablecido
(Cancel = 0) 0 no (Cancel <> 0). St nosotros ponemos este pardmetro a un valor
distinto de cero, el enlace se rehusa v si lo dejamos a valor cero entonces ¢s que
el cnlace se acepta. ’

El suceso LinkClose ocurre cuando b servidor finaliza la conversacion DDE
que mantiene con el control. Si el control ¢s Tewf, el esquema del procedimicnto
conducido por este suceso es: '

Sub Textl_LinkCloses ()
“nd Suhb

El suceso LinkError ocurre cuando durante una conversacién DDE ocurre
un error (no nos referimos a un error en el codigo). Por ejemplo los datos llegan
en un formato no reconocido por el cliente. $i el control es Tearl, el esquema del
procedimiento conducido por este suceso es:

Sub Texil_LinkError (LizmxIrr 1: Integer)

i

end Sub

El pardmetto LinkErr cs el codigo del error ocurrido,
e -

Cuando una forma estd actuandy como servidor en una conversacidn DDE,
reconoce los siguientes sucesos: LinkOpen. LinkClose. LinkError y LinkExe.
cule. A :

Rl .
El suceso !.ink()pcn ocurre cuando una apticacion clicnte inicia una conver-
.
sacion DDE cdn una forma. El esqueni del procedimiento conducido por este
SUCESO C§:

-
i
3

)
N
ol
ol
]

Sub Form_LinkOpen zzer)

Frnd Sub

E) parimetro Caneel que se evahia al Ginal del procedinuento conducido por
¢l suceso LinkOpen, indica si Lo comversacidn DDE se ha establecido o no. 51
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nosetros ponemos este paramerro a un valor distink de cero, el enlace se rchusa y
si fo dejamos a valor cero entonces es que ¢l enface se acepta.

El suceso LinkClose ocurre cuando el cliente finaliza la conversacion DDE
gue manticne con ¢l servidor. El esquema del procedimiento conducido por este
SUCESO e

sub “orm_Li:
Fnd St

El suceso LinkError ocurre cuando durante una conversacion DDE ocurre
un error (no nos relerimos a vn error en el cédigo) y la forma cstd actuando como
servidor. El esquema del procedimiento conducido par este suceso es:

Sub form_Lis (LinkErr s Integer)

End Sub
El pardmetro LinkErr es ¢l cddigo del ermor ocurrido.

El suceso LinkFxecute ocurre cuando una aplicacidn cliente cnviz una orden
a una aplicacién servidor para que la cjecute. El esquema del procedimiento con-
ducido por este suceso es: '

Sub Serm_Linzixecute {CndSLr is String, Cancel ns Integer)

El parimetro CmdStr es la orden enviada por ta aplicacion cliente y el pard-
metro Cancel que se evalda al final del procedimiento confucido por el suceso
LinkFxecute, indica al clicate si; la,brden fue aceptada (Cancel = 0) o no fue
aceptada (Cancel <> 0). eom ’
i-vixecuie (OmdStr Ls String, Cancel A3 Tnbaszer)
g
z2 LCezesilmdStr)

i
o

i oorden no fue aceptade

JATOS WY .
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f ,
ENV}II’\R ORDENES A OTRAS APLICACIONES

]
Utilizando ¢l método LinkExecute, se pueden enviar a través de un enlace Grde-
nesfa owras aplicaciones que soponan DDE. La sintaxis para este método ¢s 1y 1-
guiente:

Control LinkExecute ordens

Conirof es el clieme que envia la orden especificada por arden. El servidor la
rccilbe ¥ si la reconoce la ejecuta, en otro caso envia un mensye de error. La sin-
taxis de una orden depende de la aplicacion servidor. Para conocer esta informa-
cidn, consulte la documentacién de la aplicacidn en cada caso, Por ejemplo. Ex-
cel para Windows acepta drdenes encerradas entre corcheles.

Textl.LinkExecuts " [AFCHIVO.CZRRER() 1"

Textl.LinkExecuze © [BIPI (ARCHIVO.CER22R() | ISILIA() "

ACTUALIZAR GRAFICOS EN UN DDE

Si un cliente inicia una conversacion con una caja de texto de una forma que ac-
flia ls:omo servidor, cuando la informacion de ésta cambia. Visual Basic actaliza
awtomdticamente el cliente si se trata de un enlace caliente. o se ko notifica si <o

trata de vn enlace frio.

Sin embargo, Visual Basic no hace lo mismo cuando se trats de una caja de
imalgen. La r'a".f.‘én s que cnun enface caliente. los dawos son iransferidos desde el
servidor al cliente cada vez que hay un cambio en los mismos. 1o cual sienifica
que el servidor tendria que enviar 1odo el grifico al cliente cada vez que se modi-
ficara un ﬁixc‘-’ Esto conllevaria un gasto grande de tiempo y de recursos. Por eso.
cuapflg se necesite actualizar el grifico en el cliente. Visual Basic permite lamar
explicitamentg desde el servidor al método LinkSend. Por cjemplo.

Sub Pictnrel_Paint ()
!‘I.ﬂ.qui escribz las operaciones gré
realizar en ¢! servidor
Picturel .LinkSznd ‘eavia el gréfica al clien
1d Sub ’ .

rh

E
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MANIPULACION DE ERRORES :

Cuando se ejecuta una aplicacién Visual Basic que funciona como chente o como
servidor, se pueden presentar dos clases de errores:

«  Errores que ocurren al ejecutarse el cddigo escrito para la aplicacion.

» FErrores que ocurren durante vna conversacién DDE (cuando no se ejecuta el
vadigo).

La primera clase de errores va ha sido tratada en capiulos anteriores, Por
ejemplo, si una aplicacidn Visual Basic que funcione como cliente quiere inictar
una conversacidn con la aplicacion Excel. lo que hay que hacer previamente es
cargar a aplicacion que va a funcionar como servidor y después iniciar 1a conver-
sacidn, En caso contrario Visual Basic mandard un mensaje de error, de cédigo
282, indicande que no se puede establecer ¢l enlace con el servidor por no estar
activa dicha aplicacidn. :

Para ilustrar este ejemplo. inicie una nueva aplicacidn y cree una fonma titu-
lada Cliente. Afiada a la forma una caja de texto de nowbre Teat! . Guarde la apli-
cacion y la forma.

= [<]-]

Cuando el usuario arrangue la aplicacion. se da ¢l suceso Load para el abjeto
Form. De acuerdo con lo enunciado anteriormiente, 12 respuesta a este suceso
liene que ser la siguiente:

= Interceptar Yos errores que puedan ocurrir al ejecutarse ¢l codigo eserito de la
aplicacion cliente.
*  Establecer un enlace caliente para DDE entre ta aplicacion clicnte y la apti-

cacion serviddor.
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o« Si ocumre el ervor 282 (el servidor no esta active), ejecutar ta aplicacion que
va a funcionar como senvidor e intentar de nuevo establecer ¢l enlace.

+  Si ocurre ofro tipo de ¢rror, enviar un mensaje al vsuario indiciandole el cidi-
go del error ocurrido v finalizar 1a aplicacién. '

El codigo que cjecuta ¢l proceso descrito se indica a continuacion.
Sun Yorm_lecad ()

"Isre orocedimiznio arrancza la eplicacicn Exczl

‘gue finciona coso servidor

Jim I¢ is Integer

Const

Const

TONET 'rcoper enlace
= "Excelidojal”
*L1CE” :

FOT *en.ace caliente

FucinaideZrror:
If Erc = 282 Tren ‘'neo escta activa la aplicaciin
I¢ = Shell("c:ivexcellexcel .efken, 1)
Pes:me tnlace
Tlse | '
Mzgicy "Error npimero: " o+ Stri{Erv)
Erd ‘ '
7nd I
End Sub

Lt f.cgund‘;i: clase de errores se manipula a través del procedimiento corres-
pondiente cunillucidu per el suceso LinkError, Los errores que se pucden dar en
una conversaclon DDE estin definidos ¢l ficheto CONSTANTTXT v son los si-
guienes:

CErrius think:
Cinbha: Const .
Clopa. Const = 2
Clohar Const
Globel Consec 4
Global Const
Tinhal Const

s L Const

st

C AWPITULO 13, INTERC ANBIN DINASICO L » Iy

Clobal Const
Gionael Const
Global Const OUT_OF_M
Clobhal Const SERVER_ZTUEM

3_CiIENT_OPERATION = 12

Por cjemplo, suponga que tiene una caja de texto Wamada Teat! wrabajando
como cliente de una conversacion DDE. Para manipular los emores que puedan
ocurrir durante Ia conversacion DDE, escriba el procedimiento que se presenta a
mmﬁmmdﬁmlm[wmmrMgmcmgmchhﬂoCONSTANTTXTeneImﬁhh
gnbm.yuquccnélcmﬁndcﬁnMnsMSconﬂanwsrcﬂncnwsa|osen0msI)DE.

Sub 1ex:l_LinkError {(ZrrNum s Tnteger)
‘Las constantes gue racogen los cdcdigos de error
‘esuéan definidas en Global.Zas
Dim tsg As String

1
L
o

Select Case Errhun
Case OUT_OF_MEMOZY
vsg = "Ho hay sificiente memoria parn ejecutar LOES
Case WRONG_FORH ‘

Ksg = “los ditas mia el B ro estdn e formato awraeeo”
Case Else
Msg = "Error * - StrSikucmirror) + " en un DDE®

End Select
MsgRox Msg
End Sub

Cuando la aplicacién VB es ¢l servidor. el procedimiento es exastamente ¢l
misino que cuando la aplicacién VB es el cliente, excepto que ahora estd asociado
a la forma. . : :

Sub Form_LinkError {LinkErr s Intecer) _
'‘Las constantes gue recogen los codigos de error
'estén definidas en .Glgbal.3as ’

Dim Msg ks String - 0"

Select Case Frrium
Case OUF_OF_M:
¥sg - “"Ho hay
Case WROMG_FOI

ZJiciente memori: um ejecular DOES

Msg = "los dates mara el OX m nsra an i forrato correrio”
Case Flse
tisg = "Error = - Strs{iuamdr-or) o+ " en-un DRZT

End Select
Msg3ox Msg
End Sub
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FUNCION DoEvents

La funcion DoEvents intermuimpe un proceso Visual Basic y cede el control
chtorno operativo (por ejemplo. Windows), hasta que wdos {os mensajes que es-
tin esperamdo en T cola de procesos sean ejecutados, Esta funcion devuelve un
valor que se corresponde con ¢l mimero de formas VB cargadas.

Para entender Lt imponancia de esta funcion. picase gue su aplicacion Visual
Basic no estd sola. sino-que estd corriendo simultineamente con otras aplicacio-
nest lo gue implica que wdas ellas tiencn que companin los recursos del ordena-
dor!l En este sentido. cuando una aplicacion Visual Basic estd esperando que ocu-
it l:]ll suceso_automancamente estd compartiendo el ordenador con las otras apli-
cactones. Sin embargo. cuando uno de sus procedimientos se estd ejecutandu, Vi-
sual Basic no comparee ¢l ordenador con otras aplicaciones. Esto puede uriginar
problemas diversos: por ejemplo. gque otra aplicacion no pueda responder o una
comersackon DDE poigue no puede coger ef control, fo que darfa lugar a un men-
saje, de eraor, Paa evitar esto. puede wilizar la funcion DoEvents.

L) stguiente ejemplo, carea Ta aplicacion Excel, enlaza ¢l cliente Teard con
Csil ‘:Ip“t‘;ll_‘il’ln gue funciona comoe”servidor v hace una verificacion para evitar
posibes  errores, enviando dawos a0 s celdas de ta hoja de  cileulo
"CAv b jalxls™, con las que se va a establecer la conversacion.

lcacian F

Taresncnde

iy _2
; PONE = o, & ., = &, COLS = :
| s
T] ;‘-.‘.-’r«;qtf, Coto - iralsyrros
id = ShFll("rt: Domoel oo wbAnsjaloxler, 1)

Fnlace:
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La sentencia fd = DoEvenyst) incluida en el laza de verificucion, pe rll]lt.t. q:l;.
HCUITAN OLT0S SUCEsas mientras se ejecuta dicho fazo y 1 incluida en _Iu ll:l'lll'tlil lL
evror permite que se establezca el enbisce caliente una vez que hava Ginalizado Ta

carea de la aplicacion Excel,

Ltitice Dabvents pari intermunpir un proceso Vistal Basiv con ¢l fin de que
¢l ‘entorno operativo pueda responder normalmente a ooy sucesos gue puedan

ovurrir pericdicamente.

Para clarificar este concepto vanios 2 exponer un ejemnplo que perimits reahizar
un conteo ascendznte o descendénte micnlras el usuagio nuntenga putsado ¢l ho-
3 : ERT N arl i o O .

on del raton, E1 conteo se detendrd, cuando el usuario suelie ¢l boldn
Il : cacion ¥ cfee una forma u ada € r cost los con-
Inicie una nesva aplivacion 'y ciwe una formiy titnlida .(_un-ra’n!n ¢ l "
troles que se indican en la tabla siguicnte. Guande la aplicacion con el nombre
Comtador.mak v 1s forma con el nombre Contador frin.

Ohjeto ' 1 Propiedad l Valor \
Mlimnu » FormMName ' Formt I
. Cuption ] Comader i ]

Engueta CCUName ‘ ‘ bl | |
e Caption L B i
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Caja de imagen CilName Picture|
Autosize True
Index 0
Picture L ARWOIDN.ICO
Caja de imagen CilName ' | Picturel
Autosize True
Index 1
Picture | ARWOIUP.ICO
=] [ -]4]
ns

Defina las siguientes variables a nivel de la forma.
Dim Puisado, Contador, Id As Inzecer

El'procedimiento conducido por el suceso MouseDown para el control Picau-
reltIndex). primero caleula el incremento; st fndex e O, Incremenio vale ~1 y si
Index es 1. Incremento vate +1. A continuacién pone 1a variable Prlsado a valor
True. Finalmente, se cjecuta un lazo que realiza el conteo micntras la variable
Pulsado sea True. Cuando el usuario suehe ¢l botén del ratén (suceso Mouse-
Up). Pulsado tiene que pasar a valor False para que se detenga el contev.

Sub Pic'-‘_u'qpelkldou:;el)ov.:' A{index 23 1
Integer, Shift As integer, ™
If Irdeg Then '

incyemento

"
—
.

£l

n

2
Incremento = -1
End If
Pulsado = -1 "'T'RUE
while Pulsado :
Contadér = Contador + Incrs7Tsn,
l.enell.Caption = StrS5(Contzasy)
1c¢ = DoEventsi) -
Wen
=nd Sub
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-

Como se ha indicando anterionnente. cuando un procedimiento de una aph-
cacion Visual Basic se estd ejecutando. Visual Basic no compane el ordenador
con otras aplicaciones. Esto hace que otros sucesos. por ejemplo MouseUp. nn
sean cjecutados aungue sabemos que cf mensaje generado cuando se produce ¢l
suceso, se anade a la cala de procesos de Windows para cjecutarse cuando finati-
ce el procedimiento Visual Basic. En el ejemplo anterior, ¢l lazo While no finali-
za nunca.

Para permitir mirar la cola de procesos v si tos hay los ejecute el entorno ope-
rativo. hay que llamar a la funcién DoEvents. En el ejemplo. esto lo hacemos
cada vez que se ¢jecuta el lazo While. con el fin de que cuando se dé el suceso
MouseUp se ejecute el procedimiento asociado que se muestra a continuacion.

Sub Picturel MouseUp (Index s :ir-Iazer, Button AS
Irncecer, Snift As :nteger, = ~§ Zingle, Y A8 Single)
Pulsado = 0 '"FALSZ
L] N

End Sun

PEGAR VINCULOS Y COPIAR

Anteriormente, en este mismo capitulo, hemos visto que en las aplicaciones que
soportan cnlaces calientes la orden Pegar Vinculos (Paste Link) permite al usva-
rio crear aplicaciones que funcionan como clientes. Esto exige gue la aplicacion
servidor tenga una orden Copiar (Copy). Para que Tos ayplicariones Visual Basic
ofrezcan csas mismas caracleristicas, vamos a estudiar 4 continuzciom como ana-
dir la orden Pegar Vinculos y 1a orden Copiar.

Para que una orden Pegar Vincidos de una aplicaciin Visual Basic pueda
realizar un enlace caliente para que dicha aplicacion funciodie come cliente, debe
obtener la informacion del ponapgpejes{Clipboard). EI método que nos permite
obtener esta informaciénes, '

Cliphboard.GetText { {formato%]
Si el argumento formato vale 1 (constante CF _TEXT) ¢l método GetText
devuelve la cadena de caracteres contenida en ¢l ponapapeles y si vale &HBEFOG

{constante CF_LINK) entonces devuelve una cadena de b forma,

aplicacionltemaelemento de datos
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t

que cnnan la informacion necesaria para realizar el enlace (I es el cardicter AS-,
CIT 124 v 'es cheardcter ASCI 33, El valor de formaio por defecto es 1.

I,:m constantes simbalicas que especifican el argumento fornmaro% estin

dﬂﬁmdaﬁ en ¢l fichero CONSTANT.TXT.

Fl'ara que una orden Copiar de una aplicacién Visual Basic pueda realizar un
enface calicnte para que la misma funcione como servidor, debe poner la infor-
macidn aplicacionltema'elemento de datos en ¢t portapapeles (Clipboard). El

|
métode que nos permite poner esta informacion en ¢l portapapeles es.

Cliphoard.SetText duto$ [formart|

El argumento dato$ ¢s la cadena que queremos poner en el portapapeles. El
argumente forutato especifica el formato CE_TEXT (constante de valor 11 o
CF I INK teonstante de valor &HBF), el valor por defecto es 1. La cadena al-

~
macenada es de la forma,

aplicacidnlemalelemento de datos

Cuando la aplicacion se ejecuta en Visual Basic: aplicacicn es el nombre del
provecto v cuando Ly aplicacion se ejecuta utilizando el fichero ejecutable (CEXE).
aplicucion es ¢l nombre de ese fichero ejecutable, |La cadena de caracteres tema se
corresponde con la propicdad LinkTopic de fa forma ¥ el elementor de dutos, es
el nanhrL del contril o través del cual se efecuia la conversacion. Para tener acce-
SO al nombre de un control, hay almacenar el mismao en la propiedad Tag. ya que
la propiedad Lt!Namc no estd disponible en tiempo de ejecucion,

Anadir la orden Pegar Vinculos

4
[nicie una nueya aplicacion y cree una forma tiwlada Vinewloy con los controles
que se indicanten la tabla siguiente. Guarde la aplicacion con ¢l nombre Vineu-
los.mak v 1a fofma con ¢l nombre Vincalos frm.

Ohjtlllo Propiedad Valor
Menti Caption & Edicion
CtiName MenalEdicion
Meni: orden 0 Caption Cuog&tar
CtiName Orden
P Index 0
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Menii: orden | Caption ) I &Copix -
CiiName ; Orden
ndex - {1 .
| Menid: orden 2 Caption P&I .
CilName Orden
Index 2
Ment: orden 3 Caption Pegar & Vinculos -
CilName Orden
Tndex 3
Menu: separador Caption -
CiName auones
Index 4 ]
Mend: orden 3 Caplion &Sulir
CiIName Orden
Index 3 ]
Forma FormName Forml
Caption Vinculos |
Caja de texto CilName Textl
Tewt {naday
Tay Teatl

Para ejecutar L orden Pegar Vinewdos (Paste Link) siga los pasos que se es-
pecifican a coninzacion:
1. Obtenga del pocapapeles la informacion para realizar el entace.
20 Divida v informzoion en las cadenas aplivacidnliema v elementa de datos,

3 Asigne las cadenzs anteriores g las prnpletl.ldcs LinkTopic v LinkHem, res-

pectivameniz. Szl control zotive,
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Para determinar el control que estd activo utilice Ia propiedad ActiveControl
del objeto Screen.

El procedimiento que da lugar a ta orden Pegar Vinculos es cl siguiente:

ez s

EQ .GetTexe (CF_LINK)

x4 "y

1z
Screen.xcziveContvrol.Linkidode = NONE
Screen.icriveCentrol. inkimic = IeftS(Enlans, Xd - 1)
Screen.icoiveControl . Linkitan = MidS{knlaxe, X3 + 1)
Screen.: iveControl .Linkkode = HOT

Eigelf IrSir(En.lzce, "I1") Tren
‘Para los enlaces DDI que no tlernen elemento &2 datos
Screen.xcriveCcntrol . LinkMode = NONE '
Screen.lcioiveControl . LinkTopic = Enlace
Screen,lcoiveControl . i = " "
Screen.ictiveControl.LinkMode = HOT

znd" I1€f

Cage % 'Saiir
Eid' '
End Se 1
End Sub

*.

Puede ocurrir que en ¢l portapapeles no hava informacion vilida para realizar
un enlace o ctje et control cliente no sea uno de los requeridos. En este caso. lo
que haremos Serd dejar la orden Pegar Vinenlos de forma gue no se pueda ejecu-
tar (en gris).

Sub Ferniciicidr_Cilick ()
‘Glonzl . bas co CONSGTZIIT . TNT
Orde; .(3] Ena i Pegar Vinculcs
If Ciiop Then
[s i

Lrene

O'c«n("
o= 1 F
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En este procedimiento no se ha considerado el control etiqueta porque cl
usuario 0o puede seleccionarla: por consiguiente, una ctiqueta nunca pueds «er un
control activo. En adicién, el cadigo del procedimiento asegura que ¢l contenido
del portapapeles esté en el formato adecuadn. Para una caja de imagen. ‘ld( s
del formats CF_BITMAP son también viilidos CIF CMETAFILE v CF_DIB.

El método GetFormat devuelve un valor —1 si el tipo de formato del conte-
nido del pnrtdp.:pdu es recnnf)adu por Visual Basic: en caso contrario devuche
un ). Su sintaxis es

Clipboard.GetFormat (formaro®)

El argumento formato% especifica uno de los siguientes formatos FeCOnx-
dos por Visual Basic:

I 'prmalo ‘ Valor
CF_LINK ) &HBEOO
CE_TEXT i

CF_BITMAP
CF_METAFILE
CF_DIB

o0 W BN

<

l.as constantes simhélicas que-efpecifican ¢f argumento formaio® estin de-
Anidas en el fichero CONSTANT.TXT.

Anadir la orden Copiar

Para anadir la orden Copiar de forma que permita que la aplicacion Visuad Basic
pucda funcionar como servidur. escriba en el procedimiento Orden_Click antenor
el siguiente codiga: '

Cace "Copiar
tighoard Clear

: we = aplicecis:
Enlace = "VIipci:
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lee
'DaTos para cizos corniroles
End I:

—_—Ll - n d
-~
(]
{
0

El método SetData cuva simavis es.
ClipBoard.SetData {daio's, [formatoti])

ptrIT‘I!lL poner en el portapapeles una imagen daroS (propiedad Image o Picture)
ullillz.imln el formate 2 (CF_BITMAP). 3 (CF_METAFILE) o 8 (CF_DIB). Por
defecto ¢l furmato e« 2

ENVIAR TECLAS A OTRAS APLICACIONES

Vi51|mI Basic permite enviar teclas a una aplicacion gue esté cjecutindose en e}
entorno operativo, independicntemente de que la aplicacion soporte o no DDE.
Sin embargo. no se puede enviar tectas a una nxdguina virtwal DOS. esto ¢s, a una

sesion DOS ejecutindose en una ventana.

Cu.mdn se envian teclas a otra aplicacion, ¢l resultado ¢s el mismo yue si ¢l
uwalrm las hubiese pulsado. Por cjemplo. la siguiente sentencia envia las teclas
Txyz": o

SendKeys “*kyz*"

Para éhviﬁp teclas especiales. por ejemplo. F1L Tah, Enter. +. se envia ¢l
unmhre de la tecla encerrado entre Naves. Es indistinto utitizar mimisculas o ma-
yusculns Por ¢jemplo,

SendKeys "{Flj{7sn- Szt
lLas teclas que se envian van autonsiticimente a Ly aplicacion activa. Quiere
esto gccir. que s no se activa otra aplicacion. $as weclas enviadas irdn a parar ala

masana aplicacion, Para activar otra aplicacion utihee Lyosemencia,

1 N -
AppaActivate nombreS

AP Il)l‘ 1\TI Rt \\ll'!llllll\ ANSC O i ll\lll'\ LRa )

R SRR R S [

El argumento nombre se corresponde con el sombre gue aparece en la harra
de titufo de la ventana activa de la aplicacion,

La sintaxis de la sentencia SendKeys es la siguiente:

SendKeys teclusS{. esperarte)

El arcumento esperar es una expresion mimérica que vale -1 (True) o 0
tFalsed. Cuando las-teclas se envian a otra aplicacion y esperar vale -1, se proce-
san las teclas enviadas y después se devuelve el controb al procedimiento. 5i es-
perar es 0. entonces no se espera a que se procesen las teclas. Bl argumento espe-
rer sdlo tiene efecto cuando las teclas se envian a otra aplicacion. 31 las teclas se
envian a la misma aplucncmn v oS¢ necesita c<pcr.lr a que se procesen. utilice la
tuncion DoEvents.



CAPITULO 14

LLAMADAS A LAS FUNCIONES
DE LA API DE WINDOWS

LIBRERIAS DINAMICAS *

INTRODUCCION

Un programador de aplicaciones Windows ademids de conocer ¢l enturno de ra-
bajo de Windows debe conocer 1ambién su entorno de programacion, conncido
generalmente como interfaz de programacion de aplicaciones de Windows
{Windows Application Programming Interface, abreviadamente Windouws
ALy La caracteristica primaria de la AP1 de Windows son las funciones y los
mensajes Windows,

Las funciones Windows son el corazén de las aplicaciones Windows, Hay
mis de 600 funciones de Windows dispuestas para ser llamadas por ejemplo,
desde € o desde Visual Basic. Los mensajes son utilizados por Windows para
permitic que dos o mds aplicaciones-se comuniquen entre si y con ¢l propio sis-
1ema Windows, Se dice que las aplicaciones Windows'son conducidas por men-
SHJES O SUCESOS. T

-

Una libreria dindmica (Dynamic Link Libraries. abreviadamente DILLS) permite
que las aplicaciones Windows compartan ¢édigo y recursos. Una DLI. es actual-
mente un fichero ejecutable que contiene funciones de Windows que pueden ser
utilizadas por todas las aplicaciones,

Una de fas mejores caracteristicas de Visual Basic son sus librerias dindmi-
cus. Una DLL es una libreria de funciones que Windows lee y ejecuna atendiendo
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al Iaq necesidades del programa .EXE que se ejecuia. Lo opuesto a una DLL es
u}na libreria estdtica, donde las funciones necesarias para la ejecucién del progra-
“ma EXE. son copiadas en ¢l mismo durante ¢l proceso de compilacion y enlace
quc 1o genera.

La utilizacion de librerias dindmicas tiene ventajas. Una ventaja es que como
estin separadas del programa se pueden. aciualizar sin tener que modificar los
programas que fas utitizan. Otra veniaja es ¢l ahorro de memona principal y de
disco ya que como es Windows quien administra la utilizacion de las DILLs, no
existe duplicidad de codigo cuando varias aplicaciones las utilizan.

También. tiene inconvenientes. Uno de ellos es el iempo que Windows tiene
que emplear en leer las funciones que ¢l programa necestta utilizar de una DLL.
Otra desventaja es que cada programa cjeculable necesila que esién presentes las
DLLs gue utiliza. Cuando se utilizan fibrerias estdticas. las funciones que el pro-
grama necesita se incluyen en el mismo, por lo que ni se pierde tiempo en leerlas
ni la libreria ticne que estar presente.

I.as funciones de la APl de Windows estdn disponibles en las librerias: Ker-
nel,| GDI y User. Las DLLs para esas funciones estdn en los ficheros KER-
NEILEXE. GDLEXE v USER.EXE localizados en ¢l directorio SYSTEM de
Windows. Visual Basic puede uttlizar DLLs creadas en cualguicr lenguaje, con

| .
MUY Pocas excepiones.

‘Para acceder a las funciones de 1as librerias dindmicas. Visual Basic uiiliza la
scnul:ncia Declare. Afornunadamente. Microsolt dispone de un fichero Hamado
- WINAPLTXT:que contiene las sentencias Declare de cast tockas las funciones de
a API de Windows, ya que hay unas pocas funciones que Visual Basic no puede
utilizar porque trabajan con punteros. Este fichero. hasta ahora, no se suministia
con ‘el pagicte. Visual Basic. No obstante. en ¢! dm{udt que se adjunta y que
cnmrcne los ejfrcicios desarrollados en este libro. se incluye también este fichero

(concsm de M\L rosoft).

La mejor forma de unhmr el fichero WINAPLTXT es cargarlo en LI modulo
g,lobal de la aplicacion Visual Basic. no en su wialidad porque es mayor de 64K.
sino la parte de interés para Ta aplicacion en curso,

DECLARACION DE UNA FUNCION DE UNA DLL

Para .decl:lr:lr una funcion de una libreria dindmica, tiene Jue escribir una senfen-
cia Declare en el modulo global de la aplicaciin. o en la seccion de declaraciones
de b 12 0 del madulo correspondiente. Por ejeinplo.

% functien lopen LIb "Kermel* slias = _leopen® (& at
2pVal iReadirice s Integsr) s Inzeger

Observe en la declaracidon las palabras clave Lib (Libreria) y By Val (por va-
lar). Opcionalmente puede aparecer también la palabra clave Alias.

Si la funcidn no retorna un valor, declirela como un procedimicento Sub (en
lo sucesive emplearemos el término funcidn para referimos a una funcién o a un
procedimiento por compatibitidad con otros lenguajes como C). Por ejemplo,

Neclar: 9ab Clozsindow Lib "User” (BwWal hiod As Tntegsr)

La cldusula Lib indica a Visual Basic la librerin donde pucde eacontrar la
funcicn de Ta APl de Windows declarada. Las DILLs del entorno operativo estin
en "Kemel™, "GDI”, "User”, 0 en una de las DLLs correspondientes a un driver
de dispositivo tal como "Sound”. Para otras DLLs, ¢l nombre incluye el camino
completo. Por ejemplo "c:\windows\system\zexpand.dli”.

Los argumentos de una funciin pueden ser pasados por valor o por referencia.
Para pasar un argumento por valor, escriba la palabra clave ByVal delante de la
declaracidn del areumento,

Algunas funciones aceptan mds de un tipo de datos para un mismo argu-
mento. Esto se indica declarandu el argumento como Any. Por ejemplo,

Declare runcticon Catch Lib "Sermel" (lpCatchBuf =5 Ary) s Integer
Esta funcién puede ser llamada_con un argumento de tipo String, de tipo
Long, cte. : ~

resu% = Catcalargs$) AT
resu% = Catchlargg)

La cliusula Alias indica que la funcién tiene otro nombre en la libreria di-
ndmica (NLL). Esto es aul cuando el nombre de 1a funcidn coincide con alguna
palabra clave de Visual Basic, con alguna variahte o constante global. o el nom-
bre de la funcién en fa DLL tiene caracteres no reconocidos por Visual Basic. Por
cjemplo.

2 Lib "Kernel® ~lias "_lclos
(F7 al hFile As Integer) 35 Integer

En ewue ejemplo felose es el nombre que se uwtiliza en 1a aplicaciéon Visual
Busic paru referirse a la funcion v _felose es el nombre que tiene I nen la
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DI. lI Esto se hace asi porque en Visuat Basic un nombre ticne que comenzar con
una letra.

LLAMADA A UNA FUNCION DE UNA DLL

Una v °C i i
€z que se ha declarado una funcion. pueds <er invocada exaclamente igual
que otras funciones intrinsecas de Visual Basic. Por ejemplo. i

Declare Pmction IsTamis i "Gzar® (37720 Hnd 25 iveger) s Toeger

If IslIconic(Form2.hn

Este ejemplo Hama a la funcmn Islconic para verificar si la forma Fonn? es
un icono.

Visuallliasic no puede verificar si los vatores de los argumentos que se pasan
a una I‘uncu‘in de una DLL. sen correctos, Por lo tanto, si e pasan valores in‘cu-
recios, la funcién puede fallar. Quicre esiv decir que cuando experimente con
funciones de las DILLs, es aconsejable que guarde sus trabajos con frecuencia,

Visual Basic pasa todos los argumentos por referencia. Para pasar un argu-
len-m por valor anteponga en fa sentencia Declare la palabra By Val a la decla-
racion del argumento,

. Cuzmdnlhusquc iwformacion referente a una funcion de vna DL, si emplea
ocumentacion que utiliza el lenguaje C. recuerde que C pusa todos los argunen-
tos por valor excepto los amays. )

TIPOS DE D'_AT.OS EN LAS LLAMADAS

=
v H
Nl::: Basic muwpum muchos lipos de daos. de los cuates algunoes no son so-
portados por Iaslfunuunu de las tibrerfas dindmicas. Por lo wnto, hay que poner
vna especial atercidn cuando se llame a estas funciones,

Cadenas de caracteres (Strings)

l:ilS fl!nci(_\ncs de Ta-mayoria de Tas DLLs esperan cadenas de caracteres estindar
CASCUYZ) as cuales Timalizan con un caricter nulo (3 ANSD. En este caso. en
la declaracion de L funcion anteponga la palabra ByVal @ la declaracion d;:l '|‘J:IA
rimetro. De esta forma Visual Basie imerpreta gque tiene witizar ¢l estilo ¢ pari
pasar la cadena de caracteres. Por L misma razén. una funcion de una I)l'_l, ‘nn
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pucde retornar una cadena de caracieres. exceplo cuando s¢ haya escritu especili-
camente para Visual Basic. .

Si ta funcion ha sido escrita especilicamente pars Visual Basic. cntonces no
necesita utilizar la palabra ByVal. En este caso la funcion podria retorag una ca-

dena de caracteres.

Ya gque las cadenas son pasadas por referencia a una funcién de una DLL.
puede suceder que Ja funcion modifigue Ly cadena VB, En este case hay que lener
cuidado va gue si la longitud de la variable de caracieres no es suficiente, como la
Funcidn no puede incrementar dicha Jongitd. simplemente escribe a continuacion
del final Jestruyendo asi dreas de memornia. Para evitar este problema declare la
cadena de caracteres Yo suficientemente grunde.

Por cjemplo, 1a funcién GetWindowsDirectory cuva declaracion es,

Declars Sunct.lon GetWindowslirecicsy Lib "Yermal®
ty0at loiutfer fu Svring, Baal mSize s Tnteyer)

5 inteer

devuelve en su primer argumiento el camino del directorio Windows. Como nw-
dida de seguridad. para Wamar a la funcion declarare el primer anmments cunm
una cadena de longitud 255, Esto s,

Dim w s Inteaer, Cazino &8 string * 259
¥l = GetdindowsDirectory [Caxino, Len{Camino))

Otra solucion puede ser definir una cadena de Jongitud variable y reilenarla a

nulos. Esto es,

Dim ¥ 3s Integer, Camino As String
Cami=o = String$ (255, 0} ] .
W = CstWindowslirectory(Carino, Len (Caminol)

Arrays i

Recuerde, a una funcién VB (Function o Sub) se la puede pasar como argumento

un array integro. Por ejemplo.

Dec_zre Sub Fx {al), 1%, o) .
(1 To ¥itas, - o Cotsi
Call Zulwl(), Filas, Cols)
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Por el contrario, a una funcion de i DEL no se la puede pasar un array in-
lcnﬁ() de fa misma forma que a una funcién VB. Para pasar un aray intagro a una
funcmn de una DLE. se pasa el primer elementy del array por referencia. Esto es
a‘n porque los clementos del array estdn colocados én posiciones sucesivas de
lmmona Una funcion de una DLL a la que se le pasa ¢l primer elemento de un
.Jrray tiene acceso i todos los elementos del array. Esto no es totalmente cierto
para arrays de cadenas de caracteres.

Tipos definidos por el usuario (estructuras)

Algunas funciones de las DILs aceptan un tipo definido por ¢l usuario como

argumento (una estructura). Una estructura hay que pasarla por referencia. Por
ejemplo,

eit ~As Tnteger
lop ~35 Integer
Rignc A5 fnteczr.
.,oL._o*1 ~5 Integer
...-d "'Je

Decl‘are S Lwertfecs Lib "Csarm (372l 700 5s Twensr, lpfecs s FRTT)

g

Dim Posicidn s 2ECT .

La Hlamada siguiente pasa la estructura Posicidn a ta funcion TnvertRect.
- l

‘invertReco: hDC, Posicién

$| la estructura conticne miembros que son cadenas de caracteres. defing és-
tos de longjlud:hija.
N}

Punteros nulos

I
.—\Ilrmllas fununnu. de Tas DILLS esperan recibir como argumento un puntero nulo,
Para pasar un murero nulo a ana funcidn, declare el argumento de tipy Any v

pasc la expresion By Val 0&. Por ¢jemplo,

Function Find
lagsilame 3 Any

L5 Inteqger
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al muiorosoft Becel”)

Wiy Zpoacio

i

El echo de utilizar By Val para pasar la cadena de caracteres es, como hemos
expuesto anteriormente, para que Visual Basic inerprete que tiene que utilizar el
estilo C. N

Handles

Un handle cs un valor entero dnico delinido por ¢l entorno operativo y utilizado
para referirse a objetos tales como formas y controles; un handte es un nimero
de identificacidn (1D). Por ejemplo. hWnd (handle to Window) es un handle
para referirse a una ventana. hDC (handle 10 Device Context) es un handle para
referirse al conteato de dispositivo de un objeto, 1as funciones de las librerias di-
namicas utilizan mucho este tipu de pardmetro. Coando una Tuncidn de una DLI.
espera recibir como argumento un handle declirelo de tipo ByVat Integer. Por

ejemplo,
Declare -unctior: Isfoordc Jin "laert (Bdval heed Ss Integer) As Integer

¢ Ther

[W¥H

If Islconic{Torm2.h~

El entorno operativo asigna un handle a cada forma de una aplicacion VB,
para posteriormente identificarlas. La propiedad hWad de una forma, permite ac-
ceder a este bandle. Por cjemplo.

Sub Commandl_Click () . ~
1f Isltconic{Form2.7nn¢) Trnsen
IsgBox "FormZ ez In-icdono*
End If ] -
End £ub oh

Por contexto de dispositivo se entiende un conjunto de atributos (color de
fondo, tipo de letra. espaciado entre caracteres. posicion actua de la pluma, paleta
de colores, elc.) yue determinan la localizacion y [a apariencia de un objeto. Una
aplicacion no puede acceder al comeato de dispositivo directamente pero si lo
pucde hacer indirectaniente a través de la propicdad hDC del objeto (forma, caja
de imagen. u ohjeto Printer). Por ejemplo.

"Meclaracids
Declare Sub 7o T oAs Inteqger, ByVal ¥
: ByVal Color ~s Long)

' :
P N 7 P Nl
ScalcMode = 1 Sindows aibuia en plxs
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Formas y controles

No se puede pasar una forma o un control a una funcién de una DLL a no ser que
la funcién haya sido escrita especificamente para Visual Basic; tampoco se puede
pasar cualquicra de los objetos especiales {Screen. Clipboard, Printer, o Debug).

TIPOS DE WINDOWS

El fichero WINDOWS. H define nuevos nombres para algunos de los tipos estdn-
dar. La siguiente 1abla presenta estos tipos con sus equivalentes en C y en Visual
Basic. Esto le facilitard Ya uiilizacidn de documentacién para programacion en
Windows, escrita bajo el lenguaje C.

Propiedades

Las propiedades deben ser pasadas por valor. Por ejemplo,

mekearE "2 IE‘Ség é?/\,{: . -q?(gg;_; Windows C Visual Basic Definicidn
Clicx ) BOOL int ByVal Imeger Entero
jg Irngece:, iz Teiocer BYTE unsigned char
G- 10 o WORD unsigned int ByVai Integer Frtero
“2as0lucidn de e DWORD “unsigned long ByVal Long Lntero largo
,wlmv i ch 3 GetDaviceCaps (7 I.LPSTR char far * ByVal String Cadena de caracteres
- srar” ATOM WORD ByVal Integer Lniero
TR Hyo mxs HANDLE WORD ByVal Integer  Entero
S s Vi HWND HANDIE ByVal [nteger Entero
o HICON ‘1IANDLE BvVal Integer  Entero
Este ejemplo obtiene la resotucién de la pantalia y de ly impresora actualmen- “DC_ ”ANDI'I:: ByVal lnteger Fntero
te seleccionadar Para ello se pasa a la Tuncidn la propiedad hDC. HMENU HANDLE . ByVal Integer Entero
o ‘ HBITMAP HANDLE - ° ByVal Imeger Entero
Para pasaruna propiedad por referencia se debe de utilizar una variable in- COLORREF DWORD . ."ByVal Long - Entero largo

-

termedia, Todas fas cadenas son pasadas por referencia: por lo wnto. para pasar o .

una propiedad que sea una cadena de caracieres a una funcidn de una DLLL pri- Cé S . . :
6mo pasar un valor a'un pardmetro de tipo BYTE

Mero s¢ aswn‘I ha propicdad 2 una vanable de caracteres y después se pasa la va- p aunp d P

riable. Por qv.snpln. para almacenar el camino Jel directorio Windows en fa pro-

picdad Path d31a lisia de icheros Filel. escriba: Algunas funciones de las DLLs aceptan un valor de tipo BYTE. Como este tipo

de Jdatos no estd delinido en Visual Basic, se debe pasar un dato de tipo Integer.

Por ejemplo, la funcién GetTempFileName cuya sintaxis es,

Deciare Toction CGeu v Zib "Herralr (Byval

=el rilze S5 luteger) S
int (;oL'I‘emr)h leName (27 TE CD"l-uh tter,
coeieg ] T jS{I‘R lpPrafixString,
- WORD wunigue,
LT5TR IpTterpfiletiame)

: Z‘.-;vn {Camino})

crea un nimbre dnico para un lichero temporad que la aplicacion puede widizar

Para pasar propicdades nuiméricas por referencia, utilice ke misni éenica, parat almacenar ditos,
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La declaracion de esta funcion en Visual Bzsic. seria de 1a forma siguiente:

Déclare Function Ge:z?7 " : in evevnelt
¢ Byvail chr .
Byval 1un?
RyWVal winl
' ByvVal lpTexy : I AS InCeger

La razdn es que el lipo mas pequedio de datos que se pone en la pla de un
microprocesador 80x86 ¢s un palabra. Por lo antu. el tipo BYTE igual que cl In-
teger requicre una palabra de memoria para almacenarse en la pila, Yo que nos
conduce a resultados idénticos, o :

MENSAJES

La caracteristica primaria de la APl de Windows son las funciones y los mensajes
Windows. Hacieado uso de los mensajes de Windows se puede obtener inforsm-
cién !de un control, que no se puede obiener utilizando sélo las caracteristicas
propias de Visual Basic, Para utilizar las funciones y los mensajes Windows, es
necesario conucer de cada una/o de ellasfos su finalidad, sintaxis, valor que de-
vuelve y pardmetros que utiliza. Encomtrard una amplia informacién tamo de las
funciones como de los mensajes Windows en ~Microsoft Windows SDK™.

Un mensaje consta de tres partes:

» Nimero de measaje, identificado por el nombre del mensaje.
. Llln pardmetro word {16 bits). referenciado por wfaram.
o« Un pur;illlc[fo long (32 bits), refereaciado por {Param.

Por ejesnplo, EM_GETLINE copia una linea de un objeto multitinea a un
irea de mcmu'r"& (huffer). El pardmetra wParam define ¢l minero de linea; la
primelra lineu ¢ ‘Ia (). El parimetro {Param apunta al drea de memoria donde se
almacena Ja linga. E} nimero mdximo de caracieres que se pueden copiar se pone
en la primera palabra del bhufTer,

! .
La sintaxis para enviar un mensaje es la siguiente:

Declare Function Senc¥e

i}
Wi

K]

Tzt
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El parametro hiWnd es el handle de la ventana que recibe el inensaje y el pa-
rimetro wMsg es el mensaje que se envia. Los parimetros wllaram y Param
contienen informacién adicional al mensaje que encontrard ¢n la descripeion del
propio mensaje. Por ejemplo.

Er_GZTLINE,
~z2a), Bufier$)

endM

t

Fosk =

Cada uno de estos mensajes s¢ encuemra definido en un fichero escrito en
lenguaje C, del SDK de Windows (Software Development Kit) denominado
WINDOWS H y las declaraciones equivalentes en Visual Basic, se encuentran en
el fichero WINAPLTXT suministrado en ¢l disquete que se adjunta. Por ejemplo,

Globa! Const “WM_USER = LH400
Global Const ZM_GE1LINE = WM_USER+20

EDITOR DE TEXTOS

FI siguiente ejemplo utiliza una caja de texto multilinea para hnplementar un
editor de textos y para demostrar la utilizacion de la funcidn SendMlessage y de
varios mensajes de la AP1 de Windows.

El editor realizari las siguientes operaciones:

e Cuando ¢l usuario escriba Vineas de texto, se indicard en la linca de estado
(Iinea del fondo) el nimero de la linea sobre la que estd el cursor y el ndmero
total de lineas del wexto, ‘

‘b

o Tendrd un menti Fichero con las ordenes, Nuevo, Abrir, Guardar y Salir.
Con respecto a las dos primc;ms-drdcncs. no tmplementaremos su funcion
pero si visualizario el nwnsajcl."j,(}uicre salvar los cambios?” cuando alguna
de ellas se cjecute y el teato haya cambiado. Este mensaje no aparecerd si
previamenie se ha ejecutado la orden Guardar. La orden Safir estard opera-
tiva v también detectard si el texto ha cambiado y no se ha guardado, con el
fin de notificar al usuanio si desea guardar los cambios antes de salir,

e Tendrd un mend Edicidn con las drdenes, Deshacer, Cortar, Copiar, Pegar 'y
Borrar. Todas estas Grdenes estarin operativas.

Inicie una nueva aplicacion y cree una forma titulada Editor con los comtroles
que se indican en la tabla siguiente.” Guarde la aplicacion con ¢l nombre Fdi-
tor.mak v la Torma con ¢l nombre Editor frm,
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Objeto Propiedad Valor
Menii Fichero Caption &Fichero
CilName MentiFichero
Fichero: orden 0 Caption &Nuevo
CtiName NuevokFichero
Fichero: orden | Caption & Abnir
CtName AbrirFichero !
Fichero: orden 2 Caption & Guardar :
CiName GuardarFichero
Fichero: separador - Caption -
CuName guiones|
Ficheru: orden 3 Caption &Salir :
CudName SalirFichero ;
Ment Edicidn Caption &Edicién :
CtkName MenudEdicidgn S
Edicion: orden 0 Caption & Deshacer
CiName Deshacerkdicién
Edicidén: separador Caption
) CtlName ouiones?
I=dicidn: orden | Caption Cor&tar
CtIName ConarEdicion
Edicion: orden 2 Caption & Cupiar |
: s CtlName CopiarEdicion |
Edicién: orden 3 Caption & Pegar
-' CName PegarFdicidn
Edicidn: orden 4 Caption & Borrar
N CuUName BorrarEdicion
Forma o FormName Forml
X Caption Editor
Caja de texto ‘| CiName Teatl
Text {nada}
Multiline True
ScrollBars 2 - Ventical
Etiqueta CtiName Labell |
Caption ldel |
AutoSize True :
Temporizador CuName Timer! :
Interval 330 |
Enabled True J
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Chis

Renlice 1as sigutentes definiciones a nivel de Ta [orwa.

Defint -7 ) o
Const CLNCEL:R = 2, SI = 6, CIRL = 2
’ La sentencia DefIni A-Z indica que por defecto todas fas variables son ente-

ras. Las constamtes CANCELAR v 51 se comesponden con los valores devuehos

por la funcicn MsgBox.

Cuando cf usuario ejecute la orden Salir. el procedimienio asucml.u I:umz: a':.n
‘ it i T : texto ha

funcion TexteModificado para venticar si s¢ ha modificado e! 'luun. Si ¢ ooy

sido mudificado, el procedimiento Mensaje invoca 4 la funcion MensajeGuarde

W ice "El 1e a si ihcado”,
gue visualiza una ventana con un titulo que dice "El tento ha side ;}Udll,!.l v
- .5 aue.dice " Quiere salvi ¥ 1057 L
una pregunta dirigida al usuano que. dice (._Qmm. salvar los cam , my“ada
bmuucsv Cancelar, Si y No. para que el usuario responda a 1a pnggma (;n e ei
bl sepyesta {6 = Si. 7= N = Cancelar). 3
La variable Bordn almacena esta respyesta 6=S5i.7=Noy 2 ‘

rexto no ha sido modificado. simplemente se tinaliza la aplicacton.

@ i Quiere salvar los cambios?

| o | | cancetar '

frere que se muestnaa coptinuacion.

S

Escriba el procedunicite Sufirfic
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(}
Then

.—\bm fa ventana de cédiga e inicic un nugvo procedimiento denominado Men-
suje (orden New Procedure del ment Code) y escriba el codigo que s¢ muestra a

continuacion.

Sub e ()
arlacé:*. = MensajeGuardar(}
Szlect Case Bordn

Cesz CAMNUELAZ

Sub

guarde el [ichero

add.lmc en el modulo Editor.bas.

Guando e} usuario ejecute 1a orden Grardar, ¢l procedimiento asociado guar-
dard el texwo y pondrd el indicador de modificado a cero. (False - no modificado)
para In cual invocard al procedimiento NoModificade que se presenta un poco

mas adcldnl-. cn el médulo Editor.bus.

Sub Guah\lar?ichero_(‘,‘l ick ()
fagu i, guarde el [ichero
1gModi<icado

E..ci lsub _"‘

)

'Cuando el usuario cjecute ki orden Nueve. ¢f procedimienio asocia

rd si se ha modificado el texto actualmente en proceso. en cuyo caso permilird
ntinuacion limpiard la ventana de exto y pondrd el indicador de

1
wugrdarlo. vy ac
modificado a cero (False - no muditicado).

t

Sup [tugrorichero_Click ()
£ TexzoModificedol} Thnen

LI IET T

e

o
G

!

O

Laﬁ funciones TevtoMadificado y MensajeGuardar se detallan un poco mis

E

¢

b
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Cuando ¢l usuario ejecute 1a orden Abrir, el procedimiento asociado verifica-
rd si se ha modificado el texto actualmente en proceso, en cuyo caso permitird
euardarto. y a continuacion cargard en [a vemana de texto ¢l fichero elegido de la
lista {esta operacion no se implementa) v pondri ¢l indicador de modificado a
cero (False - no mudificado). -

Sub rbrirFichero_Ciizs ()
If 1exLoHoq1:1ch:;' Then
Mensaje
Endg 1f

rero que desea abrir
el fichero glegido”

‘Codigo para elegir
Texil . Text = "S2 vig:
MoMcdif icado

end Sub

Suponga ahora que ¢l usuario sale de 1a aplicacion ejecutando 1a orden Cerrar
del ment de control de la ventana. En este caso se da el suceso Unload y k forma
se descarga. Por lo tanto, el provedimiento conducido por este suceso tiene que
ejecutar las mismas acciones gue el procedimicnto Salirtichero_Click con fa ii-
ferencia de que agui no se necesita una sentencia End.

S5ub Form_Untoad {(Canzsl As Iniager)
I Textolodiitcadet) Thern
Botdn = MensajeCuzrdar ()
Select Cacse Botd-
Case CrNCEILAR
Cancel = -1
Exic Sub )
Case S5I o '
© ‘thgui, guardsz @l fichero
Erd Select .
End Tf T -
Fnd Sub oo
LN
El parimetro Cancel de esie procedimionto es verificado astomiticamente
por ¢l sistema al finahzar-la ejecucion del mismo. Si su valor es cero fa forma se
descarga: si su valor es distinto de cero la forma no se descarga. Entonces, si of
usuarieor intenta cerrar la aplicacton a ravés del mena de control y ¢l texto ha sido
madificado, igoal que en procedimientos anteriores se visualiza una caja de did-
logo advirtiéndole de este hecho: si pulsa el botén Cancelar de esta caja, Ja forma
no debe descargarse para 1o cual hay que poner el pardmetro Cancel a un. valor

distinto de cero.

Para reflejar en la linca de estado el nimero de linea donde actualmente se
encuentra el cursor UActual v el namero wtal de lineas (Fhineas) se utiliza un
temporizador cuvo procedimiento isociado actualiza cada 357 segundos
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(propiedad interval), las varables que conticnen estos valores. bas variabley
LActualAnt ¥ TLineasAnt contienen los valores anteriotes a los actuales.

Fseriba el siguiente procedimiento conducido por el suceso Timer. La lun-

.cién LineaAcrial devuelve el ndmero de linea donde actualmente se encuentra ¢l

cursor ¥ la funcion ToralLineas el nimero total de lincas. Ambas funciones se
detallan un poco mds adelante. en el médulo Editor.bas.

Sub Timer!_7i
Lrtcrusl = )
TLineas = st}

;o Or TLineas <> ThLineasin
SIrs(iicrual) + " de" + Sors(

A continuacién vamos a escribir los procedimientos para las érdenes corres-
pondientes al menu Edicion.

Sub Deshazcerbdicidn Clizx ()
Deshacer
End Sun

Sub Corcarsdicid:_Ciicx ()
Corvar :
End Sub
B
Sub Copiarzdiciéa_Clica ()
Coplar
End Sub

Sub Pegardicidr_Click () -» o
Pegsr ¢
end Sub L
I
Sub BorrarZdiciZna_Clicx (1}
Borrar '
End Sub

Estos procedimientos llaman a otros tantos procedimientos definidos en el
médulo Ediror bas, que tras enviar un mensaje a Windows realizan 1a operagion i
la que hacen referencia.
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Para completar 1a aplicacién vamos a desarrollar un procedimiento gue per-
mita borrar 1a linea subre la que estd el cursor. cuando el usuario pulse las teclas
Ctri+Y. Para ello. hay que tener en cuenta que la linea | de nuesiro editor es la )
para Windows, valor devuelto por el mensaje EM_LINEFROMCHAR.

_Kewdown (ZeyCole ~s Integer, Sniit &s Irteger)

t = CTRL ~nd XeyCoce = ~sc(®:" ?hen .
ual = Linmeaicruzal() - 1 'parz wWincows una mencs
.Selstart = Caracteresintesi{iictuall =
- inea = Caracteresintes{iaciuzal - 1) - Texti.SelStarg
SeiiLength = LonglLinea
.Seifext = "

Para finalizar la aphcacion, cree un nuevo midulo llamado Editar bus y es-
criba las siguientes declaraciones. definiciones. funciones y procedimientos refe-
renciadas/os en los procedimientos hasta ahora expuestos. Sinplemente por clari-
dad en el disefio, el uutor ha preferido incluir todos los procedimientos y funcio-
nes que Naman a funciones de Ja APl de Windows en un maodulo aparte. Al ﬁn;.ﬂ
podrd compiobar que es posible prescindir de este modulo y por lo tanto reducir
el nimero wtal de procedimientos desarrollados.

pefInt ~-2

Declare Function Send:essacge Lib " {
Byval A8 Inteqer,
ByVal Ls Integer,

Byval wParam As Integer,
lPara> =58 Any) ~s Long

Declare Function GetFocus Lib *"User® () As integer

'‘Constantes correspondiertesya los menss =5 que serén enviados
Const WM_USER = 1024 + n

Const wWM_CUT = 768

const WH_COPY = 769

Const i _PASTE .= 770

Const w4_CLEAR = 771

Const IM_GETMODIFY WM_USFER + 8
Const EZM_SETMODIFY = “M_USER + 9 ‘
Const EM_LINRTHBEAZ = WM_USER + 11

Const I_LINEFROMCHAZ = WM_USER - 202
Const CUHDO = wWHM_USER o+ 23 A
Const ZW_GETLIMNECOUIT = WH_US¥ER + 1.

Function Mense

dajefrardar ()
Tiwuions = "kl

ichero ha sido meziiicaco
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!” 595 = “:Quierz salver los cetbios?s Funciion Caractereshntes (Laciual 3 Integer)
.‘ ensaeGuarcdar = Msg3ox(Msg$, 19, _tulOS] hurd = GetFocus ()
¥ zzrerestntes = Sendiessage (hiyd, B LTETDEX, Lactual, Ca)

lie
d Lnczion . : Car
i Co fnd Tunction
Punctlo* T=

to¥eililicado ()
Ih'nd = Foc

' S, k:n este médulo aparecen en primer lugar las sentencias Declare para las fun-
o BLEEIODIY, 0, G * o) ciones de la AP! de Windows SendMessage v GetFocus.

La utilizacion de la funcién SendMessage depende de la prnpiedad'h\\'nd
del objeto al cual se quiere enviar ¢l mensaje. Desaforiunadamente, esta propie-

hi'vnﬂ = Ll‘OCCS(}
- (\jff = SencHessags(hWnd, EM_SETMODIFY, 0, 0&) = -1 - dad sélo la tienen las formas. No obstante, existen varias maneras de encontrar cl
nd Sub : handle (hWnd) de un conteol utilizando Yas funciones de la APl de Windows. L.a

mas sencilla es utilizar 1a funcidn GetFocus. Esta funcion devuelve ¢l hWad del

Functicrn Lirearc-:al ()
| - ) contrel que actualimente posee el foco.

hl'.‘nc = CetFocus|(
leeal_ﬁ:'fa = SenMzssage(hwnd, BM_LINEFROMCH=R, -1, 08£) + 1

Los valores de WM_USER y superiores. hasta 32767, pueden ser utilizados
por una aplicacién para definir mensajes. Observe que Windows define un men-

Fukl;n_‘c:t(iio.—; L.or,a ILix ; as () saje como un nomero WM_USER +valor. Si usted necesita definir un mensaje de
- awn = SCLerocus i) . .. :
! este modo, elija un valor que no se solape con los definidos en el fichero WIN-
TOtal.'_l."f mANE , ad 00 . . .
= Sensviessage (hnd, BN GETLINZCOMT, 0, 05) DOWS. H (0o WINAPLTXTY: por ejemplo, por encima de 2. La siguiente tabla

End Funczion

Sub Deshacer {)

especifica los mensaje utilizados en esta aplicacion.

hiWnd = Ge_'ti?ocu:- {) Mensaje Significado
En;rS;bSc.:C:';t‘bSa’;: toking, EM_UNDO, 0. &) WM_CUT Muecve el texto seleccionady en un control al ponapa-
peles.
Sub| Corzar, {) WM_COPY Copia el texto seleccionado en un control en el pona-
hWnd = GetFocus(}) ] papeles. -
vr = SehcHessecz{hWnd, WM_CUT, 0, 0&} : WM_PASTE Copia el texto del portapapeles en un control.
End| Sun ; ' WM_CLEAR Borra el texto seleccionado ¢n un_control sin copiarlo
Sub Coo‘;c () ‘ o ' et el portapapeles. o
heingd = MeFocus () EM_UNDO ' Deshace eliltimo cambio,
vr .= SendMesszzzinking, WM_COPY, 0, 0&) EM_GETMODIFY Determina si se ha modificado el texto del control.
End| Sub - |, K EM_SETMODIFY Activa {(wParam = True) o desactiiva (wParam =
) o . ' False) el indicador de modificado del control.
Sull?l.rpggfr(‘;‘). e EM_LINEINDEX Devuelve la posiciin que ocupa en el texto el primer
vl%n(z éc:cu.be:z;i_)(m*rc KM_DASTE, 0. 06 caricter de la linea especificada. Este valor se corres-
‘End|sth ) - ponde con ¢l ndmero de caracteres que hay antes del
) principio de la linea,
Sub |¥ EM_LINEFROMCHAR  Devuelve el mimero de linea correspondiente al texto
(SRR o ) ' seleccionado (wParam = -1) o la posicion en el lexto
};‘nr\:’i! , PHLCLEST 0, B de un determinado cardcter (wParam > 0).
- EM_GETLINECOUNT  Determina el nimero de lineas de teato que hay en un
w : ) . : N control multilinea, .
i,
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Légicamente, nos estamos refiriendo a un control que permite la edicién. En
AUEsiro caso se trata de wna caja de texto multilinea.

BORRAR UNA LISTA

El siguiente ejemplo muestra como borrar rpidamente una hista. Hasta ahora esie
proceso lo hemos realizado borrande un elemento cada vez. Esto es,

No While List1l.ListCournz > 0
Listl.Removelten 0
Loop -

Pura borrar todas las entradas de una lista de una sola vez, simplemente hay
que enviar a fa mismit el mensaje EB_RESETCONTENT de Windows,

Inicie una nueva aplicacion y cree una forma titulada Liste con los controles
que se indican en {a tabla siguiente. Guarde a aplicacion con el nombre Lista.mak
y la forma con el nombee Lista frm.

Ohjeto Propiedad Valor

Lista ; CilName Listl
Soned True

Botén Caption Borrar lista
CtiName Borrarl.ista

Co Listi O
: | Boras at |

Escriba la siguiente sentencia en la seceion de declaraciones de fa forma,

DefInt A-Z
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Para probar 1a aplicacién necesitamos afadir algin clemento a fa lista. Ewe
proceso pucde realizarse cuando se inicia la aplicacion. Para ello. escriba el pro-
cedimiento Form_Load que se presenta a continuacian,

~rrada_" + FormatsS(l, "007)

Cuando el usuario pulse ¢l boién Borrar lista todas las entradas de la lista se
borrarn. Para realizar esta tarea el procedimiento asociado con este botdn, invoca
al procedimiento Borrar_Lista y le pasa como argumento el control Listal. Este
procedimiento, que s¢ detalla a continuacion en el mddulo Lista.bas, coge ¢l
handle de Listad para a continuacion enviarle el mensaje cum:_spundiénlc.

iisra_Click ()}
isca

Para finalizar la aplicacién. cree un nuevo médulo Hamado Lista.bas y es-
criba las siguientes declaraciones, defiiciones, funciones y procedimientos refe-
renciadas/os en los procedimientos hasta ahora expuestos.

Declizre Function SencdMessage Lib "User™

S Byval hwnd As Integer,
Byval wMsg As Integer,
ByVal wParam As Integer,
lPavam As Any) 2s Long

'
{

Sec_zr2

Ry
uiction CetTocus" Lib *"User” () As Integer

stion SetTocusAPI Lib "User™ Alias

trocus" (ByvVal hWwnd As Iinteger) is Intzs<zer
= 1024
CONTENT = WM_USER + 5

Para enviar un mensije 2 un control, primero hay que salvar el handle def
control ue actualmente estd enfocado, después se enfoca el control al que se
guiere enviar el mensaje y e recupera su handle y por dllimo. se vuelve a enfo-
car ¢l control onginal. Esto es,

T T
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‘nidControl (Cori
tocus () ‘'handle cei Conor
ocus z

?uqctio:
t hivnd = C

QoD

El mensaje 1.B_RESETCONTENT borra todos los eletmentos de una fista v
Ilhcra la menwria asociada con ellos. La sintaxis para enviar este mensaje es la
SIgUICIlIC

ars)

wrParamz, .

vr = SendMessage (niindg, Msgi,

donde AWad identifica al control que va a recibir el mensaje. Msg es el mensaje a
envmr (&HH03) y wlaram y [Param no se utilizan (valor cero).

Sub Bor-er_fLista {Ctrl As Corcrol)

h‘.nd = hwndControl {Cirl) 'recupera Z= Cerl
vr = SencMessage (hlrd, L3_RISIZTCONTZ '
~nd Sub

PALABRA DE PASO

‘ .

| ' _
Un control tiene varios_estitos de edicion: por ejemplo. texto ajustado a la iz-
quierda, texto centrado, desplazamiento vertical automatico. teato en mas dsculas,
pululhra de pasuo. ete. El estilo utilizado para introducir una palabra de paso es que
cualguier caricler que se ¢seriba se visualice como un asterisco (%), Visual Basic
no ln.nc ninguna funcion para que cuando se escriba un caricter en un control, se
visualice un asterisco en su Jugar. Para consepuir ésto. hay que wilizar las si-
uunclntes funciones de la APl de Windows: GetFocus. GetWindowlLong. Set-

Window I,onls ¥ SendDMessuge,
J

; IPJT{] crear una cija de texto con estile palabra de pase hay que realizar los
pasos siguientg's:

L lUlilizundn la funcién GetFoeus se toma el handle de la caja de tevo.
i hinés = GetFocus () '
2.1 A continuacidn, wtilizando el argumento GWL_STYLE con la funcién Gel-

R
|
| i\\mduu'l.ung se recupera el estilo de Ja caja de testo.
FEstiloi = Gewvindowiong (hingi, GWi_&77iz)
|

3. Despuds, unilizando ta tuncién SetWindow Long se pone ¢l nueve oxtilo o la
' Te teatn,
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2.

Estcilo& = Zstiiod Or ES_PASSWCED .
Fstilo&é = SecWindowLonglhnwncéd, CWL_STYLE, Estilok)

4. Poriltimo, enviando ¢l mensaje ES_SETPASSWORDCHAR se informa al

comtrol, del cardcier que se va a utihizar como midscara para la palabra de
paso. El cardcter utilizado normalmente es un asterisco (*},

Miscararsasod =
vr = Sendessage (handk, E.\SI:IPW\U{IIJHR MiscaraPoasok, L)

E) siguiente ¢jemplo muestra como utilizar una caja de texto para introducir
una palabra de paso.

Inicie una nueva aplicacién v cree una forma titwlada Forml con los controles
que se indican en la rabla siguiente. Guarde la aplicacion con el nombre
ppaso.mak y 1a forma con el nombre ppaso fim.

Objeto Prapiedad Valor
Etiqueta Caption Palabra de paso:
Tabindex 0 _
Caja de texto CilName PPaso
Text {nada)
Tabindex 1
Boén Capiton Aceptar i
CtlName Aceptar
Default True
Tabindex’ 2

e il

S

Palabia de past:: I

]

:

Cuando el usuario ejecute la aplicacion, le forma Ferm{ se cargard y [a caja
de testo PPaso quedard eafocada. Fsto hace gque se dé el suceso GotFocus para
este control y por o tanto, gue se cjecute el procedimiento 'Pase_Gotbocus.
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En tiempo de ejecucion el cursor lo recibe el control que tenga ¢k valor de
TabEndex mas bajo de aquellos que pueden recibirlo (los mends y los wempori-
zatores no tienen propiedad TabIndex v en uempo de ejecucion. no pueden re-
cihir el cursor los controles invisibles o desacuvados, las ctiquetas ¥ Tos marcos).

t:] procedimiento PPaso_GotFocus. utilizando la variable estitica Sefifecuid,
permitird que se ejecute una sola vez el procedimiento EstiloPPase que pone a la
caja de texto PPaso el esulo de edicidn de palabra de paso.

Sub PPaso_Gotfocus ()
Static SeEjecuid s Irmzezer
1f Hot SeEjecucd Trer
SeREjzcutd =
EstiloPlPaso Zsc(" ")
End TIf
end Sub

*igual a True

El procedimiento EstifoPPaso se escribe a conliina o vn el madulo
ppaso.bas.

Cuando ¢l vsuario haya escrito fa palabra de paso, pulsard Enter o ¢l botén
Aceprar. Esto hace que se ejecute el procedimiento Aceprar _Click que comproeba
si es correcta la palabra de paso: si bo ¢s correcta se permitirid al vsuario repetie la
entrada hasta un maximo de tres veees. .

Suby Aceprar_Click
Dim Clave As Stri
Static Cuenta -:s
Clave =.PPaso.Tex:
1£ UCasesi{Clave) <>

MsgBox';"La palabra
Cuernta:-= Cuenta + .

1f Cusgta = 3 Than Ind
PPaso.lext = "

PPaso. FetFocus

Else '

‘Conctinde el preczzs
End If
Frid sub

* Then
no s correcté”, 16

Para finalizar la aplicacidon, cree un nuevo moadulo lamado ppeasenbas y es-
criba Jas sizuientes declaraciones. deliniciones. funciones y procedimientos refe-
renciadis/os en los procedimientos hast ahora expuestos.

Declzre Furnciion SerdMessage Lib’ "User® (
- Byval kwnd As Integer,
ByVal wi¥sg As Integer,
RyvVal wraram Ais Intecsr,
- lParam s Any} is Loz

Declere Function Cetrocus Lib "User* () As Integer -

Declare Furnction GezwindowLong Lib *User® |
3yVal hwWnd As Integer,
3yVal nIndex As Integer) As L2ng

Declara Function SetwindowLong L.ib *User" {
dyVal hWnd As Integer,
3yval nIndex ~s Integer,
3yval dwNewLong As Longl) s ang

Const “M_USER = 1024
Const THM_SZTPASSWORDCHEAR = WM_USER + 28
Cons:z =5_PASSWORD = 12

Const GWL_STYLE = -1

Wy

Sub EsriloiPaseo (Mascara As Long}

Dim awnd 2s Inveger, Estilo As Long, vr As Long

hWné = GetfFocus

Estilo = CetWindowiong{hWwnd, GWL_STYLE)

Estilo = Estilo Or ES_PASSWORD '

Estilo = SetWindowlong(hWnd, GWL_STYLE, Estilo}

vr = SendMessage (hwnd, EM_SETPASSWORDCHAR, lMascara, 0)
End S:o o .

MOVIENDO CONTROLES ENTRE FORMAS -

‘
1

Visual Basic no soporta el movithiento de controles entre formas. No obstante,
creando en cada furma un array de controles del mismo tipo que ¢l control gue se
yuiere mover, se puede simular el movimiento de un contiol de una forma a otra.
Para conseguir ésto. hay que utilizar las siguientes funciones de la APl de Win-
dows: GetFocus y GetParent.

Para simular ¢l movimienio de controles entre formas, realice los pasos si-
guientes:
1. Inicie una nueva aplicacion. Esto hace que se cree una forma Forml.
2. Cree una nueva fuorma Ferm? (orden New Form del ment File).

3. Cree un nuevo madule mover.bas (orden New Module del mena File).
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Else
Mover = NO
Forma.Mover.Capticn = “Movsr = lig®
End 1%
For 1 = 0 To &
‘ Forma.Orden(i) .Drac¥ode = Nover
Next T
End Sub

IMPRIMIR UNA IMAGEN VISUAL BASIC

Visual Basic tiene un método denominado PrintForm que permite imprimir to-
dos los controles visibles y mapas de bits de una forma. Por ejemplo,

Forml.PrintForm

. El método PrintForm también imprime los gréficos e imagenes anadidosfas
a |n ftorma cn liempo de ejecucion, si la propiedad AutoRedraw de los mismos es
True (-1).

ll"n cambio, no hay forma de imprimir.sito una imagen a menos que se uti-
hu:nI funciones de 1a APL de Windows. Esto es Gtil cuando se yuiere controlar la
POSl(;IOH o el tamaiio de la imagen que se desea imprimir; también es Gl cuando
en una iisma haja se quiere incluir una determinada imagen con otras imagenes
0 texto,
. i- .

f;ara imprimir una imagen, siga los pasos siguientes:

| ‘

l. Crce un cohtexto de dispositivo en memoria (memory device context - mD(_)
que seq comp.lllblc con el mapa de bits que desea imprimir. Un contexto de
(llsposulvdnén memoria es un blogue de memoria que se wtiliza para preparar
Ia imagen antes de imprimirla. Para ello, utilice ty funuon de la Al’[ de
Windows (“Treate( ompatibleDC.

i‘hmIJC = CreateCompatibleDC{Piczurel hpC)

Esta funcién devuetve un handle al mDC creado. EI mDC cs compatible
con el dispositivo especificado por hDC.

2. Seleccione la imagen y muévala al contexto de dispositive creado. Para rea-
lizar esta operacion, utilice Ia funcién de la AP[ de Windows SelectUbject.

hBit¥ap = SelectObject(hmdC, Piccturel.Picturs)
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Si en el mDC hay un’objeto del mismo ripo, resultado de una seleccién
anterior, ésle €5 removido por el nuevo objeto seleccionado. La funcién
SelectObject devuelve el handle det objeto removido.

) 4
3. Liilice Ta funcién StretchBlt para copiar el mapa de bits del conlexto de
dispositivo en memoria. a la impresora. Los argumemos de esta funcién
indican tanto para ¢l destino comoe para ¢l origen, ¢l dispositivo, esquina
superior izquierda ¥ 1amaio deb recngulo que contiene la imagen. Esta
funcion devuelve un cero st ocurre uit error y un valor distinto de cero en caso
contrario.

= “ox—PI = Strencrzt
Pringer.=27, 0, 0,

Frinter.&ralewidth, Srintcer.Scaleieight,
hene, 6,77,

Plcrurel . Icalewidon, 2icrurel.Scaleleiagh:,
SRCCO2Y}

4. Utilice la funcion DeleteDC para borrar el mapa de bits del contexto de
dispositivo en memoria. Esta operacidn exige invocar previamente a la fun-
cién SelectObject, ya que un objeto seleccionado y movido a un contexto de
dispositive no puede borrarse hasta que ao sea removido por otro. La funcion
DeleteDC devuelve un cero si ocurre un error ¥ un valor distinto de cero en
€a50 CoNLrario.
hBitMap = SelectOhbiect (hmDC, h3itHap)

ErvorAPI = Delete2Z (hmDC)

Como ejemiplo. inicie una nueva dphicacion y cree una forma titulada Forirl
con los controles que se indican en 1a tabla siguiente. Guarde Ya aplicacion con el

nombre printer.mak y la forma con el nombre printer.frm. R .
Objeto Propiedad' Valor
Imagen CilName A Pictuire |l .
AutoRedraw True
AutoSize True
Piciure S Avbebtbrdelk bmp
Botén Caption [mprimir
CilName imprinyr
Drefauht True

Para que este ejemplo irabgje correctamente necesita utilizar una impresora
laser estindar tno PostScript).
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Anada las sizuientes declanaciones a la seccion de declaraciones de la forma.
Recuerde que cada sentencia Declare debe estar ¢n una sola linea.

-eclare ComnpatiniedC
~s Inczger)
Seclare Object
~s In
nchiect 2

oeclare

i

Tunckion Sire

By
ierelC Lib TCRIT

Zeclare Fuhction
3 hC Ls Intecger) ~s Intssars

3

Cuandu el usvario cjecute la aplicacion v pulse el boadn fnpremir s obtendrd
por Fa impresora laimagen especificindi por el codigo ded procedimiento que se
presenta a contimicion. Li posicion v el timano de B bmagen se especilican en
ta Hamada a o Mancion Streteh Bl

Abra L ventana Je cddigo correspondiente al botin tmprimir v escriba ¢l
procedimienta siguicnte.
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Sub Imprimir_Clice«
Diz rval S5 Tnltocer,
Const SECCOVY = iF
Congt. PIAEL 3
Const NEWFRAME =

-, Errorn?l &5 Integer
= origen

'vigualizar el rel2f c=2 zrevé
ViousePointer = 1

‘Picturel.Scalelo
Printer.ScaleMocs =

Printer.Print ‘a. ae-zar ur2 lirea

habDC = CreateCons
hBitMap = SeleciCh?

‘pleZl(Picturel . hDC)
zco (=7DC, Picturel ., Picture)

‘Colocar en el destino La mage cenirada y de tanafo 5 veces el raal
ErrorAPl = Strecch3ic{Zrinter.nicC,
Frinter.S-aladidn ° 2 - Ploirel.Scaleiidrh * 5\ 2, 0,
Picturel.Scalewi3-h * 3, Picturel.Scaleileight * 5,
hmpC, 0, 0,
Picturel.Scalenidon, Ficrurel.Scaleleight,
SRCCOPY) ’

hBitMap - SelectCoizct {7m0C, h3itHMap)
ErrorAPI = DeletelC{hmDC)}

'print Escape{Princer.aiC, LTWFRAE, 0, Byval 04, Byval 0&)
Printer.NewPage ~

Printer.EndbDoc Sid
1 Iy
MouscPointer = 1 'rastaurar e! puntero del ratdn
Fnd Sub

La funcidn Escape de la APl de t\"indnws permite enviar secuencias de es-
cape a un dispositive tal como una impresora. Por ejemplo NEWFRAME permite
finabivay fin pdagina actuat ¥ avanzar a la siguiente pigina. Todas las secuencias de
escape suportadas por Windows 3.0. no son soportadas per Windows 3.1 La
secuencin NEWFEFRCUE oy soportada por Windows 3.0y 3.1, sin embargo en
Windows 3.1 ¢s mis usual wtilizar las funciones EndPage y StartPage. En ©
Visual Basic para finalizar Iy pigina actual y avanzar a una nueva pagina lenemos
el método NewPape.
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4! Sobre ambas formas. cree los controles que se indican en la tabla siguiente.

Oihj:'em 7 Propiedad Valor
Boton | Caption Orden O
CtlName Orden
' ' Index 0
Bown2 Caption Mover = No
' CtiName Mover

|Gllarde 1a aplicacién con el nombee mover.mak y las formas con los nombres
mover! frony mover2 frm respectivamente,

+ Adada la siguiente declaracién al madulo global v denominelo mover_g.bas.
Dim| I As Integer
i :

Cuanda el usuario ejecute la aplicacién. Forml se situard en fa mitad iz-
quierlda de la pantalla, se visualizard Forn2 v se aiadicdn al amay de controles
Orden() de Formi ceatro botones mas tiwlados Orden 1. Ovden 2. Orden 3y
Orde:n 4. Para cllo, anada a Forml el siguiente procedimtiento conducido por el
suceso Load.

“Oorden” =
-1

o
o
[
D" -
<

3]

i

End Sub

Cuando ¢l procedimiento Form_load asociado con 1a forma Formi cjecuta la
sentencia Form2.Show, se carga la forma Form2 1o que hace que se CJ,CCEJle el
rn Load asociado con ésta. Este procedimiento situara Form?2
d array de controles Ordent) de la
2w 2. Orden 3 v Orden 4. ini-
anada a Form2 ¢l

procedimicnto Fo
en la mitad derecha de la pantatla y adadird al
misina, cuatro botones mas twlados Orden 1. Orden
cialmente no visibles. Para que se realicen estas opRraciones
siguiente procedimiento conducido por ¢l suceso Load.

Sub Fovm_iocad () ] ‘ o
‘1rovar Lz forma a la mitad derecre de la pantalle
Mowe Screen.wideh \ 2, Top
Orcden(0).7isible = 0.
I = i To 4 'Cargar el array de controlzs

ror I = 1L
i

C:gen(Z) .Tcp = Orden ('['-‘ - 1).Top = Ozden{i - 1) LHelght

3

ouno de 1os botones Orden 0 a Orden 4. se ejecu-
X simplemente. visualizard un mensaje
a Forml v a Form2 el si-
[l procedimiento Bo-

Cuando el usuario pulse al
tard el procedimiento BotdnPulsado que,
indicando 1a orden que se ha ejecutado. Para cllo. afada
guiente procedimienty conducido por el suceso Click.
ronPulsado se escribe a continuacion en el midulo mover.bas.

: {Index As Integear)
Orden(index})
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. v

Cuando el usvario pulse el botén Mover = SN, se ejecutard el procedi.
miento MoverSiNo para permitir que los botones Orden 0 a Orden 4, puedan o no
maverse de una forma a otra. Para cllo. afiada a Form! €l siguiente procedimicnto
conducido por el suceso Click.

ll)

ubh ! over _Click ()
5t

tatic Mover 2s Tniecger
MoverSilNo Forml, - “over
E‘.!d S 3

Por la misma razon, afada a Form? el mismo procedimiento anterior, pero
ahora pasando como argumento Form2.

Sub Mover_ Click ()
Static Mover As Iniecger
liover3iNo Form2, Mover

End Sub

La variable estitica Mover ticne el valor NO () cuando el titulo del botén es
Mover = No y uene ¢l valor SI (1) cuando ¢l titulo del boton es Mover = Si

El procedimiento MoverSiNe se escribe a continuacidn en ¢! médulo mo-
ver.bas.

Cuando el butdi Mover = Si/Notenga por titulo Maver = Si. el usuario podra
apuntar a cualquiera de los bolones Orden 0 a Orden 4 de la forma co-
rrespondiente y arrastrarlo para dejarto sobre la otra. Cuando realice esta ope-
racion. se ejecitari ¢l procedimiento conducido por el suceso DragDrop para el
objeto sobre el'que se arrastra. ¢) cual invoca al procedimiento MoverControf que
elimina ¢l control arrastrado de la forma origen v lo aiiade a la Torma destino, El
procedimiento MoverControl se escribe a continuacion en el madulo mover.bas.
Para mover un control de Form? a Forml. afiada a Forml el siguiente
procedimiento,”

Sub ?Orm_D"tagDrop {Sooce Simgley
Dim hWndCtrl As Intecgsr
Source. SetFocus
hilnéCtrl = Getrocus| )
hwad?adre = GetPar
I'f hindPadre <> Form!

MoverControl Source, Torzn

End 1f

=nd Sui
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- .

Para mover un contsol de Formi a Form?. agada a Form2 ¢l siguiente pro-
cedimiento conducido por el suceso Click.

Jreé s Ginmzl=
naCs cgal

Zen

1=z

Pac

Cor

Para finalizar la aplicacién. afada un nuevo midulo flamado mover.bas ¥
escriba en éb. las sivuientes declaraciones. definiciones, funciones ¥ procedimicn-
105 referenciadasfos en los procedimicntos hasta shorg expucstos.

Windews mantiene una tabla de todos los handles, asi como de los enlaces
cxistentes entre los objetos padres e hijos. La funcién GetParent devuelve &
handle del padre del objeto referenciado por AWnd.

Sub ZondnPuisado

(Cor
Sox "O-den” + &z Ctrl.Index) + " pulsadat'®®

SHD voverConorol (C_:E As Conirol, Desting S Formi
Thdice xs Intecer o -

CLvl Index - "

Lnlin01ca) Gaoilion = (|L] caption
nilncice) . Leic = ich
niindice) . Tco
no. ni{lncice).Wicth
ino.0védonn(Inéice) . He?
‘ino.Crden(indice) Vi
Visizla - 0

Width
e rat

il (Forve s Fors, Mover As o lnlegar)
- 0, 53 =2 i
TFowover = MM 'Than '
Meacr o= B
Sorina L Moo JCant ton = oIy s 1T
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- l::l objeto Printer es utilizado para controlar ¢l texto y los grificos que se
Limprimen en una pagina y para enviarlos directamente a la impresora por defecto,

El méiodo Endloc asociado con el objeto Printer finaliza un documento

enviado a la i : i i iSpositi i
13 a la impresora. descargdndolo en dicho dispositivo o en la cola de im-
presion, . '

S e inv . . . ;
S1 s¢ invoca EndDoc inmediatamente después del método NewPage, enton-

ces no s afiade una pagina en blanco.

CAPITULO 15

COMUNICACIONES

INTRODUCCION

Este capitulo presenta técnicas de comunicacion con DOS, ejecutando programas
DOS desde Visual Basic, y técnicas de comunicacion con el exterior utilizando
periféricos como ef puerto serie, el altavoz, la impresura y ¢l imonitor.

EJECUTAR UN PROGRAMA DOS

v

Supongamos que tenemos una utilidad DOS que en ovasiones necesitamos ejecu-
tar desde Windows. Para no forzar al usuario a invocar al shell del DOS, escribir

la orden y ejecwtarla, implementaremos una aplicacion para que pulsando simple- '

mente un botdn, se muestren los resultados requeridas. Por otra parte, una vez
que el usuario ejecute la utilidad DOS, céimo se entera la aplicacion Visual Basic
que dicha utilidad ha finalizado (comunicacion entre prograimnis).

- Para ilustrar esto, cree primero un, fichero denominado PROGDOS BAT que
- - - ML ..
contenga la linea que se indica a cotitinuacion.

DIR | FLMD *"<DIR>" | SORT > DIR.TXT -

Esta utilidad DOS crea el fichere DIR.TXT con los nombres de los subdirec-
torios del directonio actual, ordenados atfabéticamente.

A continuacién, utilizando ¢l editor PLF de Windows, ¢ree un fichero deno-
minado PROGDOS PIF con el contenido siguiente:

Nombre del programa: ~ PROGDOS.BAT

[
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directonos
CAVBASAMPLES\CAIYYS

Titulo de la ventana:
Directorio intcial:

y elija las upciones,

En ventana
Segundo plano

Uso en pantalla:
Ejecucion:

Este fichcro es necesario para que puedan ser wtifizados los estilos de la sen-
tencia Shell. Por ejemptlo, el estilo 2 signilica ventana. minimizada (transformada
en un iconn) y enlocada. '

Inicie una nueva aplicacion v cree una forma ttulada Ejecutar un programa
DAY con los controles que se indican en 1a tabla siguiente. Guarde la apiicacidn
con ¢l nombre dos.mak y la forma con ¢l nombre des.frm. Posteriormente presen-
taremos otras dos versiones de ésta misma aplicacion con los nombres dos/ mak
y dos2 mak.

Objeto Propiedad Valor
Caja de texio CidName Textl
Multline True
ScrollBars 3 - Both
Text (nada)
Botén Caption Ejecutar
CuName Ejecutar
Temporizador - CdName Timerl
- Fnabled A False
Interval 1H{X)X)

Escriba en la seccidn de declaraciones de 1a Tornia fas siguientes sentenvias:
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La funcion GetNumTasks de la API de Windows, devuelhve como resuliade
¢l nimero de tareas que eskin actualmente cjecotindose.

Cuando el usuario puise el bowdn Fjecnar. ol procedimienio Ejecutar_Click
tomard el niinero de tareas que se estin ejecutando. ejecutari la uilidad DOS n-
vocada a través de progdos pif. v activard el temporizador que hace que ¢l proce-
dimieno Timer!_Timer se ejecuie cada segundo (propicdad interval). Esie pro-
cedimiento tiene como finatidad veriticar cuando {inaliza la utlidad DOS. para a
continuacion visualizar el contestido del fichero DIR.TXT.

Esto es asi. porque si nada mas ejecutar Ja sentencia Shell abridramos el fi-
chero DIR.TXT para visualizarlo. nos encontrariamios con un fichero inexistente
lo que daria lugar a un error. Esto ocurre porque uni vez que Visual Basic ha lan-
zado un proceso DOS con Shell. pasa 2 ¢jecutar la siguicnte sentenciit sin esperiy
a que finalice dicho procese DOS. ' :

Para que ¢] proceso Visual Rasic no cominte inicmrus no Ninalice ¢l proceso
DOS. atilizaremos un temporizador que ejecutard a intervalos de tiempo un pro-
cedimientu que comprobari este fiecho. Este procedimicnto abrini ¢l fichero
DIR.TXT y fo visualizard cuando ¢l nimero de tareas en ejecucion sea el inicial.
Escriba las siguientes sentencias para ¢l procedimiento Timerd _Timer.

i_Timer ()
~S 5L
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Texti.SelTexi = Texvi.8e_Taxt - Lirza - CFLT
Looo
Closes *i

}Tl"'(‘;‘! .Enanp.eg = 0
Scrccn Mougerfoinzar = 1
End =:

=nd 1Sub

‘ .O}ra forma de realizar esta misma apticacién es prescindir del temporizador y
utilizar GetNumTasks en un lazo para verilicar cuando el nimero de tareas en
ejecucion es el inicil. En cl cucrpo de este lazo colocaremos ta funcidn DoE-
venis|para permitir que otras aplicaciones compartan los recursos del ordenador.
De esta forma el procedimiento Timer!_Timer queda eliminado ¥ el procedi-
miento Ejecutar_Chick queda como se indica a continuacion,

Sub E]crut 2r_Clicx ()
Dl'n Linea As String, CRLF as Sctring
CRLF = Chr5{13) + Chnrs(l0)

Screen.MousePointer = 11 'reioj de arena
HumTareas = GetllumYasxs() ‘tareas ejecucérdoss
Textl.Text = =~

ChDir ("c:\vbisamplesicanls®)
Id = Shell{"progdos.nii”, 2} 'se ejecura procd2s.ban

'E‘spegar a gque finalice la tarea DOS
Do, While GetWNumTasks() <> Numrareas
Id = DoEvencst)

Loop o,

'abnr el Elchero readd y visualizar su conent G0 &1 Tl
Open "dir,txt" For Inonul As =1
Do| While Not EOT(1)

L.Lne Igput 21, Linca

Tey; .SelTexe = Texpl.SelText : Linea = CHELT
L,oop .
Clpse 41 1‘
Screen. MousePolinier = 1
Fnd Sub

Esla forma de verificar coando una tarea DOS wemina tiene un problema v cs
que uranie 1 ¢jecucion de la misma camience otra tarea. Para solucionar este
problema existe una forma mads segura de realizar esta verificacion que consiste
en unllmuun de dos funciones de Ty API de Wlndm\\ denvminadas GelAeti-
w“lnduu y Is¥Window. .

L4

eclare iy ion Getics ey inaaw Lib =idrert () 78 Integer
Neclare Anction isdindas h "User® (3sal M rs Intapr) As Integer

La funcién GetActiveWindow devuelve el handle correspondiente a la ven-
tana que estd actualmente activa (la vemana que tiene et foco) y la funcion
IsWindow devuelve un valor True (-1) si la ventana especificada existe y un
valor False (0) si no existe.

Para ilustrar esta nucva forma de proceder, escriba en la seccion de declara-
ciones de 1a forma las siguientes senlencias:

Mclare Aunctios- orhct ivadiscow Lib "User® () As Integer
Meclare Functic:  .wlindow Lib "User® (3/val hdnd As Integer) As Integer
Dim Feréaet Bs pnvager, Id 5 oweger

Cuando el usuario pulse el boton Ejecurar tienen gue sucederse los siguientes
hechos: primero se lanza el proceso DOS con Shell para su ejecucion; una vez
activo este proceso, se toma el handle de Ja ventana activa, que en este instante
es la ventafia correspondicnte a dicho proceso DOS: y por dltimo se establece un
lazo con IsWindow que verifique cuando la ventana deja de existir, lo que ocurri-
ré cuando finalice Ja aplicacién DOS. En ¢l cuerpo de este lazo se coloca la fun-
ci6n DoEvents para permitir que otras aplicaciones compartan los recursos del
ordenador.

Sub Ejecutar_Click {}
Dim Linea As String, CRLF s String
CRLF = Chr${13) + Cars(lU}

Screen.MousePointer : 11 'reloj de arena
Text1l.Text = ""
ChDir ("c: \vb\saro‘es\caplS )]

-

hWndAact = GetAct we..mdowl) ‘handle de la ventana activa
Id = Shell{"progdos. pifir, 2) 'se ejecuta progdos bat
'E:snerar a que se active la tarea DOS
While GetActivenwindowl) = hindAct
Id = DoEvents () X
Loop

h¥indact = GetaActivewindow() ‘'handle de la ventana OS5
"Esperar a que firslice la tarea DOS
Do While IsWindow (7 mGAct)
Id = DeoEvents()
Loon

‘Lhrir el fichero crzidn v vigsiaziizar su contenido en Textl
Open "dir.txg” Fc:- ___an L5 #1
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CARGAR UNA APLICACION UNA SOLA VEZ

Sceuramente. en alguna ocasién se habrd encontrado con alguna aplicacidn Win-
dows que permile ejecutarse multiples veces y también se habrd encontrado con
aplicaciones Windows que una vez que estdn en ejecucion. si intenta ejecutartas
de nuevo visualizan un mensaje indicando gue dicha aplicacién ya esti cargada.

Nuestro propdsito ¢s mostrar Ls forma de evitar gque una aplicacion sea car-
cada mids de una vez.

Inicie una nueva aplicacion v cree una forma titlada Mi Aplicacidn con Tos
controles que se indican en [y abla viguiente. Guarde la aplicacion con ¢l nombre
cerrgar.mak v la forma con el nombre cargar.frm.

Lﬂhjclu I'ropiedad Valor
Etigueta Caption Aplicacion en ejecucian
- AuroSize True
N FuntSize 15

~|-

Aplicacidn en ejecucion

Una forma simple de senticar ¢l nimero de veces que miestra aplicacion estd
et ejecucicn s wihizando Lis funciones GetModulelLindle v GetModuleUsage.

CAPITUVLO 15: COMy __ACIONES Ins

-

Un médulo es una aplicacion en ejecucion; la funcion GetModuleHandle da
el handle del médulo especificado v la funcién GetModuleUsage devuelve el
mimero de veces gue ¢l médulo especificado ha sido cargado por la misima u otras
aplicacione ‘ )

Otro detalle a tener en cuenta es que Visual Basic, por defecto, inicia 1a eje-
cucién de una aplicacion por la primera forma colocada durante el diseiio de fa
aplicacion. Para seleccionar otra forma, ejecute la orden Set Startup Form del
ment Run. De esta forma solamente puede cargarse una forma; el resto de las
formas deben cargarse explicitamente wilizando Y sentencia Load o el método
Show. También puede seleccionarse que Visual Basic inicie la ejecucién de la
aplicacién por un procedimiento previamente creado v denominado Main (opcidn
Sub Main de la misma orden anierior). En este caso no se carga ninguna forma
automdticamente, ‘

Ejecute la orden Set Startup Form del.memi Run y elija fa opcion Sub
Main para que la aplicacion inicie la ejecucion por ¢l modulo Main gue se pre-
senta a continuacién. ’

Seleccione 1a orden New Module del ienid File y escriba el cadigo que se
muestra a coentinuacion. ‘ ‘

DefIntvA-2Z
beclare Function GetModuleXZandle Lib "Kernel* |
ByvVal inModulieNeme As String) As Integer

Declare Function Get:-:ddul_eijsage Lib "Kernel" ¢{
Byval hEModule s Integer}) As Integer
Sub Main {) S
htodule = GetModule¥andie({®*cargar.exe*)
HumCargas = GetlMod:leUsage(nh¥odule)
1f NumCargas > 1 Then
MsgBox "Esta aplicacidn estd actualmente en ejecucidn”
End
Else
Forml . Show
End T€
End Sub

Guarde la aplicacién cargar ¥ ejecute la orden Make EXE File del menu File
para crear un fichero cargar.eze ejecutable desde Windows. Asegirese de que
este fichere y el hchero vhrunlQ0.dN se encuentran en el mismeo directorio.

" Ahora simplemente dirijuse 4l Administrador de archivos, ¢jecute la-aplicacion
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y reduzca a un icono la fonna resultante. A continuacion, pruebe 2 ejecutar de
nuevo la misma aplicacidn y vera ¢l mensaje “Esta-aplicacién estd actualmente en
e]ccucmn

SONIDO CON VISUAL BASIC

En M‘icmsoft Basic, QBasic o QuickBasic disponemos de las sentencias SOUND
y PLAY para generar somidos a través del altavoz. Sin embargo. estas sentencias
no estan disponibles en Visual Basic. La siguiente aplicacion tiene como finali-
dad désarrollar dos procedimientos Sound y Play que realicen la misma tuncidn
que las sentencias Basic del inismo nombre.,

En el fichero SYSTEM.INT se especifica el driver de sonido que utiliza Win-

) dows que por defecto es SOUND DRV, Este fichero contiene funciones de bajo

ni\'eil para controlar ¢l alavoz del PC y se encuentra en el directorio SYSTEM.

1

El altavoz del PC puede tocar sélo una nota cada vez. En cambio, existen
wrjetas de sonido. por ejemplo Sound Blaster Card, que tipicamente permiten
enviar,entre 8 v 16 sonidos cada vez. Cada uno de estos tipus de sonido es cono-
cido en Windows como una voz. Cada voz tiene asociada una cola de notas (lista
de notas) para tocar, almacenada en memoria. Cuando todas las notas de una cola
han sido tocadas! esta queda vacia.

l.;lx funcidn OpenSound permite que una aplicacion pueda acceder al dispo-
sitiva [de sonido. Esta fuacion retoma el mimero de voces disponibles. Para ¢l
caso del alavoz de un PC este valor es | si el dispositivo de sonido ¢std libre y
un \dl()r newativo si ¢l dispositivo ya ha sido abieno por otra aplicacion. El acce-
so al dlbpﬂsill\ 0 de sonido estd restringido a una sola aplicacidn. Para abandonar
el dlsh)osm\o de sonido v liberar la memoria gue ocupan las notas, 1a aplicacién
tiene que Ilap‘mra la funcion CloseSound.

_ “#)

L.a funcién SetVoiceQueueSize permite ftjac el tumaio de memoria ea bytes
de la cola, corrdspondiente a una determinada voz, que va a contener las notas.
C.jd.i nota ocup‘] seis bates de memoriz. Para afadir una nota o la cola hay gque
wiilizar la funcidn SetVoiceNote. La funcion SetVoiceQueueSize tiene lus si-
guxenlés parimetros: voz v el tamano de la cola en bytes. Esta funcidn devuelve

| . L .
U CEro S1 8¢ CjeiUla sanbsbactonamente.

La funcién SetVoiceAccent permite fijar ¢l scento de wna voz. Tiene los si-
guicntes pardmetros: voz_tempo o alimero de cuantas notgs por minuto, nivel de
volumen ((+a 235). un valor que afecta a como suena cada nota (nenmal. legato,

staccato) v un valor de 0 a 83 para afiadir a la nota. Esta funcion devuelve un cero
si se ejecuta satisfactoriamente.

La funcion SetVoiceNote anade una nota a la cola de una determinada voz,
Ticne los signientes pardmetros: voz. ndmero de la nota (1 a 84: 0 significa
pausa). tongitud de la nota tuna longitud de 1 equivale a una duracion de una nota
completa. 2 4 media nota, 4 a un cuarto de nota. e1c) ¥ el aimero de merementos
de media duracién que se aiaden a la duracion de 1a nota. Esta funcion dev uclve
un cero si se ejecuta satisfactoriamente.

La funcién SetVoiceSound permite cambiar la frecuencia wilizada por un
dispositivo de sonido para producir un sonido. E cambio se hace para la posicion
actual de la cola. Tiene los sicuientes pardmetros: voz. frecuencia en ciclos por
segundo v duracién del sonido en tics de reloj. La frecuencia es un dato de tipo
long donde la palabra de mayor peso contiene la frecuencia v la de menor peso la
parte fraccionaria que generalmente es cero. Esta funcion devuelve un cero shosg
¢jecuta satisfactoriamente,

L.a funcidn StartSound comienza a 1ocar las notas de (odas tas colas.
Inicie una nueva aplicacion v cree una forma titulada Semide con los contsoles

que se indican en la tabla siguiente. Guarde la aplicacion con el nombre soni-
der.mak y 1a forma con el nombre sonido.frin.

Objeto Propiedud ' Valor
Boton Caption - Sanidos
i CiName . : Sonidos
Boton Caption Muisica
CiName Musica
Boin Captivif - i : Salir
CtlName | Satir
linagen AutoSize I True
CtlName } Picturel
Picture i . whdconstmiscunisc3 1
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Escriba en la seccién de declaraciones de la forma la linea siguiente:

Deilnt ~-2

Para generar un sonido (SOUND) hay que realizar los siguientes pasos:

Solicitar acceso al dispositivo de senido (funcién OpenSound).

Mandar un tono de una duracion determinada (funcion SetVoiceSound).
Indicar a Windows que envie el sonido al altavoz (funcién StartSound).
Repetir los pasos 2 y 3 hasta finalizar,

Dejar hibre ci dispositivo de sonido (funcidn CloseSound)

Abra la ventana de codigo asociada con-el botdn Sonidos y escriba el codigo
gue se indica a continuacion.
Sub Soni dos _Click ¢}

'Splicitar acceso al dls:pom tivo de sonido

Voces .= OpenSound{)

I

For f‘="], To 3 .
For J % 4000 To 1000 Step -i
Sound J, 1 ‘'enviar Lono y duracion
Ner: "-

Fer J = 140 To 90 Step -t
Sound J, 18 ‘*enviar tono
Newz J
Hext ¥
End Sub

Guracion

El provedimiento Seund, que se describe un poco nuis adelante, vnlizae las
funciones de la APEde Windows SetVoiceSound para mandar un tono du una du-
racion deserminada y StartSound para enviar dicho sonide al altavos.
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Y ¥

Cuando finalice fa aplicacién. pulsando el bbton Salir. deje libre el dispositi-
vo de sonido para vtras aplicactones.

S_":) Torm_ L‘* load (Carncel As Integeri
Ind S:b

Inicie un nuevo médulo (orden New Module del meni File) y escriba el pro-
cedimiento Sernd que se indica a continuacion. Este procedin..-mo realiza la
misma funcion que la sentencia Basic SOUND.

Para dar independencia al médwlo Sound realice las declaraciones que se in-
dican a continuacion, en la prapia seccién de decluraciones del modulo.

Deilnt A-Z

' Furnciones para sonido

Declare Furction OpenSound Lib "Soznd*® () &5 [nteger
Daclare Function SetVoivceSound Lip "Sound=

Byval nVoice REs Incecer,

Byval 1Frequency xs Long,

Byval nburation &~s Integer) as Integer
Declare Function StarcSound L1b "Sourd® (} As Integer
Declare Sub CloseSound le "Sound" [}
Sib Zound (3val Frecuenc1a ‘As Lona, 3/al lehc1on As Integer)

rracuencia = Frecuencia * 65536

siar tono y duraCLon,
r = SetVoiceSound(l} ¥recuenciz, Duracidn)
v o= StarcSound() ‘'vocar el toro znviado

Para utilizar el madulo Sorad bas en otras aplicaciones de a misma forma
que lo hemos hecho en ésta, simplemente tiene que afadirlo wtilizando la orden
Add File Jdel mena File.

Para generar musica (PLAY) hay que realizar los siguientes pasos:

I, Solicitar acceso o dispositive de sonido (funcion OpenSound).

2. Establecer el amanio de la cola de notas (funcion Set VoiceQueueSize).

i .y
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3. [Mandar a la cola asociada con una determinada voz, el acento, cuandq se
| | indique, y las notas que se quieren tocar (funciones SetVoiceAccent y Set-
VoiceNote). .

4. |Indicar a Windows que envie la misica al altavez. (funcién StartSound).

5!. Dejar libre el dispositivo de sonido (funcién CleseSound) cuando finalice de
tocar la musica.

Abra la ventana de ¢édigo asociada con el boton Miisica y escriba el codleo
que se indica a continvacién.

Sub Musica_Click () ‘
Partel$ = °"LBGFZ-TGGGPBFFF4"
Parte2$ “GB-43-1GFE-FGGGGFFGFE~- . P3~
Melodia$ = "T10003" + Partel$ + Partel$
Play Melodias

End Sub

El procedimiento Play, que se describe un poco mds adelante, recibe la cade-
na de caracteres Melodia que serd analizada cardcter a cardcter con el fin de enviar
las rllolas y demds informacion, a la cola correspondiente; la rutina MandarNota
se encarga de esta operacion. Observe que hay veces que es necesario convertir un
nimero dado en la cadena de caracteres a valor numénco; de eslo se encarga la
rutina ValorNumérico. Por ejemplo, cuando el cardcter analizado es una nota, el
cédilgo no envia inmediatamente 1a nota, sino que espera por el nimero de mcre-

menios y la longitud de la nota.

Para desan'ollar el codigo comespondiente al andlisis de la cadena Melodia
debe tener un pcrfec(o conocimiento de l1a sentencia PLAY de Basic y de las no-
tas posnbles

Nota R‘[erenua Valor
DO C, l
. C Y. 2
RE D 3
[ D# 3
M E b
FA F 6
! F# 7
SOL G 8
| G# 9
LA A in T
' A# 1
St B 12

T
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La 1abla anterior muesira las doce notas y sus valores asociados correspon-
dientes a la octava cero. Como hay siete octavas, exisien 84 notas posibles. Un
valor cero se considera una pausa (P). Para calcular el valor correspondiente a una
nota se utiliza el codigo siguiente:

Const liotas$S = "PCsDsZFsGsAsB*®

En la cadena Notas, la posicion de la nota menos uno coincide con el valor de
la nota (s indica sostenido, esto es, después de C va (#). P indica pausa.

Car$ = MidS$(MelodiaS., PosCar, 1) ‘tomar un caracter
Select Case Cars$ ’
Case "A™ To "G,

"y

Tono = InStr(Motass, Cars) - 1

If Té.'-:r:') > 0 Then Toro = (Tono = {Ocactva * 12}) - 1

En conclusidn, antes de enviar una nota o el acento, hay que calcular los valo-
res de los pardmetros de la funcion de {a AP de Windows implicada,

Cuando finalice la aplicacion, pulsando el botdn Safir, deje libre el dispositi-
vo de soniclo para otras aplicaciones. Los procedimientos correspondientes a este
boton ya fueron descrilos anteriormente.

Inicie un nuevo médulo (orden New Module del meni File) y escriba el pro-
cedimientu Play que se indica a continuacidn. Este procedimiento realiza la mis-
ma funcion que la sentencia Basic PLAY.

Para dar independencia al médulo Play realice fas declaraciones que se indi-

can a continuacion, en la propia se¢cign de declaraciones del modulo.
T

DeflInc A-Z

' Furncicones para sonido
Declare Function Open3cund Lib "Sound" {) As Integer
Beclare Function SetVoiceQueueSize L,ib "Sourd”™ {
Byval nVoice As Intecger,
Byval nBytes As Intager) As Integer
Declere Function SetoiceAccent Lib *Sound"
ByvVal nVeoice As Intecer,
Byvel nTempo As lntegsr,
Ryval avVolume As I1LLger,
By'7al atode Ls Integer,
Byval nPitch as Intecer) As ° er
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Declare Function Setiolcelate 110

By Va ]. nw
Byial
Byiial
BEsial z
Declars Tunction 3tar: od L
Declare Sub CloseSourné Lib "&£
‘En la cadena Hotas, 1z posicién
‘coincice con el valor el l1d -c
'{s indica-sostenicdo,
Const !otas$ = "BCsis
Const :limerosS$ = "0123:1%
Const TRHE = -1
Const TALSE = 0

Sub Play {Melodizs)
Melodias = UCases(M=laodia
Voces = OpenSoundl}
vr = 3etVoiceQueuaSi
Tota.Cars = Len{¥2lcozlas)
"Valcres por delecto
Tiemzpo = 120
Misica = 0 ' normal
Ocaiva = 4
LoncrorbDefecto
Motallceva = VFALZ:
Acenrioluevo = T2UE
PosCer = 1
Lo

Mids({irelod’es, PosCar,

Case (Cears

IAI‘ Ji‘io IGI' -_:!

Foqub Mandariko-a
crfl

no

ar
e:

nxm v
m nl

Cas

Tono = Iit
NotaNuevea

Case "+", ="
Tono = Tono & C

Czse "-"
rono = Tono -

- L] L] B
a5y H

li‘MHH - Tk

) i B R B
Gobub VYelostirivico
LongHotatace = aloris!l
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Case "»°*
GoSub tandarkota
Ocetva = Ocatva + 1

ase "<* -
GoSub MandarNota
Ocatva = Ocacva - 1
Cazse "NM°"

GoSt:b Handalloua
PosCar = PosCar + 1
Cars = MidsS{lelodias,
Select Case Cars

Case "N°

isica = 0 ‘normal
Case "L*

tiusica = 1 'ligada
Case "5*

asica = 2 ‘'des

- Ena Select
Acentoluevo = TRUE

Case "NI"
GoSub MandariWcta
PosCar = PosCar + 1
GoSub ValorNumérico
Tono = ValorDeR
NotalNueva = TrRUE
GoSub Mandarliota

Case "O-
GoSub MandarNota'
PosCar = PosCar + 1
GoSiub ValorNumérico
Ocatva = ValorDeN

Case "7T°"
GoSub Mandariote
PosCar = PosCar + 1
GoSub Valorlumérico
Tierpo = Yalorhel
AcentalNuevo = TRUK

Case ~i*
GoSulr Fandarliota
- = PosCar o+ 1
GoSsun Vatorl mcriro
Longforitelfecio = Yalort

..

-'siguiente octava

‘octava anterior

|
"

'mﬁsiqi_

rosCar, lﬁ7

(legatg)

cada (staccato)

‘noLa

‘octava

'L iempo

'fijar longitud noca

.

=l
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Case Else El driver de sonido de Windows 3 hace que la misica se procese en segundo

End Select : plano (background), ain cuando.la tarea es modal (un tipo de forma que retiene

FosCar = PosCar + &
Loow Until PosCer » 7

~otalCars cl foco hasta que sea cerrada). por lo que MF y MB son simplemente :gnoradas
GoSub Mandarloia

Por ejemplo, podemos lanzar una misica y a continuaciin visualizar una ventana

|
vr = StartSound() con un mensaje; la masica seguird sonando hasta finalizar o hasia quc se gjecute
Zxig Sub : . CloseSound. .!‘ :
Mandarilota: . ) . i ',
I1E ~Neoowdluexn Then wvr = Set\{o_i_ce}cbzi(l. Tilmpo, 1, Wizica, 0) - StartSound ) “ .
If liotaNueva Then ¥ vr = MsqBox (Mensaje, 43, Titulo) ’
‘Calcular el valor de la no: Close So“”d
I{ Tono > 0 Then Tono "—.,(LC..O + (Ocatva * 12)) - 1

1f LongllotabDeda Then
Longitudiota = LongHotaDeda
L.ongMNotabada = 0

Este ejemplo, lanza una musica v visualiza un mensajé. La mCusi:ca seguird
sonando hasta finalizar o hasta gue se cierre la ventana moniento en el gue se eje-

Else . cuta CloseSound,
LongitudNota = LongPorDeizczio
End If . : : Si desea detener 1a aplicacidn hasta que la muasica Ninalice (musica en primer
. = g i R 1 e iruc < N . . A - .
4 SetVoiceNote{l, Tono, LingitucdNota, TceMDN) plano) declare la funcién CountVoiceNoles.
[de¥DN = 0 - ' . " . .
End 1§ Declare Function CouniVoiceNotes Lib "Sound” (
Not‘"_‘upva L SE Byival nVoice As Integer) As |Integer
[ By - =
Acentoluevo = FALSE . .. . .
Ferurn ' y escriba el siguiente cidigo después de cada Hlamada a Play.
valorNumérico: ‘cdlculo de n de Ga, La, Tn, eic. while CountVoiceNotes(i) > 0: wend .

'Primer digito {digito més sic
ValordeN = Val(MidSiMelodias,
1f PosCar < TotalCars Then

Si ademas quiere permitir que se ejecuten otras tareas, aiiada a la condicién la
funcion DoFvents. Por cjemplo. queremnos que al pulsar un botén se visualice un

SiguienteCars = MicdS(Melodic sCar +« 1, 1) s T
. S . i ca siga ocando.
If InStr {Nimeros$, Siguients o 0 Then mensaje y la musica siga toc
£l segundo caracter es un Lo : - )
. . : e ! .
valorpeN = Yaloridald * 10 - SiguienteCars) .While DoEvents({) Ané CountVoiceNotes(l) > 0: Wend
osCar = PosCar - 1 '
Clse ‘ ’
© Return - COMUNICACIONES CON EL PUERTO SERIE
Fnd LFf I
Ena If La gestian de los puenos de comunicacion no es una tarea ficil. Lo primero que
1f PosCar < ToralCars hay que pensar es gue fos datos llegan a los puentos de forma asincrona; es decir,
?iuilrl]bf:"( :’,‘31 > (_):;IEIZI 1(::; su llegada es imprevisible. Esto sugiere que el dato que llega tiene que 'prmcsanc
& I ¢ ..
‘F] tercer cardcTer inmediatamente puesto que pueden llegar otros datos. De esta larea se 'cnc.uﬂa el
YalorDeM = Yaleorls hardware del PC. de forma gue cuando detecta la llegada de un dato, mlerumpe
Postar = FosCar el Nujo normal def proceso para ceder ¢l control a la rutina de proceso de comuni-

PLE caciones. Esta rutina tiene que ser una rutina de Windows, en lugar de'luna ruting
de Iz aplicacion. Esto es asi por dos razones:
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»  Windows debe mantener el control de la multitarea. En efecio. si la llegada de
un dato hiciera que se transfiriera el conrol del procesador a su aplicacidn,
Windows perderia su habilidad para gestionar la multitarea. Esto quiere decir
que Windows ticne que estar entre la aplicacion y el hardware.

*  Windows no puede dirigir el dato recibido directamente a Ja aplicacion, |a
razon ¢s que los daws que se reciben en el pueno de comunicaciones no lle-
gan con la identidad de la aplicacion que los tiene que recibir. Por lo tanto.
Windows ticne gue salvar en un Buﬂ'er los datas que llegan para una aplica-
cion. Para qué aplicacidn, debe determinarse por adelantado; esto es. su apli-
cacidn debe haberle pedido a Windows la propiedad del puerto. utilizando la
funcion OpenComm. Esta misma funcion establece dos buffers. uno para la
‘entrada y otro para la salida.

Cuando una aplicacion solicita a Windows la propiedad de un pueno, Win-
dows sélo se lo dard si ninguna otra aplicacidn lo tiene. Por ¢l mismo motivo.
mientras su aplicacion tiene el control de un puerto, Windows se lo prohibe a lus
demds aplicaciones que lo soliciten. Cuando su aplicacién finalice la operacidn de
Eis - _ouenio, debe dejar el control del mismo para que olras aplicaciones
puedan u.i...arlo, 1o cual requiere Hamar a la funcién CloseComm.

Coma ejemplo vamos a realizar una aplicacion que permita transfenr datos
entre dos ordenadores personales. Para probar la aplicacidon, debe conectar via
puerto de comunicaciones los dos ordenadores. Una vez realizada la conexion,
ascgurese de que estd bicn hecha utilizando un paquete de comunicaciones co-
mercial como el progruma Terminul de Windows.

Una forma de realizar esta aplicacion seria utilizar las semencias estandar de
E/S Open. Close, Get. Put v Err. para efccwar las operaciones de F/S sobre el
puerto. Pero esta forma de trubajo presenta problemas de pérdida de datos. espe-
cialmente por encima de 2400 baudios; también, cuando Windows cede e control
a atra aplicavion, todos Jos caracteres recibidos en esta situacion se perderian. La
razon es que estas sentencias trabajan con os drivers de {us puertos sere de DOS
y éstos no fueron disednados ni para velocidades altas, i para un entormo muhtita-
rea como Windows. Por lo tanto. la solucidn es utilizar las funciones de la APl de
Windows equivalentes a estas sentencias, tas cuales se indican en la tabla si-
guie'nle. -

\B APl Funcion

Abre un puesto de, comunicaciones
Cierra un pueno de comunicaciones
Lee datos

Open OpenComm
Clo CloseComm
Gt ReadComm
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Put
Eer

- .

WriteComm Envia dasos

GetCommErmor Comprueba si ocusrié algin emror
SetCommState Establece las caracteristicas del puerto
BuildCommDCB Canstruse el bloque de control de datos

Para establecer una comunicacidon siga los swuu:me% pa%m

Abra el puento de comunicacion. Para realizar esta opqpcmn llame a la fun-
cién OpenComm con los arsumentos, puerio de comunicadiones, tamaio del
buffer de entrada y tamaio del buffer de salida. Esia, funcién devuelve un
aimero que idemifica al puerto de comunicaciones abimu 0 un mimeio ne-
2ativo si ocurre un error (constantes [1E_). :'

.
Construya el bloque de contral de datos {DCB). Para ello, llame a la funcidn
BuildCommDCB con los argumentos, definicidn del puento y estruciura
DCB. La definicion del puerto es una cadena de caracteres con un formato
igual al utilizado por la orden MODE de DOS, que se utiliza para llenar la
estructura de upo DCB. Por ejemplo "com2:2400.n.8,1"

Establezca las caracteristicas del puento. Puara realizar esta operacién llame a
la funcidn SetCommState pasando como argumento la estructura de datos de
tipo DCB, en la que previamente se almacenaron tales caracteristicas.

"Cuando quiera enviar datos al puerto de comunicaciones. utilice la funcién

WriteComm gue tiene los siguientes pardmetros: un valor 11 yue identitica
al dispositivo de comunicaciones (esie valor es devuelio por la funcién
OpenComm), una cadena de caracteres que contiene los caracteres enviados
y ¢l nidmero de caracteres enviados. Un valor negativo indica que ha ocurmrido
un error. El valor absoluto del valor devuelto por fa fimcion coincide con el

- mimiero de caracteres enviados.

Estiblezca un lazo que esté a la espera de los datos gue nuestra aplicacidn es-
pera recibir. Para ello, utifice la funcién ReadComnm que tiene los siguientes
pardmetros: un valor 1D que identifica al dispositive de comunicaciones, una
cadena de caracteres gue contiene los caracteres recibidos y el ndmero de ca-
racteres recibidos. Un valor negativo indica que ha ocurrido un error. El valor
absoluto del valor devuelw por la funcién coincide con L‘I nimero de caracte-
res leidos,

Cuando vcurre un eror durante una operacion de comunicaciones, Windows
bloquea el pueno comrespondiente. el cual permaneceri bloqueado hasta que
se ltame a la funcion GetCommError. El emmor es copiado ¢
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de tipo COMSTAT. Esta funcion devuelve el cddige del error ocumrido
(constantes CE_). '

E< una bucna prictica llamar a la funcién GetCommError después de
invocar a la funcién ReadComm por si ocurre algin error sobre el dispositi-
~vo de comunicaciones.

7. Unlice la funcidén CloseComm para cerrar el puerto de comunicaciones cuan-
do éstas finalicen. Si el puerto no’puede cerrarse, esta funcion devuclve un
valor negativo, :

Inicie una nueva aplicacion y cree una forma titulada Communicaciones con los
controles que se indican en la abla siguiente. Guarde la aplicacién con ¢l nombre
rs232.muk y la forma con el nombre rs232,frm.

Objete Propiedad Vator
Forma Caption Comunicaciones
AutoRedraw False
I FormName FormCom
Mend Caption & Transferencias

_ CiName Transferencias
Transferencras: orden ) | Caption 3 Tx/Rx
CiiName &TransRec
Transferencias: orden 1 | Caption &Detener
CuName Detener
Menu Caption Salir
CilName &Salir

Translerencias
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DOWS H. adaptadas al lenguaje de Visual Basic e incluidas en erlw!/l\Pl.TXT,
estdn relacionadas con las sentencias Declare correspondientes a las funciones de
comunicaciones de la APl de Windows, que se encuentran en e'l fichero

WINAPLTXT, y que también tiene que aiiadir a este mismo modulo.

' Error Flags

Global Const CE_RXOVER = &H1
Global Const CE_OVERRUN = &H2
Glohal Const CE_RXPARITY = &H4
Global Const CE _FRAME = &HB
Global Const CE_BREAK = &H10 °
Global Const CE_CTSTO = &H20
Global Const CE_DSRTO = &H40
Global Const CE_RLSDTO = &HB0
Global Const CF_TXFULL = &H100
Glopal Const CE_PTO = gH200
Global Const CF_IOE = &H400
Globhal Const CE_DNS = &HBOO
Global Const CE_QOP = &H1000
Glohal Const CE MODE = &HBOOD
Global Const IF_BADID = (-1}
Global Const T1E_OPEN = (-2)
Glohal Const IE_NOPEN = (-3)
Globkal Const IE_MEMORY = (-4)
Glokal Const IE_DEFAULT = (-5)
Global Const 1E_HARIMWARE = (-10)
Glohal Const IE_BYTESIZE = (-11)
Gleobal Const IE BAUDRATE = (-12)
Type DC3

Id ks String * 1
Raudrate 2s Tnteger
ByteSize As String * 1
Parity As String * 1
Stop3its As String * 1

'Intemal Device ID *

'‘Baudrate at which runing
'Number of bits/byte, 4-8
'0-4=None,0dd, £ven, Mark, Space
'0,1,2=1,1.5,2

Detener 7

Escoiba las siguientes declaraciones en ¢l médulo global, y denomineto
rs232.bas. Estas decluraciones, que han sido importadas del fichers WIN-

R S — s

-

RlsTireout As Intexger
CosTimeout As InLeger
DsrTimecut As Integer
Bytel As String * 1
Byte2 As String * 1
¥onCrnar As String * 1
YoifCnar As String * 1
Yonl.im As Integer
Zofflim As Integer
PeCnzr As String * 1
HofCrar As String * 1
BEvtChar As String * 1

‘Timeout for SLED to be set
“rimeout, for CiS Lo be set '
"Timeout for DRSS to be set |

'Tx and Ex X-O7F character
"Transmit X-ON threshold
"Transmit X-OrT threshold
*Parity error replacement char.
‘End of Input character
‘Recieved Event character

1
'"Tx and Rx X-O: character [
]

I

4
Receive Queye overflow
Receive Ovefrun Error
Receive Parity Error
Receive Framing error
Break Detected
CTS Timeout «-
DSR Tirmeout) -
RLSD Timeout
TX Queua is full
LPTx Timeout
LPTx I/0 Error
LPTx Device not selected
LPTx O1t-Of -Paper
Requested mode unsupported

Invalid or unsupported id
Device Already Open
Device Not Open
Unable to allocate queues
Error in default parameters
* Hardware Not Present
* TIllegal Byte Size
' Unsupported |BaudRate

v ey
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'Inoont of tize between chars

crOowwie A5

Ird Tyrs

r ‘court of craracters in ix O

' Puoitlionsgs parz comnicaciores,

4 . I. -.—

Declare Timenion CoenComm Lib "User= |

z72l IpToslame As Scring,

1 wirg.sie s Integer,

I wOuzQueue 25 intecer) As Ihteger

Ivclare © =21 1dCom 3 Lib "Ussr®
i 1

1pZel 15 String,

Declare =

Neclare T motion ZzadCom Lib “User® |
I nCig ~s Irteger,
L 1p3: ~s String,

1 ngizze ~s Integer) 3As Integer

. Lib "User" (

c -5 Integer,

is Sering,

~S Integer) As Integer

Doclare ©

Declare Tirction GsiCorrzrror Lib "Usarm |
2l nCigd s Inceger,
oz QOMSTAT) =s nteger

S ea

Declare Tinction Closecom Lib *User® |
T2l nCla 55 Integer) -5 Integer

2 und ventbana

Necls i Urkdatedindow LD "User® {Ftal hind As Integ

{
DCB As BXC3) As Integer

ar)
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Escriba las siguientes declaraciones en 13 seceidn de declaraciones de la
forma FormCom.

da datos
Bim nCid ~s Integer 'identificacidn del puerto
Consc DefCom = "COM2:9600,.n,8,1" ax%ﬁsdcﬁsdelpxﬂto
Const Th = 1024 ‘tamafio del bu

Cuando el usuario haga clic en la orden TvRy del rﬁ!ﬁhli._ Trunsmisiones, se
abre ¢l puerto de comunicaciones COM2 y se establecen Sus caracteristicas; para
ello se invoca al procedimiento Abrir_Com y se le pasa ccé’q’no argumento la cade-
na DefCom que contiene ¢l nombre del puerto v los pardmetros bajo los que se

desea establecer la comunicacidn. En nuestra ejemplo se.ha elegido el puerto

COM2 (el puerto COM generalmente es utilizado para el ratén), velocidad 9600
baudios, no paridad, 8 bits por dato; y 1 bit de parada. A continuacién, se llama al
procedimiento RecibirCom para establecer un lazo que mantenga a la aplicacién a
la espera de recibir datos.

Sub TransRec_Click ()
Abrir_Com DefCom$
I£ nCid Then .
FormCom.Caption = *Puerto de cuominicaciones abierto®
End If
RecibirCom
End Sub

Sub Abrir_Com (DefPuertoComs}
Dim vr As Integer

" Cerrar cualquier puerlo abierco previamente
vr = Closecomm({l) -
vr = (Closecomm{2} '

‘gbhrir el puerto de comunicacicnes. nCid es el ID
‘nCid < 0 indica un error (constantes IE_).

Puoarcalams = Lefes (DefPuertolors, InSorilsoersoCams, ":") - 1)
nCid = OpenComn{PuertoComs, Th, <o)
It nCid < 0 Then
Isghx " se puede air el prarto Q1 * + SOS(Cid), 16
End
end LE
‘Cargar el bleque de coxniiol ¢z dates (DC3) con los
*valores dados en DefPuertoComs
'El primer paradmetro del NDC3 es muesto mar nente

LpdCB.Id = Chr$(nCid)



382 VISUAL HASIC. APLICACIONES PARA WINDOWS

If {zoileCommdT3(2
KsgZox “llo 2 pu

Enc

end I

‘tiscanle v laz cerecteristizzz el zusrto

Tf (SecCommSta-2(lp3l3)) T
Meshow "l se pooden porsr Los pardretres oare DU, 15
End

Fnd 2 T

tnd Sun - - v

Subh RecinirCom ()

Dim vr As Integer
Dim' = s COMSTAT
Do B

‘lzar daigos ¢zl puis-to

Nurars = Reaalonin(nCid, Sufisrioo, Lan{3eiZerknt))

'Tanorir errceras

If HumCars < 3 Tnen LuoCarz = -Huzlars

'Vigsualizar CCLos
HE unCars ii-c" v
'Restanlec L
RE-ror = (Jel’Co

erbEnt, Lumnars)
rrca un error

Permitir que ziacuten
vIo= dehventsi()
lL.oop

Enad Sup

Si fa variable N Cars es negativa s que ha ocumido un error, no obstanie,
sa valor absoluto indica el ndmero de caracteres leidos. Observe yue en caso de
error se ignora el signo, porgue a continuacion siempre se Hama a la funcion Get-
CommError. Exta funcion devuelve un entero correspondiente al codigo de error
ocurrido (constantes CE_).

Los dmos leidos son visualizados en la five: « por el procedimiento Visuali-

- zurDatos. Yue tambidn provee un sistema de desplazamiento vertical de la infor-

macion en la ventana, cuando ésia s lena. Para ello. utiliza las funciones de b
APl de Windows ScrollWindow v UpdateWindow.

La funcion ScroollWindows permite realizar en una sentana Epasinietro
WWaed)y un desplizamicnto en la direccion X iguat al valor Xameuns vy un despla-
sapnento en la direccion Y iguat al valor Yamounr (ver sentencia Declare). Re-
vacide que T onidid mds pequena de resolucidn de un monitor es el pixel. Esa
funciom no rabaja bicn i la propiedad AutoRedraw de L 1orma es True,

La funcion UpdatezVindow acwaliza fa ventana.
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. <,

roceser Lodos
Sooodlo=

75 0= Mids{Bufier
itfay que reali
IS = Cuesil0)y Ao
Serollwindow Fors
UpdateWindow ?
vr = DoEventsi:
(urn nex = 0 .
Chr2:«il) Then 'si €7, or mc'.') o ce llraz

Sun VisuatizarDatos
Zim Yamoualt As I e niszer
Srzliemoae = 3 fe: a - ;
Tirount = TextHelchzd alv r
s ¢ res .
To Len{Z:iie

U5y

Si ahora el usnario quiere transmitic informacton. simplemente ticne que es-
cribirla en la ventana. El procedimiento Form_KevPress conducido por el suceso
KevPress se encurea de esta actividad. Para enviar datos a 1a cola de salida, pri-
mero hay que verificar que no estd llena, para lo cual se Hama a la funcion Get-
CommError, y se comprueba el valor del miembro cbOuiQue de i estructura
Lpstar. Si hay espacio, la funcion WeiteComm envia los dates al bulTer de sabida
y Windows se encirga del resto.

Sub Torm_KeyPress (YeyAscii As Intacer)
Tim NMumCars As Imtegar, vr As Integeé:r:, Whrror ~s Intecz:s
Sim Lpstat As COMSTAT 'estado del puesto
Szzric BufferSals

12 aCid = 0 'Then Zxit Sub

Toifertals Ruffeys
o= CeL(ommb110"
‘oreda espacio en
ipscalt . chOutus
nviar caracter
ars = W iteCom
[ravis rnlxa-- [{
wError = GetCor
liminar los c
flerSals = Mizds

£

S + Chr$({<evascii)
[ L) estado acLua.

'\ X
‘f‘.-[h
Q_,r-ﬂ

Vit

salica
Len(3uiiersalsyy
s *‘Iloicrar errorez

—

B
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Cuando el usuario haga clic en 1a orden Derener del menu Transmisiones, s¢
ejecuta el procedimiento Detener_Click que invoca al procedimiento Ce-
rrar_Com que cierra el pueno y detiene las comunicaciones.

Sub Detener_Click ()}
Cerrar_Com

FormCecm.Caption = "Busrio €2 ccrunicaciones cerrado®
Znd Sub

.- . - K
Sub Cerrar_Com () o

Dim vr As Integer

if nCid vr = Closecorn(acisg)

1f vr < 0 Then .
F5a304 "No se pueda2 cerrar el Dusrto COOM: ' o+ StrSivr), 16
Fnd

Else
nCid = 0 'Poner a cero nCid parz detener RecibirCom

nd i -

Znd Sub

Cuando el usuario quiera finalizar la aplicacién hard clic en €l mend Salir.
Como se ve en ¢l procedimiento siguiente. para salir de la aplicacién no es nece-
sano ejecutar previamente la orden Detener.

Sub Salir_Click ()
cerrar_Cain
End

Fnd Sub

Observard que no se han utilizado las constantes de error. Esto es asi, porque
fa idea era crear una aplicacion simple. que funcione. ¥ que al mismo tiempo le
muestre los elementos con los que puede trabajar.

CONTROL DE ERRORES EN LAS CO!..  "ACIONES

I a aplicacién siguiente es una nueva versin de la anterior. La idea fundamental
-l irstamiento de los errores durante las comunicaciones.

Ahora, cuando el usuario desee enviar informacion, la escribird en una caja de
texto mutubinea y una vez escrita, pulsard un bown para enviarla. La informacion
recibida se visualizd también sobre la caja de teato.

laicie una nueva aplicacion y cree una forma titulada €omimnicaciones con los
que se indican en la abla siguiente. Guarde la aplicacidn con el nombre
sk y Ja forma con ¢l nombre rs232err frm.
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-

r()hjelo _ Propiedad : Valar

Forma Caption Comunaicaciones
AutoRedraw False
FormName FormCoim

Mend Caption &Trapsferencias
CtiName Transferencias

Transferencias: urden 0 | Caption Tx/Rg.
CuName &TransRicc

Transferencias: orden | { Caption &Detener
CtlName Detener

Menii Caption Salir
CuName | «Salir

Caja de texto CiName Cd
Muliill.ine ~ b
ScrollBars 2 - Vertical
Text {nada)

Botén .t Caption Enviar lexto
CiNune TransmitiCom

Escriba las siguientes declaraciones en el o+ Sloball y denominelo
rs232err.bas. Esias declaraciones, han sido ymponadas del fichero WINAPLTXT.
' Constantes oolean
Glozal Const )
Glonzl Const

foIrroves en
Glooal Const CZ_;
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Clohal
Global
- Global
Glohal
Glohal
Glohal
Glohal
Global
Globhal
Glohal
Glohal
Global
Glohal

szcaive Crerrun Error
1 Pariny Error.

Const CE_OVEFRUN = 432 !
Corst CE_RXFARITY = £4H4
Const CE_FRRMZ = &:3 ' c2lve rraving erver
Cecnzt CE_BRESX = LRi0 ' < Defscted

Const CE_CTSTO = 4520 R et lLﬁEOJC

Corst CE_DSRTO = L1540 ' D33 Timeols

Cernst CE_RLSDTO = 4230 ' RISD Timouls

Const Cr_TWESLL = £2100 * T4 Qieue is fgll

Const CE_PI) = &H200 ¢ IDTH Timeol

Consc CE_IOF = &H400 ,, ' L27x I/0 Zrror

Const CE_MMMS = &HBOD v L2Tx Device not selscted

Const CE O0P = &HlocH &~ ¢
Const CE_MODZ = &HBCCO .

L27x Out-0Qi-Zaper
fetasted Tode unsuoported

' Errores en (penCom

Glohal
Global
Glaohal
Globial
Global
Glomal
Glohal
Global

Const IF_NOF! = (-3) )

=7alid or unsupported id
vice riready Ooen
D=rice Mot Open

Urzble to allocate ¢izues

Comst 1E_BIDID = (-1)
Const 1FE_OPE! = (-2) !

Const IE_MEMORY = (-4}  °

Const TE_DEFAJLT = (-3) ' IZrror inéefault perazveters
Const TE_HARIRARE = {-10) ' Hardeare Noo fresent
Const. TE_BYTESIZE = {-11) ' Illegal Byte Size

= (-12) ' Unsupported ZeudRate

Const [E_BAUDRATE

Declaraciones para QO
' Parivy: 0-4=None,0dd, Even,tark, Scice

Global
(;lotal
Glohal
Global
Global

' SLop Bits:

Glohal
Global
Global

Const NOPARITY = 0
Corst ODDPARITY = 1
Const EVENPARITY
Const. MARKPARITY
Const SPACEPZRITY = 4

2

"o

0,1,2=1,1.5,2
Const ONEST0P8ET = 0
Const ONESSTOPBITS =
Const TWOSTOPBITS = 2

1

' Estructura de datos DC3 (Blogue ¢z Control ¢é21 Dispcsicivo)
Type [CH

Id As String * 1
BaudRate As Integer
ByteSize 2s String * 1
Parity As String * 1
StopBits A5 String * 1
RlsTimeour 25 Infeger
CtsTureout ~s Inbeser
PxacTinesont S5 Integer
MedeControl A5 Integer
XoncChar A5 String * 1
Yoftthar ~s String * 1

‘inrernal Zsvice @D

‘Baudrate z- which runing
thavher ol Slts/bye, 4-8
*0-4=None, (33, 2ven, Mark, Spacs
J i.3,2
Jor PLSD 1o 2 set
T 075 w0 e set

. |
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. .

Yorlim As Integer *Transmit X-ON threshold
Xoiilim A5 Inceger 'Transmit X-GFF threshold
PeC-ar As Scring * 1 ‘Farity error replacemenc char
Eoilhar /s String * I '£nd of Input character [
Evilhar As Scving * i ‘recieved Fvent character -
Twilay 45 integer *  ‘Zmount of time between chars!
Fnd e 'g
Type SIMSTAT
ModzControl fs String * 1 ‘Q"_L
chiue s inceger ‘count of characrers’ in Bx Queue

chioQue 2s Inceger

End T.pe

' Tunciones para comunicaciones Y

Declare

Declare

Declare

Declare

Declare

Declare

Declare

Declare

Escriba

forma FormCom. l

Dim LpBCB ~s 2C3 "'ouhe ca control de datos
Dim nCid ~s -“‘cc:: 3
Dim BufferSzl Z
const D:fCom = *

‘coun of characters, in Tx Queue

Funccion COcenComm Lib “User™
ayVal lpComNzme As String,
ByVal wInQueue As Integer,
3yVal wOutQueue As Inceger) As [nteger
Function BuilcdCommDCB Lib "User® {
Byval lpDef as String,
1phC3 35 NCB) As Integer
Funccion SecCommState Lib “User® {
1phCB as DC3) As, Integer
Function ReadComm Lib "User™ (
Byval nCid As Integer, i
ByVal lpBuf 2s String,
ByVal nSize 2s Integer) As Integer
Functrion VWrigeComm Lib "User* (
ByVal nCid As Integer,
ByVal lpBuf 3As String,
gyval nSize As Integer) As Integer
Funccion CezCommError Lib "Usert (
Byval nCid As Integer,
1pSta- As COMSTAT) ~s Integer
Function FlushComm Lib "User™
Byval nCid As Integer,
3yval nQueue As Intecer) As Integer
Furnction Closecomm Lib *"User”™ |( |
ayvel nCid As Integer) As Intege r!

las siguicnies declaraciones en la seccidn de dLLIaraulones de la

ntificacidén del puerio|
'muifer de salida
‘caracieristicas del |puerto
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Consz Th = 2042

La inicializacion del puerto se hace llmmando a la funcién de la APl de Win-
dows SetCommState v pasando como argumenio {a estructura LpDCB. La defi-
nicién det pueno es la cadena DefCom gue Se pasa como argumento cuando se
invoca la funcion de fa APIde Windows BuildCommDCB.

LLos caracteres que ¢ usuario escribe sobre Teard para transmitir, san almace-

nados en la variable BufferSal: esia \aL‘mhlc es estitica por defecto. Para ello. es-
criba el siguiente procedimiento: L

+ Chrs{i3}) + Chrs({10) ' -C=Z-LF

+ ChrS{<oyrscii)

Cuando el usoano haga che en Ly orden TRy del mena Transmisiones, se
abre ¢l puento de comunicaciones COM?2 y se establecen sus caracteristicas: para
cllo seinvoca al procedimiento Abrir_Com y se le pasa como areumento ba cade-
na DefCom que contiene ¢) pombre del puerto v los pardmeltros bajo los que se
duesea establecer la comunicacion. A continuacion, se llama al procedimiento Re-
cibirConr para establecer un lazo que nintenga a La aplicacion a la espera de re-
cihir datos,

Transtec Click ()

BerCorn:
-“}‘Pll

Toer o do comuniceciorgs eirfzrio”

ng
defrozroaiars, titv - L}
i - PuerzoCoTs - = ...-"
Co
! Si coemunicaciones. nCid z3 20 1D
' zrror (Censtancess 15 )

SrarosConS, Th, Tol
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- .

If nCid = IZ_ en
Msg = "Dispositivo COM abierco” + Chr$(13)
Msg = ¥sg - ":Quiere ur.iliza'.‘lo':‘-'
v = MsoBox (Msz, 36, *Srror en las comunicaciones®)

If vir = 6 *S1: csrrar puerto
"Cerrar Cu..-uUl@* puerto gmerLo
vr = CloseCommi{l)

vz = CloseComm{2)
'‘Cerrar otro puerto distinto a losl'hnte"mres
vr = ClosaComm({2sc(LpDCB. Id))

Else 'NO: unalxzar aplicacién
Msg = "lplicacion finalizada”
FsaBox Wsg, 16, *Comunicacidn abortada®
£rd |
End 1Lf -
Else
Msg = “Error &i abrir el dispositivo CQt4" « Cnr$(13)

ise la conexidn vy
eiecute d= nuevo le aplicacida®

vr = MsgBox(lisg, 16, "Error en ias comunicaciones™)
End ’

End If

Else

‘Tnicializar pugrso de commicaciones PuertoComns como:

'2400,8,8,1,.C00,CS0,D50,R5,TB2048, RR2048

If (BulldCommDI3{DeiPuertoComs, LpbCBY)} Then
MsgBox “No se puede construir el DCY", 16
Fnd

fd If

'El resto de los pardmetros del U33Q0ﬂ[1ESUX)mﬂlﬂhmmte

.LpBCB.Id = Chrs{nCid)

‘Establecer el periodo de tiempo en milisegundos

‘para (D, C5 y- 05, in valor { represanta ui tiecpo infinito

‘inhabilitanco el plOLOCOlO sobre esa linea

LpLCH . RIsTimeOur = 0

LphCcR.CeslimeOur = 0

LpDCB.DsrTimeG.c = 0

Msg = Msg o+

'Tes siguientes flags de wn bit forman el camo ModControl .
'SiLiriabilita, 0 mebilita y vieearsa.

‘f3inary = 1 M binario. 0 implica HOF ((heS(26)).
{RraDisshled = 1 I ,.0111*"’ linaa regeest-to-serd (#5).
‘flarity = 0 L Chamen G e idad,
orCuerloe = 0 cdeaen G clear-to-sad.

O A Crpen e Gsta-set-mead, (DER).
Dy crvales.,

lirea dara-sot-rexdy, (07R).
UADEF Gurante la ¢ oisidn.
ir A1/ AXF arante la .

YOt X =
I =
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' resrplansy

o caraTieres 2 eror de pavidal om
' el carédrer oxsaidn = el carin FeChar, 1 or=aplaza
ol o dzrgn;r(zfdrerx 2ilos racibidos. I asscarta
. 7:1(.._ et Gl caraTST arLenido en el carn
' it o eigiitinca o . Sa0e0. 1 significz saceso
La 1imem TR ro 2= 2%k
la ifrea TS 0 =5
FEseraD

0000 0000
exadecimal: W 0C 1 0 0

vadeContro:r § L1102 C201]

- LHCITS
= Cn:S(O)
Chrs (0)

.AOﬂChAL
.AoffChar =
FonLim = 0
Fofilim =.0
3. pPeCrar = Chrs{}})
3.FofChar Chrs{26)
.EveChar = Chrsi(0)

Y

T :\DC

isticas

armCom. Caotlon = endo caracter
uerco + "

. oCom$
= SellormStatea (LooCB)

vr < O Then
iy = *frror dopante la t-amicn Gel prerto” - Ghrs(13)

fmicigl

vy = Meg - "Fevise la arexidn ¥ ejocrie (2 mevo la
enticacziin®
= Mugoox (Mg, 16, *Trror e LA ornicaciones”)
Le rar_Com
.58
'znfocar la cais c2 texio
Textl.SerFocus
znd I
T
wnile nCid < 1}

Dim T

] . |
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'Pestaplecer la comunicacidn
SrrorCom 'verificar si ocu
*Pernivicr que oiras aplicacis
vr = DoEvents{)
ican
= S'le -

- ! - - -
El procedimiento ErrorCont que se presenta a connnujcu’m pcrmluc visualizar

los posibles errores que pueden ocurtir cuando se integia abrir un

dispositivo

COM. Este procedimiento es Hamado por ¢l prmednmluud Abrir_Com Lu.mdo al

invocar a Ia funcion OpenComm se produce ua error.

Sub ErrorOpenCom {CadigoZrror s Integszr)
Dim Msg As String : "\
Sala ct Case Codigorrror

Case [E_BADID

Msg = *“TID no walido-
Case TE_BAUDRATZ

-Msg = "Velocidad en baudios =g soportada
Case IE_BYTESIZE

Msg = "Tamafo en bytfes no vélido”
Case IE_DEFAULT

Msg = "Frror en los pardmeircs por detec
Case TE_HARDWARE
Msg = "Hardware no presente”

Case I[E_MEMORY
Msg = "No es posible asignar colas”®
Case TE_NOPEN
Msg = *"Dispositivo no ébierzo®
Case LE_OPEN
Msg = "Dispositivo abierto”
zrd Select :
“sgdox Msg, 48,
End Sub

"Error en las coounigaciuvnes

Cuando se realiza una operacion de recepeion {ReadComm) o de

{WriteComm) pueden ocurrir errores. Para detectar estos errores,
mientos RecibirCom y TransntitirCom, invocan al procedimicnte £y
s¢ presenti a continuacion. ' :

Sun ZrrorCom ()

DJim CR %~s String'* 1, vr 25 intsgsyr, Msg AS
Jim LpStat As COMSTAT

C3 = Chrs(ti3) ‘rvetorno G2 carrs

ierificar si
: GetCommError (nCid,
<>  Then

to"

transmisién
los procedi-
rorCom que

string

e _
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If {(vr ~And C:= Then .
Msg = "Ince {break) " 1 {vr sn¢ CE_=L3DT0) = C=_
GoSub Visua Msg = "Tiawn screpasan RS (Fzrelve-lire-clzmal detect) s
End I: . GoSub VisualizarMensaje
If (vr And C= Then =nd If
Msg = {Clear-Lo-send) " ) i
GoSub Visual.lzariers T2 (vr And CE_ZXOVER) = C=_ FUZR qhe:
End If - Msg = "Deshordamiento &n ¢! bifter ¢z recepcidn”
GoSub VisuallizarMensaje m_
Tf (vr znd CZ_DE=T0) a[C?_DSQTO Tnen . ’ Tnd 11 Y
Msg =."Tiergo zobrepisado DSR (Data-set-reedy)” S
GoSub Visue_ izarlMersaie 17 {vr »nG CF_PAPARITYY = CE_ZXBARITY Then

o

de paridac*
) . GoSub Visualizarbensaje ;

= CZ_DNS Then =rd [T v

: no seleccionador®

End I - -‘ - Msg = "Zrror

If (vr =nd CE_2U5
lsg = "Dispzsiz

GoSub Visuall T7 (vr and CE_TFFULL) = CE UL Then
End Tf lisg = "3uffer de transilisidén llenon
GoSub VisualizarMensaje
If {(vr ~nd C=_ _FR-ME Then gnd 1f
Mgg = "Error 1516n (encuadre)® Znd If
GoSub Visualiz Zxit Sub
End I
. Visuvalizartensaje:
if (vr And CZ_ICI) i0Z Then lsyZox Msg, 48, *“Zrror en las coxunicaciones®
Msg = "Errcy &n d itivo de E/S" 4+ CR Teturn
Msg = Msg + "imisie escablecer camnicacion con 1PTx" Enc Sub
GoSub VisuallzarMensa; . :
End It La estructura LpStar se wiliza como parimetro con la funcion GetComm-

- - - ) : [ s i icha estrucwra el error ocurrido.
If (vr and CI_*0SZ) = CS_MODE Then Error, con el hn de que ésta copie en dicha estruc el errs

-~
~

lisg = "Modo szoilicitado no’'soportado” - .
GoSub Visualizarlkenssie : Si ahora el usvario quiere transmitir informacion, simplemente tiene que es-
End If T cribirla en la caja de texto y pulsar el botén Enviar rexter. La informacion escrita
es almacenada en la cadena BufferSal y enviada al puerto de comunicaciones por
If (ve And CE CUF) = C;—O?Srf?e" - cIpnxc&nﬁcm07huumﬂhtbmtwescnumsuuacuMhmadﬁw

Msg = "No revs Dapel
GoSub Yisue.lzart
End If :

Sun TransmicirCom_Ciick ()
Din 35 String, NumCars 33 _nIager

If (vr a2nd Cz _C CE_OVERRUN Then

= Q0 Then

¥eg = “Error crivura en buffer” : -

: - “Dispost - Chrstl3
GoSub Visuel “?% PO T ’
End I b B
It (ve snd CE_=1700) JI_PTO Tnen

Fsg - tTiern: el oannento Jdet - JFS

Fsg =« Msg - "z coruntcacTon con LFix

wsub Visue frzervernizie ;:'orC'ﬂ
If ‘ .._.[ QI7

Zliminar
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RufiersSal = ZarSal, TumCars + 11}
End it
Textl.SetFocus

End Sub

Cuando ¢l vsuario quiera inlerrumpir las comunicaciones, ejecutard la orden
Detener del ment Transmisiones. Esto hace que se ejecute el procedimienio De-
tener_Click que nvoca al procedimiento Cerrar_Com que se encarga de vaciar
los buffers de entrada y salida ¥ de finalizar las comunicaciones.

oo
. [ .
Sub Detener_Click () '
Cerrar_Com
FormCom.Caption = '_3'_':::0 de comunicaciones csrrado”
End Sub J

Sub Cerrav_Con {}
Dim vr &s Incecgsr
if nCiu Tnen -
vr —lutho*"rﬂ’“'ﬁ ~y 'wWacia el buffer de transmisidn

vi- = TlushConm( ; tiacia el buffer de recepcidn
vr = CloseCorm{nCid
End If

If vir < 0 Then
Msg3ox “"llo se p.ed=s czrrar el poerto COHM: " o+ SLrsivry), 16
End

Else . .
nCid = 0 'Foner 2 c2rc n7id para deterer FecibirCon

End [ ’ .

End sSub

Para finalizar y salir de la aplicacidn el usuario puede hacer clic en ¢l meni
Salir, entonces se ejecuta el procedimiento Salir_Click. o en la orden Cerrar del
mend de conrol de la furma. con lo que se ejecuta el procedimienio
Form_Unload. E| cddigo para ambos procedimientos se presenta a continuacion.

Sub Salir_Click (}
Cerrar_Com
End

kEnd Sub

Suby Ferm_Untoad (Uarcs. 23 Integar)
Salir_Click :
Fnd Sub

MARCADOR DE TELEFONOS

CAPIIULO 13 COMUNIGACIONES 395
7.

Si dispone de un modem, la siguicate aplicacidn le permitird marcar. cualquier

teléfono que previamente teclee en la caja destinada a tal fin. Esta aplicacién po-

dria desarrollarse utilizando las funciones de comunicaciones de la APl de Win-

dows. pero en este caso presundnrunos de ellas y uuhzarepms las sentencias es-
tandar de E/S de Visual Basic. ‘

’& !

Inicie una nueva aplicacion y cree una forma titulada Te!efmm con los contro-

les que se’indican en la tabla siguiente. Guarde la aplicacidn con el nombrc telé-

Sono.mak y la forma con el nombre teléfono frm. ‘

3

Objeto Propiedad Valor i
|

Etigueta Caption Teclee un nimer ...

CttName Labell | .
Caja de texto CuName Textl |

Text (nada) !
Botdn Caption Marcar

CtName Murcar_Colgar

= P

Teclee un nimero p pulse Maicar

|
J
1
%
Antes de probar esta aplicacién asegtrese de que ¢l modem esta LOHCClﬂdO y

qué pueno utiliza (COMI, COM2, COM3 o COMYY: en el cjemplo, hémos su-
puesto que el modem utiliza el puerto COM2,

Cuando ,eiecute esta aplicacion, primeramente teclee en Ja caja de texto el
nimero que desea marcar y después pulse el botdn titulado Marcar. E h este ins-
tante el tiulo det boton cambia a Colear. Cuando la comunicacion se Jsldblezm,
hable. Finulizada la conversacion, cuelgue el teléfono vy pulse el botén ‘titulado
Colgar.
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Cuando pulse ¢l boton denominado Marcar_Colgar. ¢l cédigo ventice . <l
litulo del mismo ¢s Marcar o Colgar. Si es Marcar, se envia al puenio de comu-
nicaciones una cadena de caracteres formada por un prefiju y el mimero tecleado,
y se cumbia el titwlo Marcar por Cofgar. Para un modem comparnble Hayes ¢l
prefijo es ATDP si el 1eléfono es de pulsos 0 ATDT si el etéfono es de wonos. Si
el titul - ox Colgar entonces se ciema la comunicacion; para ello se envia al pueno
la cadena ATH, se cierra el pueno de comunicaciones, v se cambia ¢l titubo Col-
gar por Murear. El procedimiento Marcar_Colgar_Click que se muestra a conli-
nuacion, recoge todas estas operaciongs. «

Sub Marcar_Colgar_Clicx ()
If Marcar_Colger.Caprion = "M
1 Text]l.Texz <>
"a1lsos=AT02,
Nimeros = LTS
Cuan "COMZ" For Cuir
Foint o#l, limercs

tzhell .Caption = *Cizncdo Zinalice pulse Colgar-
Yarcar_Colgar.Canticn = "Colgaz”
Fric It
Else
NOmeros = *ATie
Print #1, Nizeros
Clcse &1l

Latell . Caption = "Te
Mzrcar_Colgar.Cantio
End I
nd Sub

Apéndices

Resumen del lenguaje
Diferencias entre Visual Basic y Basic
Cédigos de caracteres

fndice alfabéli‘co
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RESUMEN DEL LENGUA JE

FUNCIONES, SENTENCIAS, y METODOS :

. 1
La siguicnte 1abla presenta as Tunciones., senlencias, y métodos ugmp}udos por la
tared Yue desempenan. - '

i

Arrays . |

f

Bim, Global, ReDim, Static Declarar e inicializar areays |

|

Etase, ReDim Reinicializar arravs !

|

i

I.Bound, UBound Obtener los limites de un array !
Option Base Cambiar ¢! limite inferior de L:n.'army

- !

L]
4 om.rl'olur el fIujor de un programua !
t
Do ... Loop, For ... Next, While ... Realizar bucles o luzos ‘

: I
Wend I
GoSub ... Return, GoTo, On Error,  Subrutinas. biturcaciones C(lll(‘JIL‘II(JﬂulcS
On ... GoSub, On ... GoTo v bifurcaciones incondicionales
If ... Then ... Else, Select Case Tomar decisiones :

I
DoEvents, End, Stop, Unload Sulir de o detener un programa

i
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Convertir
Chr$

Asc

StrS, Format$

Val

CCur, CDbl. CInt, CLng, CSng,

Fix, Int

Hex$, OctS

DateSerial. DateValue

Day, Month, Weekday, Year
'_I"imeSeriaI. TimeValue
Hour, Minule, Second

Now

-

Un valor ASCII a cardcter
Un cardcter a su valor ASCII

Niumero a cadena

< Cadena a nimero

- Un tipo de dato numérico a otro

3

Un mimero decimal, a hexadecimal y
octal respectivaente

Una fecha a un nimero

Un nimero a una fecha

Una hera a un nimero

Un niimero a 1a hora correspendiente

Un ndmero que representa la fecha y
hora actuales

Grdficos

QBColor, Point, RGB
Line, Circle, PSet
LoadPicture, Savelicture
TextHight. Text\\ridlh
Scale

Print

Cls

Trabajar con colores

Dibujar figuras |
1
Cargar 0 guardar una inagen
o
Tamafio del texto R
Cumbiar ¢l sistema de coordenadas

Escribir 1exto

Borrar texto o un grifico

Munipulacion de errores

On Error, Resume

{nterceptar un error durante la ejecucion

Copiar, cortar y pegar

Clear, GetData, GetFormat,
GetText, SetText, SetData

Date$, Time$

’

Timer

Utilizac el portapapeles

Tomar o poner la fecha o la hora

Temporizar un proceso

Intercambio dindmico de dutos
LinkSend

LinkExecute, LinkPoke,

Aplicacion Visual Basic como senvidor

Aplicacion Visual Basic como cliente

Err, Erl N° de error y linea en donde ocurrid
Error§ Mensaje de error

Error Simular un error

E/S con ficheros

Open Abrir o crear un lichero

Close, Reset

l;rint ¥, Put, Writc #

Spe, Tab, Width #

Get, Input #, Input$, Line Input #

EOF, FileAttr, FreeFile, Loc,
LOF

Seek

Cerrar l"tc:herus

Escribir en un fichero

Controlar la apariencia de la salida
Leer de un fichero

Tomar informacidn acerca de un fichero

Posicionarse en un {ichen
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ChDrive, CurDir$, ChDir,
MkDir, Rmbir

Dirs, Kill. Lock ... Unlock, Name

Trabajo con discos y directones

Manipular ficheros

- Mandpdar ebjeios

Hide, Show

l.oad, Unload
Move

Drag
SetFocus
Refresh
Printkorm

Addliem. Removeltem

InpulBoxS. MsgBox

* Ocultar 0 mostrar una forma

.Cargar o descargar una fonna

Mover v ajustar el tamaiio de un control
Arrastrar y dejar caer

Enfocar un control

Actualizar un objelo

Imprinue una forma

< Adadir o eliminar un elemento enuna

lista 0 en un combinado

Visualizar cajas de didlogo

Marenndticas

Exp, Log. Sqr
Atn, Cos, Sin, Tan
Fix, Int

Abs

Sgn

Kandomirse, Rnd

eX. bogariimo y raiz cuadrada

Arco tungcn.lc; COSCNO. e v ingente
Parte entera de un valor

Valor :lh.\jlllull)

Obiener el signo

Generar ndmeros af azur
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Imprimir
EndDoc, NewPage

Scale. Spe, Tab, Textleight,
TextWidth

Print, PrintForm

Finalizar un documento o nuevajpdgina

Controlar la apanengia de la salida
R

Impnnir texio o ulqﬁ'forma

Funciemes v procedimientos
Format$

SpaceS. String$

Asc, Che$

InStr. Lelt$, L.Trim$, Mid$,
Right$, RTrim$

I.Case$, UCase$
LSet. RSet

Len

X t
) L '
Dar formato a la salida

Crear una cadena repitiendo un caridcter
L

Valores v caracteres ASCil y ANSI

Trabajar con cadenas de caracteres

I
Convertir a mintisculas o maytsculas
t

Justificar una cadena

Lungitud de una cadena '

Variables y constanies

Const, Dim, Glohal, Static

Declarar constantes v vanables

Let Asignar un valor i
Defripor Definir ¢l tipo por defecto (ripo; Im,
Lng. Sng. Dbl Cur. Sir} '
Tyvpe Crear un tipo definido por ¢l usu.Im:rio
Orray |

AppActivate, Sheli-

DoEvenls

Ijecutar otra aplicacion

Permitir gue se ejecuten otros procesos
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SendKeys

Enviar teclas a la ventana activa
Command$ Contiene los argumentos enviados en {a
: linea de drdenes ‘
Environ$s Devuelve una cadena del entorno del
sistema operativo
£l
Beep v, Pitido

L.a siguiente 1ubla presenta las propiedades agrupadas en funcion del contexto

donde se aplican.

Aspecio

BackColor, ForeColor

BorderStyle
MousePointer

. Visible .

Color de fondo v del primer plano
Estilo del borde
Forma del puntero Jel ratén

Ocultar o visuahzar un objelo

" Intercambio dindmico de datos

LinkItem, LinkMode,

LinkTimeout, LinkTopic

Intercambio dindmico de datos {DDE)

Ficheros

Drive, FileName, Path, Pattern

Archive, Hidden, Normal, -

ReadOnly, System

-

Visualizar nombres de ficheros.

Ocubir o mostrar ficheros con esus

atributos
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.

Fuentes
FontCount, Fonls
FontName, FontSize

Fontestilo

Fuentes disponibles
Cambiar la fuente acl:lual

i
Estilo de 1a fuente (estilo: Bold, Italic,
Strikethru, Transparent, Underline)

Formas v controles

Cancel, Default

Interval

Parent

ScrollBars

Style

Tablndex, TabStop

Value

CtiName, Index

ActiveConltrol

List, ListCount, ListIndex, Sorted

Max, Min, LargeChange,
SmallChange

Enabled, Checked
Enabled

ControlBox

Botén por defecto b‘:nra Esc y para
Enter S

Poner el intervalo de liempo

Forma a la que pertenece un control
Visualizar las barras de desplazamiento
Tipo de combinado

Fija el orden seguidu.por Tab

Verifica el estado de un control
Nombre e indice de un control

Retorna ¢l control que estd enfocado
Manipular listas

Valores relativos a las barras de
desplazamiento

Controlar un elemento de un mend
Responder 0 no a sucesos

Determina si aparece o no el mend de
control de una forma
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lcon, MaxRutton, MinButton,
Window State

FormName

Draglcon. Drag\Maode

Propiedades relacionadas con minimizar
O MaMIMIZar una fornil

Nombye de 1a forma

Arrastrar v dejar cier

Grificos

AutoRedraw

AutoSize
Image, Picture
CurrentX. CurrentY, DrawMode,

DrawStvle. DrawWidih,
FillColor, FillStyte

v
LAY

Restaurar una inugen cuando sea
. preciso

“ Ajustar el tamadio autonkilicimente
Acceder a una imagen

Dibujar

Tprinmir

hge

Namero de pigina

Tamanio v posiciin

Alineacivn del texio en una cliqueta

Left, Top _ Posicidn de un objein
Ht‘i_ghl. Width Tamaio de un vbjcle
Tevto

© Alignment
AutoSize

Caption, Text

Sell.ength. SelStart, SelFext

Ajustar el tumafio aulonkiticanicnle
Titulo ¥ comtenida du v control

Testo seleceiondo”

]
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*

Ventanas X
kDC Handle del contexto de dispositivo
hWin ' ‘ . Handle de 1a forma -
;
B
. .
SUCESOS "o !

La siguiente tabla presenta los sucesos gue se pueden dar cuando ocurre una de-

terminada accion.

Accion

Sucesos

Cambios en ua contiol

Armastrar y dejar caer

Intercambio dinamico de datos

Pulsar una tecla

Operaciones con el ratén

Cambiar el foco (enfocar)
Transcurrio el intervalo de tiempo

Trabajando con farmas e imdgenes

Ch;lnge. DropDown, i
PathChange, l'alu:rnChapge

DragDrop, DragQOver

LinkClose, LinkError,
LinkExecute, LinkOpen

KeyPress, KevDown, KeyUp

Click, DbIClick, MouseDown,
MouseUp, MouseMove !

.

1
GotFocus, LostFocus
1

Timer :
1

Paint, Resize, Load, Ul“ll(jad

OBJETOS

j
1
|
t
i

Lo . . . S
La siguiente tabla presenta una lista de acciones v los objetos que tipicamente se

utilizan con tales acciones.
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Accion ()hjelt; . ' .
Devolver ka forma o el con-lrol Acvo Screen , APE‘NDICE B
durante 1a ¢jecucion .
Elegir un elemento de una lista l.ista, combinado, grupo de
' opciones
| - DIFERENCIAS TNTRE, VISUAL
Conpiur. contar ¢ pegar + " Cliphoard

| BASIC.Y BASIC

Visualizar datos ca la ventana inmediata . Debug

Visualizar un mapa Je bits s - Caja de imagen INTRODUCCION A‘.l
Agrupar controles Marco _
Visuzal Basic no es totalimente compatible con otras versiones de BASIC, como
Introducir texto Caja de texto GWBASIC y BASICA, o con las versiones posteriores a éstas, QBASIC, Quick
. Basic y BASIC profesional, lo cual exigird hacer algunas modificaciones a los
Linprimir 1exto o grificos Priater . ‘ programas realizados en estas versiones, para que puedan funcionar en Visual
7 . Basic. En lo sucesivo, para referimos a ambos grupos utilizaremos los 1érminos
Desplazamiento de los datos en un uhjeto  Barras de desplazamiento GWBASIC y QBASIC respectivamente.

horizontal y vertical

CONVERSION DE BASIC A Visual Basic

Ejecutar una orden Botén, meni ’

Seleceionar un directorio Lista de directorios Cualquier fichero ASCII que contenga cédigo BASIC puede ser importado a Vi-
sual B;;sic ejecutando la orden Load Text del mend Code.

Seleccionar una unidad de disco Lista de unidades de disco

, En Visual Basic, todo el codigo ejecutable estd agrupgdo en procedimientos
Activar o desactivar una opeicn Seial, opcién {Subhy funciones (Function) y la parte de) codigo relativa a declaraciones

(Detzpo, Type. cic.) se escribe en la seccidén de declaraciones de Ja forma o del
_madlo, y en el madulo global,

Los programas GWBASIC no tienen procedimicntos. Por lo 1anto, cuando

Visuzl Basic importa un programa GWBASIC. coloca todo el c6digo en la sec-

~cion ¢ declaraciones de la forma o del méduto actual. A continuacion, es tarea
del programador adaptar el cédigo y colocarlo en procedimientos y funciones,
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ry

Los programas QBASIC ticnen procedimientos ¥ lunciones, Por lo tanio. AMBITO DE LAS VARIABLES
cuando Visual Basic impona un programa QBASIC, coloca los procedimientos ¥
i imi s Sub v Funcli ivel de I: v del modu-
las funciones. en procedimientos Sub v Function a nivel de la forma ¢ . o o
Jo actual. v ks declaraciones en 1a seccion de declaraciones correspondiente a di- S_L t"”@"dc' por dmbito de una vanable. el ¢RI de la .J[:)ln..a(_‘.l(ln dO‘ﬂ‘dL la va-
cha fnrm'l'u médulo. A continuacian. es tarea del programador adaptar ¢l codigo, Eﬂhi-c ul:s ;;Mhlc v pur lo 13A10 se pucde unlizar (para mids informacion vea el
I . ¥ H P H o e v apiuio 3).
colocar en procedimientos v funciones et cédigo que atin no lo esté, 3 cuolocar cn p ;
3 al las declaracione correspondan. . ) ) !
¢b madulo global Tas decluraciones que € po En GWBASIC, todas las variables son compartidas por todo ¢l programa: en

Vicgal Basic las variables son locales por defecte. Pur Iuﬂhnu?. cuando se impone

. n : Riividht -
PALABRAS CLAVE NO SOPORTADAS un programa GWBASIC se pueden dejar todas las vartables locales Em;r defecto. y
: declarar en la seccion de declaraciones de la Torma. del médulo. (;) del modulo
Visual Basic no soporta s siguientes palabras clave: . global. donde corresponda. aquellas que sean compartidas por varios procedi-
e ' E o . Mieos. . . |
BLOAD BSAVE CALL ABSOLUTE CALLS CHAIN . . B -
CLEAR COLOR COM CSRLIN cvD Las variables locales en un programa QBASIC se trasladan sini cambios a
('\'H').\llll-‘ ("\"'I‘ \vS CVSMBF DATA Visual Basic. Las sentencia COMMON SHARED en QBASIC hay I‘qﬁc reempla-
I;I:[: i"\‘ : l-)l"F SEG DR AW ERDEV . ERDEVS zarla por la declaracién Global en el madulo global, v DIN SHARED por la de-
}:“_:[ D ]_-“‘ S N I'RE T INKEYS INP claracion DIM a nivel de fa forma o del médulo,
i0CTL. [OCTES KEY LOCATE LPOS . . R E .
LPRENT MEKDS MKIS MKIELS - MKSS En FEsumen. una vez importado un progranks. para evitar ‘rmrlcsflr:udlc.mns
MESMBES  ONCOM ON KEY ON PLAY ON STRIG de conservar el mbito de cada una de las varisbles stempre (e sea pusihle,
.(,\u -T;I\Il:l.'{ ()iJT . PAINT PALETTE PCOPY Cuando esto no sea posible. puede ser necesario cambiar ¢l l\l\lllhliﬂ de alzunas
I-’I;‘l-’K o PN PLAY PMAPR ' POKE ' variables para evitar contlictos. Tamibién habrd que wener en cuenta que el nombre
I‘(-)é PR“FSF RVE PRESET RESTORE RUN de una variable no coincida coq el nombre de un objeto o de uma propiedad.
SADD SCRELEN SETMEM SLEEP SOUND -‘
. s 1
STICK STRIG SWAP TROFF TRON B
LSINGS VARDPTR VARPTRS  VARSEG VIEW CONSIDERACIONES GENERALES _:
WAIT WIDTH LPRINT - WINDOW ‘La sentencia Peclare solamente es valida para rutinas DXL v para’ funciones
En la mavoria de os casos, una palabra clave no es soporiada porgue Visual {Function) sin argumentos. que son Hamadas sin vilizae paréniesis. Esto es. una
B-mic_I‘:|u':xll-:hll.\n<.r:|1:(;in-&-nc:;;.'su‘riui para lograr ¢l mismo resuliado. Por cjemplo, Hamada a una funcion, Fur‘lctiun. ticne que wilizar paréntesis ;mnquc%[u funcion
lu .;cnlcnciu LPRINT no ¢s soportada porgue Visual Basic provee ¢l ubjeto Prin- no tenga argamentos, Por ejesplo, :
ter que controla wda informacion enviadi a Ta impresora. En ofros casos, una . i

i 0 v ; Vo= MiFoacidn ()
palabra clave no es soportiads porgue involucra operaciones de bijo nivel que en- d

tran en conllicto con ek entoro Windows. Pari poder omitir los paréntesis es necesario incluis una sentencia Declare en

: - la reccion de declaraciones de la forma o del mddulo actual,
En Visnal Basic. cualquicr referencia 2 una linea ctiguetada (GoSub o Ge- ¢

oy debe ser local al procedimiento. No ohstante. una ruti invocada con GoSub
puede ser consertidie en un procedimienta, Asitmismo, las funciones dclu.nda:s' con
b sentencia DEE FN no soporiada. ticnen que ser convertidas en tunciones

Una rutina para manipulacion de errores (On Error ... ) ticne que ser siem-
pre local al procedimiento. La rutina y la sentencia On Ercor ticnen lque estar en
el mismo-procedimicno. '
tFunclinn,
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La sentencia PRINT de Basic tiene el mismo efecto que 1a sentencia Print en
Visual Basic con Ja diferencia que és1a escribe en la forma actual. Para escribir en
atro lugar, por ejemplo en la caja de imagen Picrure! hay que wtilizar 1a sintaxis,

Picturel.Print
Otras ahermativas para visualizar datos son la sentencia v la funcidn MsgBox.

l.a sentencia INPUT Ov.neralmenu;'la 'recmplazaremm con la funcién’ Input-
Box$. Otra solucién es crear una caja de texto v wtilizar su propiedad Text.

Visual Basic no soporta la sentencia INKEY. Para reemplazarla utilizaremos
un procedimiento conducido por el suceso KeyPress.

La sentencia Defripo sélo puede utilizarse en fa seccidn de declaraciones de
la forma o del médulo, y en el modulo global. Esta sentencia tiene que escribirse
anles de cualquier sentencia Declare.

No'se puede definir un array implicitamente. Los armays tienen que ser decla-
rados explicinamente utilizando la sentencia Dim o ReDim. Si en la sentencia
DYim se especifican las dimensiones, se crea un array de longitud fija. Por ejem-
plo, :

Dim Mizrray(99)

Esta sentencia puede aparecer a cualquier nivel. No obstante, cuando aparece
dentio de un procedimiento, tiene que especiticarse antes de cualquier sentencia
ejecutable. Si en la sentencia Dim se omiten las dimenstones, se crea un aray di-
nimico. Posteriormente, utilizaremos la sentencia ReDim para asignar espacio.
Por ¢jemplo,

Dim MiZrray ()

ReDim MiArray (99)
‘. i g . -
También se puede crear un array utilizando directamente la sentencia Re-
Dim. Como esta sentencia es ejecutable, sily pJ ede aparecer en cualyuier parie
dentro de un procedimiento.

L.a sentencia Option Base sélo puede wilizarse en fa seccidn de declaracio-
nes dc la forma o del médulo. y en el médulo clobal. Esa sentencia tiene que es-
> antes de cualquier referencia a un array.

N <.

La sentencia Input$ (n, id_fichero) devuelve un EOF (fin de fichero) cuando
intenta leer de un fichero en el que quedan menos de # caracreres. Una solucidn a
este problema puede plantearse a través de la sentencia On Error. Otra solucion
es hacer que m valga |, como en el ejemplo que se presenta a continuacion.

05 For Iaput As =1 '1
":S(l, 1)
EOQF (1) '
S} <> 10 Then zrint cars; o
utS(l 1) s

Visual Basic acepta ka sentencia Return. pero no Retaen ief_linea.

Enlasentencia Width # id_fichero, n, si n vale 0 indica que el fichero o dis-
positivo no tiene limile de ancho (para esto, otras versiones de Basic utilizaban
n=233). Un vilor de n>0 indica donde finaliza una linea. Visual Basic no soporta
las seatencias:

WIDTH columnas_pantalla, lineas. pantalla
WIDTH dispositive, anche

Orras consideraciones de interés son:

+  Para referenciar una propicdad, un método 0 un mieinbro de un tipo definido
por el usuario, se utiliza como separador ¢l punto. Por lo tantu no utilice este
cardcter en la declaracién de variables o constuntes.

* Visual Basic soporta lineas de hasta 236 caracteres, puo no liene un caricter
de continuacion de linea,

+  Visual Basic no permite que dos variables decluradas al mismo nivel tengan
¢l mismo nombre, aunque tengan diferentes tipos. Por ejemplo a% y a$ no
pueden existir al mismo nivel de declaracion.
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CODIGOS DE CARACTERES

UTILIZACION DE CARACTERES ANSI CON WINDOWS

t
Una tabla de cddigos es un juego de caracieres donde cada uno tiene asignado un
nimero wilizado para su representacion interni, 1

\
. - . . _— b

Winduws utiliza el juego de caracteres ANSL Para escribir un cardcler ANSE

que no esté en el icclado: :

1. Localice en la tabla gque se muestra en la pagina siguicnte el canicter ANSI
gue necesite y vhserve su codigo numérico, !

I

. . . o
Pulse Eitecta Blog Num (Num Lock) para activar el teelado nunmiérico.
3. Mantenea pulsada la tecia Alty wiilice el teclado nuindrico pari pulsarel 0 y
a continuacidn las teclas correspondientes al codigo del cardeter.
- i

Por cjemplo, para escribir el canicter % bajo el entorno Windows, mantenga
pulsada L tecta Alt micntras escribe 0177 en el teclado numérico.
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JUEGO DE CARACTERES ANSI UTILIZACION DE CARACTERES ASCI
: Buajo MS-DOS y fuera del entorno Windows e unliza el juego de caracteres
. = Yoare g e N ol oM o e 1t -
DEC €k DEC CAR EC CAR DEC AR ASCIL Para escribir un cardcter ASCH gue no esté en el weclado:
n o b e ot b Busque el caricter en la 1abla de cidigos que coinciha con b tabla activa.
s LT s v 0 L Utilice la orden chep para saber qué tabla de codigos et activa.
;: : )] \ 1 . s |
¥ s :: 1 :: - :: : 3. Muantenga pulsu'(lfl'la techa .:\Il v utilice L:I teclado nwlnc_r:co para pulsar las
» o % C B ws b teclas correspondientes al numero del cariicter que desee. ”
% ¥ . LU 0% N . ) L )
a ) L T Y 154 "% FIT . ] o P .- ,
g . " 155w m 0 Por ejemplo, si estd wiilizando la 1abla de codizos 850, para escribir el caride-
+ . ) . -
a :: : :: = ::; 3 ter © mantenga pulsada latecla AlLmientras escribe 127 ep'cl teclado nunérico.
o . r r 15T »n IV N '
“~ . g 159 ® ns  x
4 U [T ¥ I U] N O
4 e 08 W m v
2 1 0 ) o« m 0
b 2 197k T ¢ ney 0
5 3 | 14 o ue O
51 4 "™ = 16t m ot
3 $ He w 117 u: b
4 ¢ Nt o 1 8 mw .
L 7 n g - 14 A
6 8 1n g 16y = us
57 ’ 1 r e ne 4
4 : ns s mo - m
53 H et [/ T 1 s
® < " m o . i v
(1] = 13 L] 14 & PA ] - .
61 > n w s AT
34 ? M x 1% " oo
H4 9 m oy 1M s 1L .
[ 1) A 112 1 m L4 pall *
“ B m 1 Bs
L1 C i [T I 1T Y
L D 1s  } [T nr 4
® E T [T+ m
1¢ F 117 »n 1 . 19 |} -
n G s n - LT I |
n H 129 3 s ' 141 A
B v B 1% ¢ M b
T4 J FRTT - 1w . M 4
m K N T S PYT I
L (K I 1 % YT}
7 M [T 1% % T !
* N 135 m It TR o+
» o 1% B m .
wor [FE A b 1T I
InoQ (LU LYIY PP
n R 1y " - T H T
& s ® n 1% A 3 Y
L T [E1-} (LA § 8§
as U X B M £ 14 b
Lo ¥ 141 1" 185§
¢ W (¥ " 100 E
L] A 148 T




18 VISLAL BASIC, APLICACIONES PAR A WINDOWS

. . |
APENDICE €: CODIGOS DE CARACTE

|

rrs 419

JUEGO DE CARACTERES ASCII

. htied :l::]m Bool m|unu ;‘;Eim
000] oo inuLl  lo43| 28| . [oss! ss ! v J129j 81| o |172)aC] 'l NI5] P2 ¢
001 o1 json] © [oaa| 2¢ | oz sr 1w [130[ 82 ¢ {173{an| i |216]08i =
002/ 02 | s} @ |o4s| 20 ossl s8] x {131 83§ ¢ [174) ae | - [117]00] 1
003| 03 [Emx} @ foas| 26| . omel 5ol v J132]8a) s N7s|a | . j218[ 04t "
004| 04 €01} @ loar| 26 | , |osa! 5al 2 [133| 85} & |174| BO [RZ[219[ 08 ®
“|0os] os [eral & [oas} 30| o [091] 58 | i |1d4] 86 | & [177] B [ {220/ DC =
00s] vs [ack]| 4 Joas] 3111 [oez2) sci v [rasfer{.c [178] 82 [mm|221|00 |0
007] 07 feet| « 050/ 32| 2 |o93jso| | |13sfsaf s |179je3 | i Ja22fDE; §
00a| oa |.as ' E¥{os1| 3313 Josal sei o j137| 89| & 180 8¢ | 1 |223] OF | mm
009! 09 [Hr 1 O |os2| 34 ] 4 logsi sf i _ liaslan] o q1810 65 1 = [224] €0 | o
010 oa | 15 1{@ 053 35! s |09e) 60| - [139} 881 i [182]88 | 4225 €V | 8
o0V o8 [vi|(Sos4| 360 4 [097i 611 o {140[8ci i [183] 87 | 70 |226] €2 | =
o12)oc | k¢ 1 O loss| 37| 7 |osal e2i b |141] 80 1 [184j 88 | = [227] €3 (77
013| oo |cn| s joss| 38| o |ovsl 63| « |142| 8| A [18s| 09 | =0 [228] € i1
o1af oc |50 153 J057| 39| ¢ |100j 6| d |143[ 8F) & [186]BA] uj229|ES ) o
ois|of | 9 | O lose[3a] ; [10vtes} « [1aal90] ¢ |187] 88 [ 3 |230] €8 | &
016| 10 {oLe| = |o59) 38| . |1021 681 ¢ |145]91 | = [188]BC| A|7n| €7 ] ¢
017} 11 [DC1i =080 3C | < 1031874 9 [146]52 | & 189/ 8O | 5 j732) €8 | >
018( 12 [0c2| | 081301 = 1041 681 b 1147] 93| 6 |1o0] B€ | 1 233} €9 | B
019 13 Joca| o Jos2) 36| > frosieer i j148| 94 ] & [191]8F | T ]234] EAJ ()
020/ vaJoca] v {os3| 3¢ [ 7 fros exi i |149] 951 o [192[cO| L J23s5| €8} »
021 15 [naxi 8 Josa| 401 @ f1o7' 631k [1s0) 96|y [193] O | L fz36) €CicO
022 16 [SYH|==]065] 41 |_A f108i¢C] 1 |15} 97 o [194]C2 | T[237]€0: 3
023] 12 |et8| ! {ossl 42| & |109, 601 m {152| 98| 5 (195 C3 | }- (238) EE | T
024] 18 [can] | |067| 43| ¢ [110f 8E | n |153] 79| O [194)C4 [ — 239 EF I
025 19 |Em | | [068) 44 | O {100 6Fj o |154[9A| O [197)C5 | + |240] FO | =
026 1A |3uB] -- loe9) 45 | E |112: 700 p |155] 98] ¢ [198[CE | = [2a0| PV} ==
027{ 18 [esc| -- Jo70| «s 1 ¢ 113 711« |1ss]9ci e |ive[c7 | ¥ |2a2| 721 =
08| 1C]es L_Jor1|+7 | G jhig, 72t « 15790 v [700|C8 | & |243] F1 | =
029( 1065 [<~=[072| 487 n frasi 73} s [158) 96| m [200[Co | & (244 F4} 1
030| Ve RS | A J073[ 49| 1 jrasi 74 ¢ [159f 9F | 4 [202]ca| d[2a5] 5 )
W7iis i P 3¢ |228] F6 1 ~

s se iy ; [ T NS

19 == 24-_6 3, =

= 149 FRiw

=t: 250 FA -

A 12514 FO iV

1 f2s2f FC | -

T |asalfo

4.

CODIGOS EXTENDIDOS .

Segundo cédigo Sigaificado i |
k) NUL {null character) |
15 Shilt Tab {—< + +) "
16-25 AN-Q/W/E/R/T/¥/UA/O/P
30-38 Al-A/S/D/IFFG/HA /KL 1" !
4450 Alt-Z/X/CiN/B/N/M - 1
59-68 Keys F1-F10 (disabled as softkeys) '
¥l Home !
12 Up arrow ) |
73 PgUp ' '
75 Left arrow ! 5
17 Right arrow
79 End
&0 Down arrow
81 PgDn !
82 ins
83 Del | :
84.93 . FI1-F20 (Shift-Fl 1o Shifi-F10)
94.103 F21-F30 (Ctrl-F1 through F10) .
104-113 F31-F40 (Alt-FI through FI10) !
14 Crrl-PriSc '
(1} Curl-Left arrow
16 Ctrl-Right arrow
17 Cirl-End j :
118 Ctrl-PgDn |
119 Cirl-Home :
120-13 Alt-1/2/3/4/5/6/1/8/9/0/—/ = :
132 " Cul-Pglp '
133 Fli :
134 Fi2 . ]
13§ Shift-Fl1 .
136 Shift-Fi2
132 Cul-Fll .
138 Curl-F12 .
139 Alt-Fll
140 Alt-FI2 ‘
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CODIGOS DEL TECLADO
Tecia Cédigo es Hax Tecla Cédigo en Hax
Esc -0 Left/Right orrow OF . ' | APENDICED
H . 02 | Q 111 . 1
@2 ’ 03 W 11
3 04 E 12 - . b
“ ’ ' 0s "o R 13 ',!- A
%S5 06 S 7] ‘£ at A T W
s e i s - INDICE ALFABETICO
&7 08 v 16 -
8 09 - i 17 . .
lid ' 0A 0 13 ' o
)./ a 0B P 19 i
= oD 1) IB
Backspace OF Enter IC A arrasire
Cirl 1D Y 2B ‘ . de una imagen. 242
A \E z C N abnr fichesor, 164, 177 - manual, 248
s IF X Fin] . Acceleraior, 98 Amars, 129
D 20 C 2E ' Access, 178 . de contrales. 36; 718
- F 21 v 2F activar oira aplicacidn, 122 de estructuras, )22
G 22 B 10 ActivaeControl, 126; 320 de cegistros, 131176
. AcuvarcForm, 126 de vanables. 35
.23 3 , : *anables. 5
5" 24 z 32 ot ActiveContral, 320 dinamicos, 56
p 25 3 Addltermn, 142 . . eskiticos, 55
< algoritmos Hash, 267 . hash, 267
L :g ’>/ :‘; Alas. 327 . A, b
N ? . ambito ASCIL 17
! 28 RightShift - 36 de un pricedimiento, 48 AutaRedraw, 200; 203: 206
= 29 . PriScr® 37 de una variable, 18 AuwtoSize, 191
LeftShift 2A Alt 3B ancho de finea, 208 aywda, 12
Spacebar 39 7Home 47 animacin. 191 -
Caps Lock 1A - 8Up arrow 43 de una imagen, 214 T,
. ANSL 115 -
Fi . 3B 9PgUp 4 i . 8
F2 . iC - . dA y.320 - .
Fj 0 : dLeft arrow . 4B , aftadir un elementa a una lista, 142 - o BackColor, 71
e 3E . s L4 AFL 23 barma
F3 ¥F SRight arrow 4D aplicacin. 3. 6 de mends. 16
crear, §; 19 de propicdades. 7: M
Fé 40 + . 4E depurar, 31 i
F7 4 1End 4F Cputar, de vitulo, 16
. . ejecutar, 31 barras de desplazamizato, 16; 22: 150
2 42 2Down arrow 50 guardar, 30 BorderSide, 142
F9 4] 3PgDn b1} aplicaciones Windows, 112 bewrar un‘comrul, a8
Fio L : Oins 2 _ AppAativate, 322 . buton
FI - D9 Del b3 Append. 165 ' del raén mis 1acly, 222
Fi2 DA ' argumentos por defecio, 12
Num Lock 45 de los sucesos del raién, 219 pulsado, 220
Scroll Lock 46 - . por referencia y por valor, 51 . botones, 12; 72
d . ' armancar Visual Basic, 14 Hreak, 259
arrasurar, 238 BuilkdCommDCB. 377
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HYTE. lips
ByVal 53 2

[N

cuga de tevo mulilinea. 99
Caja de levn. 22
valculadora, 53

cumpa, 13y

Canvel. 33

Cuption, #3

cargir wna aphicacion una solaves, 361

Change, 32 132 163
Checked. 93

Cirele, 211

Clear, 112

(4] 28171
chiente, 28t 2000 296
Cliphoard. 111
Clane, 163
ClineComm. 37X
CloseSound. Shh
Cly, M0, Mu

codign |

unin 3 los obpetos, 27
visualizar 7
cusho, 215
volorear figuras, 213 '
oo, L BR3
LR AL B

costabinadss.

ind

camctarny, 33
Comnands_ 14
LU
CONSTAXNT 27
coistaie e caracieres, 36

vonslanie, 36
contento de dispanitive, 131
control .
anadir. 195
anadir, climinar, 81
hograr, 24
crear. 13
moree, 23
miner. nnslihwar, (93
tipa Contral, 32
ControlBuy. 26

ies

Crear et cjevuoinn, 8

Ihove The s Db, 164
vemstnech s 7

YT PTYPUE S |
PECTT S WA WS

deb puntene del

rolanivas, 2iH7

Copuar,

contrel. 23

cerilfolas SR eJacucion, &
un ficheri epeceiable, 32

un aidula, 3905514

un provedimizabe general. 43
una aplicacion, 31962

utia foima, 4 -
CreszeCompanbledC, 351
ClName, 63
CurDnirs. 256

Currracy. 38
CurentX. '
Cumsm Y. 1'#)
vursaor del randn, 250

DOE. 259
dr sioes, 26y
Drbag. Prim. 261

devharar una uaion J: uns DEL. 326

Declare. 30; 126
Dutault, 72 81k 16y
DeleeDC .
depasar wna aplicacivn, 31 23y
dibupar los controles, 4271
dibujar

un circules, U elipae oua aree, 20k

un punie, 104
T oung cape, P
una linga, 207
dibejos, 214
Lum. 33402
s, 236
Jirectonio, seleccinnae, 171

i, sebeccivaun, 170
dishe, 239

DL, 3o 323

|5 L NEY )
Ihcbrents, 3037 2L

EMIS. cjevitaz ubabadad. 359
breg 282

Mher,
1o Shonde, 2ed
oSt le, T08
row s ik, e

LT TSN N

Vet

APENDICE 12, [NDICE ALUAI

ETICD 423

F4S de daws, B3]
CJECUIIn paser g paec. 260
ejecucion. 230
iniciv, 363
e deunauaplicacion, 3
d2 Grdenes ! sistemy, 73
de un procrame. Shelll 153
cjecutar. 2

chiminacion e elemenios, 271

climinas vn ehemento de una biste, 133

Elwe. 42

el .. TapeOf. 5
M_GETLINECOUNT, 243
EM_GETMODIFY, 513
EM_LINEFROMUHAR, 343
BN LINEINDEX, 325
EM_SETMODIFY, 335
ESE_UNI). 323

End Functima. 39
Ladih, 3
chficar un ubpern. 126

enlace calicoie, 291
enlace frio o culicnie. 302
enface Irio, 3(H

entieno operatise, M3
enviar leclas, 322
LEOF, k73

Em, 258

Lt S,

Errow.

enores, T 3R
ot ide BAF
DDE, 114

M CYNUAR TR, 3B
manipatacidnde, 234
ES _PASSWORD. 337
ES_SETPASSWORDUHAR, 337
Facape. 337
evenbir fichero, 162 177
eserhis e, |
etiho, 208
LU turge 2 conie). 37
osliucturas. 34 33
cliyueta, 22061
EXEL crew fichern, 32
ot fn
[AYTR T A
Exa Fundtnem, Y
Eait Sub, ®0

enpresion Jo Baede, 23

hehero
abrie, 177
abrir, cxenihir. cermar. 164
aleatoria 162 174
binarin, §62; 157
borrar, 1IR
cambiar nombre. [83
cervar. N
de datos] 161 -
cjeclable, 31
ecribi] 177
inderado, 266: 271
feer, 180
secucnwial. 162
seleceromar, 172
Bicheras largos, 173
FileName, 168
FliColor, 213%
FallSinte. 213
final del fichero, 173
finalizar la ejecucion. 21
fiwo, 126
FortName, 107
For .. Newt. 45
ForeColor, |13
Foenm. tipo, 52
Form_Load. 110
forma. 7
amdin, 124
cargar, 110
crear, 4
moser v sjusiar, 2
weulnar, F1O
suceses, M)
s Fagth, 32
vicualizor, 70110

Fonmas s comroles,

lonmas
manipular, 111
referencis a. 111
FornuS, 64
Fucntes, 1117, 256
Flu-hComm, 391
lunciin
A, b6
Curl)irS. 2536
du aceeso, 268
LhrS, 236
Pralivents, 303 214
LR 175
Err 238
Eirm b
Fanans, 64
Hueas, 137
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Inputs. 175

InputBor . 139, 132

[nSu. 118; 202

Len. 105

LoadPiciure. 19

Loc, 158

LOF. 183

Luim$, 128

Mids, 73

MypBot, 132,178

Now, 70

OcLs, 137

QBColor. 133

RGB. 133

Rights, 123

Rinms. 115

Shell, 73: 152

Sus, 1169

Tab. 211

TimeS. 116

L Caweh, b6

Val 2

NValor, 78
Tupciongs de la AP de Windows, 126
funciones, d4: W9
Function, 18, 11

Geet, |80), 187
GetActseWindow | 36l
GetCommErns, 377
GetFocus, 143

. GetFormat, 321

GeModuleHandle. 365
GetModulel sage. 365
GaNumTasks, 3ol
GelParent, 333
CietTempFileName, 113
GerTew, 108 217
GerWindowlong, b6
Global, 10
glubal, médulo. 57
Guifocus, 126
gidficos, 18%, 114

bowrar. 2b4

enun DDE, 110

persislentes, 201
guardar 1a aplicacion, 30
GWL_STYLE, 36

Haxh, .

abierin, 268
con orerflow, 270
climinacion de ua elemeato, 271
hD(C, 33
Height. 193197
Hens, 137
Hide, 110
hWnd, 331

Icon, 111; 246
iconos, 109; 191

asociar, 112
If... Then ... Elw ... 42
if ... TypeOf. 53

If. 53
Image, 321
imagen, 22
afadir. 109; 169
tipus, 159
inmediata, 10; 12 261
impeimis resultados, 283
Indet, 56: 57, 79 86: 99
indevado. 266
inicia de fa ejecucidn. 163
Inpws. 172: 175 413
InpuiBansS, 1291132
instalar Visual Basic. 13
InSu. 138 202
inlerfaz, 61
Intenal, 114
IsWindow, 63

KesPuown, 67; 1G5

KevPress, ¢ 116: 237

KesUp. 67: 103

kil 178 - ) .

LargeChange. 131
L.LB_RLESETCONTENT. 36
leer fichero, 1722 130

Lefuy Top, b2

Lefi, 193

f.on. 103

Lib, 127

libreria dindmica. 225

Ling lopw, 3

Line, 201, 2

APCADICE D INDICE ALFABETICO 323

Link€lime, MY 2imp
[ RTINS
LinkFecure. 30

[ ank Fxceue, 310
Lk liem. 2900

LankMode, 241 -

LankOpen, W07; 38
Link Poke, U2
LinkReguest. 191: 310
1 inkSend. 31D
ink Timeaur, 202
1 ink Tupic. Y90
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Lab 1:

Créatiﬂg an About -Box“

= A

‘Objective

The overall objective for this lab is for you to become comfortable with the way the
Microsofte Visual Basic™ programming systcm for Windows™ supports application
development. In this lab you will design and build an Aboul box—that's the

copyright form—for the Employee Database application that you will be building
during class.

At the end of this lab, you will be able 1o create a single-form Visual Basic
application with:

» Two label controls
= One command button control
a  One picture box control

When you are finished; the form should look like this.
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Procedures

E To get started

4
2.

Slan Vlsual Basic.
Rename and save the form as ABOUT.FRM in\STUDENT NABOQUT,

E To create controls and set properties

L.

Set \he properties for the About box form as follows.
Caption BorderStyle Name

About Employee Daabase 1-Fixed Single  f{rmAbout

. Resize the form to make it smaller and narrower. For exact dimensions, scc

Appendix A, *“The Employee Database Application Object List,” in the back of
this manual.

. Set properties for each of the controls lisied below.
. To create the top label, double-click the label control tool in Lhc Toolbox, and

position the new control at the 1op of the form.

5. Set the properties for the top label as follows.
Control Name Caption A ~ Alignment
Top label IbiTop - Employee Database version 2.0 2 - Center

. Grab the sizing handles and Icngthen the label so that the caption fits on onc

line, Center the labet and move up.

. Tocreate the bottom label, double-click the label control ool in the Toolbox,

again. Position this sccond label in the middlc of the form.

. Set the properties for the bottom label as follows and center it on the form.
. Control Name Caption I Alignment

10.

11,

Bottom label IblBottom Copyright (c) 1992 Student 1 2 - Center

. Grab the sizing handles and Ichglhen the label 50 that the caption fits on one

line. Center the label and move up.

To add the command bution in the upper-right comer of the form, doubie-click
the button control tool in the Toolbox. Position the button in the upper-right
comer of the form.

R Scl lhe properties for the button as follows.

. ‘Control .. Name Caption

Command button cmdOK OK
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"12. To add the picture box, double-click the picture box toot in the Toolbox, and

position the picture box-in the upper-left corner of the-fom. - - ——--

13.  Set the properties for the picture as follows:
= - Control Name AutoSize BorderStyle

i

- Picurebox - picLogo True 0 - None

Z To add a picture .

1. To add the correct icon for the picture control, select the picture property, and
then click the three dots(...) that arc displayed at'the nghl end of the sctlings
box. It should look like this.

2. This will display a Load Picture dialog box.

lLoad Picture:

Ditoctorias:
c:\vb

¥ B e\
v

] bitmaps

* binp,".wmi,"ico.".

0 3 icons
- £ matafile 2
Liat Files of Iype: Drives:

[an Picte Fies [ |[&Ee i

-+ -3, Iathe\VB subdirectory, locate the NCONS subdircctory and then the \MISC
... -subdirectory. Select the MISC28.1CO file and choose OK. This will dispiay the
two figures as an icon on Lhe form.

Z To position the form for startup

"Now that you have placed the controls on the form and set the propertics for those
controls, you might want to set the position for the form on the screen when it is
started, This is a lot simpier than you might think.

e Place the form where you want it— for example, in the middle of the screen.
When you save the form, it will retain the information about its position on
screen.
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Z To save your work ' !

Now you need 10 make sure that you save Lhe changes you have madc (o the About
box form. This process has two steps: saving the form itsclf and saving the project.

1.

-l k!

=3

5.

" To save the form, choose Save Filc As from the File menu . Make surc that you
save the form in the \ABOUT subdircctory. This will probably not be the default
directory in the Save File As dialog box.

Choose QK.

Next you need to save the project itself—in this case, only the About box form,
but in other cases an entire list of forms.

From the File menu, choose Save Project As. You will get a dialog box that asks
you to give the project a name.

. Type ABOUTBOX.MAK in the form, -and make sure that you are saving the

file to the \STUDENTINABOUT subdlrectory
Choose OK,

Itl There's Time

You have completed the essential steps needed to get a simple About box up and
running. In order (o become familiar with some of the other propertics of labels that
you can set, alter the FontName, FoniSize, FontBold, and Fontlialic properties to
further customize the look of the form.



Lab 2: Employee Database
Applieation Specification

Objectives

There are two objectives {or this lab: The first is to outline the general
characteristics for a small front-end for an cmployce database; the second is to give
you a chance to take a first pass at designing Lhe application based on your current
skill level.

Procedures

Imagine that you are sitting at your desk and you have just received a memo like
this.

Memo

To:  Joe Prototyper

From: High Management

Date: Today

Re; Front-end of our new employee databasa

We have just decided that we need a new fiont-end to our employee database
and have heard the Visual Basic Is just the product to do it with.

Please develop a working prototype for this application and make sure that it
contains these functlons:

1. Display a list of employees and thelr departments.

2. Display the following information about any employee selected from the list
mentioned above:

Employee name (last name, first name, MI}

Employment status - full of part or temporary

Department code

‘Emaii allas

Picture

Payroll deductions

Employment Stock Purchasa Program

401K

United Way

3. Add new employees to the database.

4. When new employees are added, this application should be able to add a
digitized version of a current pholograph of the employee to the employee
information display.

5. Allow administrators to print out delailed data on individual employees.

This application will alse have a legal copyrighl notice.

~2 Q000
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The appicaticn should be very eqsy to use and be consistent with user Interface
guldelines provided by Microsoft.
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G b b St 5L

Now You Do It

Based onthe spemﬁcauon and your currcm understandmg of uscr mlcrface dCSIgn
guidelines, take a first pass a1 designing the interface for the class application.

.. Directions

You should probably work in small groups, but thal is not required.

1. Decide how many forms your application might have.
2. Sketch in the menu items for the application.
3. Locate the controls on the forms.

Let's See What We Did

Now that you have had a chance to work on the user interface design for the class
application, take a look at one possible way of solving the probicm:,

Walk Through — Introduction to the Employee
Database Application
1. Start Employce Database from the Walk Throughs program group.

This is the base form for the application. It contains two list boxes. One displays
employee names and the other displays the employecs departments.

2. Click the File menu 1o show Exit.
3. Click the Help menu o show About,

There are two menus, conlaining one item each. Choosing the Exit command

from the File menu allows the user 10 exit from the application. Choosing the

About command from the Help menu leads to an About box that displays
 copyright information about the application.

4. From the Help menu, choose Aboul.

The About box is a standard clemcent in most commercially available
applications. It normally appears as an item on the Help menu, and itis the legal
statement of copyright ownership.

5. Choose OK.

Close the About box and retum to the Embloycc Database form.
6. Click the Peter Krauss name in the list box.
7. Choose the View button.

Clicking this button lets the user see the employee information for the name
selected in the Employee list box.

‘This view of the Employec Record form will only display the contents of the
database; it will not let the user change that information.

8. Choose the Done bution.
This returns you to the Employce Databasc form,

Let's say that you are the database administrator and you nced to add a new
employce, onc Claude Thibcau.
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9.

10.
i,
12.

13.

15,
16.
17.

18.

Choose the Add button.

Clicking this button takes you to the Employec Record form where you add
employees to the dalabase.

“"Here are the particulars on the new employee’s cmploymenl slalus Add this
- information in the cotrect controis.

Name: Thibeau, Claude P.
Position Type: Full Time
Depantment: . SAL

Email Name: claudet
Deductions: None

The bitmap of his cmployee identification photo has already been added to the
system, so you will need to find it to display it with the data.

Choose the Add Photo button.

With this command, you can locate and display a current photo of the employce.
Sclect CPT.BMP.

This file is located in \PHOTOS.

Choose OK..

This adds the photo to the form.

From the Employce Record form choose Done.

You are prompted to save changes. Choose OK to save changes.

This returns-you to thc Employee Database form.

. Select the employec Maria Lopez and choose the Update button.

This button displays the Employee Record form and allows you to updaic the
information.

Change the last name from "Lopez to “AnotherName”.
Choose Update. ' '

From the Employee Record form choose Done.

This returns you Lo the Employec Databasc form.

From the Employce Databasc form sclect Peter Krauss and choose the Delete
button..

You are prompted if you are sure you want lo delete the employce.

_.Choose OK to accept the delcte.

" The employee is delcted from the list.

19.

Choose the Exit button.

This closes the application. Notice that the user can exit cither from a command
button on the form or from the menu. This approach is consistent with uscr
interface guidelines.
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Introduction fo the Employee Database

"

If you are interested in Lhe Print Preview function, start Visual Basic and open the

_ proje;t\SOLUTION\PREVIEW\EMPLOYEE.MAK.

: <..,.al .. From the Run menu choose Start.

2. From the Employee Database form, choose Peter Krauss.
3. Choose View.

To preview a printout of an individual cmploycc record, the user would...
4, Choose Print Preview.

This displays the employee record details on a form that appears in the center of
your display.

By the way, this Print Preview functionality is an optional lab at the end of the
course.

5. Choose Preview Cancel on the Employee Database form. (Notice that it is not
on the Print Preview form.)

6. On the Employce Record form, choose Done.
This returns you to Employce Database.

You have just laken the user's tour of the appl ical'ion. but you arc all programmers.
What does the application look like from the programmer's perspective?

The easiest way to lock at the Employec Database application from the
programmer's point of view is to look at Appendix A, “Employee Databasc
Application Object List.”

Open your student workbook. Take a detailed look at the forms and controls that

make up the application.
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=

Obijective

You have the main forms for your database front-end. L is now time for you to add
the menus. : '

At the end of this lab you will be able to create menus for single-form and
muliiform applications developed in Visual Basic.

Your outpul from this lab should look something like this.

— Emp]uyeeoatabage R o
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-——Procedures

v B W i

1. From the STUDENT]1 program group, double~click the Menus icon.

- This starts Visual Basic with \STUDENTI\MENUS as your current worKing

- direclory. - :

. From the File menu, choose Open Project.

. Double<lick EMPLOYEE.MAK.

. From the Project window, select EMPDB.FRM.,

Choose the View Form button.
This displays the 1ab version of the Employee Databasc form.

6. From thc Window menu, choose Mcnu Design Window,

7. To create the File menu arid its Exit item, sct their propertics as follows.
Control Caption Name Indentation
File menuitem  &File - mnuFile . 0
Exit item E&xit . - ' mnuFileExit 1

Note Use the right arrow icon in the Menu Design Window 1o st the
indentation to 1. .

8. From the Mcnu Design Window, choose Next.
9. Tocreate the Help menu and its About item, set their properties as follows.
Control Caption Name Indentation
" Helpmenu item  &Help mnuHclp 0
About &About... mnuHelpAbout 1
10. From the Menu Design Window, choose OK. -
11. Test o see that your menus work by clicking cach of them.
12. From the File menu, choose Save Project.

Save the project as EMPLOYEE MAK in \STUDENTI\MENUS.
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Objectives

So far, you have created the base forms and menus for the Employee Database
application. Now it is lime to connect those forms so that they behave a little more
like a Windows-based application.

At the end of this lab, you will be able 10 code an event procedure so that it:

w Makes a form invisible.

» Displays one form and hides another.
s Unloads a form from memory.

m Closes a Visual Basic application.

Al the end of this lab, y'ou will have made the following changes to thesc files.

File Changes . Declarations/Procedures
EMPDB.FRM Display the About form. i mnuHelpAbout_Click
' Close the application. ' - mnuFilcExit_Click

Display the Employce Record form cmdView_Click
and hide the Employee Database form.

ABOUT.FRM Unload the About form. emdQK_Click
EMPREC.FRM Hide the Employee Record fomm and cmdDone_Click
display the Employee DB form.

Before You Begin

Before you start this lab, get out a blank piece of paper. Usc the paper as a mask (o
cover Lhe page below the sicp where you arc immediatcly working.

This lab is designed to be interactive. During it, you are asked questions thal arc
designed to test your understanding of the concepis presented during the lecturc.
: Usually the answer to the question is on the following lines, and the paper will
:=.. cover the answer until you've had a chance to challenge yoursclf.
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——Exercise:~Connecting the Forms of Your Application .~

High-Level Procedures

The following instructions give a high-level view of the stcps required to complete

]]us lab. More detailed instructions follow.

These are the five major phases required for successful completion of this lab:

‘1‘

Add the code that displays the About box form from the Emplbyec Database
form when the user chooses the About command from the Help menu.

Add the code that closes the Employee Databasc application from the Employec
Database form when the user chooses the Exit command from the File meny,

. Add the code that hides the Employec Database form and disptays the Employee

Record form when the user chooses the View command bution on the Employce
Database form.

Add the code ¢ . hides the Employee Record l'orm and displays the Employce
Database form wiien the user chooses the Done command button on the
Employee Record form.

. Add the code that unloads the About box form when the user chooses the OK

command button on the About box form.

In each instance where you necd to add code, there is a comment—remember,
Visual Basic comments start with an aposuophc {)—that begins:
'**x* add herae.... S0 all you have 10 do is choose the Find command from Lhc

+ ;- Code menu 10 scarch for places wherc the string *** appears.

Detailed Procedures |

z To add the code that displays the About box form

1.

From the Studentl program group, double-click the Connecting Forms icon.

This starts Visual Basic with\STUDENTINCONNECT as your current workmg
directory.

2. From the File menu, choose Op;::i Project.
3. Double-click EMPLOYEE.MAK.

Make surc you arc in ﬂw\STUDENTI\CONNECF subdircclory.

4. Swop here! Which form do you need 1o open in order to find the event procedure

that invokes the About box?

ht

. lf yait_ saad the Employee Database form, you were correct.

5. Select the appropriate form name.,

Note We have added 2 Vicw button (0 this form. This is provided because you
will need some kind of mechanism for moving from oxnte form within the
application 1o another. You will also find a Donc button on thec Employce
Record form.

6. From the Project window, choose the View Code button.
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.

7. In the Object list box, scroll to the mnuHelpAbout object. Then in the Procedure
list box, scroll to the Click event procedure.

Now you have come Lo the heart of the matter. You need to insert a statement
- thal names the appropriate Visual Basic method to display the About form.

- What is the syntax for that?

if you said frmAbout Show, you were correct. Or, if you wanted to make the
About box form modal and you said frmAbout.Show 1, you were also correc.

8. Add either of the preceding siatements 10 the event procedure.
9. Keep the Code window open.

"To add the code that closes the Employee Database application

Now you need (0 add the code that closes the application when the uscr chooscs the
Exit command from the File menu,

1. What event procedure do you need to go to next?

f you said mnuf ileFxit Click, you were correci.

2. Use the list box at the top of the EMPDB.FRM code window to localc that cvent

procedure. Sclect the procedure name. _
What statement do you need to use o close the application completely? -

If you said End you were correct.

. 3. Add this statement to the mnuFileExit_Click procedurc.

4.- Keep the Code window open.

To add the code that hides the Employee Database form and displays the
Employee Record form

You should be experienced at this by now.
¢ What event procedure do you need 1o go 10 in order to implement this?

Tip This uses one of the command buttons that we gave you.

If you said, without hesitation, cmdView_Click, then you are indeed
expérienced.

What is the syntax for showing the Employec Record form?

If you said frmEmpRec Show, then you were right.
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-What is the syntax for hiding.lhe.Emplo&eeDatabase.form?.. .

- -
=)

If you said frmEmpDB Hide, then you were right.

Nole As a test of your understanding, the detailed procedures for the next set
of changes have been omitted. You should be able to make the changes to these
forms using the methods oullined above, Complete phases described below.

2. Add the code that hides the Employee Record form and displays the

Employee Database form

- -

Z To add the code that unloads the About form and to set the Startup Form
When you finish, test your application. :

1.

[ 2 R

[= LV T

00 =]

9

From the Run menu, choose Start.

But before you go much further, you should consider this: You have threc forms
out there and only onc of them will be displayed at startup. Which form do you
think that should be? ‘

If you said frmEmpDB, you were correct.
- .

The next question is this; How do you sct the startup form?

From the Options menu of Visual Basic, choosc Project.
This reveals a dialog box coniaining a number of sclections.
Select the Start Up Form oplion,

This places the option in the drop-down list box., :
Using the cursor, select the drop-down arrow on the list box.

Sclcct EmpDB 1o be the startup form.

Choose OK.

Now you can continue testing work.

Choose the View button. This displays the Employee Record form.

Choosc the Done button. This hides Employee Record and displays Employce
Database.

From the Help menu, select About. This displays the About form.

10,_On the About form, choosc OK. This unloads the About form.

11

From the File menu, choose Exit. This unloads the entire application and retums
to the Microsoft Visual Basic screen in design mode.

Z Save your work
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=

Overview

The overall objective of this module is for you to finish creating the uscr interface

for the Employee Database that you arc byilding. This will include completing the
following forms: ‘ :

& The Employee Database form

This is the startup form for the application. It allows the user to select employee
information by department and will bring up the Employee Record form,

» The Employee Record form '_ _
This form allows the user to cnter personnel data about the individual into the

Employce Database. Starting from this form, users will be able 1o locate a
picture file on the employee.

At the end of this lab you will have the forms and controls necessary for the
modified implementation of the application up to the printing lab. In later labs, you
will add any code nceded to make the application work.

Procedures

Some controls and propertics have been provided for you in this lab's project files.
You will have to create additional controls and sct additional propertics as outlined.
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- ——Exercise:~Completing the Employee Database Form

1. From the STUDENT! program group, double-click the Adding Controls icon.

~ This starts Visual Basic with \STUDENTINCONTROLS as your current
-— & working directory.

2. From the File menu, choose Open Project.

3. Double<lick EMPLOYEE.MAK.,

4. From the Project window, select EMPDB.FRM.
5. Choose View Form.

6

. Notice that one list box and its labcl have already been provided for you on Lhe
right side of the form. This list keeps track of information the application needs
but the user does not. You will resize the form before you save it to hide this fist.

When you finish working on this form, it will look like this.

Employee Dotobase

File Help

stReoMum

1N

You will add:

¢ The Employce label and list box
» The Department label and list box
¢ The Add and Exit butions

Note For exact information on position and size for each of these controls, sce
Appendix A, “Employce Databasc Application Objcct List.” If you want, feel
. free to approximale the placement.

7. Add the two labels for the Employce and Department list boxes by double-
clicking the label tool in the Toolbox twice. Posilion them in the upper-left
corner and upper center of the form. Set their propertics as follows.

Control Name Caption Alignment

Lefi list box label . IblEmployec Employee: 0 - Left Justify
Middle list box label biDept Department: 0 - Lefi Justify
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LT

8.

Add the 1wo list boxes for the Employee and the Department list boxes by
doubie-clicking the list box tool in the Toolbox twice. Position the two list boxes

- on the form and set their properties as follows.

- Control Name - FontName FontSize

- Left Lizt box label ISiEmployce FixedSys 9

10.

Middle list box label IstDept FixedSys 9

Note The first character of each of the preceding control names is a lower
case "L". Visual Basic control names must start with a letter, not a number.
Also, be sure to change the FoniName property to FixedSys. If you do not, the
font sizes avatlable to you will not be correct.

. Using the sizing border, resize the [orm by moving the right edge inward so that

IstRecNum is no longer visible.

Add two additional command buttons for manipulating employee information
and canceling the form by double-clicking the command button tool in the
Toolbox twice. Set the properties for these buitons as follows.

Control Caption Name

11.
12.
13.

Add bution &Add... cmdAdd
{below View) :

Exit button (to the E&xit cmdExit

right of Delcte)

This completcs placing controls on the Employee Database {orm.

From the Control menu on the Employee Database form, choose Close.
From the Project window, sclect EMPREC.FRM.

Choose View Form to show the starting version of this form on screen.
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Exer_cisg::C"ompLeting--the Employee Record Form -

“The final version of this form will look lil_(p this.

- T 0 -l

DO 1541 A
Last Name: First Name: Middle lnitial:
|
| N — -
[ Position Type | Department:™ - Email Name:
S T 1+
O Temporsary e [:l
' Photo:
O] Esep
1 O s01k
‘ [ united Way L———lnme J

You willadd: -

» The Deductions frame and check boxes
= The Deparument label and text box

s The Email Name label and text box |
s The Photo label and piclurcbox - -, .. g
» The Add Photo and Cancel buttons

".I‘

Note The IbiListNum conurol provided in the center of the form is a hidden
control that is used for record-keeping purposes. It will not appear on the form at
run time, and codc for using it will be supplied in a later lab.

1. Add an additional frame control for the Deductions group by double-clicking the
frame lool in the Toolbox. Position it on the left side of the form under the
Position Type [rame.

Waming In order for frames to retain the controls you sct on them, you must
first place the frame and then draw the controls on (not double-click) them.

2:.Set the propertics of the Deductions frame as follows.
Control Caption Name

Deductions frame Deductions fraDeductions
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tp

. Double<click the check box tool and draw the check box inside the frame

Repeat these steps for each of the three check boxes.

Control Caption . Name
" ESPP check box " ESPP chkESPP
-+ 401K theck box 401K chk401K
United Way check box United Way chkUWay

. Add the two labels that are used for the Department and Email Name controls

by double-clicking the label tool twice. Position these two labels in the middle of
the formn and to the right of the form, rcspecu\rely Sel the propertics for the
labels as follows.

Control Caption . Name
Department label Department: 151DeptName
Email Name labei Email Name: IblEmailName

. Add the two text boxes that are used for the Department and Email Name

controls by double<clicking the text box tool in the Toolbox twice. Position thecm
below the two labels, and then sct the propertics of the text boxes as follows.

_Control Text ' Name
Department text box (biank) leDépLNamc
Email Name text box (blank) ixtEmailName

. Add the label over the Photo box by double-clicking the label tool in the

Toolbox. Position this labct below IbiListNUm. Set the propertics for the label
as [ollows.

Control Caption Name

Photo label Photo: IblPhoto

. Add the picture box by double clicking the picture tool in the Toolbox. Position

it in the lower center of the form. Sct the propertics for the piciure as follows.

Control Name

Picture box picEmployce

. Finally, add two additional command buttons o the right side of the form by

double-clicking the command button tool in the Toolbox twice. Position the
command buttons, and then set their propertics as follows.

Control Caption Name °

'!:_\dd Photo butlon Add &Photo cmdAddPhoto
(below Add)

Cancel buiton &Cancel cmdCancel
(above Done)

You are now finished building the two major forms in this application. You will
be building two additional smaller forms in later modulcs.
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.9: From the Control menu on the Employec Record form, choose Close.

Now save all of your'formS‘and'lhé'projccl.

10. From the File menu, choose Save Project. You should already be in
" \STUDENTINCONTROLS.

T, Save the project as EMPLOYEE.MAK.



Lab 6; Using Constants and Variables

N e -

Objectives
At the end of this lab you will be able to:

= Define global conslants in a .BAS module

s Define global variables in a.BAS module

= Declare form-level variables in a .FRM file

At the end of this lab, you will have made the following changes to these [iles.

File Changes Declarations/Procedures

EMPLOYEE.BAS Global conslant declarations
Global variabie declarations

EMPDB.FRM Local variable declaration Form_Load
Local variable dcclaralions cmdView_Click

EMPREC.FRM Form-level variable declarations General Declarations

Before You Begin

- Notice that we have provided a final form of the browser for this and following
labs.
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- —_—*ExerCISQ:Adding-_Qaia Declarationsto Your - - - --

Appllca’ﬂon

- ngh Level Procedures
~ The following instructions give a high-level view of the steps required to complete
this lab. More detailed instrucuons follow. '

There are five major phases required for successful completion of this lab. For
specific details on constant and variable names and their initial valucs, sec the
appropriate tables in the Detailed Procedures section that follows.

Copy already-coded variables and constants into the appropriate filc.

Add the appropriate gtobal constant declarations to a module.

Add the appropriate global variable declarations to a module.

Lol o .

Add one form-level intcger variable and one string variable (called Position and
Deductions, respectively). Use the position variable to hold information about an
employee's position type (Full Time, Temporary, or Part Time). Use the
Deductions siring as a (hrcc-characlcr string o siore information about an
employee's deductions.

5. Add a declaration for a local integer variable (called RecordNumbcr) that will

" be used 1o track the location in an array for a specific employee's data, and add a
declaration for a local integer variable (called ListEntry) to be used 1o keep
track of the ListInidex number for a specific cmployce in the listson the
Employee Database form.

Detailed Prog:eduresﬁ

z 'f‘o copy already coded variables and constants into the appropriaie file

1. From the STUDENT1 program group, doublc-click the Constants and Variables
icon.

This starts Visual Basic with\STUDENTINDATA as the current working
directory.

2. From the File menu, choosc Open Project.
3. Double-click EMPLOYEE.MAK.
Make sure you are in the \STUDENTI\DATA subdircctory.
4. Inthe PrOJcct window for EMPLCYEE.MAK, click EMPLOYEE BAS.
5, Select View Code.

An empty Code window with the caption EMPLOYEE.BAS will appear in the
center of your screen.

6. From the File menu, choose Load Tcxt
7. Locate and merge EMPLOYEE.TXT.

Note Usc the Mcrge command button here to add code at the bottom of the
file, not the Replace command button.
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2. Toadd the appropriate global constant declarations to the .BAS module

o

Having found and loaded the .BAS module, you arc now ready to begin adding a
number of constant declarations to this file.

* Remember, in each instance where you need to add code, therc is a comment hat
‘begins: ' **+ Add here.... Soall you have to do is choosc Find from the Code

menu to search for places where the siring * ** appears.

* - Add each of the following constants along with their initial values 1o
EMPLOYEE.BAS. '

Constant . Value

UNCHECKED 0
CHECKED
OK_AND_CANCEL
OKAY

CANCEL

[ S

Note Did you rcmember that you nced 1o specify to Visual Basic what kind of
constants these are?

To add the appropria}e global variable declarations to the .BAS module

_Having added the global constants to EMPLOYEE.BAS, you arc now ready to add

a couple of variable declarations to the same file.

Remember here, too, that you need to specify to your application what kind of
variables these are.

Scroll to just below the user-defined data typc EmpRec at the bottom of
EMPLOYEE.BAS. This portion of the file decals with a number of variablcs that the
application needs in order to manage the list of cmployees and their data.

Variable name Data type (_Iqmrﬁent

PositionType String Variable-length siring
NextLocation Integer Steres next unused location in the array
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L Z To add one form-level integer vanable and one. ﬁxed Iength strmg vanable to

the employee record-form o

So far in this lab you have worked with global-level declarations. Now you are
gomg to do some form-level declarations.

9.1 you haven't saved and closed EMPLOYEE.BAS, do s0 now.
2. Select EMPREC.FRM in the EMPLOYEE.MAK Project window.
3. Select View Code. K
4. In the Object list box, sclect General. In the Prdcodures list box, select
Declarations. N
At this point, you are going to be declaring the following.
Item . Data type Comment
Position - Integer ‘
Deductions String Length represenicd by the conslant

MAXDEDUCTIONS

E To add declarations for two local integer variables to the Employee Database
form

So far, you have been working with global- and form-level declarations, but as the
presentation on scoping indicated, you can also declare variables locally. For this
phase and the next one, you will need to be in the code for the Employce Database
form— EMPDB.FRM.

If you haven't already saved and closed EMPREC.FRM, do so now.

Select EMPDB,FRM in EMPLOYEE.MAK,

* Select View Code.

The EMPDB.FRM code window should appear in the middle of your screen.
In the Object List box, click the down arrow.

Select the procedure for the View command buiton.

e B ol e

At the top of this event procedure, you nced to declare a couple of list-
management variables for later use. More will be said about that in a later lab.
For the lime being, declarc these two variables and make surc that you indicate
their type.

Name ' Data type

RecordNumber Integer
Llsl.Ermy B Integer

T,

8. From lhe Flle menu, choose Save Project.
Save the project as EMPLOYEE.MAK in\STUDENTI\DATA.

i 4t
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Objectives
Al the end of this lab you will be able to:
» Define general procedures in a module file (a .BAS file).

At the end of this lab, you will have made the following changes to this file.

File Changes ' Declarations/Procedures

CLEARREC.BAS  General procedure definitions ClearEmpRec
ClcarDeductions

Exercise: Adding Code to Your Application
High-Level Procedures

The following instructions give a high-leve!l view of the steps required to complete
this lab. More detailed instructions follow.

There are two major phascs required for successful completion of this lab.

1.- Add the appropriatc statements to assign values to control propertics 1o a general
procedure in a .BAS module that clears all of the controls in the Employ:
Record Form. . . o

2. Crealte a general procedure in a .BAS module to clear all the deduction check
boxes on the Employee Record form, ’

Remember, in each instance where you need to add code, there is a comment
that begins: '*** Add here.... Soall you have to do is choose the Find
command rom the Code menu to scarch for places wherc the string * **

appears.
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_Detailed Procedures

2 To add the appropriate statements to assign values to control propertlﬁ ina

general procedure

.

-

F:aom the STUDENT] program group, double-click the Writing Code icon.

This starts Visual Basic with\STUDENTINCODE as your current working
directory.

From the File menu, choosc Open Project.

. Double<lick EMPLOYEE MAK,

Make sure you are in the \STUDENT INCODE subdirectory.

4, In the Project window for EMPLOYEE.MAK, click CLEARREC.BAS.

Select View Code.

6. You will be in the Ueneral Declarations section. Select ClearEmpRec from the

Z Create a general procedure in a .BAS module
1

procedures list.

You will add code to flesh out some of the details in a general procedure that
clears all of the controls in thc Employee Record form when the uscr chooscs
either the Add butlon or the Cancel button on that form,

In essence, what this procedure does is t0 set all of the properties for all of those
controls to either blank or default seltings. The three controls that you are
interested in (with the properties of interest) are listed below:

e Department text box —Text property

¢ Full Time Position Type check box— Value property
.« Employce Photo picture box-——Pflclu'rc property - -

.' There are details in the comments marked with * % * regarding the valucs o
" assign to the propertics.

If you look carcfully at the ClearEmpRec genceral procedure, toward the bottom
of it there is a call to another procedure called ClearDeductions. We have
provided the skeleton of thal procedure and left it to you to fill it in. You
remember what the deductions were, don't you?

. From the General Declarations section, select ClearDeductions (rom the

Procedures list in the Code window,

3. Following is a list of the deductions and the propertics that need to be changed.
Control property Value to assign

..._ESPP Value property UNCHECKED
401K Value property UNCHECKED
United Way Value property UNCHECKED

. From the File menu, choose Save Project.

Save the project as EMPLOYEE.MAK in\STUDENTINCODE.
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Objectives

The overall objective for this lab is for you to become comfortable with Visual
Basic implementations for writing code to control the flow of your program by

using If...Then...Else and Select Case statcments,

You will also lcam how to use loops to manipulate items in a list. In this lab you
will add code to several different procedures that necd to test certain conditions 10
decide which action to take depending on user actions or variable values,

Al the end of this lab, you will be able to:

‘e Code a For loop to go through an array of user-defined type variablcs, take
" elements from the current user-defined type variable, and place them into

different lists, using the AddItem method.

s Use the ListIndex property of a list 1o make a given item in the list the default

user sclection.
s Code If...Then...Else statcmenis,

s Code Select Case statements that test conditions depending on user interaction,
control propertics, or variable values and based on those conditions alter the

flow of the program appropriately.

At the end of this lab, you will have made the following changes to the following

{iles:

Form . Procedure Code {0 add
EMPDBFRM Form_Load For Loop

EMPDB.FRM Form_Load Sct delault list sclection
EMPDB.FRM Sub FillFields If...Then...Else statcment
EMPDB.FRM Sub FillFieids Case Statemcent

EMPREC.FRM cmdAddPrintUpdate_Click

Case Swatement
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" Exe

ercise:Using-Conditional logicand Loops — -

The following instructions give a high-level view of the sieps required to complete
Lrus Iab More detailed instructions follow. '

H:gh -Level Procedure’s

There are five major phases required for successful completion of this lab:

1. Coding a For loop to add items to a list

2. Modifying the ListIndex propeny (o sct a default list sclection
3. Coding an If...Then...Else statement

4. Filling a Select Case statement skeleton

5

. Coding a Select Case statement skelcton

Detailed Procedures

1. From the STUDENT! Program group, double-click the Condmonal Logic and
Loops icon,

This starts Visual Basic with \STUDENT INLOGIC as the current woricing
directory.

2. From the File menu, choose Open Project.
3. Double-click EMPLOYEE.MAK.
_ Make sure you are in the \STUDENT\LOGIC subdirectory.
4. In the Project window, click EMPDB.FRM.
5. Choose the View Code command. - -

To code a For loop ]
Since the code in the For loop is what causes the employee data for the application

10 be loaded into the lists on EMPDB.FRM, you will code the For loop before the.

If...Then...Else and Select Case statcments.
For this part of the lab, you will be coding a For loop to do the following:

s Get the last name, first name, and middle initial for an cmployee from the
EmpData array and place it in the Employce list on the Employec Database
~ form.
u Get that employee's depariment from the same array and place thm in the
_ Depanmem list on the Employee Database form.

. " Get the record number from the array and place that data‘in the hidden list
“(IstRécNum) on the Employec Database form.

In order 1o do this:
1. Locate the event procedure Form_Load.

2. To decide how many times the For loop must be executed, cheek the general
procedure LoadEmpDetails to sce how many cmployces are originally loaded
into the array EmpData and what subscript range they use.

Whal is thal range?

If you said 0 to 2, you were correct.
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!!bl

8.

Return io the Form_Load procedure to code the opening statement for the For
loop with the appropriate range.

. Within the Form_Load procedure, find the commented section that starts:

'*** Add here a For loop ....

: Sét')?our For loop counter (already declared in the Form_Load procedure as I to

use the range you found in LoadEmpDctails.

The first statement 10 be included inside the For loop has been included in the
comments s0 you can see an example of the syntax required to access separate
clements of uscr-defined types in an array.

You will need 10 add the nexi Lwo statements, one 10 add an employec's
department information to the list IstDept on frmEmpDB and another to add the
cmployee's record humber information to Lhe list IstRecNum on frmEmpDB.

Don't forget to close the For loop.

Z To make a given item in a list the default user selection

Set the default setection to the top item in the list IstEmpioyec by scting the
Lisundex property of this list to the appropriate valuc.

Tip The appropriate value is in the comments in the lab code.

Z To code an If...Then...Else statement

1.
2.
3

You should still be in EMPDB FRM,
Go to the general procedure FillFiclds.
Find a section of comments that starts: _

*#%* pAdd here an If Then Else statement...

Add an If ... Then ... Else statement that will do the following:

if PicturcFile isn't an empty string, -
load into the picture box on the
Employee Record form the filename
contained in the PictureFile
element of the current employec's record;

otherwise,

- clear the picture box on the Employece

Record form of any picturc left
there from a previous employee record.

AFor more detailed information, check the comments in the code.
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Z .Tofill a Select Case statement skelelon . e

1. Stay in the general procedure FillFields in EMPDB.FRM for i the next part ol' the
lab.

"In this procedure you will find a partially complete Select Case statemcnt that
=7 tests the value of the variable thal stores the.information regarding an
employee's position type, using predefined constants for the cases. The cade for
the case for a Full Time cmployee is complete. It seis the appropriate property
values for the Position Type option butlons and assigns a value to the suing
variable PositionType. 4 ‘

2. Add cases for Temporary and Part Time positions and all the code that will set
the values for the appropriate option buttons and PositionType correctly in cach
case.

Z To code a Select Case statement skeleton '_

1. Go 1o the event procedure cmdAddPrmlUpdatc Click in the form
EMPREC.FRM.

. 2. Add a"skelcton” Select Case statement 10 test the value of the caption on the
, - .- cmdAddPrintUpdate command bution, for the captions:
! ’ "&Add“ N ; v
"&Upda[ﬂ"
"&Print"

Check the comments in the code for the exact syntax you will need 1o use after
7 the words "Select Case.”

For the time being, alter cach case, insert a MsgBox statcment to report which
| case was selected. In later labs, code for two of the threc buttons will be added
1 to implement them more fully. In the extended solution, found in
%\SOLUI‘ION\EXTENDED, the Update bution is also implemented.

3

. From the File menu, choose Save Project.
Save the project as EMPLOYEE.MAK IN\STUDENTINLOGIC.
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Objectives

3 x

The overall objective for this lab is for you to become comlortable with writing
code to create a report on an output form containing formatted text and, optionalty,
picture boxes with graphics and 1o send that form to the default printer under

Windows.

AL end of this lab, you will be able to:

m  Use the form properiies CurrentX and Current, various Font propertics, the
Cls and Print methods and the Spe, Tab, and string manipulation {unctions,
such as RTrim$ and Mid$ to create formatted oulput on a form.

s Use the picturc box property Image to copy a graphic from one picture box to
another. :

a Use PrintForn method 10 send this form to the default printer under Windows.

At the end of this lab, you will have made the following changes to this file.

Form ‘ Procedure - Code to add

EMPREC.FRM cmdAddPrintUpdate The Print and PrintForm
methods change some
properiics

Exercise: Gefting Output

High-Level Procedures

The following instructions give a high-level view of the sieps required 10 complete
this lab. More detailed instructions follow.

There are two major phases required for successful completion of this lab:

= 1. Displaying formatted output to frmQutput.

2. Sending frmOutput lo the default printer.
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Before YouBegin" ™ ... . .. .

Before you begin, make sure that you have used the control panel to set your defauit

printer to go to a file 50 you will be able to test your work when you are done.

_11 Double-click the Control Panel icon in the Main program group.
2.
3

Double-click the Printers icon in the Control Panel program group.

. Select the PostScript printer in the list of Installed Printers, and then press the
Connect button, '

Scroll down the Ports list in the Connect dialog box, until you find FILE. Click
FILE and choose OK.

Choose the Sct As The Default Printer button.
. Then choose the Close button in the Printérs dialog box.

Note You have been provided with the form that you nced to complete this tab —
OUTPUT.FRM. It is the form (0 which you will be printing employec records.

Detailed Procedures — Printing to Forms and
Printers

Z To display formatted output to frmQutput

. From the STUDENT!1 program group, double-click the Printing icon. -

- This sians Visual Basic with \STUDENTI\PRINTING as the currcnt working

=R

directory.

From the File menu, choose Open Project.

Double-click EMPLOYEE.MAK. |

In the Project window, click the EMPREC.FRM. 1
Select the View Code option.

Locate the cmdAddPrintUpdate_Click event procedure.

Before you start coding the application, you should probably review what the
oulput is supposed to look like.

Employee Record Details

Employee: Richardson, Barbara, J.
Email: barbarar Dept: SAL

Cétegory : Full time

Deduct:  ESPP 401(k)  United Way |

——
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11.
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Lab 9: Getting Qutput a3

‘In the Case Print section of the Select Case statement that you created in a
previous lab, add a scrics of Print statements that output individuai records to a
form called frmQuipuL. Do the following:

. Immediately under the line Case &Print, add a statement to clear ali previous

_output from the form frmGutput.

: ‘Néil, tell the procedure which record 1o get for printing.

Each control has a Tag property where you can store string data for any purpose
that you like. The class application uses it to keep track of the position of the
employee's personnel informalion in the array EmpData.

To tell the procedure which record Lo get, you will need to complele two steps:

a. Convert the Tag property for txtiastName from a siring to a number, using
the Val function.

b. Then you need to assign that converted value to the integer variable
RecordNumber.

Below the line that assigns a value to Recodeumbcr. add statements 10 sct the
CurrentX and CurrentY propertics of form frmQutput to 0. This places the
cursor in the upper-left comer of the form.

Next add statements to set the following values:

FontNamc to "Couricr"
FontSize 10 14
FontBold io TRUE

Use the Print method to print the following siring to the second print zone:

" "Employee Record Deltails” followed by a blank line. Remember that you usc a

comma (0 move o a print Zong,

If you look carefully at the form, you will notice that the size of the font has
been changed and the bolding has been tumed off for the record output
information.

Now add statcments to set the following values:

FonlSize to 12
FontBold 1o FALSJE

Then print out employee details listed in the cominented area of the lab code,
using the spacing indicated.

Next, load a copy of the graphic in picEmployee on form [rmEmpRec into the
picture box of the same name on the form frmQutput.

z To send frmQutput to the default printer

" o Finally, send the form Output to the default Windows printer using the

‘PrintForm method.
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-_Exereisea—Adding_Erint~Preview—CapabiIity---(Optioan)-

Your objective for this lab is to add a print previcew capability to the application.

At the end of this lab, you will have made the following changes to thesc files.

Form Procedure _ Code To Add

EMPDB.FRM cndView Change caption on cmdAddPhoto.

EMPREC.FRM cmdAddPrintUpdate Convert code Lthat prints 1o [rmOutput
*  toa general procedure.

EMPREC FRM cmdAddPhoto % Add Print preview and Preview cancel

functions.

As usual, check the code undcf \STUDENTINPREVIEW for stalements that start
t+#* Add hera... tofind the places to add the print preview code.

High-Level Procedures

You can use a strategy thal you have already seen. Remember the 10p button on the
Employec Record form? Its functionality and caption change depending on the use
of the form— View, Add, or Update,

You can use that sarne strategy for addjng new functionalities to the Add Photo
buuon

Detalled Procedures — Add a Print Preview ’
Capability

Z Displaying the formatted output on frmOutput -

At a more detailed level, your task during this optional lab is to implement the
following functionalities:

» Adding a sccond capability 1o the Add Photo button (when the user has chosen |
View on the Employce Database form) called Print Preview.

« Adding a third capability to the Add Photo button (when the user has chosen
Print Preview on the Employee Record form) called Preview Cancel.

Here are a few hints on how 10 implement print previcw on the existing form:

1. First you should add code to the cmdView click event to change the caption of
the Add Photo button on the Employcc Record form to Print Preview.,

2,- Next you should convert the code that prints to frmOutput under the Case Print
.._part of the cmdAddPrintUpdate click event code to a general procedurc. This
wnll let you cail it both from the Print bution and from the Print Preview button.

Todo this, move all of the code that you wrole for the Case Print in
cmdAddPrintUpdate_Click (except for the last line that scnds the output to the
printer) into a new general procedure named PrintOutput.
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L

3.

Now place a call to l.ﬁis general procedure inside the Sub
cmdAddPrintUpdate_Click to replace the code that you cut from the Select
Case statement.

Note You will necd to add the code to change the caption on the button to read

** ““Pririt Preview". (In your codc you will nced an ampersand in front of the “v" so

4,

that it can be accessed through the keyboard.)

When the uscr chooscs the View buiton on the Employce Databasc form, add the

. code to change the caption on the Add Photo button to make it a Print Preview

bulton.

In the Click event for your enhanced Add Photo button, you will now nced to
add a Select Case statement to handlc three possibilities for the value of the
Add Photo button's caption: ‘

¢ Add &Photo, which will contain the original code for this button; appropriate
when the user clicks the Add or Update button on the Employce Databasc
form. :

*  Print Pre&view, which will contain code to call the new general procedurc
PrintOutput, make ftmOutpal visible to the user and, lasuly, change the
caption on the button to "Preview Ca&ncel” to give user access o the third
capability of this button.

e Preview Ca&ncel, which will contain code to make frmQuiput invisibic and
which will toggle the caption on the Add Photo button back to "Print
Pre&view."
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Target Audience

= Applications Developers, Profotypers, and Analysts
who Want to Know More About:

s The Essential Functions of the Visual Basic Product
= The Conventions of a Graphical User Interface
» The Essentials of the Basic Language
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Using Visual Basic

-+ Lab: Creating an About Box

Designing and Building Applications

Lab: Employee Database Application Specification
Working with Forms

Laying Out Menus

Lab: Creating Application Menus

Connecting Fo_rmsl

Lab: Loading and Unloading qums
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Course Outline
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= ‘Using Controls
" Lab: Adding Controls to Forms
s File Browsers and Other Controls
= Using Visual Basic Data Types
Lab: Using Constants and Variables
= Writing Visual Basic Code
Lab: Writing Procedures
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+u-Using Conditional Logic and Loops
Lab: Conditional Logic-and Loops
= Debugging Code in Visual Basic
» Printing to Forms and Printers
Lab: Getiing Output
= Using the Data Control
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*a“Nameé Card
= Student Workbook
= Lab Manual
s Evaluation Form
= Reference Materials
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Microsoft University Curricula .

. Programming In Microsoft Visual Basic™

Microsofte MS-DOSs Operating System

Microsoft Windows™

Microsoft C and C++ Programming

Microsoft Excel Programming

Microsoft LAN Manager

Microsoft Mail

Microsoft SQL Server

Management Education for Client-Server Computing
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= Typographic and Naming Rules
= Program Groups and Lab Code Conventions

Sample Code
All code examples are written using monospaced Courier font, for example:
Sub Picturel Click ()

Picturel .Move Picturel.Lleft+750, Picturel.Top-550
Ernd S5Sub

Visual Basic Terms
Microsoft Visual Basic programming terms are set in italic the first time they occur,
for example:

Event procedures can be associated with a control or a form. They will be executed
when a-user or the system riggers the associated event.

Visual Basic Keywords
Words in bold are keywords used to write Visual Basic code, for example:

Event procedures are always Sub procedures. When you define an event
procedure, Visual Basic automatically codes the Sub and End Sub statements
into the procedure.

You can reference Visual Basic terms and keywords through the online Help or the
Visual Basic documentation.

For More Help

Each module contains pointers to the documents and specific chapters within the
document that support the topics presented in the module. For additional
information on using the Windows online Help facility, see Chapter 2 of the
Microsoft Windows User’'s Guide.
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Naming Convention for Controls

Visual Basic keeps track of all controls used in an application and lists them
-alphabetically. You will want to take advantage of this by adding prefixes to all the
- controls in your application. The following  “ventions have been used in the lab
= code. Iris récommended that you adopt the . ..owing naming conventions in your
own applicauons. '

Control type Name prefix
Check box chk
Combo box ¢ho
Command button cmd
Direciory list box dir
Drive list box drv
File list box fil
Form . frm
Frame fra
Grid grd
Horizontal scroll bar hsb
Image img
Label . bt
Line . ‘ lin
List box Ist
Menu mny
OLE client ole
Option button opt
Picnre box pic
Shape shp
Text box Tt
Timer iyerg
Venical scroll bar ‘ vsb

Note You will need to establish your own namies for the additional controls
available in the Professional Edition of Visual Basic,

Program Groups

.-You will be working directly with three Program Groups during this course. The
Walk Throughs program group is located on the left side of the Program Manager
and contains the finished code for each of the sample applications used in the
student manual. Studentl, located on the right side of Program Manager, is the
starting point for each of the labs in the course. Finally, the Solutions group, which
is iconized at startup, contains a finished version of each of the labs in the course.
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— First-and foremost. each of the-tabs-is-self-contained,-This-means. that-success-in—

_Lab Conventions

th

later labs is not dependent upon having completed earlier labs. Secondly, locations

.. for fixes in code are marked by three stars, (* * *). To locate them, open the

_appropriate item in the Student! program group, and select the View Code option in

“"the Project window. When the Code window opens, choose the Find command from

the View menu, enter "***"_ select the "All Modules” option, and then press ENTER.
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S OVeIViE W T e

- -

“'u’ Visual Basic Tools
= Building.a Simple Visual Basic Applicoﬁon
» Visual Basic Menu Commands

Overview
The purpose of this module is to introduce you to the key elements of Visual Basic.
This is not intended to be an exhaustive review of all functions and tools; rather, it

is designed 10 get you up and running on the product. Later modules will flesh out
all of the details that you need to know to become Visual Basic programmers.

The best way to learn about Visual Basic is to review the individual functions in
each major portion of the Visual Basic interface and then walk through the steps
you should follow to develop an application.

The module is divided into three major sections. The first major section is a lecture
about the elements of the Visual Basic application that you use in the creation of
applications. The second is a demonstration where the trainer walks you through the
application design process and you end up with a compiled executable file. The
final section is a lab that gives you hands-on practice using some of the tools that
you have just been introduced to.

Prerequisites
There are two key skills that you need for success in this modple:

»- Practice in using a mouse
s - Uniderstanding of graphically based applications

Overall Objective

At the end of this module, you will have successfully created your first Visual Basic
application.
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Learning Objectives -
At the end of this module, you will be able to;

" Design an application user interface using the Form window, Toolbox, toolbar,
- .and Propertv window.

Name and save the application’s forms and project files,

- Start and stop an application from the Visual Basic menu and/or the toolbar,

Create an executable file and add it to a Windows group.
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Y VisualBasic Tools- — - .. ..

-~ *' .= .Form and Prd]ect Windows
= The Toolbox and Properties Window
s The Toolbar and Code Window
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Form and Project Windows

Aun [ebug Qpﬂ ‘Windew Help

T - BB R

What Is a Form?

Forms are the heart of a graphically based application. They are what the user sees
and interacts with in order to accomplish some task. They are also the place where
you begin 10 build applications; on them you place controls —command buttons, list
boxes, option buttons— that present the user with the choices that they have.

What Is the Project Window?

The Project window is a list that Visual Basic uses to keep track of the forms that
you are uyng for your application. You will have as many .FRM files listed in the
Project window as you have forms in your application. In addition you may have
other files— .BAS and’. VBX files— but we will hold off talking about those for a
little while.
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The Toolbox and Properties Window ~ - - - —-
Pointer Picture Box
w Label Text Box
Frame Command Button
Check Box Option Button
Combo Box List Box
Horizontal Scroll Bar Vertical Scroll Bar
Timer Orive List Box
Directory List Box File List Box
Shape Line
Image Data Control

Custom Controls (*.VBX)

What's in the Toolbox?

As the name suggests, the Toolbox is where you go to get the basic elements of
every Windows-based application you create in Visual Basic.

There are two ways that you can place controts on a form, either by double-claclung
the control ool in the Toolbox or by clicking and dragging the control. For the most
part, either method has the same result. When you double-click a tool, the control
shows up in the middle of the form; so you then have to drag the conuroi to the
correct position on the form.

Each control that you place on a form has a set of properties that you can use in
order to get the right "look and feel” for your application. For the time being, all you
need to know is that there are properties to each control. In later modules you will
get a much closer ook at Lhe most commonly used propetties for most of the tools in
the Toolbox.

Custom Controls

You can add controls to the Toolbox. Some third pames have created custom
controls that you can purchase separately, The Profess:onal edition of Visual Basic
contains various custom controls.

Ti)_ Ad__d a Custom Control
1. From the File menu, choose Add File.

2. Select the appropriate file. Custom Control files have a .VBX extension.
3. Choose OK.
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What Are PiOpenies and How Are They Set?

Properties for a control are set using the Properties window:

Z To set properties
1. Click the control whose properties you want set.

2. Scroll the Properties list on the Properties window until you find the property
you want to set and select it.

3. Place the value for the property in the Settings combo box,
4. Click the check box to the left of the Setings combo box.

What Is the Toolbar?

The toolbar provides quick access to . mon commands or functions. These
functions—like saving projects and starting the application during the design phase
—are also available from the Visual Basic menus as well as through access and
shortcut keys. ‘

m Mirras nm finual Flasic [designj

y Flle Edit !Iew Bun Debug gplionl ﬂindw Help i

Nine of the relevant items on the toolbar are.

““Toolbar - Menu path Shortcut keys

New Form From the File menu, nfa
choose New Form.
New Module From the File menu, nfa
choose New Module.
Open Project From the File menu, nfa
_ choose Open Project.
Save Project From the File menu, nfa

choose Save Project.

N
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L

_ Toolbar ~ _ Menu Path Shortcut Keys
Menu Design window From the Window menu, ~ CTRL + M
choose Menu Design.
" Proper..:s window From the Window menu, F4
Sl : choose Properties.
Start From the Run menu, F$
choose Run.
Break From the Run menu, CTRL + BREAK
choose Break,
End From the Run menu, nfa
choose End.

Note The rest of the functions deal with debugging and will be covered during
that module.

Position and Size Coordinates

Visual Basic displays the coordinates for the upper-left comer for each control on
the form relative to the inside upper-left comer of the form. It also displays the
width and height of the conrol. You can set these values by placing the form or
control approximately where you want it, or you can specify Left and Top
coordinates from the Properties list. The unit of measurement is in twips (there are
1,440 twips in an inch). You will find out later that you can change this unit of
measurement 10 something you are more familiar with.

What Is a Code Window? .

Code windows display the code that implements your application. At first Code
windows only contain the template for procedures and functions; you will add more
code - them as you develop your application. There are several ways 1o open a
Code window. The easiest way is 10 double-click the object whose code you want to
view, For example, to locate the Click event template for a command button,
double-click the command bulton on the form during design time.

%

Form1.frm

Sub Commandl Click ()
| _ . L
End Sub
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Building a Simple Visual Basic Application

- T

Hello, World!

Walk Through — Building a Visual Basic
Application

2. To start WORLD
1. From the Walk Throughs program group, start WORLD.

The purpose of this little application is to give you a chance 1o walk through
most of the major steps needed for developing a Visual Basic application.

How does the application work?

It has one text box and two command buttons.
2. Choose the Fill button.

When the user clicks the button, text is revealed in the text box.
3, Choose the Clear button. _

When the user clicks this button, the text in the text box is cleared.
4. Quit the WORLD application.

From the Control menu, choose Close.
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_z To start Visual Basic _

1. Double<lick the Visual Basic icon.

Visual Basic will start with a blank form on the screen.

2. Resize the fonn to: , . ’
Height 2700
Width 4065

z To;’('iosign ihe base form

The first step in designing the user interface is to set the properties for the
application’s base form. In this case, set the properties for the Hello, World!
form. '

1. In the Properties window Propertiés list, setect BackColor.
2. Click the ellipsis {...) at the end of the text box.
3. Select a shade of green.

The background of the form wums green. Selecting any color will automaucally
hide the color paletie.

4. Inthe Properties list box, select Caption.
5. Inthe text box, type Hello, World!
The Form title bar will contdin Hello, World!
6. In the Properties window Properties list, select Name.
7. Inthe text box, type frmWorld - '

z To add controls and set properties
- To créate the form's controls, double-click the appropriate butions in the Toolbox.
1. Double-click the command button tool in the Toolbox.
2. Set the following properties:

Caption Fill
Name cmdpFill _ *
FontSize 18

3. Move the Fill button to the upper-right comer of the form.
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I
1
T

Double-click the command button tool in the Toolbox.

5. Setthe following properties:

.. Caption Clear
© Name . cmdClear
FontSize 18

6. Move the Clear button to the lower-right comer of the form.

7. Double-click the text box tool in the Toolbox.

Set the following properties:
Name ixtBox1
Text Delete any text in the text box for this propermy.

Z To add the Basic code to enable the controls

In this step, code will be added to activate the functionality of the controls in the
form. The code will enable the text box to be filled with the words Hello World!
when the user clicks the Fill button and enabie the text box to be cleared when the
user clicks the Clear button.

1.

Doubie-click the Fill bution that you just created 10 open the Code window.

When you double-click this command button, Visual Basic brings you directly 10
the template for a procedure that responds to a Click evgnt for this cont~1. The
names of event procedures follow the pattern:

Sub objectname_evantname ()

[n this case the procedure is named:

Sub_ cmdFill Cliek ()

Also note that Visual Basic provides the statement that ends the subroutine:

" End Sub

In the graphic below, notice that the bbject name shows up in the Object list box
on the left, and the event name shows up in the Procedure list box on the right.

; frmWorld.frm

Object: [cmaFil W Poc Ok I

Sub emdFill Click ()
| _
End Sub
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__ 2. Add the following code: _

txtBox1.Text = "Hello, World!"

Add a line of code between the two lines of the template for the Click event
-procedure. This <ode gives the application the target for the action (filling the

" text box) and the contents that you want assigned to the text box. In this case,
"Hello, World!" is the contents.

3. In the Object list box, select cmdClear.
4. Add the following text:

txtBoxl.Taxt = ""

Inside the template for this Click event procedure, add a line of code (o give the
. application the target for, the-action (clearing the t6Xt box) and the contents that

you want ass: ned to the text box..In.thig ¢asé the contents is an empty

siring (""). s s PRI AT

g e g
N o

4

z To save your work

Before you create an executable version of this Visual Basic applicaton that you
can run directly in Windows, you should save the source code to disk. You wiil do
this through two actions—saving the form and saving the project.

1._From the File menu, choose Save File As.

alr

Save File As
File Nama:
[ FRM |
c\walkthru\samples
Directories:

(]

(-a]

fel

(]

(z]

L)

Make the current directory CAWALKTHRUNSAMPLES.
Save the file as WORLD.FRM.
Choose OK.
_ From the File menu, choose Save Project As.
S.f_i_ve the file as WORLD.MAK.
Choose OK.

N o R W
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Z To make an executable file

To create an executable file, make sure the source code for the project is open in
_Visual Basic. : :

- .g,_’:I-

“os W e

'From the File menu, choose Make EXE File.

Make the current directory CAWALKTHRINSAMPLES.
Save the file as WORLD.EXE.
Choose OK.

Minimize Visual Basic.

E To start the executable from Windows

You can start an execulable file from Windows in two ways: 1) create a program
group, and add the name of the file to the group; or 2) start Program Manager, open
the File menu, and choose the Run command. We'll use the first method.

1.

From the Program Manager File menu, select New.
The New Program Object dialog box appears.

. Select the Program Group option.

3. Choose OK.

The Program Group Properties dialog box appears.

In the Group Properties Description control, name the group something like
SAMPLES. '

In the Group File control, type SAMPLES

5. Choose OK.

10.

A blank window will appear.
From the Program Manager File menu, choose New.

The New Program Object dialog box appears with the Program Item option
selected.

Choose OK.
The Program Items Properties dialog box appears.
Name the application.

In the Descripiion control, name the application WORLD or another name that
reflects its function. '

Now comes the tricky part. You need to help Windows locate the executable file

. that you created.
. Click the Browse button.

The Browse window will appear.
Select drives and directories to locate WORLD.EXE.
It should be in CA\WALKTHRUNS AMPLES.
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11. Choose OK.

rh

Command Line text box,

=12, Choose OK.

. - The"SAMPLES Program Group will appear containing WORLD and a program
icon.

Z To run your application

. Double-click the World icon.

The Hello, World! application will start in the same screen location where the
form was created.

Z To stop your application ,
1. Click the Control menu in the upper-left comner of the Hello, World! form.
A menu will appear. '
2. Choose the Close command.
Windows closes the Application for you.
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-Visual Basic Menu Commands

B
n

‘Md’n‘bging Forms ‘and Projects: The File Menu

Editing Visual Basic Code: The Edit Menu

Testing Applications During Development: The Run
Menu

Visual Basic Window Management: The Window
Menu

Getting More Information: The Help Menu

In order to develop the simplest of applications, there are a number of Visual Basic
commands that you need to know about. Below is a brief listing of these commands,
The list is not exhaustive; there are a couple of topics that have been left to a later
module.

Managing Form: and Projects: The File Menu

Adding a New Form

File menu, New Form

Adding an Existing Form v a Project
File menu, Add File

Deleting a Form from a Project
File menu, Remove File

Making an Executable File

File menu, Make EXE File

Printing Code

File menu, Print, select Code option
Printing Forms

File menu, Print, select Form option
Saving a File and Naming It

File menu, Save File As

‘Saving a Form

File menu, Save File

Note Saving a file does not mean that the project is aiso saved.

Saving a Project
File menu, Save Project
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s Saving a Project and Naming It'

"~ File menu, Save Project As_
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Note A Walk Through showing you how to save a text version of the code is
located at the end of this portion of the module.

-~ :diting Visual Basic Code: The Edit Menu

Searching Code for a Tex1 String
Edit menu, Find

Searching and Replacing a Text String
Edit menu, Replace

Cutting and Pasting Text

Edit menu, Cut, Copy, and Paste
Undoing Changes

Edit meny, Undo

Testing Applications During Development: The Run Menu

Starting the Application
Run menu, Start

Notice the change in the title bar when you select this option to indicate that you
are now in Run mode.

Stopping the Application

Run menu, End

Visual Basic Window Management: The Window Menu

Displaying the Properties Window
Window menu, Properties
Displaying the Toolbox

Window menu, Toolbox
Displaying the Project Window
Window menu, Project Window

Displaying the Color Palette
Window menu, Color Palette

Getlting More Information: The Heip Menu

Using the Help Table of Contents
Help menu, Contents

Searching for a Specific Topic
Help menu, Search

“Locating Product Support Information

-~--Help menu, Product Support
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- - Walk . Through —Saving.a.Text Version of-Code ..

vk

" Procedural programmers are used to sezing all of their code in one place.
Remember, however, that the code is not executed in the order it appears in the text
- file you create here. It is still event-driven code, and the flow of execution stiil
.. depends on user and system events.

: 2 To save a text version of code

1. Restore Visual Basic.
2. From the File menu, choose Open Project. *
3. Open WORLD.MAK, located in \WALKTHRINSAMPLES. .
4. Choose OK.
Load the sample project that you  -ve just completed, but do not run it.
5. From the Project window, select WORLD.FRM.

Make sure that you select the correct file. When you load a project, the first file
in the list is selected by default.

6. From the File inenu. choose Save Text.

Visual Basic will give your text file the same name as the form, in this case
WORLD.TXT. That will probably do in most cases. Make sure thal you save
the file to the \WALKTHRINSAMPLES subdirectory.

7. Choose OK.
8. Minimize Visual Basic,
9. Return to Program Manager.
10. In the Accessories group window, open Notepad.
11. From the File menu, Choose Open.
Use the Open dialog box to locate WORLD. TXT.
12. Choose OK.
This loads WORLD.TXT into Notepad so that you can review the code.

If you want 10 print code directly to a printer, choose the Print command from
the Visual Basic File menu.

! '
You can print just the form or code or both for the current file, or you can print
all forms or code or both for your entire application. Remember, however, that
BAS files do not have a form associated with them, so in this case you will only
be able to print code.

_2 To.save a text version of properties and code

You-can also save the form with the properties and code in a text file.

1. From Visual Basic, open the project WORLD.MAK in
\WALKTHROUGH\SAMPLES.

From the Project window, select WORLD.FRM

From the File menu select Save File As.

. Select the check box Save As Text and choose OK.

. The form is saved in text format. The extension .FRM is used.

L Y N )

. Use Notepad to compare the two tex files.
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Walk Through — Using Visual Basic Help

Y, To use Help
-1. ‘From the Visual Basic Help menu, choose Contents.
-~ ¥ .The-Visual Basic Help window appears. This wiridow provides a brief topical
tour of the major components of Visual Basic.
A topicatl list that might be of interest to you is Programming Language.
2. Choose the Programming Language topic.
Information on that lopic appears in a window.
3. Choose the Beep Statement.
Language reference material on the purpose, use, and syntax of this statement
appear on screen.
Z To use the Search command

Like standard Windows Help, the Visual Basic Help system has a Search command
on the Help screen. To use Search, simply type in the term you are looking for.

1. From the Visual Basic Help window, choose Search.
2. Type Toolbox in the text box.
The text box is located at the top of the screen.
3. In the Search dialog box, select Show Topics.
4. Select the topic Toolbox,
5. Choose Go To.
Visual Basic opens a window with informalion on the term “Toolbox.”
6. From the Help screen, choose Back.
Visual Basic returns you to earlier topics.

Z To use the History command

Use the History command to retum to topics that you have covered earlier in the
session. Topical lists in this option are arranged in reverse chronological order.

1. From the Visual Basic Help window, choose History.
The Windows Help History dialog box appears.

2. Double-click the 10pic of your choice.
The Help screen for that topic appears.
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_ 2. To cut and paste sample code into your code

tho

e most powerful part of the-Visual Basic Help systt_er_n-js-ﬁle-l;r_ge number-of code
samples that you can paste into a project and run.

" The following proc.‘ures allow you to copy and paste sample code for a Click

©o.oevent -

1. Visual Basic should already be running.
Make sure there is a new form on the screen.
2. From the Help menu, choose Search.
3. Type Click in the text box.
4. Click the Show Topics button.
Click Event should be highlighted.
5. Choose Go To.
6. At the top of the Help form, click the word “Example.”
This brings up sample code in a window.
7. From the Event_Click example window, choose Copy.
This brings up another window with all the sample code in it. .
8. Highlight the code you want.
In this case, take only the lines starting picturel .Move. ..
9. Click the Copy button. v . !
This copies the selection to the Clipboard and hides the copy form.
10. Exit Visual Basic Help. '
11. Double<click the picture box tool at the top of the Toolbox.
12. Drag the picture box to the lower-left corner of the screen.

'13. Double<click the picture box on the form,

The Code window will open.
14. From the Edit menu, choose Paste.
Paste the sample code from the Clipboard to your form.
15. From the Run menu, choose Start.
16. Click the picture box once.
It will move toward the upper-right comer of the screen.
17. Continue clicking the picture.
- "It'will disappear into the upper-right comer.
18. From the Run menu, choose End.
19. Minimize Visual Basic.
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summary

" « Visual Basic Tools

. Buildihg a Simple Visual Basic Application
= Visual Basic Menu Commands

Obijectives
In this module, you leamed 10:

Design an application user interface using the Form window, Toolbox, toolbar,
and Property window.

Name and save the application’s forms and project files.
Start and stop an application from the Visual Basic menu and/or the 1oolbar.
Create an executable file and add it to a Windows group.
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. LabTime

Go to the Cfeating An About Box portion of your lab manual.
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S-Overview ——

- -

"'« Event-Driven vs. Procedural Programming

Microsoft Visual Basic Terminology
Application Development Process
User Interface Design Guidelines

Configuring Your Environment

Overview

The purpose of this module is to introduce you 10 several related concepls that help
you make the transition from the procedural world to the eveni-driven world. This
module creates the logical framework for much of the rest of the course. It contrasts
programming for Microsoft Windows with MS-DOS and other character-based
applicauons.

[t also provides a high-level overview of and establishes relationships between
objects and events. '

This module also quilines the general process that is used to develop Visual Basic
applications and some general suggestions for overall application design.

Prerequisites -

Nomne.

Overall Objective

At the end of this module, you will understand the paradigm shift from procedural 10
event-driven programming.

: -~ Learning Objectives
' At the end of the module, you will be able to:
= Explain the key differences between graphical and character-based applicalions.
s Provide high-level definitions for some key Visual Basic terms.
s Qutline a basic application design and development procedure.
» Explain several fundamental principles of user interface design.
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Event-

Driven vs. Procedural Applications

Programmer-Driven ] User-Driven

Character-Based §{ Graphically Based

Single Tasking [ Muititasking

Windows Control
| of Environment

Programmer Control
of Environment

Example

References

Traditional programming is linear. It has a top-down sequencing that is controlled
by the programmer. :

Windows-based programming is event-driven. Windows-based events can be
triggered in one of two ways. They can be either user-triggered or system-triggered.

Below, in pseudocode, is a very general summary of the structure of an event-driven
program for the Windows operating system:

Begin MAIN PROGRAM

1
2 Begin Loop
3 ' Ask Windows to pass messages to 'your program
4 ' about what events have accurred
3 Case Statement GETEVENT
6 CASE Click
7 ' You can choose ta inaoft code to respend to
8 ' click events for the appropriate objects.
9 CASE Change
10 ' You can choose to insert code to respend to
11 ' change events for the appropriate objects.
1z CASE ... ’
13 - CASE Default:
2714 R , ' VB will handle other events internally
15 ' without giving your program accesas.
16 ' One of the default cases ia the "end
17 ' application” message that causes an exit
18 ' from the loop and causes your application
19 ' to terminate.
20 End Case Statement
21 End Loop

22° End MAIN PROGRAM

For a complete list of the events that Visual Basic recognizes, see the Introduction
in the Microsoft Visual Basic Language Reference.
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o

- n da o4 s

..Notice that there is not a linear flow to the progiam because the flow dependson _

what events-are-generated-and the order-in-which they-are reporied-to-your-program
by the Windows operating system.

" Applications that run in the MS-DOS environsrient are programmed to be the only
..... application running. MS-DOS —based applications do not handle multitasking very

well.

Window applications are multitasking. They can share screen space and computing
time. !

MS-DOS -based applications are character-based. Windows-based applications are
graphically based and typically use proportionally spaced fonts.

Applications programmed to run in the MS-DOS environment are able to controt
the environment the user operates within. The program can have control over the
sequencing and appearance of where the user will go next in the application.

' Applications progrémmed to run under Windows give control of the environment to

Windows. How the user moves between events is controlled :iwough the Windows
operating systern itself rather than through the Windows-based application.
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Visual Basic Terminology

B A

Controi
[

i {Propony
1

The terms on this foil depict two major components of the Visual Basic
development environment: the graphical side of it and the code side. Put in tabuiar
form, they look like this:

Application
Forms
Properties
Events
Controls
Properties
Evenits

What Is an Object?

Consider this example: The dashboard of your car offers users a variety of gauges,
dials, and accessories that take input and give output. The therrosiat tells you how
hot the engine is. The steering wheel lets you change direction. Each one of these
"objects" performs a specific purpose, and you use it 10 attain a given goal or
objective. Users learn how to use these objects.

For the most part, users do not leam how to install, maintain, or troubleshoot these
things. They do not leam how these things function. The user only needs 10 know
that these objects work and what to expect from them. In a like manner, Visual
" “Basic offers programmers objects — forms and controls—that they can use to build
applications. For the most part, the programmer need only use the object without
necessarily having a detailed understanding of how the object does what it does. -
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The Graphical Side

o

Objects

- Components of an application, usually forms and controls.

-~ .Forms

Forms are the building blocks of applications. They are the windows that users see
when they run your application; they are the major structural units that make up
your application. Visual Basic is made up of several forms. The Toolbox, the
Properties window, the Project window, and the Save Project As dialog box are all
examples of forms.

Walk Through — Forms and What You Get Free

To open a blank form
1. Stant Visual Basic.
A blank form should be on the screen.
2. From the Run menu, choose Start.
Notice all of the things that Visual Basic gives your form, such as:
¢ Sizing border
¢ Controi menu
¢ Minimize button
e Maximize button

You don't need 1o write any of the code for painting any of these features of your
application. You also don't neéd to write any of the code for managing these
feawres.

3. From the Run menu, choose End.

Controls

Controls are the tools you place on forms that provide users with application
functionality. Examples of controls are the command buttons and labels.

Properties

Forms and controls have properties (attributes) that you can change during design
and run time. An example of a property is the caption that appears on a command
button. Generally speaking, you set the values for control and form properties when
you are designing your application.

Event Pfocedures

Event procedures are code intemal to Visual Basic and Windows that is written for
you and provides your application with some of its basic functionality. For example,
when a user clicks a check box, the Click event knows how to paint an X in the
square. However, you must place code inside the Click event for that check box to
cause your application to react appropriately when a user places an X in or removes
an X from the check box.
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The Code Side

Project

“Your development project is made up of more than graphic.al forms and controls; it
-~ *also has Basic code in it. This is managed and accessed through the Project
window. . .

" Walk Through — Visual Basic View of Your
Project

E To view your project

1.
2,
3.

If it isn't already started, Start Visual Basic,

From the File menu, choose Open Project.

Load the ICONWRKS MAK file.

This file is located in \VB\SAMPLESNCONWRKS.

- From the Run menu, choose start to run the application.

Work with the application for a minute, but the point here is that this application
is mz:ie up of a number of different forms.

5. From the Run menu, choose End 10 stop the application.

Access the Project window.

The Project window keeps track of the forms and modules that make up your
application.

For o'ur,p.urposes, Visual Basic treats each of your forms as a separaie
component. ’

Visual Basic keeps track of the number and kinds of files that you are using in
your application in the .MAK file and loads them when you want to start
working on your project.

. Quit Visual Basic.
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Module

In'Visual'BaeiC'a‘mOdUIe'is~a'ﬁle'mat'éontam;'oﬁlj; -cc;d;:ér_ae-e;‘aﬁl;-of-afBAS
file that you could see at the top of a Project window is MODULEL.BAS.

" Another way of showing the relationship among forms, controls, properties, and
" -+ event procedures is this:

| MODULE1.BAS
Data and Code

FORM1.FRM

Graphical Elements
Da% Project

FORM2.FRM.

Graphical Elements
72 Data and Code '

The .MAK file ~ontains names of both the FRM and the .BAS files in the project
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Application Development

Calculator

2,

Creating an Application

To create an application in Visual Basic, follow this suggested sequence

1. Open a new project (or use the new project created when you start Visual Basic)
10 organize the parts of your apptication.

Create a form for each window in your application.
Draw the controls for each form.

Create the menu bar for the main form.

Set the form and control properties.

Wrile event procedures and general procedures.
Save your work.

Debug your code.

Create an execulable file to tum the project into an application.

T A o

Distributing the Application -
When you distribute the executable of your application to users, you need to
distribate a copy of the Visual Basic dynamic-link library VBRUN300.DLL with it.

* ‘This dynamic-link library (DLL)} is 2 part .: the Visual Basic installation files, and

you can distribute it royalty free. If you build your application using any of the
available custom controls, you will also need 1o ship all appropriate . VBX files, and
in some cases .DLL files. The product documentation for the custom controls will
tell you what these files are.

Finally, during design time, you may decide 10 move the forms for the application 10
another machine. In this case, you will probably need to rebuild the .MAK file,
because it keeps track of all the files that make up your application as well as the
fully qualified path to them. To do this, copy all the files 1o the new machine, then
update the paths in the MAK file by using the Remove File command from the File
menu, and then the Add File command.
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-~ —— UserintefaceDesign -~ - - . ... .

= .General Guidelines
« Design Basics
s Color

s Fonts

User interface design guidelines are an agreemem to create consistent user
interfaces. o

User interface guidelines are important for ease of learning by the user. They also
prevent programmers and developers from "reinventing the wheel.”

They are guidelines— suggestions on the way you might want to design the user
interface. There are no hard and fast rules. -

General Guidelines
» Design basics

‘o Design for the user, not the system
Composition and functionality
¢ User control .
¢ Directness
» Consistency
o Clarity
® Aegsthetics
- o Feedback
"o 'Forgiveness
s Color
¢ Color as an attention-getter
¢ Complementary versus circus colors
= Fonts
¢ Serif versus sans-serif
s Size
o Number (variety)
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For More Information _
For more detaiis on user interface design guidelines, see:
‘- The Mﬁdows Interface: An Application Design Guide

' Vilsuc'ztrbesign Guide contained within Visual Basic *

Walk Through — Designing the User Interface

As you walk through this application, look at the property listed and answer the
question that follows.

Y. Print Utility #1
1. From the Walk Throughs program group, start Print Utility #1.

First impressions are important. Are the function and purpose of the application
apparent from a first look at the interface?

2. Title Bar
The title bar should contain the name of the application. Does it?

3. Menus

The menu structure should reveal somethjnf; about the contents of the
" application. Does it?

" Does the first menu item follow user interface guidelines?

Is the Help command in the standard place?

Is lhe Quit command handled suitably? -

Where does the About command normally appear?
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S 4. Scroll bar

Is this the most effective way (0 ask users for the number of copies they will be
wanting? '

[

Are the size and location of the scroll bar appropriate given the overall purpose
of the application?

5. Options ,
How many sets of options are there really on this form?

Are the check boxes presented in red, the best way t0 get information from the
user? :

Cwr

How should the header, footer, and page numbering questions be implernented?

6. FilcName text box

If the user wants to find a file and print it, what other tools does the user need .
Dbesides this simple text box? ‘

7. Stop and Print buttons
Are these buttons appropriately sized for this form and its function?

8. Exit
Close the application.
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Y. Print Utility #2
1. From the Walk Throughs program group, start Print Utility #2.
2. 'Open the second version of this application.

=I5 the overall layout of the form effective? How does the layout suggest how the
user might work with the form?

How do the frames help structure the user's decisions?

How is the menu structure consistent with user interface guidelines?

Why were the header and footer options dropped from the form?

Why was the Percent Done label added?

3. Quit the api)licatjon.
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. - User Interface_Design Guidelines -

-

Device Input
Getting Input from a Mouse

There are a limited number of things that users ¢an do with a mouse:

1. Single-click with either the primary or secondary (left or nght, top or bottom)
button. .

2. Double-click with either the primary or secondary button.
3. "rrag normmally with the primary buiton.
4, Drag and drop.

For example, a single click with the primary mouse button normally indicates that a
choice such as a bold, italic, or underlinc text format option has been made on the
ribbon of a text editor. Selection of a file 10 be opened is normally indicated by a
single click.

Double-clicking selects the object to be acted upon and initiates the action. That is,
if you want 10 select and open a file, you simply double-click a filename. The same
thing happens when you double-click an icon.

Dragging is used to resize a window, move the window (0 a new location, or
reposition an icon. Drag and drop is normally used to select an object, for example,
the name of a file, and then place it over another object, for example, a printer, so
that the file can be printed.
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Keyboard and Mouse Functions

Whenever possible, all mouse actions should be duplicated with an equivalent
_keyboard action. Keyboard shortcuts and access characters should also be used to
" reduce the number of keystrokes and potential for errors by the user.

- -

" For éxémple. in most cases you will want to give a keyboard shortcut for the most
commonly used commands. If possible, use the first letter of a menu or control as

the access character. If there is a conflict, use another letter in the menu or control
name.

When you design the application and its forms, specify the shortcut keys.
' 4

i
i
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Configuring Your Environment - -

i

Delauilt S ave As Fomat i ]
Save Pioject Beiore Run o
Selecton Ted ~
Selachon Backgound
Next Statement Taxt

Comment Text

You can configure much of the look and feel of the development environment. From
the Options menu, choose Environment Options. From this window you can set
everything from the default tab stop in code to the foreground and background
colors of comments in code.’

Setting Default
Tab Stop Width 4
Require Variable Declaration . No
Syniax Checking No
Default Save As Format Binary
Save Project Before Run No
Selection Text

Selection Background
Next Statemen: Text
Next Statement Background
Breakpoint Text
Breakpoint Background
Comment Text

© Comment Background

" Keyword Text

Keyword Background
Identifier Text
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Setting Defauit
Identifier Background

Code Window Text

-Code Window Background

Debug \'Nindow Text

Debug Window Background

Grid Width - 120 Twips
Grid Height _ 120 Height
Show Grid Yes

Align o Grid Yes

For a list of the colors avaitable, see the Colors section of CONSTANT. TXT

located in the \VB subdirectory.

Note Changing to a larger grid size and then aligning the controls 1o the grid may

change the size of your controls.

Automatically Loading Visual Basic Extension

at Startup

You can control which of the .VBX or Visual Basic Extensions are loaded when
starting up a new project by editing AUTOLOAD MAK with a text editor. This file -
is located in the \VB subdirectory. The default settings are:

GRID.VBX
MSOLE2.VBX
ANIBUTON.VBX
CMDIALOG.VBX
CRYSTAL.VBX
GAUGE.VBX
GRAPH.VBX
KEYSTAT.VBX
MSCOMM.VBX
MSMASKED.VBX '
MSOUTLIN.VBX
PICCLIP.VBX
SPIN.VBX
THREED.VBX
ProjWinSize=152,402,248,215
ProjWinShow=9
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e

.Event-Driven vs. Procedural Programming

Microsoft Visual Basic Terminology

Application Dreyelopmeni I?rocess

User Interface Design Guidelines

Configuring Your Environment

Ry A N

Obijectives
In this module you leamned to:

e

Provide high-level definitions for some key Visual Basic terms. ~

s OQuiline a basic applications design and development procedure.

Explain several fundamental principles of user interface design.

Explain the key differences between graphical"and character-bag%‘éa applications.
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Lab Time

te

.Go to the Employee Database Application Specification portion of your lab manual.
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—>-Overview

Forms and Their Properties

Message Boxes . |
Starting the Forms of the Employee Database
Muitiple Document Interface Applications

Overview
The purpose of this module is to introduce you to the Visual Basic programmer's
fundamental tool—the form.

Even though this is a relatively brief module, it inroduces some key terms that are
required for a full understanding of the programming environment. This module
primarily focuses on the various properties associated with forms, separate from the
discussion of controls and propertes. This module also touches on event procedures
and methods associated with forms. A more detailed discussion of these issues will
be found in a separate module.

This module also serves as the inroduction to the main elements of the class
application and walks you through creating, naming, and saving these forms.

Prerequisites ,

Prior to starting this module, you should have a fundamental awareness of:
s Windowing technology from the user perspective

s The Visual Basic programming environment

Overall Objective

At the end of this module, you will understand the fundamentals of working with
forms in Visual Basic.
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Learning Objectives
Al the end of this module, you will have:

» Set captions on forms.

Y4 Setthe Name property for a form.
n Added a form 10 a project.
s Saved all of the forms in a project.
s Saved the project itself.
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______Propetrties for_ Forms

e

Forms and Their Common Properties

Forms are the central element of Visual Basic. They are the design of your
application; they are the thing that your user interacts with. They are where you
place the controis for your application.

You will notice that many of the properties for forms have the same names as those
found for controls, but on forms they have a different use.

Property " Defauit Comments

BorderStyle 2 - Sizable Set BorderStyle 10 “3- Fixed Double” 1o create a modal
form (used for dialog boxes).

Caption Form1 Appears at the top of the form.

ControlBox True Enables the Control menu.

FoniSize - 825 Used in printing 10 a form.

FoniName Helv Used in printing to a form,

Name Forml The name in code.
Also appears on Project list.

Height 4425 twips

- Ikon . Default icon for your executable.
‘ fele KeyPreview False Delermines whether the form keyboard events occur

before control keyboard events.

Lef - From left edge of screen.

MaxButton True Disable for a medal dialog box.,
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Property Default Comments
MinButton True Disable for a modal dialog bex,
. Also see BorderStyle.
=MousePointer 0 Default Sets cursor shape on form— 13 possible choices, See
R the Microsoft Visual Basic Language Reference
Top - From top edge of screen.
Visible - ' True False is equivalent to cafling the Hide method.
Width 7483 twips
Events

load A Load event occurs when a form is loaded. Normally, you witl use a Form
Load event o se[ initial values for the controls on a form.

Example Sub Form_Load ()
Tep = 1500
Left = 1000
End Sub

Unload An Unload event occurs when a form is about to be removed from
memory. This event is normaily triggered by the user closing the form using the
Control menu

Methods

Hide This method is used to remove a form from Lhe screen without unloading it.
When you use the Hide method, the Visible property of the form is set to False.

Show The Show method is used to display a hidden form.

Example Sub mnuPrintOptions_Click ()
frmPrintOptiona. Show
End Sub
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—— - Message Boxes

'

Microsoft Visual Basic

What Are Message Boxes?

For the most part. Visual Basic applications are made up of forms. You will find
several places in your applications where you want to convey fairly routine kinds of
information to users and you really don't want to design and build a form to deliver
it.

.

Visual Basic has a convenient 100l that displays a kind of form—-called a message
box— where all you need to do is to provide the message string and, optionally, a
number that indicates the number and types of buttons and icons to be displayed on
the form, and a title for the dialog box. ’

If you wanted to make sure that users had saved all of their new data prior 10,
closing an application that you are writing, you could create a whole new form, or
you could use the MsgBox function.

Waik Through — Coding Messoge Boxes

To inspect the message box sample application
1. From the Walk Throughs prbgram group, start MsgBox.
2. Click the Exit bunon on Forml.
' 'T'hls displays a dialog box that queries users about the status of their data.
3. Choose Yes, No, or Cancel.

Any one of these choices closes the dialog box. Implementing code that .
differentiates them will be added in another module.

4. Open the Control menu on Form1, and choose Close. -
This closes Forml.
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Z To code the message box sample application

. If Visual Basic is not running, start it.

Double-click the command button tool in the Toc’ ~x

=3. Place’it in the lower-right comer of the form, or any other out-of-the-way place.
. In the Properties window Properties list for the command button, change the

following property:
Caption: Exit

. Click anywhere on the form.

This puts the focus back on the form.
Double-click the command button.

This will automatically open the Code window for the form and take you to the
Command1_Click event template.

. Add the following code:

Msg$ = "Have you saved all your work?"
MagBox Mag$, 3 + 32, "MagBox Walk Thry"

What does the code do? First you create a stnng variable with the message you
want to display, and then you call the MsgBox statement. You can pass the
MisgBox statement three arguments. Although the second and third arguments
are optional, in this case we have you include them.

The first argurnenl is the message string that is displayed inside the message
box.

The second is a sum of values that indicates to Visual Basic the type of message
box you want. More about these numbers in a minute.

_The third argument is the title of the message box.

8. From the Run menu, choose Start.

10.
1.
12.

Test the diatog box.
Use the mouse pointer to choose the Exit command button. The dialog box will

 appear in the middle of your display.

To close the Message WalkThru dialog box. choose t.he Cance! button.
From the Run menu, choose End.

In the Code window, highlight MsgBox.

Use the mouse pointer to highlight this word in the code.
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13.

Press Fl.

Make sure you are in i the 1e design mode not the run mode.

By adding the appropriate key values listed in the second table in the Visual
Help topic for the MsgBox statement. you can control the number and type of

- . buttons, control the icon displayed in the message box, and even set a default

14,
15.

button.

In this walk through, you add the value 3 (to request a message box with Yes,
No, and Cancel buttons) and the number 32 (to request a message box wuh a
Warmning Query or question mark icon),

There are more sophisticated ways of implementing and using message boxes,
but this gives you a start,

Did you notice that the Yes, No, and Cancel command buttens do much, yet?

If you read further down in the Help window, you see that each of the different
buttons retumns a different value. You will use those values a litte later in the
course, along with some conditional logic to code the three butions on the dialog
box. For the time being...

Minimize Help.
From the File menu, choose Save File As.
Save _us form in \WALKTHRINSTUDENT1 as MSGBOX .FRM.

16. rFrom the File menu, choose Save Project As.

17.

Save the project in the same subdirectory as MSGBOX.MAK.
Select the Visual Basic Control menu, and choose Close.
Quit Visual Basic and Help.
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Modal and Modeless Dialog Boxes

te

Opﬂnuﬁl'llilfljf

List Fides of Typa: Drives:
(Protect Fles* Max) ¥ [@@e: i#

Modal, Modeless, and System Modal

You can designate a form as being either modeless or modal. The default is
modeless, which means that the user can open the form and still get to other forms
within the application to do work. Modal forms, in contrast, require that the user do
something — click a button, check to make sure they really do want to delete all
those files — before they can do any work.

Walk Through — Modal Dialog Boxes

To use a modal dialog box

1. From the File menu, choose Open Project.
Bring up the Open Project dialog box.

2. Access the Project window.

Place the cursor on any other portion of the Visual Basic interface. Press either
one of the mouse buttc-

A beep sounds and the cursor continues to flash in the text box. In this case the

user must choose one of the three choices presented: Locate the name of a

project using the list boxes, input a valid project name, and choose OK or
“Cancel.

‘3~ Click the Cancel button.

Close the dialog box.
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Applicaiion Modals and Sysfem Modals

e

applxcauon They have no effect if the user switches 10 Windows or to another

~-application. In order 10 make a form system modal, all you need to do is to use the
- siyle%e parameter for both MsgBox statements and functions.

The syntax ooks like this:

{form.] Show [style%]

In addition, you would need to declare three global constants:

Glebal Const MODAL =1
Glokal Const MODELESS = 2
Global Const SYSTEMMODAL = 4096

Watk Through — Making the Forms of the
Employee Database Application

To make the forms of the Employee Database application

1.
2,

If Visual Basic isn't already running, start it.
Set the following properties for the form:
Caption Employee Database

"Name frmEmpDB :
Height 5760 (approximately) ' =
Icon \WBNCONSWMISCWMISC28.ICO
Width 7600 (approximately)

Note When you set the Icon propenty for a form, you will need to know the
full path to the source file, but the Visual Basic interface will only tell you lhal
you have an icon by displaying the property as (Icon).

. From the File menu, choose Save File'As. )

Make sure that you save the file in the appropriate subdirectory. If ybu don't, the
.MAK file will not be able to find this part of your project. This first pass at the
application should be saved in \STUDENTINFORMS.

Name the file EMPDB FRM.

5. Choose OK.

This saves the form.

 Click the Project window.

Notice that the filename is in the left column on this list, and the name of the
form is in the right column. :

So far, you have given the form the names that are known to the file system and
to Visual Basic. '

From the Control menu for the Employee Database form, choose Close.
Close EMPDB.FRM.

From the File menu, choose New Form.

Add a second form to the application.
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e

e

10.

11
12.
13.

14,

15.

16.

17.

Set the following properties for the form:
Caption Employee Record
Name frmEmpRec

Height © * 4545 (approximately)

MaxButton False
Width 5485 (approximately)
From the File menu, choose Save File As.

Now, rename and save the file, making sure that you save it in
\STUDENTINFORMS.

Name the file EMPREC.FRM.
Choose OK. '
From the Control menu on your newly created form, choose Close.

Close the form, and notice that the name of this form has been aﬁded 10 the list
in the Project window.

User interface guidelines suggest that applications have an About box—a form
that indicates that the application is copyrighted. You have already created an
About box: now you need to add it to this application.

Note You will also want 10 make some changes to the About form, but the
directions for doing this are not included here. You would, for example, change
the caption for the About box so that it contained the name of the application,
but doing that here distracts from the point of this walk through.

Copy ABOUTI.FRM from \STUDENT NABOUT to \STUDENT INFORMS.

Before you add the About box form to the project list, you should make a copy
of the About box form that you have already completed and place that in
\STUDENTINFORMS.

From the File menu, choose Add File.

ABOUT.FRM should appear in the \FORMS subdirectory, so ail you need to do
is select the name so that it appears in the text box.

Choose OK. .

The name of the added form should appear in the Project list.

From the File menu, choose Save Project As.

Now that you have made most of the basic forms for the Employee Database

. application, you need to rename and save the file that keeps track of the files in

.. the project.

The Save Project As dialog box should appear center screen, with the correct

18.
19.

subdirectory already listed in the current working directory and a suggested
filename with the appropriate file extension.

N :e the project as EMPLOYEE MAK.
C: e OK. -
This saves all of your current build information.
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20. From the Run menu, choose Start.

If you want to test the application, you should see the Employee Database form

appear on screen. This form appears only because that was the first form you

created. If you try to open the Employee Record form, you will see that you have
.. . notimplemented code for that task yet.

21. From the Run menu, choose End.
22. Quit Visual Basic.

bt



70 - Module 3: Working with Forms

Multiple Document Interface Applications

B e wie
Fite ‘Window -
- Child e
= Chiid
R od -
I
brrs

Placing Forms Within Forms

Visual Basic allows you to write applications that can create multiple copies of a
form and display all the forms within a single container form. Microsoft Word for
Windows and Microsoft Excel are both applications that allow users to do this.

Walk Through — Creating MDI Applications

Z To see the final version of your MDI application
1. From the Walk Throughs program group, start MDI.

For the most part, in this course, we will focus altention on placing controls on
forms. However, Visual Basic has the capacity to place forms on forms and
multiple instances of forms on forms.

The purpose of this walk through is to give you the fundamentals of
implementing an MDI application. We don't include all the enhancements that
you might want to implement. Detailed coverage can be found in the follow-on
Programming in Microsoft Visual Basic 3.0 course.

2. From the File menu, select New.

. Do this three times. You may not see much happening at first, but each time you
 select New, another instance of the child window is being drawn on screen. one
~ atop the other.

3. From the Window menu, choose Tile,
This organizes and displays all of the child windows that you have created.
4. From the Control menu on the Parent foﬁn, choose Close.

In order to create this application framework, follow the steps below; but there is
.a warning required here. You will be typing in a number of things that haven't
been explained yet. Don't worry; they will be. For the time being, accept that
things work and that the details will follow.
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Z To create a simple MDI application

1]

-

10.

11.

Start Visual Basic:
A new, blank form will appear on screen.

. From the File menu, choose Add File.
. Use the browser to add PARENT1.FRM located in \WALKTHRU\FORMS.

Note Under normal circumstances, you wouldn't go this route. You'd setect
the New MDI Form command. If you did that, a second form would appear on
screen, the entry named MDIFORM 1. FRM would be added to your project list,
and the New MDI Form command on your File menu would be disabled. From
there, you would need to add all the menu items; but since you haven't done that
yet, we will give you the completed form, so that you can concentrate on the
MDI capabilities.

‘Now you should have two forms in your project.

In the project list, put the focus on FORM1.FRM.

That is, make sure that you see FORM1.FRM on top of all the other forms
within Visual Basic.

From the File menu, choose Save File.
Save the file as FORM1.FRM.

.. From the Window menu, select Properties.

This displays the Properties window for FORM1.FRM. o
In the Properties window Properties list, locate the MDIChiid property.
The default value for this property is False.

) G

. Doub!e-click the value in the table.

This toggies the value to True.

Select the Control menu for the Properties window and choose Close.
In the Project window highlight PARENT1.FRM and choose View Form. '
This places the focus on this form.

Open the File menu on the Parent Form and choose the New command.

This is the shortcut for getting from the form to the code that supports it. You
should now be in a Code window that looks like this.

F
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12. Place your cursor on the line between the Sub and End Sub lines and add this
code: SO

Dim NewDoc As New Forml
- NeuDgc .Show
“That's all there is to it. Your questions about Dim and New and Show will all be
answered in a little while,
13. From the Object drop-down combo box, choose General.

This moves you to the General Declarations section of the code, where you can
declare a couple of constants that Visual Basic needs for arranging the windows
that your application creates. :

14. Add the following code:
Const _CASCADE = 0
Const TILE_HORIZONTAL = 1
15. From the Object drop-down combo, select rmnuWindowCascade.
16. Add the following code on the blank line between the Sub and End Sub lines:

MDIForml.Arrange CASCADE

17. From the Object drop-down combo, select the mnuWindowTile.
18. Add the following code on the blank line;

MOIForml.Arrange TILE HORIZONTAL

That should do it. Now ali you need 1o do is 10 run your application.

z To run your new application

1. Choose the Run icon on the foolbar.
2. From the File menu on the Parent form, choose New.
3. Do this a couple of times so that you have several windows to work with.
4. From the Window menu on your application, choose Tile.

This tiles all of your windows.
5. From the Window menu on your application, choose Cascade.

This re-arranges all of the windows.
6. From the Run menu, choose End.
7. From the Visual Basic File menu, select Save Project As.

- Now that you have the framework for an MDI application finished, save your

. work.

8. Save the project as MDL.MAK and make sure that it is in
\WALKTHRINSAMPLES.
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.Forms and Their Properties

Message Boxes

Starting the Forms of the Empioyee Database
Multiple Document Interface Applications

Objectives
In this module you leamed to;

Set captions on forms.

Set the Name property for a form.
Add a form to a project.

Save all of the forms in a project.
Save the project itself.
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Y _Qverview

LY

= Menu Guidelires
= Microsoft Visual Basic Implementation

Overview

Previous modules gave you a chance [0 see and use the processes you should follow
for developing Visual Basic applications. In those modules you developed a single-
form application. In another module, you developed all the forms that are needed o
implement the database front-end, but there was a part that was missing— the
menus on some of the forms. This modyle begins with a discussion of the general
layout of menus and the user interface specification. It ends with a
demonstration/walk through of the Menu Design window.

Prerequisites

To successfully complete this module, you must be able to use a mouse. Experience
with Windows-based applications is useful but not required. You should also be
able 1o start Visual Basic and create a form.

Overall Objectives

'The overall objective of this module is to teach you how to design user-friendly
menus and create them using Visual Basic.
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Learning Objectives
At the end of this module’s lab, you will be able to:

® List and explain the use and value of all of the key menu elements:
¥ 4 Access or hot keys
* Shortcut keys
* Menu bar
e Separator bar
+ Ellipsis

w Create an application that uses at least one menu on an application window and
uses more than one form. It should include a least one funciionality menu as well
as a Help menu that includes choices to display a simple Help form and an
About box.
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— ———""Menu Guidelines

Write - (Untitled)

Document Help

Cuta |}
Paste Cirtav |
Faste Spgoial... ’
Pasta Link
Links...

Chjact :
Insert Object...

Move Picture
Size Picture

Style
Guidelines

Menus and Their Standard Propenies

Under user interface guidelines, menus are one of the primary ways for
programmers to structure application functionalities for users. Normally, menus do
one of two things: explicitly invoke a command, such as closing an application
using Exit, or invoke & dialog box that offers users more options, such as the bold
and italic text-formatting options.

Menu Structure

Under normal circumstances. most applications will start out life on the
development side with three main menus—File, Edit, and Help. The File menu
normally will contain commands that are related to file manipulation:

s New

» Open

= Save

e SaveAs
s Print

= Pring Setup
= Repaginate
m Exit

Quitting the application, by convention, is done from the bottom of the first menu.
Help is normally the last menu on the right.
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Style
Guidelines

The general Edit menu normally contains at least these four commands:

s Undo
-» Cut

- wCopy- -

s Paste

It may contain several other commands as they are needed for specific functions
within the application. '

Finally, Help is normally implemented with at least these four choices:

a Contents — Table of contents for Help

w Search for Help on... — Index to Help

= How 10 Use Help — Directions for using Heip
» About application name — Copyright notice

Special Features of Menus
Period Ellipses

e three dots at the end of a command on a menu indicate that a dialog box will
sppear offering you more choices related to the command. A lack of three dots
indicates that as a resuit of choosing the command, an action will be carried out.
For example, if you choose Centered from the Paragraph menu, all highiighted
paragraphs will be centered on the page.

Checking Options
A check mark next 10 a menu item indicates to the user that the option is currently
invoked.

Separating Clusters of Related Commands

Separator bars are used to visually cluster related commands so that the user sees a
short list of related items, rather than a long list of seemingly unrelated items.

Access or Hot Keys

Access keys are marked by an underscore beneath a single letter in the menu item
or commang, Access keys are the keyboard (as contrasted with the mouse) input
device for the menu. Access keys are invoked by pressing the ALT key and then the
underscored letter in the command. For example, pressing ALT+F opens the Fiie
menu. Pressing ALT+F+0 opens the File menu and then chooses the Open command.

_For access keys, you should try to select the letter that will be most memorable for
most users, Normally this is the first letter in the word, but that might not always

work. For example, Minimize and Maximize both begin with "M," so a better set of
options might be to use the "n” from Minirnize and the "x" from Maximize for the
access keys.
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Shortcut Keys

Style - --
Guidelines

Shoricut-keys-are-a second-form-of-keyboard-access-to the-menu-To-use shortcut

keys, Lhe user need only press a function key or some other key combination (such

_ as CTRL+A} in order (0 execule a command.

...Same examples of standard shortcut keys are as follows:

F1 Help

CTRL+X Cutting selected text

CTRL+C Copying selected text
CTRL+V Pasting selected text

CTRL+Z . Undo
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Laying Out Menus

Visual Basic Implementation

The Menu Design Window

From the Window menu, choose Menu Design window. If the Menu Design
window command is unavailable (dimmed), click any of the forms in your Visual
Basic application. You will then be able to access the Menu Design window. The
Menu Design window dialog box appears.

The remainder of this topic divides the Menu Design window into two units—

‘Menu Layout [tems and Layout Manipulation Items.

Menu Layout Items

Item - Default Description
Caption ) Name that appears on the menu.
Name © Name used in code. Use mnu as a prefix.
Index Used for adding menu items dynamically.
Shortcut CTRL + shortcul keys.
Window List Specifies whether a menu controi will include a
list of open MDA child forms.
HelpContextID Specifies an identifier for the menu item in a
) . Help system.
Checked . Not checked Indicates whether a check mark will be
o o displayed to the left of a menu choice.
Enabled Checked Indicates whether a menu choice is available 10
the user (disabled choices are dimmed).
Visible Checked Indicates whether a menu itemn is visible 1o the
user.
‘Layout Manipulation items

~ In order to use most of the Layout Manipulation Items on the Menu Desigr window,

you must first select the control (menu) and then press the manipulation it<: s 10 alter
the control.
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S Item Function
LEFT ARROW Raises a menu item one level —for example, makes a
submenu int¢ a main menu.
" RIGHT ARROW Lowers a menu item one level—for example, makes a
) Lt main menu into a submenu.
LP ARROW Moves the menu item up one position in the menu list,
DOWN ARROW Moves the menu item down one position in the menu list.
Next Moves the cursor down one ilem in the menu list. Also,
clears the Caption and Name so that you can add a new
menu item.
Insert Insens a blank line in the list of menus so that you can add

Style
Guidelines

anew menu item.
Delete . Deletes the selected menu item from the list.

In order to implement access or hot keys, place an ampersand (&) in front of the
letter 1o be used in the ALT+ combination. For éxample, to implement ALT+F as the
access key combinaton for the File menu, you would type &File in the Caption
control of the Menu Design window.

" Separator bars are implemented by entering a single hyphen ¢-) as a Caption.

Note You must assign a menu name 10 the separator even though it is not really
acting as a control.

- Walk Throughs — Startup Application with

Menus and Click Events

To see the final version of the menus Walk Through
1. From the Walk Throughs program group, start Startup.

This sample application serves two purposes. It introduces you to the methods
for implementing menus in Visual Basic applications, and it gives you a simple
example of how Click events work in Visual Basic. Incidentally, this sample
application also shows you how to use the Shell function.

2, Choose the Cardfile command button.

. 'This applicauon starts up Cardfile or Windows Paintbrush™.
3. Close Cardfile. '

4. From the Edit menu, choose Colors.

. “The application shows the implementation of menus, cascading menus and
* checked menus. It also uses the ampersand for hot keys.

5. From the Colors cascading menu, choose Red.

Finally it shows the use of a Click event to reset the background color of the
application.

Now, the question is: How did we do all of thai?
6. Close the Startup application.
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Z To implement menus on the Startup application

1.

If Visual Basic isn’t running already, start it.

*- A new blank form should be on the screen.

2

From the File menu, choose New Project.

Start 2 new project. ‘
. Set the following properties for - form in the Properties window:
Name frmStartup
Caption Startup Applet.
Height 2860 (approximately)
Width 2670 (approximately)
Open the Menu Design window,
5. Make the following changes. ‘
Menu item Caption Name Indentation
Edit &Edit mnuEdit 0
Colors : &Colors mnuColors 1
Red &Red " mnuRed 2
White &White mnuWhite 2
Set... the Checked '
_ option.
Blue _ &Blue mnuBlue 2
- mnuSepl 1
Exil E&xit mnuExit 1
Help . &Help mnuHelp * 0
About _ &About... ‘ mnuAbout 1
Deselectthe |
Enabled option.

10.

Note Notice that the menu names include only the prefix and the menu
function, We shortened the names for this exercise to facilitate compieting the
walk through.

Choose OK.
Double-click the command button tool in the Toolbox swice.

" Add two command buttons and place them appropriately on the form.
. Set the following properties for the command buttons.

Button Name Caption
Cardfile cmdCardfile ‘ &Cardfile
PaintBrush cmdPaintBrush &PaintBrush

From the Project Window, choose View Code.
Make sure that STARTUP.FRM is in the foreground.
In the Object drop-down combo box, choose General Declarations.
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Add the following code:

L

12.

14.

i5.

16.

Conat RED = &HFF§
Const WHITE = &HFFFFEF Make sure you type six Fs.
Censt BLUE = &HFF0000 Make sure you type four zeros.

- - -"Set the hexadecimal values for the colors that you want. You can find these

colors and several others in CONSTANT.TXT.

Note There is a second method for completing the siep above: Open
CONSTANT.TXT, and copy and paste the appropriate lines into the General
Declarations section of the form.

In the Object drop-down combo box, select cmdCardfile and locate the Click
event templaie.

When the user clicks this command button, use the Shell function to start -
Cardfite in a regular window. Add the following code:

x% = Shall{"c:\windows\cardfile.exe", 1)

. In the Object drop-down combo box, select cmdPaintBrush and locate the Click

event procedure template.

When the user clicks this command button, use the Shell function to start

_ Paintbrush in a regular window. Add the following code;

y% = Shell{"c:\windows\pbrush,exe", 1}

In the Object drop-down combo box, select mnuRed and locate the Click event
procedure tempiate. Add the following code:

frmStartup.BackColor = RED
mnuRed .Checked = True
mnuWhite.Checked = False
mnuBlue.Checked = False

In the Object list box, select mnuWhite and locate the Click event procedure
template. Add the following code:

frmStartup.BackColer = WHITE
mnuRed. Chacked = False
mnuWhita.Check: : = True
mnuBlue.Checkad = False

In the Object drop-down combo box, select mnuBlue and tocate the Click event
procedure template. Add the following code:

frmStartup.BackColor = BLUE

" mnuRed,Checked = Falae

. manuWhite . Checked = Falase

17.
18.

19.
20.

mnuBlue.Checked = True

From the Run menu, choose Start and test your application.
From the Run menu, choose End.

Close the application. You may notice that the Exit and About commands are
not implemented yet. You will complete those functions in the next module.

Save the form as STARTUP.FRM in\WALKTHRINSAMPLES.
Save the project as STARTUP.MAK in \WALKTHRINSAMPLES.
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| Summary

=

= Menu Guidelines
= Microsoft Visual Basic Implementation

Objectives
In this module you leamed to: _
» Listand explain the use and value of all of the key menu elements:
e Access or hot keys
o Shoricut keys
e Menu bar
¢ Separator bar
+ Ellipsis .
s Create an application that uses at least one menu on an application window and
uses more than one form. [t should include a least one functionality menu as well

as a Help menu thai includes choices to display a simple Help form and an
About box. '
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-——— Lab.Time

e

Go to the Creating Application Menus portion of your iab manual.
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—> Overview-

.

“a Form Management

Statements
Methods
Event Procedures

= Setling the Startup Form

Overview

This module has two broad goals. First, it provides an introduction 10 the concepts
of event procedures and methods as they relate to managing the forms of your
application. Second, it reviews all the important events and methods, and therefore
1s a crucial lead-in to the controls moduies, and the general discussion of functions
and statements as they are implemented in Visual Basic,

This module also contains the first actual hands-on experience you will get in
wrilng code that will be implemented by user actions with the application interface.

Prerequisites

Prior to starting this module, you should already be familiar with these terms;
s Conuols ' .

s Forms

e Properties

Overall Objective

The primary objective of this module is to present the notion of event procedures
and 10-discuss the essential events needed to manage forms.
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Learning Objectives
At the end of the module. you will be able to:

-
n
.
]

Use the Unload statement to unload a form from memory.

Use the Load statement to load a form into memory.

Use the Show method to display a form.
Use the Hide method to hide a form but not unload it from memory.
Set the startup form.
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--—Statements

Open Project

File Name: | : B

s:\...\vb-disc\employee
Files: Directories:

employee.mak [-]
Py [text]

The Load Statement

The Load statement is used to load a form or control into memory. It normally
appears within other event prc  Jures,

Syntax Load object
Example ‘Event procedure for a contrel on Forml
Sub Commandl Click ()
Lead Form2
End Sub

important Load does not automatically display the form; it just loads it into
memory. To make the form visible to the user, call the Show method, discussed
later in this module. In some cases you may choose to preload all the forms in the
application at application startup. Doing this causes them to be displayed more
quickly when the Show method for the forms is called at the appropriate time. Of
course this technique will add to the time it takes to start your application initially.

Further Application Form Procedure/Event

Examples »
Calcutator CALCFRM Form_Load
' Cancel_Click
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The Unload Statement

The Unload statement is used to remove a form or control from memory. Unloading
-a form from memory may be necessary when the memory resources used are needed
«-for some other object or when you need 10 reset properties to their original value,
~- Another typical use for the Unload statement is in an OK button Click event for a
form like an About box. There is no reason to keep the About box form in memory,
because it is seldom used.

Note that when a form is untoaded, only the display component is unloaded. The
code associated with the forrn module remains in memory.

Syntax Unload object
Example Sub Commandl Click ()
Unlocad Forml
End Sub

End Statement

This statement ends a Visual Basic program, procedure, or block. By itself, the End
statement stops program execution, closes all files, clears the values of all vanables,
and destroys all forms.

You have seen or will see various uses for the End statement in other modules to
end portions of code. The topic appears here because you can use the End keyword
alone in code to end your application.

Syntax End [ {Function | Select | Sub | Type } )
Statement Description )
End Functioen Ends a Function procedure definition
End If ' Ends a bleck If...Then statement
End Select Ends a Select Case block
End Sub . Ends a Sub procedure
End Type Ends a user-defined type definition

More examples are available in Visual Basic Help.

Example 1 'End Statement Example

2 Sub EndDemo ()

3 Do ' 'Set up infinite loop
4 Mag$ = "Enter A, B, C, or X.r 'Enter X to exit

5 Userlnput$ = UCase${InputBox$(Msg$)) 'Gat user input
6 Select Case UserInput$ 'Evaluate input
:7‘ Case "A": Msg$ = "You enterad 'A'."

&y Case "B": Mag$§ = "You entered 'B'."

9 Case "C": Mag$§ = "You entered 'C'."

10 Case "X": End ' 'End if user entered X
11 Casa Else: Mag3 = "You made an invalid cheics.

12 ATry again.”

13 End Select

14 MagBox Msg$ ‘Display results

15 Loop

16 End Sub
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——Methods — Hide

i

EMPDB.HIDE

Employee Qatabase

Empioyee: Department;
Maria Lopez

Petar Krauss
Barbara Richardson

OPS
SAL

Symax

Example

Further
Examples

Hiding a Form

When a form is hidden, it is removed from the screen and its Visible property is set
1o False. A hidden form's conirols are not accessible to the user, but they are
available 1o the running Visual Basic application. to other applications
communicating with the Visual Basic application through dynamic data exchange
{DDE), and to timer events. .

If a form is not loaded when the Hide method is invoked, the form is loaded but not
shown, ’ _ )

[form.] Hidg

Note the optional form in the square brackets. Also note that the period within the
brackets is not optional.

The following examplie is available from Visual Basic Help.

i

1 'Hide Method Example

2  Sub Form Click ()

3 Dim Mag$ ' Daclare variable

4 Hide ! Hide form

5 Mag$ = "Choose QK to make the form reappear.”

6 MagBox Mag$ ' Display message

7 Show ' Show form again

8 End Sub .

Application Form Procedure/Event

Menu M - IN.FRM mnuAppMgr_Click
mnuEditor_Qlick
mnuNum_Click

mnuToDo_Click
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Walk Through — Hide vs. Unioad

Z To see the difference between Hide and Unload

1.

From the Walk Throughs program group, start Hide vs. Unload.

'When the application starts you see two forms. Form1, on the left, contains two

buttons: one to show Form2, the other to unload Form2.

Form?2, on the right, contains nine buttons, Command1 through Command8, and
a button labeled Hide Form2. The eight command buttons were placed on the
form to make sure that Form2 uses enough memory and Windows resources 10
illustrate the poinl.

The purpose of the application is to demonstrate the difference of the impact on
memory and Windows-based resources when hiding a form versus unloading it.

. Click the Hide Form2 button.

This hides the form. - o

. In Program Managef, choose About Program Manager from the Help menu.

From the Help menu in Prograr. “anager, choose About Program Manager.
Note the values for the two lines at the bottom of the form for amount of
Memory and System Resources free.

. Choose OK.

Close the About Program Manager dialog box.
Press CTRL+ESC to display the Windows Task List.

6. Double<click Hide.

10.
“',
1.

. Click the Unload Form2 button.

Unload your Form2.
In Program Manager, choose About Program Manager from the Help menu.

Note the values for the two lines at the bottom of the form for amount of
Memory and System Resources free.

Now that Form2 has been unloaded, not just hidden, you should see more
memory and/or resources available. The amount will vary depending on your
machine's environment.

Choose the OK button.

Close the About Program Manager dialog box.
Press CTRL +ESC.

Select Hide from the Task List.

Click the End Task bution.

Terfninaie the project.
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- EMPDB. SHOW

Employee Database

Employee: Department:
Maria Lopez

Peter Krauss
Barbara Richardson

.| OPS

Syntax

Example

Further
Examples

Showing a Form

Show is used to display forms that have been loaded. If you use the Show method
on a form that has not been loaded, the Show method will auomatically load the
form and then show it '

{form.] Show {style%)

Note The siyle% parameter is an integer value that determines whether the form
is modal or modeless. If style% is O, the form is modeless; if style% is 1, the form is
modal.

Users must respond to a modal dialog box by clicking any one of a number of
buttons. Any dialog box that lets the user continue working with other forms in the
application is a modeless dialog box.

This example is available from Visual Basic Help.

1 '*Show Method Example
2 Sub Form Click ()
3 Dim Msg$ : ' Dec:are variable
L I Hide ' Hide form
5 Mag$ = "Choose OK to make tha form reappear.”
6- MsgBox Mag$ ' Display message
7 Show ' Show form again
8 End Sub
Application Form Procedure/Event
Hello GETSTART FRM mnuButerfly_Click
' " mmuHello_Click

mnuScroilbar_Click
mnuShell_Click
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Walk Through — Connecting Forms in Startup
z _To run the STARTUP.MAK project
. 1 _.If Vi_sﬁa_l Basic isn’t running already, start it.
i A new blank form should be on the screen,
2. From the File menu, choose Open Project.
3. Open STARTUP.MAK.

" This should be Iocaleﬂ INWALKTHRINSAMPLES. Load the code, but do not
run the appiication yet.

4. From an MS-DQS prompt copy ABOUT.FRM from \STUDENT NABOUT 10
\WALKTHRINSAMPLES.

5. From the File menu, choose Add File.
6. Choose ABOUT.FRM,
7. Choose OK.

This adds ABOUT.FRM to the .MAK file for the Startup application.
8. Select STARTUP.FRM in the Project Window and choose View Code.
9. In the Object list box, select mnuAbout.

Go to the Object list box and locate the template for the mnuAbout_Click event.
It should be empty.

10. Add the following code:
frmAbout . Show 1
Add the code that will show the About box when the user selects the Help menu

and the About command. Remember the | causes this form to be modal. Notice
the symax here? FormName.Show. :

Important  You might be tempted to use the Load statement to display the
frmAbout form, but you will find that won't work here. Loading a form only
means that it is in memory. It doesn't mean that the form is actually displayed on
screen. For that you need to use the Show method.

11. From the Run menu, choose Start.
Start the application to test the result.
12. Open the Help menu and choose the About command on the Startup application.
) ’I‘h_e,Aboul box from the lab appears on screen.

" Note ~You will need to now change the Caption property on the About box
form as weil as the Icon and Text properties on the tabel to fit the current
application.

13, Choose OK.
Try (0 choose the OK button on the About Box form.
You haven't coded that yet.
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14,
15. Select ABOUT.FRM.

16
17.

18,

19,
20.

21.

22,

23.

24.

25.
" appropriate code there.

26
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From the Run menu, choose End.

Select the ABOUT.FRM file in the Proj_ect window,
Choose View Code.

‘Bring up the Code window.

In the Object list box, select cmdOK.

Locate the code template for the cmdOK_Click event procedure. -
Add the following code: '
Unload £rmAbout

Add that code on the blank line in the template.

Notice the syntax here? The Unload statement comes first, and the object name
follows. Notice.also that there is no punctuation.

From the Run menu, choose Start.

Start the application again to test the succéss of your changes.

Open the Help menu and choose the About command on the Startup application
This should display the About box.

Choose OK.

Choose the OK command button on lhe-About box, and it disappears from the
screen.

Now the question is what do you do to end or close the application itself?
From the Edit menu, choose Exit.
Try exiting from this command.

In order to close the application entirely, you still need to make one more change
to the source code.

Note This placement of Exit is not standard for Windows. *n application that
follows interface guidelines for Windows would place Exit a» ihe last item on
the File menu.

From the Run menu, choose End.

Stop the application.

Select frmStartup in the Project Window and choose View Code |

In the Obiect list box, choose the Exit menu Click event procedure, and place the

Add the following code:

End

Put this code on the blank line in the template.
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27.

28.
2.

From the Run menu, choose Start.
Test the Exit command on the Edit menu, and test the About box elements,
From the Run menu, choose End.

‘From thé File menu, choose Save Project.

Save this project as STARTUP.MAK in \WALKTHRUNSAMPLES.
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—Event Procedures

e

) . EMPD.FRM
| Object: [Form I# Proc:[Load F 1|

Sl-.lb Form_Leoad [)
Forml.Left = {Screen.Width - Forml.Width) / 2
Forml.Tep = (Screen.Height — Forml.Height) / 2 §

End Sub

Syntax

Event Proceddres

An event procedure is defined as a procedure invoked by a user or system-triggered
event. Event procedures are always aitached to a given form or conwol, and the
syniax for an event procedure looks-like the following:

Sub objectname_eveniname
statementblock
End Sub

Examples of event procedures are: Command1_Click and Form_Click.

Loading a Form

A Form Load event occurs when a form is loaded. it normally occurs when an
application is run or as the result of either a Load stalement or an implicit load that
is caused by any reference (0 an unloaded form's properties or controls.

Typically you place initialization code for a form in a Form Load event procedure.
For example, you would specify default settings for controls, initialize the contents
of a combo or list box, and initialize form-level variables in a Form Load event
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Syntax

Example

Further
Examples

Sub Form_Load ()

Tnitialization code
End Sub .
oL B
1  Sub Form Load {)
2 ' Center the form on the screen
3 Forml.Left = (Screen.Width - Forml.Width) / 2
4 Forml.Top = (Screen.Height - Forml.Height) /2
5 End Sub

Unloading a Form

An Unload event happens when a form is about to be removed from memory. When
that form is reloaded. the contents of all the controls are reiniualized. Normatly, this
event is triggered by a user action, by choosing Close from the Control menu or by
an Unload statement.

Many times the Form_Unload event procedure contains a Select Case statement to
verify that unloading should proceed or to specify actions that need to be taken prior
10 unloading.

Sub Form Unload (Cancel As Integer)

End Sub

Complete information on the Unload event is available from Visual Basic Help.

Application Form Procedure/Event
Menu APPMGR FRM mnuDeiApp_Click
~ mnuExit_Click
EDIT.FRM mnuClose_Click
_ mnuExit_Click
NUMSYS FRM mnuExit_Click

TDABOUT FRM Command1_Click
TODOFRM . mnuEdit_Click
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. Sefting the Startup Form

I Projert Options

ek 20T

Setting the Startup Form

If you have a multiple-form application, by default the first form you create will be
the startup form, It is easy to make another form the startup form as you will see in
the demonstration.

Walk Through Serhng ’rhe Staﬁup form
Comment

Z To set the startup form
1. Start Visual Basic.
2. From the File menu, choose Cpen Projécl.
Locate EMPLOYEE.MAK in\SOLUTION\FORMS.
3. EMPLCYEEMAK.
Load the Employee Database application into the Project window.
4. From the Options menu, choose Project.

5. Choose the Select Startup Form option, and press Lhe drop-down arrow on the
combo box at the top.

6. Select frmEmpDB from the list.
7. Choose OK.
Set the startup form.
8. Save the project.
9. Quit Visu.. Basic. )



104 Module 5: Connecting Forms

summary

*a Form Management

Statements
Methods
Event Procedures

= Setting the Startup Form

Objectives
In this module you leamed to:

Use the Unload staternent to unload a form from memory.

Use the Load statement (o toad a form into memory.

Use the Show method o display a form.

Use the Hide method 10 hide a form but not unload it from memory.
Set the startup form.
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_____LabTime

te

Lab Time
Go 10 the Loading and Unloading Forms portion of your lab manual.
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be

ZMOverview

= Types of Controls
» Properties for Controls

Overview

The purpose of this module is 10 make sure that you understand the general
purpose of controi properties and events as well as the essential properties for
each of the controls in the Toolbox.

This is not intended 10 be a comprehensive treatment of all the possible properties
and events for ail of the controls. In addition, this module covers only half of the
total number of controls in Visual Basic. The module following this covers the
other half.

The general approach here is to let you practice changing the properties for each
control and actually see how the change affects the controi.

Prerequisites ,

Prior to starting this module, you should have a fundamental awareness of:
» The functionality of Micro- ‘1 Visual Basic

a The general use for each of the controls in the Toolbox

w The general methods for setting properties on controls
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‘e

Overall Objective
At the end of this module. you will be able to use key properties on half of the

controls located in the Toolbox.

‘Learning Objectives

At the end of this module, you will have set key properties for:
w Labels

s Text boxes

s Frames

» Command buttons

. C_heck boxes

s Option buttons

» Combo boxes

s List boxes

s Horizontal and vertical scroll bars
s Timers

s Picwre boxes
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———Types of-Controls

e

- Pointer F;_ Picture Box
Label I;% Text Box
- Frame ™| G Command Button
Check Box §®{@®] Option Button .
Combo Box |EBiEgi| List Box
Horizontal Scroll Bar |erif i} §| Vertical Scroll Bar
Timer =]| Drive List Box
Directory List Box File List Box
Shape ~| Line
Image Data Control -
Custom Zontrols {*.VBX)

This module covers the various clusters of controls found in the Toolbox, their
most commonly used properties, and the events that are normally used with them.
One of the first things you will see is that many of the controls have the same
kinds of attributes. In many cases, a property wiil be covered only once, even
though it shows up with almost every control.

Controls will be discussed in order of placement in the Toolbox, with the
exception of the picture box, which will be covered last, and the drive, directory,
and file list boxes, which will be discussed in a separate module.

A good way to get a handle on properties as they relate 1o controls is to {ook at
the very front of the Microsoft Visual Basic Language Reference. There you can
find a comprehensive list of controls and their properties.

Adding Controls to The ToolBox

The graphic on this page displays the default ToolBox. You can add controls o the
Toolbox.

To add a custom controt to the Toolhox
1. From the File menu choose Add File,
- The Add File dialog is displayed.

2, From the Add File dialog, locate the custom controt file that you want to add.
For example, locate the file THREED.VBX. This file should be in the
CAWINDOWS\SYSTEM directory. This is a custom control provided by
Visual Basic.

3. Select the file THREED.VBX and choose OK.

The new controls are added to the Toolbox. You may get an error message if
THREED.VBX has already been added to the Toolbox.

4. Use this same process to add any custom control to the Toolbox.
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Y. Properties for Controls

= Labels, Text Boxes, and the Masked Edit Text Box

" = Regular and 3-D Frames, Check Boxes, and Option
Buttons

» Regular and 3-0 Command Buttons
« Combo and List Boxes
-« 'Horizontal and Vertical Scroll Bars
= Timers
= Picture Boxes
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- labels and Text Boxes

Labell

Labels and Their Common Properties

Labels are most commonly used to display text that you don't want the user 10 be
able to change. Typically this would be a caption under a graphic or captions for
drive, directory, and file list boxes.

Default

Property _ Comments

Alignment 0 - Left Justify

AutoSize False Determines whether a control adjusts 10
fit its contents.

BackColor White '

BorderStyle 0 - None

Caption Labell Title for the control on screen. The
caption is the default propeny for this
control, Syntax—Labell = "Files"

FontName Helv

FontSize 8.25

ForeColor Black

Height 500 In twips.

Left - From left border of form.

Name Labell Name used in code.
Use I as a prefix.

TabIndex Assigned by Visual Determines the 1ab order of the tabel.

Basic
. TabStop True Determines whether use can use Tab key

to move to the lext box.

Tag - User-defined value.

Top - . From 1op border of form.



14 Module 6: Using Controls

Text Boxes and Their Common Properties

A text box control displays either information thai is provided by the application
or.information that the user can type.

Typical-uses-of text boxes would include the box where users type the string of
characters they want the application to find in a search function. If you were
creating a front-end for a database, you could use a sequence of text boxes (o
gather information about members of the database.

Property Defauit Comments

Alignment 0 - Left Jusufy

FontName Helvy

FoniSize 8.25

Height 500 In twips.

Left - From left border of form,

MaxLength 0 - Controls amount of user input. Ranges
from 0 to 64 characiers.

Multiline ‘ False Means no muitiline capability.

Name Textl Name used in code.

. Use txt as a prefix,
PasswordChar Specifies the character to be displayed
: ‘ when user types text in the text box.

ScrollBars 0 - None '

Text Textl For none, assign ", This is the default
property for the controi.

: Syniax—Text]l =""
Top From top border of form.

Width Width of text box,

LN
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Walk Through — Text Box with a Scroll Bar

L

Z To use the text box with a scroll bar

.,

From the Walk Throughs program group, start Text Box with a Scroll Bar.

. When you start the application, you will see a form with a text box with a

vertical scroil bar in the center of the form.

The purpose of this application is 10 demonstrate the behavior of a text box
with a scroll bar and how to create a text box with a scroll bar.

. Type some text into the text box.

Type enough text into the text box to cause it to start scrolling. Notice that the
text will aytomatically wrap at the right margin. Notice also that you can
select text and then cut and paste it just as in a standard Windows-based text
box. Use CTRL+C Lo copy, CTRL+V (0 insert, CTRL+X 10 cut and CTRL+Z to undo.

Doublelick the Conirol menu.

Close the walk through.

Start Visual Basic.

Double-click the text box ool in the Toolbox.
This will create a text box control.

. Inthe Properties window drop-down combo box, make these changes:

7Helghl 1000 (approximately)
ScrollBars 2 - Vertical

Set the ScrollBars property to 2 - Vertical. Notice that you don't see the
control change. There's a litile problem here. Setting the ScrollBars property
for a text box only becomes effective if the MuluLme property for the text box
is also set to True.

Set the MultiLine property to True,

Notice that a vertical scroll bar now appears on the text box.

From the Run menu, choose Start.

Test the behavior of the text box to see if it behaves as it did in the demo.
From the Run menu, choose End.

Close the application.
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Masked Edit Control

Masked Edit Control

This control is a special form of the text box control. It is used to restrict user input
as well as 1o format data output.

Mask characters Description

Decimal placeholder
. Thousands separator
Time separator
Date separator
Treat next character as a literal
Character placeholder
Alphanumeric placeholder
Letter placeholder ¢
Digit placeholder

Walk Through — Validating User Input

)y To monitor user input with the masked edit control
.1, From the Walk Through program group, start Masked EdiL.

i - T

+*

The purpose of this walk through is to demonstrate one of the routine uses of the
masked edit control —displaying a text box that prompts for and monitors the
correctness of a user-added telephone number.

2. Type a welephone number.

Notice that the use of the parentheses and the underlining prompis the user on

. the type and amount of information to be typed. Notice also that the masked edit
text box automatically tabs the cursor 10 the next control as you type the
telephone number.

3. Close the application. N
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: Z To create the application

1. Start Visual Basic.

2. Resize the form and set its properties as follows:

) _Heig,hl 2850 (approximately)
Width 4560 (approximately)
3. Place a label control at the top of the form and set its properties as follows:
Alignment 2 - Center |
.AuIOSize True
Caplion Customer's Telephone Number

4. Place the masked edit control in the center of the form and set its properties as
follows:

Mask (#54) Hht-iHHH
Width 1635 (approximately)

Visual Basic calls the parentheses and the hyphen "literals.” They are the visual
. cues that tell the user the type of data that is expected, and you type them as part
of the input mask. The number signs (#) are called “digit placeholders,” and they
specify that a digit is required. As you have seen, when you run the application,
 the control places an appropriate number of underscores that tell the user the
total number of character-  the number as well as the user's relative position
- within the number. :

5. From the Run menu, choose Start.

Test the behavior of the masked edit control o see if it behaves as it did in the
demo, ’

6. From the Run menu, choose End.

ValidationError Event

If a user types an invalid character, a ValidationError event occurs. You can place
code in the ValidationError event o display an error message. For example, you
might want to beep if the user types an invalid character.

1. Place the following statement in the MaskedEdit1_ValidationError event:

Beap

2. From the Run menu choose Start. Type a letter in (he masked edit field.

The system beeps.
3. ‘Save the form and .MAK file with appropriate names in
 \WALKTHRU\SAMPLES.
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Reguiar and 3-D Frames Check Boxes, and Option
Buttons

"

Frame{——— R}
@M . BJ Check1
(O option2 D Check2

O A 108 OB PAOS505

The frame, check box, and option button controls provide a way to present users
" with a set of opuons from which they ¢an choose,

For example, if you start the Solitaire game in Windows, then open the Game
menu, and then choose Options, you will see a dialog box that contains two sets
of option buttons. Inside the frame labeled Draw are the options affecting how
many cards are drawn. Inside the other frame labeled Scoring are the options that
affect how the game is scored. The arrangement on the screen and the use of
frames tell the user and the system thai these are independeni groups of option
buttons. A choice made in the Draw group will not affect the Scoring group, and
vice versa,

Frames and Their Common Properties

Frames provide a means for graphically and functionally grouping controls.
Frames are most commonly used to group two or more opuon buttons in a set of
mutually exclusive choices.

Note Information presenied in frames and option buttons can also be presemed

' m drop-down list boxes.
Property Default Comments
Caption ' Framel On screen label. This is the default
property for this control.
Syntax —Frame = " Definitions"

Name - Framel . Name used in code,
' Use fra as a prefix.

Visible True False hides the frame and any controls
inside it.
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Caution When Placing Controls on Frames

There are two methods for placing controls on a form. The simplest method is 10

double-click a control icon. An instance of the control will appear in t=2 center of

the form, and you can position the conurol from there. This is a particu:arly useful
*approach when you are placing several controls on a single form.

The second approach is to single-click a tool in the Toolbox, move the cursor to
the form, and drag the control on the form until it is the size you want. This
second method is required for placing conirols on a frame. If you do not use this
method, you will lose the controls when you try 10 move the frame around on the
form.

3-Dimensional Frames

Added property Default Comments

Alignment 0 - Left Justify You canrnot center- or right-justify frame
captions with the other controls.

Caption This is the default property for this control,

: Syntax—Framei = "Definitions"

Foni3D 0 - None Sets the amount and direction of shading in
the Caption.

Name Frame3D! Name used in code.

Use fra as prefix.

Check Boxes and Their Common Properties

Property Default Comments

Caption Checkl On-screen value.

Enabled True False disables all user access.
Name Checkl Name used in code.

Use chk as a prefix.
Value 0 - Unchecked 1 - Checked; 2 - Grayed.

(Fiils box with gray). This is the defauit
. property for the control.

Visible True False hides the check box.

Events Click Normally a Click event indicates that the user has made a selection. In the
case of a check box, the Click event acts as a toggle. If there is an X inside the
check box when the user clicks it, the X will be removed. If the check box is
empty, an X will be placed inside the check box after the user clicks it. In either
case, the Value property will be reset. A typical use of a check box might be 10

-~ allow the user to choose beiween bold or normal font.
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Opticon Buttons and Their Common Propetties

Style
Guidelines

Events

Option buttons, as noted previously, are used to display an array of choices from

~ which the user may select only one. An example is found in the Microsoft

Windows Write Print Setup dialog box, where the user can select either the

-*.default printer or a specific printer and either porirait or landscape page

orientation.
Property * Default Comments
Caption Optionl On-screen value.
Name Option} Name used in code.
Use opt as a prefix.
Enabled ~ True . User has access to control.
Value False This is the defauit property for his control.

Syntax— QOptionl = False

Always have one option button in a group selected as the default for the user
when the form is displayed.

Click When the user clicks an option button, the Click event actually invokes
several activities. It paints the dot on the selected option button, removes the dot
from any other option button within the frame, and resets the appropriate values
for ail option buttons in the same group.

Waik Through — Option Buttons and Displaying
Their Values _ '
To compare the effect of the Click event for a check box versus an optiop
button

1. From the Walk Throughs progfa.m group, start Check versus Option.

When you start the application, you will see a form with three option buttons,
two check boxes, and a clear screen button on the right side.

The purpose of this application is to compare the effect of the Click event for
a check box versus an option button.

2. Click the Optionl option button.
The values for all three buttons should be displayed on the left side of the form.
3. Click the Option2 option button.

The updated values for all three buttons should be displayed on the left side of
the form,

4. Click the Check! check box to place an X in it.
The value of Checkl.Value is printed on the form.

Compare the number that is printed for the value of a check box when it is
selected (1) to the value that is printed for an option button when it is
selected (-1).
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S.

Click the Check?2 check box to place an X in it.
The value of Check2.Value is printed on the form.

Compare the effect of the Click event for check boxes versus option buttons.
Clicking one option button affects the state of the other option buttons in its

~group. Clicking a check box will not affect the state of other check boxes.

Double<lick the Control menu.
Close the walk through.

Z To code values for option and check boxes

1.
2.

el B A

10.

11

12.
13.

If Visual Basic is not running already, start it.
Doubie-click the frame control tool in the Toolbox.

Add a frame to the form. Click and drag the sizing handles to make it big
enough to hold three option butions. Place it near the lower-right corner of the
form so that there is plenty of room 10 dispiay the values for the three option
buttons you will add. '

"Click the option button tool in the Toolbox.
 Move the mouse over the frame you just created on Form1.

Note that the mouse pointer has changed from an arrow (o a cross hair.
Click and drag inside the area of Frame1 to draw an option button there.
When the button is the size you want, release the mouse.

Draw two more buttons inside Framel.

Double-click the top option button.

This displays the FORM1.FRM Code window with the Opnonl Click event
procedure template.

Add the following code:
Print "Optionl.Value = "; Optionl.Value
Print "Option2.Value = "; Option2.Value

Print "Option3.Value = "; Optionld.Value

This adds the code that priﬁts the values for the buttons.

[n the Object list box, select Opnonz and locate the Click event template from
the Procedure list box.

Add the following code:

Print "Optionl.Value = "; Cptionl.Value

~ Print "Option2.Value = "; Option2.Value
Print "Option3.Value = "; Orzion3.Value

This adds the same code that prinis the values for the buttons o the Click
event for Option2.

Using the Copy command, place the code-above into the Clipboard.

In the Object list box, select Option3 and locate the Click event template from
the Procedure list box. )
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14. Using the Paste command, copy the contents of the Clipboard to this event
procedure template.

"

The code should look like this:
Print "Opticonl.Value = "; Optiecnl.Value
. ,Pr:Lnt "0pt1on2 Valua = "; Cpticn2.Value

Print "OpuonS Valua = "; Cptienl.Value -
This adds the same code that prints the values for the buttons to the Click
event for Option3.
15. From the Run menu, choose Start. |
Test your code.
16. From the Run menu, choose End.
Close the application.
17. Quit Visual Basic.

3- Dlmenslonal Frames Option Buﬁons and
Check Boxes

For the most part, these “~ree controls are identical to the three controls just
discussed. However. th  :re a few subtle differences that need to be noted as well
as the procedures for setung the 3- D qualities for these controls.

3-Dimensional Ophon Buttons and Check
Boxes

Added property Defauit Comments

Name (fdr check Check3D1 Name used in code.

boxes) ‘ : Use chk as a prefix.

Name (for option Option3D1 Name used in code.

buttons) : . Use opt as a prefix. -

Fon3D 3 - Inset with Light Sets or returns the ﬂn'ee-dunensmnal style
Shading of the caption, For example, you can set

Font3D to have font appear raised or inset
with light or dark shading.
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Regular and 3-D Command Buttons

(oo

Style
Guidelines

Events

Command Buttons and Their Common
Properties

A command button performs a task when the user presses it.

Property Default Comments
Cancel False _True—button activated by ESC.
Caption Command! On-screen value.
Default False . True—button activated by ENTER.
Enabled True False disables the button for users.
Height - 500
- Left - From left border of form.
Name Commandl Name used in code.
. Use emd as a prefix.
Top - From top border of form.
Width 1215 wwips
Value Syniax—Commandl = Enabled

Place buttons in a group on a form, either horizontally along the bottom of the

form, or vértically along the right side of the form.

Click With command butions, a Click event normally means that the user wants’
some kind of action 10 take piace. In the case of an OK button, for example, users
might want a form removed from the screen so that they can continue work. In
this case, you will be providing code.
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Example

.

When the user uses the mouse pointer to choose a command button, the Click
event-changes-the color of-the-button-(to simulate-its-being pressed)-and executes
whatever code you have added to the Click event procedure. A user can also use

. the keyboard to generate a Click event for a button by 1abbing to the bulton and
_ then pressing the SPACEBAR.

Sub Commandl_Click ()
' Stop all execution of the program
End

End Sub

3-Dimensional Command Buttons

“This form of the command button behaves in much the same manner as the other
command buttons, but there are a couple of interesting differences.

Property Default Comments
Bevel Width 2 Specifies the thickness of the highlight and
shadow around the button. Valid range is
) from Oto 10.
Name Command3D1 Name used in code.
~ Qutline ’ True False disables the border or line edging the
‘ button.
Picture " None - Enables placing a picture or icon on a

command buttorn.
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Combo an

[ B

d List Boxes

0 -'Drop-down Combo Box 1 - Simple Combo Box

Ty
2200R0DNR 00t o] oo otoittattiinns osopoeitd

List Box 2 - Drop-down List Combo Box

There are actually four kinds of list box controls, each of which has a slightly
different functionality.

Both drop-down styles of boxes are designed (0 save on the initial amount of
screen space in use by the control.

Users can only add new ilems directly into either a drop-down or simple combo
box. With a list or drop-down list, they are limited to the choices provided by the
application. '

List Boxes and Their Common Properties

List boxes display a list of items from which the user can select only one at a
time. Through the list box control, users can only select from the given list of

- articles, bul you can write code that allows them to add and delete items duning

run time through some other control.

- Automatic Scroll Bars

All list and combo boxes will automatically add a vertical scroll bar if the number
of items contained in the list is greater than what will fit in the maximum display
size of the control, which is set by the Height property. 7{

: I’_;opef‘i_:y . Default Comments _
Columns Defauit Enables multiple-column display of daaina
single list box. .
- List . Accessible only at run time. Sets or returns the

. items contained in a controi’s list string array.
ListCount Returns the number of items in the list.
ListIndex Retwrns the index of the selected item in the list.
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Property Default Comments

Events

Methods

2

MutliSelect v - None. Other options: 1 - Simple and 2 - Extended. None

means that the user can select one within the list,
Simple means user can select multiple items
o — using the cursor. Extended means user can press
. CTRL to select multiple items.

Name Listl Name used in code.
Use Ist as a prefix.
Soned : False
Text This is the default property for this control.

Syntax—Listl = "Item1"

Click  With any of the list boxes, a Click event occurs when users select an item
from the list to indicate their preferences.

DbIClick A double click normally is used s a shoricut that combines two
actions: the selection and the starting up of a process.

These are used for list management.

Name Function Syntax

Additem Used to add individual items 1o Listl.AddItem "name"

list box. Seeding a list box is
done from Form_Load.

Removeltem Used to remove ilems one at a Listl.Removeltem (Listh"tint)
time from a list box.

Clear . Used to remove all items inalist  Listl.Clear
box in one sroke.

Walk Through — Adding and Removmg Llst
items

To add and remove list items

1.

From the Waik Throughs program group, start List Box.

When the application starts up, the cursor should already be placed in the text
box.

The purpose of this application is to demonstrate a simple procedure for
adding items to and removing items from a list box.

Type Harwood, Gene in the text box.

: Add a new name in the text box.
‘Choose Add. '

You can do this wuh either the mouse or the ENTER key
Select the text box
Tab to or click the text box.

. Type Simons, Anna in the text box.

Add a second name to the list box, and a vertical scroll bar should appear on
your display.
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=

Choose Pfeiffer, Terry.
Single-click this list item.
Click the Remove button.

-. The list item is removed from the display.

The question here is this: How does all of this work?

Z To code list box handling

1.
s

If Visual Basic isn't running already, start it.
From the File menu, choose New Project.

Note If you want to do all of the work for this walk through, go to the next
step and start changing the properties for the form. If you want to start from a
completed interface, you can also find a partially completed form called
LIST. MAK in \WALKTHRUNSAMPLES. [f you choose this option, skip
down 10 step 12, the point where you start adding code to the Form_Load
event.

Set the properties for the form as follows:

Caption Consultants

Name Forml

Height 3075 (approximately)
Width 3420 (approximately)

. Double-click the list box_ tool in the Toolbox.

Add a list box to the form.

. Set the following properties:
Name List1
Height 1005 (approximately)
Sorted False
Width 2775 (approximately)
Double-click the text box tool in the Toolbox.
Add a text box 1o the form.
. Set the following properties:
Name Textl

‘Height. 555 (approximately)

.- Tablndex 1
Text Blank
Width 2775 (approximately)

Double-click the command button tool in the Toolbox.
Add a command button 10 the form., '
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i

L1,

13.
14.

15.

16.

LA

18.

19.

-Caption Add —

Set the following properties (o create an Add button.

Name Commandl
Def ault True

' Height 555 (approximately)

Width 1215 {approximately)

10. Double-click the command button tool in the Tooibox.

Add a second command button to the form.

Set the following properties to create a Remove bution.

Caption Remove

Name Command2 .
Height - 555 (approximately)

Width 1215 (approximately)

Now that you have created the interface, you need 10 add the code to make it
function. /

. In the Project window, choose the View Code button.

Make sure that the Form is selected.
In the Object list box, select Form.
In the Procedure list box, select Load.

Add the initialization code that loads the names into the list box when the form
is loaded at run time.

' Fill the list box at run time
Lisrl, AddItem "Morton, Joan®
Listl.AddItem "White, Don"
Listl.AddItem “Marshall, Lynn"
Listl.AddItem "Pfeiffer, Terrcy"

In the Object list box, select Command] and locate the Click event procedure
in the procedure list box.
Add the following code:

Listl AddItem Textl.Text

This code takes whatever is in the Text property of the text box and adds it to
the list box.

From the Run menu, choose Start.
. Run your application.

Type Harwood, Gene in the text box.

Type Gene Harwood's name in the text box and press ENTER or click Add. His
name should be added to the list box but not deleted from the text box.

From the Run menu, choose End.

In order to clear the text box, you need 10 add a second line to the Click event
procedure here,
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20.

Add the following code to Command!_Click;

Taxtl,Text = "

* This takes care of the simple addition of items 10 a list box.

(1]
—.

22

23.
24.

25,

26.

27.
28.

. From the Run menu, choose Start.

Try adding Gene Harwood's name one more time. [t should work just fine, but
what about removing it?

From the Run menu, choose End. _

Removing items from a list box is fairly straightforward.

In the Object list box, select Command2 _Click.

Add the following code:

List].RemoveItem Liscl.ListIndex

This code removes the item indicated by the value of List1.ListIndex. The

Removeltem method removes items one at a time. With small lists, this might
be suitable. With larger lists, you would use the Clear method.

The above code will cause an error if no list item is selected. You can avoid
this by modifying the code as follows:

If Listl.ListIndex = =1 Then
magS = "Please Select a Consultant”
MagBox mag$, 64, "List Selection®

Else n
Listl.RemoveItem Listl.ListIndex

End If

From the Run menu, choose Start.
Add and delete a coupie of names to see that the code works.

From the Run menu, choose End.
Close the application.

" How about sorting this list? Don't you have to add a lot of code to sort the
-items in the list? No, you don't! You simply set the Sorted property to True

for List1, and all items inserted in the list will be sorted automatically.
Close the Code window.

From the Properties list box, select Sorted for the list box.

Click the List! list box on the form.

) Set_ the Sorted property to True.

29.

30..

31

From the Run menu, choose Start.

Note that the names in the list are now sorted. Add and delete a couple of
names to see that the sorted order of the list is maintained.

From the Run menu, choose End.

Close the application.

Save your form and .MAK files with appropriate names in
\WALKTHRINSAMPLES. You can overwrite the file if it already exists.

‘
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Walk Through — Combo and List Box -- -

2

L

Differences

-To add entries to combo and list boxes
e l :
2.

From the Waik Throughs program group, start Combos.

Type Fred in the drop-down combo box. .
If you press the DOWN ARRCW key, the list of names is displayed.
Press ENTER.

The name Fred is added to the list. If you add several more names, a vertical
scroll bar is also added to the list. '

Type Natasha in the simple combo box.

5. Press ENTER.

The new name wiil be added to this list. Notice here that the scrolt bar is aiso
added.

Select the name Larry in the drop-down tist box.

This name appears in the box at the top of the list, but users cannot add items
to the list directly.

. From the Control menu choose Close.

Close the application.
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Combo Boxes and Their Common Properties

Property Default Comments
Name ‘ Combol ‘ Narne used in code.
T R Use cbo as a prefix.
Siyle 0 - Dropdown Combo 1 - Simple Combo
2 - Drop-down List
Text Combol
Height 300 _ Simple combo—The height displayed
’ both at design time and run time,
Drop-down—Set height propenty at
design time (of run time), but full height
will not be displayed until the user
drops down the list at run time.
Text : This is the default property for the
control.
Syniax—Coembol = "Natasha"
Events - Change A Change event indicates that the contents of a control have changed.

1 combo box. a Change event occurs whenever you edit the text box portion of
uie combo box or when you assign a new value to the Text property from code.

Drop-Down and Simpie Combo Boxes

Drop-down combe boxes are an alterative to option buttons within frames; that
is. "~ v are designed to display a limited number of logically arranged choices
frc... which the user may select one. A classic example of a drop-down combo
box is found in the Windows Control Panel. From the Settings menu. the user can
choose Ports and then set the baud rate for the modem at any one of eight possible
values. or type a value into the text box portion of the control. The new value
typed can then be added to the list. The drop-down combo box enables a
scrollable list that allows the user to review more choices than can be easily
presented on screen. The user's choice is displayed in the top box.

Drop-Down List Combo Boxes

Drop-down list combo boxes are used 10 present users with a limited number of
choices, from which they may select only one.

Key Feature ,

Both drop-down combo and drop-down list combo boxes display data from which
the user may select only one choice. But with a drop-down list users can only
select from the list; they cannot add to it.
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—S¢roll Bars

Scroll Bars and Their Common Properties

Scroll bars are most commonly used to enable quickly moving across a long list
of items, such as a long list of filenames. They can also be used for indicating the
current position on a scale, such as shades of coloring for customizing the look
and feel of the screen. Or, scroll bars might be used to indicate the volume of an
audio system,

Property Default Comments
LargeChange 1(1-32,76T) Amount of change when user clicks scroll
bar shaft. .
Max 32,767 Maximum value of scroll bar handle in
botiom most position.
Min 0 Minimum value of scroil bar handle in
topmost position. -
Name HScrolll Name used in code.
-~ Use hsb as a prefix.
Vscrolll Name used in code.
. . Use vsb as a prefix.
SmailChange 1(1-32,767) Amount of change when user clicks a scroll
oo ArTOw. .
Value 0 This is the default property for this control.

Can be set by user's direct interactionl with
the control or through code in response to
other evenis.

Events Change Occurs when the contents of the control have changed.
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Walk Through — Scroll Bars, Properties, and the
Change Event

Y _To see scroll bars, properties, and the Change event
* 1. Fror the Walk Throughs program group, start Scroll Bars,
You will see a form with a vertical scroll bar on it.

The purpose of this application is to demonstrate the behavior of a scroll bar
and the effects of the properiies LargeChange and SmallChange on the Value

property.

2. Click the arrows on both ends of the scroll bar.
Note the change in the Value property.

3. Click on the shaft of the scroll bar both above and below the scroll box.
Note the change in the Value propenty.

4. Close the application.

5. Start Visual Basic.

6. From the File menu, choose New Project.
Start a new project.

7. Set the following form properties in the Propenies window:
Height 4425 (approximately)
Width 5430 (approximately)

8. Double~lick the vertical scroll bar 100l in the Toolbox.
Add a vertical scroll bar and change some of its properties:

\ Height 3495 (approximaiely)
LargeChange 20
Max 100
SmallChange 10
Width 375 (approximately)

9. In the Project window, choose the View Code buuton.
Make sure that Form1 has been selected.
10. In the Object list box, select VScroll_Change.
Locate the Change event procedure for the vertical scroll bar.
11. Add the following code:

~.- Print "WScrolll.Value = "; VScrolll.value

Display the Value propeny each time it changes.
12. From the Run menu, choose Start.
Test the application you have written.
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Timers

Timers and Their Common Properties

Timers are used o run events at a specific ime or within an interval that you
specify. For example, within a scheduling application, timers would be used to

enabie alarms for the user.

A special characteristic of this control is that it is never visible at run time.

Property Default Comments
Enabled True This is the default propenty for this
control.
Syntax —Timerl = Enabled
Interval 0 Countdown inierval for the timer,
‘ measured in milliseconds.
Name Timerl Name used in code.

Use tmr as a prefix.



Module é: Using Controls 137

Walk Through — Clock Appllcohon and the

Timer Control

’ szo use the timer control

-"1: - From the Waik Throughs program group, start Clock (Timer).

When you start the application, you will see a form containing a digital clock
displaying the date and time. The clock will be updated every second.

The purpose of this application is to demonstrate the behavior and use of a
timer control.

2. Doubleclick the Control menu.
Close the walk through.

3. Stant Visual Basic.

4. From the File menu, choose New Project.

Start a new project.

5. Set the properties for the form as follows:
BackColor  Yellow
BorderStyle 3 - Fixed Double Also removes Min/Max buttons
Caption Clock ‘
‘Height 2235 (approximately)
Name frmClock
Width 4345 (approximately)

6. Double-click the label tool in the Toolbox.
Add a 1abel to the form.

7. Setthe broperties for the label as follows:
Alignment 2 - Center
BackColor Red
Caption _ (none)

FontSize 12
ForeColor  White
Height 1340 (approximately)
Left 120
~Name ibiDateTime
) Top 420
Width 4015 (approximately)

8. Double-click the timer tool in the Toolbox.
9. Set the following properties:

Name tmrTimerl

Interval 1000

Place a timer on the form. Set the properties for it. You can place it anywhere.
Behind the label will be,fine, because timers are not displayed on screen at run
lime.
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13,

14,

15.

16.
17

. In the Project window, choose the View Code window.
Make sure that frmClock has the focus.
. In the Object and Procedure list boxes, locate the tmrTimer]_Timer.

" .Locate the Timer event in the code.
12.

Add the following code:

iblDateTime.Caption = Format$(Now, "mmmm d, yyyy h:mm:ss am/pm")

Add the code on the blank line in the Click event template.
Double<lick the Control menu.

Close the Cou: window.

From the Run menu, chovse Start.

Test the clock application that you have just created.

From the Run menu, choose End.

Close the clock.

Quit Visual Basic.

Save your form and .MAK files with .ppropriate names in
\WALKTHRUNSAMPLES.

Using a Timer to initiate a Task at a Specific
interval

You can use the timer 1O initiate a task after a specific interval. In the following
example, the timer event starts a backup procedure. The timer event occurs after at
least 60 seconds have elapsed. You could place code in the Timer event to check the
current time and start the backup routine only at certain umes.

1
2
3
4
5

o

Sub Form_Lead ()
Rem Timer will go off after 60 seccnds.
timerl,Interval = 60000
timerl Enabled = True

End Sub

Sub Timerl timar ()
x = Shell("c:\myb. ap.bat")
End Sub
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— . Picture Boxes | - -

Picture Boxes and Their Common Properties

Picture boxes are used to display a range of graphics, from icons 10 bitmaps to
metafiles. You could use a picture box, for example, to display the icons in the
Visual Basic icons library. You could also use the picture control to display the
kinds of card backs available for users of a Solitaire game.

>

Property Default Comments
AutoRedraw False Will not automatically repaint. -~
AutoSize Faise Will not automatically resize control to fit
its contents.
Name Picturel Name used in code.
Use pic as prefix.

Picture {none) Use Load Picture dialog box at design time
- to setect a .BMP, WMF, or .ICO file. This
is the defaull property for this contrel.

Syntax —Picturel = LoadPicture("\parh'f)

Events Paint This event occurs when a form or control is moved, exposing parts that
weren't initially painted on screen. Note that this applies only when AutoRedraw is
set to False. If AutoRedraw is set to True, repainting is done automaticaily, and no

:=  Paint event occurs. '
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Loading a Picture at Run Time

To load a new picture file from disk into a picture box at run time, cali the
LoadPicture function with the name of the file you want 10 load.

Example 'Sub. Commandl_Click ()
Pictyrael . Picture = LoadPicture ("\VB\ICONS\ARROWS\POQINTLZ.ICO")
End Sub

If you want to copy a picture from one picture box to another at run time, use the
[mage property of the picture you wish to copy.

Example Sub cmdCopyPicture ()
PictureZ .Picture = Picturel.Image _A -
End Sub

Clearing a Picture Box

At design time, clear the Picture property by clicking the picture box you wish to
clear. Make sure the Picture property is selected in the Properties list, click the
settings box, and then press the DEL key. The settings box will now read (none).

At run time, clear a picture box's Picture property by cailing the LoadPicture
function with an empty argument.

Example Sub Command2 Click ()
~ Picturel.Picture = LoadPicture ()
End Sub
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p

T Walk Through — Picture Box Controls and

AutoSizing

2 _To use picture box controls and autosizing
= _:1.. Start Visual Basic.
2. From the File menu, choose New Project.
Open a new blank form.
3. Double-lick the picture box icon in the Toolbox.
Place a picture control on the form.
4, Set the following properties for the controi:
AutoSize  True
Height 1000 (approximately)
Width 1000 (approximately)
5. Place an icon in the picture control.
6. Set the Picture property to: -
\WBNCONSARROWS\ARWOIDN.ICO .
The picture box automatically resizes to fit the graphic when it 1s added.
7. Place a bitmap in the picture control.
8. Set the Picture property to:
\WBBITMAPS\GAUGENCIRCLOCK.BMP
The picture box automatically resizes to fit this graphic.

9. Toremove the Picture property:
Click the Name property and then click back on the Picture property.
Click in the Settings combo box for the Picture property.
Press the DEL key

+ The settings box will read (none). This will remove the graphic from the
' Picture property of the picture box.

10. Quit Visual Basic.
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Sumrhary |

Types of Controls

s Properties for Controls

Objectives
In this module you set key properties for:

Labels

Text boxes

Frames

Command buttons

Check boxes

Option buttons

Combo boxes

List boxes

Horizonual and vertical scroll bars
Timers

Picture boxes
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.- Lab Time

Go to the Adding Controls to Forms portion of your lab manual.
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—— > Overview

L S

“a File Browsing
= Grid Control
» 3-D Panel Controls and Group Push Button

Overview |
This module is designed to directly follow the controls module, and it covers most
of the rest of the tools in the Toolbox. However, because of time limits it does not

cover picture clip, lightweight line and shape, image, and serial communications
controis.

The first part of the module discusses file browsing controls—file, directory, and
drive list boxes as well as the common dialog control. The first three are specialized
controls that act just like regular list boxes; but-as you will see, they have special
“eatures that make them distinct,

The purpose of this module is to walk you through the flow of events that are
needed to connect the various controls. The emphasis here is on talking about the
kinds of events that need to be used in order for the changes on one control (o be
reflected on the other control,

The rest of the module provides you with discussion of and walk throughs for most
of the rest of the tools in the Toolbox.

Prerequisites

This module assumnes prior experience with:
« List boxes

s (Click event implementation

Overall Objective

The overall objective is for you to develop an awareness of the rest of the tools in
the Toolbox. ’
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Learning Objectives
At the end of this module, you will be able to:

® Design'and develop a form that lets users browse drives, directories, and files.
*i  Use thie Change and PathChange events.
®  {se the grid control.

® [se the group push button and 3-D panel controls.
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_ ., File Browsing

- .= Scenario
= Properties and Events for File Browser Controls
= The Common Dialog Control
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Scenario

e

File Name: Directories:
[axt c:\windows
22701::1 e\
yte.tx .
networks.txt =7 windows
printers.txt E:I system
readmae.txt '
sysini.txt
sysini2.txt

List Files of Type:

| Text Files (*.TXT) |}

File Browsers

A quick review of the workings of the file browser in Notepad shows that a number

“ gvents occur when the user selects a different drive or directory. If the user
selects a new drive, the directories and files list boxes are automatically updated,
showing the current working directory for the system and any files (of the file type
specified in the List Files Of Type list box).

| A bl
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. Walk Through — How File Browsers Work

z To use file browsers
1. Inthe Accessories group window, open Notepad'. ,

‘e

_ All of you have used a file browser of one sort or another, but you may not have
looked closely at how it works.

2. From the File menu, choose Open.

Drives list box The Drives list box is a special form of drop-down list box.
The user can see options presented in the list but cannot add items 10 it.

The more important element to notice at this point, however, is that when the
user selects a new drive, the change in selection is reflecied in the directory and
file list boxes as well as in the cumrent working directory.

Directories list box The Directories list box is a special form of list box. It
behaves lik: a regular list box but dispiays only directories and subdirectories.
Users cann.:i add items (o or delete items from the list.

File Nam= combo box The File Name “mbo box is a special form of the
list box th:.: sends and receives messages from a text box. The text box allows
users to add items to the list, something that cannot be done with a list box.

List Files of Type Combo Box Notice that this, too, is a drop-down list
box. Users can select items from it, but they cannot add items 10 it themselves.

" Current working directory  Finally, notice that there is a abel that tells the
user the current drive and directory. :

3. Choose Cancel, and close Notepad.

End walk through.
Style . Typicallj(, file browsers can be set to display only a given type of file in the
Guidelines specified drive and directory. Because Notepad is designed to read files that have

the .TXT extension, .TXT is the defauil file type and *.* is the second choice.

Because the Employee Database application is designed to locate . BMP and WMF
files, they will be the default file types.
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Properties and Events for File Browser Controls

const2.txt
" | constant.ixt
decomp.dll
form1 frm
packing.ist
projecti.ma
readme ixt

clipart
bitmap

Example

Drive, Directory, and File List Boxes

All three of these controls are special forms of list boxes. They have many of the
same characteristics, but there are also a number of special properties that they use
to enable navigating through a file system

Drive List Boxes and Their Common Properties

The first of these controls is the drive list box. It is a special form of the drop-down
list box. Initially it only shows the current drive for the form. However, if the user
clicks the drop-down arrow, the control wiil dispiay all of the other drives currenily
available on the systern.

Property Default Comments

Name Drivel Name used in code,
Use drv as a prefix.

Drive Accessible only at run time, this property
returns the selected drive. This is the default
property for this contol,

Synchronizing the Drive Property

‘Sub Drivel-cChange ()

'When drive is changed, reset the directory list box path
Dirl.Path = Drivel.Drive
End Sub
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Example

Exampie

Directory List Boxes and Their Common ..

Properties
Property Default Comments
.-Name - Dirl Name used in code.
Use dir as a prefix.
Path

Accessible only at run time, this propeny
returns the absolute path for the selected
directory, This is the default propeny for this
conirol.

Synchronizing the Path Property

" Sub Dirl Change ()}

! When directory is changed, raset tha file list box path

Filal.Path = Dirl.Path
End Sub

File List Boxes and Their Common Properties

Property Default Comments

Archive True Displays all files with archive bit on.

Name Filel Name used in code.

. Use fil as a prefix.

FileName Sets or returns the selected file from the tist
porticn of a file list box. Accessible only at
run time. This is the default property for this
control.

Hidden False Does not display hidden files.

List Accessible only at run time; returns the items
contained in a list box.

ListCount Accessible only at run time; returns the total
number of itemns in the list box.

ListIndex Accessible only at run time; returns the index
of the currently selected itern.

Normal True Displays all files with archive bit set on. -

Path Accessible only at run time. ’

Paitem ** ) Display all files.

ReadOnty True — Tyl A NIV

System False -, PR

Sub Filel DblcClick ()
Labell.Caption = Filel .FileName
End 3ub

~ Accessing the FileName Property
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Evenis Click For all three of the basic controls, a Click event indicates that the user has
made a selection. That is, the user is seleclir_lg or changing drives, directories,
subdirectories, or filenames.

. Double-click The only time that a double click is routinely used in a file

- browsér is when the user uses the File Name combo box. In this case, the double
click indicates that the user has located a specific file of interest and wanis the
application that uses the file browser 10 actuatly open that file.

Change The real workhorses of a file browser are the Change events. Code that
you add to the event procedure template keeps the three controls synchronized
whenever the user selects a new item in one of the list boxes. )

PathChange This event occurs when the selected path has been changed by
setting the FileName or Path property from code.

PatternChange This event occurs when the pattern has been changed by setting
the FileName or Pattem property from code.
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Y, Change Events | S

= Change Event
= PathChange Event




154

Module 7: Flle Browsers and Other Controls

The Change Event

.,

. .Dirl_Change ()

autoexec.bat
autoexec.bak discovar
command.com [:] dos i
config.bak imdos Drivel Change ()
contig.sys [ Imdos.okd Py
windows l
=

Example

Example

Changing the Path for Differing List Boxes

Change Events Change evems indicate that the contents of a control have
changed. Change evenis are associated with a wide variety of controls including
combo boxes, horizontal and vertical scroll bars, labels, and picture boxes. For our
purposes. this module focuses on the Change events for directory and drive list
boxes only.

Directory List Box The Change event is invoked when the user clicks a new
directory or when the Path property is changed from the code. It indicates that the
contents of the control have been changed.

Sub Dirl_Changm ()
! When diresctory is changed, reset the file path
Filel.Path = Dirl.prath

End Sub

Drive List Box The Change event is invoked when the user selects a new drive or
when the Drive property is changed from the code. It resets the path for the
directory list box.

Sub Drivel Changs ({)
' When drive is changed, reset the directory's path
" Dirl.Pith = Drivel.Drive
End Sub
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Walk Through — Drawing and Coding a File

2.

Browser ' _ :

To draw and code the file browser

.:1, _From the Walk Throughs program group, start Browser.

When this application starts, you will see a simplified form of the file browser
. used in the Employee Database. This form has file, directory, and drive list
boxes only.

Click a new directory and notice the file list is updated.

The purpose of the application is t0 demonstrate the Path and Dnive properties
and the Change events that are used to synchronize conwrols. -

Close Browser,
Start Visual Basic. .
From the File, choose New Project.

AN

For Form1, set the following properties in the Properties window:

Height 3930 (approximately)

Width 4290 (approximately)

6. Double<click the file list box tool in the Toolbox.

. *Set the following properties:
‘Height = 2760 (approximately) _ '
Width 1455 (approximately)

8. Doublelick the directory list box tool in the Toolbox.

9. Set the following properties:

~J1

Height 2175 (approximately)

Width 1455 (approximately)
10. Double-click the drive list box tool in the Toolbox.
11. Set the following properties: '

Width 1455 (approximately)

The first step of implementing a file browser is to add the Change event code
that synchronizes changes in the state of the drive and directory list boxes. To do
this, you need 10: '

12. Double~click the drive list box.
~ This displays the Code window with the Drivel _Change event procedure in it.

13, Add the following code:

Dirl.Path = Drivel.Drive
This code resets the Path property of the directory list box to that of the Drive
property of the drive list box.

Now the directory list box will be kept current with changes in the drive list box.
But what about the file list box?

' 14, From the Object list, select Dirl.

The Code window with the Dirl _Change event template is displayed.
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15.

16.

17.

18.
19.
20.

Add the following code:

Filel.Path = Dirl.Path

Click Form1 1o display the interface. .

The code added above resets the Path property of the file list box to that of the
Path property of the directory list box. |

The characteristics of the Path property of a directory list box vary depending on
whether the user's current working direCtory is the root directory.

'If the user selects the root directory, the path will be "\"—that is, a path (in this

case the root), which is a backslash. If the user selects any other directory, the
path will end in the current working directory, with no backslash at the end.

This is important when a program needs to build a fuily qualified filename. The
code must check to see if a backslash must be added to the current value of the
Path property before concatenating it to a filename.

The code to handle this requires a knowledge of conditional processing. To see
how this is done, inspect the cmd OK _click procedure in the AddPhoto.FRM
code in \SOLUTIONWPRINTING.

From the Run menu, choose Start.

Test to see if your code works.

From the File me 1, choose Save As. 7

Save the file as BROWSER.FRM in\WALKTHRUNBROWSER.
Save the project as BROWSER. MAK in\WALKTHRINBROWSER.
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_____PathChange S S

.

Filel PathChange ()@

Dirl Change ()

Far] C
system

arches. bmp
argyle.omp

Path: c:\windoWs
bootiog.txt : -

0 ey odpns

' Examples

Further
Examples

PathChange

The event occurs when the selected path changes by setting either the FlleName or
Path property from code.

These two examples are from Visual Basic Help.

Sub Dirl_Change ()
Filel.Path = Dirl.Path
End Sub

“'pathChange Event Example

Sub Filel_PathChange (}
Labell.Caption = "Path: " + Dirl.Path
End Sub :

Notice in this example that the PathChange event is generated by code in a Change
event in the directory list box control to synchronize the value of the Filel.Path
property (0 the new value for Dirl.Path.

For further examples using Lhe PathChange event, see the following.
Application " Ferm Procedure

" IconWorks VIEWICON FRM " File_FileList_PathChange
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The Common Dialog Control

File Name: Duectories:
c:\vb

£ bitmaps

2 edk

I he [J Read Only
3 icom :

3 metalile -

Save File as Type: Dnyes:

| H (@

The Common Dialog Control
The common dialog control is a versatile tool provided as a standard pan of the
Professional Edition of Visual Basic. The most common use for it is as a file

" browser, but as you will see, it has many other possible uses.

Sub mnurileCpen_Click {}
CMDialogl.Action = 2
End Sub

Below is a list of the Action property settings and their associated dialog box type.

Action setting Type of dialog box
0 No action
1 File open dialog box
2 File save dialog box
3 Color dialog box
4 Choose font dialog box
5 Printer dialog box
4] Invoke WINHELP.EXE
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¥ More Controls

w.

= Grid Control
= 3-D Panel Controls and Group Push Button

This final portion of the module deals, briefly, with each of the remaining 1ools in
the Toolbox. .

a5
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Using the Grid Control td Display Output

Gridl.Col =1
Gridl.Row =1
Gridl.Text = "Name"

The Grid control atlows you to display output on a grid.

The Cols and Rows properties set the total number of columns and rows you want
in the grid. These properties are available at design time or at run ume. .

The Col and Row properties set or retum the current cell in the grid. These
properties are available at run time only. The Text property sets or returns the text
in the current cell,

Sub cmdAddText Click {}
'Seat the current cell; remember that the first row and
‘col ara 0
Gridl.col = 1
Gridl.Row = 1
Gridl,.Text = “Name"
End Sub

The Clip property sets or retumns the contents of the grid's selected region—for
example: :

Gridl.Clip = "ABC"

You can include tabs and carriage retumns in the string expression to indicate new
columns and new rows, respectively.
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———

The following example places text in a iwo-by-two range of cells.

Example

e

1
2
3
N 4_ N .
s Gridl.SelEndRow = 3
6
1
8
)

Sub emdClipText_Click ()
Gridl.SelStartCel = 1
Gridl.SelEndCol = 2
Gridl.5elStaztRow = 2

tb$ = Chr3(9) 'Tab character
cr§ = Chr§(13) 'Carriage return
d$ = "Joe J" + tbS$ + "123" + crj + "Sua B + th$ + "45§"
Gridl.Clip = dg
10 End Sub
The grid control is used to display cutput. However, you can simulate input on a
grid with code. The following example updates a grid cell when the user types into a
text box:

Sub Textl Change ()
Gridl.Taxt = Textl.Text
End Sub
Some of the key properties that you will need in order to use this control are as
follows. :

Property Defauit ~ Comments
ColAlignment +  0- Left Justify - Sets or returns the alignment of datain a 4
. column .
Cols, Rows ' ~ Sets or returns the tp1al number of rows or '
: columns in the grid
. N - ™
ColWidth Sets or retums the width (in twips) of a -
specified column
FixedCols, Sets or returns the total number of fixed
FixedRows colurmmns or rows for a grid
GridLines —1-True Determines whether lines between cells are
displayed

Picture _ Sets or retums a graphic for the current cell
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3-D Panel

- This control has a number of possible uses. It has, however, two primary uses-—the

first is to provide greater three-dimensional (3-D) quality to another control or
group of controls. For example, you can place other controls on the panel; it can be
used in place of a frame. You might also use this control as a background for the
entire form. The three-dimensional panel, because it has FloodPercent and
FloodType properties, can be used as a status or progress indicator.

Some of the key properties that you will need in order to use this control are.

Property Default Comments

Alignment 0 - Left Jusiified Top ~ Caption alignment for this conirol offers nine
possible choices.

Bevellnner 0 - None Sets the style of the irmer bevel of the panel:
none, inset, or raised.

BevelOuter 2 - Raised Sets the style of the outer bevel of the panel

BevelWidth 1 Sets or returns the width of both the outer and
inner bevels of the panel.

FloodColor Sets or retumns the color used to paint the area
inside the panel’s inner bevel when used as a
status indicator.

FloodPercent Sets or returns the percentage of the painted

e - area inside the inner bevel when used as a
status indicator.

FloodType 0 - None Determines whether and how the panel is .

used as a status indicator.
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Walk Through —Cr atingaPerc ntM t r

Z_T—o set the Percent Meter at work
- 1. From the Walk Through program group, choose Percent Meter.

.. .. The purpose of this walk through is to demonstrate the siatus reporting
capability of the three-dimensional panel contral.

2. On the Percent Meter application, choose Start.

In a few seconds the panel will progressively change color, indicating along the
way the percentage completion of the process.

3. Open the Control menu on the Percent Meter application, and choose Close.

z To create the Percent Meter application
1. Start Visual Basic.
2. From the File menu, choose New Project. -
3. Set the properties for the form as follows.

Property . Setting
Caption Percent Meter
Height 4425 (approximately)

-MaxButten False

-MinButton False

| Width 2535 (approximately) @
4. From the 1oolbar, double-click the 3-D Panel tool and set its properties as

follows.
Property - Setting
Bevellnner ' 1 - Inset
BevelQuter 2 - Raised
BevelWidth 3
BorderWidth 2
Caption
FloodColor Yellow
FloodType l 4 - Bottom to Top
Height 2655 (approximate!y)
Left 240 (approximately)

. Outline True

. Top 240 (approximately)

Width - 1935.
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. From the toolbar, double-click the Command button and set its properties as

follows.

~ Property Setting

11.

- Caption . Start

FonuSize 135

Height - ) 495 .(approximately)
Left - 480 (approximately)
Top 3240 (approximately) -

. Doubleclick the Command button in design mode in order to open the Code

window.

Visual Basic displays a Code window with the Command1_Click event
procedure template in it.

. Place the following lines of code between the two parts of the emplate:

Panael3dl.FloocdParcent = 0

For i% = 1 To 100
Panelldl.FlocdPercent = i% » 1

Naxt ik

. From the Run menu, chonse Start.

Test your application.

. From the Run menu. choose End.
10.

Save your form and .MAK file with appropriate names in
\WALKTHRINSAMPLES.

Close Visual Basic.
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.——-Group Push Buttons .

‘I Fite Edit Format

B

- Group push buttons work like combination command buttons and option buttons.
They are like command buttons because when the user clicks the button, something
- happens—a file is opened or saved, or text is right-justified. Group push buutons,
however, are also like option buttons because. with the properties set properly,
selecting one option can automaticaily remove the seiection from another option.

Some of the key properties that you will need in order 1o use this control are as

follows.

Property Default Comments

GroupAllowAllUp -1-True Determines whether all buttons in a logical
o group can be in the up position.

" GroupNumber 1 Sets or returns the group number for a given
group push button. This property is used to
create logical groups of buttons.

Oultline Sets or returns whether the button has a
border around it.

PictureDisabled None Specifies the bitmap 1o display on the 3D
group push button when it is disabled.

PictureDn None Specifies the bitmap to use when the button
is depressed. :

PictureDnChange 0" Determines how the PictureUp bitmap is to

c be used to create the PictureDn bitmap; 2

merely inverts the PictureUp bitmap.

PictureUp None Specifies the bitmap Lo use when the buiton

is up.
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Walk Through — Creating a Tbolbor

Z To see the interface you will be creating
«1. From the Walk Throughs program group. choose Toolbar.

This little applicalion doesn't do very much. What it does show is that the user
can select any or all of the first three options, whereas they can only select one
of the second three. More 1o the point, it is an example of how you would go
about drawing a toolbar like the one found in Microsoft Word for Windows or
Microsoft Excel.

2. From the Control menu on the Toolbar form, choose Close.

Z To create the toolbar
1. Open Visual Basic.
2. From the File menu, choose Open Project.

Locate TOOLBAR.MAK. It should be located in \WALKTHRUNSAMPLES.
This form already contains the basic form—TOOLBAR.FRM with all of its
properties already set. In order to add the (oolbar, you need (o complete the
following steps:

3. Place seven groﬁp push buttons on the toolbar panel at the top of the form.

4. Use the mouse pointer and the control key 10 select all seven of the group push
buttons, and then set the following properties for all of them.

Property Setting
Height 420
Top 30
Width 450

5. Place three of the push buttons side by side on the left end of the panel,
These will become the text formatting buttons for Bold, lialic, and Underline.
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6. Select the first button in this group and set the properties as follows.
Property Setting
 GroupNumber 0
- P_ic_n_;reUp BLD-UP.BMP located in \WB\BITMAPS\TCOLBAR3
PictureDn BLD-DWN.BMP

These changes create the first button on the toolbar and make use of two
separate bitmaps to indicate the status of the button 1o the user.

7. Select the second button in this group and set the properties as follows.
Property Setting '
GroupNumber 0
PictureUp ITL-UP.BMP
PictureDn : ITL-DWN.BMP

8. Select the last button in this group and sel the properties as follows.

' P-rperty Setting
GroupNumber 0
PictureUp ULIN-UP.BMP
_f’ictureDn ULIN-DWN.BMP

Notice that all three of these buttons have the same number—0. A group
number of 0 means that they are not part of a logical group, and therefore
changing the state of one will not change the state of others. After all, your user
may want 10 have bold and italic and underlining. Clusters of controls with any
other group number will act just like option buttons—only one will be in force
at any one time.

For purposes of contrast, we will take a slightly different approach on the second
group of push buttons. Here you are giving the user the option of formatting text
as either lefi-, centered-, or right-justified. In this case, you will want these
buttons to work as a group because any one bit of text can have only one of
these three states. : .

. Create the second group of buttons side by side toward the middle of the panel.

In all likelihood, you will not be able to keep the butions in perfect top-to-bottom
alignment. Don't let that bother you, You can select the entire group at the end of
this walk through and set the Top property for all of them in one step, as you did

above. !

10. Select the first button in this group and set the properties as foliows,
' _ Property Setting
GroupNumber S22
PictureUp LFT-UPBMP
PictureDnChange 2 - Invert PictureUp Bitmap

Notice what we have done here? We have created the PictureDown bitmap by
inverting the image using the property PicrureUpChange.
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11. Select the second button in this group and set the properties as follows.

Property Setting
- GroupNumber 2
*- PicureUp ’ CNT-UP.BMP
PictureDnChange 2 - Inven PicureUp Bitmap

12. Select the third button in this group and set the properties as follows.

Property Setting

GroupNumiber 2

PictureUp RT-UP.BMP
PictureDnChange 2 - Invert PicureUp Bitmap

What this example emphasizes is that the property GroupNumber i$ your way of
telling Visual Basic how you want individual sets of buttons to be grouped.

13. As a little extra challenge. you set the properties for the last control. It's
supposed 10 represent a printer, so you will need to use the PRT-UP.BMP,

14, Save your work in \WALKTHRUNSAMPLES.

Y. To Code The Toolbar

If you want to implement the toolbar so it functions properly, you can add the
following code.

1. Double-click the bold button to open the code window for GroupPush3D!_Click
event and add the following code:

lblMessage.FontBold = value

2. Double-click the italic button to open the code window for
GroupPush3D2_Click event and add the following code:

lblMessage.FontItalic = Value

3. Double~click the underline button to open the code window for
GroupPush3D3_Click event and add the following code:

lblMessage.FontUnderline = Value

4. Double-click the left-justify button to open the code window for
GroupPush3D4 _Click event and add the following code:

1blMessage.Alignment =

5. Doublg-click the center button to open the code window for
"+ GroupPush3D5_Click event and add the following code:

1blMessage.Alignment = 2 -

6. Double-click the right-justify button to oper: the code window for
GroupPush3D6_Click event and add the following code:

" iblMessage.Alignment = 1

7. Save your work in \WALKTHRUNSAMPLES.
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- Summary

« ..® File Browsing
» Grid Control
= 3-D Panel Controis and Group Push Button

Objectives
In:this module you learned to:

Design and develop a form that lets users browse drives, directories, and files.

Use the Change and PathChange events.
Use the grid control.
Use 3-D panel controls and the group push button.

1

_\\
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—— 3 Qverview

‘Key Terms

Using Variables and Constants
» Scope

Additional Visual 8asic Data Types

Overview

The overal! purpose of this module is to introduce already knowledgeable
programmers 1o the data types of Visual Basic and their scoping rules. This module
is designed as the first of a series of modules on the impiementation of Basm within
Visual Basic.

Prerequisites

Prior to starting this module, you should already be familiar with:

a Data types and scoping rules within some other procedural language
s The general Visual Basic programming system

Overall Objective

At the end of this module, you will be able to correctly and efficiently use almost all
of the Visual Basic data types.

Learning Objectives
At the end of this module, you will be able to:
u . List and describe the seven variable data types in Visual Basic.
» Correctly identify the six type declaration character symbols.
- m  Use the contents of CONSTANT.TXT.
= Distinguish among. the various levels of scope in V  .al Basic.
s Explain the rules for using each level of scope.
s Declare and use a user-defined data type.

e Declare and use simple arrays.
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Key Terms

“s Varigbles o

Constants

Procedures

Statements

Scope
Module

Variables Changeable values that the program manipulates
Constants Unchanging values that the program manipulates
Procedures Activities that the program performs
Statements Subactivities within procedures

Scope (Accessibility) Which pan of a program can access specific data or
procedures

Module File containing code and data not attached to a form
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——-»-Using Variables and Constants = .

« Data Types of Variables
=« Data Types of Constants
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Data Types of Variables

“w Integer %

= Long &

» Single !

* Double #

= Currency @

= String $

= Variant (none)

There are seven fundamentai data types of variables that you can use in Visual

Basic.
Type name Description Type-declar:ition Range
character
Integer Two-byte integer % -32.768 10 32,767
Long Four-byte integer & ~2,147.483.648 10
2,147,483,647
Single Four-byte floating- ! -3.40E+38 10
point number 3.40E+38
Double Eight-byte floating- # ~1.79D+308 to
point number 1.79D+308
Currency Eight-byte number @ -9.22E+14 10
with a fixed decimal 9.22E+14
point
String String of characters M 0 to 65,500 characters
{approximately)
Variant (Default) Datesime, floating- (none) Date values:
point number, string January 1, 0000. to

December 31, 9999,
numeric values same
as double; siring
values same as string
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Declaring Variables

In-polite society-you-always formally-introduce strangersto each other the first time
they meet. Visual Basic is no exception. You should introduce your variable to

. Visual Basic by declaring the name of your variable before you use it. You do this
. in one-of two ways: by using the Dim statement, or by using one of the two
" keywords—Global and Static. As you will see in a couple of pages, not declaring

vanables can be risky business in some situations because the defaul[ data type in
Visual Basic is Variant.

You have two choices on how to explicitly declare variable data types. -

Using As _~  Using the type-declaration character
Dim I As Intaeger Dim I%
Dim Amt As Double Dim Amt#

s P G ArL s =
- BERCERIRE N, - ST e

o e
Dim YourName Ai:StEing_ Dim™ YourNamaS

Dim BillsPaid As Currency Dim BillsPaid@

In order 10 make compound variable declarations, you merely state:

Dim X as Integer, Y a3 Long

Caution If you declare three separate variables with the following statement,
you will get K3 as a siring and I and J as varianis, not as strings.

Dim I, J, K$

Exphcﬂ Declarations
To require explicit declaration of variables in all of your code, place the following
statement in the General Declarations section of any form or module.

Option Explicit

If you want 1o require that all variables be explicily declared in all of your projects,
from the Options menu choose Environment and set the Require Variable
Declaration option to YES.
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Variable-Length Strings

Sometimes you may need a variable that can hold strings of different lengths at
different times. This is called a variable-length string variable. You declare it like
this: ‘

Dim Message Ra String

Fixed-Length Strings

At other times you know that the strings that will be assigned to a certain variable
will never have more than a certain number of characters. In this case, you can
declare a fixed-length variable like this:

Dim FixedLengthString As String * 50

In this example, you are declaring a string variable with the name
FixedLengthString, and you are telling the application that the variable may contain
up to 50 characters.

You can take this one step further. For example, set the length using a Global
constani with the name FixedLength, set the value of the constant io 50, and then
point i that constant name using the following syntax:

Glebal Const FIXEDLENZ:Y = 50
Global FixedString Aa String * FIXEDLENGTH

Rules When Working with Variables

1. Variable names can be up to 40 characters long.

2. Names can include only letters, numbers, and underscores.
3. The first character in the name must be a letter.
4

. You cannot use Visual Basic reserved words. See the list of programming topics
in Visual Basic Help for a partial list of reserved words.
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Variant Data Type e

la‘

As the chant-above-shows;the-Variant-data type is the default-The Variant data
type can siore numeric, string, or date/time information. You don’t need to convert

. between these kinds of data when assigning them to a variant variable; Visual Basic
_ .automatically performs any necessary type conversions for you.

Rules for Using Variant Variables

1. If you perform arithmetic operations or functions on a variant, it must contain a
number. If you wanl to test a variant to see if it contains numeric data, use the
IsNumeric function.

2. Normally, when you concatenate two strings you would use the plus (+) sign. To
avoid ambiguity with variant data, use the ampersand (&) to indicate
concatenation.’

Note When concatenating, be careful to leave a space between a variable
name and the ampersand. If you don’t, Visual Basic assumes that you are
typecasting the variable into a Long data type.

3. When passing a Variant variable as an argument, check the procedure
parameters. If the comresponding argument is an explicit data type, you must pass
the Variant variable with parentheses around it in order o pass it by value.

Dim V As Variant
V= “"Testing"
Debug.Frint PrintString{{(V})} '‘Extra ﬁarenthesea to pass by value

Sub PrintString(S As String) !
'Do something
End Sub

4. To determine the internal represenlation for a variant variable, use the VarType

function. See documentation for specific returm values.

5. A variant variable has the Empty value before it is assigned a value. The
Empty value is a special value, different from a zero, a zero-length string, or a
NULL value. To test your Variant variable for an Empty value, use the
IsEmpty function. To reassign a Variant vaniable back o the Empty value,
you must assign another empty Variant vanable (o it

6. To test for a Variant variable containing NULL, use the IsNULL function.

Note For alisting of the string conversion functions for the Variant daia type,
see the appropriate table at the end of the Visual Basic code module.
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B e e Ty

Constants

Module1.bas

T ' {general)

" Alignment {label)
Global Const LEFT_JUSTIFY
Global Const RIGHT JUSTIF
Glopal Const CENTER = 2

i$3 Proc: |{declarations)

[ Label1 Label

- Left Justity -

- Left Justify
- Right Justity
- Center
BackStyle 0 - None
BorderStyle | a

Caption {none)
Draglicon 0 - Manual
Enabled True

Example

What Are Constants?

Constants are just that, entities within your program whose value you need, but
which will not be changed during the running of the program. For example. if your
program needed to work with circles, you would probably need a consiant like

P1=3.1459.

Examples of typical constanis can be found in CONSTANT.TXT. If you look at
this file, you will find several constant values declared that are familiar to you from

the overview of properties for controls.

‘Border 5tyle

Const NONE = 0

Const FIXED SINGLE = 1
Conat SIZABLE = 2
Conat FIXED DQUBLE = 3

wm b oW

How Are They Declared?
Visual Basic contains a CONSTANT.TXT file, which lists all the common

constants. You can copy and then modify this file to meet the application's specific
‘needs. You can then load CONSTANT.TXT into the General Declarations section
of a module (BAS) to be used by the application. Following is a partial listing of

- - the general categories of constants defined in CONSTANT.TXT.
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~'n' §cope of Data

Declaring and Using Local Variables

Declaring and Using Form-Level and Module-Level
Variables

Declaring and Using Global Variables
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Scope of Data

.. . FormFRM Module1.BAS

FormmeDim A . Globals{Globalc | |
' Modulecg$ Dim D :
Declarations Dectarations
Sub X Sub Pl

LocalmeDim B Localcspim E
_ *Sees A,B,C - ‘Sees C,D,E| E
Procedure Procedure
Sub Y Sub P2
‘Sees A,C ‘Sees C,D

Procedure

What Is Scope of Data?

The scope of a data variable or constant is its level of visibility within an
applicaton. Scope of data falls into three levels of visibility: local vanables, form-
and module-level variables, and global variables.

Scope of Data — An Analogy

Scope of data basically deals with who can use what. The easiest way (o think of
this is by analogy.

Say you had a refrigerator/freezer full of all kinds of goodies—candy, soft drinks,
ice cream. Almost everyone likes these goodies and would like to get to them. Your
job as the manager of these resources is (0 make sure that the right people get to
them and the wrohg people don't.

If you put these goodies out where everyone can get 1o them, they will be used,
right? If that is what you want, then fine, make them globally available. In Visual
Basic terminology. declare and define vartables that all functions will need access
to using the Global keyword in the General Declarations section of 2 module
(.BAS), not a form, :

For those goodies that you only want some people o get to, for example, just the
-members of your work group, then put the refrigeratot/ireezer where only they can
get to it—for example, in your work group area. In Visual Basic, declare and
define these variables using the keyword Dim in the General Declarations section
of either the form or the module. You'll see an example of how this is done in just a
few minutes.

-3
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Finally, for those goodies 0 which only you should have access, put the refrigerator
in your office. That is, declare and define those variables locally —insidé a _

procedure. Again, you'll see examples of this is just a minute.

~ Variable Declaration Keywords and Their

~'Scope
The table below details how the different variable declaration keywords are used.
Scope Declaration .
Local Dim, Static, or ReDim (within a procedure)
Module Dim (in General Declarations section of a form or a code
module). _
Global Global (in General Declarations section of a module)

A simple example of data declarations can be found this way
Start Visual Basic. ,

From the File menu, choose Open Project.

Go to the CAVB\SAMPLES\CALC subdirectory.
Double<lick CALC MAK.

Click CALC.FRM in the Project window.

Click View Code in the Project window.

TN S S

Visual Basic displays the form-level variable declarations for the calculator
application. Notice the declaration of seven variables and the Option Explicit
statement.

Note When you are writing code and you want to create module- or form-level
vanables, make sure that you are really in the general declarations section of the
code before you make changes or additions.

Always be sure that the iop of your form window has these (wo options selected.

General Declarations

‘ ICONWRKS.FRM |
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Style
Guidelines

2 For a more complex listing of global declarations

1. From the File menu, choose Open Project.
Go to the CAVB\SAMPLESNCONWRKS subdirectory.

Click ICONWRKS.GBL in the Project window.
Click View Code in the Project window.

2.

3. Double<click ICONWRKS.MAK.
4,
5.

Scroll down to the General Declarations section of [CONWRKS.GBL and inspect
the varnious values declared and defined.

Rules for Using Local Variables

1. A local variable is recognized and dectared only within the procedure in which it
appears using the keyword Dim. The variable is re-initialized to zero or a '
NULL string when the procedure begins, unless the local variable is declared as
Static. A local variable is a good choice for any kind of témporary calculation.

2. If you use a variable without declaring it, then Visual Basic ass...nes it is locai
and assumes Variant as the data type. However, this technique may waste
storage space and is not as rehable as declaring the variable in the appropriate
procedure. It is also not as efficient.

Rules for Using Form- and Module-Level
Variables

1. A form-level variable is declared in the General Declarations section of the
form, using the keyword Dim. A form-level variable is available 10 any
procedure on that form and onldy that form,

2. A module-level variable is declared in the General Declarations section of the
module, using the keyword Dim. A module-level variable is available to any
procedure in that moduie and only that module.

Rules for Using Global Variables

1. A global variable or constant is shared throughout an application. Multipte
forms and modules can use a global variable. They are declared in the General
Declarations section of a module using the Global keyword for variables and
Global Const for constants.

2. Global variables are persistent; they retain their value throughout the entire
* application.
Good'pfqgmmming practices when using variables and constants include:
w Use form-level and module-level constants and variables as opposed to global-
level if possibie. :

s Declare the variable or constant with the Dim statement rather than accepting
Basic automatic variabies.

s Use Integer declarations instead of default Variant declarations whenever
possible. Integer declarations 1ake less space, avoid rounding errors, and
consume less CPU time than Variant declarations.
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—— - Declaring and Using Local Vgriables | S

EMPREC.FRM

Proc: [ AddEmp [

Sub AddEmp ()
Dim CurrentLocation As Integer

Example

Example

Local variables reset to value zero (0) or an empty string when the local procedure
begins.

To declare a local variable, place the Dim daia declaration statement inside the -
local procedure.

1 Sub Form_Click ()

2 "The local variable below disappears upon procedure exit

3 'and is reinitialized to zeroc when the procedure is re-entered
4 Dim EnployeeNumber As Integer

5 EmployeeNumber = Val{Textl.Text) b
[ Print "The Employee Number is: * + Str${(EmployeeNumber)

7 End Sub

In the example above, EmpioyeeNumber is declﬁred as an Integer. How would the
code be different if you handled it as a Variant?

1  Sub Form_Click{)
2 Dim EmployeeNumber

EmployeeNumber = Taxtl.Text
4 Print “The Emplcoyee Number is: " & EmployeeNumber
5 - End Sub

Note Notice the use of the ampersand to concatenate the literal String and the
Variant in the Print statlement above?
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If you want a local variable to be persistent, declare it as Static. Static local
variables will retain their data value when the procedure performs a rerum.

Example 1 ‘sub StaticDemo ()
=2- .- . ‘The atatic variable below will retain its value across
' calls and is used to keep track of how many times
' StaticDemo ia called.
Static RunCount As Integer ' Create a persistent variable
RunCount = RunCount + 1 ! Use it to keep run count.

MagS$="The RunCount for tha StaticDemoc procedure is: "
Msg$ = Msg$ + Str5(RunCount)

Print Mag$ ' Display message.

10 End Sub

LT-T . - B R AN S R
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Declaring and Using Form-Level and Module-Level- - -

.

Variables

e

Example

Use form-level variables or module-level variables when sharing data only within a
form or a module. The data remains persistent within the form or module but is not
accessible to procedures in other forms or modules.

To declare a form-level or module-leve! variable, place the Dim statement in the
General Declarations section of the corresponding form or module.

The declaration below appears in the General Declarations section of the module
DEMO.BAS:

Dim UsarName As String

When the procedure below is called, it can access this module-level variable. For
example, suppose that a text box is supplied for the user to type his or her name:

UserName = txtUserName. Taxt

Then the appropriate value for UserName will be printed when the Sub procedure
WelcomeDemo is called:

1. Sub WelcomeDemo ()

' Variablo declared in modula's Declaraticons section can bhe
' referencaed here

Print "Welcome " + Usa:Name
End Sub

[E IR FU S ]
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The module-level vanable is also available to all other procedures defined in

DEMO.BAS.
Exomple 1 Sub VerifyUserName ()

e -
2 Msg$ = "UserName = "
3 ' variable declared in module's Declarations section can
4 ' also be referenced here
5 MagBox Mag$ + UserName
[ End Sub
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—--—- Declaring and Using Global Variables e

GlobalNumber . GlobalNumber Also
Accessible Here "Accessible Here

Example 1

Example 2

Use global vanables and constants when sharing data throughout an application.
The data remains persistent and accessible from all forms and modules within the
application. ' :

To declare a global variable, place the Global statement in the General
Declarations section of a module—that is, a .BAS file:

Global GlcbalNumber As Inteager

The variable GlobalNumber can now be referenced throughout the application.

1 ' Code for Forml

2 Sub Form _Click )

3 ' Global variables can be referenced here
4 GlobalNumber = GlobalNumber + 1

5 End Sub

1 ' Code for Form2

2 Sub Form _Click ()

3 ' Global variables can also bes referenced hare
4 Print = "GlopalNumber " + Str${GlobalNumber)
5 End Sub '

Load any constants you want declared for an entire program into the General
Declarations section of a module.
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Walk Through — Scope

): "To demonstrate the concepts of scope of déta in Visual Basic
« 1. From the Walk Throughs program group. start Scope.

When the appiication starts, you see two forms. Form 1, on the left, contains a
Commandl button. Form2, on the right, contains a Command] button.,

The purpose of this walk through is to demonstrate the concepts of scope of data
in Visual Basic. :

2. Click Form1 (on the form, not the command bution).
The Form_Click event will display values of data items as their scope permits.

The global and form-level data values are displayed. Note, however, that the
Form2 modute-level variable and the Form1.Command]_Click and
Form2.Command! _Click local variable values are not displayed. Remember,
you just requested a Form_Click event, so the Command1_Click variables are
not yel in scope and Form2 vanables are not in scope until Form2 has focus.

3. Click Form2 {(on the form, not the command button).
The Form_Click event will display values of data items as their scope permits.

The global and form-level data values are displayed. Note, however, that the
Form1 module-level variable and the Form1l.Command1_Click and
Form2.Commandl _Click local variable values are not displayed either.
Remember, you just requested a Form_Click event, so the Command2_Click
variable is not yet in scope and Form! variables are not in scope until Forml1 has
focus. :

4. Click the Command1 bution on Forml.

The Command1_Click event will display values of data items as their scope
permits. ‘

You have just generated a Form1.Command1_click event. and this places the
Form1.Command1_Click variable in scope. Form1 still has focus, though, so
Form2's variables are not accessible.

5. Click the Command] button on Form?2.

The Command}_Click event will display values of daia items as their scope
permils.

You have just generated a Form2.Command 1 _Click event, and this places the
Form2.Command1_QClick variable in scope. Form?2 still has focus, though, so
Form1's variables are not accessible.

6. Double<click the Control menus on both forms (o close them.
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. Additional Visual Basic Data Types

= User-Defined Data Types
= Arrays

Syntax

" Example

User-Defined Data Types

Earlier in this module standard Visual Basic data types were discussed. Visual
Basic also allows you to create your own data types. User-defined data types, called
records or structures in some other programming languages, must be declared in the
General Declarations section of a module, using the Type statement,

Type usertype
elementname As typename

[elementname As typenamé] -

P
End Type

This feature allows you to create new variables that can be customized to fit the
needs of your application. For example, you might want (0 define a data type 10 hold
customer information as follows:

1 ' Place this declaration in a module

2 Type CustomerRecord

3 " CustNum As Lang

4 CustName As String * 38

5 CustAddressl As String * 38 ' Street Address
6 CustAddress2 As String * 38 ' City, State

1 CustZip As String * 10

8 End Type
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Example

Example

Exampie

o1
3

You can then declare and use variables of this new type in your application
wherever you need them. To refer to a particular ¢element, use the syntax
variablename.elemeniname.

' Sub GetCustcomerInfo ()
"t ‘Daclare a variable of your user-defined type
Cim NewCustomer As CustomarRecord

' Use contents of variocus text boxes on a form to £ill in values to
' the elements (fields} of your new CustomerRecord variable
NewCustomer.CustNum = Val (txtNumber.Text)

NewCustomer.CustAddressl = txXtAddrl.Text

NHewCustomer.Cusathddress2 = txtAddrl.Text

HewCustomer.CustZip = txrlip.Taxt

W ) gy AR I

10 End Sub

Arrays

Visual Basic, like many other programming languages, allows you to create arrays.
An array is a group of variables of the same data type that share a common name.
Each separate element of the array is identified by a unique index number.

' Declare an array
Dim ArrayName (UpperBounds) As DataType
Dim TestScores(23) As Single

Note By default, the first element in the array is referred to with the index O
(zero). This creates an array of 24 (not 23) single-precision numbers in which you
could store the scores for 24 students.

If you wanted 1o print this score out 10 the form, you woul!d use the following:

Print "The test score for the first student is: "
Print TestScores(0)

There is an alternate syntax for declaring arrays that allows you 1o specify the lower
(beginning) and upper (ending} indexes, or bounds, of an array. You couid declare
an array to hold 24 test scores like this:

Dim TestScoraes{l To 24) As Single
You would then refer to the first element in the array as TestScores(1).

If you didn't have arrays, you would have to create 24 separate variables, named

~ something like Scorel, Score2, Score3, and so on.

In the module on looping structures, you will discover that loops are a very useful
tool for accessing elements in an array.

Note To change the default lower bound to 1, place an Option Base statement in
the General Declarations section of the module, like this:

Option Base 1
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Variations on Array Declaration Syntax

Depénding upon where the array is declared and the special needs of your program,
the syntax to declare an array may vary a bit. Here is a table that summarizes the
“rules.

""Séd;-ie'éf variable declaration = Keyword to use

Application-wide Global (Used only in the General Declaraiions section
of a .BAS module))

Form or module level Dim (Used in the General Declarations section of a
form or medule.)

Within a procedure Statie (If the entire procedure has been declared Static,

then you may use the word Dim to declare the aav)

Multidimensional Arrays

The array described in the last section, TestScores, is an example of a one- ,
dimensional array. You could think of it as representing a single column (or row) of
numbers. You can also declare an array of several dimensions. The maximum -
number of array dimensions allows in a Dim statement is 60. For example, to
represent a table of humbers you can deciare a iwo-dimensional array as follows:

Sub GetNumbers (}
Static Tablei{4, 23) Aa Single

-0Or-

Static Tablei{l Tc 5,7 1 Tc 24) As Single

End Sub

This would create an array of five rows of 24 test scores each and provide room to
hold five scores for each of 24 students. ’

Dynamic Arrays

There are times when you want to use an array, but the size needed will change at
run time. Visual Basic allows you to create dynamic, or variable-length arrays by
doing the following:

Declare the array without declaring its size with either the Dim statement (for a
form- or module-level array) or the (Global statement {for a global array). To do
this, just place an empty set of parentheses to the right of the array name:

' Place in General Declarations section of a form or module
Dim DynArray() As String * 25

=0r-
Global DynArray() As String * 25 ' Place in MODULELl.BAS

Here is another example:

Global DynIntArrayi(} As Integer
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i

Then inside a procedure, when you know the size you need for this array in some
particular circumstance, redimensicn the array to the size you need:

" Example 1  sub UaeArray ()

w .

2 ' Notice you can use a variable from your program to set the size
3 ReDim DynArray( Listl.ListCount)

4 End Sub

Important Each time you use the ReDim statement, all the values currently
stored in the array are lost, and each element is reset to zero or a NULL string
depending on the type of the elements in the array. If you want (o preserve the

values during re-dimensioning of the array, use the Preserve keyword.

ReCim Preserve MyArray(UBound (MyArray} + 10)

In this case, you are re-dimensioning an array called MyAuray 1o be 10 elements
larger while maintaining existing data.

Control Arrays

Visual Basic has a special type of array called 5 control array, which has special
features and does not follow all the rules of slandard arrays.

You will learn t0 use contro! arrays in the course that follows this one in the
Microsoft University Visual Basic curriculum.
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Key Terms

'
n

Using Variables and Constants
Scope
Additional Visual 8asic Data Types

Objectives

In this module you learned to:

e List and .escribe the seven variable data types in Visual Basic.
s Correctly identify the six type declaration character symbols.

» Use the contents of CONSTANT.TXT.

. Distinguish among the various levels of scope in Visual Basic.
s Explain the rules for using each level of scope.

s Declare and use a user-defined data type.

s Declare and use simple arrays.
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Lab Time

Go o the Using Constants and Variables portion of your lab manual.
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..

Y—Overview

Visual Basic Procedures
Scope of General Procedures

writing Code in Visual Basic _
String and Numeric Conversion Functions

Overview

This is the "Everything You Ever Wanted to Know About Writing Code...But Were
Afraid to Ask" module. It gives you the background and procedures needed to begin
writing the Visual Basic code that implements the interfaces.

Prerequisites

To successfully complete this module and its associated lab, you should have a
detailed understanding of forms, controls, and properties as they are implemenied in
Visual Basic. '

Knowledge of any block structured programming language is required.

Overall Objectives
There are two overall goals for this module:

1. To quickly review most of the fundamental procedures of Basic as it is used in
the Visual Basic product )

2. To show students the first steps required for completing the code for an
.applicaton

Learning Objectives
At the end of this module, you will be able to:

s Define important characteristics of Functions and Sub procedures and write
code that correctly uses both.

s Define and comrectly code for-appropriate scope of data.
s Write code that uses any of the cornmon Basic data types.
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Sample Code

The best way for you to leam how to write Visual Basic code is to read it. Sample
code for a four-function calculator application can be found in the
OVB\SAMPLES\CALC subdirectory.
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[T

.= Sub Procedures

» Functions
= Arguments and Parameters
= Procedures
Event Procedures
‘General Procedures’
Methods

Syntax

Syntax

What Are Piocedures?

A procedure is a block of Visual Basic statements that are called as a logical unit.

Two Types of Procedures — A First Pass

Sub Procedures

After the Sub procedure completes its work (executes its code), it reums to the
procedure that called it.

Sub SubName ()
statementblock

End Sub

Functions

A Function is similar 10 a Sub procedure. In addition, it has a data type justas a
variable does. After it completes its work. it returns a value of that type to the
procedure that called it.

Function FunctionName() As SomeDataType
* statementblock
FunctionName = SomeValue

End Function
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Cadlling a Sub Procedure with Arguments

EventP moadue
| sub Commandl click ()

DisplayError "MyError"

End Sub

.:- t> Sub DisplayError (ErrMsg As Stririg)
_lblError.Caption = ErrMsg

End Sub

Syntax

Syntax

Arguments

Any procedure can be defined to receive data when it is called. A piece of data sent
to a procedure is called an argument: and an argument is matched to its equivalent
parameter enury in the procedure list. Each parameter is declared 10 be of a specific
data type. . - :

" The following is a Sub procedure that receives two arguments; -

Sub SomeSub (Param! As Integer, Param2 As Single) .
statementblock '
End Sub

When you call this procedure you must make sure to pass it the same number and
type of arguments in the same order they appear in the Sub definition.

~ SomeSub Argument!, Argumeni2

=0Or-
Call SomeSub (Argument!, Argument2)
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Example

 The following calls a Function procedure with arguments. _

Module 9: Writing Visua! Basic Code 0

Dim Result As Integer

- Result = SomeF unction (Arg_un_zeml » Argument2)

- Funiction SomeFunction (Parami As Integer, Param2 As Single)

A As Integer
Statehemblock
SomeFunction = Remrn.Value

End Function

Note The argument names used when you call the procedure do not have to match
the argument names used in the definition of the procedure as they do in the above
example. The number, data type, and order of the arguments must maich in the
procedure definition and call.

An alternative notation for the function return value data type is as follows.

Function SomeF unction% (Param! As Integer, Param2 As Single) .
StatementBlock

‘ L.?omF unction = ReturnValue

End Function ‘ -

Note Function procedures with an explicit retum value dala type are more
efficient than those with a Variant retum value data type.

Remember what we said about Variant data types earlier? If your argument is a
Variant and its corresponding parameter is not, the Variant argument must be
passed by value. This is accomplished by putting a set of extra parentheses around
the Variant argument.

You can accomplish the same objective by using the ByVal keyword when you
declare your parameter in the procedure.

[

Function Reverse (S As String, ByVal N As Inteqger) As Variant
'...SomeStatements
End Functien

w N

Dim U As Variant, V As Variant, W As Variant
"V = "Tasting"

W o= 10

U = Reaverse {{V), W)

~ h b &

/7
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Passing Arguments by Value

Visual Basic passes arguments by reference as a defauit. What this means is that

.the procedure can modify the values of the arguments in the procedure list because
. itknows the address for the data. This in effect allows you to pass back more than
~ one valie merely by changing the arguments within the procedure.

In contrast, you can pass an argument o a procedure by value, which means that the
procedure receives only a copy of the data and cannot modify the value of the actual
argument. Any changes made to the argument within the procedure are local and
have no effect on the actual data. :

To pass an argument by value, use the keyword ByVal in the parameter listor put a
set of parentheses around the argument in the calling statement.
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Types of Procedures —— - —— -~ —.~—

a Event Procedures
s General Procedures

Types of Procedures — A Second Pass

Visual Basic applications have two categonies of procedures: event and general.

Event Procedure

An event procedure is a procedure invoked by a user- or system-triggered event.

Event procedures are always attached to a given form or control. The first part of an

event procedure’s name indicates which object it is attached to.
Syntax - Sub objectname_eventname ()
statementblock

End Sub

Examples of event procedures are: Commandl_Click and Form_Click. If the user

clicks on the command button named Command1, the event procedure -
Command1_Click will be called; but if the user clicks on the form, the everit

procedure Form_Click will be called.
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Creating the Event Procedure

L Procedure Name Determines

What Event to Respond To

Obiject: IHaIloBunon gj Proc: | Click

Sub HelloButton Click ()
Readout .Text = "Hello, World!"
End Sub

Example

Templates (Sub and End Sub siaiements) are supplied for all the events Visual
Basic automatically recognizes.

All you need to do is fill in the code:

1. Open the Code window.

2. In the Object list box, select the appropriate object.

3. In the Procedure list box, select the appropriate event.
4. Type code into the template provided by Visual Basic.

Calling the Event Procedure

You don't have to do anything to call the event procedure. Visual Basic
automatically recognizes all the events for all Visual Basic objects {forms and
controls). As soon as a user or the system triggers an event for an object. the code in
the appropriate event procedure will be run by Visual Basic.

Scope of Event Procedures

Event procedures are only available on the form where they were defined.

. ‘Note . Event procedures may only be Sub procedures, not Function procedures.

The following is a Click event procedure for a command button.

1 Sub Commandl _Click {)

2 ' This value can be found in COESTANT.TXT

3 Conat RED = sHFF& .

4 ' Sat the background color of the form to red
5 Forml,BackColor = RED

6 End sub
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1

References

A large number of event procedures are available for your use in Visyal Basic. The
ones set in italic type below are covered in this course, and the remaining event

" procedures are covered in the Programming in Microsoft Visual Basic 3.0 course.

" Action Event

Change to control Change
DropDown {combo box only)
PathChange, PatternChange (file list box only)
Drag and drop DragDrop, DragOver
Dynamic data exchange LinkClose, LinkError, LinkExecute, LinkOpen
(DDE) )
Keystroke : KeyDown, KeyUp, KeyPress
- Mouse ' ) Click, DoubleClick, MouseDown, MouseUp,
MouseMove
Shift in focus GotFocus, LostFocus
Timer interval Timer
Forms and picture FPaint, Resize, Load, Unload

Use the online Help or the Microsoft Visual Basic Language Reference (0 find
descriptions of Lhe event procedures in Visual Basic.

.
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General Procedure

New Procedure

Type
E@ Sub O Function

Name: | NewProc

s om0 O R B R A A e

Example

A general procedure is a procedure executed only when explicitly called by another
procedure.

Creating the General Procedure

- PUR I

e ) hoWn

1. Open the Code window.

2. From the View menu, choose New Procedure.

3.

4. Add the code to the procedure template provided by Visual Basic. If you are

Type the name for the procedure, and choose either Sub or Function.

creating a new function, remember 10 define the return type of the function and
to include a statement in the code assigning the value you want returmed to the
function name.

Function StockValua {¥umShares As Integer, SharePrice As Single)
A As Single

StockValue = NumShares * SharePrice
End Functlieon .

Sub TotalStock ()
Print "Total value of all stock is: " )
Print StockValue{10, 123.25) + StockValue{20Q, 1%.75)
End Sub '

Calling the General Procedure

You must explicitly call a general procedure, or the code will never be run.
Typically, you place a call 10 a general Sub or Funcuon inside an event procedure
or inside another general procedure.
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il —Scope of General-Procedures——— -

Nt

Event

- "-Change‘ 'Textl_Change |
‘ return

ClCK | cmd1 Click |™= {DisplayBarChart

o return I
Click ’ __

Event mamp| Cmd2 Click

return

Form-Level Scope of Code (.FRM)

The scope of a general procedure depends on where it is defined. If you follow the
steps listed above while you are in the Code window for one of your forms, then
that procedure is available from anywhere on that form only.

. Global Scope of Code (.BAS)

If you have a muitiple-form application and need to be able to call certain
procedures from anywhere in your application, you will need to create a separate
BAS module 1o hold those procedures.

Note, for example, if DisplayBarChart is defined as a general procedure for Forml,
then Texil, Cmd1, and Cmd2 must ail be controls on Formt. If, however,
DisplayBarChart is defined in a separate .BAS module, Text!, Cmd!, and Cmd2
could each be on a different form and still be able to call DisplayBarChart.

Private Scope of Code (.BAS)

1n some cases, you will want 1o limit the accessibility of a procedure contained
within a module. In order to do this, use the Private keyword in front of Sub or
Function definitions.

. Declaring a Private Sub Procedure
Syntax Private Sub SomeSub ()
SomeStatements

End Sub
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Syntax

References

)

‘The following calls a method from an event procedure attached to a form:

Declaring a Private Function
Private Function SomeFunction () As Integer

SomeStatements
End Function
Method

A method is a special type of proceddre provided for you by Visual Basic for
specific objects but not associated with a specific event.

Special Characteristics of a Methbd

1. You cannot creaie a method; you can only call it.
2. You cannot view or change the code for a method.

3. The names of all Visual Basic methods are keywords. You cannot creale a
general procedure of your own with the same name as a Visual Basic method.

~

Sub Form_Click() ' Form Click event for Forml
Form2.Show ) ' Display Form2
End" 5ub -

Methods in Visual Basic
A large number of methods are availabie for your use in Visual Basic. The ones set
in italic type below are covered in this course.

Drawing and graphics Circle, Cls, Line, Point, Pset
Printing " EndDoc, NewPage, Print, PrintF orm, TextHeight,
‘ . TextWidth
DDE LinkExecute, LinkPoke, LinkRequest, LinkSend
List box management h Additem, Removeltem, Clear '
Clipboard - Clear, GetData, GetFormat, GetText, SetData,
' SetText
Moving controls Drag, Move
Form managerment o Hide, Show, Refresh, Scale, SetFocus

1

Use the online Help «: ihe Microsoft Visual Basic Language Reference 1o find
descriptions of the methods available for Visual Basic objects.
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A s Ty oag

Writing Code in-VisuaI-_Bc:sio---—---_w-_-.- e

L] Ed View Run Debug Options Window Help

Reds

Cut Ctrl+X
Copy Crl+C
Paste CtrieV
Bas: Lk

Delste Det
Find... Cirl+F
Find Next F3
Find Previous® Shift+F3
Replace... Ctri+R
Bring to Front  Cirle=
Send to Back Ctrl+-
Align to Grid

There are several facilities built into Visual Basic that make writing code easy. All
of the search and replace procedures discussed below let you search in the current
procedure only, in the current module only, or in all modules. :

Cutting, copying and/or pasting code

Edit menu, Cut or Copy. and Paste

Finding strings (variable names, for example) in code
Edit menu, Find

Finding the next instance of a string in code
Edit menu, Find Next

Finding the previous instance of a string in cods
Edit mesu, Find Previous

Finding and i'eplacing a string in code

Edii menu, Replace

Loading text from the hard disk

File menu, Load Text

Saving code as text out 1o the hard disk

_ File menu, Save Text

Note Visual Basic offers a useful feature for people writing code. By default it
checks the syntax of your code as you are writing it. This is good news because you
get constant feedback on the correctness of the syntax. Because there might be
times when some people find this intrusive, this option can be disabled.
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2. String and Numeric Conversion Functions

L

UCase$ Function

Visual Basic provides a number of prewritten functions that make your work with
strings a tot easier. Below is a partial list of prewritten functions, The focus here is

on what man:

:e| are the most important library functions. For a more detailed

listing of library functions, see Table I, "Functions, Statements, and Methods by
Programming Task"” in the Microsoft Visual Basic Language Reference.

Returns Variant

Returns String

Meaning/syntax, example, note

Chr

Format

LCase

Left

"LTrim

-~

Mid

Right

RTrim

Chr$

Format$
LCase$

Left$

LTrim$

Mid$

Right$

RTrim$

Returns a one-character siring for an ANSI
code argument. For exampie, Chr$(13) +
Chr$(10) is a carriage return and line feed,

" which creates as new line,

A powerful function that displays a number in
the format you request.

Returns the lowercase instance of an uppercase
character.

Remrmns a specified number of the lefimost
characters of a string. Left$(stringexpression,
nd&) See online Help for an example.

Returns the number of characters in a string or
the number of storage bytes required by a
variable.

Returns a copy of a string with lefumost spaces
removed.

Returns a string that is part of another string.
MidS$(stringexpressions$, start&, [length%])

Returns a specified number of the rightmost
characters in a string.

Right$(stringexpression, nd)

Returns a copy of a string with the rightmost
spaces removed.
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Returns Variant Returns String Meaning/syntax, example, note s
~StF Strs ' Converis a number (0 a sSTing of digiis.
Trim Trim$ ~ Removes leading and trailing spaces from a
I string.
“-UCase’ UCase$ Returns the uppercase instance of a lowercase
character.
Val Converts a string of digits to a number.

String Conversion Functions in the Employee Database

Function Sub procedure Form {
Chr$ (not used)
LCase$ © (not used)
Left$ _ (not used)
Len FillFields * EMPDB.FRM
. LTrim$ (not used) '
Mid$ FillFields EMPDB FRM
Right$ emdOK_Click ADDPHOTO.FRM
RTrim$ : FillFields EMPDB.FRM
Sir$ Form_Load EMPDB.FRM
. FillFields
UCase$ (not used)
Yal cmdView_Click EMPDB.FRM

Numeric Conversion Functions
There are a number of functions available within Visual Basic that will convert data
ypes.

Function Comments

CCur ) Converts a numeric expression to a Currency value,

CDbl ] Converts a numeric expression to a double-precision number.

Clnt Converts a numeric expression (0 an [nteger by rounding the
fractional part of the expression.

CLng Convens a numeric expressicn to a Long (4-byte integer) by
rounding the fractional part of the expression.

CSng . Converts a numeric expression (o a single-precision value.

CStr Converts a numeric expression to a String value.

Cvar, Convers a numeric expression or String to a Variant.

CVDate Converts an expression to a Variant of VarType 7 (Date).
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Format$ Function

) Form1.frm

Command1

Proc: { Click

Sub Commandl Click ()

Textl.Text = Format$ (Now, "d mmmm yyyy")
End Sub

11 February 1992

09:16 AM

This function converts a number to a string and formats it accorw.ng 1o instructions
contained in a format expression. :

Syntax , Format$(numeric-expression{, fmt$] )

fmt$

A format expression is a string of Visual Basic display-format characters that detail
how the numeric expression is to be displayed. '

Here are several sample format expressions and how the output would be displayed.

Format$(fmt$) Positive § Negative § Decimal .5
0.00 5.00 5,00 0.50

#4H0 5 S5 1
$4,4#0.00;(SH#40.00)  $5.00 (55.00) 50.50

The Now function can be used 10 rerurn the current system date/time as a serial
number. Date/time serial numbers can then be formatted with date/time or numeric
formats (because date/time serial humbers are stored as floating-point values).
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X

Example

further
Examples

Sub cmdDiaplayDate ()
ixtTodayaDate.Tex: = Format$ (Now, "mm/dd/yy"™)

End Sub

Format Display
“mydfyy 12/7/58
©wd-mmmm-yy 7-December-58
<.mmmm 7-December
. TeYY December-58

hh:mm AM/PM 08:50 PM
h:mm:ss a/p 8:50:35p
h:mm 20:50

h:mm:ss 20:50:35
m/dfyy h:mm 12/7/58 20:50

A complete description of the Format$ function can be found in Visual Basic Help.

.

A‘pplition Form Procedure
[conWorks ABOUTBOX FRM Form_Load )
) COLORPAL .FRM Txt_RGB_Change )

COLORPAL.FRM Display_New_Color_and_Elements
ICONEDIT FRM" Save_Settings_To_INI_File ‘
ICONEDIT.FRM Paste_ClipBoard_Contents
ICONEDIT FRM Save_Colors_To_INI File
ICONEDIT FRM Prepare_For_New_Icon
ICONEDIT.FRM Display_Mouse_Coordinates .
VIEWICONFRM  Form_Load B
VIEWICON.FRM Load_All_Icons
VIEW!ICON.FRM File_FileList_PathChange
VIEWICON FRM Form_Unload

IconWorks makes extensive use of the Format$ function. The above table is only a

partial listing.
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summary

*a Visual Basic Procedures

» Scope of General Procedures

= Writing Code in Visual Basic

» String and Numeric Conversion Functions

Objectives
In this module you learned to:

s Define important characteristics of Functions and Sub procedures and write
code that correctly uses both.

» Define and correctly code for appropriate scope of data.
»  Write code that uses the cornmon Basic data types.
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Lab Time

o

Go to the Writing Procedures portion of your lab manuat.
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> Overview.— — = moommme

= Control Structures
If...Then Blocks

Select Case Statements
Do While Loops

Do Until Loops

For...Next Loops

GoTo Statements

Overview

Control structures are a crucial part of any computer language because they enable
systematic decision making within the code. in this module you will leam how to
control the logical flow of your program. You will also leam how to mark off
blocks of code that are to be executed if a specified condition is true or false. You
will also learn how to specify the number of times that a given block of statements
is to be executed.

Prerequisites

This module assumes a fairly detailed understanding of coding mechanisms in
Visual Basic. You will also need proficiency in designing and building the user
interface for software applications. You should atready be familiar with:

= Forms and properties

s Statements, Sub procedures, and Function procedures

a General and event procedures, as well as methods

s Visual Basic data types

s Variables and constants

s Use of the MsgBox$ statement and concatenating strings
» String handling functions

Overall Objective

At the end of this module, you will be able to write code that provides systematic
decision making within an application, .
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Learning Objectives
At the end of this module, you will be able to use:

» If..Then...Else blocks
“u Select Case statements

s Do While loops

s Do Until loops

s For...Next loops

s GoTo statements
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—— 2, Control Structures- -

* ' {f...Then Blocks
» |f...Then...Else Blocks
s Select Case Statements
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if...Then Blocks

-

Bl ébhaiffon Then statement

If condition Then
statements
End If

Example

The foil shows that there are two possible arrangements for If...Then blocks. You
can use either a single line or multiple lines containing multiple statements. If you
have multiple statements, you need (o use End If.

Operators

There are six operators that you can use in the conditior nortion of the If...Then
block. :

Operator ' i Meaning

= Equal

<> Not equal

< Less than

<= Less than or equal to

> Greater than

>= Greater than of equal 10

Note In this case the = operator is not being used for an assignment statement,
such as: Readout.caption = *0."; instead it is being used for a conditional test.

T opt?uii"r.i.mo.\'alue = TRUE Then PositionType = "Full Tima"

Examples in the Employee Database Code

For a list of example If...Then blocks, If...Then...Else blocks. and Select Case
staternents in the Employee Database code, see the listing at the end of this module.
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L S

——— —It..Then..Else-Blocks - - -—— - -

-IF condition ] Then

statermentblock]

ELSEIF condition2 Then

statementblock?

ELSE

statementblockn

ENDIF

Here you get a ¢iance to test for several different situations and react appropriately
10 each one. Adding Else (o the If...Then statement provides much more flexibility
in the response.

Waik Through — If...Then...Else Example

To use the If...Then...Else statement

I.

5.

From the Waik Throughs program group, start IfElse.

When the application stans, there will be a form with a check box labeied Bold
with an X in it and a command button labeled Print Something.

The purpose of the application is to show an example of where an
If...Then...Else block might be used.

Click the Print Something command button.

The word "Something” will appear on the form in bold.
Click the Bold check box.

This removes the X from the check box,

. Click the Print Something command button.

The word Something will appear on the form with the bold format removed.
Close IfElse.

To create the If .. Then...Else example

1.

Start Visual Basic.

2. From the File menu, choose New Project.

Start a new project.
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. Select FontBold on the Properties list box.

View the Form property FontBold. Note that the defauit value is True. This

. means when the chkBold check box is created, its value should be set 1o

‘.

Checked.

ﬁéﬁblé—élick the check box too!l in the Toolbox.
Create a check box on the form. v

. Set the following properties for the check box: ,

Name chkBold
Caption Bold Font
Value 1 - Checked

Double-click the command button tooi.

Creale a command button. ‘

Set the following properties for the command button:
Name cmdPrintSomething

Caption Print Something

Now that you have created the interface, you need to add the code 1o make it
function. ’ ’

8. From the Project window, choose View Code.

10.

11.
12.

In the Object list box, select chkBold _Click.,
Add the following code:

Conat CHECKED = 1° ‘
If chkBold.Value = CHECKED Then
Forml.FontBold = TRUE
Else ’

Forml.FontBold = FALSE
End If ’

This will cause the font (o be set to bold or not, depending on how the user has
set the check box.

In the Object list box, select cmdPrintSomething_Click.

Add the following:

Print "Something®

This will print the word Something to the form. Depending on the value of the

~ check box, it will be in bold format or not.
13.
14,
15.
16.
17.

From the Run menu, choose Start.

From the Run menu, choose End.

From the File menu, choose Save As.

Save the form as IFELSE.FRM in \WALKTHRUNLOGIC.
Save the project as IFELSE.MAK in\WALKTHRU\LOGIC.
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—— ————

Select Case Statements” -

*" “select Case testexpression

Case expressionlist]
statementblock 1

Case expressionlist2
statementiblock2

Case Eise
stcrementblockn

End Select

Select Case statemenis look a lot like [f...Then...Else blocks, and there is a good
reason for this: Select Case stalements offer the same kind of functionality but in a
much more efficient— for both the code and the coder —manner. As.you can see
from the example, Select Case statements work particularly well as a means for

handling structured choices offered to the user,
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Walk Through — Coding a Message Box with a
Select Case Statement

‘In another module, you created a message box that prompted users to save their data
« prior to closing the application. This message box allowed users three choices: Yes,
No, and Cancel.

This module has provided the tools needed 10 write code to detect which button the
user clicked: the Select Case statement.

E To code a message box with a Select Case statement:
© 1. Stan Visual Basic.
2. From the File menu, choose Open Project.
3. Open MSGBOX2 MAK,

This file is located in \WALKTHRUNLOGIC and should already contain the
following: . '

Sub Commandl Click ()
' The values for MagBox conatant declarations
' come from \VBE\CONSTANT . TXT
' MagBox parameters
. Conat YESNOCANCEL = 3 - ' Yes, No, & Cancel btns
Const ICONQUESTION = 32 : ' Warning query
Mag$ = "Have you saved all your work?”
MsgBox Mag$, YESNOCANCEL + ICONQUESTION, "MagBox WalkThru" -
End Sub

In order to get the butiens to respond appropriately, you need to add a nurﬁber of
statements {o this. Do that by declaring a variable and several constans.

4. In design mode, double-click the command buuon on the form.
This opens the Code window with the event procedure code in it.
5. Add the following code to the Code window:

Const CANCEL = 2

Const YES = §

Const KO = 7

Dim MB_Response As Integer

The Cancel, Yes, and No declarations define more meaningful names for the
values :nat are retumed for each of the buttons. For example, if the user clicks
the No button on the message box, the value 7 is returned by the sysiem. For
code readability and maintainability, you should place Const declarations in

- your code and use the constants in the Select Case statement. Remember, you
can find the correct values to declare in \VBN\CONSTANT.TXT or by searching
online Help for the 1opic MsgBox function and checking the table of retum
values.
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Al

In the earlier message box example, you created a message box by cailing the
"MsgBox statemén(. Evén though you creatéd a message box with three buttons,

you had no way to tell which buton the user clicked. Another way to create a
message box is to call the MsgBox function. In this case, you need to declare an
Integer variable to receive the value the MsgBox function returns.

" Next, you need to alter the MsgBox statement, making it into a function cail.
Remember, when you call a function you must assign its return value to the
appropriate type of vanable. If you pass the function any arguments, the
argument list must be enclosed in parentheses. ' .

6. Edit the original MsgBox statement so that it reads:

MB_Response = MagBox (Mag$, YESNOCANCEL+ICONQUESTION,
A"MsgBox WalkThru™)

Now you need to add the Select Case statement. You may want (o add only the
actual code and teave the comments out.

7. Add the following code:

' When an integer value is returned by MagBox function
Select Case MB_Respcnse
' if it matches the value of the Const YES (6),
‘Case YES : .
' indicate that the user clicked the Yesa button
Print "User clicked Yes"
' if it matches the value of the Conat NQ (7),
Case NO ’
' indicate that the user clicked the Ne button
Print "User clicked No"
! if it matches the valus of the Conat CANCEL {2),
Case CARNCEL .
' indicate that the user clicked the Cancel button
Print "User clicked Cancel”
End Select

8. From the Run menu, choose Start.
Test the code of your application.
9. From the Run menu, choose End.

Close the application.
End the walk through.
Examples in the Employee Database Code
Form ) Procedure/Routine Controt! structure type
EMPDB FRM FillFields ' If...Then
RS If...Then...Else
emdDelete_Click Select Case statement
FillFields Select Case statement

ADDPHOTO.FRM cmdOK_Click If...Then..Else
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Y. Loops

"s Do While
= Do Until
= For...Next
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DO.LOOD - - o e -

Do While condition
¥ -statements
Loop

-Qr-
Do

statements
Loop While condition

Use a Do...Loop to execute a block of statements an indefinite number of limes.
(By contrast, For loops let you specify how many times a set of statements are
executed.) In Do... Loop While loops the numnber of times the loop is executed is
controlled by a True/False condition, When some other event switches the value of
the condition from True to False, the looping stops.

What's the Difference?

The location of the While condition is the key difference between the two examples
of syntax above, but what does that mean? [f the While condition ts at the top of the
block, the statements within the loop will not be executed if the condition is false 10
begin with. The block of statements will always be executed at least once if the
While condiuon is placed at the bottom of the loop.
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Walk Through — Coding a Do While L00p

Z To code a Do While loop

1 Start Visual Basic.

From the File menu, choose New Project.

. Double-click the command buuo_n tool in the Toolbox.

A command button appears on the form.

. Double-click the command button on the form.

This will open the command button Code window. -

. Add the following code to Form1.frm:

Sub Commandl Click {)
Dim I As Integer
I =1 -
Do While I <= $
Print I
I=1I+1
Loop
End Sub

. From the Run menu. choose Start.

Run the application,

. From the Run menu, choose End.

End the walk through.
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Do.loop

Do..Loop Until'loops are almost identical to Do... L00p While, but they test to see
if condition is false rather than true.

For further examples of ...Loop While, see the following.

Application Module/Form Procedure/Routine
[conWorks ICONWRKS.BAS ~ Help_File_In_Path

Walk Through — Do .Loop While with Lists

To use Do...Loop While with lists
1. From the Walk Throughs program group, start Do While with Lists.

When the application starts, a form with a list box and a command button
labeled Add To List appears.

The purpose of the application is to show an example of using a Do...Loop
While structure.

2. Choose Lhe Add To List button.
An input box will appear prompting the user to add an item 1o the list box.
3. Type some text and choose OK. '

The text just typed in the text box will be added as an item to the list on the loop
example form.

4. Repeal the above step several times.

Note that if you add more items to the list than can be displayed at once in the
list box, a vertical scroll bar will automaticaily be added to aliow you 1o view all
iterns. In the case of this example, you must add at least seven items (o the list to
make a scroll bar appear.

5. Quit the application.

To use Do While loops in list processing

1. Start Visual Basic.

2. From the File menu, choose New Project.
Start a new project.

3. Set the following properties:
Caption Do Loop While Example
Height 4035 (approximately)

. Width 3870 (approximately)
Left 5565 (approximaiely)
Top 1290 (approximately)

4. Double-click the list box tool in the Toolbox.
Create a list box on the form.
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. Set the following properties:

Height 1455 (approximately)
© Width 1215 (approximately)
CReft--- 960 {approximately)

Top 360 (approximately)

. Double-click the command button tool in the Toolbox.

Create a command button.

. Set the foilowing properties:

Narne cmdAddToList
Caption AddtwlList =
Height 375 (approximately)
Width 1215 (approximately)
Left 1080 (approximately)
Top 1920 (approximately)

Now that ycu have created the interface, you need 1o add the code to make it
function,

. From the Project window, choose View Code.

9. In the Object list box, select cmdAddToList_Click.

10.

Add the following code:

- Dim Reaponse As String

Co - .
Response = InputBox$("Item to add:", "Add Item”, “", @, 1000)
If Response <> "" Then Listl.AddItem Response

Loop While Rasponse <> "7 e

By creating a While loop with the test at the bottom. you ensure going through
the loop once to prompt for input, before any conditions are tested.

An input box is similar 10 a message box, except it contains a text field for user
input. The arzuments for the input box are:

Argl = Prompt

Arg2 = Title bar caption

Arg3 = Default value for text box
Argd = X-position for input b‘ox
Arg5 = Y-position for input box

" An If test is added so that the empty string that indicates the user wants 1o exit

11.

the loop will not be added as an item in the list.

Keep this project open, because in just a moment you are going to add a Do
Until loop.

Test your code.

.End the walk through.
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DoUntil - - e

Do Until condition

T statements
Loop

=0Or-~
Do

statements
Loop Until condition

Do Until is the opposite of Do While. The statements in a Do Until loop are
execuied only while the condition is False. A Do Until condiuon is the equivalent
of a Do While Not condition.

Walk Through — Do Until Example

E To use Do Until
1. From the Walk Throughs program group, start Do Until.

This is an enhanced version of the previous Do While example. When the
application starts, a form with a list box, a command button labeled Add To List,
and another command button labeled Clear List appear.

The purpose of the application is to add an example of using a Do Until
structure. ) :

2. Choose the Add to List button.
An input box will appear prompting the user 10 add an item to the list box.
3. Type some text and choose OK.

The text just typed into the text box will be added as an item to the list on the
Loop Example form.

4. Repeat the above step several times.
" Add several items 1o the list.
5. Chogse the Clear List button,
All items will be cleared from the list box.
6. Quit the application.
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Z To create the Do Until example

L.

o

"2,

Start Visual Basic.

Make sure that you are still workmg on Lhe Do While walk through.
Set'the followmg properties for the form:

Caption Loop Example

Double-click the command button tool in the Toolbox.

Create anothet command button.

Set the following properties of the command button:

Name emdClearList
Caption Clear List

Height 375 (approximately)
Width 1215 (approximately)
Left 1080 (approximately)
Top 2520 (approximately)

Now that you have created the i~*=rface, you need to add the code to make it
function. .

5. From the Project window, choose View Code.

In the Object list box, select cmdClearList_Click.

7. Add the following code:

Do Until Lisatl.ListCount = Q
List]l.Removeltem 0
Loop

A Do Until loop can be used to keep removing items from List1 until the list
box is empty. The ListCount property keeps track of the number of items
currently in the list.

Inside the loop is a statement to call the Removeltem method. When you pass a
zero 1o Removeltem, you are teiling it to remove the top item in the list.

Rather than setting up a loop, you can clear an entire list box with the clear
method.

Liatl. clear

From the File menu. choose Save File As.
Save this file as DOUNTIL.FRM and the project as DOUNTIL. MAK in the

~ \WALKTHRUNLOGIC subdirectory. You will need these files in the For Loop

lab.
End the waik through.
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~For..Next—--— - - -« ————

.

N

--For counter = start To end ( Step increment)

( _sfotemenrs ) -
( Exit For)
( statements)

- Next ( counter)

For...Next loops are used to execute a block of statements a fixed number of times.
The key difference between a For...Next loop and a Deo...Loop is that a For...Next

loop includes a counter that increases or decreases with each repetition of the loop.

Complete the demonstration for an example of For...Next toops.

Walk Through — Using Visual Basic For...Next
Loops
'To use For...Next loops
1. Stan Visual Basic. i
Open Visual Basic. Open a new form.
2. From the File menu, choose New Project.
3. Double<click the command tutton tool in the Toolbox.
This will open the command button Code window.
4. Add the following code in the Code window:
5. Add the appropriate code to the Commandl_Click event:

Sub Commandl_Click ()
Dim I As Intager
- For I = 1 to 6
Print I
Next I
End Sub

6. From the Run menu, choose Start.

Test the application you have created. The default value for Step is 1. The
application prints the numbers 1 through 6 on the form.
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Example

10.

. From the Run menu, choose End.
In the Code window, change the Step value to 2.
. From the Run menu, choose Start.
Test ihe application again.
How has the output you are gewing changed?
How would you change the For...Next loop to dlsplay only even numbers?
From the Run menu, choose End.
End the walk through.

A more sophisticated use of the For...Next loop can be found in Visual Basic Help.

1
2
3
4
5
6
7
8
9

10
11
12

1y

..Next Statement Example

Sub ForNaxtDemc ()

NL$ = Chr5{l3) + Chr$(10) ' Cefine newline.
For Rep% = 5 To 1 Step -1 ' Set up five repetitions.
' Equatae alphabet t¢o numbers.
For Indx% = Asc{("A") To Asc{"Z™)
' Append each_le:tér te string.
Mag$ = Mag$ + Chr$(Indxs)

"Maxt Indxd '
Mag$ = Mag$ + NL$ . ' Add newline for each rep.
Next Rept : :
MagBox Msg$ ' Display resulits,

End Sub

Notice that one For...Next loop is "nested” inside the other in this examplc" This is
a powerful 100l for processing multiple rows or columns in arrays. ’

If you want to see this code running, follow the directions detailed above and make
the appropriate modifications to the code so that it executes as the result of a
command button being clicked.
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. Walk Through — Another For.Nextloop - - - -

Example
“ Z To use another For...Next loop
*- .. 1..From the Walk Throughs program group, start ForLoop to Clear List.

This is an enhanced version of the prévious Do While example. When the
application starts, a form with a list box, a command button labeled Add To List,
and another command button labeled Clear List appear.

The purpose of the application is 10 change the example to use a For...Next loop
1o clear the list.

2. Choose the Add to List button.
An input box will appear prompting the user to add an item to the list box.
3. Type some text and choose OK. )

The text just typed into the text box will be added as an item Lo the list on the
loop example form.

4. Repeat the above step several times.

Add several items to the list.
5. Choose the Clear List button,

All items will be cleared from the list box.
6.. Quit the applicalion. '

2 To create the For.. Next loop example
1. Start Visual Basic.
2. From the File menu, choose Open Projecl.
3. Open DOUNTIL.MAK.

Open the project from the Do Until Walk Through. it is located in the
\WALKTHRWNLOGIC subdirectory,

4. From the Project window, choose View Code.
5. Inthe Object list box, select cmdClearList_Click.
6. Replace the existing code with:

Dim I As Integer

For I = 0 Ta Listl.ListCount-1
Listl.RemoveItem O

Next I

You can use a For...Next ioop to keep removing items from List] unui the list
" box is empty. In this case, the range for the loop will be from O (the top item in
the list) to ListCount-1 (the last item in the list).

Inside the loop is a statement to call the Removeltem method. When you pass a
zero 10 Removeltemn, you are telling it to remove the top item in the list.

Further For further examples of a For...Next loop see:
. Examples ’ . .
Application Module/Form Procedure/Routine

Employee Database EMPDB FRM Form_Load
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The GoTo Statement

EMPREC.FRM

Proc: [ AddEmp Y )

Sub AddEmp () .
If PrintIt Then GoTo PrintlLabel

Exit Sub
PrintLabel:
Print "Made It ToHere!"
End Sub

Style
Guidelines

Further
.Examples

GoTo causes execution 10 jump from the GoTo statement to another location
marked by a label or line number.

Even though the GoTo statement doesn't enjoy much favor these days, Visual Basic
supports it, and there are several places where there is an obvious use for it. Error
handling is a particularly gooe! >xample.

Note GoTos are not like procedures; there is no standard return from a GoTo as
there is from a procedure.

s Each line label must begin with an alphabetic character.
Each line label must end with a colon.

s Each line label must be unique within its own module.

s Each line label can have no more than 40 characters.

s Do not use Visual Basic keywords in line labels,

w Line labels are not case sensitive.

» A line tabel must start with the first nonblank character on a line, but it need not
be in'the first column, Visual Basic forces it to the leftmost column.

Examples

Additional sample code is located in Visual Basic Help.
For further examples of GoTo statements see the following.
Application Module/Form Procedure/Routine

IconWorks ICONWRKS.BAS Validate_FileSpec
Employee Database EMPREC.FRM AddEmp
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2

Summary - . - ——

L

.a.Control Structures
If...Then Blocks
Select Case Statements
Do While Loops
Do Until Loops
For...Next Loops
GoTo Statements

Objectives

In this module you learned 10 use:
a’ If..Then...Else blocks

= Select Case statements

s Do While loops

= Do Until loops

w For...Next loops

s GoTo statements
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Lab Time

Go to the Conditional Logic and Loops portion of your lab manual.
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Y -Overview-—— —

"'s Debugging Terms
= Debugging Code in Visual Basic
Using the Call Tree
Using Watch Variables to Monitor Program Execution

Overview

" Visual Basic offers programmeré of all skill levels a set of robust tools to use during
application development.

Prerequisites

Prior 10 starting this module, you should already be familiar with:
» Conirols, forms, and properties

s Function and Sub procedures

w General and event procedures

Overall Objective

The overall objective of thi .odule is to introduce you to some of the most useful
debugging tools available ... visual Basic. This is not intended to be comprehensive
reatment of debugging techniques in general.

Learning Objectives

At the end of this module, you will be able 10:

» Distinguish among run, design, and debug modes in Visual Basic.

s Use the Waich window to display the current values of variables within a
program.

w Set breakpoints within code.

= Single step through applicauon procedures.
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Debugging Terms

"= Watch Expressions
= Watch Point Variables
Watch point — break when true
Watch point — break when changed
» The Debug Window
The Immediate pane (?, =)
Watch pone‘

Watch Expressions

A watch expression is a variable whose value is displayed in the Debug window
whenever a program enters break mode.

You can set a watch expression by opening the Debug menu and choosing either the
Add Warch or Edit Waich command. This can be done-in either design mode or
break mode. : .

Watch Point Variables

A watch point variable will cause a program (o enter break mode whenever the
watch point condition is satisfied.

You can set a watch point variable by opening the Debug menu and choosing either
the Add Wacch or Edit Watch command. This can be done in either design mode or
break mode.

Watch Point — Break When True

This watch point variable will cause a program 10 enter break mode whenever the
variable's value becomes true.

‘Watch Point — Break When Changed

" "“his waich point variable will cause a program to enter break mode whenever the
variable's value changes.

The Debug Window

The Debug window is broken into two parts: the Immediate pane (the lower half of
the window) and the Watch pane (the upper haif). The Immediate pane is where you
can have an interactive conversation with the debugger using either the question
mark (?) or the equal sign (=). The Watch pane is where the watch variables are
displayed during break mode. '
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— -Degu_gging-_;CAo_de_-tin_-\/;is_U'al:B_asiC'f

crosoft Visual Basic (desugn)

Add Watch .

Instant Watch... Shift+F9
Edit Watch... Ctri+W

Calls Ctri+L
Single Step F8

"| Procedure Step Shift+F8

Using the Visual Basic Debugger
This module is actuaily made up of a number of walk throughs that introduce you to
the various tools availabte within the Visual Basic debugger.

Walk Through — Using the Call Tree

Z To see the first sample application work
1. From the Walk Through program group, start Debugl.
2. CQlick the Call Procedures command button.
3. Observe the output generated on the form.

Debuy  Call List E-vrise
Start Calling Proceduros - Command1_Click
This is Procedwue A

RAenaning hom Procedus A
Retuming from Command?_Click

Note that Command! Click calls ProcedureA, ProcedureA calls ProcedureB,
and then ProcedureB calls ProcedureC.

4. Choose End.
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Z To examine the code for the walk through

The purpose of this walk through is to introduce you to two tools that you will find
very useful: the Call window and single stepping through code.

1.
2.

Stant Visual Basic.
Open the DEBUG1.MAK file located in \WALKTHRUNDEBUG.

3. Select MOD1.BAS in the Project window and click View Code.
4.
S. Examine the code for ProcC.

From the Procedures drop-down list box, select ProcC.

As it stands. this procedure prints two staternents at coiumn 49 on your form.
The other three lines are “commented out.”

Remove the three comment marks in front of the Stop and Print statements.

What will happen when you do this? You have added three new statements to
the application. The first one prints a message (o the form at column 40 that tells
you the application is going into break mode. The second statement actually
stops that application using Stop. The final statement prints a message to the
form that telis you that you have entered single-step mode after pressing F8
twice.

From the Run menu, choose Start.

8. Click the Call Procedures command button.

If you move the Code window from on top of Formi, you will see that the output
is slightly changed. Now it should look like this.

Debuyg Call ListE crrcise . )
Stant Caling Proceduses - Command!_Click
Thea i3 Pyocodurg A
Calling Procedus B
This 15 Procedurs 8

Notice that the calls are listed with the most recently called at the top.
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10.

Click the Show command button.

'!'-his'remms-you-zr.‘.-MOD1-:BAS.—

12.

13.

14.

15.

16.
17.

18.

19.

20.
21,

22.
23.

J19

You should see the code for ProcC with a box around the code line containing
the Stop statement.

. -Single step by pressing Fs once.

This will start you single stepping through the rest of the procedure. This makes
pzint "Geing into Single Step Mode" the next sialement to execule,

If you position both windows so that you can see almost all of them, yOu will see
Visual Basic work as you single step tmrough the application.

Press F8 one more time.

This executes the current Print statement and makes pzint "Returning from
Procedura c" the next statement to execute.

Press F8 a third time,

This executes the current Print statement (check the output on the form) and
makes the End Sub statement the next statement to execute.

Press F8 a fourth ume.

This executes the End Sub of ProcC and takes you 10 the next stalement to
execute in ProcB, which is the Print "Returning from Procedure B"
staterment. )

From the Debug menu, choose Calls or press CTRL+L.

“Note the most recent .procedure 1s now Procedure B.

Doing this verifies that the call list has changed since the return from ProcC.
Click the Show command button to retum 10 ProcB.
Press F8 a fifth time and then a sixth time.

This takes you through the remaining two Procedure B statements and takes you
to the next statement in PrOCA—Print "Returning from Procedure A".

Press F8 twice more.

This single steps you through the remaining Procedure A statements and takes
you to the next statement in Commandl_Click—print "Returning from
Commandl Click”,

Press F8 twice more. _

This takes you through the remaining the Command1_Click event procedure.
From the Run menu, choose Break.

From the Debug menu, choose Calls.

. Notice that no cails are listed. That is because no Sub or Function procedure is

currently "open” and your application is in idle waiting for the user to do
something.

Choose the Close command button on the Calls dialog box.
From the File menu of Visual Basic, choose Exit.

If you want to try this exercise a second time, do not save the changes to the
files.
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Walk Through — Using Watch Variables to
Monitor Program Execution

_Debugging Applications

- Debugging applications is somewhere between a science and an art. By careful use

of your debugging tools, such as breakpoints, watch variables, single stepping, and
procedure stepping, you can zero int on the logical bugs existing in your code.

This walk through applies breakpoints and watch expressions to locate a number of
logical errors contained within the code.

To see the second debugging application run
1. From the Walk Through program group, start Debug?2.
2. Click the Print File command button.

You get output 'lhal looks like this.

OEBUG2

10 20 30 40 50  Tolal= 150 Average = 30

12245 Tolal = 165 Avetage = 16
100 S0 25 75 200 Tols= 615  Avesage = 4%
109876 Total = 55 Average = 32

112233 45 Totai = B20 Avesage = 12

ISum of all totals = D
Avg ol all tolah = {1

This program lists five numbers, their total, and their average. It does this for
five sets of data. At the end, it prints the total of all the numbers and the average
for all the numbers. '

3. But examine the output carefully. It isn’'t giving you what you want: The totals
and averages aren’t COTTeCk.

If the application were coded correctly, final output should look something like
this.

10 20 30 40 SO Total = 150 Avmage = 30

12345 Tolsl= 15 Average = 3
100.50 25 75 200 Total= 450 Avmage = %0
‘fonaazrs Totsi= 40 Aversge = 8

M 2345 Total = 165 Average = 13

ISum of all totals = 920
Avy of ail totals = 32

You need to correct the logic, but where do you begin?
4. Double<lick the Control menu on the Debug? form to close the application.
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177If Visual Basic is not running already, start it.
2.
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o

From the File menu, choose Open Project to locate and start DEBUG2 MAK,
located in \WALKTHRUNDEBUG.

. Note that there ar.  +0 files 1o this project: DEBUG2.FRM and MOD2.BAS.

What are the global-level variables, and where they are located?

A

If you inspect the General Declarations section of MOD2.BAS, you will see
x(5), an Integer array, and sumcounter declared as an Integer,

There is also a String variable called FilenameS in MOD2 BAS.

What are the form-level variables, and where iﬁey are located?

If you inspect the General Declarations section of DEBUG2.FRM, you will find
Sum declared as an Integer. But, be careful here. Visually inspecting the
General Declarations section doesn’t tell you all you need to know, and this will
come back to haunt you a little later on.

Why do you need 10 know this? Awareness of the types and scope of the
variables within your application will help in the analysis of the code.

Z To analyze the procedures used in the sample application

L.
2,

In DEBUG2.FRM, examine the cmdPrintFile_Click event procedure.
Which general procedure is called in this procedure?

If you said the Readfile procedure from MOD2.BAS, you were comrect.  /

Examine the ReadFile general procedure in MOD2.BAS.

To display the source for the ReadFile general procedure, place the cursor in the
word ReadFile in the cmdPrintFile_Click procedure and press SHIFT + F2

Note the outer For...Next loop is controlled by J, whereas the inner For...Next
loop is controlled by L. These two loops control part of the calculations in your
application.
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2 To use breakpoints and watch expressions to chserve program behavior

In order to observe the logic flow and [ and I's values, we will use two watch
expressions and a breakpoint.

*1. Seta breakpoint on the next 13 line.

Place the cursor anywhere on the next 1% line and press F9.

2 'High]ight the 1% variable on the For I line.
3. From the Debug Menu, choose Add Watch.
A form will appear on screen that looks like this.

“Add Watch

Expressian:

 Context
@ Procedure lﬁeadﬁle

| © Eoimmisodule {MOD2.BAS ¥

QO Global '

r'Watch Type
® Watch Eapression
O Bieak when Expression is Tiue
O Break when Expression has Changed

4. Make sure that the values for the Add Watch window are as follows,

Control Setting -
Expression 1%
Procedure Readfile
Form/Module MOD2.BAS
Warch Type _ Waich Expression
5. Choose OK.
6. Repeat the above steps (1 thorough 5) for J% to create a watCh expression for
1%, '

You now have two watch expressions. Each time your program enters inio break
mode, the current values of these 1wo variables will be displayed at the top of
the Debug window.



2. To observe your watch expressions in action _
1
2.

-Start your program’by pressing Fs.
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e !

Armrange the windows so that you can see DEBUG2.FRM, the Debug window,
and MOD2.BAS code window.

" "You might want 10 arrange them so that they look like this.

= DED ={2tHw] Debug Window [DEBUGZ2.FRM} |

._MOD2.BAS B
<t [igenwan T8} Peiec [ Resdiie
Open Filename3 For Input As Frumid

For &R = % "0 § .
' Input : well¥, x{1), x(2), x(I), x(&), x(5)
Forsi.rrint .

Choaose the Print File button.

Because you have set a breakpoint, your application will stop execution on the
line Nexe 1%. -

Note the values of 1% and J% in the Debug window.

Right now they should each be at | because you are in the first iteration of both
loops. If you look at the owput of DEBUG2.FRM, you will see that the value 10
has been printed there.

Continue execution by repeatedly pressing Fs until 1% equals 2 and 1% equals 3.

Each time you press FS, your application enters break mode and the current
values of I% and J% are displayed in the Watch pane.

At this point you know that I% and J% are behaving correctly. It is time 10
pursue analysis in a different direction.

From the Run menu, choose End 1o stop execution of your program.
Press P9 to clear your breakpoint on the vext 14 line.
The .axt 1t line in the Readfile procedure of MOD2.BAS should already be

_ seieted; so press F9.

To this point, you have seen what we wanted to demonstrate about watch points and
watch expressions. If that is all you need from this exercise, then quit here. If,
however, you want 1o sharpen your debugging skills, continue on with the exercise.

The question here is this: What is going wrong with the application? First, it doesn’t

seem to be calculating the individual totals properly. You are ending up with a
value of 165 for the second set of numbers when it should be 15. Why don’t you
next set a watch point on Total%?



254 Module 11: Debugging Code In Visual Basic

Z To use watch points—break when expression has changed (Total %)

L

In the Code window for MOD2.BAS, locate the procedure Readfile and

- highlight the variable Totail% within the For [% loop.

2. From the:Debug menu, choose Add Watch.

3. Make sure that all the controls for the watch point are as follows.
Control - Setting
Expression Total%
Procedure Readfile
Form/Module MOD2.BAS
Watch Type Break when Expression has Changed

4.

Choose OK to close the Add window.

z To observe your watch variable in action

1.

From the Run menu, choose Start to run your program.

Note the entry added to the top of the Debug window. This will cause the
program (o enter into break mode whenever Total% changes.

You may need to expand the Waich pane display area in order to se¢ the
additional watch variable. ‘

. Click the Print File command button to enter the Readfile procedure.
. What is the first value for Total%?

If you said 10, you were correct.

Press F5 six more times (so that I% equals 1 and J% equals 2).

5. Now, whalt is the value of Totai%?

If you said 151, you were correct; but what should the value of Total% be at this
point, and what does that tell you?

The value for Total% at this point should be 1, because that is the first value for
the second pass through the J% loop. What this tells you is that you need to reset

~ the value of Total% before each entry into the 1% loop.

6. From the Run menu, choose End.

Add the following line just before the for 13 = 1 to s line:

Totaly = 0
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8. Test your change by running the code again. Notice that the total is.correct. -- -

\\\

You will notice that the-averages {61 the 1ast four sets of numbers have the
values 1, 30, 2, and 6. That is. they are still wrong. To fix this problem, what
other variable must you zero out before reentering the 1% loop?

If you said counter%, you were COrrect.

9. From the Run memu, choose End.

10. Add the following line just before the For 1% = 1 to 5 line:

Countert = 0

11. Test by running the progfam again.
12. Inspect the Total and Average for each of the five sets of data.

Total and Average for each set of numbers should now be correct. Compare
them with the correct output displayed earlier in this walk through.

13. Inspect the values displayed for the overall sum and average values.
* They are both 0. That can't be right.
14. From the Run menu, choose End.

Z To clear all watch variables and all breakpoin_ts
1. From the Debug menu, choose Edit Watch.
2. Choose Delete All 1o delete all watch points you may have setl.
3. Choose Close to close the Edit Watch dialog box.
4. From the Debug menu, choose Clear All to clear all breakpoints that are set.

Z To use watch points—break when expression becomes True (Sum)

At this point you have fixed the calculation of individual totals and averages. but
the calculation of the overall total and average is still wrong. For this reason,
closer examination of the Sum variable is warranted. ‘

1. From the Debug menu, choose Add Wartch.
2. Fill in the following entries:

~ Expression Sum>0
FormyMod DEBUG2.FRM
Procedure cmdClear_Click
- Break when Expression is True
Choose OK

3, From the Run menu, chéose Start.
4. Note the entry added to the top of the Debug window.

This will cause the program 10 enter into break mode whenever Sum > 0
becomes True.
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2 To observe your watch variable in action

. Press the Print File command button 1o run the program.
2. Did you ever enter Break mode?

Your program should ot have entered break mode because the variable Sum
was never greater than 0. '

. From the Run menu, choose Break. Notice in the debug window it specifies Sum

<Not in Context>. This is because Sum is a local variable and you are not
currently running the procedure that contains Sum.

4. From the Run menu, choose End._

Z To fix the code —using debugging and logical analysis to correct the code

. First of all, how many variables named Sum are in this application?

Remernber at the start of this walk through that we asked that question and said
that there was only one. Well, there are really two. If you said two, you were
cofTect,

7 . Look in the General Declarations section of DEBUG2.FRM. Notice that it

contains an explicitly declared form-level integer variable cailed Sum. This
variable is not available outside this form.

. Now look at the code in MODZ2.BAS. Is the variabie called Sum there, the same

one as in DEBUG2.FRM? No, this is an implicit variable local to the Sub
procedure Readfile. This is the source of your probiem.

How can you make sure that the variable called Sum in cmdPrintFile in
DEBUG2.FRM and the one referred 10 in Readfile are the same?

If you said delete the local variable declaration and make it Global, you were
nght. )

. Delete the declaration in DEBUG2.FRM.
5. Add the following declaration to MODULE2. BAS:

Global Sum Aa Integer

p)) _To test your scoping changes

. Run the program again.

After making these changes, you'll discover that the sum of all totals is 2025 and
average of all towals is 81. They're stll not right.

2. Choose End from the Run menu.
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3.

Set the breakpoint on Next 1% and the watch expressions on [% and J% in the _

'Readfile_procedure. (Follow. the guidelines outlined earlier-in the walk-through;

if you need to.)

_' 2 To single step through your program

L
2,

7.

" From the Run menu, choose Start.

Chlick the Print File command button.
The next line of code to be executed should be next 1%,

. Now, query for the current value of Sum by placing your cursor in the Debug

window and typing:
?Sum

Then press the ENTER key.

. Observe that the vaiue 10 displayed in the Immediate pane of the Debug

window. That's the curtent value of Sum.

. Step through the [% loop again, stopping at the same point as before, and query

the value of Sum.

Observe that the value 40 is displayed. However, 10 + 20 does not equal 40,
What's the problem? ' '

- If you said the line: sum% = Total + sum needs to be moved below the line: Next

I%, yOou're comect.

Cut and paste the line sum$ = Total + SumiO just below wext 1.

2 To test your logic changes

1.

Start and test the application again to see if it's working properly now.

2. Compare your output with the desired final output shown below.

106 20 30 40 50 Total = 150 Average= 30

12345 Total = 15 Average = 3
100 S0 25 75 200 Total= 450 Average= 90
1039876 Total = 40  Average= 8
11 22 33 44 55 Total = 165 Average = 33

um of all totats = 820
vg of all lotals = 32

3. Close the application and give yourself a pat on the back.

A

LIEN
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Summary

[ %

« Debugging Terms
= Debugging Code in Visua! Basic
Using the Call Tree
Using Watch Variables to Monitor Program Execution

e e b St
AT, Ton alz - Rl TR el
DR e g o gy R, RN

Obijectives
In this module you learned to:
a Distinguish among' run, design; and debug modes in Visual Basic.

e Use the Watch window to display the current values of vanables within a
program. ‘ '
Set breakpoints within code.

" Single step through application procedures.
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Scenario

Methods for Printing

Print-Related Functions
Using PrintForm

-Overview

- Printing to forms and printers can be as éomplicaled or as simple as you want to

make it. This module shows you some of the simple tricks that you can use to
prepare text for printing.

Prerequisites

To succeed in the module, you should already be familiar with:
s The general syniax for methods.

s Select Case statements and If...Then...Else blocks.

Overall Objectives

The purpose of this module is to give you an introduction to printing using Visual
Basic. This module is split into two topics: printing to a form and sending that form
to a printer.

Learning Objectives
At the end of this module, you will be able to:

" @ Use the Print method 10 create output directly onto a form.

» Describe how the AutoRedraw property relates Lo printing direculy 1o a form.

a Use the CurrentX and CurrentY properties of a form and the Spc and Tab
functions to control the placement of output printed (o a form.

s Use the Cls method to clear a form. ,
= Use the PrintForm method to send a bit-for-bit image of a form (o the printer.
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Scenario

= Printing a Form

LI

The specification for the Employee Database requires that users be able 10 pﬁm out
an individual employee’s personne! information.

Individual Reports | " -

You have determined that users want the individual report to include the following
information on individual lines:

Last narme, first name, and middle initial

Electronic mail alias and department code

Position type

Deduction information

e T o

Employee photo centered at the bottom of the page

After much work, you have determined that a workable individual report form
would look like this.

Employee Record Details

Employee: Richardson, Barbara, J.
Email:  barbarar Dept: SAL

Category: Full time

Deduct: ESPP . 401 (k) United Way
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_ . Methods for Prinfing . - | - -

N Form1.frm
Object: Proc:

Sub Form Click ()
Dim I As Integer
ForI=1t%to é

Print I
Next I
End Sub

N

Syntax

Overview

There are a number of different methods, functions, and properties you will need to
understand in order to print to a form and then send that form 1o a printer.

Methods Functions Properties
Print Spe CurrentX
Cls Tab CurretY
PrintForm Format AutoRedraw,

Fontsize, and so on

The Printer Object

The Printer object is a predefined object in Visual Basic. You can send output to the
Printer object using the Print method. When you are finished placing information
on the Printer object. you use the EndDoc method to send the output to the printer.
The output will print on your default printer.

Printer.Print "Here is some information on Page one."”
Printer.NewPage 'This causes a pags break
Printer.Print "Here is some more information®
Printer.EndDoc 'This sends the output to the printer.

The Print Method

The Print method is used to put a text string on a form, a picture box, or Printer
object using the current color and font. This portion of the module will discuss the
Print method by first talking about it in general and then discussing the
implications of printing (o a form and printing to a picture box.

[object.|Print{expressionlist)[{:l,}]

The object can be either a form, a picture, or a printer to which the expression list
will be printed.
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The expression list is either text or numbers that you want to print. Multiple
expressions can be separated with a semicolon, a comma, or a space, If the
expression list is omitted, Visual Basic prinis a blank line.

+ The semicolon and the comma are used to specify the location of the text cursor for
the next character displayed. A semicolon means the cursor is placed immediately
after the last character displayed. The comma means the cursor is placed at the start
of the next print zone. Print zones begin every 14 columns.

Notle A :.rm does not need (o have the Visible property set 10 True to be able 10
send output to it.

Walk Through — Printing with For...Next Loops
Z Tao print with For...Next loops
1. From the Walk Throughs program group, start Fank:y Print,
2. Click the form.
This displays the output from the code contained on the next page.
3. From the Control menu, choose Close.

The following example is available in Visual Basic Help.

Exomple 1  'Print Method Example

2 Sub PrintDemo ()
3 Const BLUE = 1
4 Conat MAGENTA = 5
5 Conat BRIGHTWHITE =~ 15
6 cls ‘ ' Clear form,
3 width = 7200 ' Set form width.
8 Height = 5000 ! Set form height.
9 BackCclor = QBColor{BLUE) ' S5at background celor.
10 For I% = 1 Te 3
11 Selact Case I%
12 Case 1 ' First time.
13 'Set foreground color.
14 ForeColor = QBColor {MAGENTA)
is Kty = 1: L% = 9: Mt = }

16 Msg5s = "Visual”® ' Set message."”
17 CX =0 ' Set position variable.
18 Case 2 ' Second time.
19 K = 1: L% = 9: My = 1
20 i Msg$ = “"Basic"
21 CX = ScaleWidth

22 - case 3 * Third time,
23 . ForeColor = QBColor {BRIGHTWHITE)
24 K¥Y = 9: Ly = 1: My = =]
25 Msg§ = "Visual Basic”
26 CX » ScaleWidth / 2

27 End Select
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28 . _For J% = K% To L% Step MY

29

Further
Examples

o

53 End Sub

Select_Case_J%

Wy

! _Change-font-siza.

30 Case 1l: Fontsize = 8
Case 2: Fontsize = 10
32, Case 3: Fontsize = 12
330 .- Case 4: Fontsize = 14
34 Case 5: Fontsize = 18
35 Casa 6: Fontsize = 29
16 " Case 7: Fontsize = 24
37 Casa 8: Fontsize = 36
38 Casa 9: Fontsize = 48
39 End Select
40 If I¥ = 1 Then
41 Cffset® = 0 ' Text on left.
42 ElanIf I% = 2 Then
43 Offsec¥ = TextWidth{Msg$) ' Text on right.
44 Else
45 ' Text in center.
46 Offsat% = ToxtWidth (Msg$) / 2
47 End If
48 CurrantX = CX — Offsatd
49 Print Mag$ ' Print messaga.
50 Naxt J% ’
51 CurrentY = 0 ' Reset to top of form.
52 Next I%

For further examples using the Print method, see the following. .

Application Form Procedure

IconWorks I[CONEDIT.FRM DisplayMouseCoordinates
ICONEDIT.FRM Pic_StatusArea_Paint
VIEWICON.FRM  Load_All Icons
VIEWICON.FRM Pic_SelectedIconLa cl_Paint

Employee Database EMPREC FRM cmdAddDeleteUpdate_Click
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Y Print-Related Functions

[ S

= Spc Function
= Tab Function
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.

_- | .Object: [ Form (E Proc: [ Click 3

- - 8pc Function -~ - - oo —

Sub Form Click ()
FontName = "Helv"
FontSize = 12
Print "Skip 1 space and print a"; Spc(l) "1"
Print "Skip 2 spaces and prlnt a", Spc(2) w2
Print IIS o~ L] n
Print "SK\p 4 sp§= i '
print "sd % 5 sp{ Skip 1 space and printa R
Print "Sk : Skip 2 spaces and printa 2

Skip I spaces and printa 3

dl Skip 4 spaces and print a

Syntax

Example

Further
Examples

This function inseris a specified number of biank characters in a Print method,
starting at the current print position.

Spc(number%)
The number argumeént must be an integer between 0 and 32,767 inclusive.

Important When using fixed pitch fonts (where the space ailowed for each
character is the same size), Spc is not complicated to use: but with a proportionally
spaced font (such as Times New Romane), the width of the space is always the
average width of all characters in the point size of that font.

'Spe Function Example

Sub Form_Click {}

FontNama = "Courier" .

Print " 1 2 3 4 5"
Print "12345678901234567890123456799012345678901234567890"
Print "I'll skip scme spaces then print an x"; Spe{2); "x"
End Sub

R . JEE T B N PV LS

For other examples using the Spc function, see the following.
Application Form Procedure
Employee Database EMPREC FRM cmdAddPrintUpdate_Click
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Tab Function

— Formi.frm
[ otiect: o Proc[Clx T}

Sub Form_Click ()
FontName = "Helv"
FontSize =12
Print "Tab to"; Tab(10); "10"
Print "Tab to"; Tab(20); "20"
Print "Tab to"; Tab (30); "30"

Syntax

The Tab function moves the text cursor o a spec:ﬁed print position when used with
the Print method.

Tab{columnt)

The parameter column% is an Enteger expression that is the column number of the
new print position, The lefumost print position on an output line is always 1.

For forms, the only limit to the rightmost print position is the range of the Integer
daia type.

For a complete description of the Tab function, see Visual Basic Help.
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_ . Using PrinjForm---- e

(form.)PrintForm

Syntax

Example

Further
Examples

WM -l o B W B

PrintForm

Once you have finished formatting all the output to a form, you can use the
PrintForm method 1o send a bit-by-bit image of the form 0 a printer.

[form.]PrintForm

This example is available in Visual Basic Help. If your machine is correctly
connected 10 a printer, this code w.il send the current form to it

'PrintForm Method Example
Sub PrintFormDemo ()
On Error GeTo ErrorHandler ' Set up error handler.
PrintForm ' Print form.
Exit Sub
ErrorHandler:
Mag$ = “"The form could not be printed. "
MsgBox Mag$ ' Display message.
Resume Next
10 End Sub
Application Form Procedure
Employee Database EMPREC FRM cemdAddPrintUpdate_Click

Remember, the Print method is used to place the data on the form. The PrintForm
method is used to send a bit-by-bit image of the form to the default printer.

You should set the AutoRedraw property of a form 0 True if you will print it using
the PrintForm method. If AutoRedraw is not True, graphics drawn directly on the
form using Print, Line, Circle and other graphic statements will not appear on the

printer. '
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Walk Through — Effects of AutoRedraw

Z To see the effects of setting the AutoRedraw Property
. 1. From.the Walk Throughs program group, start PrintForm & AutoRedraw.
"2, Click the Draw command button.
This draws lines on the form.
3. From the AutoRedraw menu notice that AutoRedraw is set 1o False.

4, Drag the minimized Program Manager icon onto the form and then move it
away.

Notice the form now has a gap where the Program Manager icon erased the
lines. The lines are not redrawn. [f you had printed this form using the
PrintForm method, the lines would not appear.

5. From the AutoRedraw menu choose True 1o set AutoRedraw (o True.
The code in this menu selection invokes the Draw buiton for you.

6. Drag the minimized Program Manager icon onto the form and then move it
away.

Notice the form automatically redraws the lines if necessary. If you had printed
this form using the PrintForm method, the lines would appear.
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- -Summary-

é’Jl

'
[ } a a

‘Scenario

Methods for Printing -
Print-Related Functions
Using PrintForm

Objectives

In this module you learned to:

Use the Print method o create output directlff onto a form.
Mescribe how the AutoRedraw property relates to printing directly to a form.

> the CurrentX and CurrentY properties of a form and the Spc and Tab
.unctions 1o control the placement of output printed to a form.

Usé the Cls method to clear a form.
Use the PrintForm method to send a bit-for-bit image of a form to the printer.
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Lab Time

Go to the Getting Output portion of your lab manual.
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>, Overview -~ -~ ==

N

.

‘Overview of a Database

How Does Visual Basic Access Databases?
The Data Control

Binding Controls to the Data Control

Data Control Walkthru

Data Control Methods and Properties

Objectives
At the end of this module, you will be able to:

w Describe how Visual Basic accesses databases.
»  Use the data control 10 view the contents of a Microsoft Accesss database.
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Overview of a Database

Overview of a Database

The following information will help you understand some of the terminology and
concepts associated with database structure and design.

Relational Database Objects

Visual Basic provides a relational interface o database files. Basically, a relational
database is one that stores data of rables, made up of columns and rows. In Visual
Basic, columns are referred 10 as fields and rows are referred to as records.

Tables

A table is a logical grouping of related information. For example, the Northwind
Traders database has a table that lists all the employees and another table that lists
all the customers.
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‘ Erployee D | Last Name Frst Nare
1% | \lewrig Tim
Foss 284 Bucheren BL
(records)
Fields —

Each column or field in a table contains a single piece of information. For example,
the Employees table has fields for Employee ID, Last Name, and so forth.

Records

A row or record in a labie contains information about a single entry in a table. For
. example, a record in the Employees table would have information on a panticular
- employee. Generally, you do not want two records in a table (o have the exact same
data. You would not want to have two Employees with the same name and the same
ID number. Most tables have a field or combination of fields that must be unique.

indexes
To make access to the database faster, most databases use indexes. Database.table
indexes are sorted lists that are faster to search than the tables.

Structure Query Language (SQt)

Once the data is stored in the database, retrieving it is made easier by using an
English-like language called Structured Query Language, or SQL. SQL has
evolved into the most widely accepted means 10 “converse” with a database. The
user submils a query and the database returns all the rows that match that query.

Example . Selact [Last Name], Title From Employees Whera Title = 'Sales Rep'

Sample Databases

In this coursé you will the Northwind Traders sample database. This database is
included with Microsoft Access.

(N
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How Does Visual Basic Access Databases?

How Does Visual Basic Access Databases?
There are three types of databases that you can access from Visual Basic:

s “Native” Microsofl Access databases. These databases are accessed directly
by Visual Basic,

s Indexed sequential access method (ISAM) databases— for example dBASE,

"~ Paradoxe, and Btrieves databases. Visual Basic reaches these databases
through user-installable drivers that link Visual Basic to the specific
databases.

s Open Database Connectivity (QDBC)-accessible databases. These include

Py . client-server database management systems (DBMSs), such as Microsoft
R AN SQL Server and ORACLEe. Visual Basic reaches these databases through
R the appropriate ODBC drivers.

There are various galeways that are availabie to connect 10 a mainframe database.
This is typically implemented through an ODBC driver.
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Data Control

The data control allows you to link a Visual Basic form to a database. With the data
control, you can create an application that displays and updates data from a
database — without writing a single line of code!

Adding the Data Control to the Toolbox

If the data control is not visible in the Toolbox, add the fotlowing line at the end of
the {Visual Basic) section in the VBINI file in the CAWINDOWS direciory:

Datalccess=l

The DatabaseName Property

The data conuol locates the database through the DatabaseNamne property. If you
are connecting to a dBASE, Paradox, or Btrieve, database, set the DalabaseName
property to the directory that contains the database files:

Datal.DatabaseName = "c:\walkthzu\nwind.mdb"

The RecordSource Property

The RecordSource property indicates the name of a table, query or it contains the
text of an SQL string.

The following example connects the data control to the Employees table:

Datal .RecordSource = "Employees”

The following example retrieves a subset of the Employees table.

Datal.RecordSource = "Select * from Employees where [Last Name] > 'M'"
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72 BBining Two Tables

wDaral.RecordSource =

The following example joins two tables. The brackets are used with fields Ihal have
a space in the name.

"Select customers. [Customer Id],
AlContact Name], [Order Id]
AFrom Customers, Crders )
AWhere Customers.[Customer Id] =
AQrders’ {Customer Id}"

Ordering the Records

The following example selects only some of the fields in the Employees table and
orders the records by last name:

Datal .RecordSource = "Select (First Name], [Last Name] from

AEmployees Order by [Last Name]"
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.DataSource = Datal
.DataField = ’Last Name’

Example

Binding Controls to the Data Control

The text, picture, image, check box, masked edit, 3D panel, and 3D check box
controls can be bound to a data control. When a control is bound to a data conwot,

- the data from the database is automatically displayed in the bound control. In

addition, if the user changes the data in the bound control, those changes are
automatically posted to the database as the user moves 10 another row.

To bind a control 10 a data control, set the DataSource property to the data controt
name and set the DataField property to a field name from the data control’s table.

'The DataScurce property must be set at deasign time
Textl.DataSource = Datal

'The DataField property can be set at design or run time
Textl.DataField = "([Laat Name]"
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Data Cantrol Walkihrough

Data Control Walkthrough'

To get a quick overview of the data control, let's create a simple application that

T connects to the Microsoft Access Northwind database and browses the Employees

o table;
" 1. Start with a'new project and add the data control to the form; leave the default
name Datal.
" 2. Set the following properties for Datal:

DatabaseName = cA\walkthru\nwind.mdb
RecordSource = Employees

Note When you set the DatabaseName at design time, Visual Basic atlempts to .
connect to the database. If it successfully connects 1o the database, it will display a

 list of possible values for the RecordSource property. Notice when you set the
RecordSource property, you can type data in direcily or choose the DOWN ARROW 10
display a list of possible selections.

3. Add two text boxes to the form: leave the names Text] and Text2.
4. Set the following properties for Textl:

DataSource = Datal
DataField = Last Name

5. Set the following properties for Text2:

DataSource = Datal
DataField = First Name

6. Run your application!
. (continued on following page)
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—————— v -

7. Click the right amrow buuon_lo,rﬁove.foward,-lefl arrow button 1o-move- - -——--————— "

TG T TR backward. .
8. Change a last name, click the right arrow button to move forward, and then click
the left arrow button to move back. The record shouid be updated.

"* .79; Notice you have not written a single line of code!
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Data Control Methods and Properties ...

“a Refrésh Method
Connect

Exclusive
ReadOnly

Refresh Method

" The data control reflects modifications to existing data by other users but does not
reflect records deleted or added by other users. The Refresh method updates the
data control with the latest information from the database.

Datal .Refrash

Connect Property.

The Connect property indicates the type of database that will be opened. The:
Connect property does not need 10 be set if you are connecting 1o a Microsoft

Access database.

Database format Da!ab;ise name Connect

Microsoft Access drive:\path\file.mdb (none)

dBASE drive:\path\ "dbase HL" or "dbase [V

Paradox drive:path™ “paradox;”

Birieve ‘ driveX\path\ "brrieve;”

ODBC Registered data source "odbc:dsh=datasource:uid=

' ' narne (server) user;pwd=password"

. : . (Professional Edition only)

: Excluswe Property

If you set the Exclusive property to True and then open the database. no other
application will be allowed 10 open the database until you Close the database. If
another applicaticn has the database open and you attempt to open the database
with Exclusive set to True. your application will receive a run-time error.

ReadOnly Property

If you set the ReadOnly property 10 True, your application will rot pe allowed to
wrile to the dalabase.

f




.
oo

[

Module 13: Data Access Using the Deta Control

~

- -+ an

St
10 Numbet

- Last Name

e Dutabase Application

- LDavoiod

Fst Name

1‘ [Hmd .

- - = m

e et iy

A Sample Application
Here is a sample application that adds, finds,
database.

updates and deletes records from a

The details on how to code this application are beyond the scope of this class.

However, you may find this application useful as an example.

The demonstration program DBSAMPLE.MAK is located in the
\WALKTHRUNDBSAMPLE directory.
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Z Summary

Overview of a Database .

- temael "
-

‘How.Does Visual Basic Access Databases?

The Data Comroi

i
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“ ) .- o Data Control Watkthru T H
; = Data Control Methods and Properﬂes
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